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1
Working with Unifier Managers

This guide explains how to work with the following managers:

• Configurable Managers (Configurable Modules)

• Cost Manager

• Document Manager

• Portfolio Manager

• Planning Manager

• Resource Manager (if you have access to this feature, which was deprecated starting with
version 23.10)

• Schedule Manager (if you have access to this feature, which was deprecated starting with
version 23.5)

• Activity Manager

• Space Manager

Within the documentation, some content might be specific for cloud deployments while other
content is relevant for on-premises deployments. Any content that applies to only one of these
deployments is labeled accordingly.

Note

The instructions and information presented in the documentation are based on an out-
of-the-box (OOTB) setup and before being customized by the user.

Configurable Managers (Configurable Modules)
Configurable managers have flexible coding structures that allow you to analyze your data.
Configurable managers are created and named in uDesigner depending on the intended task.
They can be created at the project/shell or company level. Configurable managers provide
additional functionality and do not replace existing managers. A configurable manager behaves
like any other module in the system.

There are two types of configurable managers:

• Code-based (code based)

• Code and Records-based

You can have up to 25 configurable managers (CM1, CM2, ..., CMx. The letter "x" represents a
number ranging from 1 to 25 managers). For Generic Cost Manager (CM0 or CM zero), see 
Generic Cost Manager.

The Configurable Modules node will display managers in the following structure:

Configurable Modules
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• <name> Manager [Code-based configurable manager]

• <name> Manager [Code and Records-based configurable manager]

– Sheets

– Class

Note

The following sections may use the sub-nodes Parts Manager, Material
Inventory Manager, Condition Assessment Manager, and so forth as
examples of Code-based or Code and Records-based configurable managers.

For information about language (internationalization) and CSV files, see Internationalization
and CSV Files.

Code and Records-based Configurable Managers

A Code and Records-based configurable manager allows you to define codes and capture
data using records. This type of manager allows multiple classes of sheets and records to be
created (each with its own coding structure).

For a Code and Records-based manager, you must first create the manager sheet. The
system automatically adds information to the sheet as it is gathered from records that were
created from business processes tied to the sheet.

For example, a Parts Manager could be created to do the following:

• Categorize parts by type (or class) by creating records for classes

• Track inventory at various locations

• Maintain basic cost information

• Track parts transactions (bought, sold, received, or shipped)

• Monitor costs generated by transactions

Code-based Configurable Managers

A code-based configurable manager also allows you to define codes, but it works with sheets
to analyze information generated manually or from BPs. All the data is consolidated in one
sheet. For a code-based manager, you must manually enter the rows on the sheet. The system
automatically adds data to the rows as you manually enter it, or as it is gathered from records
that were created from business processes tied to the sheet.

For example, a Condition Assessment Manager could be created to do the following:

• Define a building systems code structure at the company level, project level, or shell level

• Design multiple BPs to track and calculate:

– Maintenance requirements

– Inspections

– Work orders

– Repairs

Chapter 1
Configurable Managers (Configurable Modules)
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– Cost of maintenance

– Deficiency costs

– Renewal costs

• Various indexes, such as a facility condition index, to monitor the condition and usability of
facilities

Access a Configurable Manager (Configurable Modules)

The configurable manager modules are designed in uDesigner and configured by your
company administrator.

Note

User permissions are granted per class or sheet. If you cannot view any part of the
configurable manager to which you require access, contact your company
administrator.

To access a configurable manager at the project/shell level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select the [configurable
manager name].
The managers reside under the [configurable manager name].

• If you are using a Code and Records-based configurable manager, there are sheets
and classes (for example, Sheets and Material Inventory Manager).

– To access a sheet, select the Sheets node, and select a sheet from the log.

– To access a class, select a class. The log for the class opens.

• If you are using a code-based configurable manager, there is just one sheet, which is
listed under the log (for example Parts Manager).

To access a configurable manager at the company level (User mode):

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select the [configurable
manager name, class or sheet].

To access a configurable manager at the company level (Admin mode):

1. Go to the Company Workspace tab, and switch to Admin mode.

2. In the left Navigator, select Templates, and then select Shells or Configurable Modules
to expand it.

Reverse auto-population and Code and Records-based Managers

Certain Data Elements (DEs) support reverse auto-population (RAP). These are specified in
uDesigner. RAP means that some values can be automatically updated when other values are
modified in a Business Process (BP) form or Record Attribute Form.

Chapter 1
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You can use RAP to update the fields on records, as well as attribute forms and line items.
This option can streamline the use of forms by keeping the information on them up to date with
the latest data from components inside or outside the BP.

Depending on the set up in uDesigner, RAP can occur in these instances:

• Changes to the DEs in a BP Detail form under the Company level can result in changes to
the Record Attribute Form of a generic manager at the Company level

• Changes to the DEs in a BP Detail form under the Project level can result in changes to
the Record Attribute Form of a generic manager at the Project level

• Changes to the DEs in a BP Detail form under the Shell level can result in changes to the
Record Attribute Form of a generic manager at the Shell level

Creating Sheets and Records for a Code and Records-based Manager
(Standard View)

You can use the Create option to create a new Code and Records-based sheet by way of the
following methods:

• Manually: Read the process for manually creating a sheet, below.

• From Template: This option enables you to create a configurable manager from a
template. The From Template option is available only if one or more configurable manager
templates are defined at Company Workspace (Admin mode).

• From Shell: When you select this option, the system opens a window which lists all the
shells that the administrator has created. You can copy a configurable manager sheet from
a shell that is listed.

To create a Code and Records-based sheet manually:

1. Select Create, and select Manual to open the create sheet window.

2. In the overlay, enter the values. You can also edit existing values in the Properties tab, for
example, change the Picker field value from All Records to records with their statuses set
as "Active," "InActive," or both in the Records with statuses field.
The Default Filter View drop-down field does not have any values when you create a new
sheet. This field has a value for an existing sheet and can be changed.

3. When finished, from the top, select Save.

4. Select Save on the create sheet window.

You can use the Create option to create a new Code and Records-based class.

Important Information about Creating a Record in a Code and Records-based Sheet
Manually

As a general rule, the system disables the fields used in the formula definition of CMx coding
structures. As a result, after you create a record in a Code and Records-based sheet manually,
you cannot modify the CMx coding structures that compile (roll up) the data. In some special
cases, such as when a data picker is used to modify the fields used in the formula definition of
CMx coding structures, you can modify the CMx coding structures. Also, after you create a
record in a Code and Records-based sheet manually, and the record contains a formula field
that is being auto-populated from another field (source field), you must ensure that you do not
modify the value of the source field; otherwise, if you change the value of the source field, the
fields used in the formula definition of CMx coding structures will be modified. See the following
examples:

Chapter 1
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Example 1 (No rollup issue)

Material SKU is a data picker

Material Category is auto-populated from Material SKU

Material Code (CMx code) that rolls up to the Sheet = Material Category<umatCategoryPD> +
Material SKU #<umatSKUMtrDP>

Material Category is auto-populated with Material SKU and Material SKU is part of the formula
that makes up the Material Code.

So, Material Category and Material SKU are disabled.

Example 2 (Rollup issue)

Material SKU is a data picker

Material Name is auto-populated from Material SKU

A1 = Manual entry

Material Code (CMx code) that rolls up to the Sheet = Material Name + A1

Material Name and A1 are used in Material Code formula. So, Material Name and A1 are
disabled.

However, Material SKU is not disabled as it is not used directly used in Material Code formula.
So, if you change the value of Material SKU data picker (which is not disabled), it will change
the value of Material Name through auto-population. Material Name which is part of Material
Code will now be modified. As a result, the roll up of data seen in the CMx Sheet will be
incorrect.

Creating Sheets for a Code-based Manager (Standard View)

You can use the Create option to create a code-based configurable manager sheet:

• Manually: Read the process for manually creating a sheet, below.

• From Template: This option enables you to create a configurable manager from a
template. This option is available only if one or more configurable manager templates are
defined at Company Workspace (Admin mode). If no templates are defined, this option
will not be available. If you do not have create permission, this option is disabled. In this
scenario, you can access rows or create more rows irrespective of the way that a sheet is
created, manually or by template.
You cannot modify the segment sources. Creating a sheet by way of a template enables
you to access the sheet rows.

• From Shell: When you select this option, the system opens a window which lists all the
sheets that can be copied from other shells that the administrator has created.

To create a code-based configurable manager sheet manually:

1. Select Create, and select Manual to open the create sheet window.

2. In the Properties tab, enter the values. You can also edit existing values in the Properties
tab, for example, change the Picker field value from All Records to records with their
statuses set as "Active," "InActive," or both in the Records with statuses field.
The Default Filter View drop-down field does not have any values when you create a new
sheet. This field has a value for an existing sheet and can be changed.

3. Select the Segments tab, and add segments.

Chapter 1
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You can add multiple segments by selecting the plus icon (+). When you select the plus
icon (+), the system inserts a new row on the grid. After you add a row, you must select the
cell under the Segment Source label and select a source, which has been designed in
uDesigner. You can use drag-and-drop to move the segments. To delete a segment, select

the segment row, and select Delete . The Segments tab has a grid that is similar to the
grid and fields of the Line Items in BPs.

4. When finished, from the top, select Save.

5. Select Save on the create sheet window.

Working with Configurable Manager Sheets (Classic View)

The following topics describe how to use configurable manager sheets.

Create a new sheet from an existing template

You can create a sheet by copying an existing template from the same class.

To copy an existing template:

1. Select a class template from the log.

2. To copy a template, do one of the following depending on which level the template is:

• At the company level, select Copy, and then select Template.

• At the project level, select Copy, and then select Project.

• At the shell level, select Copy, and then select [shell name].

The Properties window opens with the information from the original template.

3. Make changes as needed in the Properties window, and select OK to create the new
sheet.

Add columns to a sheet

If you have created permission, you can add columns, but not rows, to a Configurable Manager
sheet template. The columns can capture data from business processes or manually entered
data.

To add a column to a sheet:

1. Open the sheet.

2. Select Columns. The Columns log opens.

3. Select New. The Column Properties window opens. Complete the window as described in
the table below.

In this field: Do this:

Name The Name field is populated with the data source value
selected.
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In this field: Do this:

Datasource Select a data source. The data sources available are data
elements that are defined in the detail form for a class in
uDesigner. Also listed are data elements based on SYS
Numeric Logical Datasource, SYS Date Logical
Datasource, SYS Project Cost Datasource, SYS BP
Currency Amount, SYS BP Decimal Amount, and SYS
BP Integer Amount data definitions.

Note

You can add data picker fields
as columns, but you cannot
invoke the data picker from
the sheet.

Width (pixels) Enter the width the column should be. Maximum is 2000
pixels. (You can also manually resize the columns on the
sheet.)

Alignment Specify whether the data in the column should be left-
or right-aligned or centered.

Entry Method Choose a data entry method for the column. The options
vary depending on the data source selected:
• Manual entry: You can enter data directly into the

cell, or data is rolled up from another source, such
as the form.

• Formula: Formula types are numeric, date
difference, and date add. See Add a formula column
for details on working with formulas.

• Define: Use this method to specify data that should
roll up from line items. Select Define and in the
Formula Creation window, select the business
processes and fields whose values should roll up to
the manager sheet. You can select single fields to roll
up, or you can add several fields together for a
combined roll up amount.
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In this field: Do this:

Data Format Specify how the column data appears for numeric
columns. The options are:
• Show as Percentage: Data entered in a column is

displayed as a percentage. For example, if you enter
0.25, it displays as 25%.

When entering the percentage values in your sheet, if
you are working in Classic View, enter the value by
using decimal number format. For example, for ten
percent, enter: 0.1, and if you are working in Standard
View, enter the value by using percent format. For
example, for ten percent, enter: 10%. The value that the
system uses to validate the value of the Percentage
column, when applicable, will be: 0-100.
• Decimal Places: Select the number of decimal

places to display (0 to 8).
• Use 1000 Separator (,): If you select this option, the

entered data is formatted with a separator for
numbers with more than three digits. For example,
1,000 rather than 1000.

• Negative Number Format: Specify if negative
values are displayed with a negative sign or in
parentheses.

Display Mode Select Hide to make the column invisible to users. Select
Show to display it. You can show/hide any column on
the sheet, including the code name column.

Summary Rows Specify what the summary rows display.
• Blank: Summary row remains blank.
• Sum of All Rows: Summary row displays the sum

total of all row values for this column.
• Use Formula Definition: Formula entered in the

Formula field applies to the summary row.

Total Specifies what displays in the bottom summary row for
each column:
Blank: Summary row remains blank.
Sum of All Rows: Summary row displays the sum total
of all row values for this column.
Use Formula Definition: Formula entered in the
Formula field applies to the summary row.

Column Position After Determines the position of the column on the sheet.

To copy a column:

1. In the Column log, select a column, and select Copy.

2. The Column Properties window opens. Make changes as necessary for the new column.
You must change at least the data source.

View column properties

The Properties window for a column maintains the column name, data source, entry method,
and other properties for that column.

To open the column properties window:
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In the sheet, select a column link. The View Column window opens, showing the data source
from which the column values are gathered and the data entry method, including any formula
used to calculate the values.

Add a formula column

You can add a formula column to the sheet for data sources that are based on either the data
definitions SYS Numeric Logical Datasource or SYS Date Logical Datasource.

You can define formulas for the following types:

• Numeric: This option is available if the data source is SYS Numeric Logical.

• Date Difference: This option is available if the data source is SYS Numeric Logical. It is
used for formulas that calculate the difference between two dates.

• Date Add: This option is available if the data source is SYS Date Logical. It can be used to
add values to a date to calculate a new date.

To create a Numeric formula:

1. In the column Properties window, choose Formula and select Numeric.

2. Select Create. The Create Formula window for numeric formulas opens.

3. Select either Item or Sheet from the data type drop-down list. Item lists data elements that
are defined on the form. Sheet lists columns that are already defined on sheet.

4. Build a formula by doing the following:

• To include a data source in the formula, select the data source from the list, and click
Select.

• Select a mathematical modifier (plus, minus, and so on) and numbers on the keypad.

5. When the formula is complete, select OK.

To create a Date Difference formula:

1. In the column Properties window, choose Formula and choose Date Difference. Select
Create. The Date Difference window opens.

2. For Earlier Date and Later Date, click Select. Select a data element. The list includes date
type data elements from the form or existing date type columns on the sheet.

3. Choose one of the following:

• Calculations based on Calendar Days: The calculation is based on calendar days
and does not take company non-working days into account.

• Calculations based on Work Days: The calculation is based on the company
calendar working and non-working days.

• Show Partial Day

4. Select OK.

To create a Date Add formula:

1. In the column Properties window, choose Formula and choose Data Add. Select Create.
The Date Add window opens.

2. For the Date field, click Select, and choose a data element from the list.

3. For the Add field, click Select, and choose a data element from the list.

4. Choose one of the following:
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• Calculations based on Calendar Days: The calculation is based on calendar days
and does not take company non-working days into account.

• Calculations based on Work Days: The calculation is based on the company
calendar working and non-working days.

5. Select OK.

Open a sheet

Manager sheets are listed on the Sheet log of the configurable manager.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.

To open a sheet for a code-based manager:

1. Go to the shell tab in which the manager resides and switch to User mode.

2. In the left Navigator, select Configurable Modules.
The Navigator expands to display the configurable managers that have been created for
this project/shell.

3. Select the configurable manager you want to work in. The system displays the sheets log.

4. On the sheets log, double-click the name of the sheet. The system opens the sheet.

To open a sheet for a Code and Records-based manager:

1. Go to the shell tab in which the manager resides and switch to User mode.

2. In the left Navigator, select Configurable Modules.
The Navigator expands to display the configurable managers that have been created for
this project/shell.

3. In the left Navigator, select the name of the manager you want to work in. The Navigator
expands to display a Sheets node.

4. In the left Navigator, select the Sheets node. The system displays the sheets log, listing a
sheet for every class created for the manager.

5. On the sheets log, double-click the name of the sheet. The system opens the sheet.

View record details

To view the details of a listed record, select the record. A view-only window opens displaying
the record details.

View sheet properties

The Properties window for the sheet maintains the name and display options. It can be used to
map a column to a company account code.

To open the sheet Properties window:
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In the Sheets log, select the sheet, and select Properties.

• The General tab is described in the following table.

• In the Options tab, sheet columns can be mapped to company account codes.

Expand or collapse the sheet rows

For convenience in viewing sheet data, you can expand and collapse the rows to expose and
close sub-items on the sheet.

Drill down to more data

From the sheet, you can use the blue hyperlinks to drill down to additional detail about the
item.

View or edit code details

Each row item on the sheet is identified by a code, which is in the first column on the sheet.
The code is hyperlinked. If you want to see more details about a row item, select Link.

Code-based manager and record-based manager

The system displays a read-only copy of the Detail form, or the attribute form, for that item. You
cannot edit the displayed form because the manager retrieves the information from the records
that have been created, automatically.

The sheet for a code-based manager is designed to be dynamically editable, so you can edit
the fields that are not read-only (grayed out). For a code-based manager, the system displays
the Code Details window which shows the fields from the manager attribute form. Note that the
"Code" field is not editable.

If the field appears as a column on the sheet, any changes that you make to the field (in the
Code Details window) will appear on the sheet. Reciprocally, any changes you make on the
sheet will also appear on the Code Details window, for the item.

View rollup data

For Code and Records-based managers, BP line item data, such as costs and quantities, can
be configured to roll up to the manager sheet from across shells. Cells that contain rolled-up
data will show a hyperlinked value. Every transaction will include an ID that includes the
project/shell number where the BP Record was created. You can select this hyperlink to open a
cell details window and view all the business process transactions that contributed to the
rollup. Double-click a transaction to open the original BP Record in view mode.

Sort the sheet content

If the manager sheet is in flat mode (that is, it lists the codes in a flat structure, rather than
hierarchically), you can sort the content on the sheet by column. By default, the system shows
column data in ascending order.

To sort column data:
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Select the column heading. The system will redisplay the data in that column in descending
order. To return the column data to ascending order, select the heading again.

Filter the sheet content

Some managers, particularly those configured to function across shells, can accumulate a
substantial amount of data. To make viewing this data easier, you can create filters to restrict
the content of the sheet.

To create a filter:

1. Open the sheet.

2. From the View menu, choose Filters. The Setup Filters window opens.

3. Select Add. The Add Filter window opens.

4. In the Filter Name field, enter a name for this filter.

5. Select Add. The Query Condition window opens.

6. In the Data Element field, enter the name of the field you want to appear on the manager
sheet.
The values in the field must meet a condition (such as "equals" or is "greater than") to be
included on the sheet.

Depending on the data element you enter, the Query Condition window will display variable
fields.

Select the Show result matching ANY condition checkbox if you want the field to meet
any one of the conditions in the filter, rather than meeting all filter specifications.

Select the Display Summary Rows checkbox if you want to see the summary rows
recalculated based on the filtered view of the sheet.

7. Select OK, or select Apply Filter to filter the sheet content.

To apply a filter to a sheet:

1. Open the sheet.

2. From the View menu, choose Filters. The Setup Filters window opens, showing a list of
the filters that have been created for the sheet.

3. Select the filter you want to use, and select Apply Filter.
The system displays a filtered view of the manager sheet. While in a filtered view, you can
use all sheet functions except Export and Import.

If you want to redisplay all the rows on the sheet, you can clear the filter by choosing
ClearFilters from the View menu.

To edit a filter:

1. Open the sheet.

2. From the View menu, choose Filters. The Setup Filters window opens, showing a list of
the filters that have been created for the sheet.

3. Select the filter you want to edit, and select Edit.

Enter sheet data

For manual data-entry columns, you can enter data directly into the sheet.
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To enter data on a sheet:

1. Open the sheet.

2. Click inside a manual-entry cell, and enter the data.

3. Select Save.

Edit sheet data

You can perform some editing on the sheet itself. Columns are designated with an entry
method when they are added to the sheet. If the column specified "manual entry," you can
enter data directly into that column on the sheet. If you change a field value on the sheet, the
system will also change the field on the item's attribute or detail form.

Note

The name of the row item is always editable. The code, however, is never editable.

To enter data on a sheet:

1. Double-click inside a manual-entry cell. The system will highlight the cell data and open a
text box.

2. Enter the data in the text box, and select Save.

Create and view a snapshot

You can take a snapshot of a sheet to keep as a record and view later.

To create a snapshot:

1. Open the sheet.

2. Select File, and then select Create Snapshot. The Create Snapshot window opens.

3. Enter a title, and select OK.

To view a saved snapshot:

1. Open the sheet.

2. Select View, and then select Snapshot Log. The Snapshot log opens.

3. Select a snapshot from the list, and select Open. A read-only view of the sheet opens,
displaying the sheet data at the time of the snapshot.

Copy data to another column

You can copy data from one manual-entry column to another.

To copy data from one column to another:

1. Select Edit, select Copy, and then select Column Data. The Copy Column Data window
opens.

2. Select the manual-entry column to copy, the percentage value, and the column to which to
copy.

Chapter 1
Configurable Managers (Configurable Modules)

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 13 of 671



3. Select Copy.

Search for records on a sheet

To search for records:

1. Open the sheet.

2. Select Find. The Find window opens.

3. Select the search criteria:

• Column: Choose a column from the sheet.

• Value: Enter a value to search.

• Search: Select the direction to search from the selection on the sheet.

4. Select Find Next to search for the entered value. You can select Find Next again to
continue searching.

5. Select Cancel to cancel the search.

Export sheet data

You can export data from columns that have been manually entered to a CSV file. The data is
for reference only and cannot be re-imported.

To export columns from a sheet:

1. Open the sheet.

2. Select Export, and choose Codes (for code-based managers only) or Column Details.

3. Select the columns to export, and select OK.

4. Save the CSV file to your local drive.

Import sheet column data

You can enter data into manual-entry columns by importing a CSV sheet. The column must be
configured on the record detail form to accept numeric data elements.

To import column data:

1. In the CSV file, enter data for each listed record. Be careful not to change the CSV file
structure.

2. Save the CSV file.

3. Open the sheet to which you want to import the data.

4. Select Import, and choose Codes (for code-based managers only) or Column Details.

5. Browse to the CSV file containing the column data, and select OK.
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Note

You cannot delete summary rows from the sheet using a CSV import. You also
cannot delete existing rows using CSV import if their codes have been added to
business processes.

Working with Configurable Manager Sheets (Standard View)

The configurable managers are nested under the Configurable Modules as shown below:

Configurable Modules

• <name> Manager [Code-based configurable manager]

• <name> Manager [Code and Records-based configurable manager]

– Sheets

– Class

The following explains applicable actions for each sub-node.

Add Columns or Rows to a Sheet

The following explains how to add columns or rows to a sheet, where applicable.

Configurable Modules: <name> Manager [Code-based configurable manager]

Note

You must have the "Create" permission to proceed with adding columns or rows.

To add columns to a code-based configurable manager sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
displays a list of sheets and the corresponding properties (on the right side).

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Add Column  to open the Add Column window.

5. Enter values in the fields that are displayed.

6. After you are finished, select one of the following options:

• Cancel: To cancel the changes and close the window.

• Save: To save your work for creating a new column.

• Save & Add New: To save your work and begin creating a new column.

To add rows to a code-based configurable manager sheet:

1. Go to the shell tab, and switch to User mode.
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2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
displays a list of sheets and the corresponding properties (on the right side).

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Add Row (  ) to open the Add Row window.

5. Enter values in the fields that are displayed.

6. After you are finished, select one of the following options:

• Cancel: To cancel the changes and close the window.

• Save: To save your work for creating a new row.

• Save & Add New: To save your work and begin creating a new row.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

Note

You must have the "Create" permission to proceed with adding columns. You cannot
add rows. The columns can capture data from business processes or manually
entered data.

To add columns to a Code and Records-based configurable manager sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Add Column  to open the Add Column window.

5. Enter values in the fields that are displayed.

6. After you are finished, select one of the following options:

• Cancel: To cancel the changes and close the window.

• Save: To save your work for creating a new column.

• Save & Add New: To save your work and begin creating a new column.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

You can only create new <name> Manager [Code and Records-based configurable
manager]-Class.

Fields

The following details some of the fields:
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In this field: Do this:

Name The Name field is populated with the data source value
selected.

Datasource Select a data source. The data sources available are data
elements that are defined in the detail form for a class in
uDesigner. Also listed are data elements based on SYS
Numeric Logical Datasource, SYS Date Logical
Datasource, SYS Project Cost Datasource, SYS BP
Currency Amount, SYS BP Decimal Amount, and SYS
BP Integer Amount data definitions.

Note

You can add data picker fields
as columns, but you cannot
invoke the data picker from
the sheet.

Type
Data Format Specify how the column data appears for numeric

columns. The options are:
• Show as Percentage: Data entered in a column is

displayed as a percentage. For example, if you enter
0.25, it displays as 25%.

When entering the percentage values in your sheet, if
you are working in Classic View, enter the value by
using decimal number format. For example, for ten
percent, enter: 0.1, and if you are working in Standard
View, enter the value by using percent format. For
example, for ten percent, enter: 10%. The value the
system uses to validate the value of the Percentage
column, when applicable, will be: 0-100.
• Decimal Places: Select the number of decimal

places to display (0 to 8).
• Use 1000 Separator (,): If you select this option, the

entered data is formatted with a separator for
numbers with more than three digits. For example,
1,000 rather than 1000.

• Negative Number Format: Specify if negative
values are displayed with a negative sign or in
parentheses.

Display Mode Select Hide to make the column invisible to users. Select
Show to display it. You can show/hide any column on
the sheet, including the code name column.

Summary Rows Specify what the summary rows display.
• Blank: Summary row remains blank.
• Sum of All Rows: Summary row displays the sum

total of all row values for this column.
• Use Formula Definition: Formula entered in the

Formula field applies to the summary row.
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In this field: Do this:

Total Specifies what displays in the bottom summary row for
each column:
Blank: Summary row remains blank.
Sum of All Rows: Summary row displays the sum total
of all row values for this column.
Use Formula Definition: Formula entered in the
Formula field applies to the summary row.

Column Position After Determines the position of the column on the sheet.

You cannot copy a column.

View Column Properties

The following explains how to open the column properties for each configurable manager.

Configurable Modules: <name> Manager [Code-based configurable manager]

To view the column properties:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
displays a list of sheets and the corresponding properties (on the right side).

3. Double-click the sheet to open the sheet log that displays the columns.

4. In a column, select a cell that has a link. The screen will divide in half and the lower portion
of the screen displays the following tabs which provide details about the cell:

• General

• Audit Log

• Transactions

• Cell Details

Select and drag the three dots on the border of the two screens to resize the windows, or
select once to open and close the right pane.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

To view the column properties:

1. Go to your <name> Code and Records-based configurable manager]-Sheets. The log
displays a list of sheets.

2. In a column, select a cell that has a link. A new window opens and the screen will divide in
half. The properties pane (right side of the window) contains the following tabs which
provide details on each cell:

• Comments
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• Linked Records

• Linked Mail

• Audit Log

To expand the properties pane, select Maximize . To minimize it, select the icon again.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

To view the column properties:

1. Go to your <name> Manager [Code-based configurable manager]-Class. The log
displays a list of sheets and the corresponding properties (on the right side).

2. Double-click the sheet to open the sheet log that displays the columns.

3. In a column, select a cell that has a link. The screen will divide in half and the lower portion
of the screen displays the following tabs which provide details about the cell:

• General

• Audit Log

• Transactions

• Cell Details

Select and drag the three dots on the border of the two screens to resize the windows, or
select once to open and close the right pane.

Open a Sheet

Manager sheets are listed on the sheet log of the configurable manager.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.

Configurable Modules: <name> Manager [Code-based configurable manager]

To open a sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
displays a list of sheets and the corresponding properties (on the right side).

3. Double-click the sheet to open the sheet log that displays the columns.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

To open a sheet:
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1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

To open a sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select the class sub-node (<name> Manager [Code and Records-
based configurable manager]-Class) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

View Record Details

To view the details of a listed record, select the record. A view-only window opens displaying
the record details.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.

Configurable Modules: <name> Manager [Code-based configurable manager]

To view record details:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
displays a list of sheets and the corresponding properties (on the right side), Properties
tab.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

To view record details:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
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manager]), and then select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log.

3. Select a record to see the corresponding properties (on the right side), Properties tab.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

To view record details:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select the class sub-node (<name> Manager [Code and Records-
based configurable manager]-Class) to open the log.

3. Select a record to see the corresponding properties (on the right side), Record Details
tab.

View Sheet Properties

The following explains how to view the properties of a sheet.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.

Configurable Modules: <name> Manager [Code-based configurable manager]

To view the properties of a sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, expand the Configurable Modules node.

3. Select your code-based configurable manager (<name> Manager [Code-based
configurable manager]). The log displays a list of sheets and the corresponding
properties (on the right side), Properties tab.

4. Double-click the sheet to open the sheet log that displays the columns.

5. From the toolbar, select Menu Options (  ), and select Properties.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

To view the properties of a sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
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manager]), and then select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log.

3. Select a record to see the corresponding properties (on the right side), Properties tab.

4. Double-click the sheet to open the sheet log that displays the columns.

5. From the toolbar, select Menu Options (  ), and select Properties.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

To view the properties of a sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select the class sub-node (<name> Manager [Code and Records-
based configurable manager]-Class) to open the log.

3. Select a record to see the corresponding properties (on the right side), Record Details
tab.

Filter Sheet Content

Some managers, particularly those configured to function across shells, can accumulate a
substantial amount of data. To make viewing this data easier, you can create views that filter
(restrict) the content of the sheet.

You can use the View option to access created views, create views, or update the existing
views. The views that have been created, including Default, are listed in the upper segment of
the drop-down list. The lower segment of the list includes the Create New View and Manage
Views options.

To create a view:

1. Select Create New View.

2. Use the Save option to name your new view.

3. Use the following tabs for adding columns and filtering, grouping, and sorting information:

• Columns tab

• Filters tab

• Group By tab

• Sort By tab

4. Use the Columns tab to select the columns that you want displayed in the view.
The Available Columns box displays all the columns that you might want to include. The
Selected Columns box displays all the columns that you select. You can move columns in
and out of the Selected Columns box.

Use the following fields to set the position of the new view:

• Left Lock after Column: Displays a list of all columns, except the last column from the
selected columns list. By default, None is selected, which means that you have
chosen no column to be locked, from the left side of the sheet.
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• Right Lock after Column: The default value is None, which means that you can
select not to right-lock the column in the view. Other values in this field are based on
the value that you have selected in the Left Lock after Column.

5. Use the Filters tab to control what information is displayed in the selected view.
You can add multiple filters to a view, and you can use the same data element multiple
times. When adding multiple filters, you can use operators to specify that the view must
match all listed filters or that it can match one or more of the listed filters.

a. Select Add Filter.

b. Choose a Data Element: This drop-down list displays all data elements that are on the
attribute form. Any data elements in a hidden block are not available.

c. Choose a Condition: This drop-down list displays a list of conditions. This list is based
on the type of data element selected.

d. Choose a Value: Depending on the type of data element, choose a value that the
query condition must meet.

• Data Element: Lists the data elements on the attribute form.

• Constant Value: You can enter a full or partial entry of the value to filter by. This is
similar to entering search criteria.

6. To add additional filters, select Add Filter again, and repeat the preceding steps.
You can use the same data element multiple times.

7. If you are using multiple filters, select the applicable operator that should apply:

• And: If you want to specify that the view must match all listed filters, select And.

• Or: If you want to specify that the view should match any of the listed filters, select Or.

8. Use the Group By and Sort By tabs to identify which columns should be used for group
and sorting and in what order.

9. When you are done, select Save.

To manage a view:

To update a view, select the applicable view from the View list, select Edit View , and then
make and save the applicable changes.

To modify or remove a filter:

1. From within the applicable view, select Edit View , and select the Filters tab.

2. Make the applicable changes, such as changing the selected Data Element or Condition,
updating the Value, or removing one or more of the filters from a set.

3. To save your changes, select Save or Save As.

Create and View a Snapshot

You can take a snapshot of a sheet to keep as a record and view later.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.
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Configurable Modules: <name> Manager [Code-based configurable manager]

You cannot create a snapshot.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

To create and view a snapshot:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Menu Options (  ), and select Snapshots.

5. Select one of these options:

• Create
When you select Create, the Save As Snapshot New window opens which enables
you to create a snapshot by entering the snapshot title and selecting OK.

• Open
To open and view an existing snapshot, if available.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

You cannot create a snapshot.

Export Sheet Data

You can export data from columns that have been manually entered to a CSV file. The data is
for reference only and cannot be re-imported.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.

Configurable Modules: <name> Manager [Code-based configurable manager]

To export sheet data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
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displays a list of sheets and the corresponding properties (on the right side), Properties
tab.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Menu Options (  ), and select Export.

5. Select one of the following options:

• Codes: To export a Microsoft Excel Comma Separated Values File.

• Column Data: To export column details.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Sheets

To export sheet data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Menu Options (  ), and select Export.

5. Select one of the following options:

• <sheet name> Summary Sheet: To export a Microsoft Excel Comma Separated
Values File.

• Column Data: To export column details.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

To export sheet data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select the class (<name> Manager [Code and Records-based
configurable manager]-Class) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Actions, and select Export CSV Template.

5. Follow the prompts to complete the export.

Import Sheet Column Data

To import column data:

1. In the CSV file, enter data for each listed record. Be careful not to change the CSV file
structure.
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2. Save the CSV file.

3. Open the sheet to which you want to import the data.

4. From the toolbar, select Menu Options.

5. Select Import, and choose Codes (for code-based managers only) or Column Details.

6. Browse to the CSV file containing the column data, and select Import.

Note

You cannot delete summary rows from the sheet using a CSV import. You also
cannot delete existing rows using CSV import if their codes have been added to
business processes.

You can enter data into manual-entry columns by importing a CSV sheet. The column must be
configured on the record detail form to accept numeric data elements.

Note

You must have permissions to access a sheet. If you need access to a sheet not listed
in the log, contact your company administrator.

Configurable Modules: <name> Manager [Code-based configurable manager]

To import sheet data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, and then select your code-based
configurable manager (<name> Manager [Code-based configurable manager]). The log
displays a list of sheets and the corresponding properties (on the right side), Properties
tab.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Menu Options (  ), and select Import.

5. Select one of the following options:

• Codes: To import by opening a local folder and selecting a file.

• Column Data: To import column details.

Configurable Modules: Generic Cost Manager

For Generic Cost Manager (CM0 or CM zero), see Generic Cost Manager.

Configurable Modules: <name> Manager [Code and Records-based configurable manager]-
Sheets

To import sheet data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
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manager]), and then select Sheets (<name> Manager [Code and Records-based
configurable manager]-Sheets) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Menu Options (  ), and select Import.

5. Select Column Data to import column details.

Configurable Modules: <name> Manager [Code and Records-based configurable
manager]-Class

To import sheet data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Modules, select your Code and Records-based
configurable manager (<name> Manager [Code and Records-based configurable
manager]), and then select the class (<name> Manager [Code and Records-based
configurable manager]-Class) to open the log. The log displays a list of sheets.

3. Double-click the sheet to open the sheet log that displays the columns.

4. From the toolbar, select Actions, and select Import to open the Upload CSV window and
select a file.

Working with Configurable Manager Logs (Standard View)

The following topics describe how to use configurable manager sheets in Standard view. In
particular, this section explains how to access, review, and create both code-based and Code
and Records-based configurable managers.

Code-Based Managers Log (Standard View)

The code-based configurable manager log is divided into two panes, left and right. The
following explains the left pane elements of the log.

Left pane elements:

• Toolbar: Create
This option is available if a sheet has not been created. After you create a configurable
manager sheet, there will be no toolbar options.

• Column: Title, Description, and Last updated

Right pane elements:

This right pane is blank for an empty log. When you create a sheet, the right pane displays the
Properties tab that captures the details of the sheet.

• Properties tab

– Title

– Description

– Display Mode

– Default Filter View

– Picker

– Segments
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• Expand toggle key
To expand the tab window.

Creating a Code-Based Configurable Manager Sheet (Standard View)

You can use the Create option to create a code-based configurable manager sheet:

• Manually: Read the process for manually creating a sheet, below.

• From Template: This option enables you to create a configurable manager from a
template. This option is available only if one or more configurable manager templates are
defined at Company Workspace (Admin mode). If no templates are defined, this option
will not be available. If you do not have create permission, this option is disabled. In this
scenario, you can access rows or create more rows irrespective of the way that a sheet is
created, manually or by template.
You cannot modify the segment sources. Creating as sheet by way of a template enables
you to access the sheet rows.

• From Shell: When you select this option, the system opens a window which lists all the
sheets that can be copied from other shells that the administrator has created.

To create a code-based configurable manager sheet manually:

1. Select Create, and select Manual to open the create sheet window.

2. In the Properties tab, enter the values. You can also edit existing values in the Properties
tab, for example, change the Picker field value from All Records to records with their
statuses set as "Active," "InActive," or both in the Records with statuses field.
The Default Filter View drop-down field does not have any values when you create a new
sheet. This field has a value for an existing sheet and can be changed.

3. Select the Segments tab, and add segments.
You can add multiple segments by selecting the plus icon (+). When you select the plus
icon (+), the system inserts a new row on the grid. After you add a row, you must select the
cell under the Segment Source label and select a source, which has been designed in
uDesigner. You can use drag-and-drop to move the segments. To delete a segment, select

the segment row, and select Delete . The Segments tab has a grid that is similar to the
grid and fields of the Line Items in BPs.

4. When finished, select Save.

5. Select Save on the create sheet window.

Code and Records-based Managers Log (Standard View)

Sheets

The sheets log is divided into two panes, left and right. The following explains the left pane
elements of the log.

Left pane elements:

• Toolbar: Create, Find on Page, and Print
Empty log has one option on the toolbar: Create.

A non-empty log, in which sheets for all classes within the manager have not been created,
has three options on the toolbar: Create, Find on Page, and Print.

A log in which sheets for all classes have been created shows the options: Find on Page,
Print.
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• Columns: Title, Description, Class, and Last updated

Right pane elements:

This pane is blank for an empty log. When one or more sheets have been created, this pane
shows a tab that captures the properties of a selected sheet.

• Properties tab

– Title

– Description

– Class

– Display Mode: To determine how the entries in a sheet are going to be displayed.

– Default Filter View

– Picker

• Expand toggle key
To expand the tab window.

Class

The class log is divided into two panes, left and right. The following explains the left pane
elements of the log.

Left pane elements:

• Toolbar: Create, Actions, View, Edit View, Refresh, Print, Search, Find on Page, and
Help

• Column: Attachments and class-related titles

Right pane elements:

• Record Details tab which displays all the details related to the highlighted class.

• Expand toggle key: To expand the tab window.

• Tooltip: If an attribute form is present, you can hover over the question mark (?) symbol to
see more information in the form of a tooltip.

You can:

• Use the Actions option to perform:

– Import: To import a CSV file to create records in bulk.

– Export CSV Template: Same as: Selecting Export Template, and then selecting CSV.
To export a CSV template.

– Bulk Edit: You must have permission to perform a bulk edit (similar to the same option
in the non-Workflow BP record log).

• Print the log based on the current view. This would output a report similar to a UDR. You
can use the print functionality to print the CM Class log. When you select Print, the system
displays a Print Preview in HTML format.

• The layout of the printed information is based on the view. This means that the column
order, columns displayed, applied filtering conditions, and so on will all be printed. You can
print all pages.
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Note

If you select a record and the record summary is displayed, this information will
not be included as part of the log print.

• Select the order of the columns in the log and define which columns must be visible.

• Sort on one or many columns within the log.

• Search the parameters displayed on the search window have all been configured in
uDesigner. Search user interface and logic is similar to the search function in the non-
Workflow BP record log).

• Group based on one column, or up to 3 columns, and define how the groups are sorted
and how rows are sorted within the groups.

• Apply filters to individual columns.

• Lock columns so that they are fixed on the left side and the remaining columns scroll on
the right side.

• The Help option to view the CM Class specific help, which has been set up by the
Administrator. The tool tips for this icon are:

– <Class Name> help

– User Productivity Kit

• Use the gear menu ( ) for each record to:

– Open: To open a record.

– Copy: To copy a record.

– Print-HTML

– Print-PDF

– Print-Custom

The system default for viewing Code and Records-based records is All Records. Your other
options are:

• Records Created by Me

• Create New View: You can create views by selecting the Create New View option. Similar
to the Tasks log view creation, the New View window has the following tabs:

– Columns

– Filters

– Group By

– Sort By

• Manage Views: Use Manage Views to manage the user-defined views and the default out-
of-the-box (OOTB) views.
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Note

– The system uses the Classic View of the log (of the CM class) for the view
definition.

– Certain restrictions are placed for the view options provided OOTB.

The views, based on the designs, provide the following information:

Columns: The column layout, based on the uDesigner layout.

Sort By: Based on the Sort Order, in the uDesigner Sort Order.

Find: All search parameters in the Find are in the Filter page of the view.

Navigation: Standard view does not display the navigation structure elements that are defined
in uDesigner.

CM Class Record

You view the CM Class record summary from the logs.

Visibility of the panel

The Panel is displayed when you select a record.

The details in the panel are available only when a single record is selected.

When multiple records are selected, the panel displays the following content:

Details of multiple records cannot be viewed.

Content displayed in the Panel

The detail form of the CM Class attribute.

The Panel consists of one tab: Record Details.

Use maximize option to view the record details in the full screen mode. When the full screen
mode is active, the screen occupies the right section. Select minimize to return to the previous
screen.

The record details contain the layout, block description, and so on. This option is available in
View only mode.

The picker type fields are displayed with just the values. There will be no hyperlinks. Select
maximize to view this in an expanded form.

Group By row highlighted

When Group By row is highlighted, the right section does not display any details.

When you select the CM Class log, a log similar to the log of a non-Workflow BP record
appears. You can double-click a record to open it. The following explains the log options.

Columns

As set of predesigned columns and labels. You can adjust the columns in the log as follows:

• Visibility: Right-click the column header and select to hide the column.

• Reposition: Drag and drop.

• Resize: The system keeps your adjustments without saving.
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• Locking: Use the view option.

Note

When you adjust the columns in the log, you modify the view settings. The system
does not save your view automatically, except where it is noted. You can save the
view using the "Save as" option. The application saves the column width
adjustments that are made on top of the default settings (in uDesigner); however,
you can change the width of a column.

The column marked with the "x" icon captures the errors if you attempt to save the grid with
incorrect entries. This function is similar to the errors column in the BP Detail Form grid entry.

Row Number: This is a read-only column. This column does not have a header. As you insert
new rows, delete rows, or reorders rows, the row numbers throughout the grid gets updated
accordingly.

Segment Source: This is an editable, type-ahead and drop-down field. The drop-down values
are the same as in the Classic View.

Delete Row: This column does not have a header. This column displays a delete icon for each
row. Selecting the icon deletes the selected row.

Drag Row: This column does not have a header. This column displays the reorder icon. You
can select multiple rows and drag them to another position.

Creating a Code and Records-based Configurable Manager Sheet (Standard View)

You can use the Create option to create a Code and Records-based manager sheet:

• Manually: Read the process for manually creating a sheet, below.

• From Template: This option enables you to create a configurable manager from a
template. The From Template option is available only if one or more configurable manager
templates are defined at Company Workspace (Admin mode).

• From Shell: When you select this option, the system opens a window which lists all the
shells that the administrator has created. You can copy a configurable manager sheet from
a shell that is listed.

To create a Code and Records-based sheet manually:

1. Select Create, and select Manual to open the create sheet window.

2. In the overlay, enter the values. You can also edit existing values in the Properties tab, for
example, change the Picker field value from All Records to records with their statuses set
as "Active," "InActive," or both in the Records with statuses field.
The Default Filter View drop-down field does not have any values when you create a new
sheet. This field has a value for an existing sheet and can be changed.

3. When finished, from the top, select Save.

4. Select Save on the create sheet window.

You can use the Create option to create a Code and Records-based class.

Bulk Editing Configurable Manager Records
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If you have many records that need the same edits, you can use Bulk Edit to update all the
records at once. You can update up to 200 records at a time. Bulk editing must be defined in
uDesigner, and you must have the Allow Bulk Edit permission set for the manager.

Note

You cannot bulk edit codes or names.

To update records using bulk edit:

1. Navigate to the Configurable Manager log.

2. Select one or more records or use Find to search for a group of records with specific
criteria. You can select the records from the class log or the Find log.

3. From the Edit menu, select Bulk Edit. The Bulk Edit window opens. The fields displayed
depend on what is specified in uDesigner for detail form integration for the class.

Note

Bulk edits overwrite data without asking you to verify each change. Be sure that
you have entered the data you want to edit correctly.

4. The Bulk Edit form includes all editable fields for the detail form. Modify the Bulk Edit form
as needed.

5. Select the Update checkbox for the fields that you want to update. The checkbox is
automatically selected when you type in a field. You can deselect it if you do not want to
modify the field.

6. To start the bulk update of the selected records, select Update. The Bulk Actions Status
window displays the progress of the update.

7. Select OK after all records have processed. Select Cancel if you want to cancel the bulk
update in progress.

Printing a Configurable Manager Form

You can print a copy of the record form for Code-based manager and record-based manager.
You can choose PDF, HTML or Custom print formats and select one of the following options:

• Save a copy of the form as a PDF file and print the file

• Print an HTML view

• Print from a Word file if a custom print layout has been created for the form

The Custom Print formats include the Oracle Analytics Server custom print templates designed
in the Custom Templates node. If custom print layouts have been created for the Configurable
Manager, the form will print according to the layout that you select. For more information, see 
Printing Options - Custom Format.

To preview and print a Configurable Managers form:

1. Open a Configurable Managers record that you want to print.

2. From the File menu, choose Print Preview, and then choose one of the following:
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• HTML to view the form in the browser which can then be printed.

• PDF to open the form in Adobe Reader, which can be saved or emailed as a PDF file,
or printed process, you are asked to save the changes to the form.

• Custom to select the Oracle Analytics Server, Microsoft Word, and PDF custom print
templates from the same place as the current custom prints. For more information, see 
Printing Options - Custom Format.

The Print Options window opens. This window displays the record information that can be
printed.

3. Select the checkboxes for the information that you want to print.

4. To select all the checkboxes, click Select All. To clear all, clear Select All. If you deselect
all checkboxes, only the header and footer will print.

5. Select OK. The preview form opens in an HTML or PDF (Adobe Acrobat or Reader)
window, from which you can print.
If you chose PDF, you can save a copy or print it. To print from HTML format, select Print
in the upper-right corner.

Print Options for Configurable Manager Form

The following summarizes print options.

Print option What it prints

Detail Form This prints the information entered on the form.
General Comments The general comment text and create details are printed.
Record Attachments File attachments to the record are listed alphabetically

by file name and include the file title, issue date,
revision number, and file size.

Note

For Oracle Analytics Server
template the sorting is done in
the template; as a result, the
alphabetical list of file names
may not always apply.

Record Attachments followed by Comments Prints comments associated with file attachments to the
record. "Record Attachments" must also be selected to
select this option.

Record Attachments followed by Comments followed by
Attachments

File attachments attached to the comment are listed and
contain the file title, issue date, revision number, and
file size.

To print a Configurable Managers form with a custom print layout:

1. Open the form that you want to print. Be sure it is in a view mode.

2. From the File menu, choose Print Preview, and then choose Custom to select the Oracle
Analytics Server , Microsoft Word, or PDF custom print templates from the same place as
the current custom prints (Custom Format Print selection window).

3. Select a layout, and select Ok. The File Download window opens.
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Note

• In case of the Oracle Analytics Server templates, you can select an output
format and based on that selected output format the output file is generated.
The output file appears in a new window.

• In case of the PDF format, the output is a .pdf file and is displayed in a new
window and save.

• In case of the RTF format, the output is a .rtf file and you can open the .rtf file
with Microsoft Word and save.

• In case of the Excel format, the output is an .xls file and you can open the .xls
file with Microsoft Excel and save.

Custom Format Print Options for Configurable Manager

The Custom Format Print Window for non-Workflow Configurable Manager forms has two
sections:

• Select a custom print template

• Select a template and format to print

Both sections facilitate custom print template and format selections.

Select a custom print template

Lists all the custom print templates existing for the non-Workflow Configurable Manager forms,
including the custom print templates created in the Custom Templates node and the custom
print templates created in the configuration of the non-Workflow Configurable Manager forms.
For example, the list may include Oracle Analytics Server custom print templates, Word, and
PDF custom print templates.

If there are multiple custom print templates for the same non-Workflow Configurable Manager
forms, all the published templates are listed in this section.

The "Select a template and format to print" is populated by the selection made in the "Select a
custom print template" section.

Select a template and format to print

• If you select an Oracle Analytics Server custom print, you can select the desired template
and format from the drop-down lists.

• Template drop-down displays all the available templates for the selected format.

• Format drop-down displays the available formats for the selected template.

• If the custom print template was created using PDF or Word, the "Select a template and
format to print" is disabled.

Default template and format (non-Workflow)

• If an Oracle Analytics Server print template is selected, the default values in the drop-down
lists are set based on the default in the custom print template.

• When an Oracle Analytics Server print template is selected in the "Select a custom print
template" section, the template and format are populated based on the default value
selected at the time of designing the print template.
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Custom Format Print Window for Workflow Configurable Manager forms

If there is only one custom print template and it is an Oracle Analytics Server template, the
print template is selected in the “Select a custom print template” section, and the template and
format are populated based on the default value selected at the time of designing the print
template.

The Custom Format Print window has three sections for Workflow Configurable Manager
forms.

• Select a custom print template

• Select a template and format to print

• Select options for Workflow Progress

By default, when the Custom Format Print window is launched, all three sections are enabled
and the first template is selected. The options seen in the subsequent sections are based on
the selection made in the "Select a custom print template" section.

You can select options for workflow progress in the 'Select options for Workflow Progress"
section of the Custom Format Print window for PDF and Word templates, which are created at
the time of configuring the Workflow Configurable Manager forms.

If the selected custom print template is of an Oracle Analytics Server type, the “Select options
for Workflow Progress” section is disabled. This is because the custom print template
designers can always use the system provided Workflow views to include workflow-related
information in the template.

Default template and format (Workflow)

• When an Oracle Analytics Server print template is selected in the "Select a custom print
template" section, the "Select a template and format to print" section is populated based on
the default value selected at the time of designing the print template.

• If there is only one custom print template and it is an Oracle Analytics Server template, the
print template is selected in the “Select a custom print template” section, and the template
and format is populated based on the default value selected at the time of designing the
print template.

Cost Manager
The Cost Manager module or grouping node lets you work with the following features, which
are presented as sub-modules or functional nodes:

• Cash Flow

• Cost Sheet

• Schedule of Values (SOV)

• Funding Sheet

• Commitment Funding Sheet

The following topics provide details for each feature and explain other features that are related
to the Cost Manager.

Cash Flow
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The term "cash flow" refers to:

• The movement of money in or out of a project (or business) during a specific time period.

• The movement of money in or out of a company in regard to a specific existing project, or
shell, during a specific time period.

• The distribution of cost over time.

In the context of capital projects, cash flow is the estimating of future spends to be incurred on
a project, based on current Actuals (or "spends).

The term cash flow is synonymous with cash flow forecasting, Actuals (or "spends")
forecasting, and time-phasing of budget, which all refer to the availability of proper funding in
each future period (month, quarter, or year).

Cash flow management includes the following steps:

1. Establishing a baseline spending plan: Baseline

2. Tracking actual costs: Actuals

3. Calculating future expenditures based on project schedules: Forecast

Note

Cash flow forecasting is used to ensure that cash is available when payments are
due.

The Cash Flow module lets you create the following curves and compare them on one cash
flow worksheet:

• Baseline

• Forecast

• Actual (or Spends)

• Portfolio Budget

• Derived

• Custom curves

You can create data source, distribution profiles, and cash flow curve templates to simplify the
creation of cash flow in multiple projects/shells.

If you do not select a distribution profile, the system uses the default distribution profile, when
you refresh the curve. If you remove the default distribution profile during a CSV curve setup
for import, the system uses the default distribution profile that was selected in the curve
properties.

Administrators can set up Base Commit business processes to automatically create cash flow
curves for the commitment record at a particular workflow step, or for non-workflow business
processes, when the record is complete.

The following defines the three most common, and important, standard cash flow types:

• Baseline

• Actuals (or Spends)

• Forecast
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Baseline

The Baseline is defined as:

• The time-phased distribution of the project budget over the project duration.

• The project budget distributed over the duration of the project, indicating how the budget
might be spent.

A project can have multiple Baselines (original, revised, and so on).

Actuals (Spends)

The Actuals (Spends) is defined as:

• The spends that have actually been incurred (approved invoices, or in some cases,
accruals).

Note

Spends is defined as periodic outlay of money, tracked per CBS.

• The project spending which includes actual invoices received for each period.

The Actuals (Spends) can be compared to baseline budget to maintain budgetary control.

Forecast

The Forecast is defined as:

• The time-phased distribution of the project forecast, from the latest Actuals (Spends).

• The expected spends for the future.

The start point of a Forecast curve is the end of the latest Actuals (Spends), and the end
point is the total forecast.

You can use cash flow forecasting to ensure that cash is available when payments are due.

Forecast is updated as new actuals are incurred.

You can create cash flow at multiple levels in a project to:

• Track cash flow for the entire project/shell: Project/Shell

• Track the costs associated with summary CBS code: Summary CBS

Note

If you select this option, the system sets the Summary CBS Level to 1 by default.
You can select another level, based on what is available in the Cost Sheet.

• Track cash flow at the CBS code level, across all or specific CBS code: CBS

• Track cash flow data for an entire commit record, including Base Commit, Change Commit,
and related invoice: Commitment
Base Commit and Change Commit are Commitments BPs which are sub-types of Cost-
type BP.
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Cash Flow Curves

Cash flow curves are graphical presentations of the expenditures or spends. Cash flow curves
enable you to:

• Pull data from cost sheets, business process records, or schedule sheets

• Record cash flow history by way of using snapshots

• Generate cash flow curve reports

The cash flow management steps (Baseline, Actuals or Spends, and Forecast) can be
displayed as Cash flow curves in the system.

The following lists the cash flow curves types:

1. Detail Curves: Cost per period.

2. Rollup Curves: Each period includes sum of all previous periods.

3. Summary Curves: Each project/shell cash flow has a system defined project/shell
summary curve.

Cash Flow Curves and Data Sources, Types, Distribution Profiles, Detail curve
templates, and Roll up curve templates Options

A cash flow curve requires a data source which your administrator can create in the Standards
& Libraries node.

Data Sources

Used to identify cash flow curves and Roll up data to the company worksheets. Multiple data
sources can be defined per curve type, depending upon business needs. Example: “Original
baseline and Current baseline” data sources can be defined for type “Baseline”. For roll ups,
curves are summarized across data sources.

Curve Types

Used with pre-defined categories of cash flow curves for:

• Baseline

• Forecast

• Actual (or Spends)

• Portfolio Budget

• Derived

• Custom

Each curve type has its own logic to address different business requirements.

Distribution Profiles

Used to distribute data automatically in the cash flow worksheet.

Detail curve templates

Cash flow curves can be created either manually or from a template.

Cash flow templates are created in Company Workspace from project templates and are used
to create cash flow worksheets.
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Roll up curve templates

Used to create curves that roll up cash flow data from projects/shells.

Cash Flow Curves Types

The following explains each of the cash flow curves types in detail.

Detail Curves

The Detail Curves are referred to a family of curves that can be defined at the project/shell
level, or at the company level.

Each curve, within the family, is based on a data source (one curve per unique data source).

A cash flow curve of type Detail Curves is a curve that is used to monitor the movement of
cash at different detail levels in a project/shell.

The cash flow (Detail Curves) levels in a project/shell are:

• Project/Shell

• Commitment

• CBS

• Summary CBS

Note

If you select Summary CBS, the system sets the Summary CBS Level to 1 by
default. You can select another level, based on what is available in the Cost
Sheet.

As mentioned earlier, you can specify the following cash flow types for each detail level in a
project.

Note

The first three cash flow types in the list below are the three most common, and
important, standard cash flow types.

Baseline

Depicts the project budget that is spread over the duration of the project. Users can define
multiple baselines for a project.

Actuals (Spends)

Depicts the expenditures (spends) that have actually incurred.

Forecast

Depicts the projection of the future costs, based on current expenditures (Actuals or Spends).

Portfolio Budget
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Depicts the Baseline curve, or Forecast curve, used for portfolio optimization scenarios in the
Portfolio Manager.

Derived

Depicts the Baseline curve, or Forecast curve, used for portfolio optimization scenarios in the
Portfolio Manager.

The Derived curve is used to convert the sources currencies to a currency used by the
Portfolio Budget curve.

Custom

Depicts cost data other than Baseline, Actuals, and so on.

The Custom curves can include any other cost data that you want to view graphically.

Roll up Cashflow Curve (Rollup Curves)

A Roll up Cashflow curve includes a group of curves with Active status summarized by data
source across all projects/shells in a company.

A Roll up Cashflow curve facilitates the aggregation of cash flow data source (from projects/
shells and CBS) to the company cash flow worksheets.

Note

A Roll up Cashflow curve can only be created at company levels.

You can compare curves side-by-side, in the cash flow worksheet, to view cash flow
distribution over time.

Summary Curves or Summary Cash Flow Curves

A summary cash flow curve is designed to present a consolidated view of cash flows, and each
project/shell cash flow has a system-defined project/shell summary curve. A summary cash
flow curve:

• Uses the detail cash flow curves to compare the movement of curves against the previous
snapshots, and in the process show differences among curves with respect to time and
schedule.

• Displays Variance and Forecast analyses, similar to the detail cash flow curves.

Cash Flow Worksheets

You can use cash flow worksheets to define and manage:

• Project/Shell level cash flow detail curves (listed under Detail Curves in project/shell Cash
Flow log) and

• Company level Roll up Cashflow curves (listed in the company Cash Flow log).

The following descriptions applies to both the project/shell and Company levels cash flow
worksheets.
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Note

The cash flow worksheet (Standard View) shows a blank page on the Safari browser.

The cash flow worksheet is generated automatically after you define the properties for a new
cash flow curve.

The system collects data from various managers and displays it in the cash flow curves. As a
result, the curve options (for example, data sources and distribution selections) determine the
appearance of a curve in a Flow worksheet.

The cash flow worksheet displays a graph and each curve listed has its own data set. You can
select the curve name to open the window for the curve to view the contents. Depending on
the curve set up, you can manage the curve data in that window.

Each part of the cash flow worksheet can be individually maximized. Additional options let you
filter the information on the cash flow worksheet to display selected curves and to print the
worksheet or both.

Transaction Currency in Cash Flow Curves

Introduction to Transaction Currency

When your Company Administrator signs into the system the first time, that person specifies
the Base Currency, which becomes the default project currency for each project/shell.

When you create a project/shell, you can change the default project currency to any currency
listed in the company-level exchange rate table.

Note

After creating your project/shell, you can add additional currencies to your project/shell
as needed.

Depending on the Commitment BP design, during record creation you can select a transaction
currency from the list of available currencies in your project/shell. The system stores costs in
the project currency and uses the active company level exchange rate table for currency
conversion.

Transaction Currency in Cash Flow Curves

In the Project/Shell, Summary CBS, and CBS cash flow curves, the system displays cash
flow costs in the project currency.

By default, the system displays Commitment curve cost data in the record transaction currency,
which is stored in project currency, using the active currency exchange rate table.

As a result:

• If the transaction currency is different from the project currency, you can change the
currency view between transaction and project currencies, but you can only edit data in the
transaction currency.
The summary curve displays 0 (zero), if:

1. The transaction currency is different from the project currency, and
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2. No exchange rate has been defined.

• If there is a more recent value in the exchange rate table, refreshing the curve will refresh
the cost data.

• If the transaction currency is different from the project currency, the system conducts the
exchange rate conversion before rendering the Summary Curves cash flows.

• If the base currency is the only currency used in the company, the system does not
conduct the exchange rate conversion, and the Summary Curves cash flows show the
Summary Curves cash flows in project currency which is the same as the base currency.

Switching Between Transaction and Project Currency in Cash Flow Curves

To switch between transaction currency and project currency in a cash flow worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log and double-click the curve to open the cash flow worksheet
window. By default, the worksheet opens in the transaction currency if different from
project currency.

4. Use the drop-down currency menu located at the top-center of the worksheet to change
currency views. If the transaction currency and the project currency are the same, you will
not see the drop-down field. The numbers and curve refresh to display the new currency
values.

5. In the cash flow window curves list, located on the bottom portion of the window, select a
curve and open the curve details window.
If you selected the project currency view before opening the curve details window, and the
curve is in transaction currency, the data will be read only.

6. In the details window use the currency menu to switch to the transaction currency.
Depending upon the curve set up, you can manually enter data or change the
automatically distribution profile.

7. When finished, select Save. The cash flow window will refresh with changes.

Project or Shell Level Cash Flow

Project/shell level cash flow curves are curves that are defined at the project/shell level.

Note

If you are working in a project/shell, the Cash Flow log displays cash flow Detail
Curves. If you are working in a company (User mode), the log displays the company
level Roll up Cashflow curves.

Project or Shell Level Cash Flow Log

The Cash Flow log is the starting place for cash flow operations.

To access the Cash Flow log:

1. Go to the shell tab, and switch to User mode.
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2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

Note

If you are working in a project/shell, the Cash Flow log displays cash flow Detail
Curves. If you are working in a Company (User mode), the log displays the company-
level Roll up Cashflow curves.

The project/shell Cash Flow log is divided into the following sections, as shown in the following
typical screen capture:

• Title

• Toolbar

• Log

• Properties tabs. The Properties tabs include Preview, Permissions, Schedule, and History.

When you select a record (curve) on the Cash Flow log:

1. The log view splits in half to display the properties of the selected curve, on the right.

2. The gear menu ( ) becomes active.

The following provides more details about the properties of the selected curve, and the gear
menu options.

Properties of the selected curve

When you select a record (curve) on the Cash Flow log, the log view splits in half, and the
right pane displays the following tabs which collectively show the properties of the selected
curve, if available:

Preview

A preview of the Actuals, Baseline, or Forecast cash flow curve.

Permissions
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Groups, users, and permissions that have been assigned to the cash flow are displayed on this
tab. You can grant cash flow curves viewing and usage permissions to other users, within this
tab.

Schedule

Information about the refresh condition, scheduled runs, schedule frequency, and range of
recurrence.

History

A history log of all data updates or refresh requests (manual and scheduled). The history log
contains the requestor's name, the start and end dates and times, and the status for each
detail curve.

Gear menu ( ) of a selected curve

When you select a record (curve) on the Cash Flow log, the gear menu becomes active.

For Detail Curves, the gear menu lets you conduct the following on the selected curve:

Open

To open a curve.

Copy

To copy a curve.

When you select Copy, the New Cash Flow Worksheet window opens with the options and
values within this window pre-populated by way of information in the Properties of the source
curve. The Name field in this window will be prefixed with "Copy of." You can make changes as
needed and select Save & Close to complete creation of the cash flow curve and add it to the
log.

Delete

To delete existing cash flow curves. When you select one or more curves (cash flow detail
curves or summary cash flow curves) and select Delete, if you select, Yes in the resulting
window, the selected cash flow detail curves will be deleted.

Refresh Now

Refresh Data has three states: Refresh Now, In Progress, and Refresh Complete.

Rollup Status

A single menu option with two sub-options:

• Active

• Inactive

To manage cash flow curves roll up status. It controls whether the cash flow data from the
current project/shell is rolled up to the company cash flow curves.

This option only applies to the Detail Curves, and it will be blank for the Summary Curves.

Permissions

To set, or modify, user permissions applicable to the curve.

Properties

To open the Cash Flow Properties window.
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Note

When you highlight more than one detail curve (multiple detail curves) on the log, the
gear menu lets you access View Summary. This option lets you open the Summary
window and see a summary curve for all selected curves. You can use the Snapshot
menu (upper-right corner of the window) to Create Snapshot or Save Summary
Curve.

For Summary Curves, the gear menu ( ) lets you conduct the following on the selected curve:

Open

To open a summary curve.

Copy

To copy a summary curve.

Project or Shell Level Cash Flow Log Toolbar Options

The Cash Flow log has the following toolbar options:

Create

This drop-down field has the following options:

• Manual: Lets you create a cash flow worksheet manually.

• From Template: Lets you open the Cashflow Templates window, select a cash flow
template, and create a cash flow worksheet from the selected template.

• Summary Curve: Lets you create a summary curve.

Actions

This drop-down field has the following options:

• Refresh Now: Select one or several curves on the log, and select Refresh Now to update
the curve details. The refresh process may take some time. Refresh data has three states:
Refresh Now, In Progress, and Refresh Complete including date and time. A check mark
will be visible for curves that have been refreshed.

• Rollup Status: Select one or more curves on the log, and select Rollup Status to mark
them as Active or Inactive, for roll up purposes.

• Permissions: Select one or several curves on the log, and select Permissions to open
the Permissions window and add or modify permissions.

• Delete: Select one or several curves on the log, and select Delete to create a summary
curve.

• Manage Distribution Profiles: This action is not related to cash flow list. The Manage
Distribution Profiles option lets you examine various distributions of cost, or any value, over
a period of time, in a project/shell. The Manage Distribution Profiles option lets you open
the Edit Distribution Profiles window and create, copy, or delete distribution profiles, for
your project/shell.

View

This drop-down field has the following options:
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• All Curves: This option lets you display all the available curves on the log.

• Group by Type: This option lets you display all the available curves under the following
groups:

– Detail Curves

– Summary Curves

• <custom view>: Any custom view.

• Create New View: This option lets you open the New View window and create a view for
the Cash Flow log.

• Manage Views: To open the Manage Views window and move the order of the current
views, make a particular view visible or invisible, or delete a view.

Edit View

This option lets you open the Edit View window and update the selected log view by
determining available columns, applying filters, and grouping and sorting on the following tabs:

• Columns

• Filters

• Group By

• Sort By

When finished, select Apply, and then select Save As to save your view.

Refresh

This option lets you update the data in all the curves that appear on the Cash Flow log. The
refresh has three states: Refresh Now, In Progress, and Refresh Complete which includes the
date and time. For more information, see Refreshing Data in Cash Flow Log.

Print

This option lets you print the list of curves displayed (Print), export the list of curves displayed
to an external file (Export to CSV or Export to Excel).

Note

• For export to Microsoft Excel, the system currently supports only Euro (EUR) and
United States Dollar (USD) currency symbols.

• If you export data from a business process (BP) record, sheet (such as an Activity
Sheet), or log (such as Company Funding Sheet Log) to Excel, be aware that
depending on how your negative values are formatted, you might need to
configure your columns in Excel to match the correct data type (Number).
Otherwise, the columns will not be treated as numeric and will not sum as
expected. One supported format includes placing the negative sign between the
currency symbol and the amount (for example, $-1,000).

Find on Page

This option lets you open a row on top of the rows within the log and enter values in each
column to start a search for a specific curve in the log.
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Managing Distribution Profiles

Distribution Profiles

When working with templates (versus detail curves) in a project/shell, the distribution profiles
can be:

• Created in Admin mode (in Standards & Libraries).

• Used when selecting auto distribution for curves.

At runtime, you can create additional distribution profiles within the project's cash flow module.
When working with curves, you can apply the profiles created in Admin mode, or in the project/
shell.

Note

If you are creating a project/shell from a project/shell template, and you are copying
the Cash Flow module, the project/shell template properties and permissions will be
copied into the new project/shell.

Creating and Managing Distribution Profiles

Administrators can create a library of distribution profiles in the Company Workspace (Admin
mode), Standards & Libraries. In addition to these profiles, you may also want to create
additional distribution profiles in a project/shell. At runtime, when you select a distribution
profile, you will see the list of profiles created in Admin mode, as well as the ones created in
User mode.

To add a distribution profile in a project/shell:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the toolbar, select Actions and select Manage Distribution Profiles. The Edit
Distribution Profiles window opens.

4. Edit and manage distribution profiles in this window in the same way as the default
distribution profiles created in Admin mode.
For more information, see Create a Cash Flow Distribution Profile.

Creating a View and Managing an Existing View in the Cash Flow Log

To create a view in the Cash Flow log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the View menu, select Create New View.

4. In the View Name field of the New View window, enter a name for the new view.

5. Set the other view parameters in the following tabs:
Columns
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Filters

Group By

Sort By

6. To save your changes, select Save.

To manage a view in the Cash Flow log View:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the View drop-down menu, select Manage Views to open the Manage Views
window.

Note

The Cash Flow log views will be shared across templates and shells.

Provided that you have pertinent permissions, in the Manage Views window you can:

• Move the order of the views in the View menu on the toolbar.

• Make a particular view visible to the user.

• Delete a particular view.

The current view is marked with a green check mark in the Manage Views window. To save
your changes, select Save. To discard your changes, or to close the window, select Cancel.

Refreshing Data in Cash Flow Log

What does refresh do?

When you select Refresh, the system checks:

• To see if there are any new spends records that are not part of the curve. Depending on
Period Close settings, the spends record is added to the correct period, and therefore,
changes in values will appear for Spends curves and for Forecast curves that consider
spends records.

• To see if a distribution profile definition has changed, either in Admin mode, or in the
project/shell. Any changes will be applied to the curve.

• To see if dates are based on master schedule sheet, checks to see if values have changed
in the schedule sheet.

• For a curve in the auto mode, refresh distributes unassigned values automatically.

• For errors, such as not selecting a valid business process record or cost column, or
missing data such as a blank schedule sheet date column. The error alert will display in
red font on the worksheet (below the curve section). Select the error to view the reason.

Refresh also checks for changes to CBS structure.

What happens to unassigned fields, when you refresh?

If there is a value in the Unassigned field, hover over or select the field. The reason for the
value is displayed. For example:
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• Excess or deficit because of Spends (invoice) records

• Incoming Change Orders

• For Forecast curves with option to start at the end of Actuals (Spends amount), the amount
is put in the Unassigned field if the To Date of the forecast curve is less than effective date
of a Spends value.

Read the following topics for information about scheduling auto refresh.

You can update (refresh) cash flow curves data:

• Manually

• Automatically

How do you refresh cash flow curves manually?

The following shows the various ways that you can manually update (refresh) data that
appears on the cash flow curves.

To refresh the contents of the Cash Flow log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the toolbar, select the Refresh icon to refresh the contents of the log.

To refresh the contents of the cash flow curves in the Cash Flow log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select one or more cash flow curves from the log.

4. Select the gear menu ( ) and select Refresh Now.

To refresh the contents of the cash flow worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log and double-click the curve to open the cash flow worksheet
window.

4. From the toolbar, select the Refresh icon to refresh the contents of the worksheet window.

How do you refresh cash flow curves automatically?

The following shows how you can set up a schedule to automatically update (refresh) data that
appears on the cash flow curves.

To set up a schedule to automatically update (refresh) data that appears on the cash flow
curves, you must set the cash flow curve auto-refresh schedule. To do so:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select one or more cash flow curves from the log.
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4. On the properties pane (right side), select the Schedule tab.

5. Proceed to complete the fields to schedule the refresh runs, frequency, and range of
recurrence.
Selecting the Enable Refresh option will automatically update (refresh) data that appears
on the selected cash flow curves.

Working with Project or Shell Level Snapshots and Audit Log

A snapshot displays the graph, curves, and curve data on the worksheet. Snapshots are not
editable. You can take a snapshot and view it in project, transaction currencies, and reports.
You can manually save a snapshot of a cash flow curve at any time.

When you open a detail curve (a cash flow worksheet) from project/shell Cash Flow log, you

can select Snapshot  from the toolbar and access the following options:

Option Description

Create Snapshot Use this option to create, or to take a snapshot of a cash
flow curve, at any time.

Snapshot Log Use this option to view, open, or delete the snapshots
that have been created or taken of a cash flow curve.
The Title, Creator, and Created on data is also provided
on this window.

Audit Log Use this option to access a record of the details such as
Date, Event, Action, User Name, and so on, about the
cash flow curve.
You can use the Audit Log toolbar options to refresh the
list, print the list, and find items in the list of log items.

Properties Use this option to open the Cash Flow Properties
window.
The function of the Properties option in the Snapshot
menu  is identical to the function of the Properties
option of the gear menu ( ) next to a cash flow curve in
the Cash Flow log.
In the Cash Flow Properties window, select More
Options to open the More Options window and set the
following parameters for your snapshot in the Period
Close Settings tab:
• Enable auto snapshot
• Cut off Spends
• Apply spends to
The More Options window also lets you add the cash
flow curve to selected summary curves, in the
Summary tab:
• Available: This block shows a list of available

summaries.
• Selected: This block will contain your selected

summary.
Finally, in the More Options window, you can set the
number of decimals or opt to use currency decimal
precision, in the Decimal Options tab.

To take a snapshot at any time:

1. Open your cash flow curve.
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2. From the toolbar, select Snapshot , and select Create Snapshot. The Create
Snapshot window opens. The window also displays the time stamp of the snapshot for
reference.

3. Enter a title for your snapshot, in the Title field, and select OK.

To schedule an automatic snapshot:

1. Open your cash flow worksheet or curve.

2. From the toolbar, select Snapshot , and select Properties.

3. In the Cash Flow Properties window, select More Options to open the More Options
window and set the following parameters for your snapshot in the Period Close Settings
tab:

• Enable auto snapshot

• Cut off Spends

• Apply spends to

Note

– After taking an auto-snapshot, the system immediately refreshes the cash
flow curve. Spends will resume after the auto-snapshot.

– Because your organization might have multiple cash flow jobs and
automatic snapshots scheduled to run for a multitude of projects, your
administrator can use the Cash Flow Jobs functional node to manage the
jobs and auto-snapshots and their impact on system performance. For
more information, see the Unifier General Administration Guide.

To view a created snapshot:

1. Open the cash flow curve.

2. From the toolbar, select Snapshot , and select Snapshot Log.

3. In the Snapshot Log, choose a snapshot to view and double-click the snapshot to open
the cash flow curve or worksheet snapshot.

4. Maximize the window to be able to identify the following elements:

• Top block: Containing cost-related at-glance numeric data as well as detailed
information, when you select Show More.

• Bottom block: Containing curves corresponding to the cost periods and variances.

• Screen split : Select the icon and drag to expand the window. You can use the
Expand and Dock icons (upper-right corner) to adjust this screen. This screen lets you
access detailed information for actuals, baseline, forecast, and most other interactive
elements, but the snapshot data is not editable.

To search for a snapshot:

1. Open the cash flow worksheet.

2. From the toolbar, select Snapshot , and select Snapshot Log.

3. In the Snapshot Log, select Find on Page to open the find box for each column (Title,
Creator, and Created On).
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4. Proceed to enter a value in one or all the boxes to search and find your desired snapshot.

5. To restore the entire list, select Find on Page.

To delete a snapshot:

1. Open the cash flow worksheet.

2. From the toolbar, select Snapshot , and select Snapshot Log.

3. In the Snapshot Log, select a snapshot, select Delete, and follow the prompts.

To print a snapshot:

1. Open the cash flow worksheet.

2. From the toolbar, select Snapshot  , and select Snapshot Log.

3. From the toolbar, select Print , and select one of the following options:

• Print: To open a window that lets you select a method to print the selected curves.

• Export To CSV: To open a dialog box that lets you save a Microsoft Excel Comma
Separated Values (CSV) File version of the selected curves, so you can export the file
to a desired destination.

• Export To Excel: To open a dialog box that lets you save a Microsoft Excel Worksheet
version of the selected curves, so you can export the file to a desired destination.

Note

– For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

– If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

Project or Shell Level Cash Flow Log Columns

The Cash Flow log has the following columns options:

• Refresh Data (  ): To update each curve data and view the refresh status. The refresh
actions apply to Detail Curves and not to Summary Curves.

• Name: Name of the curve.

• Description: Description for the curve.

• Detail Level: This option applies to Detail Curves only and will be blank for Summary
Curves.

• Type: Type of the curve.

• Last Refreshed: Date when the curve received the most up-to-date information.
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• Summary Status: Summary Curve status. As the label suggests, the Summary Status
column applies to Summary Curves and not to Detail Curves. This column should be blank
for Detail Curves.

• Time Scale: The time taken by the process. This option applies to Detail Curves only and
will be blank for Summary Curves.

• Rollup Status: This option controls whether the cash flow data from the current project/
shell is rolled up to the Company cash flow curves. This option applies to Detail Curves
only and will be blank for Summary Curves. You can change the roll up status of one or
more curves. To activate or deactivate the roll up status, select Active or Inactive.

• Last Saved: The date the cash flow curve properties were last updated and saved. This
option applies to Detail Curves only and will be blank for Summary Curves.

• Auto Refresh: A detail cash flow curve can be set up to refresh automatically as per a
schedule. This column shows the auto-refresh frequency, if the curve has been set up for
the same, else, it shows as blank. This option applies to Detail Curves only and will be
blank for Summary Curves.

Project or Shell Level Cash Flow Worksheet

To open a project/shell cash flow worksheet for an existing curve:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow.

3. In the Cash Flow log, double-click the applicable curve to open the cash flow worksheet
window.

The project/shell cash flow worksheet is divided into the following sections, as shown in the
following typical screen capture:

• Title

• Toolbar

• Cash Flow Overview

• Graphic View

• Cash Flow Details

The cash flow worksheet window is divided into the following parts, as highlighted in the
following screen capture, and each part can be individually maximized.
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The following explains each part in detail.

Project or Shell Level Cash Flow Worksheet Toolbar Options

The toolbar section of the project/shell cash flow worksheet displays the worksheet title and the
following toolbar options:

• View: Use this option to Create New View for the worksheet or to Manage Views that
have been created.
If your administrator defined global views in a Cash Flow template and pushed them to
your project/shell, these views are also listed in the View menu of your cash flow
worksheet. (One of the views might also be used to define the Default view in the
template.) You can use these predefined views to create additional custom views and you
can change the order of the views. You cannot edit or delete the predefined views.

• Edit View: When you select Edit View, the Edit View window for the current view opens.
In this window, you can select the curves that you want to view on the log (for Curves,
Inflow, and Outflow). You can also add columns and group your columns when you select
the Group By tab and use the Filters tab to filter the CBS rows based on code segments
or cost attributes. The Filters tab in Views is available for the By CBS and Summary CBS
type of cash flows.

• Print: Use this option to open your browser's print options for the worksheet.

• Refresh: This option lets you update the data in all the curves that appear on the Cash
Flow log. The refresh has three states: Refresh Now, In Progress, and Refresh Complete,
which includes the date and time. See Refreshing Data in Cash Flow Log.

• Snapshot: This menu contains the following options:

– Create Snapshot: To create a snapshot of the curve.

– Snapshot Log: To view, edit, or delete previous snapshots of the curve.

– Audit Log: To view change details to the curve.

– Properties: To view the properties of the Cash Flow.

For more information, see Working with Project or Shell Level Snapshots and Audit Log.

Creating a View and Managing an Existing View in the Cash Flow Worksheet
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By default, views display as graphs. However, your administrator can create views that display
as a grid or as a split view that shows both a graph and a grid on the same page. Additionally,
your administrator might have chosen to hide the Key Performance Indicator (KPI) section, but
you can use Expand KPI
 

 
to display it.

To create a view in the cash flow worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log, and then select Open from the gear menu (
 

 
) to open the cash flow worksheet window.

4. From the View menu, select Create New View.

5. In the Save View As field of the New View window, enter a name for the new view.

6. From the Default Layout list, select Grid View or Split View (Graph and Grid) if you do
not want to use the default Graph View.

7. To hide the KPI Panel from the view, select the Hide KPI Panel checkbox.

8. Set the other view parameters in the following tabs:

• Curves: In the Curves tab, select curves from the Available Curves list, and select
the Move arrow to add curves to the Selected Curves list, or select the Move All
double arrow to move all available curves to the Selected Curves list. The last column
in the Selected Curves list is not available for locking.

• Inflow: In the Inflow tab, select curves from the Available Curves list, and select the
Move arrow to add curves to the Selected Curves list, or select the Move All double
arrow to move all available curves to the Selected Curves list. The last column in the
Selected Curves list is not available for locking.

• Outflow: In the Outflow tab, select curves from the Available Curves list, and select
the Move arrow to add curves to the Selected Curves list, or select the Move All
double arrow to move all available curves to the Selected Curves list. The last column
in the Selected Curves list is not available for locking.

• Filters: On the Filters tab:

a. Select the Add Filter button.

b. Choose a Data Element: This drop-down list includes all Cost Code Segments
and CBS Attributes. It also includes specific fixed-column items such as Total,
From Date, To Date, and Unassigned.

c. Choose a Condition: This drop-down list displays a list of conditions. This list is
based on the type of data element selected.

d. Choose a Value: Depending on the type of data element, choose a value that the
query condition must meet.
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Note

Currency precision is not adhered to within filters. For example, if your
project currency uses four digits after a decimal point, the entries in the
Value field for a Data Element related to a currency or a decimal amount
or an entry in the Total or Unassigned column selected on the Filters tab
for a view display only two digits after a decimal point.

You can add multiple filters to a view, and you can use the same data element multiple
times. When adding multiple filters, you can use operators to specify that the view
must match all listed filters or that it can match one or more of the listed filters. To add
additional filters, select Add Filter again, repeat the preceding steps, and select the
applicable operator that should apply. You can add up to 15 filters.

– And: If you want to specify that the view must match all listed filters, select And.

– Or: If you want to specify that the view should match any of the listed filters, select
Or.

• Group By: Use the Group By tab to identify which columns should be used for
grouping and in what order. When you use Group By to define a group based on CBS
attributes, the summary row displayed on the final view shows the totals and
distributed costs and–based on the filtered leaf-level rows–the earliest From Date and
most recent To Date.

Note

To minimize the potential performance impact when a detailed, Current Cost
Variance, or At Completion Cost Variance sheet is loaded, Oracle
recommends that you use Data Elements (DEs) on the Group By tab that
create useful groups, such as Type or Roll up Status, and avoid using DEs
such as Cost Code, Code Name, and Cost Type.

9. To save your changes, select Save.

To manage a view in the cash flow worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log, and then select Open from the gear menu (
 

 
) to open the cash flow worksheet window.

4. From the View menu, select Manage Views to open the Manage Views window.

Provided that you have pertinent permissions, in the Manage Views window you can:

• Move the order of the views in the View menu on the toolbar.

• Make a specific view visible or hide it.

• Delete a specific view.
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Note

If your administrator defined global views in a Cash Flow template and pushed them to
your project/shell, these views are also listed in the View menu of your cash flow
worksheet. (One of the views might also be used to define the Default view in the
template.) You can use these predefined views to create additional custom views and
you can change the order of the views. You cannot edit or delete the predefined views.

The current view is marked with a green check mark in the Manage Views window. To save
your changes, select Save. To discard your changes, or to close the window, select Cancel.

Project or Shell Level Cash Flow Worksheet Overview Section

The project/shell level cash flow worksheet overview section provides a visualization of key
information, snapshot changes, and system snapshots for faster understanding of project
financial conditions. This section of the cash flow worksheet displays the current, at
completion, and remaining cost-related information for the project, as well any remaining
forecast amount and time, for the selected curve. Select Show More on the lower-left corner to
expand the screen and see more details.

The following provides information about assigning inflow, outflow, variances, and forecast.

Assigning Inflow and Outflow

• Inflow = the amount assigned to the project as the budget. For example, this may come
from either a cost sheet column or a system activity sheet in the system.

• Outflow= the amount that has been spent and forecasted to be spent. For example, the
Actuals (Spends), Invoices, Forecast (coming from Cost Sheet), are considered Outflow in
the system.

Variance Analysis

You can view inflow vs. outflow analysis in the three tiles at the top of the cash flow worksheet:

• Current Cost Variance shows the difference between the current cost inflow and the
current cost outflow. The change in current cost variance against the last snapshot
displays beside the total.

• At Completion Cost Variance shows the difference between the at completion cost inflow
and the at completion cost outflow. The change in the at completion cost variance against
the last snapshot displays beside the total.

• At Completion Schedule Variance shows the difference between the at completion
schedule inflow and the at completion schedule outflow in months. The change in the at
completion schedule variance against the last snapshot displays beside the total.

A bar chart corresponding to the colors of the curves is visible below the variance amount.
Hover over a bar to display a tooltip with corresponding information, and select Click to Open
to open the curve worksheet.

Variance Analysis Table

Select Show More at the bottom of the tile to view a Variance Analysis Table containing the
following columns:

• Curve Name
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• Current total

• Changes from last Snapshot

• At Completion Total

• Changes from last Snapshot

• End Date

• Changes from last Snapshot

Forecast Analysis

Forecast curves include a separate forecast analysis section in which you can view Spends
versus Forecast analysis and Forecast versus Baseline analysis. This section contains the
following tiles:

• Remaining <Forecast Curve Name> Amount shows the difference between the at
completion forecast amount and the approved spends till date. The change in the
remaining forecast amount against the last snapshot is displayed beside the total.

• Remaining <Baseline Curve Name> Amount shows the difference between the at
completion baseline amount and the approved spends till date. The change in the
remaining baseline amount against the last snapshot is displayed beside the total.

• Remaining <Forecast Curve Name> Time shows the difference in date between the
forecast curve end date and the actuals end date. The change in the remaining forecast
end date against the last snapshot displays beside the total.

• Remaining <Baseline Curve Name> Time shows the difference in date between the
baseline curve end date and the actuals end date. The change in the remaining baseline
end date against the last snapshot displays beside the total.

Forecast Analysis Table

Select Show More at the bottom of the tile to view a Forecast Analysis Table containing the
following columns:

• Curve Name

• Total

• Changes from last Snapshot

• Remaining Total

• Changes from last Snapshot

• End Date

• Changes from last Snapshot

• Remaining Time

• Changes from last Snapshot

Project or Shell Level Cash Flow Worksheet Graphs View Section

The project/shell level cash flow worksheet Graphs view section displays the graphs view of
your selected curve.

Multiple curves can display on the graph. You can add as many curves as you need to the
worksheet. Each curve must be associated with a data source which is created in Admin
mode. The curves are color-coded; the color is determined by the data source.
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In the graph, you have the option to filter out some curves and display a subset of the available
curves, change the zoom level between monthly and yearly, or print the graph. You can switch
between the following views:

• Cumulative curve
A Cumulative curve displays the net of all cash flows over a period of time.

• Incremental curve
An incremental curve displays the cash flow for a certain period.

• Variance
Inflow and Outflow data is displayed in a bar chart. Variance (Difference between inflow
and outflow) is shown as an area chart.

• Current Variance:
A table displays the difference between the current cost inflow and the current cost outflow.

• Variance At Completion:
A table displays the difference between the at completion cost inflow and the at completion
cost outflow.

• Trend Analysis:
A graph displays at completion values of all the visible baseline and forecast curves
against snapshots.

Project or Shell Level Cash Flow Worksheet Details Section

The cash flow details on the right, which you can open by using the split screen  icon, or
slider, lets you see cash flow details related to your project life cycle (iteration by iteration) and
corresponding cumulative cost (total expenditures from all sources).

Note

To maximize or to adjust the cash flow detail pane (All Curves) screen for better

visibility, use Expand  or Dock  in the upper-right corner.

The cash flow details are presented through a table in the right pane, which shows the data for
the curves. Each row of the table corresponds to one of the curves on the graph and displays
the curve data in columns. The data in these columns show the distribution of cost, and the
total of cost is the value in the Total field.

• If you are doing an auto distribution by using a distribution profile, the values in these
columns are calculated based on the distribution percentages.

• If you are doing a manual distribution, you will enter the values into each time period
(distributing the amount in the Total column).

The Unassigned will displays how much of the amount in the Total column is left to be
distributed.

The following table describes each column in detail.

Note

The system displays the cost data using the latest exchange rate table.
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Curve Data Column Name Description

Color The color of the graph displays in the first column
Name The name of curve, taken from the Data Source. You can

select the curve name to view the detail window of the
curve.

Currency The currency for the curve.
From Date The starting point of the curve. This can be entered

manually or taken from a date field on the project/shell
master schedule sheet, as defined in the curve
properties.

To Date The ending point of the curve, also manually entered or
pulled from the schedule sheet. This can be entered
manually or taken from the schedule sheet.

Total This amount is the cost portion of the curve. It can be
pulled from a specified cost sheet column or business
process (BP). This total amount is then distributed over
the time period (From Date to To Date) to generate the
cash flow curve. This is defined in the curve properties.

Unassigned Any amount left over from the Total amount that has
not yet been distributed.

Time Period Columns These are the incremental time periods for the duration
of the cash flow time period. That is, the From Date to
the To Date, entered above. For monthly distribution,
these display each month and year from the From Date
to the To Date. If shown Yearly, each period is one year.

The following explains the options that are available within the cash flow detail pane for Detail
Curves and Summary Curves.

Detail Curve

Within a detail curve, the following toolbar options let you:

• Alter the view (from the View menu, select a different view)

• Create a view (from the View menu, select Create New View)

• Make existing views visible or hide existing views (from the View menu, select Manage
Views)

• Edit the view (select Edit View)

• Print the view (select Print)

• Update data (select Refresh)

• Produce a snapshot, view the snapshot log, access the audit log, and access properties
(from the Snapshot menu, select Create Snapshot, Snapshot Log, Audit Log, or
Properties)

Note

In the cash flow detail pane, any view, the values are not editable and cannot be
distributed.
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Within a detail curve, the View option provides the following options:

• Incremental

• Cumulative

The following explains each view option in detail.

• Detail Curve View (Incremental)

• Detail Curve View (Cumulative)

• Importing Cash Flow Data

• Bulk Edit Cash Flow

Detail Curve View (Incremental)

The Incremental view lets you see the details for:

• Actuals (Spends)

• Baseline

• Forecast

• Budget

• Derived

• Custom

Double-click each cost-related scenario to open it and see pertinent details.

Actuals (Spends)

If you select the Incremental view and select Actuals (Spends) (under the Name column), the
actual spent amounts, per time period, are displayed. These values are not editable and
cannot be distributed. You can use the toolbar options to:

• Export: To export one or more curves to a CSV file, which is automatically named after the
cash flow worksheet.

• Refresh: To update the data, or amounts, on the page.

• Find on Page: To find a particular amount.

Baseline

If you select the Incremental view and select Baseline (under the Name column), the baseline
amounts, per time period, are displayed. These values are not editable and cannot be
distributed. You can use the toolbar options to:

• Bulk Edit: You can conduct bulk edit on one or more curves. When you select Bulk Edit,
the Bulk Edit window opens, and you can select values for the following elements:

Note

The Bulk Edit option is unavailable if in project currency mode (in the details
window). See below for details.

– Distribution Profile (Back Loaded - Front Loaded - Linear - S curve)

– From Date
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– To Date

– Total (not applicable to Baseline)

Note

Elements in the window that have the "Update" option checked for them will
be updated with the selected value. If you do not specify a value for an
element and leave the element empty, the system will clear any existing value.

Select Update when finished.

• Import: Your import options are Curve Setup and Curve Distribution. The Curve
Distribution option is not available.

• Export: To export one or more curves to a CSV file, which is automatically named after the
cash flow worksheet.

• Refresh: To update the data, or amounts, on the page.

• Find on Page: To find a particular amount.

• CBS Hierarchy View: (Only displayed for CBS cash flow curves; available whether
schedules are entered manually or brought in through an Activity Sheet) To display a
hierarchical view of cost and summary codes. Displays summarized data for total costs,
unassigned costs, and date ranges in a view-only mode. The view retains any filters
already applied, which ensures that only the specific cost codes that you defined are
shown in the summarized view. You can select Expand all to view all codes and leaf-level
codes, select Collapse all to display the main CBS codes, and select Refresh to update
the data displayed. If you modify the date values in the main worksheet while the CBS
Hierarchy View overlay is open, you must select Refresh to update the hierarchy view.

Note

If you update a View using the Filters tab, you must close the CBS Hierarchy
View window and reopen it to see updated information.

In Commitment-based curves:

• The system shows cash flow in the transaction currency of record creation.
The system stores the data in project currency. If the project currency is different from the
transaction currency, both the main and detail windows contain a currency drop-down list,
which you can use to show costs in the project currency; however, you can only edit data
in the transaction currency mode. Currency conversion is based on the active company-
level Exchange Rates table. The Bulk Edit option is unavailable if the Detail Curve detail
window is in project currency mode.

• The Detail Curve detail window shows columns from the Business Process. For example,
Number, Name, Line No, CBS Code, Description (Short Description) columns.

Forecast

If you select the Incremental view and select Forecast (under the Name column), the
baseline amounts, per time period, are displayed. These values are not editable and cannot be
distributed. You can use the toolbar options to:

• Bulk Edit: You can conduct bulk edit on one or more curves. When you select Bulk Edit,
the Bulk Edit window opens, and you can select values for the following elements:

– Distribution Profile (not applicable to Forecast)
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– From Date

– To Date

– Total

Note

Elements in the window that have the "Update" option checked for them will
be updated with the selected value. If you do not specify a value for an
element and leave the element empty, the system will clear any existing value.

Select Update when finished.

• Import: Your import options are Curve Setup and Curve Distribution. The Curve
Distribution option is not available.

• Export: To export one or more curves to a CSV file, which is automatically named after the
cash flow worksheet.

• Refresh: To update the data, or amounts, on the page.

• Find on Page: To find a particular amount.

• CBS Hierarchy View: (Only displayed for CBS cash flow curves) To display a hierarchical
view of cost and summary codes. Displays summarized data for total costs, unassigned
costs, and date ranges in a view-only mode. The view retains any filters already applied,
which ensures that only the specific cost codes that you defined are shown in the
summarized view. You can select Expand all to view all codes and leaf-level codes, select
Collapse all to display the main CBS codes, and select Refresh to update the data
displayed.

Detail Curve View (Cumulative)

The Cumulative view lets you see the details for:

• Actuals (Spends)

• Baseline

• Forecast

• Derived

• Custom

Double-click each cost-related scenario to open it and see pertinent details.

Actuals (Spends)

If you select the Cumulative view and select Actuals (Spends) (under the Name column), the
actual spent amounts, per time period, are displayed. These values are not editable and
cannot be distributed. You can use the toolbar options to:

• Export: To export one or more curves to a CSV file, which is automatically named after the
cash flow worksheet.

• Refresh: To update the data, or amounts, on the page.

• Find on Page: To find a particular amount.

Baseline
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If you select the Cumulative view and select Baseline (under the Name column), the baseline
amounts, per time period, are displayed. These values are not editable and cannot be
distributed. You can use the toolbar options to:

• Bulk Edit: You can conduct bulk edit on one or more curves. When you select Bulk Edit,
the Bulk Edit window opens, and you can select values for the following elements:

– Distribution Profile (Back Loaded - Front Loaded - Linear - S curve)

– From Date

– To Date

– Total (not applicable to Baseline)

Note

Elements in the window that have the "Update" option checked for them will
be updated with the selected value. If you do not specify a value for an
element and leave the element empty, the system will clear any existing value.

Select Update when finished.

• Import: Your import options are Curve Setup and Curve Distribution. The Curve
Distribution option is not available.

• Export: To export one or more curves to a CSV file, which is automatically named after the
cash flow worksheet.

• Refresh: To update the data, or amounts, on the page.

• Find on Page : To find a particular amount.

• CBS Hierarchy View: (Only displayed for CBS cash flow curves; available whether
schedules are entered manually or brought in through an Activity Sheet) To display a
hierarchical view of cost and summary codes. Displays summarized data for total costs,
unassigned costs, and date ranges in a view-only mode. The view retains any filters
already applied, which ensures that only the specific cost codes that you defined are
shown in the summarized view. You can select Expand all to view all codes and leaf-level
codes, select Collapse all to display the main CBS codes, and select Refresh to update
the data displayed. If you modify the date values in the main worksheet while the CBS
Hierarchy View overlay is open, you must select Refresh to update the hierarchy view.

Note

If you update a View using the Filters tab, you must close the CBS Hierarchy
View window and reopen it to see updated information.

Forecast

If you select the Cumulative view and select Forecast (under the Name column), the baseline
amounts, per time period, are displayed. These values are not editable and cannot be
distributed. You can use the toolbar options to:

• Bulk Edit: You can conduct bulk edit on one or more curves. When you select Bulk Edit,
the Bulk Edit window opens, and you can select values for the following elements:

– Distribution Profile (not applicable to Forecast)

– From Date
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– To Date

– Total

Note

Elements in the window that have the "Update" option checked for them will
be updated with the selected value. If you do not specify a value for an
element and leave the element empty, the system will clear any existing value.

Select Update when finished.

• Import: Your import options are Curve Setup and Curve Distribution. The Curve
Distribution option is not available.

• Export: To export one or more curves to a CSV file, which is automatically named after the
cash flow worksheet.

• Refresh: To update the data, or amounts, on the page.

• Find on Page: To find a particular amount.

• CBS Hierarchy View: (Only displayed for CBS cash flow curves) To display a hierarchical
view of cost and summary codes. Displays summarized data for total costs, unassigned
costs, and date ranges in a view-only mode. The view retains any filters already applied,
which ensures that only the specific cost codes that you defined are shown in the
summarized view. You can select Expand all to view all codes and leaf-level codes, select
Collapse all to display the main CBS codes, and select Refresh to update the data
displayed.

Importing Cash Flow Data

You can import cash flow data via CSV file. This includes curve setup data (From and To dates,
Profile, and Total columns) and curve distribution data (distribution values of the Total amount
entered in the date period columns). It is important to observe the order of curve operations:
import the setup values first, and then import the distribution values.

• Manual entry generally allows data import but depends upon the curve set up.

• Auto-distribution precludes data import.

• Fields that display data from other sources (schedule sheet, cost column, business
process record) cannot be edited via CSV import.

You can change curve distribution settings; however, the system will replace your data with
data collected by the new distribution method. For example, if you change a manual entry field
to auto, all manually entered data will be lost and replaced with the autogenerated data.

To import curve setup data into the Cash Flow Worksheet by CSV import:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log and double-click the curve to open the Cash Flow worksheet
window.

4. Open the right pane by way of moving the split screen to display the Cash Flow Worksheet
Cash Flow Details pane, as shown below, and select Baseline or Forecast.
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If you are importing both setup and distribution data, import the setup data first to establish
the distribution time period.

5. To export the CSV template, from the toolbar, select the Export icon (down arrow). The
CSV opens in Microsoft Excel. You can Save the CSV file to your desktop first or Open it
directly.

Note

Cash flow data exports the currency and the values to the CSV template.

6. Add the Curve Distribution data to the CSV file.

• From Date, To Date: use the date format.

• Profile: If using auto-profile, enter the name of the default profile you want to use. This
is from the Distribution Profiles list maintained in Admin mode.

• Total: Enter a value to use as the cost total.

• Save the CSV file.

7. Import the CSV file.

• In the Details sheet, select the Import icon (up arrow), and then select Curve Setup
from the drop-down menu. The File Upload window opens.

• Locate the CSV file and select Open. The data will populate edited fields on the
Details sheet.

To import curve distribution data into the Cash Flow Worksheet by CSV import:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log and double-click the curve to open the Cash Flow worksheet
window.

4. Open the right pane by way of moving the split screen to display the Cash Flow Worksheet
Cash Flow Details pane, as shown below, and select Baseline or Forecast.
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5. Select the Export icon (down arrow) to export the CSV template. You can Save the CSV
file to your desktop first or Open it directly.

6. Add the Curve Distribution data to the CSV file.

• Enter values in the time period distribution fields. Do not exceed the amount for
Unassigned.

• The Currency field must have the currency listed.

• Save the CSV file.

7. Import the CSV file.

• In the Details sheet, select the Import icon (up arrow), and then select Curve
Distribution from the drop-down menu. The File Upload window opens.

• Locate the CSV file and select OK. The data will populate edited fields on the Details
sheet.

8. Save the Details window.

Note

You can import data into cash flow by commitment curves in either transaction or
project currencies. If you try to import data in an incorrect currency, you will be notified.
For example, if the transaction currency is in Yen and the project currency is in USD,
and you try to import in Euro, you will get an error message in the CSV file. You will
need to correct the errors in the CSV before re-importing.

Bulk Edit Cash Flow

Bulk Edit is available on the Cash Flow Worksheet Cash Flow Details pane. Bulk Edit is useful
when there are multiple items to be edited that are associated with the curve data.

For example, if you are doing cash flow by CBS, the data in the Details window displays the
CBS codes in use. You can enter curve data for one or multiple CBS codes using Bulk Edit.

If you are doing cash flow by commitment and you are including change orders in the curves
(for cost information and auto distribution), you will see all commitment records in the Details
window—the base commit and any change commits. You can enter curve data for one or
multiple records using Bulk Edit.
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Note

If you are editing a Contract-type BP, the total in the Bulk Edit will be highlighted in the
details screen of the cash flow by contract curve.

To enter cash flow data using Bulk Edit:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a curve from the log and double-click the curve to open the Cash Flow worksheet
window.

4. Open the right pane by way of moving the split screen to display the Cash Flow Worksheet
Cash Flow Details pane, and select Baseline or Forecast.

5. Select one or more rows and select Bulk Edit. The Bulk Edit window opens.

6. The fields that are editable for the curve (based on the Properties window options) will
display.

7. Enter values for the fields.

8. Select the Update checkbox for the fields you want to update.

Note

You can use the Bulk Edit button to edit multiple items in the chosen currency. The
total in the Bulk edit window will be interpreted in the currency selected in the
details screen (lower part of the worksheet window.)

9. Select the Update button.

CBS Curve

Within a CBS curve, the following toolbar options let you:

• Alter the view (from the View menu, select a different view)

• Create a view (from the View menu, select Create New View)

• Make existing views visible or hide existing views (from the View menu, select Manage
Views)

• Edit the view (select Edit View)

• Print the view (select Print)

• Update data (select Refresh)

• Produce a snapshot, view the snapshot log, access the audit log, and access properties
(from the Snapshot menu, select Create Snapshot, Snapshot Log, Audit Log, or
Properties)
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Note

In the cash flow detail pane, any view, the values are not editable and cannot be
distributed.

Within a CBS curve, the View option provides the following options:

• Incremental

• Cumulative

Within the preceding views, you can also access the CBS Hierarchy View option, which
displays a hierarchical view of cost and summary codes. Selecting this option displays
summarized data for total costs, unassigned costs, and date ranges in a view-only mode,
whether schedules are entered manually or automatically entered through an Activity Sheet.
The view retains any filters already applied, which ensures that only the specific cost codes
that you defined are shown in the summarized view. You can select Expand all to view all
codes and leaf-level codes, select Collapse all to display the main CBS codes, and select
Refresh to update the data displayed. If you modify the date values in the main worksheet
while the CBS Hierarchy View overlay is open, you must select Refresh to update the
hierarchy view.

Note

If you update a View using the Filters tab, you must close the CBS Hierarchy View
window and reopen it to see updated information.

For more information, see the following topics located in the Detail Curve section.

• Detail Curve View (Incremental)

• Detail Curve View (Cumulative)

• Importing Cash Flow Data

• Bulk Edit Cash Flow

Summary Curve

Within a summary curve, the following toolbar options let you:

• Alter the view (from the View menu, select a different view)

• Create a view (from the View menu, select Create New View)

• Make existing views visible or hide existing views (from the View menu, select Manage
Views)

• Edit the view (select Edit View)

• Print the view (select Print)

• Update data (select Refresh)

• Produce a snapshot, view the snapshot log, access the audit log, and access properties
(from the Snapshot menu, select Create Snapshot, Snapshot Log, Audit Log, or
Properties)
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Note

In the cash flow detail pane, any view, the values are not editable and cannot be
distributed.

Within a summary curve, the View option provides the following options:

• Incremental

• Cumulative

Project or Shell Cash Flow Properties

You can access the project/shell Cash Flow Properties window in two ways:

• Cash Flow log

• Cash flow curve worksheet

To access the Cash Flow Properties window through the Cash Flow log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a cash flow curve from the log.

4. Select the gear menu ( ) and select Properties to open the Cash Flow Properties
window of the selected record.

To access the Cash Flow Properties window through the cash flow curve worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select a cash flow curve from the log.

4. Select the gear menu ( ) and select Open to open the cash flow curve worksheet of the
selected record.

5. Select the Snapshot menu to open.

6. Select the Properties option to open the Cash Flow Properties window of the selected
record.

The Cash Flow Properties window is divided into two panes. The left pane shows the
General block and the right pane shows the Curves block.

The following explains the components of each pane in detail.

Project or Shell Cash Flow Properties (General Pane)

The following explains the fields under the General block. The next topic explains the fields
under the General block: More Options.
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Note

The red asterisk by a field indicates that the field is required.

Under the General block, you can manage the following cash flow properties:

• Name: Enter a unique name for the curve in the Name field.

• Description: (Optional) Enter a brief description in the Description field.

• Detail Level: Select a detail level option from the Detail Level box. The selected option
determines the level-of-data the cash flow curves will display. Choose one:

– Project/Shell: Choose this to track cash flow for the entire project/shell. For example,
Baseline and Actuals curves might chart the budget and cash outlay across the entire
project. If applicable, select Filter CBS Codes or Filter Summary CBS Codes.

– Summary CBS: Choose this option to track cash flow by summary CBS codes. To
select this option, the cost sheet used in the project/shell must be a tree structure. If
you select this option, the system sets the Summary CBS Level to 1 by default. You
can select another level, based on what is available in the Cost Sheet.

– CBS: Choose this to track cash flow within a project/shell at the CBS code level. This
lets you track cash flow across the project for specific CBS codes, or for all CBS
codes.

– Business Process (Commitments): Choose this option to track cash flow associated
with a particular commitment record and its line items. This includes, for example, a
base contract and optionally their referenced Change Commits. Select a business
process.
Items listed are the project/shell level business processes of type "Base Commit."
When creating a template, choose the one that is likely to be used in the projects/
shells the template will be used in. When creating the curve in a project/shell from the
template, you may need to verify that the business process chosen here is active in
the project/shell or pick another from the list.

• Manage Filters: If you selected Project/Shell, Summary CBS, or CBS, you can refine the
list of codes included. To do so, select Manage Filters. (The names of the subsequent
pages and options changes based on whether you are filtering CBS codes or Summary
CBS codes.) On the Filter [Summary] CBS Code page, select Add [Summary] CBS
Code. On the Cost Code Picker page, select the applicable codes, and then select Add &
Add More if you want to save your changes and add additional codes or select Add &
Close to save your changes and return to the previous page. To save the selected cost
codes, select Done.

• Select Base Commit Record: This is selectable in a project/shell, but not in a template.
Click Select. Choose the commitment record from the list of available records in the
project/shell. Each commitment record can be selected only once.
You can set up the automatic creation of a cash flow curve when a Base Commit record is
created and completed or reaches a particular step. This is done in the BP Setup for the
business process.

• Select your reference element: The worksheet will display the reference elements. By
default, the Record No. will display as the Number. You can select the drop-down list and
choose an element to display for the Name field (Contract No., Contract Terms, or Title).

• Rollup cashflow data to company?

– Yes: The curve will roll up to company cash flow the next time the curves are
refreshed.
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– No: The curve will not roll up to company cash flow the next time the curves are
refreshed.

• Time Scale: If you edit the time scale, the period close settings will be reset, and you will
need to enter new ones for the new time scale.
The time scale determines the scale and format in which the data is shown on the cash
flow worksheet.

By Month or Year: The default is Month.

Format: Choose the format that you want the month and year displayed on the graphs.
The default is M YYYY.

To save your changes, select Save & Close. You can continue adding curves that will make up
the detail curves. To discard your changes, or close the Cash Flow Properties window, select
Cancel.

Project or Shell Cash Flow Properties (General Pane - More Options)

The following explains the fields under the General block: More Options.

Note

The red asterisk next to a field box indicates that the field is a required field. You will
not be able to save your changes without entering a value in that field.

When you select More Options, the More Options window opens which contains the
following tabs on the left pane. Each tab provides additional options for the cash flow which are
described below.

Period Close Settings tab

This tab lets you set the option: Enable auto snapshot

The Period Close Settings tab lets you choose some automatic settings that will happen at
the end of each period (month or year, as chosen in the Time Scale field).

When you select the Enable auto snapshot option, you determine when the system must take
an automatic snapshot of the data.

If you selected Month for Time Scale:

You can choose a specific date each month to automatically take a snapshot, or you can
specify a particular day (such as the first Monday of the month).

If you selected Year for Time Scale:

You can specify the exact date to take the snapshot each year (or a particular day such as the
first Monday of January).

After an auto snapshot is taken, the curve will be refreshed immediately. Actuals (Spends) will
resume after the auto snapshot is complete.

Examples of using the options: Enable auto snapshot, Cutoff spends, and Resume Spends

Company A wants to take an auto snapshot of its cash flow data every time period. Company
A would choose a particular date (such as the 3rd of the month for Month, or January 3 for
Year). The system would take the snapshot and refresh the cash flow curve. They do not select
the Cut off spends option.
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Company B regularly reviews and revises forecast projections during fixed days every time
period. Because it does not want new Spends records to hit the cash flow worksheet during
this period, they choose the Cut off spends option. This option requires that you select the
Enable auto snapshot first. The company sets this option so that an auto snapshot is taken of
their changes just before spends are resumed. Snapshots can then be used for comparison of
previous forecasts with the current month. Any spends records that came in during the forecast
period are not lost; the Resume Spends option determines whether those spends records will
be included in the previous month's cash flow or pushed to the next time period.

Cutoff spends

This option is applicable for Actuals (Spends) type curves.

Selecting this option will temporarily stop spends business processes (for example, Invoices)
from hitting the cash flow worksheet during analysis periods.

The Enable auto snapshot option must be selected first. Actuals (Spends) will resume after
the auto snapshot is complete.

If no value is specified, the last date of the current month is presumed.

The system marks the time of the Cutoff spends date at the beginning of the day. For
example, on June 30, the data can become locked at the beginning of the day and not at the
end of the day, therefore, preventing the user from making any last minute changes before the
start of the next month.

Apply Spends to

The selections under this period close settings option let you apply spends to an effective date
or before/after a Cutoff spends date.

By default, Cutoff spends will resume immediately after an auto-snapshot is taken.

Note If there is a gap between the Cutoff spends date and the Enable auto snapshot date,
any spends that came during that period are not lost.

For example, if a Cutoff spends date is October 26 and the Enable auto snapshot on date is
November 2, (and the Time Scale is monthly) that defines the freeze period. Any spends that
come in on October 27, 28, 29, 30, 31, and November 1 will not hit the cash flow sheet during
the freeze period. After the Enable auto snapshot on date is reached, spends will be included
back in October for spends (Oct 27-31) or November for spends (Nov 1-2), and the effective
date will be retained.

The same month/year as the effective date

The text of the options under Apply Spends to change based on the selection that you made
for the Time Scale (By: Month or By: Year).

If this option is chosen, spends data is included back in the current period after the freeze
period is lifted. The final output is similar to the case where no period close settings are applied
because the effective date is retained. Spends for Oct 26-31 will be included in October and
Nov. 1-2 spends will be included for November.

For example, if the cutoff date is the 26th of October and the snapshot date is the 2nd of
November, the freeze period is Oct 26 - Nov 2. Any spends that come in on Oct 27, 28, 29, 30,
31 and Nov 1 and 2 will not show on the cash flow sheet during the freeze period. After the
auto snapshot date is reached, these spends will be included back in either Oct for spends
(Oct 27-31) or Nov for spends (Nov 1-2) and the effective date will be retained.

The next month/year if after the cutoff date
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After the freeze period is lifted, spends data from the cutoff date to the end of the month will be
included in the next month/year. Spends for Oct 26-31 will be included in November and Nov
1-2 spends will be included for November.

The previous month/year if on or before the cutoff date

After the freeze period is lifted, spends data from the start of the month up to the cutoff date will
be included in the previous month/year. Spends for Oct 26-31 will be included in September
and Nov 1-2 spends will be included for November.

During the Cutoff spends period, even if automatic refresh of the curve occurs as set in the
Schedule tab, spends data will not hit the cash flow sheet until spends are resumed again.

Summary tab

This tab lets you automatically add the selected curve to a selected summary curve. This tab
contains a list of available summary curves to choose from.

Decimal Options tab

This tab provides two options:

• Decimal Options: To specify the number of decimal places supported for amounts
throughout the cash flow, select this option.

• Use Currency Decimal Precision: To ensure that the cash flow preserves the number of
decimals used within areas such as Base Currency, Project Currency, and Transaction
Currency, select this option.

Project or Shell Cash Flow Properties (Curves Pane)

As shown in the screen capture below, the Cash Flow Properties window Curves pane
contains the Curves drop-down list, which lets you add or remove curves.

After you add a curve, the system adds an interactive image representation of the added curve
to the Curves pane.

The following explains the elements of the Curves pane.

Curves

Select Curves to open a list that contains the list of available curves.

These curves, or data sources, have been defined by the Administrator in the Standards &
Libraries module. (Go to the Company Workspace tab, and switch to Admin mode; in the left
Navigator, select Standards & Libraries, then select Cash Flow, and then select Data
Sources.)

The Cashflow Datasources window, where the Administrator edits the list of data sources,
contains a list of data sources that are categorized by name, curve type and color. For
example, the name of a data source can be Actuals which is assigned to a Spends curve
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type, or the name of a data source can be Original Budget which is assigned to a Portfolio
Budget curve type.

Different names can be assigned to on curve type. That is to state, depending on the curve
type, the curve setup options will differ. The admin can define one curve for every data source.

For more information, see Project or Shell Cash Flow Properties Curves Pane and Curve
Types.

Note

The Portfolio Budget curve is linked to scenarios in the Portfolio Manager. The
Project Manager must create this curve. After it is created, the curve shows the initial
budget projections.

The list of available curves include:

• Baseline curve

• Actual (Spends) curve

• Forecast curve

• Derived curve

• Portfolio Budget curve

• Custom curve

When you open a curve, you can view the data in the transaction currency, if the transaction
currency is different than the project currency.

If a curve, or data source, is available within the Curves pane (interactive image
representation of the added curve), double-click anywhere on the image to open the curve
window. In this window, you can see the curve type information as well as information related
to the curve, as described in the following table. If you make any changes, select Update to
save your changes.

Curve Type Description

Granularity • Single distribution of sum of Base Commit and all
changes

• By individual record (base commit and all changes
separately)

• By line items within each individual record

Distribution Method • Manual entry of values for each cash flow period
• Manual dates and manual profile selection
• Business process dates and default profile selection

Select change orders you want to include • List of Business Processes and corresponding
statuses are presented. Manual entry of values for
each cash flow period

• Manual dates and manual profile selection
• Business process dates and default profile selection
• You have the option to add methods to the

distribution method or remove methods from the
distribution method.

Variance Your options are Inflow or Outflow. See the following
topics for details about Variance values.
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To add a curve:

1. Select Curves.

2. Select a data source, or curve, from the list (for example, select Forecast) to open the
data source window.

3. Enter values in the fields, and select Add, when finished.

Project or Shell Cash Flow Properties Curves Pane and Curve Types

This topic provides details about adding curves to the cash flow.

You can construct cash flow curves by:

• Project/Shell

• Summary CBS (Summary CBS Code) If you select this option, the system sets the
Summary CBS Level to 1 by default. You can select another level, based on what is
available in the Cost Sheet.

• CBS (CBS Code)

• Commitment (a specific commitment BP and record)

The following topics explains the process for adding the following curves to a cash flow
worksheet, for comparison:

• Baseline curve

• Forecast curve

Note

The procedures that follow:

– Assume that you have created your data sources.

– Describe how to add a curve type to an existing cash flow (using the Detail
Level column of the Cash Flow log for the project/shell) that does not have a
curve.

Baseline Curve

The following topics explain how to add a Baseline curve for cash flow by:

• Project/Shell

• Summary CBS or CBS

• Commitment or Business Process (Commitments)
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Note

The procedures that follow:

– Assume that you have created your data sources.

– Describe how to add a curve type to an existing cash flow (using the Detail
Level column of the Cash Flow log for the project/shell) that does not have a
curve.

Adding a Baseline Curve for Cash Flow by Project or Shell

To add a Baseline curve for cash flow by project/shell:

1. Go to the shell tab, and switch to User mode.

This is the shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.

4. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

5. In the Cash Flow Properties window General pane, ensure that the Project/Shell option
is selected from the Detail Level drop-down list. The options under the Detail Level drop-
down list are:

• Project/Shell

• Summary CBS

• CBS

• Business Process (Commitments)

6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list and
select Baseline to open the Baseline window.

7. Complete the fields in this window by using the following information. When finished select
Save & Close to save your work and open the cash flow worksheet that you have added.

When you select the Project/Shell option in the Detail Level drop-down list (General pane)
and in the Curves pane you add Baseline curve (from the Curves drop-down list), proceed to
set up the following parameters:
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Parameter Description

Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates.

Select one of the following options:
• Manual

Lets you manually enter amounts for each period.
This option will be available if you have chosen
Manual in the Distribution drop-down list.
You can enter cost information in the Total field on
the worksheet.

• Distribute amount from Cost Sheet Column
Lets you use the default distribution profile. This
option will be available if you have chosen Auto by
default profile in the Distribution drop-down list.
Examples of column:
Approved Budget Revisions, Approved Commitment
Changes, Approved Contracts, and so forth.

Schedule Lets you define the range of dates (what dates to start
the curve and end the curve) to use to plot the cash flow
data.

Note

If you choose to take dates
from the schedule sheet
elements, the system uses the
Master schedule sheet for the
project/shell.

Select one of the following options for each date:
• Manual: Select this option to manually enter the

date in the cash flow worksheet.
• Use dates from Schedule Sheet: Select this option

to select a schedule sheet (from the Select schedule
sheet drop-down). You can populate the From and
To dates according to the schedules available
(Example: Actual Start Date and Actual Finish Date)
pertinent to the schedule sheet that you have
selected for the Select schedule sheet drop-down.
If these dates are changed on the selected schedule
sheet, the changes will be reflected on cash flow
after the next refresh of the curves.

• Use dates from Activity Sheet: Lets you select an
activity sheet (from the Select Activity Sheet
window). After you select using dates from an
activity sheet, you must determine the values for the
Project Type, From Date, and To Date fields.
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Parameter Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. This option
lets you select a distribution profile to use as the default
distribution profile for the curve.
Select one of the following options for how to distribute
the data automatically between cash flow time periods:
• Manual

Lets you enter values into each field manually.
• Company Level

Lets you select a pre-determined method for
distribution. Your options are:
– Linear
– S curve
– Front Loaded
– Back Loaded

• Project Level
Lets you select from a list of available project levels.

The distribution profiles are defined in the:
• Go to the Company Workspace tab, and switch to

Admin mode. In the left Navigator, select
Standards & Libraries, select Cash Flow, and then
select Distribution Profiles.

or
• Go to the shell tab, and switch to User mode. In the

left Navigator, select Cost Manager, and then select
Cash Flow. From the toolbar, select Actions, and
then select Manage Distribution Profiles.

The default profile is used for the initial display and
calculations in the cash flow worksheet. You can change
the distribution profile from the worksheet. If you do
this, the default profile will automatically update to
reflect the current selection.
When you build a Baseline curve for individual line
items, the Schedule of Value (SOV) type influences the
distribution options.
• If the SOV lists individual line items by CBS, you can

distribute cost for each line item individually.
• If the SOV groups line items, you cannot distribute

cost for each line item individually.

Variance Your choices are:
• Inflow
• Outflow
For Project/Shell, typically, the Variance is set to Inflow
for a Baseline type curve.
The value will be used to calculate variances against the
Outflow type curves.

Adding a Baseline Curve for Cash Flow by Summary CBS or CBS

To add a Baseline curve for cash flow by Summary CBS or CBS:

1. Go to the shell tab that contains the cash flow, and switch to User mode.
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2. In the left Navigator, select Cost Manager, and then select Cash Flow, the starting point
for all cash flow operations.

3. In the Cash Flow log:

a. Select a cash flow.

b. Select the gear menu ( ) and select Properties.

4. In the General pane of the Cash Flow Properties window, select any of the following
options from the Detail Level drop-down list:

• Summary CBS (for summary CBS codes)

• CBS (for cash flow by individual CBS codes)

5. In the Curves pane of Cash Flow Properties window, select Baseline from the Curves
drop-down list.

6. In the Baseline window, select the cash flow properties for a Baseline curve. For more
information, see the tables below.

You can cost-load a schedule sheet by assigning roles and resources to project-related
activities. When you associate a CBS code with an activity in the schedule sheet, the system
can distribute its cost over a period of time based on activity dates and the calendar. You will
be able to view this distributed cost along with other cash flow curves related to the project.

To ensure that Cash Flow curves represent CBS codes, schedule dates, and costs from the
baseline and not just the current project, you can manually enter CBS codes on the Activity
Sheet when you switch to Baseline Project View.

You can create another Baseline curve by selecting a Cost Sheet as the source for cost or
create a Forecast, Spends, and Custom curve. In all these cases, the list of CBS codes will be
from the cost sheet and will not be filtered by the schedule sheet.

The cash flow will pull distribution data (Linear, S-Curve, On Start and Finish) from a schedule
sheet.

Cash Flow Properties Setup For a Baseline Curve by Summary CBS

When you select the Summary CBS option in the Detail Level drop-down list (General pane)
and in the Curves pane you add Baseline curve (from the Curves drop-down list), proceed to
set up the following parameters:
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Property Description

Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates.

Select your cost source as one of the following options:
• Manual: Select this option if you want to manually

enter amounts for each period. You can enter cost
information in the Total field on the worksheet.
This option is available if you select Manual in the
Distribution drop-down list.

• Distribute amount from Cost Sheet Column:
Select this option if you want to use the default
distribution profile. This option is available if you
select Auto in the Distribution drop-down list. For
example, columns such as Approved Budget
Revisions, Approved Commitment Changes, Approved
Contracts.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 82 of 671



Property Description

Schedule Define the range of dates to use for plotting the cash
flow data. These are the dates you specify to start the
curve and end the curve.

Note

If you choose to take dates
from the schedule sheet
elements, the Master schedule
sheet is used for the project/
shell.

Select one of the following options:
• Manual: Select this option if you want to manually

enter the date in the cash flow worksheet.
• Use dates from Schedule Sheet: Select this option

if you want to select dates from a schedule sheet.
Select a specific sheet from the Select schedule
sheet list, and proceed to enter dates in the From
Date and To Date fields to plot the cash flow curve
from the selected schedule sheet. For example,
Actual Start Date and Actual Finish Date. Selecting
Use dates from Schedule Sheet option allows you
to access the individual Schedule Sheet. The CBS (or
Summary CBS) code shows the dates of the actual
CBS (or Summary CBS) related activities.

• Use dates from Activity Sheet: Select this option if
you want to select dates from an activity sheet.
Select a sheet from the Select Activity Sheet
window, and proceed to specify the Project Type,
From Date, To Date, and Periods for Cost
Distribution to plot the cash flow curve from the
selected activity sheet.

Project Type If you chose the Schedule as Use Dates from Activity
sheet, select the project as either Baseline or Current.

From Date If you chose the Schedule as Use Dates from Activity
Sheet, select the start date to use for plotting the cash
flow curve.

To Date If you chose the Schedule as Use Dates from Activity
Sheet, select the end date to use for plotting the cash
flow curve.
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Property Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. Select a
distribution profile to use as the default distribution
profile for the curve. Select any of the following options:
• Manual: Select this option if you want to enter

values in each field manually.
• Auto: Select this option if you want to specify a

default distribution profile for initial display and
calculations in the cash flow worksheet. If you
change the distribution profile from the worksheet,
the default profile is also updated to reflect the
current selection. To specify a default distribution
profile:

1. Select the CBS Profile Distribution button.

2. In the Distribute by default profile CBS
window:

a. Select a predetermined distribution method
(at the Company Level or Project Level)
from the Set Profile drop-down list.
The distribution profiles for this field are
defined in the following locations:
– Go to the Company Workspace tab,

and switch to Admin mode. In the left
Navigator, select Standards &
Libraries, select Cash Flow, and then
select Distribution Profiles.

or
– Go to the shell tab, and switch to User

mode. In the left Navigator, select Cost
Manager, and then select Cash Flow.
From the toolbar, select Actions, and
then select Manage Distribution
Profiles.

b. Select one or more WBS codes from the list,
and select Update.

Periods for Cost Distribution This field displays only if you have selected the
Schedule option as Use Dates from Activity Sheet, and
Distribution as Auto
Select any of the following options to specify how to
distribute the costs based on the activity schedule:
• Consecutive Periods: Select this option to distribute

costs based on the profile from the earliest start to
the latest finish dates across activities for each CBS
or Summary CBS code. This is the default option for
new or existing curves if you selected Schedule as
Use Dates from Activity Sheet.

• Exclude Gap Periods: Select this option to
distribute costs by honoring gaps between activities
if there are multiple activities for the same CBS
Code.

• Honor Working Days: Select this option to
distribute costs based on the working days of
activities.
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Property Description

Variance For Summary CBS, typically, the Variance is set to
Inflow for a Baseline type curve. This value is used to
calculate variances against the Outflow type curves.
Your choices are:
• Inflow
• Outflow

Cash Flow Properties Setup For a Baseline Curve by CBS

When you select the CBS option in the Detail Level drop-down list (General pane) and in the
Curves pane you add Baseline curve (from the Curves drop-down list), proceed to set up the
following parameters:

Property Description

Bring Baseline Data From Specify the source of your baseline data. Select any of
the following options:
• General: Select this option if you want to bring data

from a general CBS code.
• Schedule Sheet: Select this option if you want to

choose a schedule sheet and view the cost
distribution information by CBS. To use data from
schedule sheet, click the select icon to open and
select a schedule sheet in the Select Schedule Sheet
window.

• P6 Summary Sheet: Select this option if you want to
use cost and dates information from P6 Summary
Sheet (spread), based on the P6 Data Sources.
Proceed to specify the Data Type. The P6 Data
Sources are listed in the Cashflow Data Sources
window. (To access this window, go to the Company
Workspace tab, and switch to Admin mode; in the
left Navigator, select Standards & Libraries, select
Cash Flow, and then select Data Sources.)

• Activity Sheet: Select this option if you want to use
cost and dates information from an activity sheet.
Proceed to specify the Sheet Name, Project Type,
Cost and Schedule & Distribution.

Data Type This field displays if you chose to Bring Baseline Data
From a P6 Summary Sheet. Select any of the following
values:
• At Completion: Select this option if you want to draw

the Baseline curve using the At Completion Cost
spread.

• Planned: Select this option if you want to draw the
Baseline curve using the Planned Cost spread.

Sheet Name If you chose to Bring Baseline Data From an Activity
Sheet, select an activity sheet.
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Property Description

Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates.

Select your cost source as one of the following options:
• Manual: Select this cost option if you want to

manually enter amounts for each period. This
option will be available if you selected the
Distribution as Manual. This allows you enter cost
information in the Total field on the worksheet.

• From Activity Sheet Column: This cost option
displays if you chose to Bring Baseline Data From
an Activity Sheet. Select a column from the Activity
Sheet such as At Completion Cost, Planned Cost, or
Remaining Cost, and so forth.

• From Cost Sheet Column: Select this cost option if
you if you chose to Bring Baseline Data From an
Activity Sheet., and want to use a default
distribution profile. This option is available if you
selected the Distribution field value as Auto. From
the drop-down list, select a column name such as
Approved Budget Revisions, Approved Commitment
Changes, Approved Contracts, and so forth.

Schedule & Distribution If you chose to Bring Baseline Data From an Activity
Sheet, select a column for the Schedule & Distribution
method.
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Property Description

Schedule Define the range of dates to use for plotting the cash
flow data. These are the dates you specify to start the
curve and end the curve.

Note

If you choose to take dates
from the schedule sheet
elements, the system uses the
Master schedule sheet for the
project/shell.

Select one of the following options:
• Manual: Select this option if you want to manually

enter the date in the cash flow worksheet.
• Use dates from Schedule Sheet: Select this option

if you want to use a schedule sheet from the Select
schedule sheet list. Proceed to enter dates in the
From Date and To Date fields to plot the cash flow
curve using the selected schedule sheet. If these
dates are changed on the selected schedule sheet,
the changes are reflected on cash flow after the next
refresh of the curves.

• Use dates from Activity Sheet: Select this option if
you want to use an activity sheet from the Select
Activity Sheet window. When you select this
option, you will need to also specify the Project
Type, From Date, To Date, and Periods for Cost
Distribution.

Project Type If you chose to Bring Baseline Data From an Activity
Sheet, select the project as either Baseline or Current.

From Date If you chose the Schedule as Use Dates from Schedule
Sheet or Use Dates from Activity Sheet, select the start
date to use for plotting the cash flow curve.

To Date If you chose the Schedule as Use Dates from Schedule
Sheet or Use Dates from Activity Sheet, select the end
date to use for plotting the cash flow curve.
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Property Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. This option
lets you select a distribution profile to use as the default
distribution profile for the curve. Select any of the
following options:
• Manual: Select this option if you want to enter

values into each field manually.
• Auto: Select this option if you want to specify a

default distribution profile for initial display and
calculations in the cash flow worksheet. If you
change the distribution profile from the worksheet,
the default profile is also updated to reflect the
current selection. To specify a default distribution
profile:

1. Select the CBS Profile Distribution button.

2. In the Distribute by default profile CBS
window:

a. Select a predetermined method for
distribution (at the Company Level or
Project Level) from the Set Profile drop-
down list.
The distribution profiles for this field are
defined in the following locations:
– Go to the Company Workspace tab,

and switch to Admin mode. In the left
Navigator, select Standards &
Libraries, select Cash Flow, and then
select Distribution Profiles.

– Go to the shell tab, and switch to User
mode. In the left Navigator, select Cost
Manager, and then select Cash Flow.
From the toolbar, select Actions, and
then select Manage Distribution
Profiles.

b. Select one or more WBS codes from the list,
and select Update.

Note

The Auto option is selected by
default, if you selected the
Schedule option as Use Dates
from Activity. Additionally, if
you also selected the Periods
for Cost Distribution option
as Honor working days, Auto
displays as a read-only field,
and you can no longer select a
default distribution profile.
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Property Description

Periods for Cost Distribution This field displays only if you have selected the
Schedule option as Use Dates from Activity Sheet, and
Distribution as Auto.
Select any of the following options to specify how to
distribute the costs based on the activity schedule:
• Consecutive Periods: Select this option to distribute

costs based on the profile from the earliest start to
the latest finish dates across activities for each CBS
or Summary CBS code. This is the default option for
new or existing curves if you selected Schedule as
Use Dates from Activity Sheet.

• Exclude Gap Periods: Select this option to
distribute costs by honoring gaps between activities
if there are multiple activities for the same CBS
Code.

• Honor Working Days: Select this option to
distribute costs based on the working days of
activities.

Variance For CBS, typically, the Variance is set to Inflow for a
Baseline type curve. This value is used to calculate
variances against the Outflow type curves. Your choices
are:
• Inflow
• Outflow

Adding a Baseline Curve for Cash Flow by Business Process (Commitments)

A Commitment BP (such as a Base Commit or a Change Commit) is a sub-type of a Cost type
BP.

You can build one Baseline curve per Business Process (Commitments) record.

To add a Baseline curve for cash flow by Business Process (Commitments):

1. Go to the shell tab, and switch to User mode.

This is the shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.

4. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

5. In the Cash Flow Properties window General pane, ensure that a record under the
Business Process (Commitments) label is selected from the Detail Level drop-down list.

• Project/Shell

• Summary CBS

• CBS
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• Business Process (Commitments)

6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list, and
select Baseline to open the Baseline window.

When you select the Business Process (Commitments) option in the Detail Level drop-
down list and a Base Commit record (from Select Base Commit Record) in the General
pane, and in the Curves pane you add Baseline curve (from the Curves drop-down list),
proceed to set up the following parameters:
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Parameter Description

Granularity The cash flow Granularity option that you select
determines the:
• Distribution Method options that are available.
• Level of record detail available in the cash flow

curve.
You can roll up Base Commit and Change Commit and
see individual records separately, or you can drill to
individual line items in a Business Process
(Commitments) record.
The options that you can select from are:
• Single distribution of sum of base commit and all

changes: Selecting this option limits the
Distribution Method to Manual entry of values per
cash flow period.
In User mode, you must open the cash flow details
window to complete time scale fields and distribute
the rolled up values of the Base Commit record and
any Change Commit records.

• By individual record (base commit and all
changes separately): Selecting this option lets you
choose from the following options for the
Distribution Method:
– Manual entry of values per cash flow period:

Use this option to enter the time scale manually
and to distribute costs.

– Manual Dates and manual profile selection:
Use this option to enter the time scale manually
and select a distribution curve.

– Business process dates and default profile
selection: Use this option to select the time
scale from fields on the business process.
Select Details to open the selection window. Use
this option to enter dates manually and select a
distribution profile. In User mode, the curve
data is read-only, but you can change the
distribution profile. This selection requires a
sub-selection.
There are four columns in the Auto
Distribution window:
* Business Process: The list comes from the

Cost-type business processes available in
your company.

* From Data Element: Select the date on
which you want the distribution to start.
You can only select a Date element from the
Upper Forms and not from the Business
Process Detail forms.

* To Data Element: Select the date on which
you want the distribution to end.

* Default Profile: If desired, select a pre-
defined profile.

• By line items within each individual record:
Selecting this option lets you select from the
following Distribution Method options:
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Parameter Description

– Manual entry of values per cash flow period:
Use this option to select record line items. In
User mode you can:
* See each selected line item in the cash flow

details window; the columns come from the
business process.

* Select a profile on the detail window for
each line.

* Select the distribution profile manually.
– Manual Dates and manual profile selection:

Use this option to enter the time scale manually
and select a distribution curve.

Distribution Method The Cash Flow Granularity option that you select
determines the Distribution Method options that are
available, as described earlier, and the level of record
detail available in the cash flow curve.
By default, the system displays Business Process
(Commitments) curve cost data in the record
transaction currency, which is stored in project currency
(using the active currency exchange rate table).
If the transaction currency is different from the project
currency, you can change the currency view between
transaction and project currencies, but you can only edit
data in the transaction currency.
If there is a more recent value in the exchange rate
table, refreshing the curve will refresh the cost data.
For more information, see Transaction Currency in
Baseline Curve for Cash Flow by Business Process
(Commitments).

Select change orders you want to include Add or remove business process from the list.
Add Change Commit BPs, according to the status.
These line items are also seen in the cash flow curve
details window.

Variance Your choices are:
• Inflow
• Outflow
For Business Process (Commitments), typically, the
Variance is set to Inflow for a Baseline type curve.
The value will be used to calculate variances against the
Outflow type curves.

Transaction Currency in Baseline Curve for Cash Flow by Business Process (Commitments)

For costs distributed in the transaction currency, the system calculates and stores the
distribution in project currency using the exchange rate table.

As a result, in curves based on a Business Process (Commitments) record, the system shows
cash flow in the transaction currency of the record when it was created. The system stores the
data in project currency.

If the project currency is different from the transaction currency, both the main and detail
windows contain a currency drop-down list which you can use to show costs in the project
currency; however, you can only edit data in the transaction currency mode.
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Currency conversion is based on the active company-level Exchange Rates table.

Bulk edit is unavailable if the detail window is in project currency mode.

In curves based on a Business Process (Commitments) record, the detail window shows
columns from the Business Process. For example, Number, Name, Line No, CBS Code,
Description (Short Description).

Actuals (Spends) Curve

The Actuals (or "spends") curve tracks the actual invoice transactions. Actuals pulls the data
from a column of the cost sheet. As a result, you must select a column associated with the
data source for the Spends type business process and status that you want to track.

Note

These curves display actual spent amounts per time period and are not editable or
distributed.

The following topics explain how to add an Actuals (Spends) curve for cash flow by:

• Project/Shell

• Summary CBS or CBS

• Commitment or Business Process (Commitments)

Note

The procedures that follow:

– Assume that you have created your data sources.

– Describe how to add a curve type to an existing cash flow (using the Detail
Level column of the Cash Flow log for the project/shell) that does not have a
curve.

Adding Actuals (Spends) Curve for Cash Flow by Project or Shell

To add Actuals (or "spends") curve for cash flow by project/shell:

1. Go to the shell tab, and switch to User mode.
This is the shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.
The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.

4. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).
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5. In the Cash Flow Properties window General pane, ensure that the Project/Shell option
is selected from the Detail Level drop-down list. The options under the Detail Level drop-
down list are:

• Project/Shell

• Summary CBS

• CBS

• Business Process (Commitments)

When you select the Project/Shell option in the Detail Level drop-down list, you have the
option to filter for either the CBS Codes, or filter for the Summary CBS Codes.

6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list and
select Actuals to open the Actuals window.

7. Complete the fields in this window by using the following information. When finished select
Save & Close to save your work and open the cash flow worksheet that you have added.

When you select the Project/Shell option in the Detail Level drop-down list (General pane)
and in the Curves pane you add Actuals (or "spends") curve (from the Curves drop-down
list), proceed to set up the following parameters:

Parameter Description

Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates (because there is no
cost sheet to reference in a
template).

Lets you select a cost sheet column (for example:
Approved Budget Revisions, Approved Commitment
Changes, and so forth).
If you are creating a detail curve template, you will not
be able to add an Actuals (or "spends") curve.

Variance Your choices are:
• Inflow
• Outflow
For CBS, typically, the Variance is set to Outflow for an
Actuals (Spends) type curve.
The value will be used to calculate variances against the
Inflow type curves.

Adding Actuals (Spends) Curve for Cash Flow by CBS Summary or CBS

To add an Actuals (or "spends") curve for cash flow by Summary CBS or CBS:

1. Go to the shell tab, and switch to User mode.
This is the shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.
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The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.

4. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

5. In the Cash Flow Properties window General pane, ensure that either Summary CBS
(for summary CBS codes) option or CBS (for cash flow by individual CBS codes) is
selected from the Detail Level drop-down list. The options under the Detail Level drop-
down list are:

• Project/Shell

• Summary CBS

• CBS

• Business Process (Commitments)

6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list and
select Actuals to open the Actuals (Curves Type: Spends) window.

The following explains the details regarding the following selections:

• Summary CBS

• CBS

When you select the Summary CBS option in the Detail Level drop-down list (General pane)
and in the Curves pane you add Actuals (or "spends") curve (from the Curves drop-down
list), proceed to set up the following parameters:

Cost

You can choose the cost column when creating a curve in a project/shell but not in templates
(because there is no cost sheet to reference in a template).

Lets you select a cost sheet column (for example: Approved Budget Revisions, Approved
Commitment Changes, and so forth).

If you are creating a detail curve template, you will not be able to add an Actuals (or "spends")
curve.

Set Effective Date for CBS

The data of the curve before this date will not be included in the cash flow.

(Optional) Indicate whether you want to set an effective date for the Cost Based Schedule
(CBS) code.

For setting the date for CBS and Summary CBS type cash flow curves, see the information
below.

Variance

This is set, typically, to Outflow for an Actuals (or "spends") curve.

This will be used to calculate variances against the Inflow type curves.

When you select the CBS option in the Detail Level drop-down list (General pane) and in the
Curves pane you add Actuals (or "spends") curve (from the Curves drop-down list), proceed
to set up the following parameters:
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Bring Actuals Data From

Your options are:

• Generic
Enables you to select to bring data from a general CBS code.

• P6 Summary Sheet
The cash flow by Summary CBS - Actuals does not have this option.

The data picker lists all the P6 data sources. The P6 data sources are listed the Cashflow
Datasources window. (To access this window, go to the Company Workspace tab, and
switch to Admin mode; in the left Navigator, select Standards & Libraries, select Cash
Flow, and then select Data Sources.)

This option is not available (greyed out) when the project/shell Schedule Type = Duration
Based.

If you select this option, the system draws the Actuals (or "spends") curve by using the
Actual Cost spread from the selected P6 data source.

• Activity Sheet
Select an activity sheet from the Sheet Name drop-down list.

Select a project type from the Project Type drop-down list.

(Required) Select your cost source from the Cost drop down list. Your options are:

– From Activity Sheet Column

– From Cost Sheet Column

(Required) Select the schedule and distribution method from the Schedule & Distribution
drop-down list.

Cost

You can choose the cost column when creating a curve in a project/shell but not in templates
(because there is no cost sheet to reference in a template).

Lets you select a cost sheet column (for example: Approved Budget Revisions, Approved
Commitment Changes, and so forth).

If you are creating a detail curve template, you will not be able to add an Actuals (or "spends")
curve.

Set Effective Date for CBS

The data of the curve before this date will not be included in the cash flow.

(Optional) Indicate whether you want to set an effective date for the Cost Based Schedule
(CBS) code.

For setting the date for CBS and Summary CBS type cash flow curves, see the information
below.

Variance

This is set, typically, to Outflow for an Actuals (or "spends") curve.

This will be used to calculate variances against the Inflow type curves.

CBS and Summary CBS Type Cash Flow Curves (Actuals)
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For CBS and Summary CBS type cash flow curves, where the data is coming from cost sheet,
if you do not want the Actuals amounts to be used until a certain date, so that the cash flow is
accurate, you can set an effective date for the cash flow curve.

Either after you have created a cash flow worksheet, or you have an existing cash flow
worksheet, to determine to whether set an effective date for CBS and Summary CBS type cash
flow curves:

1. In the Cash Flow log, select the gear menu ( ) of your CBS, or Summary CBS, type cash
flow, and select Properties.

2. In the Cash Flow Properties window, open the Actuals curve.

3. In the Actuals window, select Set Effective Date for CBS, and select one of the following
choices:

• No (Default value)

• Yes

If you select No, the effective date will remain as is.

If you select Yes, the Define Effective Dates option will appear on the Actuals window. This
date represents the date from which the Actuals data are included in the cash flow curve.

a. Select Define Effective Dates to open the Define Date per CBS window.

b. In the Define Date per CBS window, select the CBS items that you must set an
effective date for. You can select one or more rows (CBS codes) and bulk select the
date time.

c. Select a date and time (in the Select Date Time field).

The effective date serves as a cut-off date and time. Any data before this effective date (time)
will not be included in cash flow curve.

The Variance calculations and the Forecast curve calculations will retain the data of Actuals
curve.

The Distribution profiles of the Forecast curve will also use the effective date as the start for the
Actuals.

If the cash flow is used for rollup, the cash flow data will roll up, considering the effective date.

The date reset options (Remove Effective Dates) enables you clear the effective date, from the
selected CBS codes.

Shell templates that contain CBS and Summary CBS type cash flow curves (Actuals) with a set
effective date can be used to update existing shell templates.

You can set effective date (date and time) for CBS and Summary CBS type cash flow curves
(Actuals) in a shell template, instead of defining the dates for every new curve individually, and
push the template.

When integrated with Web Services, the effective date can be included to help the users create
the cash flow curve directly, without having to change the dates in Unifier.

Adding Actuals (Spends) Curve for Cash Flow by Business Process (Commitments)

A Commitment BP (such as a Base Commit or a Change Commit) is a sub-type of a Cost type
BP.

You can build one Actuals (Spends) curve per Business Process (Commitments) record.
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To add an Actuals (Spends) curve for cash flow by Business Process (Commitments):

1. Go to the shell tab, and switch to User mode.
This is the project/shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.
The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.

4. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

5. In the Cash Flow Properties window General pane, ensure that a record under the
Business Process (Commitments) label is selected from the Detail Level drop-down list.
The options under the Detail Level drop-down list are:

• Project/Shell

• Summary CBS

• CBS

• Business Process (Commitments)

6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list and
select Actuals (Spends) to open the Actuals (Curve Type: Spends) window.

When you select the Business Process (Commitments) option in the Detail Level drop-
down list and a Base Commit record (from Select Base Commit Record) in the General
pane, and in the Curves pane you add Actuals (Spends) curve (from the Curves drop-down
list), proceed to set up the following parameters:

Parameter Description

Granularity The options that you can select from are:
• By Business Process
• By line items from Schedule of Values (SOV)
The cash flow Granularity option that you select
determines the:
• Distribution Method options that are available.
• Level of record detail available in the cash flow

curve.
You can roll up Base Commit and Change Commit and
see individual records separately, or you can drill to
individual line items in a Business Process
(Commitments) record.

Cost Under the Select Spends Business Process field:
Add or remove business process from the list.

Variance Your choices are:
• Inflow
• Outflow
For Business Process (Commitments), typically, the
Variance is set to Inflow for a Baseline type curve.
The value will be used to calculate variances against the
Outflow type curves.
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Cash Flow by Commitment and Cash Flow Family Curves for Actuals (Spends) Curve

In the cash flow family curves for Actuals (or "spends") curve for the cash flow by Business
Process (Commitments) for:

• Base Commits

• Change Commits

• Payment Application BPs of Summary Payment Application SOV type

If the Effective Date (uuu_effective_date) field has been defined in the Detail Form design,
this date is used as the effective date for the Costed Line Items. In the absence of the
Effective Date (uuu_effective_date) field, the workflow End Date will be used for the Cash
Flow.

You can see the Costed Amount for the Cash Flow curves of Actuals (Spends) type level
CBS and Summary CBS.

You can see the Line Item amount for the Cash Flow curves of Actuals (Spends) type level
Project/Shell.

Actuals (Spends) Curve and Forecast Curve

The system complies with the initial profile. If Actuals (or "spends") are received for a portion of
the curve, and the Forecast curve is connected to Actuals (or "spends"), the system takes the
already-consumed-profile portion out of the equation and redistributes the unconsumed
pending profile portion.

Examples:

• The Forecast curve starts from Jan 2022 - Dec 2024, stretching the system's default 20
point distribution profile over 36 periods.

• Actuals were received January 2022, February 2022, and March 2022.

• These three periods of Forecast curve already consumed 1.67 points of period distribution.

• The Forecast end date is now changed to December 2025.

• The Forecast curve is now March 31, 2022, to December 2025.

• The system then distributes the remaining 18.33 points of profile over 45 periods.

Note

The system generates Actuals information at the start of the day and uses it to
update the Forecast information. Therefore, on the last day of an Auto Snapshot
(the cutoff date), the Forecast does not include changes that might have occurred
between the generation of the Actuals and the generation of the Forecast and the
system might prevent you from updating Actuals information on the last day of the
cycle.

If there are some CBS codes that have received Actuals (or "spends") and some CBS codes
that did not, the CBS codes that did not receive Actuals (or "spends") will be replaced by 0 at
the end of the month, or on the cutoff date (depending on the UI settings).
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If there are some CBS codes that have received future Actuals (or "spends") and some CBS
codes that did not, the Forecast curve will not reflect future Actuals (or "spends") until they
become current.

The following section explains the Forecast curve.

Forecast Curve

As a part of cash flow management, forecasting is about calculating the future expenditures,
based on the project schedules.

The following topics explain how to add a Forecast curve for cash flow by:

• Project/Shell

• Summary CBS or CBS

• Commitment or Business Process (Commitments)

Note

The procedures that follow:

– Assume that you have created your data sources.

– Describe how to add a curve type to an existing cash flow (using the Detail
Level column of the Cash Flow log for the project/shell) that does not have a
curve.

Adding a Forecast Curve for Cash Flow by Project or Shell

To add Actuals (or "spends") curve for cash flow by project/shell:

1. Go to the shell tab, and switch to User mode.

This is the shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.

4. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

5. In the Cash Flow Properties window General pane, ensure that the Project/Shell option
is selected from the Detail Level drop-down list. The options under the Detail Level drop-
down list are:

• Project/Shell

• Summary CBS

• CBS

• Business Process (Commitments)
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6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list and
select Forecast to open the Forecast window.

7. Complete the fields in this window by using the following information. When finished select
Save & Close to save your work and open the cash flow worksheet that you have added.

When you select the Project/Shell option in the Detail Level drop-down list (General pane)
and in the Curves pane you add Forecast curve (from the Curves drop-down list), proceed to
set up the following parameters:

Parameter Description

Cost

Note

The distribution method that
you select determines the Cost
options that are available.

Select one of the following options:
• Manual: Select this option to setup manual entry of

amounts for each period. This option is available if
you have chosen Manual in the Distribution drop-
down list. Users can then enter cost information in
the Total field on the worksheet.

• Distribute amount from Cost Sheet Column:
Select this option to setup a default distribution
profile. This option is available if you have chosen
Auto in the Distribution drop-down list. Examples
of column: Approved Budget Revisions, Approved
Commitment Changes, Approved Contracts, and so
forth.

Schedule This parameter enables you to plot the cash flow data.
You can select one of the following options:
• Manual
• Use dates from Schedule Sheet

Lets you select a schedule sheet (from the Select
schedule sheet drop-down). You can populate the
From and To dates according to the schedules
available (Example: Actual Start Date and Actual
Finish Date) pertinent to the schedule sheet that you
have selected for the Select schedule sheet drop-
down.
If these dates are changed on the selected schedule
sheet, the changes will be reflected on cash flow
after the next refresh of the curves.
After you select Use dates from Schedule Sheet,
you must determine the values for the From Date
and To Date fields.

• Use dates from Activity Sheet
Enables you to select an activity sheet (from the
Select Activity Sheet window).
After you select Use dates from Activity Sheet, you
must determine the values for the Project Type,
From Date, and To Date fields.
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Parameter Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. This option
lets you select a distribution profile to use as the default
distribution profile for the curve.
Select one of the following options for how to distribute
the data automatically between cash flow time periods:
• Manual: Select this option to enter values into each

field manually and therefore distribute the amount
form the cost sheet column.

• Company Level: Select this option to choose a pre-
determined method for distribution. Your options
are: Linear, S curve, Front Loaded, Back Loaded.

• Project Level: Select this option to choose from a
list of available project levels.

If the initial Forecast uses a distribution profile, and it
has a configuration start at the end of Actuals (or
"spends"), the profile does not impact the Forecast
distribution when you receive Actuals (or "spends").
The distribution profiles are defined in the:
• Go to the Company Workspace tab, and switch to

Admin mode. In the left Navigator, select
Standards & Libraries, select Cash Flow, and then
select Distribution Profiles.

or
• Go to the shell tab, and switch to User mode. In the

left Navigator, select Cost Manager, and then select
Cash Flow. From the toolbar, select Actions, and
then select Manage Distribution Profiles.

The default profile is used for the initial display and
calculations in the cash flow worksheet. You can change
the distribution profile from the worksheet. If you do
this, the default profile will automatically update to
reflect the current selection.
When you build a Baseline curve for individual line
items, the Schedule of Value (SOV) type influences the
distribution options.
• If the SOV lists individual line items by CBS, you can

distribute cost for each line item individually.
• If the SOV groups line items, you cannot distribute

cost for each line item individually.

Variance Your choices are:
• Inflow
• Outflow
For CBS, typically, the Variance is set to Outflow for an
Actuals (Spends) type curve.
The value will be used to calculate variances against the
Inflow type curves.

Begin calculations at end of curve Select this option if you want to automatically start the
Forecast at the end of a selected Actual (or "spends")
curve for each time period.
Select Begin calculations at end of curve, select the
drop-down list below, and select your desired option (for
example, you can select Actuals (or "spends") curve, if
this curve exists in the list).
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Parameter Description

Replace current period forecast with Actuals on cut
off date

If you select this option and the period close settings
have not been specified, the system replaces the
Forecast curve with the Actuals (or "spends") curve at
the end of the month.

Note

The cumulative graph will not
show the Forecast connected
to Actuals (or "spends") until
the system overwrites the
Forecast with the Actuals.

Allow edit of current period forecast until
replacement actuals

This option lets you reconfigure the Forecast until the
date set to replace the Foretasted values with Actuals
(or "spends").

Note

If the cutoff date is not
specified, but the Replace
current period forecast with
Actuals on cut off date and
Allow edit of current period
forecast until replacement
by Actuals options are
selected, the system does not
allow edits to the Forecast
curve after the end of the
month.

Distribute unassigned amounts from Spends Your options for unassigned amounts are:
• Using weighted average over all remaining

periods
• Using weighted average over ___ next periods
You can enter the number of time periods (1 or more)
not exceeding the number of periods remaining.
The options above are available only if you have chosen
to:
• Select a distribution profile to use as the default

distribution profile for the curve.
• Select Begin calculations at end of curve option to

automatically start the Forecast at the end of a
selected Actual (or "spends") curve for each time
period.

• If you use auto distribution for a Forecast Curve
with Spends enabled and you want to use the same
approach for rows that are manually overridden,
select the Allow distribution of unassigned
amount for manual override rows checkbox.

Select Baseline curve for comparison Select the drop-down list and select a Baseline curve to
compare with the Forecast curve.
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Adding a Forecast Curve for Cash Flow by CBS Summary or CBS

To add Forecast curve for cash flow by CBS Summary or CBS:

1. Go to the shell tab that contains the cash flow, and switch to User mode.

2. In the left Navigator, select Cost Manager node, and then select Cash Flow, the starting
point for all cash flow operations.

3. In the Cash Flow log:

a. Select a cash flow.

b. Select the gear menu ( ) and select Properties.

4. In the General pane of the Cash Flow Properties window, select any of the following
options from the Detail Level drop-down list:

• Summary CBS (for summary CBS codes)

• CBS (for cash flow by individual CBS codes)

5. In the Curves pane of the Cash Flow Properties window, select Forecast from the
Curves drop-down list.

6. In the Forecast window, select the cash flow properties for a Forecast curve. For more
information, see the tables below.

Cash Flow Properties Setup For a Forecast Curve by Summary CBS

When you select the Summary CBS option in the Detail Level drop-down list (General pane)
and in the Curves pane you add Forecast curve (from the Curves drop-down list), proceed to
set up the following parameters:

Property Description
Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates.

Select your cost source as one of the following options:
• Manual: Select this option if you want to manually

enter amounts for each period. You can enter cost
information in the Total field on the worksheet.
This option is available if you select Manual in the
Distribution drop-down list.

• Distribute amount from Cost Sheet Column:
Select this option if you want to use a default
distribution profile. This option is available if you
select Auto in the Distribution drop-down list. For
example, columns such as Approved Budget
Revisions, Approved Commitment Changes, Approved
Contracts.
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Schedule Define the range of dates to use for plotting the cash
flow data. These are the dates you specify to start the
curve and end the curve.

Note

If you choose to take dates
from the schedule sheet
elements, the Master schedule
sheet is used for the project/
shell.

Select one of the following options for each date:
• Manual: Select this option if you want to manually

enter the date in the cash flow worksheet.
• Use dates from Schedule Sheet: Select this option

if you want to select dates from a schedule sheet.
Select a specific sheet from the Select schedule
sheet drop-down list, and proceed to enter dates in
the From Date and To Date fields to plot the cash
flow curve. For example, Actual Start Date and
Actual Finish Date. If these dates are changed on the
selected schedule sheet, the changes are reflected on
cash flow after the next refresh of the curves.

• Use dates from Activity Sheet: Select this option if
you want to select dates from an activity sheet.
Select a specific sheet from the Select Activity
Sheet window, and proceed to specify the Project
Type, From Date, To Date, and Periods for Cost
Distribution to plot the cash flow curve from the
selected activity sheet.

Project Type If you chose the Schedule as Use Dates from Activity
Sheet, select the project as either Baseline or Current.

From Date If you chose the Schedule as Use Dates from Activity
Sheet, select the start date to use for plotting the cash
flow curve.
If the date is changed on the selected sheet, the change is
reflected on the cash flow when the curve is next
refreshed.

To Date If you chose the Schedule as Use Dates from Activity
Sheet, select the end date to use for plotting the cash
flow curve.
If the date is changed on the selected sheet, the change is
reflected on the cash flow when the curve is next
refreshed.
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Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. Select a
distribution profile to use as the default distribution
profile for the curve. Select any of the following options:
• Manual: Select this option if you want to enter

values in each field manually.
• Auto: Select this option if you want to specify a

default distribution profile for initial display and
calculations in the cash flow worksheet. If you
change the distribution profile from the worksheet,
the default profile is also updated to reflect the
current selection. To specify a default distribution
profile:

1. Select CBS Profile Distribution button.

2. In the Distribute by default profile CBS
window:

a. Select a predetermined distribution method
(at the Company Level or Project Level)
from the Set Profile drop-down list.
The distribution profiles for this field are
defined in the following locations:
– Go to the Company Workspace tab,

and switch to Admin mode. In the left
Navigator, select Standards &
Libraries, select Cash Flow, and then
select Distribution Profiles.

or
– Go to the shell tab, and switch to User

mode. In the left Navigator, select Cost
Manager, and then select Cash Flow.
From the toolbar, select Actions, and
then select Manage Distribution
Profiles.

b. Select one or more WBS codes from the list,
and select Update.

Begin calculations at end of curve Select this option if you want to automatically start the
Forecast at the end of a selected Actual (or "spends")
curve for each time period.

Replace current period forecast with Actuals on cut
off date

If you select this option, and the period close settings
have not been specified, the Forecast curve is replaced
with the Actuals (or "spends") curve at the end of the
month.

Note

The cumulative graph will not
show the Forecast connected
to Actuals (or "spends") until
the system overwrites the
Forecast with the Actuals.
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Allow edit of current period forecast until
replacement actuals

Select this option if you want to reconfigure the Forecast
until the date set to replace the Forecasted values with
Actuals (or "spends").

Note

If the cutoff date is not
specified, but the Replace
current period forecast with
Actuals on cut off date and
Allow edit of current period
forecast until replacement
by Actuals options are
selected, the system does not
allow edits to the Forecast
curve after the end of the
month.

Distribute unassigned amounts from Spends Your options for unassigned amounts are:
• Using weighted average over all remaining periods
• Using weighted average over ___ next periods
You can enter the number of time periods (1 or more)
not exceeding the number of periods remaining.
The options above are available only if you:
• Selected a default distribution profile for the curve.
• Selected the Begin calculations at end of curve

option.
• If you use auto distribution for a Forecast Curve

with Spends enabled and you want to use the same
approach for rows that are manually overridden,
select the Allow distribution of unassigned
amount for manual override rows checkbox.

Select Baseline curve for comparison Select a Baseline curve from the drop-down list to
compare with the Forecast curve.

Variance For Summary CBS, typically, the Variance is set to
Inflow for a Baseline type curve. This value is used to
calculate variances against the Outflow type curves.
Your choices are:
• Inflow
• Outflow

Setting Up Cash Flow Properties For a Forecast Curve by CBS

When you select the CBS option in the Detail Level drop-down list (General pane) and in the
Curves pane you add Baseline curve (from the Curves drop-down list), proceed to set up the
following parameters:
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Property Description

Bring Forecast Data From Specify the source of your baseline data. Select any of
the following options:
• General: Select this option if you want to bring data

from a general CBS code.
• Schedule Sheet: Select this option if you want to

choose a schedule sheet and view the cost
distribution information by CBS. To use data from
schedule sheet, click the select icon to open and
select a schedule sheet in the Select Schedule Sheet
window.

• P6 Summary Sheet: Select this option if you want to
use cost and dates information from P6 Summary
Sheet (spread), based on the P6 Data Sources.
Proceed to specify the Data Type. The P6 Data
Sources are listed in the Cashflow Data Sources
window. (To access this window, go to the Company
Workspace tab, and switch to Admin mode; in the
left Navigator, select Standards & Libraries, select
Cash Flow, and then select Data Sources.)
The data picker lists all the P6 data sources. The P6
data sources are listed in the Cashflow Datasources
window. (To access this window, go to the Company
Workspace tab, and switch to Admin mode; in the
left Navigator, select Standards & Libraries, select
Cash Flow, and then select Data Sources.)

• Activity Sheet: Select this option if you want to use
cost and dates information from an activity sheet.
Proceed to specify the Sheet Name, Project Type,
Cost and Schedule & Distribution.
– (Required) Select your cost source from the Cost

drop down list. Your options are:
* From Activity Sheet Column
* From Cost Sheet Column

– (Required) Select the schedule and distribution
method from the Schedule & Distribution
drop-down list.

Data Type This field displays if you chose to Bring Baseline Data
From a P6 Summary Sheet. Select any of the following
values:
• At Completion: Select this option if you want to draw

the Baseline curve using the At Completion Cost
spread.

• Planned: Select this option if you want to draw the
Baseline curve using the Planned Cost spread.

Sheet Name If you chose to Bring Baseline Data From an Activity
Sheet, select an activity sheet.

Project Type If you chose to Bring Baseline Data From an Activity
Sheet, select the project as either Baseline or Current.
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Property Description

Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates.

Select one of the following options:
• Manual: Select this cost option if you want to

manually enter amounts for each period. This
option will be available if you selected the
Distribution as Manual. This allows you enter cost
information in the Total field on the worksheet.

• From Activity Sheet Column: This cost option
displays if you chose to Bring Baseline Data From
an Activity Sheet. Select a column from the Activity
Sheet such as At Completion Cost, Planned Cost, or
Remaining Cost, and so forth.

• From Cost Sheet Column: This cost option displays
if you chose to Bring Baseline Data From an
Activity Sheet. and want to use a default distribution
profile. This option is available if you selected the
Distribution field value as Auto. From the drop-
down list, select a column name such as Approved
Budget Revisions, Approved Commitment Changes,
Approved Contracts, and so forth.

Schedule & Distribution If you chose to Bring Baseline Data From an Activity
Sheet, select a column for the Schedule & Distribution
method.
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Property Description

Schedule Define the range of dates to use for plotting the cash
flow data. These are the dates you specify to start the
curve and end the curve.

Note

If you choose to take dates
from the schedule sheet
elements, the system uses the
Master schedule sheet for the
project/shell.

Select one of the following options:
• Manual: Select this option if you want to manually

enter the date in the cash flow worksheet.
• Use dates from Schedule Sheet: Select this option

if you want to use a schedule sheet from the Select
schedule sheet list. Proceed to enter dates in the
From Date and To Date fields to plot the cash flow
curve using the selected schedule sheet. If these
dates are changed on the selected schedule sheet,
the changes are reflected on cash flow after the next
refresh of the curves.

• Use dates from Activity Sheet: Select this option if
you want to use an activity sheet from the Select
Activity Sheet window. When you select this
option, you will need to also specify the Project
Type, From Date, To Date, and Periods for Cost
Distribution.

From Date If you chose the Schedule as Use Dates from Schedule
Sheet or Use Dates from Activity Sheet, select the start
date to use for plotting the cash flow curve.

To Date If you chose the Schedule as Use Dates from Schedule
Sheet or Use Dates from Activity Sheet, select the end
date to use for plotting the cash flow curve.
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Property Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. This option
lets you select a distribution profile to use as the default
distribution profile for the curve.
• Manual: Select this option if you want to enter

values into each field manually.
• Auto: Select this option if you want to specify a

default distribution profile for initial display and
calculations in the cash flow worksheet. If you
change the distribution profile from the worksheet,
the default profile is also updated to reflect the
current selection. To specify a default distribution
profile:

1. Select the CBS Profile Distribution button.

2. In the Distribute by default profile CBS
window:

a. Select a predetermined method for
distribution (at the Company Level or
Project Level) from the Set Profile drop-
down list.
The distribution profiles for this field are
defined in the following locations:
– Go to the Company Workspace tab,

and switch to Admin mode. In the left
Navigator, select Standards &
Libraries, select Cash Flow, and then
select Distribution Profiles.

or
– Go to the shell tab, and switch to User

mode. In the left Navigator, select Cost
Manager, and then select Cash Flow.
From the toolbar, select Actions, and
then select Manage Distribution
Profiles.

b. Select one or more WBS codes from the list,
and select Update.

Note

The Auto option is selected by
default, if you selected the
Schedule option as Use Dates
from Activity. Additionally, if
you also selected the Periods
for Cost Distribution option
as Honor working days, Auto
displays as a read-only field,
and you can no longer select a
default distribution profile.
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Property Description

Periods for Cost Distribution This field displays only if you have selected the
Schedule option as Use Dates from Activity Sheet, and
Distribution as Auto.
Select any of the following options to specify how to
distribute the costs based on the activity schedule:
• Consecutive Periods: Select this option to distribute

costs based on the profile from the earliest start to
the latest finish dates across activities for each CBS
or Summary CBS code. This is the default option for
new or existing curves if you selected Schedule as
Use Dates from Activity Sheet.

• Exclude Gap Periods: Select this option to
distribute costs by honoring gaps between activities
if there are multiple activities for the same CBS
Code.

• Honor Working Days: Select this option to
distribute costs based on the working days of
activities.

Variance For CBS, typically, the Variance is set to Inflow for an
Actuals (Spends) type curve. This value is used to
calculate variances against the Inflow type curves. Your
choices are:
• Inflow
• Outflow

Begin calculations at end of curve Select this option if you want to automatically start the
Forecast at the end of a selected Actual (or "spends")
curve for each time period.

Replace current period forecast with Actuals on cut
off date

If you select this option, and the period close settings
have not been specified, the Forecast curve is replaced
with the Actuals (or "spends") curve at the end of the
month.

Note

The cumulative graph will not
show the Forecast connected
to Actuals (or "spends") until
the system overwrites the
Forecast with the Actuals.
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Property Description

Allow edit of current period forecast until
replacement actuals

Select this option if you want to reconfigure the Forecast
until the date set to replace the Forecasted values with
Actuals (or "spends").

Note

If the cutoff date is not
specified, but the Replace
current period forecast with
Actuals on cut off date and
Allow edit of current period
forecast until replacement
by Actuals options are
selected, the system does not
allow edits to the Forecast
curve after the end of the
month.

Distribute unassigned amounts from Spends Your options for unassigned amounts are:
• Using weighted average over all remaining periods
• Using weighted average over ___ next periods
You can enter the number of time periods (1 or more)
not exceeding the number of periods remaining.
The options above are available only if you:
• Selected a default distribution profile for the curve.
• Selected the Begin calculations at end of curve

option.
• If you use auto distribution for a Forecast Curve

with Spends enabled and you want to use the same
approach for rows that are manually overridden,
select the Allow distribution of unassigned
amount for manual override rows checkbox.

Select Baseline curve for comparison Select a Baseline curve from the drop-down list to
compare with the Forecast curve.

Adding a Forecast Curve for Cash Flow by Business Process (Commitments)

A Commitment BP (such as a Base Commit or a Change Commit) is a sub-type of a Cost type
BP.

You can build one Forecast curve per Business Process (Commitments) record.

To add a Forecast curve for cash flow by Business Process (Commitments):

1. Go to the shell tab, and switch to User mode.
This is the shell that contains the cash flow that you want.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.
The Cash Flow log is the starting place for cash flow operations. The log displays all
existing cash flow curves and also provides options for creating new curves, copying
curves, viewing curve properties, and assigning curve usage privileges to other users.

3. Select the cash flow from the Cash Flow log.
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4. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

5. In the Cash Flow Properties window General pane, ensure that a record under the
Business Process (Commitments) label is selected from the Detail Level drop-down list.
The options under the Detail Level drop-down list are:

• Project/Shell

• Summary CBS

• CBS

• Business Process (Commitments)

6. In the Cash Flow Properties window Curves pane, select the Curves drop-down list and
select Forecast to open the Forecast window.

When you select the Business Process (Commitments) option in the Detail Level drop-
down list and a Base Commit record (from Select Base Commit Record) in the General
pane, and in the Curves pane you add Forecast curve (from the Curves drop-down list),
proceed to set up the following parameters:

Parameter Description

Granularity The options that you can select from are:
• Single distribution of sum of Base Commit and all

changes
• By individual record (Base Commit and all changes

separately)
• By line items within each individual record
The cash flow Granularity option that you select
determines the:
• Distribution Method options that are available.
• Level of record detail available in the cash flow

curve.
You can roll up Base Commit and Change Commit and
see individual records separately, or you can drill to
individual line items in a Business Process
(Commitments) record.

Distribution Method The options that you can select from are:
• Manual entry of values for each cash flow period
• Manual entry and Auto distribution of Unassigned -

for New records
• Manual dates and manual profile selection
• Business process dates and default profile selection

Select change orders you want to include Add or remove business process from the list.
Variance Your choices are:

• Inflow
• Outflow
For Business Process (Commitments), typically, the
Variance is set to Outflow for a Forecast type curve.
The value will be used to calculate variances against the
Inflow type curves.

Forecast Curve Behavior Test Cases
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The following table provides cases, conditions, and times regarding various Forecast curve
tests:

Cases Condition Time

Forecast Curve NA NA
Set in the past Forecast with Actuals (no Actuals

data)
Start Date

Set in the past Forecast with Actuals (no Actuals
data)

End Date

Set in the past Forecast with Actuals (with Actuals
data)

Start Date

Set in the past Forecast with Actuals (with Actuals
data)

End Date

Set in the future Forecast with Actuals (no Actuals
data)

Start Date

Set in the future Forecast with Actuals (no Actuals
data)

End Date

Set in the future Forecast with Actuals (with Actuals
data)

Start Date

Set in the future Forecast with Actuals (with Actuals
data)

End Date

Portfolio Budget Curve

The Portfolio Manager lets you pull the Baseline, or Forecast, data from more than one
project/shell into the following Portfolio Budget curves:

• Approved Budget

• Original Budget

• Shared Budget

For an explanation of these options see Portfolio Manager Budget Curves.

The following topics explain how to add a Portfolio Budget curve for cash flow by:

• Project/Shell

• Summary CBS or CBS

• Commitment or Business Process (Commitments)

Note

The procedures that follow:

– Assume that you have created your data sources.

– Describe how to add a curve type to an existing cash flow (using the Detail
Level column of the Cash Flow log for the project/shell) that does not have a
curve.

Adding Portfolio Budget Curve for Cash Flow by Project or Shell
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To add Portfolio Budget (Approved Budget) curve for cash flow by Project/Shell:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Project/Shell.

4. In the Curves pane, select Approved Budget.
The Approved Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Original Budget) curve for cash flow by Project/Shell:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Project/Shell.

4. In the Curves pane, select Original Budget.
The Original Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Shared Budget) curve for cash flow by Project/Shell:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).
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3. In the General pane, select Project/Shell.

4. In the Curves pane, select Shared Budget.
The Shared Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

Adding Portfolio Budget Curve for Cash Flow by Summary CBS or CBS

Summary CBS

To add Portfolio Budget (Approved Budget) curve for cash flow by Summary CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Summary CBS.

4. In the Curves pane, select Approved Budget.
The Approved Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Original Budget) curve for cash flow by Summary CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Summary CBS.
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4. In the Curves pane, select Original Budget.
The Original Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Shared Budget) curve for cash flow by Summary CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Summary CBS.

4. In the Curves pane, select Shared Budget.
The Shared Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

CBS

To add Portfolio Budget (Approved Budget) curve for cash flow by CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select CBS.

4. In the Curves pane, select Approved Budget.
The Approved Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:
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Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Original Budget) curve for cash flow by CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select CBS.

4. In the Curves pane, select Original Budget.
The Original Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Shared Budget) curve for cash flow by CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select CBS.

4. In the Curves pane, select Shared Budget.
The Shared Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:
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Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

Adding Portfolio Budget Curve for Cash Flow by Business Process (Commitments)

To add Portfolio Budget (Approved Budget) curve for cash flow by Business Process
(Commitments):

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ) and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Business Process (Commitments).

4. In the Curves pane, select Approved Budget.
The Approved Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Original Budget) curve for cash flow by Business Process
(Commitments):

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Business Process (Commitments).

4. In the Curves pane, select Original Budget.
The Original Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:
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Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

To add Portfolio Budget (Shared Budget) curve for cash flow by Business Process
(Commitments):

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane, select Business Process (Commitments).

4. In the Curves pane, select Shared Budget.
The Shared Budget window (Curve Type: Portfolio Budget) opens.

5. Proceed to set up the following parameters:

Parameter Description

Cost Select an option (from the Distribute amount) from field
list. The choices are:
• Original
• Shared
• Approved

Currency Select to open the Select Currency window and select
the currency for the Portfolio Budget type curve. See 
Portfolio Budget Curve and Currency for more
information.

Variance Select Inflow or Outflow or leave the field empty.

Portfolio Budget Curve and Currency

When you define a Portfolio Budget curve within any curve family type (Project/Shell,
Summary CBS, CBS, and Business Process (Commitments)), you have the option to select
the currency (Currency field under Cost) of the Portfolio Budget data source, from the
Portfolio Manager.

The Currency field is a required field (default value: Project Currency), if you have Portfolio
Budget curves. You can change the value of the Currency field to another value by opening
the curve configuration window.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 121 of 671



Note

When you run a report, the value of Currency, in the report, is also Project Currency
unless you have selected another value.

The Currency field lists all Active and future currencies from the Exchange Rates (to access
this: go to the Company Workspace tab, and switch Admin mode; in the left Navigator, select
Standards & Libraries, and then select Exchange Rates). The Show Currency List window
lists the available currencies that you can select.

Derived Curve

The cash flow Data Sources of type = Derived is available to create cash flow curves within
any family (Project/Shell, Summary CBS, CBS, and Business Process (Commitments)).

When creating a cash flow curve within any cash flow family:

• Data Sources of type = Derived must be enabled only when there is at least one non-
Derived (that is, Baseline, Spends, Forecast, Portfolio Budget, or Custom) type of curve in
the family.

• If no non-Derived type of curve exists in the family, all Data Sources of type = Derived are
grayed out.

When the Derived type data sources are enabled, and the user selects such a data source, a
window is displayed that enables the user to enter the details for creating the curve.

The following table explains the fields in the Derived type cash flow curve configuration
window:

Option Description Behavior

Name Captures the name of the cash flow
curve as defined in cash flow data
sources in Admin mode of the
Company Workspace tab.

Same behavior as in existing cash
flow curves-
 

Type Captures the type of cash flow curve
viz., Baseline, Custom, Forecast,
Spends, Portfolio Budget, Derived.

Same behavior as in existing cash
flow curves-

Base Currency Captures the base currency for user
to see and make exchange rate
decisions.

Behavior: Read-Only
Displays the Base Currency as a read-
only value
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Option Description Behavior

Source Curve To select an existing curve which
should be used as the basis of the
‘Derived' curve.

Behavior - Drop-down
List all the non-Derived existing
curves within the family in which the
‘Derived' curve is being configured.
Values are: <Curve Name> (<Type>),
example: Shared (Portfolio Budget).

Note

Derived
curve
cannot be a
source
curve to
create
another
Derived
curve.

Required? (Not Null) - Required
option. The user must select a value
for this drop-down to complete the
curve configuration.

Derived Curve Currency To select the currency that must be
used to convert the ‘Source Curve'

Behavior - Currency Selector
User has the ability to select any
currency from the Exchange Rates
located in Standards & Libraries of
the Company Workspace tab (active
and future)
Required? (Not Null) - Required
option. The user must select a value
for this selector to complete the curve
configuration.

Exchange Rate To define how the exchange rates
must be used so that those can be
applied to the source curve data.
That is, should the exchange rate be
picked up from as defined in the
Exchange Rates located in Standards
& Libraries of the Company
Workspace tab, or should the rate be
‘Pegged' to a value as chosen by
user.

Behavior: Radio button, two options:
Float, Peg
Default Value = Float
When user selects the option ‘Float',
another drop-down option appears:
‘Use Rate as' (see below) .
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Option Description Behavior

Use Rate as To choose how to make use of
exchange rate data located in
Standards & Libraries of the
Company Workspace tab, especially
if more than one rate is found for a
given period (month / year)

Behavior -Radio button
Values:
• At the beginning of the period
• At the end of the period
• A weighted average for the

period
Required? (Not Null) - Required
option if ‘Exchange rate' = ‘Float'.
If the user selects OK on the window
without selecting this option, the
following message appears: Invalid
data entered in the following field(s):
Input Required: Use rate as.

If you choose the option ‘Exchange Rate' = ‘Peg', the system provides another block titled ‘Peg
Rate as':

• If Base Currency = Project Currency, then Peg Rate options should be available for
conversion Base Currency -> Derived Curve Currency

• If Base Currency ≠ (not equal) Project Currency and Project Properties list the conversion
Base Currency -> Project Currency as ‘Peg' option, then also behavior should be same as
above, that is, list options only for Base Currency -> Derived Curve Currency

• If Base Currency ≠ (not equal) Project Currency but Project Properties list the conversion
Base Currency -> Project Currency as ‘Float' option, then peg rate options are available for
both:

– Base Currency -> Derived Curve currency

– Base currency -> Project Currency

The following explains the Derived' curve ‘Peg' Rate options:

Option: Peg Rate options

Description: To define the value by which the exchange rate must be pegged. The user will
have to enter a value manually or point to an attribute on Shell Attribute Form / single record
BPs within the shell, or choose if they want to use the pegged rate from shell properties. In the
latter case, the system will look into the value of the data element each time when rendering
the curve.

Behavior: Behavior - Radio button

Base Currency -> Derived Curve Currency: There should be helpful text informing user that
conversion is for 1.0 Base Currency -> Derived Currency (text: 1.0 Base Currency =) This is be
followed by three options:

• Constant

• Dynamic

• Use Project Rate

Default Radio Option: Constant

If you select 'Constant', the system opens a field (DD = Decimal Amount). The decimal places
only appear when user types a digit after decimal point; otherwise, an integer value will appear.
The field lets the user enter an Integer or Decimal value.
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Default Radio Option: Dynamic

If you select ‘Dynamic', the system enables two drop-downs which will capture the Data Source
for the multiplication factor:

Drop-down 1:

The Shell Attribute Form of the current shell within which curve is being created.

The Shell Attribute Forms of all parent/grandparent shells of current shell in which curve is
being created (that is, attribute forms of all shells in hierarchy of current shell, up to the root).

All single record BPs within the shell in which curve is being created.

The above should be prefixed by identifiers ‘Shell Attribute Form / <Shell name>', or ‘Single
Record BPs / <BP name>. For example:

Shell Attribute Form / All Properties

Shell Attribute Form / Buildings

Shell Attribute Form / Sites

Single Record BPs / Project Information

Single Record BPs / Important Contacts

…

Drop-down 2:

Lists all linked and custom Data Elements from the selected source form whose Data Definition
= Integer / Decimal Amount / Currency Amount. (No standard elements)

The user can change the location / hierarchy of a shell. So the above two drop-down values
must be refreshed each time the curve is refreshed.

Note

If the user chooses the options ‘Constant' / ‘Dynamic', the user must define a value
(Constant integer/decimal or Dynamic data source). If not selected, the user will see a
standard prompt after selecting ‘OK':

‘Invalid data entered in the following field(s): Input Required: ‘Constant' or ‘Data Source'

The user can choose to use the third option: ‘Use Project Rate' Selecting this option does not
open up any additional field, but the system picks up the exchange rate as defined in project
properties (described in Peg rate as ‘Use Project Rate' section below). The user receives an
applicable error message in either of following scenarios:

• The user selects a ‘Derived Curve Currency' which does not exist in Project Properties
(Message: Selected currency is not defined in project.), or

• The user selects a ‘Derived Curve Currency' which is listed in Project Properties, but its
conversion rate is set to ‘Float' (Message: Selected currency does not have pegged rate
within project.).

Error should be presented when user selects ‘OK' on curve configuration window.

Base Currency -> Project Currency
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The radio options are for user to select how to use the rate from the Standards & Libraries
module of the Company Workspace tab (label: Use Rate as).

The radio options are visible only if Base Currency ≠ Project Currency AND rate Base
Currency -> Project Currency is set as ‘Float' in project properties.

Options same as when user chooses to ‘Float' rate:

You can choose to use the rate as:

• At the beginning of the Period

• At the end of the period

• A weighted average for the period

Default value: At the beginning of the period.

Note

This block ‘Peg Rate options' is displayed only if ‘Exchange Rate' is selected as ‘Peg'.

The following provides some scenarios.

User selects the Peg Rate option for Base Currency -> Derived Curve Currency as = ‘Use
Project Rate', and the curve configuration is successful (that is, ‘Derived Curve Currency' is
listed in Project Rate with a pegged conversion rate).

The user then goes to Project Properties and changes the exchange rate for Base Currency ->
Derived Curve Currency as ‘Float', and reopens the cash flow.

Because the curve has not been refreshed, the cash flow worksheet continues to show data as
per previous value.

If user opens the ‘Derived' curve configuration window, the message, "Selected currency does
not have pegged rate within project" appears.

If user refreshes the curve, the cash flow worksheet shows all values as zero as the curve
configuration is no longer valid.

If user opens the ‘Derived' curve configuration window, the message, "Selected currency does
not have pegged rate within project" appears.

In case Base currency ≠ Project Currency;

User selects the Peg Rate option for Base Currency -> Derived Curve Currency as either of the
three possible options,

Base Currency -> Project Currency is set as ‘Peg' in project properties. So there are no
additional options to choose from, the curve configuration is successful ;

Then user goes to Project Properties and changes the exchange rate for Base Currency ->
Project Currency as ‘Float';

Then reopens the cash flow;

Because the curve has not been refreshed, the cash flow worksheet continues to show data as
per previous value.

If user opens the ‘Derived' curve configuration window, the options for Base Currency ->
Project currency appears, and the default value is selected as ‘At the beginning of the period'.
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If user refreshes the curve, the cash flow worksheet values are refreshed as per the options for
Base Currency -> Project Currency.

When user selects a currency to derive the curve, the system uses the data from source curve
per period and convert it into the selected currency as per the float or peg exchange rate
option as selected by user within curve definition:

If user chooses the ‘Float' option, the system uses the exchange rates as defined in the
Exchange Rates section of the Standards & Libraries module located in the Company
Workspace tab.

If the user chooses ‘Peg' option, exchange rate values should be as per user selection in the
block ‘Peg Rate as'.

See following sections on how the derived curve should calculate its data per period.

Note

The user can select the currency to be same as source curve currency. In that case,
the derived curve would be same as source curve, exchange rates would not apply.

Exchange Rate = Float (Rate at beginning of the period)

The user can select the Derived curve definition such that the exchange rate for currency
conversion from source to destination is picked up from the Standards & Libraries module in
the Company Workspace tab in such a way that the Rate from the beginning of the period is
used.

In other words, when doing the currency conversion, of all the available rates for a given
period, the system selects the Rate closest to the beginning of the period.

Note

If more than one rate is defined for the same day, the system picks the latest rate on
that day. If no exchange rate is available for a past date, the system uses zero.

Exchange Rate = Float (Rate at the end of the period)

The user can select the Derived curve definition such that if multiple exchange rates are
available for a given period (month / year), the system uses the rate ‘At the end of the period'.

In other words, when doing the currency conversion, of all the available rates for a given
period, the system selects the Rate closest to the end of the period.

Exchange Rate = Float (A weighted average for the period)

If the user chooses to apply the exchange rate as a weighted of all values for a given period
(Exchange Rate = ‘Use a weighted average for the period'), the value will be based on the
number of days in a given month. That is, the total of all "Rate * No. of days it is applicable
during the period" divided by "Total number of days within the period~" (~Month / Year).

When the Exchange Rate = ‘Float', Oracle recommends that the user set a ‘Refresh' frequency
(for more information, see Refreshing Data in Cash Flow Log), for the Derived curves, to cover
the following scenarios:

Scenario 1
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Future Exchange Rates from the Standards & Libraries module of the Company Workspace
tab can get changed with time. If ‘Derived' cash flow curve is not set to automatic refresh, it will
continue to hold values as per older exchange rate values (unless manually opened &
refreshed)

Scenario 2

The ‘Source Curve' might undergo a change in its configuration / values. If ‘Derived' cash flow
curve is not set to automatic refresh, it will continue to hold values as per older source curve
data (unless manually opened & refreshed).

Exchange Rate = Peg

This option means that the user does not want to use exchange rate as captured within the
Exchange Rates section of the Standards & Libraries module of the Company Workspace tab,
but the user prefers to define the rate as one of the following:

• Constant

• Dynamic

• Use Project Rate

If Constant:

To do the currency conversion (1.0 Base Currency = <constant value> Derived Curve
currency), the system uses the constant value entered by the user.

The source curve defaults to be in Project currency. If Base Currency ≠ Project Currency, the
system picks the exchange rate for Base Currency -> Project Currency from Project Properties
and makes appropriate conversion to calculate the Derived curve in Derived Currency as
selected by user.

If Base Currency -> Project Currency in Project properties is set as ‘Float', the system uses the
option as selected by user for ‘Base Currency -> Project currency' conversion.

The system picks rates from the Exchange Rates section of the Standards & Libraries module
of the Company Workspace tab by using one of the following options selected by user:

• At the beginning of the period

• At the end of the period

• A weighted average for the period

If Dynamic:

When rendering the curve, the system accesses the Data Element (DE) selected by the user
and uses the value as the exchange rate to do conversion (1.0 Base Currency = <Selected DE
value> Derived Curve currency).

If the DE value is blank/null (in source Shell Attribute Form/single record BP), the system
applies zero as the exchange rate.

If Base Currency ≠ Project Currency, the system does one of the following:

• Picks the exchange rate for Base Currency -> Project Currency from Project Properties

• Calculates the Derived curve (in Derived Currency) as selected by user.

If Use Project Rate:

The exchange rate is pegged as specified in the shell properties.

If Base Currency ≠ Project Currency, the system does one of the following:
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• Picks exchange rate for Base Currency -> Project Currency from Project Properties

• Calculates the Derived curve (in Derived Currency) as selected by user.

Note

For Commitment type curves, user can flip the view between Project and
Transaction currencies. The system calculates for Source Curve data -> Derived
Curve data by taking the source data in Project currency.

When the Exchange Rate = ‘Peg', Oracle recommends that the user set a ‘Refresh' frequency,
for the Derived curves, to cover the following scenarios:

Scenario 1

Peg rates as defined in project properties might undergo a change. If ‘Derived' cash flow curve
is not set to automatic refresh, it will continue to hold values as per older pegged exchange
rate values (unless manually opened & refreshed).

Scenario 2

The ‘Source Curve' might undergo a change in its configuration / values. If ‘Derived' cash flow
curve is not set to automatic refresh, it will continue to hold values as per older source curve
data (unless manually opened & refreshed).

For all types of Cash flow families, the ‘Derived' curve values are always displayed in its
currency, as selected by user in curve configuration window.

For Commitment type cash flow families, the user can choose to view the family curves in
‘Project' / ‘Transaction' currency.

In either case, the ‘Derived' curve renders in the currency, as selected by user for the ‘Derived'
curve configuration window, regardless of whether the rate is ‘Float' or ‘Pegged'.

The following explains special scenarios related to the exchange rate.

Special Scenario 1

The user selects a ‘Source Curve' while configuring the ‘Derived' curve;

Completes ‘Derived' curve configuration and selects ‘OK';

Removes the ‘Source Curve' itself from the cash flow family definition.

In this scenario:

When the user opens the curve worksheet, the derived curve will render all values as zero,
regardless of whether the cash flow family has been refreshed or not.

When the user opens the curve configuration window, the ‘Source Curve' drop-down continues
to show original value. When the user selects ‘OK', the message, "Invalid curve configuration"
is displayed.

Special Scenario 2

The user selects the ‘Exchange Rate' as ‘Peg' > Peg as ‘Dynamic', and then chooses a data
source DE from grandparent shell attributes.

The user completes ‘Derived' curve configuration and selects 'OK'.

The user changes the location of shell in which the curve was defined.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 129 of 671



In this scenario:

If the new parent is the same type of shell (or another shell having the data Source DE on its
attribute form), this is not an error scenario. The curve renders by using the Rate value from
new location.

However, if the new parent does not have the Data Source DE on its attribute form, the curve
configuration is invalid:

When the user opens the curve worksheet, the Derived curve renders all values as zero.

When the user opens the curve configuration window, the Data Source continues to show
original value. When the user selects ‘OK', the message, "Invalid curve configuration" is
displayed.

Special Scenario 3

The user selects a ‘Source Curve' while configuring the ‘Derived' curve,

The user completes ‘Derived' curve configuration and selects 'OK'.

The user removes the ‘Source Curve' Datasource from company Workspace Cash Flow
Datasources definitions.

In this scenario:

When the user opens the curve worksheet, the Derived curve (as well as the source curve)
renders all values as zero, regardless of whether the cash flow family has been refreshed or
not.

When the user opens the Derived curve configuration window, the ‘Source Curve' drop-down
shows original value, and when the user selects OK, the message, "Invalid curve
configuration" is displayed.

Monthly Actuals (Spends) for Derived Forecast Curve

If the checkbox is selected in the configuration and then in the Portfolio Manager, the user will
be able to the see the monthly breakdown for actuals and the values seen would be read-only
for months prior to the current month for the current year. The behavior and validation, which
exist in support for monthly actuals for Forecast curve, is available for Derived forecast curve
as well.

Actuals (Spends) for Derived Actuals (Spends) Curve

If Derived Actuals (Spends) curve is defined, the system uses the Derived Actuals (Spends)
curve data, and the derived forecast data will be pushed from cash flow to PPM. The Derived
Actuals (Spends) data links to the source actuals.

In case of multiple Derived curves for the same project with inconsistent settings (either
different currency or settings such as float versus peg), a cumulative data value is displayed in
the project currency, which is used by PPM, and the red triangle is displayed against that cell to
depict the inconsistency.

When you hover over, this warning message is displayed: {ppmname} Portfolio Manager
received data from multiple actuals curves that have inconsistent settings.

The correct value will be seen after the settings are corrected.

Custom Curve
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You can create a Custom curve when you want to create and compare curves in a Cash Flow
worksheet, but you do not want to associate them with data sources of the other curve types
(Baseline, Forecast, Actuals (or "spends"), or Portfolio).

The following topics explain how to add a Custom curve for cash flow by:

• Project/Shell

• Summary CBS or CBS

Custom curves are not available for cash flow by Business Process (Commitments).

The Custom curve setup is essentially the same as setting up Baseline curves.

Note

The following procedures describe how to add a curve type to an existing cash flow
(using the Detail Level column of the Cash Flow log for the project/shell) that does
not have a curve.

Adding Custom Curve for Cash Flow by Project or Shell

To add a Custom curve for cash flow by Project/Shell:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option.

3. In the General pane of the Cash Flow Properties window or the Cash Flow Properties
worksheet, select Project/Shell.

4. In the Curves pane select Custom from the Curves drop-down list.

5. In the Custom window, complete the fields using the information in the table below.

6. When finished, select Save & Close to save the custom curve.
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Property Description

Cost

Note

You can choose the cost
column when creating a curve
in a project/shell but not in
templates.

Select one of the following options:
• Manual: Select this amount to manually enter

amounts for each period. This option will be
available if you have chosen Manual in the
Distribution drop-down list. You can enter cost
information in the Total field on the worksheet.

• Distribute amount from Cost Sheet Column:
Select this option to use the default distribution
profile. This option will be available if you have
chosen Auto by default profile in the Distribution
drop-down list. Examples of column: Approved
Budget Revisions, Approved Commitment Changes,
Approved Contracts, and so forth.

Schedule Lets you define the range of dates (what dates to start
the curve and end the curve) to use to plot the cash flow
data.

Note

If you choose to take dates
from the schedule sheet
elements, the system uses the
Master schedule sheet for the
project/shell.

Select one of the following options for each date:
• Manual: Lets you manually enter the date in the

cash flow worksheet.
• Use dates from Schedule Sheet: Lets you select a

schedule sheet (from the Select schedule sheet
drop-down). You can populate the From and To
dates according to the schedules available
(Example: Actual Start Date and Actual Finish Date)
pertinent to the schedule sheet that you have
selected for the Select schedule sheet drop-down.
If these dates are changed on the selected schedule
sheet, the changes will be reflected on cash flow
after the next refresh of the curves.

• Use dates from Activity Sheet: Lets you select an
activity sheet (from the Select Activity Sheet
window).
After you select using dates from an activity sheet,
you must determine the values for the Project
Type, From Date, and To Date fields.
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Property Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. This option
lets you select a distribution profile to use as the default
distribution profile for the curve.
Select one of the following options for how to distribute
the data automatically between cash flow time periods:
• Manual: Select this option to enter values in each

field manually.
• Company Level: Select a pre-determined method

for distribution. Your options are: Linear, S curve,
Front Loaded, Back Loaded.

• Project Level: Select from a list of available project
levels.

Variance Select Inflow or Outflow or leave the field empty.

Adding Custom Curve for Cash Flow by Summary CBS and CBS

To add a Custom curve for cash flow by both Summary CBS and CBS:

1. Select the cash flow from the Cash Flow log.

2. Select the gear menu ( ), and select the Properties option to open the Cash Flow
Properties window (or the Cash Flow Properties worksheet).

3. In the General pane of the Cash Flow Properties window, select Summary CBS, or CBS
from the Detail Level drop-down list.

4. In the Curves pane of the Cash Flow Properties window, select Custom.

5. In the Custom window, set up the following parameters, for Summary CBS, or CBS:

Property Description

Cost Select your cost source as one of the following options:
• Manual: Select this option if you want to manually

enter amounts for each period. You can enter cost
information in the Total field on the worksheet.
This option is available if you select Manual in the
Distribution drop-down list.

• Distribute amount from Cost Sheet Column:
Select this option if you want to use the default
distribution profile. This option is available if you
select Auto in the Distribution drop-down list. For
example, columns such as Approved Budget
Revisions, Approved Commitment Changes, Approved
Contracts.
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Property Description

Schedule Define the range of dates to use for plotting the cash
flow data. These are the dates you specify to start the
curve and end the curve.

Note

If you choose to take dates
from the schedule sheet
elements, the system uses the
Master schedule sheet for the
project/shell.

Select one of the following options:
• Manual: Select this option if you want to manually

enter the date in the cash flow worksheet.
• Use dates from Schedule Sheet: Select this option

if you want to select dates from a schedule sheet.
Select a specific sheet from the Select schedule
sheet list, and proceed to enter dates in the From
Date and To Date fields to plot the cash flow curve
from the selected schedule sheet. For example,
Actual Start Date and Actual Finish Date. If these
dates are changed on the selected schedule sheet,
the changes will be reflected on cash flow when the
curves are next refreshed.

• Use dates from Activity Sheet: Select this option if
you want to select dates from an activity sheet.
Select a sheet from the Select Activity Sheet
window, and proceed to specify the Project Type,
From Date, To Date, and Periods for Cost
Distribution to plot the cash flow curve from the
selected activity sheet.

Project Type If you chose the Schedule as Use Dates from Activity
Sheet, select the project as either Baseline or Current.

From Date If you chose the Schedule as Use Dates from Activity
Sheet, select the start date to use for plotting the cash
flow curve.

To Date If you chose the Schedule as Use Dates from Activity
Sheet, select the end date to use for plotting the cash
flow curve.
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Property Description

Distribution Distribution profiles are used to distribute data
automatically in the cash flow worksheet. This option
lets you select a distribution profile to use as the default
distribution profile for the curve.
• Manual: Select this option if you want to enter

values in each field manually.
• Auto: Select this option if you want to specify a

default distribution profile for initial display and
calculations in the cash flow worksheet. If you
change the distribution profile from the worksheet,
the default profile is also updated to reflect the
current selection. To specify a default distribution
profile:

1. Select the CBS Profile Distribution button.

2. In the Distribute by default profile CBS
window:

a. Select a predetermined distribution method
(at the Company Level or Project Level)
from the Set Profile drop-down list.
The distribution profiles for this field are
defined in the following locations:
– Go to the Company Workspace tab,

and switch to Admin mode. In the left
Navigator, select Standards &
Libraries, select Cash Flow, and then
select Distribution Profiles.

or
– Go to the shell tab, and switch to User

mode. In the left Navigator, select Cost
Manager, and then select Cash Flow.
From the toolbar, select Actions, and
then select Manage Distribution
Profiles.

b. Select one or more WBS codes from the list,
and select Update.

Periods for Cost Distribution This field displays only if you have selected the
Schedule option as Use Dates from Activity Sheet, and
Distribution as Auto.
Select any of the following options to specify how to
distribute the costs based on the activity schedule:
• Consecutive Periods: Select this option to distribute

costs based on the profile from the earliest start to
the latest finish dates across activities for each CBS
or Summary CBS code. This is the default option for
new or existing curves if you selected Schedule as
Use Dates from Activity Sheet.

• Exclude Gap Periods: Select this option to
distribute costs by honoring gaps between activities
if there are multiple activities for the same CBS
Code.

• Honor Working Days: Select this option to
distribute costs based on the working days of
activities.

Variance Select Inflow or Outflow or leave the field empty.
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Creating Project or Shell Level Cash Flow Curves

There are multiple ways to create a cash flow curve or worksheet.

• You can create a cash flow curve manually.

• You can create a cash flow curve from a template.

• You can also create a cash flow curve by coping an existing cash flow curve.

• You can also create a Summary Cash Flow curve. See Creating a Summary Cash Flow
Curve.

Cash flow curves require a data source which your administrator can create in the Standards
& Libraries module of the Company Workspace tab. For details, refer to the Unifier Modules
Setup Administration Guide.

Note

• You must have permission to access and configure cash flows.

• To prevent incorrect reporting in the cash flow and associated curves, do not
create a project without a cost sheet. Currently, you can create a Project/Shell
Detail level cash flow in which the Actuals curve properties receives data from the
Cost Sheet Columns through a shell template even though the cost sheet is not
defined in the destination shell. You must manually update the Actuals curve
properties after the cost sheet is created.

To change the order of the Cash Flow curves, on the cash flow worksheet graph:

1. Go to the Cash Flow log, and select the cash flow.

2. Open the gear menu ( ) for the selected cash flow and select Properties to open the
Cash Flow Properties window.

3. On the right pane, hover over Drag to reorder ( ) for the curve that you want to move,
right-click the icon and hold.

4. Move the curve to where you want it to be displayed on the cash flow worksheet graph and
release the hold.
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Note

Changing the curves order in the Cash Flow Properties window will also change the
curve order in the All Curves tab of the cash flow worksheet.

The following sections describe the basics of how to create a project/shell level cash flow curve
worksheet.

Creating a Project or Shell Cash Flow Curve Manually

To create a project/shell cash flow curve manually:

Note

The red asterisk next to a field box indicates that the field is a required field. You will
not be able to save your changes without entering a value in that field.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the toolbar, select Create drop-down list and select Manual to open the New Cash
Flow Worksheet window, as shown below.

4. Enter values in the fields, as explained in the following sections.

5. To save your changes and create a new cash flow, select Save & Close. To discard your
changes, or close the window, select Cancel.
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Entering Values in General Pane

Enter values in the following fields, as described below.

Name: Enter a unique name for the curve in this field.

Description: (Optional) Enter a brief description in this field.

Detail Level: The selected option determines the level of data the cash flow curves will display.
You can select one of the following options:

• Project/Shell: To track your cash flow for the entire project/shell. For example, Baseline
and Actuals curves might chart the budget and cash outlay across the entire project.

• Summary CBS: To track cash flow by summary CBS codes. To be able to select this
option, the Cost Sheet used in the project/shell must be a tree structure. If you select this
option, the system sets the Summary CBS Level to 1 by default. You can select another
level, based on what is available in the Cost Sheet.

• CBS: To track the cash flow within a project/shell at the CBS Code level. This allows you to
track the cash flow across the project for specific CBS Codes, or for all CBS Codes.
Oracle recommends that you define unique leaf level cost codes, in cost sheets, and use
those unique leaf level cost codes in their cash flows.

Business Process (Commitments): To track the cash flow associated with a particular BP
record and its line items. This includes, for example, a base contract and optionally their
referenced Change Commits. This option lets you select from:
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• Business Process: Select the drop-down menu, and choose a business process. Listed
are the Project/Shell level business processes of type "Base Commit." When creating a
template, choose the one that is likely to be used in the projects/shells the template will be
used in. When creating the curve in a Project/Shell from the template, you may need to
verify that the business process chosen here is active in the project/shell, or pick another
from the list.

• Reference Elements: The worksheet will display the reference elements. By default, the
Record Number will display as the number. You can select the drop-down menu and
choose an element to display as the Name (Record Number, Status or Title).

• Base Commit Record: This is selectable in a project/shell, but not in a template. Choose
the commitment record from the list of available records in the project/shell. Each
commitment record can be selected only once.
You can set up the automatic creation of a cash flow curve when a Base Commit record is
created and completed or reaches a particular step. This is done in the BP Setup for the
business process.

Filter CBS Codes: Specify Filter CBS Codes (for hierarchical CBS structures only) that are
included in the cash flow data. If no codes are specified, the cash flow curves will reflect all the
CBS codes present on the project cost sheet.

Filter Summary CBS Codes: Specify Filter Summary CBS Codes (for hierarchical CBS
structures only) that are included in the cash flow data. If no codes are specified, the cash flow
curves will reflect all the CBS codes present on the project cost sheet.

Manage Filters: If you selected Project/Shell, Summary CBS, or CBS, you can refine the list
of codes included. To do so, select Manage Filters. (The names of the subsequent pages and
options changes based on whether you are filtering CBS codes or Summary CBS codes.) The
Filter [Summary] CBS Code page lists all codes currently included in the filter. To add
additional codes, select Add [Summary] CBS Code. On the Cost Code Picker page, select
the applicable codes, and then select Add & Add More if you want to save your changes and
add additional codes or select Add & Close to save your changes and return to the previous
page. To save the selected cost codes, select Done.

Rollup cashflow data to company?

Yes: The curve will roll up to company cash flow the next time the curves are refreshed.

No: The curve will not roll up to company cash flow the next time the curves are refreshed.

Time Scale: Your Period Type options are:

• Standard Planning Period

• Financial Periods

Proceed to set the time (monthly or yearly) and format.

To save your changes, select Save & Close. To discard your changes, or close the Cash Flow
Properties window, select Cancel.

Entering Values in General Pane (More Options)

When you select More Options in the General pane, the More Options window opens, as
shown.
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The More Options window contains the following tabs on the left pane, and each tab provides
additional options for the cash flow. Enter values in the fields of the following tabs, as
described below.
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Tab Description

Period Close Settings tab This tab lets you set the option: Enable auto snapshot
If you select this option, then:
If you selected Month for Time Scale: You can choose a
specific date each month to automatically take a
snapshot, or specify a particular day (such as the first
Monday of the month).
If you selected Year for Time Scale: You can specify the
exact date to take the snapshot each year (or a
particular day such as the first Monday of January).
After an auto-snapshot is taken, the curve will be
refreshed immediately. Actuals (or "spends") will
resume after the auto-snapshot is complete.
Examples of using Enable auto snapshot on, Cutoff
spends, and Resume Spends
Company A wants to take an auto snapshot of its cash
flow data every time period. Company A would choose a
particular date (such as the 3rd of the month for Month,
or January 3 for Year). The system would take the
snapshot and refresh the cash flow curve. They do not
select the Cut off spends option.
Company B regularly reviews and revises forecast
projections during fixed days every time period. Because
it does not want new Spends records to hit the Cash
Flow Worksheet during this period, they choose the Cut
off spends option. This option requires that the Enable
auto snapshot is selected first. The company sets this
option so that an auto snapshot is taken of their changes
just before spends are resumed. Snapshots can then be
used for comparison of previous forecasts with the
current month. Any spends records that came in during
the forecast period are not lost; the Resume Spends
option determines whether those spends records will be
included in the previous month's cash flow, or pushed to
the next time period.
Cutoff spends
This option is applicable for Actuals (or "spends") type
curves.
Selecting this option will temporarily stop spends
business processes (for example, Invoices) from hitting
the Cash Flow Worksheet during analysis periods.
The Enable auto snapshot option must be selected first.
Actuals (or "spends") will resume after the auto-
snapshot is complete.
If no value is specified, the last date of the current
month is presumed.
The system marks the time of the Cutoff spends date at
the beginning of the day. For example, on June 30, the
data can become locked at the beginning of the day and
not at the end of the day, therefore, preventing the user
from making any last minute changes before the start of
the next month.
Apply Spends to
The selections under this period close settings option let
you apply spends to an effective date or before/after a
Cutoff spends date.
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Tab Description

By default, Cutoff spends will resume immediately after
an auto-snapshot is taken.
If there is a gap between the Cutoff spends date and the
Enable auto snapshot date, any spends that came during
that period are not lost.
For example, if a Cutoff spends date is October 26 and
the Enable auto snapshot on date is November 2, (and
the Time Scale is monthly) that defines the freeze
period. Any spends that come in on October 27, 28, 29,
30, 31, and November 1 will not hit the cash flow sheet
during the freeze period. After the Enable auto snapshot
on date is reached, spends will be included back in
October for spends (Oct 27-31) or November for spends
(Nov 1-2), and the effective date will be retained.
The same month/year as the effective date
The text of the options under Apply Spends to change
based on the selection that you made for the Time Scale
(By: Month or By: Year).
If this option is chosen, spends data is included back in
the current period after the freeze period is lifted. The
final output is similar to the case where no period close
settings are applied because the effective date is
retained. Spends for Oct 26-31 will be included in
October and Nov 1-2 spends will be included for
November.
For example, if the cutoff date is the 26th of October and
the snapshot date is the 2nd of November, the freeze
period is Oct 26 - Nov 2. Any spends that come in on Oct
27, 28, 29, 30, 31 and Nov 1 and 2 will not show on the
cash flow sheet during the freeze period. After the auto
snapshot date is reached, these spends will be included
back in either Oct for spends (Oct 27-31) or Nov for
spends (Nov 1-2) and the effective date will be retained.
The next month/year if after the cutoff date
After the freeze period is lifted, spends data from the
cutoff date to the end of the month will be included in
the next month/year. Spends for Oct 26-31 will be
included in November and Nov 1-2 spends will be
included for November.
The previous month/year if on or before the cutoff date
After the freeze period is lifted, spends data from the
start of the month up to the cutoff date will be included
in the previous month/year. Spends for Oct 26-31 will be
included in September and Nov 1-2 spends will be
included for November.
During the Cutoff spends period, even if automatic
refresh of the curve occurs as set in the Schedule tab,
spends data will not hit the cash flow sheet until spends
are resumed again.

Summary tab This tab lets you automatically add the selected curve to
a selected summary curve. This tab contains a list of
available summary curves to choose from.
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Tab Description

Decimal Options tab This tab provides two options:
• Decimal Options: To specify the number of decimal

places supported for amounts throughout the cash
flow, select this option.

• Use Currency Decimal Precision: To ensure that
the cash flow preserves the number of decimals
used within areas such as Base Currency, Project
Currency, and Transaction Currency, select this
option.

When finished, select Save. To discard changes, or to close window, select Cancel.

Entering Values in Curves Pane

In the Curves pane, the Curves drop-down list lets you add the following curves, based on
available data sources:

• Actuals

• Approved Budget

• Baseline

• Custom

• Forecast

• Original Budget

• Shared Budget

To save your changes, select Save & Close. To discard your changes, or close the window,
select Cancel.

The following provides additional details about cash flow (Detail Curves) levels in a project/
shell.

For Cash Flow by Project/Shell Detail Level

Curves pane

Distribute amount from a Cost Sheet column field and From/To Dates. This is where you add
the curves based on available data sources.

Baseline, Forecast, Portfolio Budget, Derived, and Custom curves

If you want to automatically distribute a Cost amount from a cost column, the column must be
selected in the project/shell. You can choose a curve for a project/shell template if you are
creating a project/shell from the template and are copying both the curve and the cost sheet.

Actuals (or Spends) curve

Because you must select a cost sheet column associated with Spends data in the project/shell,
a Spends curve can only be created in a project/shell (or similar to the above, in a project/shell
template). You will not be able to add an Actuals (Spends) curve in a Company level template.

Forecast curve

If you define Forecast to start at the end of the Actuals (Spends) curve, the Forecast options
use data from the Spends curve. Forecast options can only be set if a Spends curve is present.
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If auto distribution is enabled and the Allow distribution of unassigned amount for manual
override rows option is also enabled, the system uses the same approach for rows that are
manually overridden. Additionally, when the From date is pushed using CSV import in manually
overridden rows, the To date is not pushed because system always considers both the From
and To dates.

Portfolio Budget curve

The Portfolio Budget curve shows current project-row plan data from a Portfolio Sheet. When
plan data changes, it becomes visible in the cash flow graph as a parallel curve so project
managers can clearly see the variance between their projections and portfolio planner-initiated
changes.

From Date and To Date

These fields can be set up to pull start and finish dates from the master schedule sheet in the
project/shell. These can be selected in a project/shell template. At runtime, be sure the master
schedule sheet is set up and has dates in the date element fields chosen for the curves.

In manual mode, the system pegs cost data distribution to the From Date. If there are date
changes, the system shifts the curve on the timeline based on From Date modifications. Each
time period (month or year) on the curve retains the value of the original distribution if the
duration remains the same. If date changes make the cash flow curve duration longer or
shorter, the system will not re-balance or redistribute cost data to match the modified curve
length (the data will change).

For Cash Flow by CBS Detail Level

Curves pane

Use dates from Schedule Sheet field - Effective for the baseline curve only, you can view cost
distribution information by CBS code in a schedule sheet.

The properties window for each curve type displays these settings:

Distribute amount from cost sheet column field and From/To Date fields. This is similar to the
"For Cash Flow by Project/Shell Detail Level" above.

Auto by default profile by CBS field.

For Baseline, Forecast, and Custom curves, you cannot select "Auto by default profile by CBS"
in a Company level template, but you can in the Project/Shell, because this setting relies on
the CBS codes used in the project/shell. You can choose it for a Project/Shell template if you
are creating a project/shell from the template and are copying both the curve and the cost
sheet.

You will not be able to double-click the CBS Summary to view the CBS details.

For Cash Flow by Summary CBS Detail Level

Curves pane

Distribute amount from cost sheet column field and From/To Date fields. This is similar to the
"For Cash Flow by CBS Detail Level" above.

Auto by default profile by Summary CBS field. Similar to CBS detail level, for Baseline,
Forecast, and Custom curves, you cannot select "Auto by default profile by Summary CBS" in
a company level template, but you can in the project/shell and a project/shell template if you
are creating a project/shell from the template and are copying both the curve and the cost
sheet.
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For Cash Flow by Commitment Detail Level

General pane

Business Process and Base Commit Record fields.

For a Commitment detail level, you must select the Base Commit type business process to
use. Ensure that you select business processes that are being used in the project/shell.

In the Base Commit Record field, you must select the record at runtime. This is not selectable
in the template, because records do not exist in templates. The list displays all records you
have permission to view. If a detail curve exists for that record, you will not be able to choose
the same record again.

Curves tab

Include Change Commits and Spends business processes.

If you chose these options, ensure that you have selected Change Commits that are being
used in the project/shell and are associated with the selected Base Commit.

If the cash flow is attached to a Portfolio Manager scenario, the planner-modified baseline
curve appears adjacent to the original baseline in the cash flow worksheet. This lets the project
manager easily spot the difference between the initial projection and the planned suggestion.

Creating a Project or Shell Cash Flow Curve by Auto-distribution

As stated, the Cash Flow module enables you to visualize the distribution of costs planned,
spent, and forecasted against time periods.

Example

If you spent $1000, $1500, $800, and $1000 in four months, you can manually enter each
amount in the corresponding time period, and the data can be displayed in a graphical format.

The manual distribution occurs when you set the distribution as manual and manually enter the
data in all monthly periods; however, you can switch between a manual and a distribution
profile.

You can access the Manual option through the:

• Profile drop-down

• Profile drop-down in Bulk Edit

Note

The Profile column in the worksheet will remain editable, regardless of the
distribution type.

At run time, the Profile column drop-down will have distribution profile options, and you can
choose a distribution profile and amounts that must be distributed in each period. The
remainder will remain in the unassigned column.

When you select the Manual option, the system will retain the amounts of the previous
selections, and they are available for override.

The system uses the latest saved Profile for cash flow, while refreshing the data.
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Distribution profiles are used to distribute data automatically in the cash flow worksheet. Since
entering amounts for each period is sometimes a tedious task, you can use a combination of
manual and auto distributions to enter amounts. So, to make the entry method simpler, you can
select a distribution profile which would automatically distribute the amounts in each period.

Example

You have spent $1000 in 4 months, equally. Instead of entering $250 in each month I can
select a linear distribution curve to distribute automatically.

The system allows you to switch to:

• Auto-distribution in the worksheet and manually override the amounts even if the curve
configuration is set as manual.

• Manual and override auto-distributed amounts, when the curve configuration is set as auto-
distribution.

If auto distribution is enabled and the Allow distribution of unassigned amount for manual
override rows option is also enabled, the system uses the same approach for rows that are
manually overridden. Additionally, when the From date is pushed using CSV import in manually
overridden rows, the To date is not pushed because system always considers both the From
and To dates.

To create a project/shell cash flow curve by auto-distribution:

1. In your shell, go to the left Navigator, select Cost Manager, and then select Cash Flow to
open the log.

2. Select Create, and select Manual to open the New Cash Flow Worksheet window.

3. Enter the required information in the left pane, and on the right pane select the curve type
(for example, Baseline) to open the curve type window.

4. In the curve type window, enter the values for the following fields:

• Cost
You can select Manual (to manually enter cost data), or you can select a cost under
the Distribute amount from Cost Sheet Column (to have a set cost data).

• Schedule
You can select Manual (to manually enter the schedule data), or you can select dates
from the Schedule Sheet or dates from the Activity Sheet.

• Distribution
You can select Manual (to manually enter the distribution data), or you can select a
distribution method from the Company Level, or the Project Level. For example, you
can select S curve from the Company Level block.

• Variance
You can select:

– Inflow (the amount assigned to the project as the budget) or

– Outflow (the amount that has been spent and forecasted to be spent).

5. When you finish, select Add.
The New Cash Flow Worksheet window opens. On the New Cash Flow Worksheet
window, the Curves block on the right pane, the distribution method is set as manual
(Distribution: Manual).

6. Select Save & Close to go back to the Cash Flow log.

7. In the Cash Flow log, open the cash flow that you have created.
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8. Select the split screen  icon, or slider, to see the cash flow details pane. Proceed to use

Expand  or Dock  (upper-right corner) to maximize or to adjust the cash flow detail
pane (All Curves) screen for better visibility.
The cash flow details (the right pane) is presented through a table in the right pane shows
the data for the curves. Each row of the table corresponds to one of the curves on the
graph and displays the curve data in columns. The data in these columns show the
distribution of cost, and the total of cost is the value in the Total field.

• If you are doing an auto distribution by using a distribution profile, the values in these
columns will be calculated based on the distribution percentages.

• If you are doing a manual distribution, you will enter the values into each time period
(distributing the amount in the Total column).

9. In the cash flow details pane, select the curve that you have selected curve type (for
example, Baseline) to open the curve type window. The following scenarios will explain
how to switch manual distribution to auto distribution and conversely.
Scenario 1 (Manual to Auto):

The cash flow worksheet with default distribution profile is set to empty or manual
distribution. The user is trying to override the manually distributed amounts with the auto-
distributed profile selection and save the worksheet.

In this scenario, the Profile column will be editable so that user can quickly select the
profile for distribution, but the selection will not be saved.

The user does not need to provide the distribution for each month in the request to update
the distribution values. The user can use the profile value to distribute the values
automatically.

Scenario 2 (Auto to Manual)

The cash flow worksheet with default distribution profile is set as S Curve. The user is
trying to override the auto-distributed values and save the worksheet.

In this scenario, although the distribution profile is set as auto amounts in each period, the
fields will be editable.

The user can choose to manually override the auto-distributed values, and the Profile will
automatically change to Manual.

The user can also choose a distribution profile and override the distributed amount
manually.

Editing data (Manual to Auto)

When you switch from manual to a Profile the system updates the amounts in each period
accordingly. When you override the auto distributed value, the Profile will change to empty,
automatically.

You must save your changes to the Manual values by selecting Save on the worksheet.

If you select Cancel, the worksheet will reset to the previously saved state.

Profile Options Menu in auto-distributed curve

The Profile drop-down field displays Manual, as an option. The profile will be manual when no
distribution profile is selected in the auto-distribution profile, in the Properties window. You can
switch between manual and distribution regardless of the profile selection, in the Properties
window.

Bulk Edit
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The Profile drop-down field in the bulk edit dialog is editable when the distribution is set to
both auto-distribution and manual distribution. You can bulk update the Profile for multiple
rows from Profile to manual or conversely using the Bulk Edit option within the worksheet.

Refresh

When you refresh the cash flow log, the system will check against each CBS to identify
whether the distribution is manual, or the distribution uses a distribution profile and then
updates the amounts in each period accordingly.

Note

You can have a combination of manual and auto-distributed values in the same curve.

CSV import

Export in Manual Distribution

You can override the manual distributed costs by using a profile from the Profile column, in the
worksheet.

In the Exported CSV template, the Profile column will be empty, but you can provide a valid
profile name to quickly allow the distribution of that row by using profile through a CSV input
request.

User can import the setup or distribution data by using the Import option. The system will
combine the Import options as one single import option.

You can update the values within the Profile column in the worksheet.

If you select a profile as input

In the input CSV template, if you select profile, the system will override the manual distributed
costs with the profile, after a successful import.

Export in Auto-Distribution

The Export option in the worksheet, when the curve has auto-distribution selected should
show all the worksheet column data and Profile column should show 'Manual' option if selected
in UI. User can update the distributed costs when profile is selected as 'Manual' through CSV
import.

When auto-distribution is selected for a curve, the Export option shows data for all of the
worksheet, and the Profile column shows Manual.

You can update the distributed costs when the profile is selected as Manual, through CSV
import.

REST Services

You can update the cash flow curve or the distribution by using RESTful web services. You
can:

• Update profile to manual in auto-distributed curve, or

• Update manual to profile in manual distributed curve.

Creating a Project or Shell Cash Flow Curve From a Template

There are two types of cash flow templates:
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• Company level templates: Created in the Company Workspace (Admin mode).

• Project or shell level templates: Created in a project/shell.

When creating curves from templates, only the properties of the curve are copied; data and
permissions are not copied.

In addition, curve properties such as cost sheet column selections will not be copied, even if
they have been selected in a project/shell template (because you can select a template from
any project/shell template).

You can pre-set curve options, except, for example, the business process records and cost
sheet columns, which are set at run time.

To create a project/shell cash flow curve from a template:

Note

The red asterisk next to a field box indicates that the field is a required field. You will
not be able to save your changes without entering a value in that field.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the toolbar, select Create drop-down list and select From Template to open the
Cashflow Templates window.

4. Select the template that you want from the list and click Select to open the New Cash
Flow Worksheet window.
Note that the following required fields have values per the template that you have selected:

• Name

• Detail Level

5. Enter values in the fields, or edit the properties where necessary.

6. To save your changes and create a new cash flow, select Save & Close. To discard your
changes, or close the window, select Cancel.

When you create a new cash flow curve from a template, the curves configured in a template
are automatically included and within each curve the following details are captured:

• Distribution: The Distribution field is populated either with a distribution profile or
manually.

• Cost: The Cost field is populated manually or with a particular cost sheet column.

• Schedule: The Schedule field is populated manually or with obtaining schedules from
activity sheets or schedule sheets.

• Variance: The Variance field remains not selected.

Within the Forecast curve, all additional values are pulled into their respective fields.

Creating a Project or Shell Cash Flow Curve by Copying

You can copy the data from one curve to another, but the destination curve must be a manual
curve which means that the Distribution, From, and To dates must be manually entered data.
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You cannot copy data to a curve that pulls data from a business process record, cost sheet or
schedule sheet. You can, however, copy data from an auto-distribution curve.

• For example, Spends curves pull actual spends transaction data from a cost sheet column
(usually, cost sheet columns that show spends business process transactions). If you want
to work with this data manually, you can create a custom curve in the Properties, be sure
that all data entry is manual, and then copy the spends curve data to the manual custom
curve.

• For another example, you can make a copy of the original Baseline curve, make
adjustments, and save the revised version.

When you copy data, any existing data in the destination curve will be overwritten with the data
from the source curve.

To create a project/shell cash flow curve by copying:

1. Open the Cash Flow log.

2. Select a curve from the log, and select Copy from the gear menu ( ) to open the New
Cash Flow Worksheet window.

3. Enter a unique Name for the new curve. The Name field in this window will be prefixed
with "Copy of."

4. Make changes as needed, and select Save & Close to complete creating the cash flow
curve and add it to the log.

Auto-creating a Cash Flow Curve from a Base Commit Record

If cash flow is set up in the project/shell you are working in and you have permissions to both
the cash flow and to the commit BP record, you can create and view a Commitment detail level
cash flow worksheet directly from the business process record. There can only be one cash
flow curve per record; that is, if you create the commitment curve through the record, the base
commit cannot be referenced in a new cash flow curve.

The following explains how the auto creation of a Commitment cash flow curve takes place.

• Auto-creation is enabled in the Business Process Workflow Setup for the project/shell. It is
only available for base commit business processes and requires a Commitment detail level
template.

• For a workflow business process, the administrator can specify the step on which to auto-
create a commitment cash flow curve. The curve is created upon reaching that step when
a user accepts the task.

• For a non-workflow business process, the administrator specifies the business process
status that will trigger curve auto-creation from the commitment cash flow template
specified in the business process setup.

• Given the proper permissions, you will see the Cash Flow option in the More Actions
drop-down list on the business process record regardless of whether the auto-create
feature has been enabled in the business process setup. This means that you have the
option to create a commitment cash flow curve manually if the curve has not yet been
auto-created.

• Creating the curve manually (by completing the curve properties, or by copying a project/
shell level template) means the system will ignore an auto-create trigger when the record
reaches the specified step or status.

A few things to keep in mind:
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• If a detail curve exists for the record, selecting the Cash Flow option will open the cash
flow worksheet, which is view-only when opened from here.

• If there are changes to the base commit record (such as additional or modified line item
amounts), these changes will be reflected on the commitment cash flow curve the next
time it is refreshed.

• If the base commit record is terminated after the cash flow curve has been created, the
curve will not be deleted. However, the next time the curve is refreshed, any data will be
removed.

• Because your organization might have multiple cash flow jobs and automatic snapshots
scheduled to run for a multitude of projects, your administrator can use the Cash Flow
Jobs functional node to manage the jobs and auto-snapshots and their impact on system
performance. For more information, see the Unifier General Administration Guide.

To auto-create a Commitment detail level curve from a Base Commit BP record:

1. Open the base commit business process record.
If cash flow is set up and you have permissions set, a Cash Flow option is available in the
More Actions drop-down list.

2. In the upper-right corner, select More Actions, and select Cash Flow.

• If a cash flow Commitment detail level curve exists, the cash flow worksheet opens
automatically.

– If at least one curve summary exists in your project, you can add this commitment
curve to a summary curve listed on the Properties Summary tab.

– You can choose an Incremental or Cumulative view by selecting the applicable
option to the right of View.

• If the curve does not exist yet, the Cash Flow by Commitment window opens.
Choose one of the following options:

– Manual. To create a curve manually, select this option, and click Select.

– From Template. To select a template, select this option, select a template to copy,
and then click Select.

3. Select OK on the Cash Flow by Commit window. The Properties window opens.

4. Complete the Properties window, and select OK. The cash flow worksheet will open to
display the data. The curve will be saved in the Cash Flow log.

To open a cash flow worksheet from a Base Commit record:

1. Open the base commit business process record.
If cash flow is set up and you have permissions set, a Cash Flow option is available in the
More Actions drop-down list.

2. In the upper-right corner, select More Actions, and select Cash Flow.

• If a cash flow Commitment detail level curve exists, a view-only cash flow worksheet
opens.

• If the curve does not exist, the Cash Flow by Commitment window opens. Use this
window to create a curve manually or by copying a template.

Company Level Cash Flow and Roll up Curve

Similar to the Cash Flow Detail Curves in projects/shells, you can conduct the following
operations on a Company level (User mode) Roll up Cashflow curve:
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Note

If you are working in a project/shell, the Cash Flow log displays cash flow Detail
Curves. If you are working in a company (User mode), the log displays the company
level Roll up Cashflow curves.

• Create a Roll up Cashflow

• Set up the status of one or more Roll up Cashflows to Active or Inactive

• Set up the permissions for one or more Roll up Cashflows

• Delete one or more Roll up Cashflows

• Print Roll up Cashflows

• Find Roll up Cashflows within the Cash Flow log

• Select one Roll up Cashflow and preview the associated cash flow curve

However, you cannot work with the data presented in the Company level Roll up Cashflow
curve. This is because a Company level Roll up Cashflow curve data is generated at the
project/shell level and then the data is rolled up to the Company level.

The procedures involved in working with a Company level Roll up Cashflow curve are similar to
the Detail Curves in a project/shell.

The following topics explain the components of a Company level Roll up Cashflow curve.

Company Level Cash Flow Log

To access the Company level Cash Flow log, follow these instructions:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the
Company level Cash Flow log.
If you cannot see the Cash Flow sub-node, ensure that your company administrator has
granted you the necessary permissions to the sub-node.

The Company level Cash Flow log is divided into the following sections, as shown in the
following screen capture:

• Title

• Log

• Properties tabs
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Company Level Cash Flow Log Toolbar Options

The Company level Cash Flow log has the following toolbar options:

• Create

– Roll up Cashflow
Select this option to open the New Roll up Cashflow window.

Enter values in all the fields under the General, Status, and Data Sources. To save
your changes, select Save & Close. To discard your changes, or close the window,
select Cancel.

• Actions
The Actions drop-down list lets you set the status and permissions for one or more
Company level Roll up Cashflow curves. It also lets you delete one or more Company level
Roll up Cashflow curves. The options within the Actions drop-down list are:

– Status

* Active

* Inactive

– Permissions
Lets you open the Permissions window and add permissions for the detail curve or
details curves that you have selected. In the Add field box you can type in the name of
the user, users/group, or group. You can also select to view (View drop-down list)

Users, Users/Groups, or Groups. Use Find on Page  to search and find users
listed within the Permissions window. Use the arrow to go to the next page. When
finished, select Save. To discard changes, or to close window, select Cancel.

Click Select to open the User and Group Picker window. This window lets you select
users, groups, or both from the View drop-down list (Users/Groups, Groups, Users)
and see pertinent details about your selection, as explained below:

* Users/Groups: Displays the Name and Company information for the Users/
Groups, in two columns.

* Groups: Displays the Name information for the Groups, in one column.
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* Users/Groups: Displays the following information for the Users: Name - User
Type - Company - Employee ID - Title - Department - Manager Name

When finished, select Done. To discard changes, or to close window, select Cancel.

– Delete
Lets you delete one or more Company level Roll up Cashflow curves.

• Print 
Select one or more cash flow curves from the log, and select Print from the toolbar to
access the following print options:

– Print
To open a window that lets you select a method to print the selected curves.

– Export to CSV
To open a dialog box that lets you save a Microsoft Excel Comma Separated Values
(CSV) File version of the selected curves, so you can export the file to a desired
destination.

– Export to Excel
To open a dialog box that lets you save a Microsoft Excel Worksheet version of the
selected curves, so you can export the file to a desired destination.

Note

* For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

* If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

• Find on Page 
Use this option to find specific items in the Cash Flow log. When you select this option, the
system inserts a row that lets you enter filter parameters.

Company Level Cash Flow Log

The Company level Cash Flow log lists all the Roll up Cashflow curves.

When you select a Company level Roll up Cashflow curve, in the Company level Cash Flow
log, the gear menu ( ) becomes active. Use the gear menu to:

• Open
Open the selected Company level Roll up Cashflow curve worksheet. See Company Level
Cash Flow and Roll up Curve for details.

• Copy
Copy the information of the selected Company level Roll up Cashflow curve to create a
Company level Roll up Cashflow curve. When you select this option, the New Roll up
Cashflow window opens, which lets you change the copied information to create a
Company level Roll up Cashflow curve. The Name field will contain the name of the
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copied, or selected, Company level Roll up Cashflow curve with the word "Copy" added at
the beginning of the name.

• Delete
Delete one or more Company level Roll up Cashflow curves.

• Status

– Active

– Inactive

• Permissions
Open the Permissions window and add permissions for the Company level Roll up
Cashflow curve, or the Company level Roll up Cashflow curves, that you have selected.

In the Add field box you can type in the name of the user, users/group, or group.

You can select to view (View drop-down list) Users, Users/Groups, or Groups.

Use Find on Page  to search and find users listed within the Permissions window.

Use the arrow (lower-right side) to go to the next page. When finished, select Save. To
discard changes, or to close window, select Cancel.

Click Select to open the User and Group Picker window. This window lets you select
users, groups, or both from the View drop-down list (Users/Groups, Groups, Users) and
see pertinent details about your selection, as explained below:

– Users/Groups: Displays the Name and Company information for the Users/Groups,
in two columns.

– Groups: Displays the Name information for the Groups, in one column.

– Users/Groups: Displays the following information for the Users: Name - User Type -
Company - Employee ID - Title - Department - Manager Name

When finished, select Done. To discard changes, or to close window, select Cancel.

• Properties
Open the Roll up Cashflow Properties window. In this window, you can modify the
general, status, data sources, and time scale information of your selected Company level
Roll up Cashflow curve.

When you select more than one Company level Roll up Cashflow curve in the Company level

Cash Flow log, the gear menu ( ) becomes active and lets you just delete the selected
Company level Roll up Cashflow curve.

Company Level Cash Flow Log Columns

The Company level Cash Flow log has the following columns:

• Name
Displays the name of the Roll up Cashflow curve.

• Description
Displays the description of the Roll up Cashflow curve, if available.

• Time Scale
Displays of the time scale (by month or year, for the period type) for the Roll up Cashflow
curve.

• Status
Displays whether the by month or year, for the Roll up Cashflow curve is active or inactive.
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• Last Saved
Displays the date the Roll up Cashflow curve was last saved.

Company Level Cash Flow Log Properties Tabs

The following lists the Company level Cash Flow log properties tab:

• Preview
When a Company level Roll up Cashflow curve is selected, this tab shows a preview of the
graph.

• Permissions
When a Company level Roll up Cashflow curve is selected, this tab shows, this tab shows
the types of permissions that have been assigned to each user or group.

Company Level Roll Up Cashflow Curve Worksheet

To open a Company level Roll up Cashflow curve worksheet for an existing curve:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the
Company level Cash Flow log.
If you cannot see the Cash Flow sub-node, ensure that your company administrator has
granted you the necessary permissions to the sub-node.

3. Select a Company level Roll up Cashflow curve from the Company level Cash Flow log,
and double-click the curve to open the Company level Roll up Cashflow curve worksheet
window.

The Company level Roll up Cashflow curve worksheet window is divided into two panes. You
can open the right pane by way of moving the split screen (slider) to display the cash flow
details pane, as shown in the following typical screen capture.

Company Level Roll up Cashflow curve worksheet Window Toolbar

The toolbar options are:

• View
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Use this option to Create New View for the worksheet, or to Manage Views that have
been created.

Similar to the errors and warnings in BPs, if there are any alerts or errors on the cash flow
curve (errors due to mismatch in time scale of project cash flows), an error icon is
displayed the "View" controls that shows the number of errors. When you select the error
icon, a window opens that lists the error messages corresponding to the project cash flow
curves.

• Edit View 
When you select Edit View, the Edit View window opens. In this window you can select
the curves that you want to view on the log (for Curves, Inflow, and Outflow). In this
window you can also add columns and group your columns when you select the Group By
tab.

• Print 
Select one or more cash flow curves from the log, and select Print to access the following
print options:

– Print
To open a window that lets you select a method to print the selected curves.

– Export to CSV
To open a dialog box that lets you save a Microsoft Excel Comma Separated Values
(CSV) File version of the selected curves, so you can export the file to a desired
destination.

– Export to Excel
To open a dialog box that lets you save a Microsoft Excel Worksheet version of the
selected curves, so you can export the file to a desired destination.

Note

* For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

* If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

• Snapshot 
For important details about this option, see Working with Company Level Snapshots.

Company Level Roll up Cashflow curve worksheet Window Graphs View

The graphs view pane provides graphs presentation for the following Roll up Cashflow curves:

• Cumulative curve
A Cumulative curve displays the net of all cash flows over a period of time.

• Incremental curve
An incremental curve displays the cash flow for a certain period.
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Company Level Roll up Cashflow curve worksheet Window Cash Flow Details

Note

Use Expand  or Dock  (upper-right corner) to maximize or to adjust the cash
flow details pane (All Curves) screen for better visibility.

The View option in the cash flow details pane lets you switch between the Incremental and
Cumulative data values. The data sources that have been selected in the properties, are listed
within each view selection. If you double-click and open each of the data sources, you can see
pertinent details for that data source, as described below.

Actuals (Spends)

If you select the Incremental view and select Actuals (Spends) (under the Name column), the
actual spent amounts, per time period, are displayed. These values are not editable and
cannot be distributed. You can use the toolbar options to:

• Export
To export one or more curves to a CSV file, which is automatically named after the cash
flow worksheet.

• Refresh
To update the data, or amounts, on the page.

• Find on Page
To find a particular amount.

If you select the Cumulative view, the net of all cash flows, over a period of time is displayed,
with the same toolbar options as for the Incremental view.

Approved Budget

If you select the Incremental view and select Approved Budget (under the Name column),
the actual spent amounts, per time period, are displayed. These values are not editable and
cannot be distributed. You can use the toolbar options to:

• Export
To export one or more curves to a CSV file, which is automatically named after the cash
flow worksheet.

• Refresh
To update the data, or amounts, on the page.

• Find on Page
To find a particular amount.

If you select the Cumulative view, the net of all cash flows, over a period of time is displayed,
with the same toolbar options as for the Incremental view.

Baseline

If you select the Incremental view and select Baseline (under the Name column), the actual
spent amounts, per time period, are displayed. These values are not editable and cannot be
distributed. You can use the toolbar options to:

• Export
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To export one or more curves to a CSV file, which is automatically named after the cash
flow worksheet.

• Refresh
To update the data, or amounts, on the page.

• Find on Page
To find a particular amount.

If you select the Cumulative view, the net of all cash flows, over a period of time is displayed,
with the same toolbar options as for the Incremental view.

Forecast

If you select the Incremental view and select Forecast (under the Name column), the actual
spent amounts, per time period, are displayed. These values are not editable and cannot be
distributed. You can use the toolbar options to:

• Export
To export one or more curves to a CSV file, which is automatically named after the cash
flow worksheet.

• Refresh
To update the data, or amounts, on the page.

• Find on Page
To find a particular amount.

If you select the Cumulative view, the net of all cash flows, over a period of time is displayed,
with the same toolbar options as for the Incremental view.

Original Budget

If you select the Incremental view and select Original Budget (under the Name column), the
actual spent amounts, per time period, are displayed. These values are not editable and
cannot be distributed. You can use the toolbar options to:

• Export
To export one or more curves to a CSV file, which is automatically named after the cash
flow worksheet.

• Refresh
To update the data, or amounts, on the page.

• Find on Page
To find a particular amount.

If you select the Cumulative view, the net of all cash flows, over a period of time is displayed,
with the same toolbar options as for the Incremental view.

Shared Budget

If you select the Incremental view and select Shared Budget (under the Name column), the
actual spent amounts, per time period, are displayed. These values are not editable and
cannot be distributed. You can use the toolbar options to:

• Export
To export one or more curves to a CSV file, which is automatically named after the cash
flow worksheet.

• Refresh
To update the data, or amounts, on the page.

• Find on Page
To find a particular amount.
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If you select the Cumulative view, the net of all cash flows, over a period of time is displayed,
with the same toolbar options as for the Incremental view.

Working with Company Level Snapshots

A snapshot displays the graph, curves, and curve data on the worksheet. Snapshots are not
editable. You can take a snapshot and view it in project, transaction currencies, and reports.
You can manually save a snapshot of a cash flow curve at any time.

Note

Because your organization might have multiple cash flow jobs and automatic
snapshots scheduled to run for a multitude of projects, your administrator can use the
Cash Flow Jobs functional node to manage the jobs and auto-snapshots and their
impact on system performance. For more information, see the Unifier General
Administration Guide.

When you open a company level Roll up Cashflow curve (from the Cash Flow log), you can

select Snapshot  and access the following options:

Option Description

Create Snapshot Use this option to create, or to take a snapshot of a cash
flow curve, at any time. See "To take a snapshot at any
time," below.

Snapshot Log Use this option to view, open, or delete the snapshots
that have been created or taken of a cash flow curve.
The Title, Creator, and Created on data is also provided
on this window.

Properties Use this option to open the Roll up Cashflow Properties
window. You can see the following cash flow properties
information:
• General (Name, Description, Decimal Places, Status,

and Data Sources)
• Time Scale (Period Type, By, and Format)
• Status (Active and Inactive)
• Data Sources (Available Sources and Selected

Sources)

To take a snapshot at any time:

1. Open your cash flow curve.

2. From the toolbar, select Snapshot , and select Create Snapshot.
The Create Snapshot window opens. The window also displays the time stamp of
snapshot for reference.

3. Enter a title for your snapshot, in the Title field, and select Create.

To view a created snapshot:

1. Open the cash flow curve.

2. Select Snapshot , and select Snapshot Log.
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3. In the Snapshot Log, choose a snapshot to view and double-click the snapshot to open
the cash flow curve or worksheet snapshot.

4. Maximize the window to be able to identify the following elements:

• Top block
Containing cost-related at-glance numeric data as well as detailed information, when
you select Show More.

• Bottom block
Containing curves corresponding to the cost periods and variances.

• Screen split 
Select the icon and drag to expand the window. You can use the Expand and Dock
icons (upper-right corner) to adjust this screen. This screen lets you access detail
information for actuals, baseline, forecast, and most other interactive elements, but the
snapshot data is not editable.

To search for a snapshot:

1. Open the cash flow worksheet.

2. From the toolbar, select Snapshot , and select Snapshot Log.

3. In the Snapshot Log, select Find on Page to open the find box for each column (Title,
Creator, and Created On).

4. Proceed to enter a value in one or all the boxes to search and find your desired snapshot.

5. To restore the entire list, select Find on Page.

To delete a snapshot:

1. Open the cash flow worksheet.

2. From the toolbar, select Snapshot , and select Snapshot Log.

3. In the Snapshot Log, select a snapshot, select Delete, and follow the prompts.

To print a snapshot:

1. Open the cash flow worksheet.

2. From the toolbar, select Snapshot , and select Snapshot Log.

3. From the toolbar, select Print , and select one of the following options:

• Print: To open a window that lets you select a method to print the selected curves.

• Export to CSV: To open a dialog box that lets you save a Microsoft Excel Comma
Separated Values (CSV) File version of the selected curves, so you can export the file
to a desired destination.

• Export to Excel: To open a dialog box that lets you save a Microsoft Excel Worksheet
version of the selected curves, so you can export the file to a desired destination.
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Note

– For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

– If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

Creating Company Level Roll Up Cashflow Curve

Creating and managing a Company level Roll up Cashflow curve is similar to creating detail
curves in a project/shell.

Note

The administrator must grant runtime permission to users so the users can have
access to each curve.

Data rolls up to the Company level Roll up Cashflow curve based on the data sources used to
add the individual Baseline, Forecast, Actual (or Spends), Portfolio Budget, Derived, and
Custom curves that make up the project/shell detail curves.

Note

Only project/shell level cash flow curves with Roll-up Status equal to Active will roll up
to the Company level Roll up Cashflow curve.

To create a Company level Roll up Cashflow curve, in the Company Workspace (User mode):

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the
Company level Cash Flow log.
If you cannot see the Cash Flow sub-node, ensure that your company administrator has
granted you the necessary permissions to the sub-node.

You will have all the permissions for the Roll up Cashflow curves that you have created.

3. From the toolbar, select Create, and select Roll up Cashflow to open the New Roll up
Cashflow window, as shown below.

4. Proceed to complete the fields in the New Roll up Cashflow window.
The Data Sources block lists the available sources for you to select.

5. When finished, select Save & Close. to add the new Roll up Curve to the Cash Flow log.
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Company Level Cash Flow and Roll Up Cashflow Properties

You can access the Company level Roll up Cashflow Properties window in two ways:

1. Company level Cash Flow log

a. Select a Roll up Cashflow curve.

b. Select the gear menu ( ), and select Properties.

2. Company level Roll up Cashflow curve worksheet

a. Select a Roll up Cashflow curve.

b. Double-click to open the selected Roll up Cashflow curve worksheet.

c. Select Snapshot, and select Properties to open the Roll up Cashflow Properties
window as shown below.

d. Proceed to complete the fields in the Roll up Cashflow Properties window.
The Data Sources block lists the available sources for you to select.

e. When finished, select Save & Close to add the new Company level Roll up Cashflow
curve to the Cash Flow log.
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Cash Flow Curves in Cost Controls

With Cost Controls, you receive a cost control cash flow that shows Baseline, Forecast, Actual
(or Spends), Portfolio Budget, Derived, and Custom curves using an S-curve distribution
profile.

After your project is in operation, your manager sheets are set up, and the Business Processes
are in use, the system will retrieve the curve data from the Project Cost Sheet to render the
Cost Controls cash flow curves.

For Baseline and Forecast curves, you can enter dates manually or set the Schedule Manager
to control the start and finish dates automatically.

You can create as many Baseline, Forecast, Actual (or Spends), Portfolio Budget, Derived, and
Custom curves as you need in a Cash Flow Worksheet.

Within a Project/Shell, each curve can be created in one of the following detail levels:

• Cash Flow Curve by Project/Shell

• Cash Flow Curve by CBS

• Cash Flow Curve by Summary CBS

• Cash Flow Curve by Commitment (one per base contract)

Note

For a Company level Roll up Cashflow, see Company Level Cash Flow and Roll
up Curve.

The cash flow worksheet allows you to:

• View or enter data
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• View and compare the curves that you added

There are several ways to create a cash flow curve, including:

• Manual creation
You define all curve properties from scratch.

• Templates
You can pre-set curve options, except, for example, actual business process records, and
cost sheet columns, which are set at run time. There are two types of cash flow templates:

– Company level templates, which are created in Standards & Libraries (in Admin
mode).

– Project/shell-level templates, which are created within a Project /Shell template (in
User mode).

See Creating a Project or Shell Cash Flow Curve From a Template.

• Auto-creation
Auto-creation of a commitment curve from a base commit record. In the base commit
business process workflow set up you can associate a cash flow template with any step
except the Creation step. When the base commit record reaches that step, the system will
automatically create a cash flow curve.

See Auto-creating a Cash Flow Curve from a Base Commit Record.

• Copy
You can copy existing curves from the Cash Flow log, or you can copy data from existing
curves.

See Creating a Project or Shell Cash Flow Curve by Copying.

Summary Cash Flow or Summary Cash Flow Curves

A summary cash flow curve is designed to present a consolidated view of cash flows.

A summary cash flow curve:

• Uses the detail cash flow curves to compare the movement of curves against the previous
snapshots, and in the process show differences among curves with respect to time and
schedule.

• Displays Variance and Forecast analyses, similar to the detail cash flow curves.

When you select a summary cash flow, whether it has been manually defined, or it has been
system-defined, the right pane shows the following tabs:

Preview tab

The Preview tab lets you see the graph or chart for the summary cash flow that you have
selected. Under the X axis, you can select Baseline, Actuals, or Forecast curves to display
their graphs or charts for comparison.

Properties tab

The Properties tab lets you see the properties of the summary cash flow that you have
selected. The Summary Curve Properties block on the Properties tab contains the following
information:

• Name

• Status
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• Description

• Detail Curves

– Available Curves

– Selected Curves

Creating a Summary Cash Flow Curve

To create a project/shell summary cash flow curve:

Note

The red asterisk next to a field box indicates that the field is a required field. You will
not be able to save your changes without entering a value in that field.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. From the toolbar, select Create drop-down list and select Summary Curve to open the
Create Summary Curve window.

4. Enter values in the Name, Status, Description fields, and select the detail curves that you
want to summarize or compare.

5. To save your changes and create a new summary cash flow, select Save & Close. To
discard your changes, or close the window, select Cancel.

Activity Sheet as a Schedule Source for the Cash Flow

An Activity Sheet can be a source for cash flow used for Resource and Cost Load Schedules.
The following topics explain the details.

Cash Flow Analysis

Performing cash flow analysis lets you develop an idea about the financial health and liquidity
of your business and determine what is available for you to be used for your business needs.
You can perform cash flow analysis based on the following information when using Planned
costs, Remaining costs, and Actual costs, from the Activity Sheet:

• Budgets

• Forecast projections

• Actuals

Unifier uses the Cash Flow module to determine the financial health of portfolio of projects, or
a single project, or contracts. You can use the Activity Sheet data as a source for the cash flow
curves. Furthermore, you can bring the activities, or assigned resources units or costs, into the
cash flow to track the Budget, Baseline, Forecast, and Spends estimates and compare them to
see the distribution over time.

When you use the Activity Sheet to manage activities and resource assignments from P6, you
can track the Baseline, Forecast, and Actual (Spends) estimates in the cash flow by using
the Activity Sheet data.
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You can manage scheduling in P6, and you can manage costs either in P6 or Unifier
(depending on the schedule type).

When you use P6, you bring the activities, resource assignments, and spread data from P6
into the Unifier Activity Sheet, and from the Activity Sheet the costs and units are rolled up to
the Cost Sheet, by way of the CBS Code, and into the Earned Value Management module.

You can use an Activity Sheet as a schedule source in:

• Project/shell detail level

• Data from early start and late finish date from the Activity Sheet

• Cost Breakdown Structure (CBS) detail level

• Data from CBS code assign to the activities in the Activity Sheet

• Summary CBS detail level

• Date of the summary CBS code in the Activity Sheet

Cash flow can support Activity Sheet Schedules in the following cash flow curves:

• Baseline curve

• Forecast curve

The following is an example for how to create a cash flow based on an Activity Sheet schedule:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cash Flow to open the Cash
Flow log.

3. Select Create to open and select Manual. The New Cash Flow Worksheet log opens.

The New Cash Flow Worksheet page has two panes with the following toolbar options,
blocks, and fields:

Toolbar options:

• Cancel

• Save & Close

General block:

• Name

• Description

• Detail Level
To select the needed detail level, for example project/shell.

• Filter CBS Codes

• Filter Summary CBS Codes

• Manage Filters

• Rollup cashflow data to company?

Time Scale block:

• Period Type

• By

• Format

Right pane:
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• Curves
To select the needed curve, for example baseline curve. When you select a curve, the
curve window, for example Baseline window, opens. In this window, you can select values
for the following:

• Cost
Options include a manual cost creation or from cost sheet columns such as: Approved
Budget Revisions, Initial Budget, Pending Budget Revisions, and so forth.

• Schedule

To establish a schedule manually, or use dates from a schedule sheet, or use dates from an
Activity Sheet. Depending on your initial selection, the picker field enables you to open a
window and specify your selection.

Example

You can select a type of active manual Activity Sheet (custom, import, manual, or profile) or the
System Activity Sheet in the Select Activity Sheet window. The inactive manual Activity Sheets
will not be displayed in the Select Activity Sheet window. In the Select Activity Sheet window,
select Manual to open the curve type window (Baseline window). In the Baseline window, you
can enter values for the following fields:

• Cost

• Schedule

If the manual Activity Sheet does not have a Baseline schedule, only the "Current" schedule
option will be made available, in the Project Type drop-down list.

If you select a System Activity Sheet, the date values (From Date) are from the System Activity
Sheet attribute form.

• Project Type

• From Date

The values are from the manual Activity Sheet or the System Activity Sheet.

• To Date

• Distribution

You have the option of selecting a manual distribution, or a distribution based on a set profile
which is displayed in the drop-down.

• Variance

When finished, select Add to go to the New Cash Flow Worksheet log.

In the New Cash Flow Worksheet log, right pane, select the Curves drop-down field and
select a pertinent option, such as Actuals. This will open the select option window (Actuals
window). In the Actuals window, select the values for the following fields:

• Cost

• Variance

When finished, select Add to go to the New Cash Flow Worksheet log. In the New Cash
Flow Worksheet log, right pane, you will see the added curve, in this case Actuals.

Use the Curves drop-down field to select more curves, such as Forecast, and enter values for
each curve.

When finished, select Add to go to the New Cash Flow Worksheet log. In the upper-right
corner of the New Cash Flow Worksheet log, select Save & Close to create the cash flow.
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When the Cash Flow log displays, you can select on a profile (from the left pane) to see the
preview of the curve on the right pane.

• Select on a profile to open the profile window.

• Select on a curve type tab, for example Baseline, to see the details about that curve type.

At this point, for example, you can check the date values in the curve with the values in the
manual Activity Sheet (in the left Navigator, select Schedule Manager, and then select
Activity Sheet, open the manual Activity Sheet).

You can update your dates from the manual Activity Sheet, within the Activity Sheet sub-
node. After changing the dates, select Save, select Actions, and select Update Baseline.
When finished, go to the Cash Flow sub-node, find the item, open the item, and select
Refresh to see the new dates.

If you select more than one item, or date, you can change the values by using the Bulk Edit
option (toolbar option).

You can use the import and export features to update values.

Using Activity Sheet Data to Track Baseline, Forecast, and Spends in Cash Flow

You can perform Cash Flow analysis based on the budgets, forecast projections, and actuals
received by using the Planned, Remaining Cost, and Actual Costs received from the Activity
Sheet. In summary, for:

Cash Flow curves: CBS Detail, Baseline, and Forecast (Activity level)

Ability to define Baseline and Forecast Cash Flow curves with the Activity Sheet (Activity level)
selected as a source for distribution or cost. In this scenario:

The period distribution for each CBS Code is received at the Activity level, from the selected
Activity Sheet. The value is the sum of all the planned units for each CBS code by the day on
which it will distribute the costs. The schedule is disabled after you select Activity Sheet as the
distribution source.

The cost distribution for each period can either be calculated based on the units and total cost
received from cost sheet column, or based on the cost spread received from Activity Sheet
(Activity level).

You can get data either from the current project or the baseline. If you use Baseline, you can
directly assign CBS codes.

Cash Flow curves: CBS Detail, Baseline, and Forecast (Resource level)

Ability to define Baseline and Forecast Cash Flow curves with the Activity Sheet (Resource
level) selected as a source for distribution or cost. In this scenario:

The period distribution for each CBS Code will be received at Resource level, from the
selected Activity Sheet. The value is the sum of all the planned units for each CBS code by day
which it will be used to distribute the costs. The schedule will be disabled after you select
Activity Sheet as the distribution source.

The cost distribution for each period can either be calculated based on the units and total cost
received from cost sheet column, or based on the cost spread received from Activity Sheet
(Resource level).

You can get data either from the current project or the baseline. If you use Baseline, you can
directly assign CBS codes.
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Cash Flow curves: CBS Detail, Spends (Activity level)

You can define Spends Cash Flow curves when the Activity Sheet (Activity level) is selected as
a source for cost. The value is the sum of all the actual costs for each CBS code per day
across the activities.

Cash Flow curves: CBS Detail, Spends (Resource level)

You can define Spends Cash Flow curves when the Activity Sheet (Resource level) is selected
as a source for cost. The value is the sum of all the actual costs for each CBS code per day
across the activities.

Similar to the P6 Summary Sheet, you can use the Activity Sheet as a source in Cash Flow.

The following table explains the details:

Type CBS

Baseline (Distribution) Activity Sheet (Activity Level)
Sum all the planned units for each CBS code by day
which will be used to distribute the costs. You can select
either the current project or the baseline. If you use
Baseline, you can directly assign CBS codes.
Activity Sheet (Resource Level)
Sum all the planned units for each CBS code by day
which will be used to distribute the costs. You can select
either the current project or the baseline. If you use
Baseline, you can directly assign CBS codes.

Baseline (Cost) Cost Sheet Column
Activity Sheet (Activity Level)
Sum all the planned costs for each CBS code by day. You
can select if this is from the current project or the
baseline. If you use Baseline, you can directly assign CBS
codes.
Activity Sheet (Resource Level)
Sum all the planned costs for each CBS code by day. You
can select if the from the current project or the baseline.
If you use Baseline, you can directly assign CBS codes.

Baseline (Schedule) Schedule is derived from the unit distribution.
Spends (Cost) Activity Sheet (Activity Level)

Sum all the actual costs for each CBS code by day.
Activity Sheet (Resource Level)
Sum all the actual costs for each CBS code by day.

Forecast (Distribution) Activity Sheet (Activity Level)
Sum all the remaining or at completion units for each
CBS code by day which will be used to distribute the
costs. (Schedule disabled)
Activity Sheet (Resource Level)
Sum all the remaining or at completion units for each
CBS code by day which will be used to distribute the
costs. (Schedule disabled)
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Type CBS

Forecast (Cost) Cost Sheet Column
Activity Sheet (Activity Level)
Sum all the planned costs for each CBS code by day.
Activity Sheet (Resource Level)
Sum all the remaining or at completion costs for each
CBS code by day.

Forecast (Schedule) Schedule is derived from the unit distribution.

Note

Be aware that when the cost and schedule are brought in from the System Activity
Sheet or a manual Activity Sheet and the Project Type is Baseline or Current, the cash
flow uses the earliest date across Planned, Actual, or Remaining Cost as the From
Date and the latest date as the To Date.

CBS Type Cash Flow Curve

In a CBS type cash flow curve, you can access the units, or cost data, from the Activity Sheet
according to the CBS Code at one of the following levels:

• Activity

• Resource

Note

Be aware that when the cost and schedule are brought in from the System Activity
Sheet or a manual Activity Sheet and the Project Type is Baseline or Current, the
cash flow uses the earliest date across Planned, Actual, or Remaining Cost as the
From Date and the latest date as the To Date.

Baseline Type Cash Flow Curve

In a Baseline type cash flow curve, you can access the following, from the Activity Sheet, per
CBS code:

• Planned units or costs

• Remaining units or costs

• At Completion units or costs

In this scenario, the costs information originates from one of the following resources within an
Activity Sheet:

• Cost sheet column

• Planned units or costs

• At Completion units or costs
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Note

Be aware that when the cost and schedule are brought in from the System Activity
Sheet or a manual Activity Sheet and the Project Type is Baseline or Current, the
cash flow uses the earliest date across Planned, Actual, or Remaining Cost as the
From Date and the latest date as the To Date.

Forecast Type Cash Flow Curve

In a Forecast type cash flow curve, you can access the following, from the Activity Sheet, per
CBS code:

• Planned units or costs

• Remaining units or costs

• At Completion units or costs

Note

Be aware that when the cost and schedule are brought in from the System Activity
Sheet or a manual Activity Sheet and the Project Type is Baseline or Current, the
cash flow uses the earliest date across Planned, Actual, or Remaining Cost as the
From Date and the latest date as the To Date.

Spends Type Cash Flow Curve

In an Actual (or "spends) curve type cash flow curve, you can access actual costs, from the
Activity Sheet, in addition to costs from the Cost Sheet Column or from P6 Summary Sheets.

In summary, for:

• Cash Flow CBS Detail Curves—Baseline and Forecast (Activity level), you can define
the Baseline and Forecast cash flow curves with the Activity Sheet (Activity level) selected
as a source for distribution or cost.

– The period distribution for each CBS Code will be received at the Activity level from the
selected Activity Sheet. It is the sum of all the Planned units for each CBS code, by
day, which will be used to distribute the costs. The schedule will be disabled after you
select Activity Sheet as distribution source.

– The cost distribution for each period can either be calculated based on units and total
cost received from the cost sheet column, or from the cost spread received from the
Activity Sheet (Activity level).

– You can get the data either from the current project or the Baseline. If you use
Baseline, you can directly assign CBS codes.

• Cash Flow CBS Detail Curves—Baseline and Forecast (Resource level), you can
define Baseline and Forecast curves with the Activity Sheet (Resource level) selected as a
source for distribution or cost.

– The period distribution for each CBS Code will be received at the Resource level from
selected Activity Sheet. It is the sum of all the Planned units for each CBS code, by
day, which will be used to distribute the costs. The schedule will be disabled after you
select Activity Sheet as distribution source.
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– The cost distribution for each period can either be calculated based on units and total
cost received from cost sheet column, or from the cost spread received from the
Activity Sheet (Resource level).

– You can get the data either from the current project or the Baseline. If you use
Baseline, you can directly assign CBS codes.

• Cash Flow CBS Detail Curves—Spends (Activity level), you can define Actual (or
"spends) curve with the Activity Sheet (Activity level) selected as a source for cost. It will
be the sum of all the actual costs for each CBS code, per day, across the activities.

• Cash Flow CBS Detail Curves—Spends (Resource level), you can define Actual (or
"spends) curve with Activity Sheet (Resource level) selected as a source for cost. It will be
the sum of all the actual costs for each CBS code, per day, across the resources.

Note

Be aware that when the cost and schedule are brought in from the System Activity
Sheet or a manual Activity Sheet and the Project Type is Baseline or Current, the
cash flow uses the earliest date across Planned, Actual, or Remaining Cost as the
From Date and the latest date as the To Date.

Activity Sheet with Resource-Loaded and Cost-Loaded Schedules

For all CBS shells, the following Cash Flow curves can get data from an Activity Sheet:

• Baseline

• Forecast

• Spends

Note

To ensure that Cash Flow curves represent CBS codes, schedule dates, and costs
from the baseline and not just the current project, you can manually enter CBS
codes on the Activity Sheet when you switch to Baseline Project View.

When you are defining Baseline, Forecast, and Spends Cash Flow curves (when the detail
level is selected as CBS, based on the schedule type of the source project), the Activity Sheet
is available as a source for:

• Distribution

• Schedule

• Cost

The option is not available for Cash Flow curves when the detail level is selected as:

• By Project

• By Summary

• By Contract

The Cash Flow curve properties window enables you to select to get data from:

• Baseline
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• General

• Schedule sheets

• P6 Source

• Activity Sheet

If you select Activity Sheet, additional options (Cost, Schedule, and Distribution) will be made
available, based on the type of activity sheet that you select. In the case Resource-loaded
Activity Sheet and Cost-loaded Activity Sheet, the schedule is derived from the source.

The other fields in the Cash Flow curve properties window enable you to select the distribution
method and schedule for the Cash Flow curve based on the source of the Activity Sheet.

Note

Be aware that when the cost and schedule are brought in from the System Activity
Sheet or a manual Activity Sheet and the Project Type is Baseline or Current, the cash
flow uses the earliest date across Planned, Actual, or Remaining Cost as the From
Date and the latest date as the To Date.

An Activity Sheet can be linked to more than one source project.

If an Activity Sheet is linked to two or more source projects, and if at least one source project is
duration-based and the other source projects are resource-based, or Cost-loaded, the other
fields in the Cash Flow curve properties window will be based on resource-loaded or cost-
loaded projects.

When the source project and the Activity Sheet (Activity level) are selected as source, the
properties window for the Baseline Cash Flow Curve type enables you to select:

• Where to get the original data

• Activity sheet name

• Data type

• Cost

• Schedule and distribution method

• Variance

For Resource-loaded and Cost-loaded schedules, the properties window for the Baseline Cash
Flow Curve type enables you to select cost, schedule, and distribution. When you select
Activity Sheet, as a source, the Sheet Name drop-down field allows you to select one of the
following system activity sheets, from the project activity sheets:

• System Activity Sheet (Activity)

• System Activity Sheet (Resource)

By default, the System Activity Sheet (Activity) option will be selected.

Note

The Baseline Cash Flow curve type will display the data from the system activity
sheet, if the source is a single project.
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In the properties window, the Project Type drop-down field enables you to select the following
project schedules:

• Current Project

• Baseline Project

These options are available based on the schedules that have been received.

Note

If you do not receive a Baseline project spread, the options above will not be
displayed.

By default, the Current Project option will be selected.

When you select Activity Sheet as the source and Sheet Name as System Activity Sheet
(Activity), the Cost drop-down field allows you to select the following options:

• Manual

• Cost Sheet Columns

• Activity Sheet Columns

The Cost Sheet Columns option enables you to display all the columns of the Cost Sheet.
The Activity Sheet Data Sources will display the Planned, At Completion, and Remaining
Costs, based on the Sheet Name that you have selected.

In the scenarios above, the Cost options are:

Use the Cost option to select one of the cost sources for the Baseline Cash Flow curve type.

By default, the Manual option is selected.

The Schedule & Distribution drop-down field displays all the units based on the Sheet Name
and the project type that you have selected. If you select the Cost as Activity Sheet
Columns, the Schedule & Distribution field drop-down will be disabled while displaying
From Activity Sheet.

The Schedule & Distribution drop-down field displays the following options when you select
Sheet Name as System Activity Sheet (Activity) and the Cost is selected as Cost Sheet
Columns or Manual:

• Planned Total Units

• At Completion Total Units

• Remaining Total Units

By default, the value in the drop-down field will be Planned Total Units.

The following table lists the various selections and results:

When Sheet Name is
selected as:

Project type is selected as: Cost options are: Schedule & Distribution
options are:

System Activity Sheet
(Activity)

Current Project or Baseline
Project

Activity Sheet Columns:
• Planned Total Cost
• At Completion Total

Cost
• Remaining Total Cost

From Activity Sheet option
selected and disabled.
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When Sheet Name is
selected as:

Project type is selected as: Cost options are: Schedule & Distribution
options are:

System Activity Sheet
(Activity)

Current Project/Baseline
Project

Cost Sheet Columns Will show following
options:
• Planned Total Units
• At Completion Total

Units
• Remaining Total Units

System Activity Sheet
(Resource)

Current Project/Baseline
Project

• At Completion Cost
• Remaining Cost
• Planned Cost

From Activity Sheet option
selected and disabled.

System Activity Sheet
(Resource)

Current Project/Baseline
Project

Cost Sheet Column Will show following
options:
• At Completion Units
• Remaining Units
• Planned Units

The following explains Forecast Cash Flow curve properties for when the Activity Sheet is
selected as a source:

• Start at the end of the actuals. Use the drop-down field and select the actuals curve. The
drop-down field displays all the actual curves that have been defined with the Cash Flow
curve family.

Note

The Forecast options will be disabled if the Activity Sheet is the source of data.

• Replace the current period Forecast with the actuals on the cutoff date.

• For the unassigned amount, the auto-distribution options will be enabled. You can select
the redistribution of unassigned amount based on the weighted average calculations.

• The period close settings option is not applicable to Spend, if the period close settings are
received from the Activity Sheet.

The following explains Spends Cash Flow curve properties for when the Activity Sheet is
selected as a source:

In the Spends Cash Flow curve properties, you can select the source of cost as Activity Sheet.
The Spends Cash Flow curve properties has the following Cost and Distribution options,
based on the source that you select:

• Where to bring the approved Spends data from.
The Bring <Spends Curve name> data from drop-down field displays a list of sources
that you can use to bring the actuals cost and distribution. If you select Activity Sheet from
the list, the Sheet Name field value will be activated and provides the list of sheet names,
both at the Activity level and Resource level.

• Sheet name
The Sheet Name drop-down field displays the Activity Sheets in the project, which is a
single activity sheet or the System Activity Sheet. The following are the options available
for the Sheet Name drop-down field:

– System Activity Sheet (Activity)

– System Activity Sheet (Resource)
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• Cost
The Cost drop-down field displays:

– The business process columns that are available in the Cost Sheet.

– The formula columns which are based on the business process.

– The Activity Sheet column, Actual Total Cost, if the Sheet Name is selected as
System Activity Sheet (Activity).

– The Activity Sheet column, Actual Cost, if the Sheet Name is selected as System
Activity Sheet (Resource).

• Schedule & Distribution

– This option displays Actual Total Units when you select Cost as the Cost Sheet
column and the Sheet Name is selected as System Activity Sheet (Activity).

– This option displays Actual Units when you select Cost as the Cost Sheet column
and the Sheet Name is selected as System Activity Sheet (Resource).

• Variance

The following table shows the various selections:

Sheet Name Cost Schedule & Distribution

System Activity Sheet (Activity) Cost Sheet Column Actual Total Units
System Activity Sheet (Resource) Cost Sheet Column Actual Units
System Activity Sheet (Activity) Actual Total Cost From Activity Sheet text selected and

disabled.
System Activity Sheet (Resource) Actual Cost From Activity Sheet text selected and

disabled.

If you select the Cost option, the system draws the Spends Cash Flow curve by using the
Actual Cost spread, Actual Start Date, and Actual Finish Date for each CBS Code, from the
selected Activity Sheet.

The following topics explain the various Baseline and Forecast Budget (Cost Distribution)
Cash Flow curve properties for when the Activity Sheet is selected as a source:

• Baseline curve or Forecast curve when Schedule & distribution are derived from the
Activity Sheet and Cost is derived from the Cost Sheet

• Baseline curve or Forecast curve when Schedule & distribution and cost are derived
from the Activity Sheet

• Baseline curve or Forecast worksheet when Schedule, distribution, and cost are
derived from the Activity Sheet

• Baseline curve or Forecast worksheet when Schedule, distribution, and cost are
derived from the Activity Sheet

When you select the original source as Activity Sheet for the Baseline Cash Flow curve, the
From and To dates and the spread for each CBS Code will be derived from the selected
Activity Sheet and Project Type. Unifier uses the spread data from the selected Activity Sheet
to draw Baseline Cash Flow curve (the period units are coming from the activity spread, and
the cost will be derived either from the Cost Sheet column, or from the activity spread.

Baseline curve or Forecast curve when Schedule & distribution are derived from the
Activity Sheet and Cost is derived from the Cost Sheet:

You can select the following distribution and cost sources when the data is originating from the
Activity Sheet:
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Distribution Cost Cost per CBS Code

Sheet Name: System Activity Sheet
(Activity)
Project Type: Current Project
Data Source: Planned Total Units

Cost Sheet Column: Assigned Budget Cost for each unit per CBS Code =
Total cost from the Cost Sheet
column/ The number of total units.
Cost for each period per CBS Code =
The number of units * Cost per unit.

Example

Monthly time scale: Sample monthly unit spread for CBS Code1 which is coming from Planned
Total Units in the above scenario:

 January February March April May June July
CBS Code 1 100 100 100 100 100 100 100

If Total cost per CBS Code1 = $70000, then the cost per unit = $70000/700 = $100 and cost
per period will be = 100 * $100 = $10000

Monthly time scale: Sample cost spread for CBS Code1 for each period will be calculated as
follows:

 January February March April May June July
CBS Code 1 $10000 $10000 $10000 $10000 $10000 $10000 $10000

The above Cost spread sample will be distributed in the Baseline Cash Flow curve. If the user
selects Sheet Name: Activity Sheet (Resource level), with resource units selected as
distribution source, and the cost source is coming from the Cost Sheet column, then sum all of
the Planned units for each CBS Code by day which it will be used to distribute the costs. The
Cost per unit will be calculated as shown above. The user should be able to select the units
spread from either the current project or the Baseline. The cost distribution will be done in the
similar way (as shown above) for the other time periods such as yearly scale or financial
periods.

Baseline curve or Forecast curve when Schedule & distribution and cost are derived
from the Activity Sheet:

You can select the following distribution and cost sources for the data that is originating from
the Activity Sheet:

Distribution Cost Cost for each unit per CBS Code

Sheet Name: System Activity Sheet
(Activity)
Project Type: Current Project
Data Source: Planned Total Cost

Cost in this case is coming from
Planned Total Cost spread data at
Activity level for each CBS Code.

The cost will be calculated in the
source Activity Sheet itself using the
units and assigned role or resource
rate at Activity level.
Cost for each period per CBS Code:
Sum of all planned costs for each CBS
Code at activity level.

The sample cost spread for the CBS Code 1, when the selected Planned Total Cost in the
above scenario is as follows:
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Note

In this case, the cost spread data will be received from the selected Activity Sheet
(either from current project or Baseline).

 January February March April May June July
CBS Code 1 $100 $100 $100 $100 $100 $100 $100

If you select the new distribution and cost options from the Activity Sheet, then:

• Both the cost and dates will be received from the Activity Sheet spread data.

• The forecast curve, which is set to begin at the end of actuals curve, shows data from the
data date instead of the current period.

• You can select distribution from the Activity Sheet and cost from the Cost Sheet column, or
manual, so that the cost spread will be calculated using the total spread units from the
Activity Sheet, and the total cost received from the Cost Sheet, or entered manually.

• The Project Type drop-down field and the Data Source field enables you to get the units or
cost spread from the Activity Sheet current project or baseline. The values for the fields are
Planned, At Completion, and Remaining. By default, the Planned options is selected.

• For the Forecast Cash Flow curve, the spread data (units or costs) comes from Planned,
At Completion, and Remaining costs or units. In the Forecast Cash Flow curve the default
data source is At Completion. The Forecast Cash Flow curve that is set to begin at the end
of actuals shows the actuals received as of current date, from the Activity Sheet or from
the Cost Sheet column, and the remaining periods show the spread data received from the
Activity Sheet (including the redistributed unassigned amount). The unassigned amount is
redistributed in the remaining periods, based on the selected weighted average option.

Baseline curve or Forecast worksheet when Schedule, distribution, and cost are derived
from the Activity Sheet:

For each CBS Code in the Baseline or Forecast worksheet, when the source is selected as
Activity Sheet:

• From Date will be the earliest date (beginning period from the selected Project spread
data). This can be either at Activity level or Resource level based on the sheet name that
you have selected. Similarly, the dates come from the current project or baseline.

• To Date will be the latest date (from the selected Project spread data). This can be either at
Activity level or Resource level based on the sheet name that you have selected. Similarly,
the dates come from the current project or baseline.

• From Date and To Date are read-only.

• The Profile column remains empty and will be read-only.

• The Period data shows the costs distributed from the spread.

• The distributed costs can be calculated when units are coming from the Activity Sheet, only
(you can bring the costs from the Activity Sheet). The data will be read-only, similar to the
data received from the P6 Summary Sheets.
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Note

The project picker will not be available in the worksheet. You can see the project
picker when you are allowed to pick a project as source. In this case, the data is
filtered (in the graph and worksheet) based on the project.

• The worksheet tab enables you to export.

• The Cumulative and Incremental graphs are available.

• The unassigned amount in the Forecast curve, or Baseline curve, is redistributed in the
remaining periods, based on weighted average option that you have selected.

Spends Curve and Data Distribution

The following explains:

• When both cost and distribution is coming from Activity Sheet

• When the total actual cost is derived from cost sheet and schedule/distribution is derived
from Activity Sheet

When both cost and distribution is coming from Activity Sheet

You can define the Spends curve to get the actuals spread data from the Activity Sheet for the
Resource loaded or Cost loaded projects. When you select the Activity Sheet as a source for
the Spends curve, the system will derive the distribution and actual costs from the Activity
Sheet. The actual spread data will be coming from the current project.

The From Date and To Date fields are displayed according to the values of the earlier Actual
Start Date and Date which is across the activities, per CBS Code for In progress activities.
The From Date and To Date fields are read-only.

Note

The Data Date field value can be in the past, current, or in the future. The Actuals are
always shown, until the date of the Data.

The Actuals in periods show the spread data coming from the Activity Sheet that you have
selected.

The distribution data is read-only.

The Actual spread data as of the data date is displayed in the Forecast curve worksheet if in
the Forecast curve properties, the curve is set to begin at the end of the actuals.

The graph shows both the actuals (cumulative and incremental values).

The Actual spread data per CBS Code will be until the data date. For example, if the Actual
Start is 02/10/2020 and Data Date is 08/15/2020, then the Actuals cost spread will be shown
until the data date (08/15/2020), in the worksheet.

 From
Date

To Date Feb Mar Apr May Jun Jul Aug

CBS Code
1

02/10/202
0

08/15/202
0

$100 $100 $100 $100 $100 $100 $100

Forecast with Actuals
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When you select the source as Remaining Total Cost, or Remaining Total Units, the remaining
spread data will be used as source for the Forecast curve. The Actuals will be seen as of data
date, and the remaining spread will start from the data date. For example, in the table above,
the month of August will show the Actuals as of date + remaining Forecast data ($700 + $100).

 From
Date

To Date Aug Sep Oct Nov Dec Jan Feb Mar Apr

CBS
Code 1

08/15/2
020

04/15/2
021

$800 $100 $100 $100 $100 $100 $100 $100 $100

When the total actual cost is derived from cost sheet and schedule/distribution is
derived from Activity Sheet

You can receive the Actual spread units from the Activity Sheet and the total payment amount
from the Cost Sheet column. In this case, the Actual cost can be calculated as the number of
actual units * actual cost per unit. See the following example for the monthly time scale:

 January February
CBS Code 1 50 10
CBS Code 2 0 20

In this example, if the total actual cost (received from the Cost Sheet column) for CBS Code 1
is $6000, and the CBS Code 2 is $1000, then the actual cost per unit will be as follows:

 January February
CBS Code 1 $50000 $1000
CBS Code 2  $1000

Additional Information:

• If an Activity Sheet has more than one mapped source projects, the system displays the
following message: You cannot view the data because the system activity sheet is mapped
to more than one source project with different data dates.

Note

Cash Flow curves will receive data from the System Activity Sheet mapped with
multiple source projects, if they all have the same data date.

• If you select an Activity Sheet as a source to one or more Cash Flow curves in the Cash
Flow detail curves, you cannot open the Cash Flow curve in Classic View, and the system
displays the following message when you try to open a Cash Flow worksheet, or
properties, in Standard View: The source for one or more curves is Activity Sheet. You
cannot view the curves in Classic View.

• If an Activity Sheet has not been created in the project, the drop-down field will not display
Activity Sheets as an option for the Baseline, Forecast, and Actuals Cash Flow curves.

• The Baseline, Forecast, and Actuals Cash Flow curves show the properties irrespective of
the schedule type for the System Activity Sheet. Furthermore, the Sheet Name drop-down
field displays manual activity sheets that are created in the project.

• The Cash Flow worksheet does not show the data for the Cash Flow curves that are based
on the Activity Sheet, if there is no cost spread or unit spread associated with the activities
in the selected Activity Sheet.
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Portfolio Manager Budget Curves

The Portfolio Budget curve is linked to scenarios in the Portfolio Manager. The project manager
must create this curve. After it is created, the curve shows the initial budget projections.

When you open a Portfolio Budget curve, you can view the data in the transaction currency, if
different from the project currency.

Note

If the currencies of your data sources are different, you can create a base currency
using the Derived curve as your data source.

For cash flow purposes, the Portfolio Manager extracts a project's baseline or forecast budget
numbers for use in a scenario sheet.

During a portfolio analysis, the Portfolio Manager can produce three different Portfolio Budget
curves:

1. Shared Budget curve

2. Approved Budget curve

3. Original Budget curve

Note

Before you can use these curves, you must add them to your project.

You can pull data from the three different Portfolio Budget curves (Portfolio Manager) into the
cash flow curves within your project/shell.

Note

If the currency of data pulled from any of the three different Portfolio Budget curves
(Portfolio Manager) is different from the project/shell currency, you can create a
Derived curve (using the existing curves within a family) that converts data from
existing curves to a different currency.

Shared Budget curve

This curve shows the portfolio planner's proposed number for the project. You will not have
access to this curve until the planner shares a scenario. You can include this curve on the cost
worksheet, along with the forecast budget, or any other budget curve, to see the difference
between your project's numbers and the planner's proposed budget numbers.

Approved Budget curve

When a scenario is approved in the Portfolio Manager, the budgets for each project in the
scenario are marked "approved." They are then locked and stored in the Portfolio Manager. An
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Approved Budget curves shows the approved budget for the project for that planning period
(usually a year).

Original Budget curve

This curve is for a project in execution. This budget is the last approved budget for the project
before it moves into its execution phase. This approved budget becomes the project's original
budget; and this original budget, plus any changes that occur to the numbers during the life of
the project, becomes the project's approved budget.

Portfolio Manager Budget Curves and Financial Period in Cost Manager

The Portfolio Budget curves (Shared, Approved, and Original), in cash flow, are linked to
Portfolio Manager scenarios.

User can attain data from the Portfolio Budget curves (Shared, Approved, and Original), from
the Portfolio Manager scenario in Parent Shell, into the cash flow curves within a project/shell.

During a portfolio analysis, the Portfolio Manager can produce the following Portfolio Budget
curves:

Shared Budget curve

The Shared Budget curve displays the portfolio planner's proposed number for the project.

The User can include the Shared Budget curve on the Cost worksheet (along with the forecast
budget or any other budget curve) to see the difference between the project numbers and the
planner's proposed budget numbers.

Approved Budget curve

When a scenario is approved in the Portfolio Manager, the budgets for each project in the
scenario are marked "approved."

The system locks and stores the budgets in Portfolio Manager.

An Approved Budget curve displays the approved budget for the project for the planning period
(usually a year).

Original Budget curve

The Original Budget is the last approved budget for the project before it moves into its
execution phase.

The approved Original Budget becomes the project original budget. This original budget (and
any changes that occur to the numbers during the life of the project) becomes the project
approved budget.

The Portfolio Manager scenario (with Financial Period as the Period Structure) created in the
parent Shell will push/pull the data from respective curve only. That is:

• For the child Shell, it has the same Financial Period in its options, and

• It will consolidate the data for only those cash flows where the timescale has been selected
as Financial Period.

If the user selects a financial period from the ‘by' drop-down list, the corresponding drop-down
list for financial period will get populated with the Financial Period present in the Shell options.

Other options, in timescale, will be disabled (for format and so forth), and it will remain blank
with other options enabled (for format and so forth).
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For Baseline and Forecast type curves, the summary sheet spreads and schedule manager
spreads will be assigned to the relevant period.

For the Actuals, the cost sheet columns and effective dates will be used to assign the values to
the relevant period.

Note

For a cash flow curve, the X-axis for graph will still remain the same but the points in
the curve will be based on the Financial Period that has been selected. The columns
in the grid will also be based on the Financial Period that has been selected.

Cost Sheet

A cost sheet captures data from data sources such as cost code data values, budget, business
processes (by status), and Activity Sheets.

The system dynamically updates the Company Cost Sheet with information from the project/
shell cost sheets. For more information, see "Company Cost Sheet" below.

Project/Shell Cost Sheet

The project/shell cost sheet is a detailed accounting of the project/shell budget and costs. A
cost sheet works like a spreadsheet within the system to calculate and maintain the project/
shell cost information stored in the project/shell. The project/shell cost sheet rows contain
unique CBS codes (or cost codes), which can be used to link project/shell costs to the general
ledger for finance. Cost information can be entered manually, pulled from work packages or
worksheets, or rolled up automatically, into the project/shell cost sheet, from business
processes when transactions occur in the system.

Project/Shell Cost Sheet Column Properties

• The Datasource drop-down list contains a list of Single, Logical, and P6 data sources (only
published P6 data sources as defined in the Standards & Libraries [Admin mode]).

• The Element drop-down list contains the options as defined in the Cost Sheets Templates.

• The Data Format option, Decimal, is selected for all the "Unit" fields that you have selected
from the Element drop-down list.

Note

The data sources do not list the P6 Summary Sheets in a Shell. Instead, the P6
Summary Sheets are from P6 Data Sources node, under Standards and Libraries.
The system identifies the P6 Summary Sheet that is required for supplying data to
the Cost Sheet by mapping the Summary Sheet "Type" to the column data source.

Work packages

In addition to a project/shell cost sheet, multiple work packages may also be defined. A work
package is a group of cost sheet rows that is a subset of the project/shell cost sheet. Work
packages provide insight into the budget without providing full access to the details of the
project/shell cost sheet.

Worksheets
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Cost worksheets can be created to support the project/shell cost sheet. They can be used as
sub-cost sheets, enabling specific calculations or data entry in a separate sheet, which can
then be rolled up into a defined project/shell cost sheet column. For example, a worksheet can
be used to offload complex calculations, which can be rolled up into a single cost sheet
column. Worksheets support manual data entry and formulas. Business processes do not roll
up to worksheets. Permissions can be controlled for individual worksheets. Worksheets are not
independently reportable; however, cost sheet columns that reference worksheets can be
reported on.

For Base Commits, Change Commits, and Payment Application BPs of Summary Payment
Application SOV type.

• The Costed line items (in Base Commits, Change Commits, and Payment Applications
with SOV type, "Summary Payment Applications BPs) roll up to the Cost Sheet by using
the "Amount" field.

• The Amount that rolls up to the Cost Sheet is the Costed Amount for each of the CBS
codes that is added to the Cost Distribution grid.

• If the Line Item Amount = Costed Amount, you will see a discrepancy between the Total
Amount seen in the Line Item section of Record, and the rolled up Amount to the Cost
Sheet.

• You can go to the Line Item level details by opening the record in the Transactions section.

Company Cost Sheet

A Company Cost Sheet pulls cost information from across all the CBS projects/shells that
exist in a Unifier instance.

Note

There is only one Company Cost Sheet.

The company administrator can create a company level cost sheet (the Company Cost
Sheet) to display the cost data across all the projects/shells.

Projects/shells included in the Company Cost Sheet are added by default as the project/shell-
level cost sheets are created.

Note

Only the Active and the On-hold projects/shells must be rolled up to the Company
Cost Sheet.

Company Cost Sheet Columns Properties

Data rolls up to the Company Cost Sheet columns from the individual project/shell cost
sheets columns, by data source.

The Company Cost Sheet columns headings provide the following information, upon hover
over:

• DataSource

• Total

• Formula (when applicable to the data source)
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For details about Company Cost Sheet, see Working with the Company Cost Sheet.

Types of Cost Sheet Data Entry

Cost sheet cells can be populated with data in the following ways, depending on how the
column has been set up:

Manual entry: Your cost sheet may include some columns in which you can enter data through
line items or directly into a cell. Line items can be added manually by copying data from an
existing line item within the cell or from copying existing line item data from one column to
another.

Business processes: Cost sheet data can also be rolled up automatically when cost-type
business processes reach a specified status. For example, when a purchase order is
approved, the amount can be rolled up to the appropriate column and CBS codes.

Formulas: Cell data is calculated from other column entries based on a formula defined for the
column. The formula may include data from other columns.

Budget: Information from the project/shell budget can be rolled up to budget columns. This
data is entered in the Budget window.

Worksheet: Data can be entered into worksheets and rolled up to cost sheet columns.

The following sections discuss how to view, enter, and manage cost sheet data and budget
information.

Adding a New Cost Sheet

When adding a new cost sheet either by way of copying from a template or by way of copying
from a CBS Shell instance, note the following:

Adding a new Cost Sheet by way of copying from a template

• If the CBS Shell instance does not have the Schedule Type Data Element on the attribute
form, the templates that have the option "Enable P6 sources" selected are not available for
use. That is, you are not able to add a cost sheet that has P6 Sources to the Shell.

• If the CBS Shell instance does have the Schedule Type Data Element on the attribute
form, you can only select the "Tree" structure cost sheet.

Adding a new Cost Sheet by way of copying from a Shell instance

• If the CBS Shell instance does not have the Schedule Type Data Element on the attribute
form, the shell instance that have the option "Enable P6 sources" selected are not
available for use. That is, you are not able to add a cost sheet that has P6 Sources to the
Shell.

• If the CBS Shell instance does have the Schedule Type Data Element on the attribute
form, you can only select the "Tree" structure cost sheet.

More information about adding a new Cost Sheet

• Enable P6 sources
You can select any Cost Sheet with the option "Enable P6 sources" selected, or without the
option "Enable P6 sources" selected.

After a new Cost Sheet is created within a CBS Shell instance, the option "Enable P6
sources" is carried over from the source. The "Enable P6 sources" option is editable if no
columns are added to the Cost Sheet via the P6 Data sources. If a Cost Sheet contains
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columns that use P6 Data Sources, you cannot edit (Select or Deselect) the "Enable P6
sources."

Working with Project or Shell Cost Sheets

This section discusses working with cost sheets in Projects and in CBS-code based shells.

For information about cost sheets in generic shells, see Generic Cost Manager.

Cost Sheet sub-node (Standard View)

When you select the Cost Sheet sub-node (go to the shell tab, and switch to User mode; in
the left Navigator, select Cost Manager, and then select Cost Sheet), the Cost Sheet log
opens. This log displays the cost sheets, worksheets, and work packages (where available)
within the project/shell. The log has the following elements:

• Toolbar

• Grid displaying the list of all the sheets within the project/shell

• Right pane capturing the details of each sheet

The Cost Sheet log toolbar options:

Option Description

Create Lets you create a Worksheet (from a template or from
projects) or Work Package.

Actions Lets you set the permissions (Permissions).
View Lets you set the view of the log by showing all sheets

(All) or group the sheets by type (Group by Type).
Refresh Lets you update the information of the items listed on

the log.
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Option Description

Print Lets you print the sheet (Print) or export it to CSV
(Export To CSV) or Microsoft Excel (Export To Excel).

Note

• For export to Microsoft
Excel, the system
currently supports only
Euro (EUR) and United
States Dollar (USD)
currency symbols.

• If you export data from a
business process (BP)
record, sheet (such as an
Activity Sheet), or log
(such as Company
Funding Sheet Log) to
Excel, be aware that
depending on how your
negative values are
formatted, you might
need to configure your
columns in Excel to match
the correct data type
(Number). Otherwise, the
columns will not be
treated as numeric and
will not sum as expected.
One supported format
includes placing the
negative sign between the
currency symbol and the
amount (for
example, $-1,000).

Find on Page Lets you find items on the displayed page. When you
select this option, the system inserts a row that lets you
enter filter parameters.

The Cost Sheet log grid column headings include Name, Reference No., Date Created, and
so on.

When you select a worksheet, the Cost Sheet log tabs (right pane) include Properties,
Permissions, and Audit Log. Be aware that the Audit Log only provides details based on the
import of a CSV file or an API-based update.

When you select a work package, the Cost Sheet log tabs (right pane) include Properties and
Audit Log. Be aware that the Audit Log only provides details based on the import of a CSV file
or an API-based update.

To open a sheet, select the gear menu ( ), and select Open. After you open a cost sheet, the
Cost Sheet overlay opens. The next topic explains the elements of the Cost Sheet overlay.

Project or Shell Cost Sheet
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When you open a project/shell cost sheet, the Cost Sheet overlay window opens and the
following elements appear on the screen:

• Cost Sheet header and locked/unlocked indicator

• Toolbar enabling access to several actions

• Grid with rows (if available) and columns

To open a cost sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and the select Cost Sheet.

3. In the Cost Sheet log, open the applicable cost sheet.

The Cost Sheet overlay window toolbar options are as follows:
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Option Description

Manage Rows 

Note

This option is available only to
those users who have
permission to modify the cost
sheet rows. Selecting this
option enables you to open a
new grid sheet (inline), on top
of the cost sheet, titled:
Manage Rows.

For a tree-structure cost sheets, the Manage Rows sheet
has the following toolbar options:
• Add Sibling
• Add Child

Note

Note

When no cost code has been
created yet, the toolbar has only
the Add option (instead of the two
separate Add Sibling and Add
Child options).

• Refresh
• Print
• Find on Page
• Expand All Groups or Collapse All Groups
For a flat-structure cost sheets, the Manage Rows sheet
has the following toolbar options:
• Add

Selecting Add, when no row has been selected, adds
a new row at the bottom of the existing rows.
Selecting Add, when a row has been selected, insert
a new row below the selected row.
You can always drag the row to move it above or to
any other valid place.

• Refresh
• Print
• Find on Page
When you make changes, the following additional
options (upper-right corner of the screen) enable you to
cancel or save your changes:
• Cancel
• Save
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Option Description

The Manage Rows sheet has the following columns that
are stationary:
• Cost Code
• Code Name
Other columns on the Manage Rows sheet vary as per
design (as defined in the Cost Sheet Attribute Form in
uDesigner).
For each cost code row in the Manage Rows sheet, you
have the following options columns at the very end:
• An indicator to show if a cost code row is associated

with notes.
• Attachments: An indicator to show if a cost code

row is associated with attachments.
• Delete: If a row is eligible for deletion (that is, there

is no cost associated with that cost code), you can
delete the row by using this option. When you select
this option, the row and the child rows will be
deleted.

Note

When a record is terminated or a rolled up
line item is deleted, the system still
maintains references to these line items
with the CBS code. In such scenarios, the
referenced CBS codes cannot be deleted.
However, if a CBS code is referenced by a
line item data either by direct cell entry or
a manual line item is created in the cost
sheet, upon deleting the line item data from
the cost sheet, you can delete the CBS codes.

• Reorder: You can select multiple rows and drag
them to another position. If there is no cost
associated with a selected row, you can drag codes
to another location below any parent. If any of the
selected codes is associated with a cost, you cannot
drag the group to another parent or hierarchy.

For each cost code row in the Manage Rows sheet, there
is a right pane (bottom) that captures more details on
the code. This pane contains following tabs:
• Breakdown tab: The Breakdown tab contains the

following toolbar options:
– Add

If you do not select any rows and select Add, the
system inserts a new row on the grid at the
bottom of the existing rows.
If you select one or more rows and select Add,
the system inserts a new row below the selected
row, or rows.

– Find on Page
– Row #: This is the same as the row # column in

main grid in this window. The system displays
an error message if you:
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Option Description

* Save your changes without entering a
name.

* Create a breakdown with a duplicated
name.

The red triangle symbol signifies the existence
of an error in a row. The error pop-up displays
Row # that contains the error, the CBS
description (from the main sheet row that
contains the error), the tab name, and the error
description.

– Name: Required field for capturing the
breakdown name.

– Description: To capture breakdown
description.

– Delete: Column header is blank. Select to delete
the selected row.

– Reorder: Enables you to reorder breakdowns
through drag and drop (same as drag or drop at
other places in the system, such as Manage
Views screen, and so on).

• Attachments tab: Same as the Attachments tab in
Work Package (Standard View) and right pane of the
Attachments tab in the Cost Sheet log.

• Notes tab: Similar to the Comments tab of a BP
record (right pane). It cannot be used to add
attachments to a comment.

• Audit Log tab: Use this tab to access a record of the
details such as Date, Event, Action, User Name, and
so on. Be aware that the log only provides details
based on the import of a CSV file or an API-based
update.

For a tree-structure cost sheet, the right-click options for
a cost code row, within Manage Rows window, are:
• Add Sibling
• Add Child
• Copy
• Delete
For a flat-structure cost sheet, the right-click options for
a cost code row, within Manage Rows window, are:
• Add
• Copy
• Delete
For both a tree-structure cost sheet and a flat-structure
cost sheet, when you select multiple rows, the right-click
options are:
• Copy
• Delete
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Option Description

Add Column Enables you to open the New Column overlay window
which contains the following fields:
• Name: Enter the name of the new column.
• Type: The drop-down menu enables you to select

the values:
– From Business Processes (the default value for

Type)
Select the From Business Processes option if you
want to have a column in the Cost Sheet log the
pulls data from the Amount field of a Business
Process. If you select this option, then:
- The New Column form (overlay window) stays
as is.
- The Data Source drop-down menu gets
updated to show a list of all Business Process
data sources which can be used to create a
column.

Note

The data sources that have
been used to create a column
will not be included in the list.
To create the column
successfully, you must
populate the required options
on the form.

• Direct Entry: Select the Direct Entry option when
you want to enter Numeric values into the cell
directly. When you select this option on the overlay
form, similar to the "From Business Process" option,
the form stays as is. The only difference is that the
Data Source drop-down menu displays "Logical
Sources," only. Also, those sources that have already
been used to create a column will not be displayed
in this list.

• Line Item Content: Select the Line Item Content
option when you want to enter data for each cell in
the column in a line item format, allowing multiple
line item entries per cell. The total is displayed in
the cell. When you select this option on the overlay
form, the overlay form stays as is. The behavior of
the Data Source drop-down menu is the same as
when you select the "Direct Entry" option.

• From Worksheet: Select the From Worksheet option
when you want to populate the data in the Cost
Sheet column from another column in an existing
worksheet within the project/shell. When you select
this option:
- The Data Source drop-down menu displays a list
of all those logical sources that allow the "Sheet"
type entry method.
- The sources that have already been used to create
a column do not show up in the list.
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Option Description

The Type drop-down menu will contain two
additional options:
- Sheet Name
This is an editable drop-down menu.
- Column
This is a drop-down menu, which is enabled only
when you select a sheet from the "Sheet Name"
column; otherwise, the Column option is read-only.

• From EVA Sheet (for more information about EVA,
refer to the Unifier Earned Value Management User
Guide).
Select the From EVA Sheet option when you want to
populate the data in the Cost Sheet column from an
EVA sheet. When you select this option:
- The Data Source drop-down menu displays a list
of all those logical sources that allow the "Sheet"
type entry method.
- The sources that have already been used to create
a column do not show up in the list.
The Type drop-down menu will contain two
additional options:
- Sheet Name: This is an editable drop-down menu.
- Column: This is a drop-down menu, which is
enabled only when you select a sheet from the
"Sheet Name" column; otherwise, the Column option
is read-only.

• From Activity Sheet: Select the From Activity Sheet
option when you want to populate the data in the
Cost Sheet column from an Activity Sheet. When you
select this option:
- The Data Source drop-down menu displays a list
of all those logical sources that allow the "Sheet"
type entry method.
- The sources that have already been used to create
a column do not show up in the list.
The Type drop-down menu will contain two
additional options:
- Sheet Name: This is an editable drop-down menu.
- Column: This is a drop-down menu, which is
enabled only when you select a sheet from the
"Sheet Name" column; otherwise, the Column option
is read-only.

Note

In Cash Flow, Cost Sheet, and
Earned Value, you can replace
the Summary Sheet with the
Activity Sheet as a source.

• Formula: Select the Formula option when you want
to populate the Cost Sheet column as a formula-
based on other existing columns in the sheet. When
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Option Description

you select this option, the Data Source drop-down
menu gets updated to show a list all the logical
sources that allow the "Formula" type entry method.
Also, those sources that have already been used to
create a column will not be included in this list. In
addition, the formula creator option is displayed
below the Data Source field. When you select the
formula creator, an interface to create a formula
opens.

• P6 Sources: You can select the P6 Sources option
when the sheet is enabled to create column from P6
sources. You can select the P6 Sources option if you
want to populate the Cost Sheet column from a P6
Datasource. When you select the P6 Sources option,
the Data Source drop-down menu gets updated to
show a list all available P6 sources (those sources
that have not been used to create a column so far).
In addition, the Data Source drop-down menu will
be followed by the Element drop-down menu.

• Data Source: The Data Source drop-down menu
changes as the value in the "Type" drop-down menu
change. Each change is captured above.
In some cases, the Datasource name is preceded by
*** (asterisks). This indicates the status of a BP that
does not exist in the design anymore. If there are
any BP statuses that have been removed from the
design and are displayed in the Data Source drop-
down menu with *** (asterisks) next to them, when
you select the Type as "From Business Process," the
Data Source drop-down menu shows a tooltip next
to it. Upon hover over, the tooltip states: ***
Indicates the status does not exist in the design.

• Data Format: The Data Format option is available
when a value is available to select; otherwise, it will
not be visible. For example: The Single Source
columns can be of data format "Currency" or
"Decimal," only. So, for these columns, the
"Percentage" radio option is not visible.

• Display Mode
• Total
• Column Position after
The New Column overlay window has the following
action options:
• Cancel
• Save
• Save & Add New

View These options let you use a default view, create your
own views, and manage (rearrange, hide, show, and
delete) views. See Cost Sheet Views.

• Default
• Create New View
• Manage Views

Edit View Use this option to modify the current view.
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Option Description

Forecasting

Note

This option is available only if
the cost sheet is enabled for
forecasting. When you select
this option, the Classic View of
Forecast Adjustment
window opens.

Refresh Enables you to see the added values to the columns of
the sheet.

Print Use this option to print or export the log content.

Find on Page Use this option to search for specific entries in the sheet.

Expand All Groups  or Collapse All Groups Enables you to expand or collapse the sheets to see the
subordinates.

Menu Options Enables you to conduct and access:
• Import

– Summary Budget
– CBS Details

• Export
– Summary Cost Sheet
– Summary Budget
– CBS Details
– Column Details

• Columns
– Unhide
– Restrictions

• Snapshots
– Create
– Open
– Enable Auto Snapshot

• Currency
– Project Currency
– Base Currency

• Budget Distribution: See Budget Distribution below
for details.

• Row Coloring
– Multi-Color
– Single-Color

• Properties
• Audit Log

Currency Toggle Enables you to switch the cost sheet currency from
Project Currency to Base Currency (or conversely).

The Cost Sheet overlay window column options may vary. The following are a list of possible
columns:

• Sequence No.

• CBS Code (or Cost Code): Static column
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• CBS Item (or Code Name): Static column

• Assigned Budget

• Purchase Orders (Approved)

• Change Orders (Approved)

• Invoices (Approved)

• Contingencies

• LI Content

• Risks & Issues (Closed)

• Forecasts

• Budget Approval (Approved)

• Budget Transfers (Approved)

• CBS/WBS Actuals (Approved)

• Contract Change Orders (Approved)

• Contracts (Approved)

The bottom of the Cost Sheet log (underneath the second column from the left, after the
Sequence No. column) displays the totals for the amounts for each column.

The lower-left corner of the Cost Sheet log displays the total number of items.

When you right-click a cell heading, you will see the following options:

• Insert

• Properties

• Hide

• Delete

• Lock after this column

When you right-click a cell within the cost sheet, you will see the following options:

• Add Sibling Row

• Add Child Row (available only if the selected cell row is not associated with any cost item
or line item data)

• Insert Column Before (not available if you select a cell within the CBS Code or the CBS
Item columns)

• Insert Column After (not available if you select a cell within the CBS Code or the CBS
Item columns)

• Copy

• Delete

When you select a cell, the Cost Sheet screen opens a pane on the right side that has the
following tabs:

• General

• Attachments

• Notes

• Fund Assignment Order
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These tabs provide additional information about each cell. Where allowable, you can update
the fields within each tab.

The Budget Distribution overlay window contains the following elements:

Element Description

When the Budget Distribution is locked (padlock icon
in locked position)

The following blocks (accordion menu) are visible:
• Overview: If available, the right pane of this block

(accordion menu) contains the following tabs:
– Attachments
– Audit Log
– Lock/Unlock History

• Distributed Amount: Enables you to see the Cost
Code, Code Name, Type, and Distributed Amount.
You can use the toolbar options to refresh, print (or
export), find, and collapse the information in the
log.
The right pane of this block (accordion menu)
contains the following tabs:
– General
– Attachments
– Notes
All the fields are read-only.

If you select Unlock, you must enter a reason.

When the Budget Distribution is unlocked (padlock
icon in unlocked position)

You have all the options available in the locked position,
and you can change the values in the editable fields.
Once finished, you must select Save & Lock.

Cost Sheet Views

In addition to opening and viewing a cost sheet within a project/shell, you can create your own
views with filters, groupings, and so on, to modify the default view of the cost sheet. You can
view values from data sources such as activity sheets, as well as cost attributes from the Cost
Attribute Form. When you create a view, you can select columns from the cost sheet as well as
Data Elements (DEs) from the Cost Attribute Form. For example, you can view information for
specific CBS Codes and then filter and group them by their Status of Active and Inactive.

Note

• You can use all applicable DEs from the Cost Attribute Form, including hidden
blocks and Date and Date Only Picker DEs, but excluding all other Picker DEs and
multiple-select input fields, if the DEs are included on the form.

• If you switch to the Base Currency view, no exchange currency rates will be
applied. Currency DEs on the Cost Attribute Form will be in the project currency
format.

After you open a specific cost sheet, a View option is available after the Add Column option. If
your administrator defined global views in a Cost Sheet template and they are linked to your
project/shell, these views are available through the Manage Views option. You can make
these views visible in your cost sheet, and you can change the order in which they are listed.
After they are visible, you can use them to create additional custom views. You cannot edit or
delete the predefined views. You can add multiple filters to a view, and you can use the same
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data element multiple times. When adding multiple filters, you can use operators to specify that
the view must match all listed filters or that it can match one or more of the listed filters.

Note

• If the administrator pushes additional updates to the Cost Sheet template, custom
views that you created are deleted.

• If the administrator imported predefined cost sheet views through a configuration
package, the views are hidden (the Visible checkbox is deselected) if the
destination contains the same shell template and cost sheet. If the destination
environment does not have the same shell template, the views are imported and
visible when the cost sheet is created in the destination.

If the cost sheet is created from the project template, the sheet initially uses the Default view,
which is selected from the View list. You can use the Create New View option to create views
or the Manage Views option to manage (show, hide, rearrange, or delete) existing views in the
View list.

The View list within the cost sheet is followed by the Edit View option.

Creating Cost Sheet Views

When you choose Create New View, a New View window is displayed. A Save View As text
box with New View as the default value can be seen at the top of the window. Validations are
performed to ensure that the view has been given a unique name.

The Save View As text box is followed by the Cancel and Save options. If you choose
Cancel, creation of the new view is canceled and you are brought to the previous view in the
cost sheet. If you choose Save, the new view is saved and loaded into the cost sheet.

There are multiple tabs below the Save View As text box. For more information, see the
following:

• Columns Tab in the New View Window

• Filters Tab in the New View Window

• Group By Tab in the New View Window

• Sort By Tab in the New View Window

• Conditional Formatting Tab in the New View Window

Managing Cost Sheet Views

Similar to BP logs in the Standard interface, the Default view and all the manually created
views are available in the Manage Views window. This window has the same features as other
logs, which also have the View feature within them.

Editing Cost Sheet Views

In the Edit View window, you can update the name of the view or use it to create a view with a
different name. (You cannot change the name of the Default view; however, you can use it to
create a view with a different name.) The view name is followed by the options available for
canceling the edit action, saving changes, and saving the view with a new name, or Cancel,
Save, and Save As. When you select Save As, a small overlay form is displayed where you
can save the view with a new name.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 199 of 671



You can also update the settings defined on the Columns, Filters, Group By, Sort By, and
Conditional Formatting tabs as described earlier.

Note

If you remove the view permission for a user, the user's filter conditions in the view are
not automatically updated. The user will need to edit and save their view to see the
changes in the view definition. Ensure you notify the user to update their cost sheet
filters accordingly.

Functionality within Cost Sheet Views

In the Default view, you can perform any of the actions listed below:

• Drag and drop columns

• Rearrange column order

• Select a column header to change the Sort By column

• Right-click a column header to choose the Lock after this column option

When you perform any of the above actions, the prefix of the view name becomes Modified.
The Edit View option is disabled. Therefore, you cannot save the Modified view.

The remaining gear menu ( ) for the rows and columns remain as they are in the Standard
interface of the cost sheet. All the toolbar options remain as they are in the Standard interface
of the cost sheet. You must save any modifications that were made to the Default view without
changing the view name to Modified.

In a manually created view, you cannot perform any of the actions listed below:

• Manage rows

• Add columns

• All Menu actions

– The only exceptions are Row Coloring in the case of a Tree structure cost sheet and
Import and Export options for both Flat and Tree structure of the cost sheet.

* Import options: This has the submenu option ‘Column Details' using which
customer can choose a column from the view and import data into it. The import
action allows import into all leaf rows of the cost sheet and not just the ones
present within the view.

* Export options: Same as above, this has a submenu option ‘Column Details'. Use
this option to select the column from which data should be exported. After it is
chosen, the customer can export of column data. This exports data from all leaf
rows from the cost sheet and not just the ones present within the view.

• All gear menu ( ) actions

• All Column Menu actions

When you select a value in any of the cost sheet cells, the General tab in the right pane is
displayed as read-only.

You can drag and drop columns to any place on the cost sheet. When this action is performed,
the prefix of the view name becomes Modified. However, in the case of a manually created
view, you can select Edit View and ultimately choose Cancel, Save, or Save As after making
modifications in the Columns, Filters, Group By, or Sort By tabs.
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After the View drop-down, there are many available options from the Standard interface of the
cost sheet, including: Refresh, Print, Find on Page, Expand/Collapse, Menu Options—Row
Coloring, and Currency. If you change the Row Coloring or the Currency of the cost sheet,
these changes are not saved to the view.

The Group By options that are within the view definition are visible as a grouping section with
the appropriate rows grouped in it. Each group, along with its appropriate rows, displays an
additional column that shows the group's name before the Cost Code column. There is no
column header for this grouping column.

When a Group By option applies to the view, the group's summary row displays the summary
value that is based on the Total option in the column's properties.

A special case for creating views is the addition of a few columns. After creating a view, your
administrator can take away your permissions to the columns that you added. When you try to
open the view, those columns are no longer visible. The Edit View window does not show the
columns in the Selected Columns section nor the Available Columns section.

Menu Options in Worksheet

A typical Cost Sheet log (go to the shell tab, and switch to User mode; in the left Navigator,
select Cost Manager, and then select Cost Sheet) has the following types of sheets when you
switch the view of the log from default to another type of view (View, and then select Group by
Type):

• Cost Sheet

• Work Package

• Worksheet

In the Group by Type view, the records are grouped under each category.

When you open the project cost sheet (Cost Sheet), when it is locked, you can use the Menu
Options (  ) to perform the following actions for the project cost sheet:

• Import - Column Details

• Export - Column Details

• Row Coloring - Multi-Color and Single-Color

The Menu Options (  ) and submenu options are not available for work package (Work
Package) records.

When you open a worksheet (Worksheet), you can use the Menu Options (  ) to perform
the following actions for the worksheet:

Note

The view of the worksheet can be Default.

• Import - Column Details

• Export - Summary Work Sheet and Column Details

• Columns - Copy Column Data

• Snapshots - Create, Open, and Enable Auto Snapshot

• Currency - Project Currency and Base Currency
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• Row Coloring - Multi-Color and Single-Color

• Properties

• Audit Log

Columns Tab in the New View Window

The sections under the Columns tab are: Available Columns, Selected Columns, Left Lock
after Column, and Right Lock after Column.

In addition to the previous sections, there are three options located after the Selected
Columns section: Group Management, Group Selected Columns, and Delete Group.

For a new view, the Available Columns section displays a list of all the columns from the
Default view. Cost Code and Cost Name columns are not available in the list because they
are part of all views by default. The columns that you have view restrictions for are also not
available in the list.

The Cost columns listed under Available Column are grouped as CBS Attributes and Sheet
Columns.

The CBS Attributes block items are sorted alphabetically.

In the case of a new view, the list in the Selected Columns section contains the Cost Code
and Cost Name columns. You can select one or more columns from the Available Columns
list and move those columns to the Selected Columns list.

Note

If you select Save without choosing a column from the Available Columns list, a view
with Cost Code and Cost Name columns is created.

When you select multiple columns in the Selected Columns list and then select Group
Selected Columns , you are prompted to enter a name for the new column group. The
maximum character limit for a group name is 255 characters.

You can select two or more selected columns and group them under a new name, or you can
create a column group first and then add columns to it.

The groups:

• Display with a distinct color in custom views.

• Only exist within the view in which they were created.

You cannot create a group just once and then use it within multiple views.

Upon choosing the Group Management option, a new window that shows the created groups
as tabs is displayed. You can update the Group Title for each group, but know that the Group
Title is a required field. Along with the lists of Available Columns and Selected Columns in
the Group, there are also two checkboxes. You can select the Show last column when
group collapsed checkbox as well as the Collapse group by default checkbox.

The Available Columns list displays the columns that exist in the default view of the cost
sheet. One or more columns can be selected from the Available Columns list and moved to
the Selected Columns in the Group list. Columns that are part of another group are italicized.
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Each group must contain at least one column, as empty groups are not retained. You can re-
order the columns in a group by selecting any of the arrow options.

After you create a group, the group is displayed in the Selected Columns section of the

previous window with a Column Tree icon  and the group name. This group name contains
a hyperlink that takes you to the Group Management window and selects the previously
selected column.

All changes are saved upon selecting the Save option.

If you choose a column in the Left Lock after column drop-down list, the list for Right Lock
after column displays the remaining columns and, if applicable, any groups that you created,
from the Selected Columns list. For example, if there are 20 columns in the Selected
Columns list and you choose column 4 in Left Lock after column, Right Lock after column
displays columns 4-19. Another scenario is if you select column 19 in Left Lock after column,
Right Lock after column displays column 19.

The Left Lock after column drop-down list initially displays every column from the Selected
Columns list, except for the last column and any groups that you created. None is selected in
the drop-down list by default. When None is the value in the drop-down list, it means that no
column has been chosen to be locked from the left side of the sheet.

For the Right lock after column drop-down list, None is selected by default. When None is
the value in the drop-down list, it means that a right lock column has not been chosen for the
view. The remaining values in the drop-down list consist of a dynamic list that gets populated
based on the value chosen in the Left Lock after column drop-down list.

Filters Tab in the New View Window

For both Tree and Flat Structure cost sheets, there are three sections in the Data Element
drop-down list on the Filters tab: Cost Code segments, CBS Attributes, and Sheet
Columns. The Cost Code segments section displays each cost code segment as an attribute
that can be used to apply filters to the cost sheet. The CBS Attributes section displays all
“uuu” data elements (DEs), including hidden blocks but excluding Data Picker DEs and Multi
Select DEs, defined for the cost breakdown structure (CBS) Attributes form in uDesigner. The
Sheet Columns section displays all columns from the cost sheet in order.

Note

• Picker DEs and multiple-select input fields cannot be added as filters.

• The system only applies filters to leaf-level codes within the cost sheet. The
summary cost codes do not show up in the filter results.

• Hidden, restricted, and deleted fields are not shown.

To create a filter:

1. Select Add Filter.

2. Do the following:

a. Choose a Data Element.

b. Choose a Condition: This drop-down list displays a list of conditions. This list is based
on the type of data element (DE) selected. See Condition options.
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c. Choose a Value: Depending on the type of DE, choose a value that the query
condition must meet.

• Data Element: Lists the DEs on the Cost Code Attribute Form.

• Constant Value: You can enter a full or partial entry of the value to filter by. This is
similar to entering search criteria.

Note

The default value for an integer drop-down list is 0. Therefore, the integer
list can be used as a CBS attribute DE and defined as a filter with the
criteria is not empty, which will result in the display of data with the
default value.

3. To add additional filters, select Add Filter again, and repeat the preceding steps.
You can use the same data element multiple times.

4. If you are using multiple filters, select the applicable operator that should apply to the set:

• And: To specify that the view must match all listed filters, select And.

• Or: To specify that the view should match any of the listed filters, select Or.

Group By Tab in the New View Window

Use the Group By tab to group rows in the Cost Sheet. The drop-down field in the Group By
tab contains a list of columns that the user can see in the Cost Sheet, such as the cost code
and cost item, as well as items from the Cost Attribute Form.

Sort By Tab in the New View Window

In the Sort By tab, all the columns from the default cost sheet are available, as well as items
from the Cost Attribute Form.

Conditional Formatting Tab in the New View Window

In addition to using the Filters tab to create views that display specific data, you can use the
Conditional Formatting tab to format columns based on specific conditions. This feature
helps you visually identify rows within the column that match specific criteria. You can use
different formats, such as background fill, font color, icons, and data bar, to customize the
visual identification. You can format up to 10 columns in a sheet and use up to 5 format
conditions for each column.

You can also apply conditional formats at the cell level, which lets you identify amounts or
decimal-based values that match specific conditions. For example, you can use conditions to
highlight amounts where the Total Cost Incurred is greater than the Forecasted amount for
specific cost codes. By using a condition such as Background Fill & Color, you can access your
custom view and immediately identify where total costs have exceeded what was expected
(forecasted). Or you might want to highlight approved contracts that exceed $500,000 or are
valued at less than $50,000, which lets you visually identify the approved contracts with high or
low (or both) values.

When creating conditions, be aware of the following:

• You can only apply conditions to columns and fields that you have permission to access.
Hidden, restricted, and deleted columns are not shown. If a column becomes available
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after you create a view and set up conditional formatting, you must update the view to add
the previously restricted or hidden column.

• If a column that you can view when you create a condition subsequently becomes hidden
or restricted, or is deleted, the system automatically updates the information shown to you
when you select the view or its settings. Similarly, if the column becomes visible to you
again because it is no longer hidden or restricted, the system automatically updates your
customized view and settings. However, if you update and the customized settings before
the column display is reinstated, the system permanently removes the applicable column
from the customized view; you must manually update the view to add it.

• If multiple conditions of a column are true, the conditions are applied in the order in which
you created and applied them; that is, the condition that you specified first is applied first,
and so on.

• If none of the conditions are met, the display of the Cost Sheet remains unchanged; no
message is displayed that indicates no conditions were met.

• If you intend to print the Cost Sheet or export it to Microsoft Excel:

– You must enable support for background graphics in your browser before printing the
sheet.

– Formatting is not retained during an export to Microsoft Excel, so viewing the
conditions in Excel is not supported.

To create a condition:

1. Select + Add Column.

2. Select a Column.
The list contains all columns available to you in the Default view. Hidden, restricted, and
deleted columns are not shown. Conditional Formatting is applied to the selected column.

3. Select a Format Type.

4. Select Add Format Condition (the plus [+] sign) to specify the elements for which you
want to use different formatting.

5. Do the following:

a. Choose a Data Element. This list contains all columns available to you in the Default
view. Restricted and hidden columns are not listed. The validation process to
determine whether the condition is met is processed on the selected column.

b. Choose a Condition. The conditions listed are based on the type of data element (DE)
selected. See Condition options.

c. Choose a Value. Depending on the type of DE, choose a value that the query
condition must meet. If you chose a Condition such as is empty, the Value field does
not apply.

d. Choose a Format. The options in this list depend on the selected Format Type.

• If you chose Background Fill & Color or Font Color, select the applicable color.
The listed colors are the only options available; they cannot be customized for use.

• If you chose Data Bar, Format displays a read-only Data Bar selection. Data Bar
assumes that the associated Column contains numeric values, including negative
values. A Data Bar is not displayed for summary records or totals. After the
Conditional Format is applied, the selected Column is replaced with data bars
whose length is proportional to the percentage value with regard to the maximum
value. The values are printed inside their respective bars. Negative values are
represented by red bars.
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• If you chose Icon Set, Format displays a read-only Icon Set selection that uses a
fixed representation. Positive values are reflected by a green Up Arrow, negative
values by a red Down Arrow, and zero values by a yellow Horizontal Arrow.

Note

Because you can create multiple conditions for the same column,
conditions are applied in the order in which you create them; after the first
condition is satisfied, the remaining conditions are ignored.

6. To add additional columns, select Add Column again, and repeat the preceding steps.

Condition Options

The following is a list of the available Condition options that you can use in the Filters tab and
the Conditional Formatting tab:

• contains

• does not contain

• equals

• does not equal

• is empty

• is not empty

White spaces (blank characters):

• Filters tab: All leading and trailing white spaces (blank characters) are included in the
condition; that is, they are not trimmed.

• Conditional Formatting tab: When you use any of these options on the Conditional
Formatting tab, all leading and trailing white spaces are excluded; that is, they are
trimmed.

Case sensitivity: When you use equals or does not equal, the results are case sensitive.

Open a Project or Shell Cost Sheet

The ability to open, view, enter data, work with the column structure, or modify properties on a
cost sheet is dependent upon the permissions that you have. Contact your project or company
administrator if you have questions regarding your permission levels.

Note

When you first open the sheet, the view depends on the Default View option selected
in the Properties window. Your cost sheet administrator can set this default view. Cost
sheets can be resized and split/unsplit (see Resize cost sheet window or Split or
unsplit cost sheet window).

To open a project/shell cost sheet:

1. Go to the shell tab, and switch to User mode.
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2. In the left Navigator, select Cost Manager, and then select Cost Sheet to open the Cost
Sheet log.

3. To open the applicable Cost Sheet, select it, and select Open from the gear menu ( ).
The applicable Cost Sheet opens. For more information about the options available, see 
Project or Shell Cost Sheet.

Cost Sheet Restrictions

Your Administrator can configure cost sheet restrictions to restrict users or groups from viewing
or editing columns within a cost sheet. The behavior of these restrictions depends upon the
Company-level Global setting Override column restrictions.

The following feature applies to the following cost sheets:

• Company-level

• Shell-level

• Project-level

For each type of cost sheet, the user's corresponding groups must be considered (company
level and project/shell level) for the column restrictions.

If the option Override column restrictions is not selected, then:

If the user belongs to a group which does not allow editing or viewing a column in the cost
sheet (or a user is individually restricted), the user will be restricted from editing or viewing a
column in the cost sheet.

If the option Override column restrictions is selected, then:

It allows user to view or edit a cost sheet column if any of the restricted groups or the individual
user is allowed to view or edit the column.

Note

If you remove the view permission for a user, the user's filter conditions in the view are
not automatically updated. The user will need to edit and save their view to see the
changes in the view definition. Ensure you notify the user to update their cost sheet
filters accordingly.

For more information on Cost Sheet column behavior when the checkbox is selected, consider
the following scenarios:

For all the groups that are configured for restrictions on a cost sheet column, if all the groups to
which a user belongs are restricted from viewing or editing the column and if the user is
individually configured and restricted to view or edit that column, the user will be restricted from
viewing that column.

If the user (who is configured for restrictions in the cost sheet) is not restricted from viewing or
editing the column, or if the user belongs to a group that is not restricted from viewing or
editing the column, the user is not restricted from viewing or editing that column.

If the user does not belong to any groups that are configured for restrictions on a column in the
cost sheet, and the user is not configured individually for restrictions in the cost sheet, the user
is not restricted from viewing or editing the column.
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For the user to view a cost sheet column, the user must have View permission for the cost
sheet. If the user does not have View permission for the cost sheet, the user cannot view the
cost sheet columns even if the user belongs to a group that is configured to view the cost sheet
columns.

When you select or deselect the Override column restrictions option and save the change,
the system approves the change immediately, and you do not need to sign out and sign back
in.

Resize cost sheet window

The cost sheet window can be resized by selecting the Minimize or Maximize/Restore
buttons in the upper-right corner of the window, or by dragging the edges of the window to the
size that you need.

Split or unsplit cost sheet window

When working with a cost sheet with many columns, it can be useful to split the window using
the Split and Freeze toggle buttons. This lets you scroll through the columns in the right half of
the window, while maintaining a view of the CBS Code and CBS Item columns in the left half.

To display the cost sheet in split window mode:

1. In the cost sheet window, select the Split button. The sheet is split into two sections.

2. Select the vertical split line, and move it horizontally to adjust the size of the panes, if
desired.

3. Use the scroll bars at the bottom of the window to scroll horizontally through the columns.
When you have the left portion of the window in the position you want (for example, to view
the CBS Code or CBS Item column), select Freeze to lock it in place.

4. Scroll through the columns in the right half of the window to view or enter data as
necessary.

5. Select Freeze again to unlock the left half, or select Split again to restore the window.

Entering Data into a Cost Sheet

The following topics describe how to enter data into a cost sheet.

Add a Line Item to a Project or Shell Cost Sheet

A cost sheet column may be defined for manual data entry, depending on the column
definition:

• Manual, line item content: The data is entered in a line item format, allowing multiple line
item entries per cell. The total is displayed in the cell.

• Manual, direct entry: Numeric values are entered directly into the cell.

To add a line item to a project/shell cost sheet:

1. From the project/shell Cost Sheet window, select the link in the line item cell. The Cell
Detail window opens.

2. Select Add. The Line Item window opens.

3. Complete the Line Item window as described in the following table.
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4. Select OK. The new line item will be added to the Cell Detail window.

In this field Do this

Short Description This description will appear on the Cell Detail window.
Long Description Optional, to provide more information.
Work Package Select a work package, if any, with which to associate the

line item.
Spend Category Select a spend category if this has been set up to be

tracked.
Quantity Enter a quantity (at least 1) as applicable.
Unit of Measure Select the appropriate choice from the list.
Unit Cost Enter this manually.
Amount Automatically calculated as Quantity X Unit Cost.
Delete Line Item Select this button to delete the line item from the Cell

Detail window.

Note

For budget-related columns (for example, Assigned Budget), you can enter line item
data if the undistributed balance is at least as large as the line item amount. The
undistributed balance will adjust as line items are added, displaying the budget
amount left.

To add a line item cost entry by copying an existing line item:

1. In the project/shell Cost Sheet window, select the link in the line item cell. The Cell Detail
window opens. Any existing line items will be listed in the lower portion of the window.

2. Select the line item to copy, and select Copy Line Item. The Line Item window opens with
the original line item entry information filled in.

3. Make changes as necessary for the new entry, or leave as is to make an exact copy of the
original line item.

4. Select OK. The new line item will be added to the Cell Detail window.

Enter data directly into a cell

Some manual entry cells are configured for direct entry, rather than line item entry. Data entry
cells do not have links.

To enter data into direct entry cells:

1. Click inside the cell. The cell becomes editable.

2. Enter the numeric value directly into the cell.

Note

For percentage type direct cell entry columns, you can enter a value greater than
100%.
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Copy data from one column to another

You can copy the data from any manual entry column to another.

To add line items by copying existing data from one column to another:

1. Open the project/shell Cost Sheet window.

2. From the toolbar, select Edit, select Copy, and then select Column Data. The Copy
Column Data window opens.

3. Complete the Copy Column Data window as described in the table below.

4. Select Copy. The data in the first column will be copied into the second column.

In this field Do this

Copy type Choose one of the following:
• Cell total only: Copies the total value displayed in

the cell. The new line item will be labeled as "Copy
of original column name," ignoring quantity and unit
cost.

• Cell detail: Copies all cell detail information from
the original line item.

Copy from column From the drop-down list, select the column to copy. Only
line item entry columns will be listed.

Percentage You may enter a percentage value to copy. For example,
if you choose 10%, then 10% of the value of the original
column value will be copied into the new column.

Copy to column From the drop-down list, select the column into which
you want the line items copied

Rows Choose one of the following from which you want to
copy the values:
• All: To copy values to all the rows.
• Partial: To copy the values of selected rows only.

Click Select to choose the rows to copy.

View column properties

To view column properties:

Select the column heading. All column headings except the first two (CBS Details and CBS
Item) are hyperlinks that open the View Column window. The window shows information about
the column, such as the data source, entry method or formula, data format, and format of the
last total row.

Change cost sheet currency

You can view cost sheet data in the company base currency or the project/shell currency,
which may differ.
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Note

This is also applicable to work packages and worksheets.

To choose the display currency on a cost sheet or worksheet:

1. Open the project/shell Cost Sheet or worksheet window.

2. From the Edit menu, select Currency, and choose the currency from the list.

To choose the display currency on a work package:

1. Open the work package window.

2. Select the currency drop-down list in the upper-right corner of the sheet, and choose the
currency from the list.

Expand or collapse CBS codes

You can expand or collapse all CBS codes in a cost sheet. If you have many CBS codes in a
tree structure, you can expand that structure to view all the CBS codes at once.

To expand or collapse CBS codes in a cost sheet:

1. Open the project/shell Cost Sheet or worksheet window.

2. From the toolbar, select View, and select Expand to expand all the CBS codes in the cost
sheet or select Collapse to collapse all the CBS codes in the cost sheet.
Alternatively, you can select the Expand and Collapse buttons.

View cost sheet cell details

The values displayed in a cost sheet cell may reflect information from multiple line items,
business process transactions, or results of a calculation from other cells. The following
procedures discuss how to view the details about an entry in a cost sheet cell.

To open the Cell Detail window:

In the project/shell Cost Sheet dialog, select the link of the cost code. The Cell Detail tab in the
right pane displays the contents of the Cost Attribute Form.

Note

If the data elements in the Cost Attribute Form have tooltips, they will appear in the
form of a question mark (?) symbol. You can hover over the question mark (?) symbol
to see more information.

To view manual line item entry details:

From the Cell Detail window, double-click a listed line item. The Line Item window opens.

To view business process transaction details:

1. From the Cell Detail window, double-click a listed line item. A copy of the business process
transaction opens. In here, you can view or act on the BP transaction.
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2. Double-click a BP line item. The BP's Line Item window opens.

To view formula cell details:

1. In the Cell Detail window, if line items from manual entry columns or BP transaction
columns are included in the calculation, they will be listed in the lower portion of the
window, with the calculated value for each line item.

Note

In the Forecasts and Forecasts (Unaccepted) columns, if data sources are from a
business process enabled for costs sheet forecasting, the Cell Detail window
contains an Include in Forecast button.

2. Select a listed line item. If the line item is a BP transaction, the BP form opens. If the line
item is a manual entry, the Line Item window opens.

3. To view the formula used for the column, select the Formula link.

To view budget cell details:

The Cell Detail window displays as line items information generated from the budget, as
applicable. Typical budget columns include assigned budget. The undistributed balance
amount will be displayed as a line item. You may add line items if the undistributed balance is
at least as large as the line item amount.

This item Does this

Attach Lets you attach files to the cell from your local machine
(My Computer) or from the Document Manager. You can
view existing file attachments by selecting the
Attachments link in the upper portion of the window.

Add Notes Select to add a note to the cell. You can view existing
notes by selecting the Notes link in the upper portion of
the window.

Add Select to add a line item (transaction) to the cost sheet
(applicable for manual transaction columns).

Remove Lets you remove a selected line item.
Copy Adds a line item by copying an existing one.
View Menu, and then select Audit Log Opens the Audit Log for the cell. The log displays a

record of the activity for cells using line item data entry.

To open a workflow BP record from cost sheet:

For a workflow BP, you can:

• Accept a task if the BP record is not in the end-step.

• Modify the BP record and route it to the next step. The cost sheet will be refreshed if the
record is routed to next step. If you edit the BP record and save it, the system saves a
draft.

To open a non-workflow BP record from cost sheet:

You can open and act on a non-workflow BP record if you have Edit permission. If the BP
record is in non-edit mode, the Edit option is available.

If you do not have Edit permission, you can only view the BP record.
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If you do not have View permission, the system will display the message, "You do not have
permission to view record."

To open a BP record from cost sheet (Record Editors or Step Editors):

When the BP record editor, or step editor, opens the BP record from cost sheet, the editor can
update the BP record if the BP record is in accepted state and the editor has View permissions
to view the BP record.

Upon opening the record, the editor will only see the Save option. The editor can edit the BP
record but cannot route the BP record to the next step or submit the BP record.

Add Notes or Attachments to a Cell

You can add notes or attach files to any cell in the cost sheet. Files can be uploaded from your
local environment (My Computer) or from the Document Manager.

Antivirus scanning of files

If you are using an Oracle Cloud-based deployment, Unifier includes a virus scanner. To
prevent virus attacks from infiltrating your system through external files, the system scans each
file that is uploaded. Until the scan is completed, the file remains in a Scan Pending state.

At a minimum, the system scans each file that is uploaded, submitted, or attached through the
following channels:

• Document Manager

• Business processes (BPs)

• Image pickers

• Cells within forms or sheets

• Custom Templates for use with custom prints and reports

• XML Localization Interchange File Format (XLIFF) files used for translation support

• Custom Help files, such as those provided through a uDesigner object

• Bluebeam sessions

• Web service GET calls

• Import of comma-separated values (CSV) or Microsoft Excel files

Depending on how your environment is configured, the following actions might occur:

• If the virus scanner detects an issue with a file that a user is uploading, the system sends
an email to the user who uploaded the file and the designated company contact.

Depending on the location of the infected file, the system might display a bug icon  (if

the system is configured to display alerts) or an ellipsis icon  (if the system is
configured to prevent the display of alerts).

• If a user tries to access or download a file that has not yet been scanned and the
environment is configured to display alerts, the system displays a confirmation message
that requires a response to continue. If a confirmation message appears, the user can wait
and try to access the file later.
For 2D files, the file is displayed if it passes the virus scan. Otherwise, a corresponding
error message is displayed if the file fails the virus scan, or the virus scan is pending.
However, although the virus scan is pending, you can view an unscanned file.
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• If the virus scanner detects an issue with a file that a user is trying to view or download, an
alert is displayed that indicates the file contains a threat. Only individual files can be
rescanned. To rescan the individual file, select Yes in the alert message. In addition to the
channels listed above, you can also rescan a file from the following channels: Emails,
Notifications, and Attachments.

• If multiple files are selected for download, only the uninfected files are downloaded.

Note

If you are using an Oracle Cloud-based Unifier deployment, see Updating
Company Settings on the Security Tab for more information about configuring the
environment to allow the display of messages regarding Scan Pending states.

To access cell detail notes and attachments:

1. In the Cost Sheet window, select in any cell that displays as a link (line item entry, formula,
or automatic entry from a BP). The Cell Detail window opens.

2. You can add a note, view existing notes, add a file attachment, or view attached files.

To add notes to a cell:

1. In the Cell Detail window, select Add Notes. The Add Notes window opens.

2. Type the note in the text box, and select OK. Each time you add a new note, the Notes
counter in the Cell Detail window updates to reflect the number of notes that exist for the
cell.

To view notes attached to a cell:

1. If any notes have been added to the cell, the Notes link on the Cell Detail window will
display the number of notes.

2. Select the Notes link. The Notes List opens, displaying all the notes that have been added.
Each note displays the user who added the note, and the date and time it was added.

To modify or delete cell detail notes:

Notes added to a cost sheet cell cannot be modified or deleted.

To attach files to a cell:

In the Cell Detail window, select Attach, and choose:

• My Computer to attach the file from your local system. The procedure is the same as for
uploading files to the Document Manager. For rules on attaching files, see Attaching Files.

• Primavera Unifier Folder to attach documents from the Document Manager. The window
opens, displaying the project/shell documents files and folders. Select the files and folders
to attach and click OK.

Note

Folders are not attached. The contents of selected folders are attached in a flat list.
Documents with duplicate file names will not attach.

To view attached files:
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1. If any files have been attached to the cell, the Attachments link on the Cell Detail window
will display the number of attached files.

2. Select the Attachments link. The Attachments window opens.

3. Choose a file, and select Open. The document will open in the viewer selected in your
user preferences.

To delete an attached file:

1. In the Cell Detail window, select the Attachments link to open the Attachments window.

2. Select the file to be deleted, and select Delete.

To download a copy of an attached file:

1. In the Cell Detail window, select the Attachments link to open the Attachments window.

2. Select the file to be downloaded, and select Download.

3. Browse to a location on your local system, and select OK. Select Yes to confirm.

Search for CBS codes (rows)

You can search for a particular cost code by searching for one or multiple segments.

To search for a cost code:

1. In the Cost Sheet window, select Find. The Cost Code Find window opens.

2. Select the cost code segments you want to search by, and select OK.
The results will be shown in a separate cost sheet window. The new window also has split
capability so that you can keep the CBS code in view and scroll through the columns.

Edit cost sheet data

The following procedures discuss how to modify cost sheet data. Manually entered cost sheet
data can be edited or modified directly from the cost sheet (assuming you have modify
permissions).

Cost sheet entries rolled up from transaction BPs or calculated in formula columns are not
editable. Data rolled up through business processes can only be modified by submitting
business processes such as change orders. Formula column cells will reflect changes made to
other column data used in the calculations.

To edit direct entry data:

1. In the project/shell Cost Sheet window, select inside the cell to edit. The cell becomes
editable.

2. Enter the new value.

To edit line item data:

1. In the project/shell Cost Sheet window, select the link in the cell to edit. The Cell Detail
window opens. Line items are listed in the lower portion of the window.

2. Double-click the line item to edit. The Line Item window opens.

3. Edit the Line Item window as needed.

4. Select OK to save changes and close the Line Item window.

To delete a line item:
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1. From the project/shell Cost Sheet window, select the link in the cell in which to delete the
line item. The Cell Detail window opens.

2. Do one of the following:

• Select the line item to delete, and select Remove. The line item is deleted.

• Double-click the line item to open the Line Item window. Select Delete.

3. Select Yes to confirm.

To edit or delete data rolled up from a business process:

Cost sheet data originating from a business process cannot be edited from the cost sheet.

Data must be edited in the business process record if it is still active or through an appropriate
change BP, such as a change order.

To edit or delete data calculated in a formula column:

Formula column cells will reflect changes made to other column data used in the calculations.
Select the column heading to view the formula and display the cost sheet columns used in the
calculation. This will help you determine whether to edit the formula, the data on another
column, or other source.

Create, schedule, or view Cost Sheet snapshots

You can manually create a snapshot (a read-only view) of the project/shell cost sheet and
worksheets. You can also schedule the creation of snapshots on a weekly, monthly, quarterly,
or annual basis, which you might use based on specific conditions, such as before approval of
each Budget Change business process (BP) record or using conditional formatting of forecasts
that you can then compare to earlier forecasts.

Using the Snapshot Log, you can view, print, export, and search the list of snapshots. You can
also open an existing snapshot and display it in both project and transaction currencies. You
cannot delete a snapshot.

To create (save) a manual snapshot of the cost sheet or worksheet:

1. Open the cost sheet or work sheet.

2. From the toolbar, select Menu Options (  ), select Snapshots, and then select Create.

3. In the Create Snapshot dialog box, enter a Title, and select Create.

To schedule snapshots of the cost sheet or worksheet:

1. Open the cost sheet or work sheet.

2. From the toolbar, select Menu Options (  ), select Snapshots, and then select Enable
Auto Snapshot.

3. In the Schedule Snapshot dialog box, select the Enable Auto Snapshot checkbox if you
are ready to start using the automated snapshot schedule immediately after creation.
You can create the schedule and enable or disable it at any time.

4. From the Select Snapshot Frequency list, select the applicable option (Monthly is
selected by default) and then complete the corresponding steps.

• If you select Weekly, select the day of the week.

• If you select Monthly, select:
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– Day, and specify a date from 1 through 31. For months that have fewer than 31
days, the system automatically adjusts the schedule depending on the month.

– The, and select First, Second, Third, or Fourth, and then select the day of the
week.

• If you select Quarterly, specify a Day from 1 through 90. Quarters are based on the
calendar year.

• If you select Yearly, specify a Day from 1 through 365.

Note

The system generates Actuals information at the start of the day and uses it to
update the Forecast information. Therefore, on the last day of an Auto
Snapshot (the cutoff date), the Forecast does not include changes that might
have occurred between the generation of the Actuals and the generation of
the Forecast and the system might prevent you from updating Actuals
information on the last day of the cycle.

5. In the Range of Occurrence section, specify the Start Date (required) and End Date
(optional).

6. If you want the system to update the Prior Forecast column in the sheet after each
snapshot, select the Update Prior Forecasts checkbox.
If you do not select the Enable Auto Snapshot checkbox or if you clear it later, the Update
Prior Forecasts checkbox is disabled (dimmed).

7. To create the scheduled snapshot, select Save.

To view a snapshot:

1. Open the cost sheet, work package, or worksheet.

2. From the toolbar, select Menu Options (  ), select Snapshots, and then select Open.

3. In the Snapshot Log, locate and double-click the applicable snapshot to view it.
You can also refresh the list of items in the log, print it, export it to a Microsoft Excel or CSV
file, or search for a specific snapshot.

A non-editable view of the cost sheet or worksheet opens, displaying the sheet at the time
the snapshot was taken. You can use the toolbar options to print the log, export it to a
Microsoft Excel or CSV file, or search for specific information, such as a cost code.

Importing and Exporting Cost Sheet Data

You can import CBS detail information into a cost sheet manual entry column from a comma-
delimited-value (CSV) file, such as a Microsoft Excel spreadsheet saved in CSV format.

Note

For information about internationalization and CSV files, see Internationalization and
CSV Files.

To import project/shell cost sheet information:
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1. In the project/shell cost sheet, select File, select Import, and then choose one of the
following:

• Summary Budget:
Summarizes the budget information.

• CBS Details:
Lists CBS codes and CBS details information for each.

• Column Details:
Summarizes column details for specific columns.

For a project level cost sheet, the following columns are available for import/export:

- Assigned Budget

- Yet To Buy

- AFC

- Project Cost 1 to Project Cost 100, for columns where the Entry Method is set to
Manual Entry for either Direct entry into cell or Line Item content (either visible or
hidden)

2. Browse to the CSV file to import, select it, and select OK.
Note the following:

Import Option Rules

Summary Budget The following rules apply when importing into the cost
sheet:
• Negative numbers are not allowed for budget

distribution amount.
• There is no check on import whether the total

capital or expense budget was exceeded.
After the import is completed, return to the Budget
Distribution page and save and lock the budget. After
the budget is locked, the system performs the necessary
check to determine if the total capital or expense budget
has exceeded the original budget.

CBS Details The following rules apply to the CBS details when
importing into the cost sheet:
• CBS details are updated, and new, valid CBS details

are added in the order specified in the CSV file.
• The complete CBS code, including the parent code,

must be valid and in the correct order in the CSV
file.

Column Details The following rules apply to the column details when
importing into the cost sheet:
• This selection adds a column to the cost sheet and is

usually done as part of the administration of the
cost sheet.

• For the Assigned Budget (or Budget Remaining
Balance) column and Manual Entry column, all the
existing budget line items are deleted and replaced
with the new budget line items defined in the CSV
 file, even if the CSV file only provides a partial list
of CBS codes.

• Values in the Distributed Budget column are for
reference only.
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After you have constructed the cost sheet and distributed the budget, you can export specific
cost sheet information, saving it to a local file system in a comma-separated-value (CSV)
format.

To export project/shell cost sheet data:

1. In the project/shell cost sheet, select File, select Export, and then choose one of the
following options.

• Summary Cost Sheet: Creates a summary of all rows, columns, and data on the cost
sheet.

• Summary Budget: Creates a summary of the budget window information.

• CBS Details: Lists all the CBS codes on the cost sheet and the CBS details
information for each.

• Column Details: Creates a summary of column details for the selected column.
For a project level cost sheet, the following columns are available for import/export:

- Assigned Budget

- Yet To Buy

- AFC

- Project Cost 1 to Project Cost 100, for columns where the Entry Method is set to
Manual Entry for either Direct entry into cell or Line Item content (either visible or
hidden)

The Summary Cost Sheet option only supports saving the structure for reference
purposes. The other three exported files can be modified and then imported into a new or
existing project/shell cost sheet.

2. Read the confirmation message, and select Yes to continue.
You can open the file in a compatible program, such as Microsoft Excel, to review it before
saving.

3. Select Save, and specify the location in which to save the CSV file.

Note

If you open the CSV file, you will see that it contains notes regarding modifying the
columns and data in the exported file for re-importing into a cost sheet. Follow the
notes embedded in the CSV file for modifying columns and data in the exported
file.

You can create Cost Based Structure (CBS) Codes in Cost Sheets.

Importing Cost Sheet Data from P6

P6 Schedule contains CBS Structure, or Codes, and sends the CBS codes to Unifier Cost
Sheet CBS Codes, also called CBS Codes.

• If you select to use, or run, the Synchronization "Create CBS in Unifier Cost Sheet" within
the Gateway, the Unifier Cost Sheet within the integrated Unifier Projects receive the CBS
Codes created via integration.

• If the Cost Sheet contains preexisting CBS Codes, or contains no Cost Codes, you can
choose to run the Synchronization to create CBS Codes in Unifier, via integration.
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CBS Codes created in P6 have "imported" root to Leaf Structure and are not under any
hierarchy that has been created manually. An "imported" Leaf CBS Code appears under
"imported" root and non-root Summary CBS Codes; however, you can create "manual" Leaf
CBS Codes under "imported" Summary CBS Codes.

Note

• When you are creating Summary CBS Codes by using a CSV file, ensure that you
select the corresponding "Exposed to P6" correctly.

• When you are creating Summary CBS Codes by using Web Services, the
"Exposed to P6" option remains unselected.

• If you hide a parent Summary CBS Code, all the corresponding children will be
hidden.

• If you do not select a Summary CBS Code, the corresponding Leaf codes will
remain unselected.

• If you select one Leaf code, the corresponding parent Summary CBS Code will be
selected.

• If you hide a Leaf code, the hidden Leaf code remains hidden in P6 CBS picker,
but the Summary CBS Codes stay as they were.

About Synchronization methods

Note

The Synchronization Methods are defined in P6 and not Unifier.

Complete:

When Synchronization Method = Complete, P6 sends all CBS levels/codes to Unifier via
Gateway.

The application receives the attributes for each CBS and uses the "Default" value of each Cost
Segment to create Cost Codes within the Cost Sheet.

If the number of CBS levels in P6 Schedule is fewer than the number of Cost Segments in the
corresponding Cost Sheet, Unifier creates two CBS Codes for each lowest level CBS code
sent from P6:

• One Summary CBS code

• One dummy Leaf CBS Code under the Summary CBS code

Levels:

When Synchronization Method = Levels, P6 sends selected CBS levels/codes to Unifier via
Gateway. The selected CBS levels/codes are the codes that are up to a defined number of
levels within the P6 Schedule. The remaining CBS codes are not sent.

Unifier receives the attributes for each CBS and uses the "Default" value of each Cost
Segment to create Cost Codes within the Cost Sheet.
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If the number of CBS levels in P6 Schedule is fewer than the number of Cost Segments in the
corresponding Cost Sheet, Unifier creates two CBS Codes for each lowest level CBS code
sent from P6:

• One Summary CBS code

• One dummy Leaf CBS Code under the Summary CBS code

Partial:

When Synchronization Method = Partial, P6 sends selected CBS levels/codes to Unifier via
Gateway. The selected CBS levels/codes are the codes that are selected as "Integrated." The
remaining CBS codes are not sent.

Unifier receives the attributes for each CBS and uses the "Default" value of each Cost
Segment to create Cost Codes within the Cost Sheet.

If the number of CBS levels in P6 Schedule is fewer than the number of Cost Segments in the
corresponding Cost Sheet, Unifier creates two CBS Codes for each lowest level CBS code
sent from P6:

• One Summary CBS code

• One dummy Leaf CBS Code under the Summary CBS code

Note

– You can switch between the synchronization methods at any point.

– When CBS codes are sent from P6 to Unifier, mark the codes as Imported
from P6.

Defining the budget

After the project/shell cost sheet is defined, you can define the project/shell capital and
expense budget amounts and begin distributing the budget to the various CBS accounts.
Budgets are managed in the Budget Distribution window.

About budget and budget distribution

After the project/shell cost sheet is defined, you can define the project/shell capital and
expense budget amounts and begin distributing the budget to the various CBS accounts.
Budgets are managed in the Budget Distribution window.

Note

Users with module-level modify permission can lock and unlock the budget
distribution. An exception to this is if Assigned Budget is one of the cost sheet
columns, and the user has view restrictions on the column. If a user cannot view the
Assigned Budget column, the Budget Distribution menu option is not available. In
addition, the user cannot import a summary budget.

Open the Budget Distribution window
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To open the Budget Distribution window:

1. Open the project/shell cost sheet.

2. Select Edit, and select Budget Distribution. The Budget Distribution window opens.

3. Use the information in the table below to enter budget information as necessary.

4. Select OK to save and exit.

Item Description

Project or Shell Capital Budget  
Project or Shell Expense Budget  
Scope of Budget  
Comments A text field for any budget-related comments.
Undistributed Capital Amount  
Undistributed Expense Amount  
Lock Date If the budget is currently locked, the lock date displays.
Status Shows if the budget is currently locked or unlocked.
Lock/Unlock Explanation (View) Select the View link to open an audit log that lists the

dates, times, and explanations for lock and unlock
budget instances.

Project or Shell Currency Displays the currency used in the project/shell. This may
differ from the base currency.

Base Currency Displays the base currency used for your company.
Exchange Rate This is the calculation that is used to convert the base

currency to the project/shell currency.
No. of Attachments Displays the number of files, if any, attached to the

budget window. Select the link to view or download.
Budget Distributed Amount The lower part of the window displays each CBS code

row that appears on the cost sheet. Enter the budget
amount for each one. Selecting a CBS code link will open
the CBS Detail window.

Attach Select this button to attach files to the budget
distribution window.

Save & Lock This button is available if the budget is currently
unlocked. Selecting it locks and distributes the budget.
You will be prompted to provide an explanation for this
action.

Unlock This button is available if the budget is currently locked.
Selecting it unlocks the budget to allow for modification
to the budget window and cost sheet rows. You will be
prompted to provide an explanation for this action.

Audit Log This button accesses the audit log, which records budget
activity.

Distribute and lock the budget

After the Budget Distribution window has been completed, you can distribute the budget and
lock the budget.

To distribute and lock the budget:

1. Complete the Budget Distribution window.
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2. Select Apply to save changes.

3. Select Save & Lock.

4. When prompted, enter an explanation for locking the budget, and then select OK.

5. Select Close to close the Budget Distribution window.

Unlock the budget

If the budget has been locked, you must unlock it to make any budget changes or certain cost
sheet modifications, such as adding or modifying cost sheet rows.

To unlock the budget:

1. From the Budget Distribution window, select Unlock.

2. When prompted, enter an explanation for unlocking the budget, and then select OK.

3. Make edits to the budget or cost sheet as needed, and then save and lock the budget
again.

Permission matrix for the Budget Distribution window

Assigned Budget Budget Distribution Import
Summary
Budget

Not Added Added Lock Unlock View Edit  
X X Yes Yes Yes Yes Yes
 Restrictions

(View)
Restrictions
(Edit)

     

 Yes  No No Yes No No
 Yes Yes Yes Yes Yes Yes Yes
 No  No No No No No

Managing Project/Shell Cost Sheets and Properties

The ability to modify cost sheet rows, columns, or properties is dependent on your user
permissions. Contact your project or company administrator regarding your permission levels.

View or edit cost sheet properties

Cost sheet properties include the name, description, structure definition (flat or tree), CBS
code, CBS item titles, and switches for forecast details and forecast inclusion functionality.

Most properties are not editable in the cost sheet after it has been created. The exception is
the Default View, which can be edited.

To open the cost sheet Properties window:

1. Open the cost sheet Properties window by doing one of the following:

• Select the cost sheet from the log. From the toolbar, select Properties.

• Open the cost sheet. Select File, and choose Properties.

2. The Properties window opens.
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• The General tab displays the Title and Description and enables the administrator to
set a Default View for when the cost sheet is opened from the log.

• The Structure tab displays the CBS Code segment and display structure used in the
cost sheet. This information is view-only after the cost sheet has been created.

• The Options tab displays display and forecasting information used in the cost sheet.
This information is also view-only after the cost sheet is created.

Working with Cost Sheet Forecasting

Cost sheet forecasting lets you manage the forecast process by detail line items. It utilizes
cost-type base commits, change commits, or generic business processes that were included in
the Forecasts (Unaccepted) formula.

Here is a high-level overview of the Cost sheet forecasting process.

1. When a forecast-enabled commitment routes to a terminal status it attains "Unaccepted"
status, for example, Base Commits (Unaccepted).

Note

This is different from Base Commits (Approved) or any other routing status.

2. In this example Base Commits (Unaccepted) line items become available for inclusion in
the cost sheet forecast.

3. When you select Forecasting, the Forecast Adjustment log opens, where you can see all
unaccepted line items, based upon the formula used in the Forecasts (Unaccepted)
column.

4. As these line items are accepted into the forecast, the unaccepted status changes to
accepted, for example, Base Commits (Accepted).

5. Depending upon cost sheet configuration, for the amount accepted into the forecast:

• Yet To Buy automatically decreases

• Forecast (Unaccepted) decreases

• Forecast increases

To accept line items into the forecast:

1. In the cost sheet, select Forecast. The Forecast Adjustment log opens.

2. Select the line items that you want to include in the forecast, and select Include in
Forecast. Select either All Line Items or Selected Line Items. The Select Adjustment
Option window opens.

3. In the Select Adjustment Option window you have three options. Your selection of an
option controls how your cost sheet uses the Yet To Buy (YTB) and Allowance For Change
data sources to construct the forecast. Option behavior is as follows:

Automatically adjust YTB

• The system automatically changes the line item to Accepted status, subtracts the amount
from the YTB (or adds it if designed to do so), and includes the line item amount in the
forecast, if configured to do so.

• Cell Details displays a line item for System Auto Adjustment that shows the transaction in
the YTB column.
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• Because the value of the YTB cannot become negative, each transaction will be processed
individually. This may result in only certain transactions being processed and others
staying at Unaccepted status. If the transaction was not processed because doing so
would have yielded a negative YTB, the system will cause an alert. The unaccepted line
items will be available to view in the Forecast Adjustment window.

Manually adjust YTB and AFC

• This option becomes available in the Cell Detail window when you select Include in
Forecast.

• You can add, delete, or modify line items before including commits into the forecast.

• The system does not validate the entry or automatically update the YTB in the cost sheet.

No adjustment

• The system will automatically add the commitment into the forecast, if configured, and
change the status to Accepted. It will not update the Yet To Buy or Allowance For Change
columns.

Working with Yet to Buy (YTB) and Allowance for Change (AFC) data sources

Cost sheet forecasting is designed to leverage the YTB and AFC data sources. If your
company's forecast process uses the YTB and AFC data sources, you can configure the
system to reduce the YTB automatically as you accept commits into the forecast.

Example:

The Total Commits is at $4,000, Yet To Buy is at $2,000, Pending Forecasts (that is, Forecasts
(Unaccepted)) is at $2,000, and Forecasts is at $2,000.

When the $2,000 in the Pending Forecasts column is accepted into the Forecasts column, the
Yet To Buy decreases by that amount. The Total Commits and Forecasts columns will
read $4,000, and the Yet To Buy and Pending Forecasts columns will read 0.00. The Yet To
Buy value may never go below zero.

If designed to do so, the line item commitment may increase the YTB instead of reducing it.
For example, if you have a change commit that adds scope to a project, when that change
commit is approved you may want to add scope to the YTB.

If your company's forecast process does not use YTB or AFC, you may still use cost sheet
forecasting. When the Yet To Buy column is added to the cost sheet, column details will show
any actions previously taken with the YTB.

To adjust YTB and AFC manually:

1. Select the link in the cost sheet cell to open the Cell Detail window.
In any column built with the Forecast(Unaccepted) data source, the Cell Detail window will
have an Include in Forecast button.

2. Select the line item in the Transactions log, and then select Include in Forecast.
The Select Adjustment Option window is now available.

3. Select Manually adjust YTB and AFC. The Forecast Adjustment window opens.

4. To include items in Transactions in the forecast:

a. Select a line item.

b. In the Action field select Mark. The system refreshes the sheet.

c. Repeat the last step and select Include marked in Forecast.
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The option Include marked in Forecast changes the status of any marked transactions
to Accepted and becomes a data source for use in the forecast, if included in the
Forecast formula.

Manual actions taken are not validated; you can include a value in the forecast without
touching the YTB or AFC.

Working with Work Packages

A work package is a group of cost sheet rows that is a subset of the project/shell cost sheet.
Work packages display view-only data taken directly from the project/shell cost sheet and is
not editable in the Work Package window. Data must be edited in the project/shell Cost Sheet
window.

Create a Work Package

The following procedure discusses how to create a work package.

Note

After a work package has been created, it cannot be deleted.

To create a work package:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet to open the Cost
Sheet log.

3. Select the Create button, and select Work Package. The Work Package Properties
window opens.

4. Use the information in the following table to complete the Work Package Properties
window, and select Save.

In this field Do this

Title Enter a title, which displays in the log.
Reference No. Enter a unique reference number.
Description You may enter a description of the work package here.
Creator This will be populated automatically with the name of

the user creating the work package.
Date Initiated This is populated automatically with the initiated date.
Status Select Active or Inactive.
Owner Select an owner for the record.
Vendor Select a vendor for the work package.

You can attach files to the work package after creation with the Attachments tab, which
appears in the right pane when the record is selected.

Open a Work Package

To open a work package:
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1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet. The Cost Sheet
log opens.

3. Double-click a work package from the log, or hover over the work package, select the gear
menu ( ), and select Open. The Work Package opens.

Note

You can select Split to split the window to scroll through the columns while
maintaining the CBS code in view. A summary of the work package data can be
exported into a CSV file from this window.

Change Work Package Currency

You can view work packages in the company base currency or the project currency, which may
differ.

To choose the currency in which to display the work package data:

1. Open the Work Package window.

2. In the top toolbar, select Switch to Base Currency  .

3. If you want to switch back to project currency, select the same button again.

View Work Package Properties

To open the Work Package Properties tab:

From the project/shell Cost Sheet log, select the work package. The Properties tab is visible in
the right pane.

Export Work Package Data

You can save summary work package data to a local file system in a CSV or Excel format.

To export work package data:

1. Open the Work Package

2. From the Work Package window, select Print.

3. Select one of the following options:

• Print

• Export To CSV

• Export To Excel
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Note

– For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

– If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

Depending on your browser or your export selection, the file will be downloaded automatically,
or you will be prompted to download the file manually.

Working with Worksheets

Worksheets are extensions of the cost sheet. They can be used as subcost sheets, enabling
specific calculations or data entry in a separate sheet, which can then be rolled up into a
defined project/shell cost sheet column. The rows equal the CBS codes on the cost sheet.
Worksheets can have multiple columns for data entry or formula calculations, but do not
support data rolled up from business processes.

Example uses of a worksheet:

• A worksheet can be used to off-load complex calculations requiring multiple columns. The
final value can be rolled up into a single cost sheet column.

• Worksheets are governed by individual permissions. You can design worksheets to use as
a method of data entry or review for users that you do not want to have any access to the
project/shell cost sheet, for example, a contractor who is developing an estimate.

A cost sheet column can be associated with a worksheet as the data entry method. A
worksheet column can also be associated with another worksheet, if there is not a circular
reference. There can be multiple worksheets in a project/shell.

Note

A circular reference is referred to a reference in which the last field references the first
field and creates a closed loop.

A worksheet template can be created in Admin mode. Permissions can be controlled for
individual worksheets. Worksheets are not independently reportable; however, cost sheet
columns that reference worksheets can be reported on.

Create a Worksheet

You can create a worksheet by copying a worksheet template or copying a worksheet from
another project/shell.

To create a worksheet from a template:
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1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet. The Cost Sheet
log opens.

3. From the toolbar, select Create, select Worksheet, and then select From Template.

4. In the Create Worksheet Template dialog box, select the template to copy and select
Save. The worksheet appears in the log.

To create a worksheet from another worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet. The Cost Sheet
log opens.

3. From the toolbar, select Create, select Worksheet, and then select From Projects.

4. In the Create Worksheet from Project dialog box, click Select.
The Worksheets list contains each worksheet in each project/shell. If there are multiple
worksheets in a project/shell, they are listed separately.

5. Choose an item, and click Select.

6. Select Save. The worksheet appears in the log.

You can add manual-entry or formula columns to a worksheet. Rows are created automatically
from the CBS codes in the cost sheet.

Open a Worksheet

To open a worksheet directly from the log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet.
The Cost Sheet log opens.

3. Select the worksheet from the log, and click Open.

Note

When you first open the sheet, the opening view will depend on the Default View
option selected in the Properties window. Your cost sheet administrator can set this
default view. Worksheets can be resized and split/unsplit the same way as cost sheets
(see Resize cost sheet window or Split or unsplit cost sheet window).

To open a worksheet from the cost sheet:

Select cost sheet column data that refers to a worksheet as data entry.

Adding a column to a worksheet is similar to adding a column to the cost sheet. You can add
manual-entry (direct or line item) columns or formula columns. You can also add columns that
reference other worksheets. This allows interaction between worksheets.

The available data sources are Project Worksheet Cost 1 through 50.

To add a column:

1. Open the worksheet, and select Columns. The Columns Log opens.

2. Select New. The Column Properties window opens.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 229 of 671



3. Complete the column properties as usual for a column.
If you are creating a formula, the data sources that are available for the formula are limited
to the other columns on the worksheet.

4. Complete the window, and select OK.

View or edit worksheet properties

Worksheet and worksheet type properties can be viewed and edited. The ability to edit
worksheet properties is dependent on your user permission settings. Contact your project or
company administrator if you have questions regarding your user permission settings.

To view or edit worksheet properties:

When you select your existing project cost sheet from the Cost Sheet log, the right pane of the
log displays the Properties and Audit Log tabs.

When you open (gear menu [ ]) your existing project cost sheet from the Cost Sheet log, the
Cost Sheet window opens and displays the currency, a series of toolbar options, and the
project cost sheet.

Note

You cannot edit your existing project cost sheet from the Cost Sheet log.

When you click a worksheet type in the Cost Sheet log, the right pane of the log displays the
Properties, Permissions, and Audit Log tabs. These tabs let you edit or change the name or
description of a worksheet type, view permissions for it, and view a log listing the changes in it.
(Be aware that the Audit Log only provides details based on the import of a CSV file.)

When you open (gear menu) a worksheet type in the Cost Sheet log, the worksheet overlay
window opens which contains details about the worksheet. If you click any of the cells, under
any column in the worksheet, the Cell Detail window opens, which lets you view the
information, add attachments, add notes, and so forth.

Modify worksheet default view

You cannot modify a worksheet default view, but you can create views and set any newly
created view as the default view.

Add a Worksheet Column to the Cost Sheet

You can roll up the data from a worksheet column into a project/shell cost sheet column.

To add a worksheet column to the cost sheet:

1. In the cost sheet, select Columns, and then select New. The Column Properties window
opens.

2. In the Datasource column, choose any of the project/shell cost data sources Project Cost
1 through Project Cost 25.

3. For Entry Method, choose Worksheet.

4. Choose the worksheet (name), and then the column within the worksheet.

5. Complete the rest of the Properties window, and select OK.
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Worksheet data in cost sheet column:

When a worksheet is used as a source for a cost sheet column, you can open the source
worksheet by selecting a cell in the cost sheet column, make the necessary data changes in
the worksheet, and then select Save to save the updated source worksheet.

When you update the source worksheet using this method, the system saves the updated
worksheet in the database, but the system does not immediately show the updates in the cost
sheet window.

To see the updates in the cost sheet, either:

• Refresh the cost sheet (select Refresh), or

• Close the cost sheet and open it again.

Example:

You enter $8,888.00 in your project Work Sheet Column (Cost 1 column, row 3) for cost code
00800 and save your input.

As per design, the system saves your updates in the project worksheet, but it does not display
the updates in the cost sheet until you select Refresh in the cost sheet or close the cost sheet
and open it again.

Assign permissions to the worksheet

You can configure the permission settings for each worksheet, which lets you control access to
each worksheet individually. The owner of the worksheet is granted permission to access and
modify it automatically. The owner must grant permissions for other users or groups to access
a worksheet.

To assign permissions to a worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet. The Cost Sheet
log opens.

3. Select one or more worksheets.

4. From the toolbar, select Actions, and then select Permissions. You can also select the

gear menu ( ) and select Permissions to assign permissions to only one worksheet. The
Permissions window opens.

5. In the Permissions table, type the user or group name in the Add box and select the user
or group to grant access.

6. By default, each listed user or group will be granted View permission, allowing them to
open the worksheet. To grant additional permissions, select the checkboxes that
correspond to the user or group:

• All: User will have View, Edit, and Modify Permission.

• Modify Permissions: Allows user to control the worksheet's permission settings.

• Edit Data: User can import worksheet information, save a snapshot, edit worksheet
properties, and add columns.

• View: User can view the worksheet.

7. Select Save, or select Save & Next to go to the next worksheet.
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When you change settings in the Permissions window, the Save button is enabled. After
you select Save, a spinning wheel appears while your changes are saved and then the
Save button is dimmed.

You can Remove user or group permission by selecting  in the Remove column.

Note

Permissions can only be set for worksheets. You cannot set permissions for cost
sheets or work packages.

Import worksheet column details

You can only import data into columns that are defined as manual data entry.

To import column details:

1. From the File menu, select Import, and then select Column Details, or select the Import
button and choose Column Details. The Select Column window opens.

2. Select the column, and select OK.

Export worksheet details

This will allow the user to export details of the worksheet. The following options are available
under Export:

• Summary Worksheet: This option will export the entire worksheet similar to cost sheets.

• Column Details: You can only export data from manual data-entry columns.

To export a summary worksheet:

From the File menu, select Export, and then select Summary Worksheet, or select the
Export button, and choose Summary Worksheet.

Project or Shell Cost Sheet Log

When you select the Cost Sheet sub-node in the left Navigator (User mode), you can see the
Cost Sheet log layout.

Note

The functions of the options presented in this section have been explained in the
preceding sections of Working with Project or Shell Cost Sheets. This section explains
new functions and procedural differences.

The log contains the following types of records:

• Cost Sheet

• Worksheets

• Work Packages
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Cost Sheet Log

When you select a cost sheet row, the right pane opens. The right pane contains the
Properties and Audit Log tabs, which provide more details for the selected cost sheet.

The Properties tab contains the following fields:

• Name: Cost Sheet Name. Read-only field.

• Description: Cost Sheet Description. Read-only field.

• Structure: Read-only field. Displays the selected Radio option only. For example, if cost
sheet Structure is 'Flat', then this field displays the 'Flat' only (and not 'Tree') structure.

• Sort WBS: Editable checkbox that is displayed only if the structure is 'Flat'.

• Segments: Displays a preview of the cost code structure using the segments and cost
code separator as defined by the user.

• CBS Code Label: Read-only field.

• CBS Item Label: Read-only field. This is same as existing field 'CBS Item' within the block
'Labels' and tab 'Options.'

• Forecast Details: Read-only. Displays the radio option selected by the user when defining
the cost sheet.

• Forecast Inclusion: Read-only. Displays the radio option selected by the user when
defining the cost sheet.

• Enable Cost Sheet Forecasting: Read-only checkbox. It is displayed only if the user has
selected this option.

• Enable P6 sources: Editable checkbox.

The Audit Log tab displays the Audit log for the cost sheet. Be aware that the Audit Log only
provides details based on the import of a CSV file or an API-based update.

The right pane has the 'Expand' icon in the upper-right corner. Use it to expand or collapse the
pane.

The left pane lists all the shell instances of the same type (the shell in which cost sheet is
being created).

If you create a cost sheet in a project, the list shows a list of all project instances in the
company, and you can copy the cost sheet from any source.

The Cost Sheet log layout contains the following columns:

• Name

• Reference No.
This column does not appear in an empty log or if there are no work packages in the log.
That is, this column appears only if there are work packages within the log.

• Date Created

• Created By

• Type
This will be the default sort column, followed by sort on Name.

• Auto Snapshot
This column indicates whether automatic snapshots are scheduled for the sheet.
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• Status

The following options are available on the toolbar: Create, Actions (which provides access to
Permissions), View, Refresh, Print, and Find on Page. The following explains each option in
detail.

Create

When no Cost Sheet has been created yet, there are two submenu options available:

• from Template
Lists all the available Cost Sheet Templates within the company. You can create a Cost
Sheet within the project/shell when you select New, select Cost Sheet, and then select
Copy from Template.

• from <shell type>
When you select this option, the Create Cost Sheet from Project window opens. In this
window you can:

– See the selected project

– Manually enter columns from a list of available columns

– Determine the shell size, location, and duration

The fields in this window capture the factors that you can copy over manual entry columns
from source project/shell cost sheet to destination. The Available Columns displays a list of
all manual entry columns from the selected project cost sheet. You can select none or any
number of available columns in the right section. The Factors fields let you enter a factor to
copy over the manual entry columns into the cost sheet.

When you select Done, a new cost sheet will be created in the project.

Actions, and then Permissions

Lets you configure the permission settings for a worksheet. See Assign permissions to the
worksheet.

View

The default view is All which results in the display of all sheets in the log. You can select
Group by Type view which results in the cost sheets grouped by type, with the cost sheet at
the top.

Refresh

Updates the data that is displayed.

Print

Lets you print the list of cost sheets displayed (Print) or export the list to an external file
(Export to CSV or Export to Excel).
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Note

• For export to Microsoft Excel, the system currently supports only Euro (EUR) and
United States Dollar (USD) currency symbols.

• If you export data from a business process (BP) record, sheet (such as an Activity
Sheet), or log (such as Company Funding Sheet Log) to Excel, be aware that
depending on how your negative values are formatted, you might need to
configure your columns in Excel to match the correct data type (Number).
Otherwise, the columns will not be treated as numeric and will not sum as
expected. One supported format includes placing the negative sign between the
currency symbol and the amount (for example, $-1,000).

Find on Page

To find an item on the log. You can do a text-based Find on each column.

When no records have been created within the log, the right pane is blank. You can collapse
the right pane.

When there are records within the Cost Sheet node, the Project Cost Sheet is selected by
default, and the Create option has the following submenu options:

• Worksheet: (Same as creating the cost sheet from a template or from another project.
Selecting any template creates a worksheet in the project by copying the selected
template.)

– from Template: Selecting any template creates a worksheet in the project by copying
the selected template.
Project Cost Sheet - Template 1 < listing all the available Worksheet Templates in the
Company

Project Cost Sheet - Template 2 < listing all the available Worksheet Templates in the
Company

– from Projects: Selecting this option lets you select a worksheet from another shell of
the same type in which the worksheet is being created. This picker is similar to the
'Select Project' picker in 'Create Cost Sheet from Project' window. Similar to 'Select
Project' picker in 'Create Cost Sheet from Project' form, when you select at the 'Select
Project' picker a flat list of all worksheets from all shells of same type as the one in
which the worksheet is being created. You can select 'Create Worksheet (from project)
and then navigate to some other log within the system without taking any action in the
resulting overlay form. In such a scenario, when you return to the Cost Sheet log, the
previously opened overlay form will continue to show up in the log.

• Work Package
When you select to create a Work Package, you will see a new overlay window (Create
Work Package). The 'Owner' picker is similar to a single-select type-ahead user picker at
other places in the system (For example: Transfer Ownership action within BP logs). The
'Vendor' picker is a single select type-ahead Company picker (similar to the single select
user picker). Both pickers provide suggestive text informing you that these are type-ahead
boxes.

If you select more than one record from the cost sheet log at the same time, the right pane will
be blank with message: Details of multiple records cannot be viewed.
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Note

If you select more than one worksheet at the same time, the right pane displays the
Permissions tab.

Worksheet Log

When you select a project/shell worksheet (select the row), the right pane opens. The right
pane contains the Properties and Audit Log tabs.

The Properties tab is displayed by default and contains properties of the Worksheet. The
General block in this tab has the following tabs:

• Name: Worksheet Name. Editable text box, DD will be same as existing.

• Description: Worksheet description. Editable text box, DD will be same as existing.

The Audit Log tab displays the Audit log (View and then select Audit Log) for the Worksheet.
Be aware that the Audit Log only provides details based on the import of a CSV file or an API-
based update.

The right pane has the Expand  icon at the top right. Use it to expand or collapse the pane.

If you select more than one record from the worksheet at the same time, the right pane
displays the Permissions tab. This lets you set permissions for more than one worksheet at the
same time.

To grant permission to a worksheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet.
The Cost Sheet log opens.

3. Select one or more worksheets, select Actions, and select Permissions. You can also

select the gear menu ( ) and select Permissions to assign permissions to only one
worksheet. The Permissions window opens.

4. In the Permissions table, type the user or group name in the Add box and select the user
or group to grant access.

5. By default, each listed user or group will be granted View permission, allowing them to
open the worksheet. To grant additional permissions, select the checkboxes that
correspond to the user or group:

• All: User will have View, Edit, and Modify Permission.

• Modify Permissions: Allows user to control the worksheet's permission settings.

• Edit Data: User can import worksheet information, save a snapshot, edit worksheet
properties, and add columns.

• View: User can view the worksheet.

6. Select Save.
When you change settings in the Permissions window, the Save button is enabled. After
you select Save, a spinning wheel appears while your changes are saved and then the
Save button is dimmed.

7. When editing one record at a time, select the left arrow to view the previous worksheet or
the right arrow to view the next worksheet.
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8. After exiting the Permissions window, the Permissions tab will be refreshed with the
updated information.

You can Remove user or group permission by selecting  in the Remove column.

Work Packages

When you hover over a Work Package row, the gear menu ( ) displays.

When user will select a Work Package row (select the Work Package row), the right pane
opens and displays the following tabs:

• Properties

• Attachments

Note

The 'Vendor' is a company picker.

The Properties tab is displayed by default and contains properties of the Work Package. The
General block contains all the elements of the Work Package properties window.

The Attachments tab has the same elements of the Attachments tab in a BP log. You can add
attachments from a Document Manager, or your local computer, from this tab.

The gear ( ) menu, for any attachment has the following options:

• Review

• AutoVue Review

• Open in Office for the web

• Download

• Remove

You can right-click multiple attachments and perform download or remove.

Working with the Company Cost Sheet

Like other cost sheets, the ability to work with the Company Cost Sheet depends on the
permissions that you have.

Note

Contact your project or company administrator if you have questions regarding your
permission levels.

A Company Cost Sheet, as shown in the example below, is comprised of a series of company
projects/shells represented in rows.
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Note

There is only one Company Cost Sheet.

Within the Company Cost Sheet, the projects/shells are listed in order by Project Number
and then by Project Name followed by other data sources, all shown in columns.

Data rolls up to the Company Cost Sheet columns from the individual project/shell cost
sheets columns, by data source.

The Company Cost Sheet columns headings provide the following information, upon hover
over:

• DataSource

• Total

• Formula (when applicable to the data source)

If the Base Currency is different from the Shell Currency, the current "Active" Exchange Rate is
used to display Costs in the Company Cost Sheet.

Only published P6 data source, as defined by the Administrator (in the Standards & Libraries
(Admin mode)), can be used for P6 as data source. If you add a column to the Company
Cost Sheet and select P6 as the data source, the data is acquired from the corresponding P6
Source column of the shells in the company.

The following explains how to work with the Company Cost Sheet.
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Opening Company Cost Sheet

To open the Company Cost Sheet:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet to open the
Company Cost Sheet to access all the CBS projects/shells that the Company Cost
Sheet pulls data from.

Searching for Projects or Shells in Company Cost Sheet

To search for projects/shells that are listed (rows) in the Company Cost Sheet:

1. From the toolbar, select Find on Page to open a row on top of the rows within the
Company Cost Sheet.

2. Enter values in the desired column to start a search for a specific project/shell that contains
the information that you are searching for.

To deactivate the search, select Find on Page.

Importing Company Cost Sheet Data

To export the Company Cost Sheet data:

1. From the toolbar, select Menu Options (  ), and select Import.

2. Select Column Details to open the Import Column Details window.

3. Select Column Name and select the column that you want to import.

4. Select Import.

5. Follow the prompts.

Exporting Company Cost Sheet Data

To export the Company Cost Sheet data:

1. From the toolbar, click Menu Options (  ), and select Export.

2. Select one of the following options:

• Summary Cost Sheets: Lets you create a comma-separated values (CSV) file
(Summary_Cost_Sheet.csv) for export. This option lets you export complete cost
sheet information, including project/shell name, number, and data from all columns.

• Column Details: To open the Export Column Details window and select the column
that you want to export. Select Column Name, and select the column that you want to
export. This option exports only Company Cost 1 to Column Cost 25 logical data
sources that are configured as manual entry.

3. Select Export.

4. Follow the prompts.

Adding a Column to Company Cost Sheet
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The Project Number and Project Name columns in the Company Cost Sheet are static. This
means that you cannot delete or hide these columns. Also, you cannot add columns to the
static columns or see or access their properties. These two columns are separated from the
rest of the columns through a vertical separator.

The rest of the columns in the Company Cost Sheet are dynamic. This means that you can
delete or hide these columns. Also, you can add columns to the dynamic columns or see or
access their properties. To access these options, right-click the column heading and select
from the following available options:

• Hide

• Delete

• Lock after this Column

• Insert

• Properties

With the exception of the very first column (one of the static columns), if you select inside a cell
and right-click, you get the Insert Column Before and Insert Column After options. The
second column (Project Name) only lets you Insert Column After.

To add a column to the Company Cost Sheet:

Note

The red asterisk next to a field box indicates that the field is a required field. You will
not be able to save your changes without entering a value in that field.

1. From the toolbar, select Add Column to open the New Column window.

2. Enter values, or select options, in the following fields:

• Name: Enter the name of the new column that you want to add to the existing
Company Cost Sheet.

• Type: Select the source type. Your options are:

– From Business Process

– Direct Entry

– Line Item Content

– Formula: When you select this option, the Formula field box opens in the New
Column window, which lets you enter the formula.
To create or build a formula, click Select (upper-right corner of the Formula field
box) to open the Formula Creation window. In this window, you can select the
column that you want to contain the formula and use the features to create or build
your formula.

• Datasource: Select your data source.

Note

The options made available in Datasource drop-down list changes based on
the selection that you make in the Type drop-down list.
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• Data Format: Selecting one of options under this field depends on your previous
selections. The options are:

– Currency

– Decimal

• Display Mode: Lets you determine whether to display the column after you add it to
the sheet.

– Show

– Hide

• Total: Lets you set how the totals are displayed. The options are:

– Blank

– Sum of All Rows

• Column Position After: Lets you determine the position of the added column.

3. When finished, select Save or Save & Add New.
To discard changes, or to close window, select Cancel.

Restricting a Column on the Company Cost Sheet

Restricting columns on the Company Cost Sheet refers to allowing or disallowing users or
groups to edit or view columns.

To place restrictions on a column on the Company Cost Sheet:

1. From the toolbar, select Menu Options (  ), and select Columns.

2. Select Restrictions to open the Restrictions window.

3. To select users or groups, click Select to open the User and Group Picker window. After
you select your users or groups, select Done to add the users or groups and close the
window and go back to the Restrictions window.

4. Proceed to select the column (under the Column) that you want to be restricted for the
users or groups.

5. Restrict users or groups by preventing (disallowing) them to edit or view the column.
If you do not see the Disallow Editing or Disallow Viewing columns, right-click the
Column header to open the menu, select Columns, and select Disallow Editing and
Disallow Viewing one at a time.

The Column header menu also lets you sort, lock, and unlock columns: Sort Ascending,
Sort Descending, Lock after this Column, and Unlock

6. When finished, you can do one of the of the following:

• Select Save to save your changes and close the window.

• Select Save & Close to save your changes and close the Restrictions window.

To discard changes, or to close window, select Cancel.

Changing the Properties of a Column on the Company Cost Sheet

To change the properties of an existing column on the Company Cost Sheet:

1. To open the Column Properties window, right-click the column heading, and select
Properties.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 241 of 671



2. Proceed to change or update the values, or selections, for the following fields:

• Name

• Type

• Datasource

• Data Format

• Display Mode

• Total

• Column Position After

For details about each of the preceding fields, see Adding a Column to Company Cost
Sheet.

3. When finished, select Save to save your changes and close the window.

To discard changes, or to close window, select Cancel.

Creating and Opening a Snapshot of the Company Cost Sheet

Snapshot provides a rendering of the Company Cost Sheet at the time that the snapshot was
taken. It is similar to taking a photo of the Company Cost Sheet at a specific time.

To create a snapshot of the Company Cost Sheet:

1. From the toolbar, select Menu Options (  ), and select Snapshots.

2. Select Create to open the Create Snapshot window.

3. Enter a title for the snapshot. Note that the date and time is displayed.

4. Select Create.
To discard changes, or to close the window, select Cancel.

To open your snapshot, or any previous snapshots:

1. From the toolbar, select Menu Options (  ), and select Snapshots.

2. Select Open to open the Snapshot Log.

3. The Snapshot Log lists all the Company Cost Sheet snapshots in a table, categorized
according to the snapshot title, date that it was created, and the user who created it.
You can use the toolbar options to refresh the list, print or export the list, or find items in
the list.

4. Select the desired snapshot on the list, select the gear menu ( ), and select Open to
open the snapshot. Alternatively, you can double-click the selected snapshot to open it.

You can open several snapshots, if available, to compare past values with the current ones.

You can close the Snapshot Log after you have opened your snapshots.

Accessing Project or Shell Cost Sheet from Company Cost Sheet

You can access a project/shell cost sheet through the Company Cost Sheet. This lets you
access any specific cost information (about the project/shell cost sheet) that "rolls up" to the
Company Cost Sheet.

To access the project/shell cost sheet through the Company Cost Sheet:
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1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Cost Sheet to open the
Company Cost Sheet to access all the CBS projects/shells that the Company Cost
Sheet pulls data from.

Note

If the selected source cost sheet has duplicate columns that the system cannot
auto-correct, an alert is displayed to the user to take further action.

3. From the first column, identify the project/shell that you want to access, and select the cell
(select the link) to open the cost sheet for that project/shell in a window.

As shown in the image below, the cost sheet window has the following parts:

• Title

• Toolbar

• Columns

• Properties tabs
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• Title
Displaying the title of the cost sheet and an icon (open padlock or closed padlock)
indicating whether the budget for the project/shell is unlocked or locked.

• Toolbar
Enabling to conduct various operations within or with the cost sheet. For more information,
see Project or Shell Cost Sheet Toolbar Options.

• Columns
There are two sets of columns:

– Cost Code and Code Name columns

– Other columns

For more information, see Project or Shell Cost Sheet Columns.

• Properties tabs
The properties tabs provide additional information about each cost code, as well as the
associated budget, included in the project/shell cost sheet. With the exception of the Code
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Name column, each column in the cost sheet has corresponding properties that are shown
in a series of tabs, displayed at the lower section of the project/shell cost sheet window. In
case you cannot see these properties tabs, select and drag the split screen icon ( ) to
adjust the size of the lower pane.

For details about the columns and properties tabs, see Project or Shell Cost Sheet
Columns.

The following explains the elements of project/shell cost sheet when you access it from the
company cost sheet.

Project or Shell Cost Sheet Toolbar Options

The following explains the project/shell cost sheet toolbar options, after you open the project/
shell cost sheet from the company cost sheet.

Refresh: Use this option to update the information displayed on the screen.

Print: Use this option to print the information displayed on the screen (Print) or export the list
displayed to an external file (Export to CSV or Export to Excel).

Note

• For export to Microsoft Excel, the system currently supports only Euro (EUR) and
United States Dollar (USD) currency symbols.

• If you export data from a business process (BP) record, sheet (such as an Activity
Sheet), or log (such as Company Funding Sheet Log) to Excel, be aware that
depending on how your negative values are formatted, you might need to
configure your columns in Excel to match the correct data type (Number).
Otherwise, the columns will not be treated as numeric and will not sum as
expected. One supported format includes placing the negative sign between the
currency symbol and the amount (for example, $-1,000).

Find on Page: Use this option to search the information displayed on the screen to find a
particular item or entry. Selecting this option will open a row on top of the rows within the log,
and you can enter values in each column to start a search for a specific item in the log.

Menu Options (  ): This option lets you access the following features:

Feature Description

Export Lets you export the following:
• Summary Cost Sheet
• Summary Budget
• CBS Details
• Column Details

Snapshots To open the Snapshot Log and access all the snapshots
taken from the cost sheet.

Currency To select one of the following currency options for the
cost sheet:
• Project Currency
• Base Currency

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 245 of 671



Feature Description

Budget Distribution To open the Budget Distribution window. Note that the
open padlock icon signifies that the budget for this cost
sheet is unlocked. For more information, see the
"Working with Budget Distribution Overview" and
"Working with Budget Distribution Distributed Amount"
sections later in this topic.

Row Coloring To apply color to the columns. Your options are:
• Multiple Colors
• Single Color

Properties To open the Properties window. This option lets you
review properties such as CBS code label, CBS item label,
whether the cost sheet has been enabled to received
data from P6, and so forth. The Properties fields are
read-only.

Audit Log To see a record of all the actions that have been taken on
the project/shell cost sheet based on the import of a CSV
file or an API-based update. The following are captured
in the Audit Log:
• Date
• Event
• Action
• Field
• Old Value
• New Value
• User Name
• Proxy User
• Attachment
Use the toolbar options to refresh, print, or find items
within the Audit Log.

Currency

This is a toggle key that lets you switch to Base Currency or switch to Project Currency.

Working with Budget Distribution Overview

When you select Budget Distribution from the Menu Options, as shown in the image below,
the Overview block provides two sets of information within two panes. For example, the left
pane provides information about the project budget capital, expense, and scope, and the right
pane provides properties information within the following tabs:

• Attachments tab: Contains any available files that have been attached to the budget as
supporting record.

• Audit Log tab: Lists all the actions taken on the budget.

• Lock/Unlock History tab: Provides a history regarding the times that the budget has been
locked or unlocked, which includes date, time, explanation, and user name.
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Working with Budget Distribution Distributed Amount

When you select Budget Distribution from the Menu Options, as shown in the image below,
the Distribution Amount block shows cost code details and properties. The Distribution
Amount block is divided into two panes:

• The left pane lists the cost codes and the cost codes information related to the budget
distribution.

• The right pane is the properties pane which contains the information to a selected cost
code that is listed in the left pane.

These properties pane has the following tabs:

General tab: When you select a cost code from the left pane, this tab shows the CBS details
for that cost code. All the fields are read-only.

Attachments tab: When you select a cost code from the left pane, this tab lists any files that
are attached to that cost code.

Notes tab: When you select a cost code from the left pane, this tab lists any notes related to
that cost code.

Use the Distribution Amount block toolbar options to refresh, print, find, or collapse-expand
the groups of cost codes listed (if any).
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Project or Shell Cost Sheet Columns

There are two sets of columns in a project/shell cost sheet:

• Cost code and code name columns

• Other columns

In the first column, Cost Code, you can select inside a cell, then right-click, and do one of the
following:

• Add Sibling Row: This selection will open the Add Rows window which lets you enter
CBS details for the sibling row.

• Add Child Row: This selection will open the Add Rows window which lets you enter CBS
details for the child row.

In the second column, Cost Name, you can select inside a cell, then right-click, and do one of
the following:

• Add Sibling Row

• Add Child Row

• Insert Column After: This selection will open the New Column window which lets you
name the new column, select the source type (form BP, worksheet, activity sheet, line item,
and so on), select a data source, data format, display mode, total, and determine the
column position.

If you right-click in a cell within other columns, you can:
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• Add Sibling Row

• Add Child Row

• Insert Column Before

• Insert Column After

Project/Shell Cost Sheet Columns and Properties Tabs

If you select inside a cell under the Cost Code column, the following properties tabs will be
displayed at the lower section of the project/shell cost sheet window:

• General tab: The General tab will display the CBS details, Cost Code, Cost Item, Cost
Type, Status, and other information related to the selected Cost Code. The information on
the General tab is read-only.

• Attachments tab: The Attachments tab will include attachments, if available.

• Notes tab: The Notes tab will include any related notes, if available.

• Fund Assignment Order tab: The Fund Assignment Order tab will include information if
the Funding Manager is used to set the project/shell fund assignment order at the CBS
level.

If you select inside a cell under the other columns, the following properties tabs will be
displayed at the lower section of the project/shell cost sheet window:

• Transactions tab: Which, depending on the column that you select, you can group and
view the details. For example, if you select a cost code cell under the column named
Original Budget, you can view the Transactions by selecting the Budget Approval
(Approved), for the View By drop-down field, and see the details for that transaction such
as the title, work package, description, and amount.

• Cell Details tab: As the name of the tab suggests this tab provides read-only fields
containing details about the CBS code that you have selected.

• Attachments tab: To access any attached files related to the cost code.

• Notes tab: To access any notes related to the cost code.

• Audit Log tab: To see a record of all the actions that have been taken on the column that
the selected cost code is a part of. Be aware that the Audit Log only provides details based
on the import of a CSV file or an API-based update.

Schedules of Values (SOV)

The Schedule of Values (SOV) feature provides a way to assemble information from Contract,
Change Order, Invoice, and Payment Business Process into an SOV sheet and streamline the
process of invoicing for completed phases of a project. The following is a list of Schedule of
Values (SOV) types:

• General Spends

• Payment Applications

• Summary Payment Applications

SOV functionality is available with uDesigner-created Cost BPs for which the Allow creation
of SOV option is defined. The business processes can be designed to create an SOV sheet
automatically upon reaching the designated step.

When a Base Commits Business Process (BP) is approved, it creates a Schedule of Values
(SOV) sheet. The SOV sheet is the "working document" on which committed amount are
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entered. The committed monies shown on the SOV sheet are rolled up to the Company Cost
Sheet.

Note

The Change Commit BPs continue to change or add costs to the SOV during the life
of the Project/Shell.

The Schedule of Values (SOV) functionality provides a way to assemble information from
contract, change order, and invoice/payment BPs into a SOV sheet, streamlining the process
of invoicing for completed phases of a Project/Shell.

SOV functionality is available for Cost type BPs in which the "Allow creation of Schedule of
Values" option is defined, or selected, in the design properties. The BPs can be designed to
create an SOV sheet automatically upon reaching the designated step.

You may define one SOV sheet per Commit BP, for example, a Purchase Order or a Contract.
Rows are automatically populated based on the CBS/Cost/Accounts codes defined in the
Commit BP.

Note

If you have Edit Data permission and you are working with the classic Payment
Application, you can manually edit data for text-based columns and select different
values for columns that use Pull Down data elements (DEs). This does not apply to
Summary Payment Application (SPA) or General Spends. For more information on
assigning permissions, see Granting Permissions to Other Users.

Similar to the Cost Sheet, you can create SOV sheet views for better view of data.

To access the SOV sheet log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Schedule of Values, and then select the
applicable SOV, such as General Spends.

From the SOV sheet log, you can open:

• BP records

• Base Commits BP records

When you double-click the SOV Sheet of a Base Commits BP record, a window opens that lets
you see the SOV of the Base Commits BP record.

In the Schedule of Values: General Spends window, when you select a SOV Base Record,

you can select the gear menu ( ), and perform one of the following:

• Open a record (Open)
You can also open a record by selecting the record number link in the Properties tab (right
pane of the log).

• Set permissions for a record (Permissions)

• Open a SOV Base Record in Standard View (Open Base Record)

• Open a record in Classic View (Open Classic Interface)
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When you open an SOV Base Record, the Lineitem Type column includes an active data
element link, which lets you access the line item and edit the data.

When you open an SOV Base Record, the following tabs are displayed on the right pane:

• General

• Breakdown

• Attachments
In classic view, you could add attachments, but in the standard view this option is not
supported.

• Notes

• Fund Assignment Order

The contents of these tabs are read-only, and the View Transactions is similar to Cost Sheet.

Types of SOV Sheets

The following lists the types of Schedule of Values (SOV) sheets:

• General Spends

• Payment Applications

• Summary Payment Applications

Note

In an SOV sheet, the system will round the field values, including the Decimal
Amount type field values, to two decimal places.

General Spends

Use the General Spends SOV type for any Commit Business Process and associated Change
Commits and Spends/Invoices.

Payment Applications

Use the Payment Applications SOV type:

• In association with Commit and Spends Business Processes that are designed for
payment applications. This allows direct entry of values in an SOV sheet, which are
automatically added to a payment application.

• For invoicing at the CBS or breakdown level. Payment Applications auto-populate data to
and from the SOV to manage balance-forward formulas. The breakdown is similar to the
General Spends SOV sheet.

Note

The General Spends and Payment Applications SOV types can show CBS
information either by grouping CBS codes (CBS mode) or as individual line items
from commits (base commit and change commit together). The information that
the SOV displays is dependent upon the design of the base commit.

Summary Payment Applications
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The Summary Payment Applications SOV allows users to allocate cost to line items based on
the line item type (Lump Sum or Unit Cost).

Use the Summary Payment Applications SOV type in association with Commit and Spends
Business Processes (BPs) that are designed for Summary payment applications SOV type.

Note

The Summary Payment Applications sub-node will be available under the Schedule of
Values node only if a Base Commits, or Change Commits, of SOV type Summary
Payment Applications is deployed in uDesigner.

Creating an SOV Structure

The SOV structure is defined at the Project level (User mode). Any modifications applied to an
SOV structure will be reflected on all SOV sheets using that structure, that is, all SOV sheets
used in a Project. If an SOV structure does not exist when you auto-create an SOV sheet with
a Cost type Business Process (BP), one will be created automatically with the default columns
CBS Code, CBS Item, and Breakdown. You can edit this structure as needed. The default
columns are not editable.

This section explains how to create, view, add columns to, and edit an SOV sheet structure.

To create an SOV sheet structure:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Schedule of Values.

3. In the left Navigator, select one of these options: General Spends, Payment
Applications, or Summary Payment Applications to open the Schedule of Values log.
If SOV sheets related to your options are already present, a structure exists and you can
select Update Structure to update the existing structure.

4. Select the Create Structure button. The Select Template window opens.

5. Select an SOV template from the list and select OK.

6. Read the confirmation message and select Yes to confirm. The SOV sheets will be created
using the structure defined by the template. You can use this structure as is or make edits
as necessary.

To view or to set up the SOV structure:

1. From the Schedule of Values log, select Update Structure on the toolbar to open the SOV
Structure window and view the contents and information that is listed under each column.

2. Select Columns to begin the process of adding additional columns.

3. In the Columns log, select New to open the Column Properties window.

4. Enter a name for the column in the Name field.

5. Select a data source from the Datasource drop-down list.

6. Select a Display Mode to determine whether the new column should appear on the SOV
sheet or not.

7. Select a position for the new column from the Column Position After field.

8. Select OK.
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Note

• While setting up the SOV structure, you may select Split to divide the window
in half. This lets you scroll through columns and rows on the right while
maintaining a view of the activity column on the left. Selecting the Split button
again restores the whole window. While the window is split, you may select
Freeze to lock the left half of the window in place. Select Freeze again to
unfreeze.

• The structure may contain hidden columns. For example, one or more
columns used in the formulas for other columns where the information in the
hidden columns is not important to be viewed may have been hidden, leaving
more room in the display for the formula column. Hidden columns otherwise
behave normally.

To edit an existing SOV structure:

1. From the Schedule of Values log, select Update Structure to open the SOV Structure
window.

2. From the File menu, select Properties to open the Properties window.

3. Make edits as needed in both General and Options tabs and when finished, select OK.

Note

You cannot edit read-only (grayed-out) fields.

Creating General Spends SOV Sheet

Typically, Commit Business Processes (BPs) such as Contracts and Purchase Orders, are
designed to automatically create an SOV sheet upon reaching a specified status. Occasionally,
the Business Process (BP) may allow manual sheet creation.

When you create and send a Cost-type BP in a Project, the system automatically creates a
Schedule of Values (SOV) sheet for that BP record. The General Spends SOV sheet column
structure must include the required columns and correct formulas for validating summary
commitments (by Cost code) and remaining commits balance. You must define a formula for
remaining commits balance, which reflects the amount of commits minus actual spends. This
ensures that the Spends BP line items are not overdrawn from SOV breakdowns.

After the SOV template structure is set up for a General Spends SOV sheet, the rest of the
SOV sheets are created based on the same structure.

Note

If you manually create an SOV sheet, you can only create one based on an approved
commit BP record.

Follow these steps to create a General Spends SOV sheet manually:

1. In the Schedule of Values log, select New. The Select Commit window opens.
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2. Select a commit BP (for example, a purchase order), and select OK. The SOV sheet is
added to the log.

Note

If the commit BP has been set up to automatically create an SOV sheet upon the
end step, the above procedure is not required.

To view cell details, select a link (for example, Amount or Ref) to open the Cell Detail window.
Double-clicking a record from the list window shows the details of the record.

The columns with decimal values preserve, or maintain, the decimal values specified in the
data element of the following business processes and SOV types:

• Schedule of Values (SOV) sheet: Payment Application and Summary Payment
Applications

• Payment Application Line Items

• Summary Payment Application Line Items

As a result, the system will not round the decimal value to two decimals, for the preceding DEs.

Creating Payment Applications SOV Sheet

You can define the structure of a Payment Applications SOV sheet based on a Payment
Application Business Process (BP) in the Project/Shell.

The Payment Applications SOV type:

• Allows tracking of payment schedule against your commits similar to industry-standard
forms.

• Lets you create a breakdown for line items.

The Payment Applications SOV sheet column structure uses Data Elements (DEs) from the
Detail form. After the SOV template structure is set up for a Payment Applications SOV sheet,
the rest of the SOV sheets are created based on the same structure.

Follow these steps to create a Payment Applications SOV sheet, manually:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Schedule of Values, and then select
Payment Applications.

3. Select New to open the Select Commit window.

4. Select a Commit BP such as a Purchase Order and select OK. The SOV sheet is added to
the log.

Note

If a BP has been set up to automatically create a Payment Applications SOV sheet
upon the end step, the above procedure is not required.
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From the right pane, Schedule of Values: Payment Applications window, you have the

option to select the record number and open the base record. The gear menu ( ), for each
SOV Base Record, lets you:

• Open
Open a record.

• Permissions
Set permissions to a record.

• Open Base Record
Open the base record.

• Open Classic Interface
Open the base record in Classic View.

In the Schedules of Values window of a base record, the Ref column displays information
when you select an SOV line item type as individual Commit Lines. The Ref column is not
displayed when you select an SOV line item type as Group by Commit Codes.

When you select a CBS Code, the tabs of the right pane are:

• General tab

• Breakdown tab
You can add breakdown for each row in the right pane, under the Breakdown tab.

• Attachments tab
The added attachments will be shown in a grid similar to cost sheet. You cannot add
attachments in this tab.

• Notes tab
The CBS notes added in the cost sheet will be displayed here. You cannot add notes in
this tab.

In the Schedules of Values window of a base record, the Schedule Value lists a series of
values, when you select a value, the following tabs are displayed on the right pane:

• Line Items tab
The tab displays all the transactions in the cell.

• Cell Details tab

• Attachments tab

• Notes tab

You can reorder rows by drag and drop in the sheet, similar to General Spends SOV.

The columns with decimal values preserve, or maintain, the decimal values specified in the
data element of the following business processes and SOV types:

• Schedule of Values (SOV) sheet: Payment Application and Summary Payment
Applications

• Payment Application Line Items

• Summary Payment Application Line Items

As a result, the system will not round the decimal value to two decimals, for the preceding DEs.

Creating Summary Payment Applications SOV Sheet Structure
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The Summary Payment Applications SOV is associated with the Base Commits, Change
Commits, and Payment Applications Business Processes of Summary Application type.

You can access the Summary Payment Applications node based on your permission, which is
set in Access Control.

The log (Schedule of Values: Summary Payment Application for <BP name>) is similar to the
Payment Applications log, except the title. The log displays multiple application type.

In the log, you can create or update the structure of a Summary Payment Applications SOV
sheet, related to a Base Commits Business Process of SOV Type = Summary Payment
Applications. You also add items to, or remove items from, the columns and modify the SOV
structure.

The following is a list of the default structure within a column:

• Ref.

• Cost Code [CBS Code/bitemID]

• Code Name

• Cost Line item Type [uuu_cost_li_type (Label comes from DE label of uuu_cost_li_type]

• Description

Note

Different Summary Payment Applications might have different columns, but the
default structure will always be the same.

You can modify the following default column names:

• Ref.

• Cost Line Item Type

• Description

To modify the default column names, use the Options tab of the SOV Structure Properties
window.

Note

The Cost Code [CBS Code/bitemID] and Item labels will be based on the Cost Sheet
and are disabled.

If you auto-populate the Payment Application with the Line Item fields from the Base Commits
(done in Options tab of the Base Commits in uDesigner), these fields are available to be added
as columns in the SOV.

Note

If there are any picker fields that refer to other sources, such fields cannot be added
as a column. The drop-down list of the Auto-populate on Payment Application field
includes the data sources.
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Adding columns is similar to adding columns for Payment Applications SOV (including all Data
elements from Payment Applications BP, and additional sources such as Scheduled Value,
Commits Remaining Balance, and so on).

Additional system fields introduced in the Detail form of the Payment Application BP should be
available to be added as columns.

Note

Summary and Detail line items are displayed for the logical source that you have
added to the SOV sheet, for example, Commits Remaining Balance.

From the right pane, Schedule of Values: Summary Payment Applications for <BP NAME>
window, you have the option to select the record number and open the base record. The gear
menu ( ), for each SOV Base Record, enables you to:

• Open
Open a record.

• Permissions
Set permissions to a record.

• Open Base Record
Open the base record.

• Open Classic Interface
Open the base record in Classic View.

When you open a record, in the Schedules of Values: Summary Payment Application
window of a base record, the following toolbar options are available:

• Refresh

• Print

• Find on Page

• Menu 
This option enables you to export or access the record properties.

Use Expand All Groups  and Collapse All Groups  to adjust the list view.

When you open a record, in the Schedules of Values: Summary Payment Application
window of a base record (Payment Application BPs of Summary Payment Application SOV
type), the Ref column displays information when you select an SOV line item type as individual
Commit Lines. The Ref column is not displayed when you select an SOV line item type as
Group by Commit Codes.

When you select a CBS Code, the tabs of the right pane are:

• General tab

• Attachments tab
The added attachments will be shown in a grid similar to cost sheet. You cannot add
attachments in this tab.

• Notes tab
The CBS notes added in the cost sheet will be displayed here. You cannot add notes in
this tab.
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In the Schedules of Values window of a base record, the Schedule Value lists a series of
values, when you select a value, the following tabs are displayed on the right pane:

• Line Items tab
The tab displays all the transactions in the cell.

• Cell Details tab

• Attachments tab

• Notes tab

You can reorder rows by drag and drop in the sheet, similar to General Spends SOV.

Granting Permissions to Other Users

The SOV sheets can only be seen for project/shell-level Commit BPs. The following applies to
the project/shell-level SOV sheets.

The creator of a Commit BP becomes the owner of the associated SOV sheet and can grant
permission to other users to view or modify the SOV sheet.

Follow these steps to grant permissions to other users or groups:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Schedule of Values, and then select the
applicable Schedule of Values log (for example: General Spends).
The SOV sheet displays a structure with fields that are populated by the values in the
Commit BP.

3. Select the applicable record.

4. From the toolbar, select Actions and select Permissions, or select the gear menu ( )
and select Permissions.

5. Use the Add field or Select option to locate and select users or groups.

6. Select the permissions that you want to grant (All, Modify Permissions, Edit Data, or
View).

7. Select Save.

Project Level or Shell Level SOV Sheets (Standard View)

The following details apply to logs of all the following types of the SOV Sheets:

• General Spends

• Payment Applications

• Summary Payment Applications

To open the SOV sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Schedule of Values, and then select the
applicable SOV sheet, such as General Spends.

You will see:

• Toolbar options
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• Grid

• Right pane

The following explains the toolbar options. The explanations for the grid and the right pane will
follow.

Option Description

Create

Note

This option is only available
in toolbar of the General
Spends type and the Payment
Application type SOV logs.
This option is not available for
the Summary Payment
Application type SOV log.

Lets you create an SOV. This option is available only if:
• You have permission to create an SOV.
• There are Commits BP records (without a created

SOV) in Terminal step.
When you click Create, the Commits window opens
that lists all the Commit BPs for which a Schedule of
Value (SOV) has not been created. Use the Find on Page
option to search for a particular Commits BP record. The
column headers are according to the Commits BP log
column headers in uDesigner.
After you select a Commits BP record from the list, the
system creates the SOV for the selected record.
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Option Description

Create Structure You will see this option on the toolbar if:
• You have permission to edit the SOV structure.
• The SOV structure has not been created yet.
The Create Structure option in the General Spends type
SOV sheets:
• When an SOV sheet has not been created and there

are no General Spends SOV templates defined at the
company-level (set up in the Templates module of
Company Workspace), when you select this option,
the system displays this message, "No General
Spends SOV Template exists."

• When an SOV sheet has not been created and there
is one, or more, General Spends SOV template
defined at the company level (set up in the
Templates module of Company Workspace), when
you select this option, you will see a list of templates
that have been defined at the company level (set up
in the Templates module of Company Workspace).
When you select a template from this list, the
system displays this message, "You may create only
one SOV structure per project. Do you want to
continue?" If you select Yes, the system creates a
default SOV structure and displays this message,
"Structure created successfully."

The Create Structure option in the Payment
Applications or Summary Payment Applications type SOV
sheets: When you click Create Structure, the SOV
Structure window opens. See Update Structure for the
details on the SOV Structure window.
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Option Description

Update Structure You will see this option on the toolbar if you have
permission to edit the SOV structure when an SOV
structure has been created. When you select this option,
the SOV Structure window opens. The following
elements are accessible in this window:
• Add Column ( ): When you select this option, the

New Column window opens which lets you set the
column properties. You can only edit fields that are
allowed.

• SOV Structure Properties ( ): When you select
this option, an overlay window (SOV Properties)
opens which contains the following blocks:
– General: Displays the Name and Description

fields.
– Labels: Displays all the fields in the Classic View

of the Options tab (available through Update
Structure, select File, and then select
Properties).

• Find On Page 
• Name column
• Data Source column
• Data Format column
• Visible column
For each SOV structure that is listed you have the
following options:
• Delete 
• Reorder ( ): Lets you change the order of the

structures in the list.

Actions To access the Permissions window. Lets you open the
Permissions window (similar to Non-Workflow BP or
Cost Sheet log). You can use this window to grant or edit
permissions to user or groups. All permission fields are
read-only.

Refresh To update the list on the screen.

Print To print the items on the log.

Search To search for a SOV structure.

Find on Page To find an item on the page.

When you open the SOV sheet from the Schedule of Values log, you will also see the grid
and the right pane.

The grid displays the columns shown in the General Spends SOV sheet log (Classic View).

The right pane displays details related to a record and if there are no details, the following
message, "You do not have any details for this view." is displayed on the screen.

SOV Sheet: Description/Breakdown Column

BP forms such as contracts are created with high-level descriptions (in the line items) during
the beginning of the project life cycle, and after a contract is approved, the high-level
description needs to be updated to provide more details (for example, explaining or adding the
payments for the SOV).
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Because it is important to be able to update the line items descriptions, after a contract is
approved, the Description/Breakdown column will become editable.

Example

After a contract is approved and the SOV is created, the owner asks the contractor to update
the SOV line items descriptions so that the owner can accurately determine the payments for
those SOV line items.

Similarly, a user can add a breakdown to the SOV line items in the General Spends and
Classic Payment Applications type SOV Sheet.

The length of the Description/Breakdown column is the same as the length for the
short_desc field of the line item.

You can edit the description or breakdown in the following SOV sheet types:

• General Spends (within each individual Commit line item)

• Classic Payment Applications (within each individual Commit line item)

• Summary Payment Applications

Note

Only Users or Groups who have Edit Data at the record level, or Full Access,
permissions will be able to edit, or modify, or update the data for the Description/
Breakdown column.

The following explains how updating the description or breakdown will impact:

• Invoices already reached terminal status or end step
Records that already in terminal status or end step (where user cannot update line items)
will not have any impact on the SOV line item description updates.

• Invoices that are in inflight status
When you modify or add a line item and edit the SOV picker for the records that are inflight
status you will be able to view the latest SOV description for the lines.

• Invoice records
The SOV picker in line item for the new records will display the latest description for the
SOV line item.

• Change orders selecting reference picker to update existing SOV line item
When you select a reference picker to update an existing SOV line item scheduled value
the reference picker displays the latest description for the SOV lines.

There is no impact on existing change orders, where the SOV line items are not modified.

• Records created through CSV, Integration, Auto-creation, and BP Templates
All the invoices created using CSV import, CreateBPRecord, CreateBPRecord with
attachments using REST V1/V2 services will show the SOV line items with the latest
updated description, when the description is set to auto-populate in to the line items.

All the invoices updated using UpdateBPRecord, UpdateBPRecord with attachments using
REST V1/V2 services will show the line items with updated SOV descriptions.

All the invoices created through auto-creation and BP Templates will have the latest
descriptions for the SOV line items selected.
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Note

Although the system supports the inclusion of Pull Down DEs (string or integer) on
the payment detail form for use with Auto Population from an SOV Sheet, the Pull
Down DE column cannot be added to the SOV Sheet from the SOV Structure.
Because of this, the Pull Down DE in a line item cannot auto-populate a value
from the SOV Sheet when a classic Payment BP record is created. Auto
Population is only supported for decimal or current amount DEs.

• Breakdown name
The Breakdown name can be updated in the SOV Sheet in the Description/Breakdown
column. The breakdowns can be defined for an SOV line item and can be updated from
the Breakdown tab.

Only Users or Groups who have Edit Data at the record level, or Full Access, permissions
will be able to edit, or modify, or update the data in the SOV Sheet and the breakdown for
the Scheduled Values and other direct entry columns.

When exporting the SOV summary sheet, the updated Description/Breakdown will be
included in the exported file.

• Audit Log
The Audit log will display the updated description or breakdown. The Audit log will also
display the old and new values.

For the Classic Payment Applications SOV sheet type, the following explains how updating the
description or breakdown will impact:

• Payment Application records that have already reached terminal status or end step
Records that already in terminal status or end step (where user cannot update line items)
will not have any impact on the SOV line item description updates.

• Payment Application records that are inflight and Draft status
When SOV restrictions are allowed

– SOV sheet will be locked for the inflight payment records (accepted or nonaccepted
state); therefore, the updated description will be displayed in the inflight payment
record.

– Draft payment records will show the updated description as well as other SOV merge
updates.

When SOV restrictions are not allowed

– Both inflight (accepted and nonaccepted) and draft payment records will show the
latest description for the SOV lines.

• New Payment Application records
When a new Payment Application record is created, the new SOV line items that have
been added to the payment grid will show the latest descriptions.

• Change orders selecting Reference picker to update existing SOV line item
When you select a reference picker to update an existing SOV line item or the Scheduled
Values, the reference picker displays the latest description for the SOV line items.

Note

There will be no impact on the existing change orders, where line items are not
modified.
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• Change commits when updating committed line item
When updating a committed line item (by using selecting Add and then selecting the
Modify Committed line item option) the commit line item picker window will show the
updated description for both summary SOV line items and cost breakdown SOV line items.

• Records created through CSV, Integration, Auto-creation, and BP Templates
All the payments created using CSV import, CreateBPRecord, CreateBPRecord with
attachments using REST V1/V2 services will show the SOV line items with the latest
updated description, when the description is set to auto-populate in to the line items.

All the payments updated using UpdateBPRecord, UpdateBPRecord with attachments
using REST V1/V2 services will show the line items with updated SOV descriptions.

All the invoices created through auto-creation and BP Templates will have the latest
descriptions for the SOV line items selected.

Note

Although the system supports the inclusion of Pull Down DEs (string or integer) on
the payment detail form for use with Auto Population from an SOV Sheet, the Pull
Down DE column cannot be added to the SOV Sheet from the SOV Structure.
Because of this, the Pull Down DE in a line item cannot auto-populate a value
from the SOV Sheet when a classic Payment BP record is created. Auto
Population is only supported for decimal or current amount DEs.

• Audit Log
The Audit log will display the updated description or breakdown. The Audit log will also
display the old and new values.

For Summary Payment Applications, the following explains how updating the description or
breakdown will impact:

Note

You can update the description for both the Summary and Cost breakdown SOV line
items, in the SOV Sheet.

• Summary Payment Application records that have already reached terminal status or end
step
Records that already in terminal status or end step (where user cannot update line items)
will not have any impact on the SOV line item description updates.

• Summary Payment Application records that are inflight and Draft status
When SOV restrictions are allowed

– SOV sheet will be locked for the inflight payment records (accepted or nonaccepted
state); therefore, the updated description will be displayed in the inflight payment
record.

– Draft payment records will show the updated description as well as other SOV merge
updates.

When SOV restrictions are not allowed

– Both inflight (accepted and nonaccepted) and draft payment records will show the
latest description for both the Summary and Cost breakdown SOV line items, in the
SOV Sheet.
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• New Summary Payment Application records
When a new Summary Payment Application record is created, the new SOV line items that
have been added to the payment grid will show the latest descriptions for both the
Summary and Cost breakdown SOV line items, in the SOV Sheet.

• Records created through CSV, Integration, Auto-creation, and BP Templates
All the payments created using CSV import, CreateBPRecord, CreateBPRecord with
attachments using REST V1/V2 services will show the SOV line items with the latest
updated description, when the description is set to auto-populate in to the line items.

All the payments updated using UpdateBPRecord, UpdateBPRecord with attachments
using REST V1/V2 services will show the line items with updated SOV descriptions.

All the invoices created through auto-creation and BP Templates will have the latest
descriptions for the SOV line items selected.

Note

Although uDesigner supports the inclusion of Pull Down DEs (string or integer) on
the payment detail form for use with Auto Population from an SOV Sheet, the Pull
Down DE column cannot be added to the SOV Sheet from the SOV Structure.
Because of this, the Pull Down DE in a line item cannot auto-populate a value
from the SOV Sheet when a classic Payment BP record is created. Auto
Population is only supported for decimal or current amount DEs.

• Audit Log
The Audit log (in the menu toolbar of the SPA SOV sheet) will display the updated
description or breakdown for both the Summary and Cost breakdown SOV line items, in
the SOV Sheet. The Audit log will also display the old and new values.

Managing SOV Structure, Templates, and Sheets

The following topics apply to all SOV sheets. This section explains the following:

• Editing SOV sheet

• Editing SOV columns

• Deleting SOV sheet

• Searching for SOV sheet

• Managing SOV sheet data

• Exporting SOV data

• Viewing and editing SOV sheet properties

Note

If you have Edit Data permission and you are working with the classic Payment
Application, you can manually edit data for text-based columns and select different
values for columns that use Pull Down data elements (DEs). This does not apply
to Summary Payment Application (SPA) or General Spends.

Editing SOV sheet

1. Go to the shell tab, and switch to User mode.
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2. In the left Navigator, select Cost Manager, select Schedule of Values, and then select
General Spends, Payment Applications, or Summary Payment Applications to open
the Schedule of Values log.
The SOV sheet displays a structure with fields that are populated by the values in the
commit BP.

Note

If SOV sheets related to your options are present, a structure exists and you can
select Update Structure.

3. Select a record from the Schedule of Values log.

4. From the toolbar, select Properties to open the Properties window for the SOV sheet
record that you want to edit.

5. Select the Options tab and proceed to edit the fields.

Note

You can enter a custom label for the Ref, Breakdown, and Description fields.
These are the labels that will appear as column names on the SOV sheet. You
cannot modify CBS Code and CBS Item. These labels can be modified only on the
cost sheet.

6. Select Close to close the Properties window.

7. Select Apply and then select OK.

Editing SOV columns

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Schedule of Values, and then select
General Spends, Payment Applications, or Summary Payment Applications to open
the Schedule of Values log.
The SOV sheet displays a structure with fields that are populated by the values in the
commit BP.

3. Select a record from the Schedule of Values log.

4. From the toolbar, select Update Structure to open the SOV Structure window for the SOV
sheet record that you want to edit.

Note

If SOV sheets related to your options are present, a structure exists and you can
select Update Structure.

5. Select Columns, and select a column from the Columns Log.

6. Select Open to open the Column Properties window and proceed to edit the fields.
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Note

• Some fields may not be editable. It may be necessary to delete the column and
create a new one.

• Although it is possible to change the entry method for a column (for example, from
line item content to direct entry into a cell), use caution when doing so if you have
already entered values in the column cells. For example, if you change from line
item entry to direct cell entry, the amount value shown in the cell will display
correctly. Because this field is an editable field, if you edit this field, the direct entry
amount and detailed line item information will be lost.

To move a column, from the Columns log, select a column to move, and then select Move Up
(Left) or Move Down (Right). The order that the columns appear in the log is the order (from
left to right) that they appear on the sheet.

To delete SOV columns:

1. Select a column from the Columns log, and select Open to open the Column Properties
window.

2. Select Delete. The column will be deleted.

Note

If the column is being used in a formula in another column, you must remove the
column from the formula before you can delete it. If the column contains a cell with
line item data, you must first remove each line item before it can be deleted.

Deleting SOV sheet

Select the sheet from the log, and select Delete. If you delete an automatically created SOV
sheet, you will have to recreate it manually.

Note

You cannot delete an SOV for Payment Applications.

Searching for SOV sheet

You can search for SOV sheets by the SOV Base Record or SOV Description.

1. In the Schedule of Values log, select Find.

2. In the Search by drop-down list, select SOV Base Record or SOV Description.

3. In the Search for field, enter the search criteria, and select Search. The log will display the
records meeting the search criteria.

Managing SOV sheet data

SOV data is rolled up from Cost-type BPs that have been set up for SOV sheets. As a result,
the SOV sheets cannot be edited.
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Exporting SOV data

You can export SOV data to a local file system in a CSV format.

1. Select an SOV Base Record and open.

2. In the Schedule of Values window, select File, and then select Export (or select Export
from the toolbar).

3. Open the file and review it before saving.

4. Select Save, and specify the location in which to save the CSV file.

Viewing and editing SOV sheet properties

To open the SOV Properties window:

1. From the SOV log, select an SOV sheet, and select Properties. The Properties window
opens.

2. Select the tabs to view properties information.

To edit SOV sheet properties:

1. From the toolbar, select Update Structure.

2. Select File, and then select Properties.

3. Select the Options tab to modify information.

You can enter a custom label for the Ref, Breakdown, and Description fields. These are the
labels that will appear as column names on the SOV sheet.

Note

You cannot modify the CBS Code and CBS Item labels here. These labels can only be
modified in the cost sheet.

Adding or Deleting CBS Breakdowns on an SOV Sheet

CBS breakdowns can be added to an SOV sheet. This enables each contract to have its own
set of CBS breakdowns. These breakdowns can be added directly on the SOV sheet, or they
can be imported from a CSV file. Breakdowns can be added to general spends or payment
application SOVs.

Note

You cannot add a breakdown to an SOV if there is a pending spends record against
the row, or a pending change commit with a negative line item (which may potentially
reduce the Schedule Value after routing).

To add a breakdown to an SOV line:

1. Open the SOV sheet.

2. Select Rows. The Rows window opens.
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3. Select an SOV line by selecting the checkbox. If you select an SOV line, the breakdown
will be added to that line. If you select an existing breakdown, the new breakdown will be
inserted directly below the existing breakdown.

4. Select Add Detail. The Details window opens.

5. Enter the Breakdown.

• This will appear on the SOV sheet in the Breakdown column.

• You can add an optional Description.

6. Select OK. The breakdown is added to the sheet.

7. Close the Rows window.
You may need to select the plus (+) by the checkbox on the Rows window and on the SOV
sheet to expand rows and display the breakdowns.

To delete a breakdown row:

1. Open the SOV sheet.

2. Select Rows. The Rows window opens.

3. Select one or more breakdown rows to delete.

4. Select Delete Detail. Select Yes to confirm.

Adding Breakdowns to SOV sheet by Importing

If you have multiple breakdowns to enter, you can do it in bulk through CSV file import. You can
add as many breakdowns as you need to multiple CBS codes.

You can also optionally enter breakdown scheduled value amounts. To do this, there must be a
column to the SOV sheet using the data source Scheduled Value. The amount you enter on
the CSV file will appear in the Scheduled Value column.

Note

By default, the Scheduled Value column will validate that the sum of all breakdowns
added to an SOV line will not exceed the scheduled value for summary line. That is, if
the scheduled value for a line is $1000 from the base commit record and you add
breakdowns, the amounts that you enter for the breakdown amounts for that line
cannot add up to more than $1000. (It can, however, add up to less than $1000.)

To add breakdowns by importing a CSV sheet:

1. Open the SOV sheet.

2. Select Rows. The Rows window opens.

3. Select Export, and choose Breakdowns.

4. Save the CSV file. This provides the structure for the import file.

5. Add the breakdown rows to the CSV file.

a. Open the CSV file.

b. Insert a line under the CBS code to which you are adding the breakdown.
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c. Add the breakdown name in the Breakdown column. You can enter an amount in the
Scheduled Value column. Do not add any additional information in the new row.

d. Add additional breakdown rows as needed.

e. Save the file.

6. On the SOV sheet, select Import.

7. Browse to the CSV file, and select OK. The breakdowns and amounts will be added to the
sheet. Any breakdowns in the CSV file that exist on the sheet will be updated with the
Scheduled Value amount on the CSV file.

If any errors occur, download and open the error file, and correct the CSV file before
reimporting. Validations include:

• The sum of breakdown amounts cannot add up to more than the scheduled value amount
of the summary CBS code line

• They cannot exceed Commits Remaining Balance, if used

• They cannot cause Commits Remaining Balance to fall below zero.

Funding Sheet

Funding lets you track where project/shell funding comes from and how it is being spent. This
feature is accessed by way of the Funding sub-node under the Cost Manager module or
node.

A Funding Sheet tracks Company funding through allocation to, and consumption at, the
project level.

Use the Funding Sheet to specify the appropriation and assignment of funds from each source.
You can automate fund appropriation and assignment when used with Cost business
processes.

Company Funding Sheets

The Company Funding Sheet tracks all sources of funding across all projects/shells. You
create only one sheet per company. Funding sources that are made available at project/shell
sheet level are rolled up to the company sheet, which maintains the overall fund information.
After it has been created, the Company Funding Sheet can be edited, but not deleted. The
Company Funding Sheet must be created before creating individual Project/Shell Funding
Sheets.

Project/Shell Funding Sheets

The Project/Shell Funding Sheet tracks how funding is being allocated and consumed at the
project/shell level. Project/Shell Funding Sheets work in conjunction with the Company
Funding Sheet. Allocating funding sources at project/shell level can be done manually or
through a business process. A funding template and Company Funding Sheet must be
complete before you can create a Project/Shell Funding Sheet.

Note

Filters that you set up in the shell template for a Funding Sheet are not currently
included in the Project/Shell Funding Sheet.

Funding Sheet and Commitment Funding Sheets
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You can optionally set up commitment level funding, which allows you to allocate specific
project/shell funds to individual base commit records. This works in conjunction with the SOV
sheet to track base and change commit lines and balances.

Company and Project/Shell Funding

• Design and import a fund attribute form in uDesigner. This will be used as the Fund
Details window when adding new funds to the Company Funding Sheet or viewing fund
properties. A fund picker, used to add funds to business processes or the Project/Shell
Funding Sheet, can also be designed. This is an optional step. If you do not create a fund
attribute form, a default fund code form and fund picker will be used.

• Import and set up fund business processes. You can use business processes for fund
allocations, fund assignment (consumption), and fund credits.

• Create and set up the Company Funding Sheet. The Company Funding Sheet tracks
the funds that can be used to fund project/shell expenses. The following procedures
assume that the rows (funds) and columns of the Funding Sheet have already been
created.

• Create and set up the Project/Shell Funding Template and Sheet. The Project/Shell
Funding Sheet tracks the funds that have been allocated from company funds for a
particular project/shell. The Project/Shell Funding Sheet is based on the funding template,
which is created first. The following procedures assume that the Project/Shell Funding
Sheet has been created, and rows and columns have been added.

Note

– The rows correspond to funds chosen from the Company Funding Sheet.
Funds can be added manually, or can be added via fund allocation business
processes, discussed later in this section.

– Filters that you set up in the shell template for a Funding Sheet are not
currently included in the Project/Shell Funding Sheet. To use filters, you must
set them up in the Project/Shell Funding Sheet. For more information, see 
Searching for Fund Codes and Creating and Applying Filters.

• Define funding assignment rules. Funding assignment rules are set up in the Project/
Shell Funding Sheet or template. These determine which business processes are used for
fund appropriations and assignments and how to consume funds (ratio or fund order) if you
will be using automatic fund assignment from business processes. The following
procedures assume these options have been set up.

• Create funding rules in the rules engine. Optionally, funding rules can be created in the
rules engine that can help you manage your funds and fund balances, for example, to
prevent fund balances from becoming less than zero.

Commitment level funding

Optionally, funding at the base commit (contract) level can be set up.

Commitment funding works in conjunction with the Schedule of Values (SOV) sheet. SOV line
items have an impact on the commitment funding sheet and its data through fund assignment.

Before you begin. Be sure that the project/shell funding has been set up, with funds allocated
and available on the project/shell funding sheet. Data sources are available for project/shell
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funding sheets (and company funding sheets) to track funding that is assigned for specific
base commits. Also, be sure the data source Scheduled Value has been added as a column
to the SOV structure for the project/shell. Commitment funding uses the SOV to track base
commit and change commit amounts and uses the Scheduled Value column to track
remaining balances.

• Import and set up business processes for commitment funding. In addition to business
processes that are used for project/shell funding, you can design business processes for
use with commitment funding. In uDesigner, commitment funding is enabled on the base
commit; automatic generation of an SOV must also be enabled. Then, the ability to view or
assign funds is enabled per step on the base commit and the corresponding change
commit. Be sure the linked spends business process has been enabled to consume
funding.

• Create and set up Commitment Funding Template. This template is used to create a
commitment funding structure in the project/shell, which in turn is used to create the
individual commitment funding sheets for each base commit record. These procedures
assume a template has been created and set up with columns.

• Define funding assignment rules. This is done in the Assignment tab of the Properties
window. Assignment rules can be defined in the commitment funding template, structure,
or sheets. (This procedure assumes assignment rules have been defined in the template
and will be copied to the structure and individual sheets.)

• Create Commitment Funding Sheet Structure. Structures are created at the project level in
user mode from a commitment funding template. When commitment funding sheets are
created from base commit records, this default structure is used. Details about creating
commitment funding structures from an existing template are found later in this section.

• Create individual commitment funding sheets. This is done automatically the first time you
select Funding on a base commit business process form (this button becomes available on
specific steps as designed). After creation, the commitment funding sheet is available for
viewing or modification by selecting Funding on the base commit or associated change
commits, or from the Commitment Funding log itself. Details about creating commitment
funding sheets is found later in this section.

• Configure permissions. In addition to module level permissions that are needed to create
and modify templates, structures and sheets, record level permission must be granted to
individual commitment funding sheets. By default, the owner of the base commit will have
permissions to the sheet. Additional users must be granted view or edit permissions. This
is discussed later in this section.

Company Funding Sheet, Project/Shell Funding Sheets, and Commitment Funding
Sheets

The first step to setting up funding is to create and set up a Company Funding Sheet, where
individual funding sources are set up.

For example, a corporation's funding sources may include different types of corporate
accounts. For municipal or educational facilities, funds may come from bond measures, grants,
donations, or other sources. All these funding sources will be listed and tracked on the
Company Funding Sheet. As funds are consumed via business processes or manually in
individual projects/shells, this data is rolled up to the Company Funding Sheet.

Project/Shell Funding Sheets track how your company's funding is being spent on each
project/shell. It tracks individual transactions, which are rolled up to the Company Funding
Sheet. All Project/Shell Funding Sheets must be created based on a funding template.
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Note

Filters that you set up in the shell template for a Funding Sheet are not currently
included in the Project/Shell Funding Sheet. To use filters, you must set them up in the
Project/Shell Funding Sheet. For more information, see Searching for Fund Codes and 
Creating and Applying Filters.

If you are using commitment funding, you will create a commitment funding template, which is
used to create the commitment funding structure within a project/shell. As base commits (that
are designed for commitment funding in uDesigner) are routed and approved, a Commitment
Funding Sheet is created, based on this structure, for each base commit record.

Working with the Company Funding Sheet

The following procedures described managing funds on the company funding sheet.

Company Funding Sheet Log

To access the Company Funding Sheet log:

1. Go to your Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Funding.

When you double-click the funding sheet, the Company Funding Sheet window opens.

Alternatively, you can use the gear menu ( ) to open the funding sheet. The Company
Funding Sheet window displays the fund codes and other details about the fund sheet and
contains the following toolbar options:

Add Rows

Lets you access the Fund Attributes window and add a new row to the fund sheet after
entering the fund details.

Add Column

Lets you access the New Column window and add a new column to the fund sheet after
entering the column details. After you select the data source, the remaining data will auto-
populate; however, you can change the values of the fields, if there is a need. This window
also lets you select the position of the newly added column, in the funding sheet.

View

Edit View

Lets you add or move columns from the fund sheet.

Refresh

Print

• Print

• Export To CSV

• Export To Excel
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Note

– For export to Microsoft Excel, the system currently supports only Euro (EUR)
and United States Dollar (USD) currency symbols.

– If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you might
need to configure your columns in Excel to match the correct data type
(Number). Otherwise, the columns will not be treated as numeric and will not
sum as expected. One supported format includes placing the negative sign
between the currency symbol and the amount (for example, $-1,000).

Find on Page

Menu Options

• Import

• Export

– Summary Fund Sheet

– Fund Details

• Fund Status: Lets you open the Fund Status window and either change the status for the
fund codes or delete unwanted fund codes. Use the Find on Page option to find a
particular fund code.

• Properties: Lets you open the Properties window and determine the fund sheet
properties, including the two display modes, Flat or Tree.

• Audit Log

In the Company Funding Sheet window, you can customize the columns, except the first two
columns (Fund Code and Fund Name).

Note

You can use the Lock after this Column option, explained below, to add to the
stationary columns; however, the two first columns shall remain on the sheet by
default.

Select a fund code to split the screen and access the properties of that fund code, within the
following tabs:

• Fund Attributes

• Audit Log

You can use these tabs to update the details of the fund code.

The details of your changes will be recorded in the Audit Log tab. You can print or export (by
way of the Print option on the Audit Log) the audit log data.

The fund sheet window (Company Funding Sheet log) has multiple columns. As stated
before, the first two columns are stationary, and the other columns can be customized. You can
hover over a column header to see additional information about the field. For example, if you
hover over the Approved Appropriations column heading, you may see the Data Source and
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Data Format information for the "Approved Appropriations." If you right-click a column header,
the following options let you manipulate the selected column:

• Hide

• Delete

• Lock after this Column

• Insert: Lets you insert a new column.

• Unhide

• Properties: Lets you open the Columns Properties window and access all the properties

of the selected column. Use the navigation icons (  and ) to move to and access the
next or previous column properties.

You can select a cell for a fund code, and see the different line items for that fund code, in the
properties screen, within the Line Items tab. In this tab, you can use the toolbar to access Add
Lineitem , Delete Lineitem , Find on Page  , and Print . You can use the gear
menu ( ) to access Copy and Delete for a specific line item. When you select a line item and
select Copy , a copy of the selected line item will be inserted at the last row; you can then
change the values of each cell within the added row. Use Find on Page to search for a
particular line item in the Line Items tab.

When you select a cell, for a fund code, you can select the Cell Details tab to see the cell
details such as values for the Fund Code, Fund Name, and so forth.

You can use the Attachments tab to include attachments (using the Browse option or the
Document Manager option), the Notes tab to include notes, and the Audit Log tab to access
the details of the changes made to the line item.

Use Expand  and Dock Right  or  to adjust the location of the tabs on your screen.

The following topics provide additional information about the Company Funding Sheet log.

About company funding sheet columns

The columns on the company funding sheet are used to track project/shell-level funding and
keep track of fund balances.

A common way to enter the starting value of a fund is by adding a Company Funding column
to the company funding sheet. This is generally a manual entry column (either direct entry or
line item entry). The original value of each fund (one fund per row) is entered into this column.

Additional columns commonly track fund assignments (consumption) made against each fund
in projects/shells. These can be in the form of business process transactions or manual
funding assignments. Each project/shell level business process or manual entry column can be
rolled up to the company funding sheet separately, or project/shell fund assignments can be
totaled in the project/shell sheet and rolled up to the company sheet. A good practice is to have
a fund balance formula column that tracks the difference between the original fund value minus
all funding assignments, which provides a running balance for each fund. A rule can be created
in the Rules Engine to make sure that this fund balance never becomes less than zero (or
other specified value).

To view column details:

In the funding sheet, select a column header link to view the column details. This will display
the data source and, for formula columns, display the formula used.
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About company funding sheet rows

Each row in the company funding sheet corresponds to one fund. Depending on how the
company funding sheet is set up, the starting value of each fund may need to be manually
entered. This is commonly done in a column using the Company Funding data source.

If you are working with many funds, there are ways to help you find the fund that you are
looking for. You can search for individual fund codes using the Find feature. You can also
create and apply filters, which can be used to temporarily limit the number of funds displayed
on the sheet. For more information, see Searching for Fund Codes and Creating and Applying
Filters.

To view fund details:

In the funding sheet, select the fund code link (in the Fund Code column) to open the Fund
Details.

• If a Fund Attribute Form has been designed, this window shows the fields on the form.

• If a Fund Attribute Form is not being used, the default window opens, showing basic
information such as the fund code, fund name and description.

Add currency amounts to company funds

After the company funding sheet has been set up, the funds must be "funded"; that is, you
must enter the funding amounts that will be used to fund your projects/shells. Commonly, the
Company Funding data source is used as a manual entry column to enter the starting amount
of each fund or add additional funds to it. This column can be direct entry or line item entry.

This procedure assumes the funds have already been added to the sheet. It also assumes that
a column has been added to the sheet for manual fund entry. Commonly, this uses the
Company Funding data source. You can select a column heading to verify the data source
used.

To add a value to a company fund:

1. Go to your Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Funding.

3. Open the company funding sheet.

4. Locate the column that is used for adding value to company funds on the sheet, commonly,
the Company Funding column.

5. Do one of the following:

• If the column is direct entry, select inside the cell, and enter the amount. If the cell
already has a value, you can modify it.

• If the column is line item entry, select the link in the cell. The Cell Detail window opens
in which you can take these actions.

– Select Add Line Item to add a new line item.

– Select a line item, and select Copy Line Item to add a line item by copying
another.

– Double-click an existing line item to modify it.

– Select a line item, and select Remove Line Item to remove it.
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6. Enter the line item information in the Line Item window, and select OK.

The amount in the Company Funding column can be used as the starting amount of a fund.
Other columns on the company funding sheet can be used to roll up transaction and manual
funding amounts from project/shell funding sheets, and formula columns can be added to keep
track of the fund balance.

Activate or deactivate company funds

You can active or deactivate company funds, which controls their availability for project/shell
funding. If you set a fund to "Inactive" at company level, that fund will no longer be available for
project/shell-level funding sheets; however, if a fund is already listed on a project/shell funding
sheet, inactivating the fund at the company level will not affect the fund.

To set the company fund status:

1. Go to your Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Funding.

3. Open the company funding sheet.

4. From the toolbar, select Menu Options ( ), and then select Fund Status. The Fund
Status window opens.

5. Select a fund in the table, and then select Activate or Deactivate.

6. Select Close to exit the window.

Import or export Company funding sheet information

You can export a summary of the funding sheet, which creates a CSV file that contains the
rows, columns, and data on the funding sheet. You can also export a CSV file containing fund
details, which includes all fund codes on the sheet and the data captured for them from the
Fund Details window. This is available in company, project, and shell funding sheets.

You can also import fund details to a company funding sheet. This lets you add fund codes to a
funding sheet directly from a CSV file, rather than add them manually.

For details, see Importing and Exporting Project/Shell Funding Sheet Information.

Working with Project or Shell Funding Sheets

The Project/Shell Funding Sheet tracks how funding is being allocated and consumed at the
project/shell level. Project/shell funding sheets work in conjunction with the company funding
sheet.

Fund allocation, assignment, and credits can be done manually, or through business
processes.

Note

Because funding originates at the company level in the company funding sheet,
funding is always done in base currency, even if the project currency is different.
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Open a project or shell funding sheet

The project or shell funding sheet is accessed from the Funding Sheet log.

Note

There is only one funding sheet per project/shell.

To open a project or shell funding sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Funding, and then select Funding
Sheet. The Funding Sheet log opens.

3. Select the gear menu ( ), and select Open.

The Funding Sheet window has the following, typical, page headers:

• Funding Sheet

• Currency

• Unassigned (Project Level)

• Commitment Level

• CBS Level

The Funding Sheet window has the following toolbar options:

Note

For projects that do not have funding sheet, you can use the Create toolbar option (in
Funding Sheet window) to create a funding sheet. The Create option will not be
displayed for the users with View permission. To create a funding sheet, select Create
to open the Select Template window and select a template.

Funding Sheet Window Toolbar Option Description

Manage Rows Opens the Manage Rows window which lets you
manage the displayed rows based on the available
company fund codes.

Add Column Opens the New Column window that lets you enter data
about the new column.

View • Default
• Create New View
• Manage Views

Edit View Opens the Edit View window which lets you manage the
displayed view based on the following tabs:
• Columns
• Filters
• Group By
• Sort By
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Funding Sheet Window Toolbar Option Description

Fund Assignment Order Opens the Fund Assignment Order window which lets
you manage the order for:
• Fund Code
• Fund Name
• Status
• Reorder: Bring the pointer to the cell to activate the

move-pointer, select and hold, and move the row to
a desired location.

Refresh Lets you refresh the contents of the Funding Sheet
window.

Print • Print
• Export To CSV
• Export To Excel

Note

• For export to Microsoft
Excel, the system
currently supports only
Euro (EUR) and United
States Dollar (USD)
currency symbols.

• If you export data from a
business process (BP)
record, sheet (such as an
Activity Sheet), or log
(such as Company
Funding Sheet Log) to
Excel, be aware that
depending on how your
negative values are
formatted, you might
need to configure your
columns in Excel to match
the correct data type
(Number). Otherwise, the
columns will not be
treated as numeric and
will not sum as expected.
One supported format
includes placing the
negative sign between the
currency symbol and the
amount (for
example, $-1,000).

Find on Page Lets you find a particular record on the page.
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Funding Sheet Window Toolbar Option Description

Menu Options • Export
– Summary Fund Sheet
– Fund Details

• Row Coloring
– Multi-Color
– Single Color

• Properties
• Audit Log

Create and Edit Transactions

You can manually enter transaction line item.

Note

Including attachments is not permitted in line items. Cloud customers who have
migrated to the 20.6 version of Unifier will not be able to see the previous attachments
or add new attachments post migration.

About project/shell funding sheet columns

The columns on the project/shell funding sheet are used to track the funding on that project/
shell, and to keep track of the fund balances that have been appropriated for its use.

Commonly, the Project Funding column is used to enter the allocation amount of each fund for
that project/shell.

Additional columns commonly track fund assignments (consumption) made against each fund.
These can be in the form of business process transactions or manual funding assignments,
with one column for each business process, and manual entry columns for project level funding
and CBS level funding.

The Records Funded at Project Level (or CBS Level) column(s) can be used to track the totals
of business process transactions involving fund assignment. This is used for records already
reaching terminal status. The Transient Records Funded at Project Level (or CBS Level)
column(s) works similarly, but is used for records that are currently in process, and have
already been funded before reaching terminal status. These columns can also include any
credited funding that may occur due to invoice credits or other negative amounts.

Commitment level funding can be tracked on the project/shell funding sheet using the columns
Commitment Funding (tracks funds that are allocated across base commit and change commit
business process records enabled for commitment funding), Records Funded at Commitment
Level (sum of all spends records that are funded at the commitment level), and Transient
Records Funded at Commitment Level (sum of all in-process records that are funded at the
commitment level).

A good practice is to add a fund balance formula column that tracks the difference between the
original fund value minus all funding assignments, which provides a running balance for each
fund.

To view column details:
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In the funding sheet, select a column header link to view the column details. This will include
the data source and, for formula columns, display the formula used.

About project/shell funding sheet rows

Each row in the project/shell funding sheet corresponds to a fund that has been allocated for
use on this project/shell. Each fund originates on the company funding sheet.

Fund allocation can be done manually, by adding rows to the project/shell funding sheet. A
fund picker is used to select which funds from the company funding sheet to add.

Funds can also be allocated to a project by using a fund allocation business process that is
designed to choose the funds and funding allocation amounts for the project/shell.

For manually allocated funds, the starting amount of each fund can be entered manually.
Commonly, the Project Funding column is used to enter the starting value of each fund when
funds can be used for the project regardless of CBS code, or the CBS Funding column is used
when funding is specified per CBS code. These values can roll up to the company funding
sheet column of the same data source.

If you are working with many funds, there are ways to help you find the fund that you are
looking for. You can search for individual fund codes using the Find feature. You can also
create and apply filters, which can be used to temporarily limit the number of funds displayed
on the sheet. For more information, see Searching for Fund Codes and Creating and Applying
Filters.

To view fund details:

In the funding sheet, select the fund code link (in the Fund Code column). The Fund Details
opens. If a Fund Attribute Form has been designed, this window will include the fields added to
the form in the design. If a Fund Attribute Form is not being used, the default window opens,
listing basic information such as the fund code, fund name and description.

View Project/Shell funding sheet properties

The Properties window defines general setup information and assignment details for the
funding sheet.

To view project/shell funding sheet properties:

1. In the project/shell Funding log, select the funding sheet, and select Properties. The
Properties window opens.

• The General tab defines the Title, Description and Display Mode for the sheet. If you
have edit permissions, you can edit these, including switching back and forth between
the display mode options as needed.

• The Assignment tab is used to define the funding assignment options:

– Project and CBS Level: Specifies the sources of fund allocation for the project/
shell, either manual entry or via fund appropriation business processes.

– Assignment Levels and Rules: For each funding business process that has been
set up for the project/shell, this specifies how funds are assigned, either manually,
Auto Order, or Auto Ratio:

For more information, see About Project/Shell funding assignment options.

2. Select OK or Cancel to close the window.
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About Project/Shell funding assignment options

Funding assignment options for the project/shell are defined on the Assignment tab of the
Properties window. (Open the funding sheet, select File and then select Properties.) This
includes defining how fund allocation can be done, specifying whether manual assignment is
allowed, defining the business processes that can be used to assign funds to projects/shells or
to specific CBS codes, and defining assignment levels.

Project Level and CBS Level: Specifies how funds can be added for this project/shell. This
can be Manual (appropriate funds manually from the company funding sheet) or through
funding appropriation business processes.

You can define funding appropriations at the project level (not associated with specific CBS
codes), and at the CBS level (funding is specified per CBS code). You can "mix and match" for
each project, with some business processes using project level funding, and others CBS level.
Manual fund appropriations can be done at both levels.

Assignment Levels and Rules: Specifies how assignment is done for each funding business
process that has been set up for the project/shell: Manual, Auto Order, or Auto Ratio. It also
specifies whether funds are assigned at the Project Level (funding is consumed based on the
total of the spends business process, providing greater flexibility for fund assignment), or CBS
Level (funding is consumed per line item of a spends business process, which provides greater
control over how funds are spent on each item.)

• Manual: Funds can be manually assigned. As spends business processes (for example,
invoices or payment applications) are routed and reach specified statuses, the amounts to
be funded are collected under the Unassigned total on the funding sheet. A Funding
button becomes available on the business process form. Selecting the button opens the
Funding window, in which funds can be assigned.

• Auto Order: Funds are assigned automatically when a spends business process reaches
a specified status. Funds are assigned based on the fund order, which is defined on the
funding sheet by selecting the Fund Assignment Order button. When funds are
consumed on one fund, the next funding source is used for funding. After all funds are
consumed, remaining spends are collected under Unassigned.

• Auto Ratio: Funds are assigned automatically when a spends business process reaches a
specified status. Funds are assigned based on the fund ratio, which is automatically
calculated based on current fund levels. After all funds are consumed, remaining spends
are collected under Unassigned.

View funding sheet cell details

The values displayed in a cell on the funding sheet may reflect information from multiple line
items, business process transactions, or results of a calculation from other cells. The following
procedures discuss how to view the details about an entry in a funding sheet cell.

To open the Cell Details window:

In the Funding Sheet window, select the link in the line item cell to view information. The Cell
Detail window opens.

To view manual line item entry details:

In the Cell Detail window, double-click a listed line item. The Line Item window opens.

To view business process transaction details:
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1. In the Cell Detail window, double-click a listed line item. A view-only copy of the business
process transaction opens.

2. Double-click a line item. The Line Item window opens.

To view formula cell details:

In the Cell Detail window, if line items from manual-entry columns or business process
transaction columns are included in the calculation, they will be listed in the lower portion of the
window, with the calculated value for each line item.

1. Select a listed line item. If the line item is a BP transaction, the business process form
opens. If the line item is a manual entry, the Line Item window opens.

2. To view the formula used for the column, select the Formula link.

View Audit Logs

Audit logs are available within the Fund Detail and Cell Detail windows of the project/shell
funding sheet. The Audit log captures all the events that took place, including what action
occurred, who took the action, and the value that was created or modified.

To view the project/shell funding audit log:

Open the project/shell funding sheet and do one of the following:

• From the View menu, select Audit Log.

• Select a listed fund to open the Fund Detail window, and then select Audit Log.

• Select a cell link (line item or project/shell allocation entry) to open the Cell Detail window.
From the View menu, select Audit Log.

To view commitment funding audit logs:

Open the commitment funding sheet and do one of the following:

• From the View menu, select Audit Log.

• Select a listed fund to open the Fund Detail window, and then select the Audit Log button.

• Select a cell link (line item or project/shell allocation entry) to open the Cell Detail window.
From the View menu, select Audit Log.

To view an audit log of company funding:

Open the company funding sheet and do one of the following:

• From the Funding Sheet View menu, select Audit Log.

• Select a listed fund to open the Fund Detail window, and then select Audit Log.

• Open the Cell Detail window. From the View menu, select Audit Log.

The Audit log captures all the events that took place, including what action occurred, who took
the action, and the value that was created or modified.

Allocating Funds to a Project or Shell

This section discusses fund allocation. Allocation refers to reserving a certain amount of a
company fund to a particular project/shell.
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Funds can be allocated to a project/shell either by manually adding rows to the project/shell
funding sheet and entering allocation amounts, or through business processes transactions,
which automatically add the rows and allocation amounts.

To review information about Schedule of Values (SOV) Sheets and Business Processes, see
the Unifier Business Processes User Guide.

Fund allocation can be done at the project/shell level (funds are available to any expense in
the project/shell), or at the CBS level (funding is allocated per CBS code).

Manually enter project/shell fund allocation amounts

After the project/shell funding sheet has been set up, the funds must be "funded"; that is, you
must enter the funding amounts that will be used to fund your projects/shells. The following
procedures discuss manually allocating funds and entering amounts to the funds that will be
used in the project/shell. (Fund allocation using business processes is discussed in a later
section.)

Commonly, the Manual Funding By Project data source is used as a manual entry column to
enter the starting amount of each fund or add additional funds to it. This column can be direct
entry or line item entry and is used for project level fund allocation. The Manual Project by CBS
data source can be added to the project/fund cost sheet, and values added there. The same
column data source can be added to the project/shell funding sheet to display the values
added to the cost sheet column. This is used for CBS level fund allocation.

The following procedures assume that the appropriate funds (rows) and columns have already
been added to the funding sheet. You can select a column heading to verify the data source
used.

To enter project level fund allocation values (on the funding sheet):

1. Open the project/shell funding sheet.

2. Locate the column that is used for adding value to funds on the sheet, commonly, the
Manual Funding by Project column.

3. Do one of the following:

• If the column is direct entry, select inside the cell, and enter the amount. If the cell
already has a value, you can modify it.

• If the column is line item entry, select the link in the cell. The Cell Detail window opens.
You can:

– Select Add Line Item to add a new line item.

– Select a line item, and select Copy Line Item to add a line item by copying
another.

– Double-click an existing line item to modify it.

– Select a line item, and select Remove Line Item to remove it.

Enter the line item information in the Line Item window, and select OK.

This amount can be used as the starting project level amount of a fund. Other columns on the
funding sheet can be used to track transactions, and formula columns can be added to keep
track of the fund balance.

To enter CBS level fund allocation values (on the cost sheet):

1. Open the project/shell cost sheet.
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2. Locate the column that is used for adding value to funds by CBS code, commonly, the
Manual Funding by CBS column.

3. Select the link in the cell. The Cell Detail window opens. You can:

• Select Add Line Item to add a new line item.

• Select a line item, and select Copy Line Item to add a line item by copying another.

• Double-click an existing line item to modify it.

• Select a line item, and select Remove Line Item to remove it.

4. Complete the Line Item window.

5. Select a fund from the fund picker by clicking the Select button for the Funding Source.
The fund picker lists the funds that are active at the company level. To search for a specific
fund, select Find.

6. Select OK. The new line item will be added to the Cell Detail window. If the Manual
Funding by CBS column has also been added to the project/shell funding sheet, the value
will display there.

To add funding sheet data through a formula:

Formula columns calculate results based on data entered in other columns. You cannot enter
data directly into a formula column. You may select the funding sheet column header to view
the data source for the cells in the column. If the column is a formula column, it will be
displayed, and you can view which other columns are used in the calculation.

Allocate funds through business processes

Funds can be allocated to a project/shell using a fund allocation business process, which was
defined in uDesigner. Following is a summary of the business process types and design
options that may be used:

• Project level:

– Cost type, subtype line items with fund code, classification generic.

– Workflow or non-workflow

• CBS level:

– Cost type, subtype line items with CBS and fund code, classification generic.

– Workflow or non-workflow

Commonly, columns are added to the funding sheet to capture funding allocation business
process transactions. The Project Funding column might be used (as a formula) to capture the
sum of all allocations and manual allocation for each fund.

To allocate funds and enter amounts through a business process:

1. Create the business process record.

2. Add line items as necessary.

• Select a fund from the fund picker by clicking the Select button for the Funding
Source. The fund picker lists the funds that are active at the company level. To search
for a specific fund, select Find.

• The Line Item window may also include a CBS picker, for CBS level allocations.

3. Route the business process record as usual.
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Assigning and Crediting Project/Shell Funds

This section discusses assigning (consuming) funds on project/shell funding sheets. When
funds are "assigned," it means they are consumed from the allocated amount for that project/
shell. Funds can also be credited back to the source when necessary.

Fund assignments are based on spends type business processes within the project/shell (for
example, invoices or payment applications), which enables accurate funding and tracking of
project expenses. Funds are assigned based on the amount of a spends record and can never
exceed that amount. The behavior of funding business processes depends both on the design
options chosen and the Assignment Levels chosen on the project/shell funding sheet
properties.

Funding assignments are based on business processes transactions, and commonly, columns
are added to the funding sheet to track spends business processes eligible for funding.
Formula columns may also be added to track the totals of these records, which may include
Records Funded at Project Level (or CBS Level), for completed records; and Transient
Records Funded at Project Level (or CBS Level), to track funding on records that are funded
while in process. Values can also roll up to the company funding sheet if the same data source
columns are added.

View Unassigned Amounts

When spends business processes are set up to be funded manually, the amount of the record
initially is captured in one of the Unassigned fields on the funding sheet. This value displays
until the entire amount of the record has been fully funded. For Project level funding, the
amount displays in the Unassigned (Project Level) field; for CBS level funding, the amount
shows up in the Unassigned (CBS Level) field.

If commitment level funding is being done, you may also see an amount under Unassigned
(Commitment Level). These funds are managed on the commitment funding sheet.

It is possible that an Unassigned amount can be negative, as the result of a credit invoice that
has not yet been credited back to the funding source.

Note

These can also be rolled up to the cost sheet using the Unfunded Record data source.

To view unassigned amounts:

1. Open the project/shell funding sheet.
If business process transactions have occurred that have not yet been funded, the total of
the record(s) will display in one of the Unassigned fields in the upper portion of the sheet.

2. Select the link next to Unassigned (Project Level) or Unassigned (CBS Level).
The Manual Fund Assignment window opens. This window lists transaction records that
have not yet been fully funded.

Manual and Automatic Fund Assignment

Funding assignments can be done automatically or manually. This is set in the funding
assignment levels in the funding sheet properties.
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Manual Fund Assignment

For manual assignments, and depending on the design of the business process, the following
may occur:

• You may be able to view or perform funding assignments or credits at any step in the
workflow (or for a non-workflow business process, any status). When the business process
is in process, it is referred to as a "Transient Record." This allows the record to be funded,
edited, and reviewed before the record is finalized and closed.

• When funding is enabled (or can be viewed), a Funding button appears on the business
process form. Select the button to open the Funding Window.

• It is possible that the business process can be designed to disallow funding assignments
or credits at the end step (or terminal status if non-workflow). This option prevents further
editing of funding assignments or credits after the record has gone through a review
process.

Good practice tips

Review the invoice line items and be sure they are accurate before doing funding. A good
practice for design is to disallow line item from being edited after fund assignment steps. This
will prevent the invoice line items from being edited after funding has already been assigned.

Manual Fund Assignment at Funding Sheet Level

To assign funds manually, you must access the Funding Sheet log, and then use the Fund
Code to assign the funds.

To access the Funding Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, select Funding, and then select Funding
Sheet.

3. In the Funding Sheet log, double-click the Funding Sheet.

4. Under the Fund Code, select an item.

5. On the top of the screen, select Unassigned (Project Level) link to open the Manual
Fund Assignment page. The funds that are pulled out of the record are displayed on this
page. The unassigned fund amount and all funds balances that have been assigned are
also displayed on top of the page, in tiles, under the page title. For example, Fund 3 is the
fund code and the fund balance is displayed.
When there is any funding available for a fund, the fund will have an information icon
(exclamation mark ! symbol) next to it. For any fund that does not have any funding, the
information icon (exclamation mark ! symbol) does not appear. Hover over the information
icon (exclamation mark ! symbol) to see more details about each fund (such as Total,
Assigned Amount (at fund sheet level or commitment funding level), and Remaining
Amount)

On the toolbar, by using the expand or collapse option, you can activate or deactivate the
display of both Amount and Percentage for the funds. You can enter either the Amount
or the Percentage values. For example, you can select a record with remaining value that
has been unassigned (Remaining Unassigned) and then select the cell under the
corresponding Percentage column and enter the desired percentage value, or do the
same for the Amount, for a particular fund. Depending on the value that you enter, the
system recalculates the Remaining Unassigned value.
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Records with partial assignments will have an icon displayed under the Split column.

• If a record is modified, the information icon (exclamation mark ! symbol), under the
Split column, turns blue. When you hover over the icon, the title of the report, total,
assigned amount, and remaining amount will display.

• If you assign one hundred percent for fund value (consumption), the information icon
(exclamation mark ! symbol), under the Split column, turns green.

• If there is negative amount unassigned, the information icon (exclamation mark !
symbol), under the Split column, turns red.

• If a record does not have any assignments, there will be no icons under the Split
column.

• If you do not see an icon displayed under the Split column, the Remaining
Unassigned value will be the total and the assigned amount will be zero.

6. Select Save to save your changes. You can select Cancel to discard your changes and
return back to the previous screen.

If you enter values greater than one hundred percent, the cell will display a red triangle (cell
level error icon) and when you hover over, a tooltip message explains the error.

A funding sheet-level error message will be displayed to inform you that you cannot assign
more than total fund amount to a fund.

Automatic Fund Assignment

For automatic assignments, the following generally occurs:

• Automatic funding occurs when the record reaches the End step in the workflow business
process, or when Finish Editing is selected in the non-workflow business process.

• The funds are assigned based either on the fund assignment order, or by the ratio of the
amounts of each fund, as determined in the assignment options in the Properties.

It is possible to adjust funding after automatic fund assignments.

About Crediting Funds

Sometimes it is necessary to credit back funds that have already been assigned. The same
general procedures for assigning funds can be used for crediting funds as well. You may need
to credit funds back to the credit source if:

• You receive an invoice credit from a vendor, and funds have already been assigned to the
original invoice amount.

• A mistake was made in the original fund assignment, either by assigning too high a value,
or assigning funds from the wrong fund.

You cannot credit more of a fund than has been consumed.

You can also credit previously assigned funds back to the fund source, either due to receiving
a credit invoice or line item (for example, a vendor credit), or to correct a previous assignment
error.

About business processes enabled for funding

Business process behavior is dependent on the how the business process was designed and
the assignment options chosen in the project/shell funding sheet. In general, the design
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determines when funding assignments can be viewed or performed, and the assignment
options determine whether the assignment is done manually or automatically, and at what
levels.

Spends type business processes (for example, invoices or payment applications) can be
designed to consume funds. Following is a summary of the business process types and design
options that can be used:

Project level:

• Cost type, subtype line items with fund code, classification generic, general spends or
payment application.

• Workflow or non-workflow.

• Each action form can be enabled with the following options: "View fund assignment" and
"Allow fund assignment." This option allows funding assignments to be viewed or
performed at any step in the workflow (or any status if non-workflow). The "Allow fund
assignment" option is applicable when the business process is set up for manual
assignment in the funding assignment levels in the funding sheet properties.

• An option can be set for the business process that disallows manual fund assignment after
the record reaches the end step (or terminal status for non-workflow). When this option is
chosen, it takes precedence over the "Allow fund assignment" setting, even if an action
form is used on the end step. This option does not affect automatic fund assignments. This
option is found on the Edit Studio window, Options tab.

CBS level:

• Cost type, subtype line items with CBS and fund code, classification generic, general
spends or payment application.

• Other options are the same as for project level.

Manually assign or credit funds (unassigned funds)

Normally, if a spends business process record has not been set up to automatically assign
funds upon reaching a certain status, that record total will show as Unassigned Funds in the
project/shell funding sheet.

When the funding business process reaches a specified workflow step or status, a Funding
button appears on the business process form. Selecting the Funding button opens the Funding
window, allowing manual fund assignment.

Funds can be manually assigned at the project/shell level (project/shell funding sheet), CBS
level (project/shell cost sheet), or business process level (spends business process record
designed to consume funds).

If a credit invoice (negative line item or invoice amount) has been submitted, this can be used
to credit previously consumed funds back to the source, or can be used to credit another fund.
You cannot credit an amount that is more than has been consumed.

Note

This section discusses assigning and crediting funds on the project/shell funding
sheet. See also Assigning and Crediting Commitment Level Funds.

To manually assign funds at the project/shell level from the funding sheet:
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1. Open the project/shell funding sheet.

2. In the upper portion of the window, select the link next to Unassigned (Project Level).
This link displays the amount of funds that are not currently assigned to a particular fund.
The Manual Fund Assignment window opens. This window displays the list of spends
business process records that have not yet been fully funded. A record can appear on this
list if you do not have enough funds available during an auto-assignment process, or if you
set Manual as the assignment rule for the business process under the funding sheet
Assignment tab.

3. Select one or more records from the list.

4. From the toolbar, select Assign to Funds.
The Manual Fund Assignment window opens.

5. Enter a percent (%) amount for each record against a funding source.

6. Select OK.

To manually assign funds at the CBS level from the cost sheet:

1. Open the project/shell cost sheet.

2. In the upper portion of the window, note the amount shown in the Unassigned at CBS
Level field. This is an amount that gets rolled up from the unfunded record data source in
the project/shell cost sheet.

3. Select a cell under the Unfunded Records column for a CBS code.
The Cell Detail window opens. This window displays the list of records that are not funded.

4. Select one or more records from the list, and select Assign to Funds on the toolbar.

5. Enter a percent (%) amount for each record against a funding source.

6. Select OK to close the form.

Note

Funds can be automatically consumed at the CBS level by defining the fund order
for each CBS Code from the Fund Assignment Order window on the Project/Shell
cost sheet and setting the assignment level to CBS Auto Order.

To manually assign or credit funds from a business process record:

1. Open the business process record that needs to be funded. If the record is at a specified
workflow step and status that allows funding, a Funding button is available.

2. From the toolbar, select Funding. The Funding window opens.

3. Select a line item from the upper pane. The bottom pane will display a list of funds that are
available for that line item.

4. Enter the amounts for fund assignment. This is subtracted from the fund balance. For
credits, enter negative amounts; the amount entered is added back to the fund balance.

5. Select OK.
If the business process is configured to use individual commit line items as SOV line items,
the upper pane will not show a list of line items. You will see a total amount under the
Unassigned Amount field.

Reassign project/shell funds from a business process record
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In addition to assigning or crediting funds from the funding sheet, you can also adjust the
funding allocations that were rolled up to the funding sheet directly from the business process
record in which the transaction took place.

To reassign project/shell funds:

1. Open the business process record in which you want to reassign funds.

2. Select Funding. The Cell Detail window opens.

3. Click Select. The fund picker opens.

4. Select the funding source from which to assign funds.
Depending on the design of the BP, the Fund picker may display all funds being used by
the company or only those funds currently allocated to the project/shell.

5. Select OK. The Assign to Fund window opens.

6. Enter the percentage of the transaction amount to assign to the new fund, and select OK.

Searching for Fund Codes

If you are working with many funds, there are ways to help you find the fund or funds that you
are looking for. You can search for individual fund codes using the Find feature. You can also
create and apply filters, which can be used to temporarily limit the number of funds displayed
on the sheet.

You can use the Find button to help you find a particular fund on company, project/shell funding
sheet, or a funding template. You can search by any column on the funding sheet. This option
is available if the display mode is Flat or Tree. Find is available on company and project/shell
funding sheets and templates.

In addition, you can search for funds in a fund picker. The fund picker displays when you are
adding funds to a project/shell funding sheet, or funds when adding line items to a business
process record used for funding.

To search for a fund on a funding sheet:

1. Open the project/shell funding sheet.

2. From the toolbar, select Find. The Find window opens.

3. Complete the Find window:

• Column: Choose a column name. This drop-down contains the names of all columns
that are displayed on the funding sheet, including Fund Code and Fund Name.

• Value: Enter a value for which to search. You can enter a full or partial word, number,
or other value. (Do not enter a wildcard character for partial entries.) The format of
your entry will depend on the type of value you are searching for. If you are searching
for a fund code, you can include the code separator if one is used (for example, a
dash).

• Search: Choose Up or Down. For new searches, use Down. If a value is found, it will
be selected on the sheet. If you want to continue to search, you can choose to search
up or down from the current selection.

4. Select Cancel to close the Find window.

To search for a fund in a fund picker:

1. Open the funding sheet or business process record.

2. Open the fund picker by doing one of the following:
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• On a project/shell funding sheet or template, add a row to the sheet by selecting
Rows, and then selecting Add Row. In the Fund Details window, click Select next to
the field for choosing a fund (for example, Fund Code).

• In the business process record, click Select next to the field for choosing a fund (for
example, Fund Code).

The Fund Picker opens.

3. You can search for a specific fund in the fund picker:

a. Select Find. The Find window opens. The window that opens will depend on the
design.

• If an attribute form is not defined, the default Find window will let you search by
Fund Code or Fund Name.

• If an attribute form is defined, the Find window can also be designed, and you may
have additional fields to search by.

b. Enter search criteria, and select Search. This limits the number of funds that are
displayed to those that match the search criteria.

4. Select OK. The fund appears as a row on the Funding Sheet. Funds are displayed in
alphabetical order on funding sheet.

Viewing a Funding Sheet

You can use the View option to access created views, create views, or update existing views.
The views that have been created, including Default, are listed in the upper segment of the
drop-down list. The lower segment of the list includes the Create New View and Manage Views
options.

To create a view:

1. Select Create New View.

2. Use the Save View As field to name your new view.

3. Use the following tabs for adding columns and filtering, grouping, and sorting information:

• Columns tab

• Filters tab

• Group By tab

• Sort By tab

The Available Columns box displays all the columns that you might want to include. The
Selected Columns box displays all the columns that you select. You can move columns in
and out of the Selected Columns box.

Use the following fields to set the position of the new view:

• Left Lock after Column: Displays a list of all columns, except the last column from the
selected columns list. By default, None is selected, which means that you have
chosen no column to be locked, from the left side of the sheet.

• Right Lock after Column: The default value is None, which means that you can
select not to right-lock the column in the view. Other values in this field are based on
the value that you have selected in the Left Lock after Column.

The Filters tab lets you further control what information is displayed in the selected view.
See Creating and Applying Filters.
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The Group By and Sort By tabs let you identify which columns should be used for group
and sorting and in what order.

4. When you are done, select Save.

To manage a view:

To update a view, select the applicable view from the View list, select Edit View , and then
make and save the applicable changes.

Creating and Applying Filters

If you are working with many funds, it may be useful to display a subset of the total number of
funds when working with the Funding Sheet. For example, you may want to view only new
funds for the current year.

You can temporarily limit the number of funds displayed on the sheet by applying a filter. This
feature is available on Company Funding Sheets, Project/Shell Funding Sheets, and funding
sheet templates.

Note

Filters that you set up in the shell template for a Funding Sheet are not currently
included in the Project/Shell Funding Sheet. To use filters, you must set them up in the
Project/Shell Funding Sheet.

Creating and Managing Filters on a Project/Shell Funding Sheet

If you have Create or Modify permissions, you can create and save any number of filters.
Anyone with permission to view the Funding Sheet can view and apply saved filters. You can
add multiple filters to a view, and you can use the same data element multiple times. When
adding multiple filters, you can use operators to specify that the view must match all listed
filters or that it can match one or more of the listed filters.

These procedures are applicable to Company Funding Sheets, Project/Shell Funding Sheets,
and funding sheet templates.

Note

Filters that you set up in the shell template for a Funding Sheet are not currently
included in the Project/Shell Funding Sheet. To use filters, you must set them up in the
Project/Shell Funding Sheet.

To create a filter:

1. From within the applicable view for the Funding Sheet, while you are in the New View or
Edit View window, select the Filters tab.

2. Select Add Filter.

3. Do the following:

a. Choose a Data Element: This drop-down list displays all data elements that are on the
Fund Attribute Form. Any data elements in a hidden block are not available.
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b. Choose a Condition: This drop-down displays a list of conditions. This list is based on
the type of data element selected.

c. Choose a Value: Depending on the type of data element, choose a value that the
query condition must meet.

• Data Element: Lists the data elements on the Fund Attribute Form.

• Constant Value: You can enter a full or partial entry of the value to filter by. This is
similar to entering search criteria. For example, if you want to display only funds
with "2010" in the fund code, choose the data element Fund Code, condition of
equals, and 2010 as a constant value. For pulldown or other multiple-entry fields, a
Select button appears, allowing you to select a value.

4. To add additional filters, select Add Filter again, and repeat the preceding steps.
You can use the same data element multiple times.

5. If you are using multiple filters, select the applicable operator that should apply to the set:

• And: To specify that the view must match all listed filters, select And.

• Or: To specify that the view should match any of the listed filters, select Or.

6. When you are done, select Save or Save As, as applicable.

To modify or remove a filter:

1. From within the applicable view for the Funding Sheet, select Edit View , and select the
Filters tab.

2. Make the applicable changes, such as changing the selected Data Element or Condition,
updating the Value, or removing one or more of the filters from a set.

3. To save your changes, select Save or Save As.

Applying a Filter to Limit the Fund Code Display

By using the Default view and applying a filter to the funding sheet, you can temporarily
reduce the number of fund codes that are displayed on the sheet.

To apply a filter:

1. From within the Default view for the funding sheet, select Edit View , and select the
Filters tab.

2. Select Add Filter.
The Data Elements list selects Fund Code by default.

3. Select the applicable Condition, such as equals.

4. In the Value, enter the first fund code that you want to include in the view.

5. If you want to include multiple fund codes, select Add Filter again, repeat the preceding
steps for each fund code that you want to include, and select the Or operator.

6. Select Save As, enter a name for the view, and select Save.

The funding sheet will display only those funds meeting the conditions of the filter selected.
The top of the sheet will display the name of the view.

To display all funds, select Default from the View menu.

Importing and Exporting Project/Shell Funding Sheet Information

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 294 of 671



You can export a summary of a funding sheet, which creates a CSV file that contains the rows,
columns, and data on the funding sheet. You can also export a CSV file containing fund details,
which includes all fund codes on the sheet and the data captured for them from the Fund
Details window.

You can also import fund details to a company funding sheet. This lets you add fund codes to a
funding sheet directly from a CSV file, rather than add them manually.

These procedures are applicable to company, project, and shell funding sheets.

Export funding sheet information

You can export a summary funding sheet, which is a CSV file containing the rows (funds),
columns, and data on the funding sheet. You can do this in a company, project, or shell funding
sheet. Summary funding sheet information cannot be re-imported.

To export a funding sheet summary:

1. Open the company, project, or shell funding sheet.

2. Select Export, and then choose Summary Fund Sheet.

3. Read the confirmation message, and then select Yes to continue.
You may choose to open the file in a compatible program such as Microsoft Excel to review
it before saving.

4. Select Save, and specify the location in which to save the CSV file.

Import and export fund details

You can export fund detail information from a company, project, or shell funding sheet to a CSV
file. This contains all the information captured in the Fund Details form when the funds were
added to the company funding sheet. When you export the fund details from the company
funding sheet, the details of all funds are exported; exporting from a project/shell funding sheet
gives the details of those funds added to that sheet.

When adding funds to a company funding sheet, you can use the export file as a template, add
fund details to the CSV file, and then re-import the file to add funds to the company funding
sheet. You cannot use import to add funds to a project/shell funding sheet.

To export fund details from a funding sheet:

1. Open the company, project, or shell funding sheet.

2. Select Export, and then choose Fund Details.

3. Read the confirmation message and then select Yes to continue.
You may choose to open the file in a compatible program such as Microsoft Excel to review
it before saving.

4. Select Save, and specify the location in which to save the CSV file.

To import fund details into a company funding sheet:

1. Open the company funding sheet.

2. Be sure you first export the fund details and save the CSV file.
Note the instructions at the top of the file. Remove any existing funds that may be listed in
the export file, so that only the column headings remain. The instructions at the top of the
file can remain. Save the file.
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3. Add the fund details for the funds that you want to import. Be sure to complete all required
fields. Do not add fund codes that already exist on the funding sheet.

4. Select Import Fund Details.

5. Browse to the CSV file, and select Ok. The funds you added to the import file will be added
to the company funding sheet.

Note

If any errors occur, download and open the error file, and correct the CSV file
before reimporting. Common errors include trying to import fund codes that exist
on the sheet, or not completing required fields.

Commitment Funding Sheet

Commitment Funding can be enabled for Base Commit and Change Commit, in uDesigner
(selecting the Allow Commitment based Funding and Assignment option):

The Commitment Funding sheet enables you to allocate specific project/shell funds to
individual Base Commit records (for example, Purchase Orders) and Change Commit records
(for example, Change Orders). This works in conjunction with the Schedule of Values SOV
sheet to track the Base Commit and the Change Commit line items and balances.

The following topics explain the details of the Commitment Funding Sheet sub-module or
sub-node.

For information about language (internationalization) and CSV files, see Internationalization
and CSV Files.

Working with Commitment Funding Sheets
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When using project/shell level Funding (described in the previous sections), the Fund
Assignment procedure does not distinguish which Funds is consumes for invoices or payment
applications that come in for different Base Commit BP records (that is, Contracts or Purchase
Orders business processes). There may be times when a Base Commit needs to be funded by
a specific fund or funds. If you want to allocate and assign specific funds for each Contract,
you can use Commitment Funding.

Commitment Funding works in conjunction with project/shell level Funding (the Funds
allocated to a Commit must first be present in the project/shell Funding Sheet) and with the
Schedule of Values (SOV) sheet that is created for the Base Commits (as the SOV keeps track
of the line items and the amounts of the Base Commits and any Change Commits).

The terms "Base Commit" and "Contract" may be interchanged in the descriptions, but both
refer to cost-type business processes of sub-type "Line items with CBS Code" and
classification "base commit." Common examples are Contracts and Purchase Orders.

If you are enabling a Base Commit for Commitment Funding, its linked Actual (Spends)
business process (General Spends invoice or Payment Application) will then consume Funds
at the Commitment level, not the project level. If you want to do Commitment Funding with
some Contracts and project level Funding with other Contracts, you should use a different "set"
of Base Commit, Change Commit and Actual (Spends) business processes (to use for each
type of Funding that you want to do).

If you will be using Commitment level Funding, a sheet structure must be created for the
project/shell which consists of columns and assignment rules (in the Properties). The
Commitment Funding sheets are created for each Base Commit record, using this default
structure. The Funds (rows) are added to the Commitment Funding sheets, and the Fund
amounts are allocated from available project/shell Funds to each sheet.

Note

Although Commitment Funding sheets are based on the structure, you can still modify
the columns and properties of individual sheets. You can also modify the Commitment
Funding structure after the sheets have been created. Modifications to the structure
will be reflected on the new sheets, but the modifications will not affect the existing
sheets.

Commitment Funding Sheets (Source, Structure, Permission)

The Commitment Funding sheet is based on the individual Base Commit BP records (for
example, Purchase Orders) and Change Commit records (for example, Change Orders).

The structure (rows and columns) of a Commitment Funding sheet is based on the structure
(rows and columns) of the Commitment Funding sheet template.

The Commitment Funding sheets can be accessed from the Commitment Funding Sheet log,
or from the Base Commit BP record with which the Commitment Funding sheet is associated.

Accessing the sheet from the Base Commit BP record depends on the business process
design:

• For workflow business processes, the Funding is enabled per step.

• For non-workflow business processes, the Funding will be enabled when the business
process form is editable.

The Funding sheet may also be available for viewing on View Forms, depending on the design.
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The Funding sheet is available if a Funding option is present on the Base Commit record
toolbar.

Note

The Commitment Funding sheets have record-level permission. The creator of the
Base Commit BP becomes the creator of the Commitment Funding sheet that was
created from that Base Commit BP and must grant View or Edit permission to other
users that may need to access it.

Commitment Funding Sheet Log

To access the Commitment Funding Sheet log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

The Commitment Funding Sheet log lists the Base Commit BP records (for example,
Contracts or Purchase orders business processes) and has the following toolbar options:

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 298 of 671



Option Description

Update Structure

Note

If your Commitment
Funding Sheet log has no
structure, this option will
change to Create Structure.

This toolbar option opens the Commitment Funding
Structure window. The Commitment Funding
Structure log columns provides details about the
commitment funding columns by listing their names,
data sources, and data formats.
Use the toolbar options to:
• Add a column to the Commitment Funding

Structure log columns (Add Column )
• Open the Commitment Funding Structure

properties (CFS Structure Properties )
This option opens the Properties window which
has the General tab and Assignment tab. In the
General tab, you can enter the title, and in the
Assignment tab you can set the assignment rules
(Commitment Level-Manual or Commitment
Level-Auto Ratio). The properties of a commitment
funding sheet are copied from the structure it was
created from (which in turn was copied from a
template). You can use these properties or modify
them as necessary.

• Find an item on the log (Find on Page  )
Right-click a row to insert, make a column visible or
invisible (Visible checkbox), delete, or reorder the rows
and ultimately the columns.
You can double-click a row to open the Column
Properties window and see the details or properties of
that column. Alternatively, you can use the gear menu

( ) options to do the same. The gear menu appears next
to each row when you hover over that row. Similar to
the Project Funding Sheet, new columns are created by
filling the column properties fields.
The Type has three options: Direct Entry, Line Item
Content, and Formula.
Columns such as Funding by Discrete Funds, Rows
Funded by Discrete Funds, and so on are part of the
Type: Line Item Content. The same Properties window
is used for viewing the column properties, which can be
opened by selecting Properties by right-clicking a
column heading.
To close the Commitment Funding Structure window,
select X in the upper-right corner.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 299 of 671



Option Description

Actions To set permissions for the commitment funding sheet.
Select Permissions to open the Permissions window to
add, remove, or find users or groups, and to modify or
set permissions.
• Modify Permission: This will allow user to modify

record level permissions.
• Edit: This will allow user to modify data on the

sheet.
• View: This will allow user to view the sheet.

Note

When you change settings in
the Permissions window, the
Save button is enabled. After
you select Save, a spinning
wheel appears while your
changes are saved and then
the Save button is dimmed.

Refresh To update the information displayed on the screen.
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Option Description

Print This option enables you to print the information
displayed on the screen (Print), export the list displayed
to an external file (Export to CSV or Export to Excel).

Note

• For export to Microsoft
Excel, the system
currently supports only
Euro (EUR) and United
States Dollar (USD)
currency symbols.

• If you export data from a
business process (BP)
record, sheet (such as an
Activity Sheet), or log
(such as Company
Funding Sheet Log) to
Excel, be aware that
depending on how your
negative values are
formatted, you might
need to configure your
columns in Excel to match
the correct data type
(Number). Otherwise, the
columns will not be
treated as numeric and
will not sum as expected.
One supported format
includes placing the
negative sign between the
currency symbol and the
amount (for
example, $-1,000).

Search To open the search pane and use the following filters or
fields to search for a particular record:
• Base Record
• Description
• Date Created
• Creator

Find on Page This option enables you to find items on the displayed
page. When you select this option, the system inserts a
row that lets you enter filter parameters.

When you select a row (base record), or a fund attribute, the screen splits and the right pane
displays the properties or fund attributes details of the record within the following tabs:

• Properties tab: Shows the record name and description.

• Assignment tab: Shows the Spends Process and allows you to select the Assignment
Rules (Commitment Level-Manual or Commitment Level-Auto Ratio).

• Permissions tab: Shows the users or groups and their permissions details.
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• Audit Log tab: Shows a list of the actions that have been taken on a record. The following
are captured in the Audit Log:
Date, Event, Action, Field, Old Value, New Value, User Name, Proxy User, and
Attachment. You can print the list in the Audit Log tab.

In the Commitment Funding Sheet log, each row (base record) has a gear menu ( ) option
that enables you to:

• Open: To open the commitment funding sheet window, for the base record BP
(Commitment Funding Sheet <BP Base Record Name> window). See Opening
Commitment Funding Sheet for a Base Record BP.

• Permissions: To open the Permissions window and to add or remove users or groups
and to add, modify, or change permissions.

• Open Base Record: To open the BP base record window (<Base Record Name BP>
window). See Opening a Base Record from the Commitment Funding Sheet Log.

Except for manual entry columns, all the values are editable in the commitment funding sheet.

Opening Commitment Funding Sheet for a Base Record BP

In the Commitment Funding Sheet log, double-click a row (base record) to open the
commitment funding sheet for that base record BP (Commitment Funding Sheet (<Base
Record Name BP>) window) window. Alternatively, you can select, or hover over, a record to

activate the gear menu ( ), and select Open to open the Commitment Funding Sheet
(<Base Record Name BP>) window.

The Commitment Funding Sheet (<Base Record Name BP>) window shows the
commitment funding sheet for the base record BP that you have selected to open. The window
shows the currency information and the Unassigned (Commitment Level). If you select the
amount link, on top, the Manual Fund Assignment window opens which displays the details
of the fund assignment such as the unassigned amount and name, title, the assigned amount,
remaining unassigned, description, and totals.

The Commitment Funding Sheet (<Base Record Name BP>) window has the following
columns:

• Fund Code

• Fund Name

Depending on your setup, the sheet columns will also include other funds. For example:

• Funding By Discrete Fund

• Records Funded By Discrete Fund

• Fund Balance By Discrete Fund

Except for the first two columns, you can right-click the column heading of any other columns
and hide, delete, lock, insert column, or open the properties of that column.

Use the Commitment Funding Sheet (<Base Record Name BP>) window toolbar options to:

• Manage rows

• Add columns

• Change the sheet view

• Create a new view for the sheet
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• Manage the existing sheet views

• Edit the views

• Open the Fund Assignment window that lists all the CBS codes for the base record (you
can search for CBS codes or Cost codes or change assignments for a fund code). You can
update the fund assignment for any of the CBS codes. By default, the All Funds option is
selected for all the CBS codes. You can select more than one CBS code and select a fund
from the Bulk Assign drop-down field. You must select at least one line to access the
contents of the drop-down field. After the fund is selected, all the records will reflect the
selected fund in their Assignment column.

• The Fund Assignment window can be accessed from the SOV sheet (to access it: in the
left Navigator, select Cost Manager, select SOV, select General Spends or Payment
Applications, and then open an SOV-based record).

• Refresh the items on the sheet to get the most up-to-date values.

• Print the items on the sheet.

• Find an item on the sheet.

• Use the Menu Options and set columns, export CFS Sheet Summary or Fund Details,
color rows, open column properties, and open the Audit Log.

The lower part of the sheet, depending on the Fund Code that you have selected, will show
the Fund Attributes which shows a read-only display of:

• Fund Code

• Fund Description

• Fund Category

• Fund Name

• Fund Long Description

If you select a cell, or value, under a data source (a column other than the first two columns),
the lower part of the sheet displays the following tabs:

• Transactions tab

• Cell Details tab

• Audit Log tab

The commitment funding sheet displays an error icon in case of errors. You can select the error
icon to open the list of errors.

The following explains how to open a base record BP.

Opening a Base Record Business Process from Commitment Funding Sheet Log

You can open a base record BP by one of the following methods:

• Opening the commitment funding sheet, and then selecting the BP link (<Base Record
Name BP>) in title.

• Selecting, or hovering over, a row (base record) to activate the gear menu ( ), and
selecting Open Base Record.
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The following explains the elements of a base record BP.

Title and Menu Options

The top area displays the name of the base record BP (title), and on the right corner, it has a
More Actions menu that enables you to access or conduct the following:

• Funding
Opens the Commitment Funding Sheet (<Base Record Name BP>) window.

• Email as Attachment
Opens an email message window that has a PDF version of the Base Record attached,
and the From and Subject fields auto-populated.

• Print
Enables you to print the Base Record using one of the following formats: HTML, PDF, or
Custom (using a Custom Print Template).

• Review
Enables you to review the Base Record by way of a file viewer or AutoVue.

• Help
Enables you to access the Base Record help (PDF version) or the User Productivity Kit.

• Close
To close the Base Record window and go back to the Commitment Funding Sheet
(<Base Record Name BP>) window.

Tabs and Properties Tabs

The body of the window is divided into two panes, the left and the right. The left pane has the
following tabs and each pane corresponds to a tab on the right pane, as explained in the
following table:
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Left pane Right pane

<Base Commit Record Name BP> tab
Information about the Base Record. For example, if the
Base Record is Contracts, the Contacts tab will have the
following blocks providing details:
• General
• Contract Information
• Contract Summary
• Change Orders
• Vendor Information

Attachments tab
Lists any files that are attached to this Base Record.
Comments tab
To post or read existing comments, in text format. It also
enables you to upload files by accessing either a location
on your computer (Browse), or by accessing the
Document Manager and selecting a file from the
Project Documents.
If you select the Browse option, you have the option to
Revise automatically if file with same name exists.
Linked Records tab
To access any records that are linked to this Base
Record.
Linked Mail tab
To access any emails that are linked to this Base Record.
Workflow Progress tab
This tab enables you to:
• See the Base Record Title, Record Number, Current

Step, and BP Setup Used.
• See or print the Workflow Progress - Graphic.
• Filter by Visited Steps or All Steps.
• Review details for all the steps taken such as the

Assignee and Status.
Audit Log tab
To see a record of all the actions that have been taken on
the Base Record. The log includes information such as
the Date, Action, and User Name.
Reference Records tab
Lists all the records that have been referenced in this
Base Record. You can select the records listed to see the
details.
In the upper-right corner, select View Graphic to open
and see the Reference Records - Graphic which shows
the relation between the record and its references.

Left pane Right pane

Line Items tab
• Form View (Default view and read-only. See the

image below for example.)
• Grid View (See the image below for example. You

can select a WBS Code cell which has the code as a
link and open the WBS Code window.)

• View Currency drop-down list (Your options are:
Transaction Currency, Project Currency, or
<currency>)

• Refresh
• Print
• Search
• Find on Page

Line Item Details tab
• Attachments tab
• Linked Records
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Left pane Right pane

Review Checklist tab
• Form View (Default view and read-only.)
• Grid View
• Refresh
• Print
• Search
• Find on Page

None
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Left pane Right pane

<Change Commit Record Name BP> tab
Create
To open the Create New <Change Commit record name>
(for example, Change Orders) window and add:
• The title of the new <Change Commit record name>.
• Information for the <Change Commit record name>

such as Contract Picker, Spec Section, Current
Contract Completion Date, and so forth.

• Scope
• Cost Center
• Acquisition Year
• Attachments
• Comments
• Link to other records
• Link to emails
And from the More Actions menu:
• Select SOV to open the Schedule of Values window

of the Base record to access the Cost Codes general
information, breakdown, attachments, and notes, or
to access a Scheduled Value amount to see the CBS
Line items, details, attachments, and notes.

• Select Export Line Item Template to export it
through a CSV or Microsoft Excel file.

• Select Print to the contents of the window in HTML,
PDF, or a Custom format.

• Select Reload to receive updated information about
the Change Commit record Contract Summary.

• Select Review to access any documents that are
available for review.

• Select Help to access the Change Commit record
help PDF or the User Productivity Kit.

• Select Close to close the <Change Commit record
name> window.

Next to More Actions, you can select Save Draft to
revisit your work later, or you can Send your changes to
the next step if your changes are completed.
Refresh
Print
Search
Find on Page

None
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Left pane Right pane

Payment Applications tab
Create
To open the Create New Payment Applications
window and:
In the Payment Applications tab add:
• The title of the new Payment Applications.
• Contract information
• Payment Application information
• Attachments
• Comments
• Link to other records
• Link to emails
In the Line Items tab, for each WBS Code and in case
the information is missing, you can enter values in the
Short Description, Description, Work Package, Material
Price, and other cells that are not grayed. You can right-
click any column heading and sort the cells, remove
columns, or add columns.
In the upper-right corner, select Save to save your
changes, or select Error Check to see which required
cells you have missed to enter a value in, or select
Cancel to discard your changes.
And from the More Actions menu:
• Select SOV to open the Schedule of Values window

of the Base record to access the Cost Codes general
information, breakdown, attachments, and notes, or
to access a Scheduled Value amount to see the CBS
Line items, details, attachments, and notes.

• Select Export Line Item Template to export it
through a CSV or Microsoft Excel file.

• Select Print to the contents of the window in HTML,
PDF, or a Custom format.

• Select Reload to receive updated information about
the Payment Applications information such as
Original Contract Amount, Net Changes by Change
Orders, and so forth.

• Select Review to access any documents that are
available for review.

• Select Help to access the Payment Applications help
PDF or the User Productivity Kit.

• Select Close to close the window.
Next to More Actions, you can select Save Draft to
revisit your work later, or you can Send your changes to
the next step if your changes are completed.
Refresh
Print
Search
Find on Page

None

Creating, Viewing, and Editing a Commitment Funding Sheet Structure
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Structures are created by copying a commitment funding template. The commitment funding
structure defines:

• The column structure that will be used for the individual commitment funding sheets that
are created from the base commit BP records.

• The assignment levels and rules to use for each sheet (in the Properties window).

Note

The following procedures assume a commitment funding template has been
created and available.

Structures can also be created in a project/shell template and then copied to projects/shells
created from that template. Structures created in a project/shell template can also be "pushed"
to an existing project/shell, using the Update Projects or Update Shells options.

If you modify the columns or properties of the commitment funding sheet structure, the existing
sheets will not be affected, and only the new commitment funding sheets (created from the
edited structure) will reflect your modifications. You can modify the columns and properties of
individual commitment funding sheets without affecting the default structure.

To create a commitment funding sheet structure:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. From the toolbar menu options, select Create Structure to open the window.

Note

When a structure is created, the Create Structure option changes to Update
Structure option.

4. Proceed to select and open a commitment funding template form the list.

5. Follow the prompts to either use the commitment funding template structure as is or make
modifications as necessary and use the end result for the commitment funding sheet
structure.

To view or edit a commitment funding sheet structure:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. From the toolbar menu options, select Update Structure to open the Commitment
Funding Structure window.

4. Read the following information to view or edit the commitment funding sheet structure:
The Commitment Funding Structure log columns provides details about the commitment
funding columns by listing their names, data sources, and data formats.

Use the toolbar options to:

• Add a column to the Commitment Funding Structure log columns (Add Column )
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• Open the Commitment Funding Structure properties (CFS Structure Properties
)

This option opens the Properties window which has the General tab and Assignment
tab. In the General tab, you can enter the title, and in the Assignment tab you can set
the assignment rules (Commitment Level-Manual or Commitment Level-Auto
Ratio). The properties of a commitment funding sheet are copied from the structure it
was created from (which in turn was copied from a template). You can use these
properties or modify them as necessary.

• Find an item on the log (Find on Page  )

Right-click a row to insert, make a column visible or invisible (Visible checkbox), delete, or
reorder the rows and ultimately the columns.

You can double-click a row to open the Column Properties window and see the details or

properties of that column. Alternatively, you can use the gear menu ( ) options to do the
same. The gear menu appears next to each row, when you hover over that row. Similar to
the Project Funding Sheet, new columns are created by filling the column properties fields.
The Type has three options: Direct Entry, Line Item Content, and Formula. Columns such
as Funding by Discrete Funds, Rows Funded by Discrete Funds, and so on are part of
Line Item Content Type. The same Properties window is used for viewing the column
properties, which can be opened by selecting Properties by right-clicking a column
heading.

To close the Commitment Funding Structure window, select X in the upper-right corner.

Creating a Commitment Funding Sheet

The Commitment Funding Sheet allows you to allocate project/shell funds to a specific
"commitment" (base commit) business process record (for example, a contract or a purchase
order). Changes to the original contract through the use of associated change commits will
also be reflected on the funding sheet. The commitment funding sheet is also used to track the
consumption of those funds as spends business processes (invoices or payment applications)
are created.

There is one commitment funding sheet for each base commit business process record. You
create the sheet directly from the base commit record after it reaches a step at which funding
has been enabled. (For workflow BPs, funding can be enabled per step; for non-workflow BPs,
funding will be enabled when the form is editable. The funding sheet may also be available for
viewing on view forms, depending on the design. The funding sheet is available if a Funding
button is present on the base or change commit record toolbar.)

Be sure the following is in place before creating the commitment funding sheet:

• A commitment funding structure has been created. The sheet will use this default structure.
Columns can be modified, removed, or added to the sheet; this will not affect the default
structure.

• The project/shell funding sheet has been created, and funds allocated to it from the
company funding sheet.

• To use commitment level funding, a Schedule of Values (SOV) sheet must be created for
the base commit. The commitment funding sheet uses the SOV to track base commit and
change commit line items, amounts, and remaining balances. Be sure the SOV sheet has
a column using the data source Scheduled Value, as this is used by the commitment
funding sheet.

If the fund assignment levels and rules have been defined in the structure, these will be copied
to the new sheet. These definitions can be added or edited in the sheet as needed.
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The user who creates the sheet becomes the owner and automatically has full permissions to
view and edit the sheet. If other users will need to view or edit the sheet, you will need to give
them permission.

After the sheet is created, you then allocate funding for that record from the available project/
shell funds. Fund allocation is done manually on the commitment funding sheet; allocation and
consumption can be tracked on the project/shell funding sheet by adding the appropriate
columns.

To create a commitment funding sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. Hover over the base commit business process record on which you want to perform
commitment funding.

4. If commitment funding has been enabled on the base commit business process record,
and the base commit business process record is in current step, then when you open the

base commit business process record (gear menu [ ], select Open Base Record), and

select Menu Options (  ), the Funding option will be included in the list of options.

Note

If the Funding option is not available, contact your administrator to verify that
commitment funding is available for the business process, that it is available on
the current step, and that you have the proper permissions. In addition, it is
possible that on some steps (and on View Forms), the Funding option will be
present, but the option has been designed to open a view-only version of the
sheet.

5. Select Funding to open the Commitment Funding Sheet (<Base Record Name BP>)
window.

6. Select Fund Assignment to open the window and complete the commitment funding.

About Commitment Funding Columns

The columns on the commitment funding sheet are used to manage and track the funding
allocation, assignment, and fund balances for the commit record.

Note

In these column definitions, the terms All Funds and Discrete Fund refer to the fund
assignment options (from the Fund Assignment window, accessed from the SOV
sheet or commitment funding sheet). These options determine how the SOV lines (and
therefore, the commit lines) will be funded, either automatically or manually from the
entire list of funds available to the commit, or by one specific fund.

The Funding Across All Funds column is used to enter (or calculate) the amount of each
fund to allocate for this base commit record. The rows on the sheet are the funds that will be
used to fund the commit. The value entered here will be the fund amount available for all
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commit lines that have "All Funds" as assignment. This can be a manual entry column, or a
formula that uses another manual entry column as the basis of the formula.

Additional columns commonly track fund assignments (consumption) made against each fund.
These can be in the form of business process transactions or manual funding assignments.
System provided data sources that can be used for columns include the following:

• Funding By Discrete Fund: This column displays the sum total of all the line items of
base and change commits that are funded by a specific (or "discrete") fund This value can
be used to determine the fund balance during consumption.

• Records Funded Across All Funds: Reflects the total of funds consumed from records
that are funded based on All Funds, whether funding is done manually or automatically.

• Records Funded By Discrete Fund: Displays the total of funds consumed from records
that are funded based on a discrete fund, whether funding is done manually or
automatically.

• Fund Balance Across All Funds: This column tracks the fund balance across all funds.
The formula used is (Funding Across All Funds) - (Records Funded By All Funds).

• Fund Balance By Discrete Fund: This column tracks the fund balance by specific fund
chosen in the Fund Assignment window. The formula used is (Funding By Discrete Fund) -
(Records Funded By Discrete Fund).

• Funding Ratio Across All Funds: The value of this column is calculated automatically. It
reflects the % ratio to use when performing fund assignment ratio during consumption. The
formula is (Funding Across All Funds Per Fund) / Total of Fund Balance Across All Funds).

Assignment Levels and Rules

The assignment levels and rules are defined on the Assignments tab of the commitment
funding sheet.

Note

This step is required to do commitment level funding.

The Assignment tab lists the spends business processes that are linked to base commits
enabled for commitment level funding. For each listed business process, you define how fund
assignment will be done when these spends records come in against the base commit:

• Commitment Level - Manual: Funds are manually assigned at runtime. As spends
business processes are routed and reach specified status, the amounts to be funded are
collected under the Unassigned total on the commitment funding sheet, similar to project/
shell level manual funding. You can then select each line of the spends BP and assign
funds at runtime. This can be done on transient records or in terminal status (depending on
design). Consumed funds roll up to the commitment funding sheet and the project funding
sheet.

• Commitment Level - Auto Ratio: Funds are assigned automatically when the spends
business process reaches a specified status. Funds are assigned based on the fund ratio,
which is calculated based on the current fund levels, and funds are managed and tracked
on the commitment funding sheet. If all funds are consumed, any remaining spends
amounts are collected under Unassigned.

You can define these assignment rules on the commitment funding template. When you create
a commitment funding structure in a project/shell, these assignment rules will be copied to it,
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and when you create sheets from the structure, they will be copied to the sheets. If you need
to, you can modify these rules on individual structures and sheets.

Fund Assignment Details Per SOV Line Items

This is an optional step that allows you to provide details about fund assignment or
consumption for each line on the Base Commit or any Change Commits. You access the Fund
Assignment window by selecting Fund Assignment on the commitment funding sheet or the
SOV sheet associated with the Base Commit.

• If you do not define any assignment options in this window, All Funds is the default
selection. This means that all funds that have been allocated to the base commit on the
commitment funding sheet will be available for funding each line of the spends business
process created against it (either manually or by auto ratio, as defined by the assignment
rules). When this is chosen, funding information is captured on the commitment funding
sheet in columns using data sources referencing "across all funds."

• There may be times when you need to specify that a specific fund must be used to fund a
specific CBS code on the base commit or a change commit. You can select a specific fund
(or "discrete fund") to fund selected SOV lines. When this is chosen, funding information is
captured on the commitment funding sheet in columns using data sources referencing "by
discrete fund."

After the commitment funding sheet is created, you can add rows and allocate funds to it.

About Commitment Funding Sheet Rows

Each row in the commitment funding sheet corresponds to a fund that has been allocated for
use on that commitment. Fund allocation can be done manually, by adding rows to the
commitment funding sheet. The funds that are available for allocation are those on the project/
shell funding sheet.

About Commitment Funding Assignment Options

Fund Assignment refers to how funds are to be consumed as spends type business processes
(for example, invoices and payment applications) come in against the base commit that is
being funded.

Initial assignment rules are defined in the Assignment tab. Additional details can be defined in
the Fund Assignment window. To access the fund assignment window, select Fund
Assignment on the commitment funding sheet or SOV sheet for the base commit. The Fund
Assignment window is not accessible until the SOV sheet has been created.

Allocating Funds for Commitment Funding

Similar to project/shell funding sheets, the rows of a commitment funding sheet correspond to
the funds that you want to use to fund the associated base commit (plus any linked change
commits). The funds that are available to add as rows are those that have been added to the
project/shell funding sheet.

After adding a row, you allocate how much of that fund you want to make available to the base
commit directly on the sheet. That is, you must add a column to the commitment funding sheet
using the data source Funding Across All Rows. This is the column to use for fund allocation.

This column can be manual entry or formula. If it is manual entry, you can enter the fund
allocation amount directly to the cell. If you use a formula, you must also include another
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manual entry column to use to enter an amount and include that in the formula. For example,
you might want to use your own ratio of certain funds in the initial allocations. You can add a
manual entry column, and then use the formula calculation for the Funding Across All Rows
column.

Managing Commitment Funding Sheet Rows (Funds)

The rows that you add to a commitment funding sheet are the project/shell funds that you are
allocating to the associated base commit and any change commits.

You add rows (funds) to the project/shell commitment funding sheet, but not the template or
structure. You can delete a row if no assignments have been made against the fund.

Note

The Add Rows option is available only if all the available project funds have not been
added to Base record BP commitment funding.

You cannot delete a row or base record BP, after a fund has been assigned to that row or base
record BP.

After you save a commitment funding sheet, you cannot edit the assigned funds.

To assign a different fund to a row or base record BP, delete the row or base record BP, and
then create a new row or base record BP and assign the fund.

To manage rows in the commitment funding sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. From the toolbar, select Manage Rows to open the Manage Rows window.
The window is divided into two sections:

The left section which lists the "Available Project Fund Codes" sorted in columns by:

• Fund Code

• Fund Name

• Fund Description

• Fund Category

The right section which lists the "Selected" Fund Codes sorted according to the Available
Project Fund Codes, shown above.

The fund codes listed are those that are on the project/shell funding sheet. For each row,
you will need to allocate how much of the fund to make available to the commit. You can
do that now or wait until all the rows have been added.

Allocating Fund Amounts to a Commitment Funding Sheet Row

You allocate the project/shell funds to use for each fund directly on the commitment funding
sheet per row. The commitment funding sheet must have a column that uses the data source
Funding Across All Rows. This is the column to use for fund allocation.

Chapter 1
Cost Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 314 of 671



The Funding Across All Rows column can be manual entry or formula.

• If it is manual entry, you can enter the fund allocation amount directly to the cell.

• If you use a formula, you must also include another manual entry column in the
commitment funding sheet to use to enter an amount and include that in the formula. For
example, you might want to use a ratio of certain funds in the initial allocations. You can
add a manual entry column, and then use the formula calculation for the Funding Across
All Rows column.

To allocate fund amounts to a commitment funding sheet row:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. For each row, double-click the cell of the column you are using for the manual entry portion
of fund allocation (for example, the Funding Across All Rows column). This makes the
cell editable.

4. Enter the amount to use for fund allocation.

5. Select Save to save your changes.
When you save the commitment funding sheet, the system runs a validation check to
ensure that the allocation amounts do not exceed the fund balance of each fund on the
project/shell funding sheet.

Assigning and Crediting Commitment Level Funds

Assigning (consuming) or crediting funds on a commitment funding sheet is similar to a project/
shell funding sheet, with some exceptions. This section assumes that the concepts of
assigning and crediting funds of project/shell funding sheets is already understood.

As with project/shell funding, fund consumption on commitment funding sheets is done using
General Spends or Payment Application business processes that have been designed to
consume funds.

When the General Spends BP is linked to a Base Commit BP that has been enabled to do
commitment funding, the funds are consumed from the commitment funding sheet, not the
project/shell funding sheet.

As in project/shell funding, funds are assigned from the General Spends BP record based on
the amount of that General Spends BP record.

The behavior of funding business processes depends both on the design options chosen and
the Assignment Levels chosen on the commitment funding sheet properties.

Like project/shell funding, fund assignment can be done manually or automatically (by fund
balance ratio). This is determined in the Fund Assignment rules set in the sheet Properties.

The Commitment Funding Sheet (<Base Record Name BP>) window shows the
commitment funding sheet for the base record BP that you have selected to open. The window
shows the currency information and the Unassigned (Commitment Level). If you select the
amount link, on top, the Manual Fund Assignment window opens which displays the details
of the fund assignment such as the unassigned amount and name, title, the assigned amount,
remaining unassigned, description, and totals.

When you select the unassigned commitment level value, the Manual Funding window opens.
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Note

This Manual Funding window is similar to the Manual Funding window of a project/
shell funding sheet. The only difference is that in the Manual Funding window of a
commitment funding sheet you can assign funds only from the allowed fund codes
(this is governed by Fund Code selection in Fund Assignment window).

To prevent assigning wrong fund codes, the window displays the fund codes that are not
allowed as read-only.

In this scenario, when you open the Manual Assignment window (from Transactions), the
Manual Assignment window will only include the selected rows.

About Business Processes Enabled for Commitment Funding

Commitment funding is enabled on the CBS-code-based Base Commit (Base Commit BP that
is based on CBS Codes). The design of the Base Commit BP forms determines when the
Funding option appears on the Base Commit BP record, or the Change Commit BP record.
The Funding option allows you to create the commitment funding sheet for the BP record and
also to access the funding sheet from the BP record.

Note

The commitment funding sheets can also be accessed directly from the commitment
funding sheet log.

As in project/shell funding, you use General Spends type BPs (for example, Invoices or
Payment Applications) to consume funds. If the General Spends type BP is linked to a Base
Commit BP that is enabled for commitment funding, the General Spends type BP record will
consume funds from the commitment funding sheet rather than the project/shell funding sheet.

If you will be doing both the project/shell funding and the commitment funding, use a different
set of linked Base Commit / Change Commit / General Spends business processes for each
funding.

Viewing Unassigned Amounts (Commitment Level)

When the General Spends BPs are set up to be funded manually, the amount of the General
Spends BP, initially, is captured in the Unassigned (Commitment Level) field on the
commitment funding sheet. This value displays until the entire amount of the record has been
fully funded.

For a project/shell level funding, the amount displays in the Unassigned (Project Level) field;
for CBS level funding, the amount shows up in the Unassigned (CBS Level) field.

It is possible that an unassigned amount can be negative, as the result of a credit invoice that
has not yet been credited back to the funding source.
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Note

These unassigned amounts can also be rolled up to the Cost Sheet using the
Unfunded Record data source.

To view unassigned commitment funding sheet amounts (commitment level):

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. Open the commitment funding sheet for the base record BP that you want to see the
unassigned amount for: Commitment Funding Sheet (<Base Record Name BP>). The
window shows the currency information and the Unassigned (Commitment Level). If you
select the amount link, on top, the Manual Fund Assignment window opens which
displays the details of the fund assignment such as the unassigned amount and name,
title, the assigned amount, remaining unassigned, description, and totals (transaction
records that have not yet been fully funded).
If business process transactions have occurred that have not yet been funded, the total of
the records will display in the Unassigned field in the upper portion of the sheet.

Assigning or Crediting Unassigned Funds on the Commitment Funding Sheet

If there are unassigned funds, you can assign them manually from the General Spends BP
record or from the commitment funding sheet.

When the General Spends BP record reaches a specified workflow step or status, the Funding
options appears on the BP form. When you select Funding, the Funding window opens
allowing you to do manual fund assignment.

If a credit invoice (negative line item or invoice amount) has been submitted, this can be used
to credit previously consumed funds back to the source or can be used to credit another fund.
You cannot credit an amount that is more than has been consumed.

To manually assign funds from the commitment funding sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Funding Sheet
to open the Commitment Funding Sheet log.

3. Open the commitment funding sheet.

4. From the top portion of the window, select the link next to Unassigned (Commitment
Level). This link displays the amount of funds that are not currently assigned to a particular
fund. The Cell Detail window opens. The Cell Detail window displays the list of spends
business process records that have not yet been fully funded. A record can appear on this
list if you do not have enough funds available during an auto-assignment process, or if you
set Manual as the assignment rule for the business process under the funding sheet
Assignment tab.

5. Enter a percent (%) amount for each record against a funding source.

6. Select OK.

To manually assign or credit funds from a General Spends BP record:
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1. Open the General Spends BP record that needs to be funded. If the General Spends BP
record is at a specified workflow step and status that allows funding, the Funding option
appears.

2. From the toolbar, select Funding to open the Funding window.

3. Select a line item from the upper pane. The bottom pane will display a list of funds that are
available for that line item.

4. Enter the amounts for fund assignment. This is subtracted from the fund balance. For
credits, enter negative amounts; the amount entered is added back to the fund balance.

5. Select OK.

To manually assign or credit funds from a General Spends BP record:

1. Open the General Spends BP record that needs to be funded. If the General Spends BP
record is at a specified workflow step and status that allows funding, the Funding option
appears.

2. From the toolbar, select Funding to open the Funding window.

3. Select a line item from the upper pane. The bottom pane will display a list of funds that are
available for that line item.

4. Enter the amounts for fund assignment. This is subtracted from the fund balance. For
credits, enter negative amounts; the amount entered is added back to the fund balance.

5. Select OK.

Automatic fund assignments at the commitment level

Automatic fund assignment works similarly at the commitment level as it does in project/shell
funding. The available automatic funding option is auto-ratio by fund balance (if All Funds is
chosen in the Fund Assignment window), or a specific (discrete) fund can be used.

See Manual and Automatic Fund Assignment, About Crediting Funds, About Commitment
Funding Assignment Options, About Commitment Funding Columns.

Accounts Sheet

The company accounts sheet is used to track company level accounts information, such as
assets, resources, and facility maintenance. It is similar to a project/shell cost sheet, using
account codes instead of CBS codes.

Working with Company Accounts Sheets

The company accounts sheet is used to track company level accounts information, such as
assets, resources, and facility maintenance. It is similar to a project/shell cost sheet, using
account codes instead of CBS codes.

Account codes are independent of CBS codes, but are similar in structure format. Company-
level business processes can be designed in uDesigner to roll up to the accounts sheet (line
items are associated with account codes).

Open the accounts sheet

To open the accounts sheet:

1. Go to the Company Workspace tab, and switch to User mode.
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2. In the left Navigator, select Cost Manager, and then select Accounts Sheet.

3. In the Accounts Sheet log, select the sheet, and select Open (example below).

Note

When you first open the sheet, the opening view will depend on the Default View
option selected in the Properties window. Your accounts sheet administrator can
set this default view. Accounts sheets can be resized and split/unsplit the same
way as project/shell cost sheets (see Resize cost sheet window or Split or unsplit
cost sheet window).

The accounts sheet works similarly to cost sheets. Like cost sheets, you can:

• Enter data into manual data-entry columns.

• View rolled up transaction details by selecting a cell with a hyperlink.

• View a column definition by selecting a column heading.

• Copy column data from one column to another (from the Edit menu, select Copy Column
Data; the original values will be overwritten).

• Save and view snapshots (from the File menu, select Create Snapshot; from the View
menu, select Snapshot Log).

• Import and export column details.

• Export accounts summary sheet.

Activate or deactivate account codes

You can control the status of account codes. If an account code is inactive, it will be displayed
on the accounts sheet, but will not be available for selection in an Account Code picker, such
as on company account business process transactions.

To activate or deactivate an account code:

1. Open the accounts sheet.

2. Select Account Status. The Account Code Status window opens.

3. Select one or more account codes.

4. Select Activate or Deactivate.

View or edit accounts sheet properties

Accounts sheet properties can be viewed and edited. The ability to edit properties is dependent
on your user permission settings. Contact your project or company administrator if you have
questions regarding your user permission settings.

To view or edit accounts sheet properties:

Select the accounts sheet from the log, and select Properties; or open the accounts sheet, go
to the File menu, and select Properties. The Properties window opens. The following
properties are displayed and are editable by the cost administrator:

• Title: This is the title of the sheet and appears in the log.
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• Description: This optional field can be used to provide a description or other information
about the accounts sheet.

• Display Mode: This determines whether the accounts codes are displayed in a flat list, or
a hierarchical tree mode. This setting can be switched back and forth as needed.

• Default View: These are the settings that determine how the sheet appears when first
opened by any user from the log.

Generic Cost Manager

A "Generic Cost Manager" captures non-CBS cost-related activities for a configurable shell.
These include costs such as:

• Rent

• Lease payments

• Landscape care

• Building maintenance and repair

• Remodel of building interiors

With this manager, you can capture and view cost transaction information based on a
timescale, such as quarterly or yearly. Each shell can have one Generic Cost Manager. The
Generic Cost Manager uses specific generic cost business processes as data sources.

Most of the functionality for the Generic Cost Manager is the same as that for the standard
Cost Manager. Rather than re-document all the cost management sheet functionality that is
common between the Generic Cost Manager and the standard Cost Manager, this section
documents the differences between the managers and explains that functionality in context of
the task you will be performing.

Note

The names of the Generic Cost Manager, the various shells and sub-shells, and the
generic cost sheet you will work with are determined by the names defined in
uDesigner. For documentation purposes, in these instructions, this manager is referred
to as the Generic Cost Manager.

The Generic Cost Manager:

• Defines a code structure that can be used to capture cost-related activities for a
configurable shell.

• Tracks and rolls up costs to upper management levels

• Enables interaction with cost data

– Operating budgets (monthly, quarterly, yearly)

– Projects with life cycles that span over extended time

– Costs covering the entire life cycle of the product/operation

– Transactions based on timescale

– Transactions in varying currencies
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The following procedures discuss how to access and work with generic cost sheets. The
generic cost sheet is created from a template.

Data Sources for Generic Cost Sheets

The Generic Cost Manager uses information in cost sheets that is manually entered,
calculated, or comes from Generic Cost BPs. The difference between the Generic Cost
Manager and the standard Cost Manager is that the data used in the Generic Cost Manager
comes from shells and sub-shells, not from projects.

The Generic Cost Manager uses specific Cost BPs as a data source. These BPs have the type
cost and the classification Line Items with Multiple Codes.

Opening Generic Cost Sheet

To open a generic cost sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Manager, and then select Generic Cost
Manager.
The Generic Cost Manager log lists all the generic cost sheets.

3. Select a generic cost sheet, and select the gear menu ( ) to open it.

4. Select Open to open the generic cost sheet (Generic Cost Manager overlay window) log.

You work with a generic cost sheet in the same way as a standard cost sheet, seen in projects
and CBS shells. The difference is that the data in the generic cost sheet comes from generic
shells and sub-shells. The first two columns are displayed by default. The view is fixed, and
there is no split screen capability.

Viewing Data for Shells and Sub-shells in Generic Cost Sheet

The generic cost sheet displays transactional data by period and shell level. In the context of
working with the generic cost sheet, you can filter the cost data you are viewing by shells or
sub-shells. You can use the shell or sub-shell filter in combination with the timescale selector
documented in the next section to create various views in your spreadsheet based on shell or
sub-shell and time period.

See Working with Configurable Manager Sheets (Standard View) for additional details.

In the View By selection list, choose one of the following:

• Current Shell only: Data from the current shell you have selected. Manual column data is
editable in the Current Shell only view.

• Current Shell and Sub-shells only: Data from both the current shell and its sub-shells.

• Sub-shells only: Data from the sub-shells of the current shell.

In Generic Cost Sheet views, data is rolled up from the current shell and sub-shells. To ensure
the data rolls up correctly, maintain the same column structure on the generic cost sheet
across the parent shell and sub-shells. When data is rolled up from sub-shells, the generic cost
sheet under a shell can roll up data from other shells that are created as sub-shells and their
sub-shells. The Current Shell and sub-shells only and Sub-shells only views support this
rollup. For example:
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• North Region (shell)

– Property A (sub-shell)

* Building 101 (sub-shell)

* Building 102 (sub-shell)

– Property B

* Building 201

* Building 202

In this example, the North Region Generic Cost Sheet will have data from Property A, Property
B, Building 101, Building 102, Building 201, and Building 202. Property A has data from
Building 101 and Building 102. Property B has data from Building 201 and Building 202.

Also, data from a sub-shell to its parent shell can only roll up if the codes match. For example,

• North Region (Shell)

– Property A (1000-1001: $500)

* Building 101 (1000-1001: $500)

* Building 102 (1000-1002:$200)

In this example, Building 101 will roll up to Property A as the codes match (1000-1001).
Building 102 will not roll up because the codes are different (1000-1002). Parent and child shell
cost codes must match for roll up to occur. Timescale and column definition must also match
across the shells and sub-shells.

Also, all sub-shells that will roll up must have the same currency as the parent shell. If all the
sub-shells and the current parent shell have the same currency, the data displays in that
currency. If at least on sub-shell has a different currency, the data displays in the Base
Currency. A confirmation message alerts you to this currency display.

While rolling up, only parent shell generic cost sheet codes should be considered. This is
applicable under all views.

Change the Timescale on a Generic Cost Sheet

With the Generic Cost Manager, you can capture and view cost transaction information based
on a timescale, such as monthly, quarterly, or yearly. For example, you might be working with
time-based transactions such as lease payments. In the context of working with the generic
cost sheet, you can change the timescale on the cost data with which you are working. You
can use the shell or sub-shell filter described in Viewing Data for Shells and Sub-shells in
Generic Cost Sheet in combination with the timescale selector to create various views in your
spreadsheet based on shell or sub-shell and time period.

To change the timescale on generic cost sheet data by shell or sub-shell:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Manager, and then select Generic Cost
Manager.
The Generic Cost Sheet log opens.

3. Open the cost sheet you want to work with by double-clicking the cost sheet name, or by

selecting the cost sheet name in the log, selecting the gear menu ( ), and selecting
Open.

4. Select Display Period. The Display Period window opens.
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5. Select a date range (Monthly, Quarterly, or Yearly) and the time period to go with the
range. The data for the timescale you select is displayed in the cost sheet. The default
view is Monthly and shows the current month. Data is always stored in months. Changing
the timescale units updates the totals based on the period and the calendar year.

Monthly view data is only editable in the manual columns of the Current Shell view. Quarterly
and Yearly views are read-only.

Modify Shell and Base Exchange Rates for Manual Data Entry

Data entered manually (directly) on a generic cost sheet should have a rate associated with it.
This is because any transaction that occurs under a shell will be calculated and stamped with
two currency rates: the shell currency and Base Currency. The rate in this case will be the
conversion rate between the shell currency and Base Currency (the Base Currency is the
company currency).

When you modify the exchange rate, the new rate takes effect for the currency month and
applies until you change it again. You can revert it to the rate stored in the shell properties. The
modified exchange rate applies only to data you enter manually on the sheet. It does not affect
data that is entered through business processes, which uses the exchange rate from shell
properties.

To view exchange rate history:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Manager, and then select Generic Cost
Manager.

3. Open the applicable generic cost sheet.

4. From the toolbar, select Menu Options (  ), and select Exchange Rate History.

To view the data in either the shell or Base Currency:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Configurable Manager, and then select Generic Cost
Manager.

3. Open the applicable generic cost sheet.

4. From the toolbar, select Switch to Project Currency  to switch between Base Currency
and Project Currency.

Export Generic Cost Sheet data

You can export the structure of a generic cost manager.

Print options

In the Generic Cost Manager log, select the sheet, select the gear menu ( ), and select

Open to open the Generic Cost Manager window. From the toolbar, select Print , and
select one of the following:

• Print

• Export To CSV

• Export To Excel
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Note

– For export to Microsoft Excel, the system currently supports only Euro (EUR)
and United States Dollar (USD) currency symbols.

– If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you might
need to configure your columns in Excel to match the correct data type
(Number). Otherwise, the columns will not be treated as numeric and will not
sum as expected. One supported format includes placing the negative sign
between the currency symbol and the amount (for example, $-1,000).

Export options

In the Generic Cost Manager log, select the sheet, select the gear menu ( ), and select
Open to open the Generic Cost Manager window that displays all the columns. Select Menu
Options (  ), select Export, and select one of the following options:

• Summary Sheet

• Cost Codes

• Column Data

Proceed with following the prompts.

Note

If you open the CSV file, you will see that it contains notes regarding modifying the
columns and data in the exported file for reimporting into a cost sheet. Follow the
notes embedded in the CSV file for modifying columns and data in the exported file.

Import Generic Cost Sheet data

You can import the structure of a generic cost manager.

In the Generic Cost Manager log, select the sheet, select the gear menu ( ), and select
Open to open the Generic Cost Manager window. From the Menu Options, select Import, and
select Cost Codes. Browse for the CSV file to import, select it, and select Open.

You can also select Column Data, from the Import options, to open the Import Column Details
window and select a column to import.

Note

The Import option is only available when the View By menu is set to Current Shell
Only.

Working with Generic Cost Business Processes
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The Generic Cost Manager can use generic Cost BPs as data sources. These BPs are created
in uDesigner. These generic Cost BPs work only with the Generic Cost Manager, and also only
in the context of a shell. The possible Generic cost BP types are:

• Generic: Reference against company-level commit; enforce against company-level commit
amount.

• Transfer: Transfer value from one code to another.

• Base Commit: Creates an entry in the Commitment Summary. Works in conjunction with
change commit and general spends generic Cost BPs. Reference against company-level
commit; enforce against company-level commit amount. Select Commitment Summary to
access the Commitment Summary.

• Change Commit: Works in conjunction with base commit and general spends generic
Cost BPs. Updates the Commitment Summary. Reference against company-level commit;
enforce against company-level commit amount. Select Commitment Summary to access
the Commitment Summary.

• General Spends: Works in conjunction with base commit and change commit generic
Cost BPs. Updates the Commitment Summary. Select Commitment Summary to access
the Commitment Summary.

• Lease: Works in a shell to manage lease payments and payment history.

View and edit the Commitment Summary

When a base commit record goes to Terminal status, it creates an entry in the Commitment
Summary for the shell. When change commit and general spends records go to Terminal
status, they update the associated base commit record in the Commitment Summary. If you
have the appropriate permissions, you can view and edit the Commitment Summary.

To view and edit a Commitment Summary for a shell:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Summary.

3. In the Commitment Summary log, select the Commitment Summary, and select Open.

4. From the toolbar, select Create Structure to add columns to the sheet.

5. To view or edit the sheet properties, select Edit, and then select Properties. In the
General tab, enter a unique name and an optional description. In the Options tab, enter the
following column names: Ref, Cost Code, Code Name, Breakdown, and Description.
Depending on the design in uDesigner, some columns may not display in the Commitment
Summary sheet.

6. Select OK.

Drill down from the Commitment Summary to related BPs

You can view BP information for the various entries in the Commitment Summary.

To drill down from the Commitment Summary to related BPs:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Cost Manager, and then select Commitment Summary.

3. In the Commitment Summary log, select the BP reference in the Commitment Summary.
The Cell Detail window opens.
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4. Select Close Window when you are done viewing the BP information.

Cost Manager (Standard)

The standard Cost Manager and the Generic Cost Manager work much the same way, but with
different areas in the system. This table lists the areas and the indicates which cost manager
works with each area.

The cost data from Projects/Shells (CBS) can roll up to the Company level. The cost data from
Shell (Generic) does not roll up to Company Level. For more information about the Generic
Cost Manager, see Setting Up a Generic Cost Manager.

Cost Manager Company Shell (CBS) Shell (Generic)

Cost Manager (for CBS
codes)

X X  

Generic Cost Manager   X

The Generic Cost Business Process (BP) works with the Generic Cost Manager only in the
context of a Shell. For more information about the Generic Cost Manager BP, see Working with
Generic Cost Business Processes.

There is one accounts sheet per company. There is no template for an accounts sheet. After
creation, you add columns and rows. The columns can be formulas, they can roll up data from
company cost (accounts) business processes, or they can roll up asset data, project/shell cost
data, or resource data. Adding rows to the accounts sheet creates the account codes that are
used. You must activate the account codes after adding the rows.

Optional steps:

To roll up transactions to the accounts sheet, you must create and set up company-level cost
business processes (also known as an account type business process). These BPs use
account codes rather than the CBS codes used in project/shell-level cost BPs. These are
discussed in the Business Process sections. Other options assume that you have configured
and set up an Assets Sheet (for rolling up asset data).

Rules and Rule Exceptions

The system employs a rules engine to help control costs as they roll up to the Cost Sheet. Your
administrator creates rules to work with the rules engine. For example, your administrator
might create a rule that enforces a budget limit on contracts so that invoices do not exceed the
contract amounts.

When a cost exceeds a rule, it triggers a "rule exception," and the system displays a message
that warns you of the exception. The window shows the level of the rule, an identifier, the rule
that was exceeded, the current value of the field, and the value that triggered the rule
exception.

Rule exceptions can be triggered by:

• Adding or copying a line item on the Cost Sheet

• Copying data from one column to another on the Cost Sheet

• Entering data directly into a cell on the Cost Sheet

• An email action that sends cost data to the sheet
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• An integration transaction that sends cost data to the sheet

• I-Step and S-Step business process auto-creation

• A business process record that rolls up cost data to the sheet

Some users can override a rule violation. These users are specified when the administrator
creates the rule. These users can choose to override the exception or accept it.

If you override the rule exception, the system sends your user information and any comments
you include to the audit log. If notification was specified when the rule was created, those users
who were designated will be notified by email of the override.

If you accept the rule exception (select Cancel), you will stay on the current step.

Note

The system does not display the rule exception warning if the cost data comes from an
email action, an integration transaction. If you have override control, the system will
assume that you want to override the rule and sends information to the audit log.

When your administrator creates a rule template:

• If the Include positive pendings in calculation checkbox is selected, the system adds
the positive pending values when calculating the Limit Expression.

• If the Include negative pendings in calculation checkbox is selected, the system adds
the negative pending values when calculating the Data Expression.

Note

Your administrator can check one or both options, when creating a rule template.

The rule is implemented during runtime (as a cost type BP is routed in its workflow or is Finish
Edited) and according to your choices.

Cost Rules Impacting Cost Manager

The following cost rules affect how you can work with the Cost Manager sub-modules:

• Budget

– The Budget must be greater than 0.

– This rule validates that a budget line item cannot be reduced below $0.

• Revised Budget

– The Revised Budget must be greater than or equal to Approved Commitments.

– This rule validates revised budget (approved budgets, budget transfers and budget
changes) versus approved commitments (approved contracts, change orders,
purchase orders and PO amendments).

• Invoice

– An Invoice must be less than or equal to Approved Purchase Orders and PO
Amendments.
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– This rule validates invoices (approved invoices) versus approved purchase orders
(approved purchase orders and PO amendments).

• Payment Application

– A Payment Application must be less than Approved Contracts and Change Orders.

– This rule validates approved payment applications vs approved commitments
(approved contracts, change orders).

The following actions can trigger the cost rules:

• When you attempt to send a Business Process record to the next step, whose status
activates the rule. For example, the rule may activate when a Business Process record
reaches to the Pending or Approved status.

• When you have entered the data into a Cost Sheet manually.

• Web Services calls create records.

• Records are auto-created from other records.

P6, Cost Manager, and Cash Flow

You can copy the Cash Flow curve properties that exist in a Shell template to the Cash Flow
curves that exist in instances if:

• The Shell template push is done

• The Shell template is used to create instances

To view information:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select P6 Summary Sheets.

The system uses the P6 data source that was used in the Cash Flow template as the reference
for attaining the Summary Sheet data information. To view information:

For example, if the Type in your P6 Summary Sheets is Current Schedule, then in the Cash
flow by CBS - Baseline window the Current Schedule was selected for the Use data from P6
Source field. That is, if you select data from P6 Source, along with the source and data type,
the Cash Flow template has the P6 data source as Current Schedule for your Shell template
and a new Shell is created in Unifier. The system pushes the Shell template to the new Shell
and the Cash Flow curves are generated.

When P6 and Unifier are synced, the Shell has been integrated with P6 (that is, the Type or P6
data source of the Summary Sheet is Current Schedule) and the Cash Flow data is calculated
correctly. If the distribution option selected in the Cash Flow template is a valid option for Cost
loaded Cash Flow curve, the data in Cash Flow curve is calculated correctly.

If the properties in the Cash Flow curves are incorrect, the curves display in red, in the
Properties window. You must change the Distribution, or Schedule, option if the Cash Flow
curve is opened based on the Schedule type.

If the Schedule type of the Shell is Cost- or Resource-based, in:

• The Distribution section the "Use data from P6 Source” option is enabled.

• The Schedule section the "Use dates from P6 Source” option is disabled.

If the Schedule type of the Shell is Duration-based, in:
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• The Distribution section the "Use data from P6 Source” option is disabled.

• The Schedule section the "Use dates from P6 Source” option is enabled.

See the following sections for additional information about P6 Data source:

• Adding a Baseline Curve for Cash Flow by Summary CBS or CBS

• Adding Actuals (Spends) Curve for Cash Flow by CBS Summary or CBS

• Adding a Forecast Curve for Cash Flow by CBS Summary or CBS

Document Manager
The Document Manager provides a robust platform for maintaining a wide variety of files and
documents, for example, drawings, spreadsheets, image files, specifications, and various
Microsoft Office files. Files can be stored directly in the project/shell Documents node or
organized into folders. You can also create shortcuts to commonly used files and folders. The
system ensures that all members of your team are always working on the most current
versions, and dramatically increases efficiencies by providing ready access to all documents
from anywhere at any time.

The Document Manager is available at the project/shell level for project/shell-specific
documents, and at the company level for company-specific or cross-project/shell documents.
At the project/shell or company level, the Document Manager is integrated with business
processes and the user-defined reports module. Files uploaded into the Document Manager
are stored on the Unifier file server.

The Document Manager is integrated with business processes. This means that you can
initiate a business process directly from the Document Manager and automatically attach files
and folders to it. In addition, if designed to do so, any business process can automatically
publish records, along with their comments and attachments, to the Document Manager. In
effect, this produces a detailed audit trail of the business process. Depending on how your
administrator set up the business process, it can be automatically published to the Document
Manager at a specific step in a workflow, or whenever an email notification is sent regarding
the status of the business process, or both.

At both the project/shell level and the company level, the Document Manager consists of two
nodes:

• Project or shell/Company Documents: This is the root node where published documents
(that is, documents that are ready to be used by team members) are stored and managed.
(The node is labeled project/shell Documents at the project/shell level, and Company
Documents at the company level.) You will typically work out of this node when working
with your company or project/shell documents. All uploads, downloads, revisions, markups,
and so on, are performed within this node. Access to specific folders, documents, and
shortcuts is independently controlled by permissions.

• Unpublished Documents: This is the temporary, automatic repository for files that have
been uploaded from local machines and attached to business processes, but have not yet
been published in project/shell documents or company documents. Typically, access to this
node is limited by permissions, and a designated document administrator will publish
documents from this node into the project/shell or Company Documents nodes for use by
team members.
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Note

By default, files attached to business processes are placed in the Unpublished
Documents folder in the Document Manager. A Publish Path data element can be
designed in business processes to specify the automatic publishing of documents
to a specified path and override the default.

For information about language (internationalization) and CSV files, refer to the Unifier General
Administration Guide.

Antivirus scanning of files

If you are using an Oracle Cloud-based deployment, Unifier includes a virus scanner. To
prevent virus attacks from infiltrating your system through external files, the system scans each
file that is uploaded. Until the scan is completed, the file remains in a Scan Pending state.

At a minimum, the system scans each file that is uploaded, submitted, or attached through the
following channels:

• Document Manager

• Business processes (BPs)

• Image pickers

• Cells within forms or sheets

• Custom Templates for use with custom prints and reports

• XML Localization Interchange File Format (XLIFF) files used for translation support

• Custom Help files, such as those provided through a uDesigner object

• Bluebeam sessions

• Web service GET calls

• Import of comma-separated values (CSV) or Microsoft Excel files

Depending on how your environment is configured, the following actions might occur:

• If the virus scanner detects an issue with a file that a user is uploading, the system sends
an email to the user who uploaded the file and the designated company contact.

Depending on the location of the infected file, the system might display a bug icon  (if

the system is configured to display alerts) or an ellipsis icon  (if the system is
configured to prevent the display of alerts).

• If a user tries to access or download a file that has not yet been scanned and the
environment is configured to display alerts, the system displays a confirmation message
that requires a response to continue. If a confirmation message appears, the user can wait
and try to access the file later.
For 2D files, the file is displayed if it passes the virus scan. Otherwise, a corresponding
error message is displayed if the file fails the virus scan, or the virus scan is pending.
However, although the virus scan is pending, you can view an unscanned file.

• If the virus scanner detects an issue with a file that a user is trying to view or download, an
alert is displayed that indicates the file contains a threat. Only individual files can be
rescanned. To rescan the individual file, select Yes in the alert message. In addition to the
channels listed above, you can also rescan a file from the following channels: Emails,
Notifications, and Attachments.

• If multiple files are selected for download, only the uninfected files are downloaded.
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Note

If you are using an Oracle Cloud-based Unifier deployment, see Updating
Company Settings on the Security Tab for more information about configuring the
environment to allow the display of messages regarding Scan Pending states.

Before You Begin Working with Document Manager

Ensure that you have the following defined in your user preferences.

• File Viewer option: This option affects how files are opened and viewed within the system.

• Additional software applications: Use of the AutoVue viewer markup tool requires a
license and Java installed. For translation-related information about Oracle Map, AutoVue
Server, and Flex replacement (O charts), refer to the Unifier General User Guide.

• Permission settings: Like other modules within the system, access and use of the
Document Manager is fully permission based, including for specific files and folders.
Contact your project/shell or company administrator regarding general permission access
to the Document Manager.

Note

For security, the Company Administrators can use the Security tab on the Company
Settings page to specify the type and size of files that can be uploaded by users and
per company policy. Contact your Company Administrator for more information.

Downloading AutoVue Client Certificate

Before you can use AutoVue, you must download the AutoVue Client certificate and place it in
the browser certificate exception list. Follow these instructions for each user accessing Unifier
AutoVue.

For more information, refer to the "Setup for Java Web Start AutoVue Client in HTTPS
Environments" page of the Oracle Support Knowledge tab.

Downloading on Windows

To download the localhost certificate:

1. In Unifier, select View Help menu, and then select Download Plugins.

2. From the Download page, select the download for the localhost certificate.

3. Double-click to open the localhost.cer file you just downloaded.

4. Select Install Certificate to start the Certificate Import Wizard.

5. Select the store location (Current User or Local Machine), and select Next.

6. Select the option Place all certificates in the following store, and select Browse.

7. Select the Trusted Root Certification Authorities store, and select OK.

8. Select Next, and select Finish. A dialog box opens warning you about the risk of installing
this certificate.
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9. Select Yes to accept installing this certificate.

10. After the install certificate has imported, select OK.

After installing the localhost certificate, you can use AutoVue client in Google Chrome. For
Mozilla Firefox, perform these additional steps:

1. Open a new tab and type: about:config.

2. In the Search box, type security.enterprise_roots.enabled.

3. Double-click security.enterprise_roots.enabled to set the flag to True.

For more information on installing the certificate in Mozilla Firefox (and if your Firefox version is
lower than version 49), refer to the Mozilla wiki page (https://wiki.mozilla.org): Installing
Certificates Into Firefox.

Downloading on Mac OS

To download the localhost certificate:

1. In Unifier, select View Help menu, and then select Download Plugins.

2. Double-click the downloaded localhost.cer file to add it to Keychain Access.

3. From the Keychain Access window, open the localhost certificate.

4. Expand the Trust node and set the value of the Secure Dockets Layer (SSL) field to
Always Trust.

5. Close the Keychain Access window.

Launching AutoVue Web Start Client

Windows

• Using Mozilla Firefox
The AutoVue JNLP file is automatically downloaded and a confirmation message is
displayed. Select the Open with radio button, and select OK.

To open AutoVue files automatically and bypass the confirmation message, select the Do
this automatically for files like this from now on checkbox.

• Using Google Chrome
The AutoVue JNLP file is flagged as a dangerous file extension. Each time you open an
AutoVue file, you must select the Keep option and open the downloaded file from the
Downloads folder.

Mac OS

Modify Security Settings

1. Select the Apple menu, and launch System Preferences.

2. Select Security & Privacy.

3. Select the General tab.

4. For the Allow apps downloaded from option, select Anywhere.
This option is available for Mac OS X El Capitan. For other Mac operating systems, refer to
the pertinent installation guides.

5. Select Allow From Anywhere to confirm your selection.

Launching AutoVue Files
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• Using Google Chrome
When an AutoVue file is opened a confirmation message is displayed. Select Open to
open the file in AutoVue.

• Using Safari
Open Preferences and select the Privacy tab and check the Always Allow option under
Cookies and website data. The AutoVue JNLP files are permanently saved on the disk,
you can launch the file from the Downloads folder.

About Ownership and Permissions

Like other modules, access to the Document Manager features is based on permissions set at
the module level in Admin mode. Each Document Manager node—project/shell Documents,
Company Documents, and Unpublished Documents—have separate permissions. The
Unpublished Documents node is controlled by module-level permissions in Admin mode only.

In the project/shell and Company Documents nodes, access to specific folders, documents,
and shortcuts is also independently controlled by permissions that can be set within the
Document Manager.

Note

Folder and document permissions are set at the folder level and can be changed
independently or inherited by subfolders and documents. Unlike module-level
permissions, permissions set at the folder level can differ from project/shell to project/
shell.

The creator of a folder, document or shortcut is, by default, its owner, and has full access
(privileges to view, manage, grant permissions, delete, transfer ownership, and so on). The
owner must grant other users or groups permission to view and manage these documents,
folders, or shortcuts. Otherwise, other users will not have access to them. (Exception: some
administrators will have access permissions and will be able to view all items in the document
manager.)

For this reason, it is also important to verify the permission settings for all files and folders that
you upload, create, revise, check in, copy, or modify to make sure that it is accessible by the
people who need them. For example, if one user creates folders, and then another user
attempts to move documents among those folders, the move will not be permitted by the
system unless that user attempting that move has specific permissions granted (in this case,
Copy and Delete to achieve the document move).

For more information about permission settings, see View, Add, or Modify Folder Permissions, 
View, Add, or Modify Document Permissions, and Modify Shortcut Permissions.

Note

Document Manager email notifications as set in User Preferences are only sent if the
user has at least view permission in the Document Manager node on the item
triggering the email, and if the item owner enables email notification. If you make
changes in the Document Manager root folder, to get email notifications regarding
events in the root folder, you must have at least view permission because the root
folder has no owner.
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Automatic Publishing of BP Records to the Document Manager

A business process can be designed to automatically publish its records, along with their
comments and attachments, to the Document Manager in a folder the administrator specifies
when the business process is set up. In effect, this produces a detailed audit trail of the record
information through the business process (for both workflow and non-workflow processes). You
can open these records and their information from the Document Manager.

Depending on how the administrator sets up the business process, the record information can
be automatically published to the Document Manager when the business process reaches a
specific step in a workflow, or whenever an email notification is sent regarding the status of the
business process, or both. According to its setup, the business process will publish the record
to a designated folder in the Document Manager. If you, as owner of the record, do not have
permission for this folder, the system will send the record and its contents to the Unpublished
Documents node in the manager. If the record exists in the folder, the system will publish the
record as a revision. If the folder's path in the business process record is invalid for any
reason, the record will be sent to the Unpublished Documents node.

On the Creation Step of the Workflow-type business process, the system evaluates, or
replaces, the "record_no" in the data element "uuu_dm_publish_path" or in the data element
"uuu_dm_record_info_path," when the "record_no" is used directly as part of formula, as
shown in the example below. This condition (evaluation or replacement) does not apply to the
"Advanced Formula” type data element.

Example:

Suppose 'uuu_dm_publish_path' and 'title' are defined as formula.

=> uuu_dm_publish_path = firstName + record_no + title

=> title = subject + record_no

uuu_dm_publish_path would be evaluated as 'firstName + record_no + subject' ('record_no' in
data element 'title' is ignored)

Enabling Document Manager-Generated Email Notification

As with other modules, there are events in Document Manager that can trigger email
notifications to other team members. There are three conditions that must be met for a user to
receive Document Manager emails:

• Folder Properties, Options tab: The owner or a user with modify properties permissions
on a folder can select the Send email notification to subscribed users checkbox on the
Options tab.
This option enables notifications to be generated in the first place for items in the folder.
That is, select the checkbox to notify users whenever the folder properties are modified. If
the checkbox is not selected, no emails will be generated for the folder (or subfolders
either, unless the box is selected for subfolders).

Selecting or deselecting this checkbox will automatically apply to all subfolders
automatically. This option will not override a user's email subscription selection in User
Preferences.

• Permission setting in Document Manager: A user has to be explicitly assigned at least
view permissions (at the folder or document level in the Document Manager) to the specific
folder, document, or shortcut target to subscribe to email notifications.
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For example, even if users have full access permission at the module level, they will not
get email notifications unless they are on the permission list for the folder, document, or
shortcut for which the e-mail notification would normally be generated.

• Email Subscription Preference: The user must subscribe to the Document Manager
email notifications in User Preferences.
The events that can trigger email notifications are document upload, transfer ownership,
move, delete, document revise, and folder rename.

Working with Project or Shell and Company Documents

The project/shell Documents node (in the project/shell-level Document Manager) and the
Company Documents node (in the company-level Document Manager) are the root nodes in
which published documents (that is, documents that are ready to be used by team members)
are stored and managed. You will typically work out of these nodes when working with your
company or project/shell documents. All uploads, downloads, revisions, markups, and so on,
are performed here.

Permission-based access: Similar to a shared network storage drive, access to specific
folders, files, and shortcuts is independently controlled by permissions. The user who creates a
folder or shortcut, or uploads a file, is, by default, its owner, and has full access (privileges to
view, upload, delete, download, and so on). The owner (could be the project/shell or company
administrator) can set these permissions to allow or disallow access by other team members.
For this reason, it is important to verify the permission settings for all files or folders of which
you are the owner to make sure that they are accessible by the people who need them.

Editing and version control: The project/shell Documents and Company Documents nodes
have check-in and check-out, document lock, and revision history capabilities enabling full
version control.

Use with business processes: The Document Manager is integrated with business
processes. You can initiate a BP from directly within the Document Manager and automatically
attach selected files and folders.

Reporting: In addition, document and folder properties are associated with data elements, and
are therefore fully reportable through user-defined reports.

Note

The Document Manager does not support multibyte or Unicode characters in file
names.

Accessing Project or Shell Documents and Company Documents

To access project or shell documents:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

To access company documents:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Company Documents.
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Navigating Document Manager

The following explains the options that are available in both the company level and the project/
shell level Document Manager grouping node.

Navigating to Company Documents in Document Manager

1. Go to the Company Workspace tab, and switch to User mode

2. In the left Navigator, select Document Manager.
The following functional nodes appear under the Document Manager grouping node:

• Company Documents

• Unpublished Documents

Navigating to Project/Shell Documents in Document Manager

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager.
The following functional nodes appear under the Document Manager grouping node:

• Documents

• Unpublished Documents

Note

Navigation in the Document Manager grouping node works the same way at
the company level and the project/shell level, when in User mode, as
explained below.

The documents log (for both the Company Workspace and the project/shells) displays the
contents (subfolders, documents, empty documents, shortcuts) of the folder selected. If you
are viewing the log using Tree View, you can select the plus sign (+) next to the folder name to
expand it and reveal subfolders, or you can select the minus sign (-) to collapse the structure. If
you are using Tree View, you can also hover over a folder to view the number of subfolders
and documents under it.

Note

If you are using a custom user mode navigator, you must add the Recycle Bin to the
navigator.

Navigating to Company Documents in Document Manager

The following functional nodes appear under the Document Manager grouping node in your
Company Workspace (User mode):

• Company Documents

• Unpublished Documents
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Company Documents

When you select Company Documents, the Company Documents page opens. This page is
divided into two panes, Company Documents log on the left and Properties on the right.

The Company Documents log displays:

• Categorized list of available company documents and folders

• Navigational element, as in locator links (or breadcrumbs)

• Toolbar (for details, see below)

• Columns (for details, see below)

Properties (right pane) displays the following tabs:

• Properties tab

• Audit Log tab

• Permissions tab

• Options tab

The following explains the Company Documents toolbar options:

Create

This option lets you create any of the following:

• Folder
When you select this option, the Create Folder window opens. This window has the
following tabs:

– Properties tab
In this tab, you can provide a name and a description for the new folder. You can also
select the owner's name (the read-only Owner field) and view the owner's user profile.

Use the Save option to save your input.

Use the Save & Create New option to save your input and create the folder, which will
be added to the categorized list of available company documents and folders (in the
Company Documents window).

Select Cancel to discard your changes and close the window.

– Options tab
In this tab, you can set the folder upload conditions, folder download conditions, and
notification preference.

Use the Save option to save your input.

Use the Save & Create New option to save your input and create the folder, which will
be added to the categorized list of available company documents and folders (in the
Company Documents window).

Select Cancel to discard your changes and close the window.

• Empty Document
When you select this option, the Create Document window opens. This window has the
following tabs:

– Properties tab
In this tab, you can provide a name, a description for the requester, and a general
description for the new document. In addition, you can enter or select information that
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is related to the empty document. That is, you can select an action discipline (for
example, Architecture, Construction, Design, Planning, and so on), enter the cost
center number, title or tenure, city, and select the acquisition year.

Use the Save option to save your input.

Select Cancel to discard your changes and close the window.

– Options tab
In this tab you can set the document revision option (Revisions must have same file
name).

Use the Save option to save your input.

Select Cancel to discard your changes and close the window.

• Business Process
When you select this option, the New Record (BP record) window opens, which lets you
create a BP record. In the New Record window, you must select a BP from the Select
Business Process drop-down field. If the BP record that you select is a workflow BP, the
system activates the Select Workflow drop-down field, and you must select a type of
workflow for the BP record.

When finished, select Create to create the record.

Select Cancel to discard your changes and close the window.

Actions

The Actions option has the following suboptions:

• Add to Favorites
Use this option to add a selected file or folder to your favorite list.

• Move
Use this option to move the selected file or folder into another folder.

• Copy
Use this option to create a copy of the selected file or folder.

• Delete
Use this option delete the selected file or folder.

• Send for E-Signature
Use this option to send a document to another Unifier user or to an External User for an
electronic signature.

• Recall E-Sign Request
Use this option to rescind a request for an electronic signature from users who have not
responded to the original request.

• Transfer Ownership
Use this option to change the owner assigned to the document or folder.

• Edit
The Edit option lets you perform the following operations on the file or folder:

– Revise
When you select this option, the Upload window opens which contains a list of files or
folders that are available for edit, and provides additional information related to the
files or folders that are listed.

If you do not see the file or folder that you want to edit in this window, you can search

for that file or folder by selecting , selecting Browse , and conducting a search.

– Check In
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Use this option to check in a file or folder. You can only select a checked-out item.

– Check Out
Use this option to check out a file or folder. If you select more than one item, the
system creates a zip folder that contains all the selected items.

– Cancel Check Out
Use this option if you changed your mind about checking out an item. This option lets
you avoid checking the checked out item and prevents unnecessary versioning.

– Lock
Use this option if you want to lock a document. This option is only for documents.

– Unlock
Use this option if you want to unlock the item that was locked.

• Export
Use this option to export the Structure and Properties of a selected item to a Microsoft
Excel (XLSX) file or a comma-separated values (CSV) file.

• Import
Use this option to import an existing Folder Structure Template from within the system or
the Structure and Properties of a selected item from a Microsoft Excel (XLSX) file or a
CSV file.

• Permissions
When you select this option, the Permissions window opens, which lets you select one of
the following options:

– Inherit from parent folder <name of parent folder>

– Assign new permissions

When you select the items that you want to assign permissions to and you select Inherit
from parent folder <name of parent folder>, you cannot edit the selected items.

– Inherited Permissions

– Select View, and select users, groups, or both.

– Find on page

When you select the items that you want to assign permissions to and you select Assign
new permissions, you can start from a blank permission window, or you can copy the
existing permissions of the parent folder and use it as a template.

– Add, by way of copying, parent folder permissions to the manual permissions
available. In case of conflicts, the parent folder permissions will override.

– Select from the User and Group Picker

– View users, groups, or both

– Find on Page

• Index Report
Applicable only to folders. This option lets you generate a report of the files that are in the
folder that you have selected, in the following formats:

– HTML Format

– PDF Format

– CSV Format

• View Import Audit Log
To view detailed information about the CSV or Microsoft Excel import process that was
used to create or update the structure and properties of the selected folder or files, select
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this option. The Status information displayed in the log includes an indication of whether
the import process failed, completed, or was partially completed.

Flat View 

This option displays all documents in the standard structure of all other logs. Selecting a folder
opens another log that displays all the files inside the folder. You can navigate back out of the
folder using the breadcrumb trail at the top of the log.

Tile View 

This option displays all documents as tiles with a preview of the file. Files and folders are
grouped together in two separate collapsible sections.

Tree View 

This option displays all documents in the standard structure of all other logs, but you can use

the plus  and minus  icons next to each folder to expand and collapse folders and display
all files contained within.

Download 

Use this option to save a copy of selected files to your computer.

Upload 

Use this option to add new documents to the Document Manager from your computer.

View

Use this option to filter records based on specific criteria, such Owned by me and Checked
out by me.

You can add and manage your own views with the Create New View and Manage Views
options.

Edit View 

Use this option to change the selected view. Use the arrow buttons to move columns between
the Available Columns list and the Selected Columns list. All columns in the Selected
Columns list will be visible.

Refresh 

Use this option to refresh the log and view any newly uploaded documents.

Favorites 

Use this option to view a list of documents with favorite status. You can use the Find on Page
option to filter for specific documents, or you can use the Delete option to remove a document
from your favorites list.

Initiate Bluebeam Studio Session 

Use this option to start a Bluebeam Studio Session on a selected PDF file.

Search 

Use this option to search for specific items by entering key words in the search box. Use the
drop-down menu to select which column should contain the key word.
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Find on Page 

Use this option to find items on the displayed page. When you select this option, the system
inserts a row that lets you enter filter parameters.

Expand All  or Collapse All 

This will open or close all folders, displaying all the files contained in each folder. This option is
available only when the Tree View option is selected.

The following explains the properties (right pane) elements:

Properties tab

Use this tab to edit the properties of selected files or folders. You can only edit files and folders
for which you are the owner.

Linked Records tab

After you begin the process of creating a line item, you can link the line item to a business
process record in the Linked Records tab. This tab is only available after you save the record.
Use this tab to see information such as the Record Number and Status.

Audit Log tab

Use this tab to view all changes to the selected document. You can use the Print option to print
the Audit Log, or you can use the Find on Page option to find a specific entry by filtering
column information.

Permissions tab

Use this tab to view what permissions are available for selected users or groups.

Options tab

Use this tab to configure the Folder Upload and Folder Download options available for the
selected folder. If you are working with a file, under the Document Revisions block, select the
Revisions must have same file name option if you want revised documents to keep the
same file name.

Unpublished Documents

For details, see Unpublished Documents.

Navigating to Project/Shell Documents in Document Manager

The following functional nodes appear under the Document Manager grouping node, in your
project/shell:

• Documents

• Unpublished Documents

Documents

When you select the Documents functional node, the Documents page opens. This page is
divided into two panes, Documents log on the left and Properties on the right.

The Documents log displays:

• Categorized list of available project/shell documents and folders
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• Navigational element, as in locator links (or breadcrumbs)

• Toolbar (for details, see below)

• Columns (for details, see below)

Properties displays the following tabs:

• Properties

• Audit Log

• Permissions

• Options

The following explains the project/shell documents (left pane) toolbar options:

Create

This option lets you create any of the following:

• Folder
When you select this option, the Create Folder window opens. This window has the
following tabs:

– Properties tab
In this tab you can provide a name and a description for the new folder, and you can
select a category and phase. You can also select the owner's name (the read-only
Owner field) and view the owner's user profile.

Use the Save option to save your input.

Use the Save & Create New option to save your input and create the folder, which will
be added to the categorized list of available project/shell documents and folders (in the
Documents window).

Select Cancel to discard your changes and close the window.

– Options tab
In this tab you can set the folder upload conditions, folder download conditions, and
notification preference.

Use the Save option to save your input.

Use the Save & Create New option to save your input and create the folder, which will
be added to the categorized list of available project/shell documents and folders (in the
Documents window).

Select Cancel to discard your changes and close the window.

• Empty Document
When you select this option, the Create Document window opens. This window has the
following tabs:

– Properties tab
In this tab, you can provide a name, a description for the requester, and a general
description for the document that you have created. In addition, you can enter or select
information that is related to the empty document that you are creating. That is, you
can select an action discipline (for example, Architecture, Construction, Design,
Planning, and so on), enter the cost center number, title or tenure, city, and select the
acquisition year.

Use the Save option to save your input.

Select Cancel to discard your changes and close the Create Folder window.
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– Options tab
In this tab, you can set the document revision option (Revisions must have same file
name).

Use the Save option to save your input.

Select Cancel to discard your changes and close the window.

• Business Process
When you select this option, the New Record (BP record) window opens, which lets you
create a BP record. In the New Record window, you must select a BP from the Select
Business Process drop-down field. If the BP record that you select is a workflow BP, the
system activates the Select Workflow drop-down field, and you must select a type of
workflow for the BP record.

When finished, select Create to create the record.

Select Cancel to discard your changes and close the window.

Actions

The Actions option has the following suboptions:

• Add to Favorites
Use this option to add a selected file or folder to your favorite list.

• Move
Use this option to move the selected file or folder into another folder.

• Copy
Use this option to create a copy of the selected file or folder.

• Delete
Use this option delete the selected file or folder.

• Send for E-Signature
Use this option to send a document to another Unifier user or to an External User for an
electronic signature.

• Recall E-Sign Request
Use this option to rescind a request for an electronic signature from users who have not
responded to the original request.

• Transfer Ownership
Use this option to change the owner assigned to the document or folder.

• Edit
The Edit option lets you perform the following operations on the selected file:

– Revise
When you select this option, the Upload window opens, which contains a list of files or
folders that are available for edit, and provides the following details related to the files
or folders that are listed, under the following columns:

* File Name

* Revise File Name

* File Size

* Document Title

* Revision No

* Issue Date
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If you do not see the file that you want to edit in this window, you can search for it by

selecting  , selecting Browse, and conducting a search.

– Check In
Use this option to check in a file or folder. You can only select a checked-out item.

– Check Out
Use this option to check out a file or folder. If you select more than one item, the
system creates a zip folder that contains all the selected items.

– Cancel Check Out
Use this option if you changed your mind about checking out an item. This option lets
you avoid checking the checked out item and prevents unnecessary versioning.

– Lock
Use this option if you want to lock a document. This option is only for documents.

– Unlock
Use this option if you want to unlock the item that was locked.

• Export
Use this option to export the Structure and Properties of a selected item to a Microsoft
Excel (XLSX) file or a comma-separated values (CSV) file.

• Import
Use this option to import an existing Folder Structure Template from within the system or
the Structure and Properties of a selected item from a Microsoft Excel (XLSX) file or a
CSV file.

• Permissions
When you select this option, the Permissions window opens which lets you:

– Select one of the following options:

* Inherit from parent folder <name of parent folder>

* Assign new permissions

When you select the items that you want to assign permissions to and you select the
Inherit from parent folder <name of parent folder> option, you cannot edit the
selected items.

* Inherited Permissions

* Select View, and select users, groups, or both.

* Find on page

When you select the items that you want to assign permissions to and you select
Assign new permissions, you can start from a blank permission window, or you can
copy the existing permissions of the parent folder and use it as a template.

* Add, by way of copying, parent folder permissions to the manual permissions
available. In case of conflicts, the parent folder permissions will override.

* Select from the User and Group Picker

* View users, groups, or both

* Find on Page

• Index Report
Applicable only to folders. The Index Report option lets you generate a report of the files
that are in the folder that you have selected, in following formats:

– HTML Format
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– PDF Format

– CSV Format

• View Import Audit Log
To view detailed information about the CSV or Microsoft Excel import process that was
used to create or update the structure and properties of the selected folder or files, select
this option. The Status information displayed in the log includes an indication of whether
the import process failed, completed, or was partially completed.

Flat View

This option will display all documents in the standard structure of all other logs. Selecting a
folder will open another log that displays all the files inside the folder. You can navigate back
out of the folder using the breadcrumb trail at the top of the log.

Tile View

This option will display all documents as tiles with a preview of the file. Files and folders are
grouped together in two separate collapsible sections.

Tree View

This option will display all documents in the standard structure of all other logs, but you will be
able to expand and collapse folders to display all files contained inside the folder. Use the plus

 and minus  icons next to each folder to expand or collapse the folder.

Download

Use this option to save a copy of selected files to your computer.

Upload

Use this option to add new documents to the Document Manager from your computer.

View

Use this option to filter records based on specific criteria, such as Owned by me and Checked
out by me.

You can add and manage your own views with the Create New View and Manage Views
options.

Edit View

Use this option to change the selected view. Use the arrow buttons to move columns between
the Available Columns list and the Selected Columns list. All columns in the Selected
Columns list will be visible.

Refresh

Use this option to refresh the log and view any newly uploaded documents.

Favorites

Use this option to view a list of documents with favorite status. You can use the Find on Page
option to filter for specific documents, or you can use the Delete option to remove a document
from your favorites list.

Initiate Bluebeam Studio Session

Use this option to start a Bluebeam Studio Session on a selected PDF file.

Search
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Use this option to search for specific items by entering key words in the search box. Use the
drop-down menu to select which column should contain the key word.

Find on Page

Use this option to find items on the displayed page. When you select this option, the system
inserts a row that lets you enter filter parameters.

Expand All/Collapse All

This will open or close all folders, displaying all the files contained in each folder. This option is
available only when the Tree View option is selected.

The following explains the properties (right pane) elements:

Properties tab

Use this tab to edit the properties of selected files or folders. You can only edit files and folders
for which you are the owner.

Audit Log tab

Use this tab to view all changes to the selected document. You can use the Print option to print
the Audit Log, or you can use the Find on Page option to find a specific entry by filtering
column information.

Permissions tab

Use this tab to view what permissions are available for selected users or groups.

Options tab

Use this tab to configure the Folder Upload and Folder Download options available for the
selected folder. If you are working with a file, under the Document Revisions block, select the
Revisions must have same file name option if you want revised documents to keep the
same file name.

Unpublished Documents

For details, see Unpublished Documents.

Display Folders by Project or Shell Phase

The following is only applicable to the project/shell Document Manager.

A project/shell document folder can be associated with one or more project/shell phases. This
will make the document folder accessible only during specific phases of a project/shell and
helps ensure that important phase-specific documents are visible at the appropriate times,
during the life cycle of the project/shell.

Example

If a folder or subfolder is associated with the construction phase of a project/shell, the folder or
subfolder will appear in the project/shell documents folder view (project/shell Documents log)
for that project/shell only when the project/shell is in that phase.

If a phase has not been designated on a folder or subfolder, the folder or subfolder will display
for all project/shell phases.

The folder phase is designated in the Phase selection box in the folder Properties window.
The project/shell phase is maintained in the project/shell Properties window, by a project/shell
administrator.

Chapter 1
Document Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 346 of 671



You have the option to either view folders for the current project/shell phase, or you can
choose to view all folders regardless of project/shell phase.

To display folders by current phase:

1. Access the project/shell Document Manager grouping node, and select the Documents
functional node.

2. From the toolbar, select View, and select Current Phase.
The folders and subfolders that have been associated with the current phase of your
project/shell, as well as the folders and subfolders that have no specific phase designation,
will be displayed.

The folders and subfolders that have been associated with a different project/shell phase
will not display.

To display folders for all project/shell phases, select the View drop-down menu and select
All. This will display all folders, regardless of project/shell phase.

Working with Document Manager in Company and Project or Shell

Navigating to Document Manager at the company level:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, expand the Document Manager node.

Navigating to Document Manager at the project/shell level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, expand the Document Manager node.

In general, the following nodes appear under the Document Manager node at the company or
project/shell levels:

• Documents (or Company Documents)

• Recycle Bin

• Unpublished Documents

The project/shell Documents log and Company Documents log display attributes about the
documents and folders listed in them.

Project/Shell Documents

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log.

Company Documents

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Company Documents
to open the Company Documents log.

The log can be designed in uDesigner if the folder and document properties have been
designed.
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Note

• The log used in your Document Manager may vary.

• You may need to use the horizontal scroll bar to view all the columns.

The following shows the default display of the project/shell Documents log and Company
Documents log.

Documents log or Company Documents log

The Documents log or the Company Documents log is divided into two left and right panes.
The following explains each pane.

The Documents log or the Company Documents log left pane has the following toolbar
options:

Toolbar Description

Create Enables you to create:
• Folder
• Empty Document
• Business Process

Note

The options above are
available if you select All for
the View toolbar option.
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Toolbar Description

Actions Lets you conduct the following actions on multiple files
or folders:
Add to Favorites
Move
Copy
Delete
------------------------------------
Send for E-Signature
Recall E-sign Request
------------------------------------
Transfer Ownership
Edit
• Revise
• Check In
• Check Out
• Cancel Check Out
• Lock
• Unlock
------------------------------------
Export
• Structure and Properties (CSV)
• Structure and Properties (Excel)
------------------------------------
Import
• Folder Structure Template
• Structure and Properties (CSV)
• Structure and Properties (Excel)
------------------------------------
Permissions
------------------------------------
Index Report
• HTML Format
• PDF Format
• CSV Format
------------------------------------
View Import Audit Log

Flat View Lets you see a flat list (default view) of all files and
folders, located in the root (Project Documents) folder.
To browse a folder in this view, double-click the folder
name. This opens the contents of that folder in the log.
When you select a file or folder, the relevant tabs open
on the right pane, which let you define the file or folder
properties, permissions, and so on.

Tile View To change the views between list, tile, and tree views.

Tree View To change the view of folders and documents. You can
open any number of folders in the hierarchy and view
their contents in the same view.

Download To download documents or folders onto your local or
network drive.
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Toolbar Description

Upload To upload files from your local system into the project/
shell or company-level Document Manager.

View To customize the Documents log to display files based
your filter criteria. See Working with DM Log Views.

• All
• Owned by me
• Checked out by me
• Locked
• Uploaded in last 7 days
• Uploaded in last 30 days
• Current Phase
• Create New View
• Manage Views

Edit View To change the log view (columns, filters, sort, and so on).

Refresh To refresh the items on the log.

Favorites To view the favorites list.

Initiate Bluebeam Studio Session To initiate a Bluebeam Studio Session. For details about
Bluebeam, refer to the Unifier Bluebeam User Guide.

Search To open the search window and search for a specific
document. See Searching Content.

Find on Page To find an item on the page or log. See Finding on Page.

Next to each item on the log (next to a folder, subfolder, document, shortcut, or empty

document), there is a gear menu ( ). The gear menu for each document is explained below:

Note

The following menu options change for empty documents.

Option Description

Open To open a file in the default File Viewer.
Open in AutoVue To open the file in AutoVue.
Download To download a file.
Add to Favorites To add the item to the list of favorites.
Create To create a file based on a business process.
Actions Lets you perform the following on a file:

• Revise
• Check Out
• Check In
• Cancel Check out
• Lock
• Unlock

Transfer Ownership To transfer the ownership of the file.
Move To open the Move window and move the file to the

destination folder.
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Option Description

Copy To open the Copy window and copy the file to the
destination folder and include comments.

Delete To delete the row or item.

The gear menu ( ) for each folder is:

Option Description

Create To create a folder.
Upload To upload folder.
Download To download folder.
Add to Favorites To add the folder to the favorites list.
Move To open the Move window and move the folder.
Copy To open the Copy window and copy the file to the

destination folder and include comments.
Delete To delete the row or item.

The gear menu ( ) for each PDF is:

Option Description

Self-sign To sign the PDF.
Send for E-Signature To send for E-signature.
Initiate Bluebeam Studio Session To initiate a Bluebeam Studio Session. For details about

Bluebeam, refer to the Unifier Bluebeam User Guide.

The Documents or Company Documents left pane has the following columns:

Column Description

Name The name of the document or folder.
Comments Comments associated with a file.
Envelope Code If you are using envelopes in DocuSign or Acrobat Sign

and a document or group of documents was submitted
for an e-signature request, this column displays the code
assigned to the envelope that contains the applicable
documents. If an envelope is resubmitted for signatures,
the code is overwritten with a new code.

Lock Indicates whether the file is locked or not.
Bluebeam Session Status Indicates the status of the document in the Bluebeam

studio session.
References Any references included in the file.
Linked Records (BP) Any linked records included in the file.
Title The file title.
Creation Date Creation date.
Issue Date Date that the file was issued.
Owner The owner of the file.
Revision No. If the file has been revised, the revision number appears

here.
Pub No. Publication number.
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Column Description

% Complete The status of a file.
Size The size of the file.
Upload By The name of the user who has uploaded the file.
Upload Date The date that the file was uploaded.
Location The location of the file.
Discipline The selected discipline.
Document Status Current state of the document.

The Documents or Company Documents right pane has the following tabs:

Tab Description

Properties Displays detailed information about a selected item on
the log (left pane).

Linked Records This tab only applies to Documents.
Displays the information about records that are linked
to the file.

Audit Log Displays the actions that have been taken on an item,
with details. You can print the audits or search for a
particular audit.

Permissions Displays the name of the users or groups that are
permitted to work on the selected item, and the
permission type.

Options Displays the type of options available for each item
selected.

Recycle Bin

Lists all files that have been deleted along with details about each deleted file. You can use the
following toolbar options to restore deleted files, search among deleted files, or permanently
delete the deleted files:

• Restore

• Restore All

• Delete

• Empty Recycle Bin

• Find on Page

Unpublished Documents

Lists all unpublished documents and provides details on each one. You have the option to

publish or download documents on the Unpublished Documents log. The gear menu ( ) for
each file lets you conduct the following operations on a selected file.

• Open

• Open in AutoVue

• Publish

• Download
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The Unpublished Documents node log is divided into two panes. The left pane provides a list
of unpublished documents, and the right pane provides details on each document in the
following tabs:

• Properties

• Linked Record

Working with DM Log Views

Use the View drop-down list to customize the Document Manager log to display files based
your filter criteria. You can use the following pre-defined views or create your own view:

• All

• Owned by me

• Checked out by me

• Locked

• Uploaded in last 7 days

• Uploaded in last 30 days

• Create New View

• Manage Views

If the option DM View is available, it lets you see the views defined in Log views, in Document
configuration, at runtime. In such a scenario, you can only see the active views at runtime, and
you can see all active views pertaining to the Documents log, if you have permission to
access to the DM log.

You cannot modify the view names "All" and "Current Phase" of the View option.

To create a view:

1. Go to your Documents log.

2. Select View, and select Create New View to open the New View page.

3. On the New View page, enter a name for your new view under the field Save View As.

4. In the Columns tab, select columns that you want to display.

5. Select the columns that you want to remain static on the page from: Lock after selected
Column drop-down list.
In addition to arranging the columns, you can go to the Filters, Group By, and Sort By
tabs to customize the new view by applying more refined selections.

6. Select Save to create your new view.

Your new view appears in the View list.

Note

Avoid defining a view with no columns selected.

To manage your views:

1. Go to your Documents log.
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2. Select View, and select Manage Views to open the Manage Views window.
Use the Manage Views to create, delete, or hide views within any log. In addition, you can
reorder views by dragging and dropping them in the Manage Views window.

3. When finished, select Apply.

Your arrangement appears in the View drop-down list.

To edit or delete an existing view:

1. Go to your Documents log.

2. Select Edit View ( ).

Note

If you modify the view and do not save the changes, the system keeps the existing
name and adds the word "Modify" to the existing name.

3. Edit the view of the following elements on your log:

• Columns

• Filters

• Group By

• Sort By

4. Select Apply when you have finished editing.

Using the DM Log Tile View

The Tile view lets you view files and folders as thumbnails. All folders and files are grouped
separately, you can expand and collapse each group. The Tile view only show the immediate
children of the folder.

When a file is selected, the right pane displays all the information tabs. The gear menu ( )
lets you act on an individual file or folder. The folder and file names are hyperlinks, you can
select the hyperlink to open a folder or file.

To use the tile view, from the Document Manager log, select  Tile View. To switch to list

view, select  List View.

Searching Content

When a search is initiated by typing text in the search box, the system displays suggested
areas to search in. Some of these suggested areas are system-defined (such as: Content or
Linked Records) and others can be defined by the user in the Document Manager attribute
form Log, in uDesigner. The user can configure to search on any attribute of a document
including text, drop-down, numeric, or date type attributes.
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Note

The default elements and fields (log layout, view, search, and so on) that are defined
in the Standard Log, in uDesigner, determine the Standard user interface elements
and fields of all logs.

After selecting the areas you want to search in, the system displays a filtered list based on your
search criteria. In addition, you can also use the quick filters to further refine your search
criteria.

From within the search result screen, you can choose to open, download, create a business

process record, or go to the folder by selecting the options under the gear menu ( ). The
following menu and toolbar options are displayed on the Search pages.

Menu and Toolbar Options Description

Create Lets you create a business process. Select a business
process and workflow, and select Create.

Download To download a file.

 Tile View

 List View

To view the search results in Tile View or List View.

 Find on Page Lets you find a file on the page.

Select one of the following options: Open, Open In
AutoVue, Download, Create and then select Business
Process, or Go to Folder.

To search the document log:

1. Select Search  .

2. Enter one or more keywords.

3. Select the areas you want to search in, for example Content, Linked Records, and so on.

4. Select Search. The search results are displayed.

5. From the quick filters displayed on the left pane, select filters to further narrow your search.

6. To change the area you want to search in, or to include multiple search areas, select
Change.

7. Select  Add New Condition to add additional search areas. Use  Delete to remove
search areas.

8. Select if you want the search results to display only if it matches all or any of the search
criteria by selecting Match All or Match Any.

9. Select Search. The search results are displayed.

Note

The search bar is not case-sensitive. Accented characters and wild card searches
are not supported.
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Finding on Page

The Find on Page  option lets you find items on the displayed page.

1. Select Find on Page. The system inserts a new row that lets you enter your search
parameters.

2. Enter your search parameters.

The system displays a list of files, folders, subfolders, or shortcuts that match the criteria you
entered.

If you decide to cancel the find for one of the cells, you must remove the parameters that you
have entered. If you decide to cancel the find for an entire row, you must select Find on Page

 .

Sorting Columns

You can sort columns in the Document Manager (DM) Log and the Search Results page. The
View menu is prefixed with the word Modified if the sort is applied to the columns.

To sort columns, select the up and down arrows next to the column name.

Creating and Managing Folders

If you have proper permissions, you can create any number of folders and subfolders to
organize documents and shortcuts. Folders can be created in various ways:

• Manually create a folder.

• Upload folders from your local machine.

• Import folders from a CSV file.

• Create folders in a project/shell template (Admin mode). When a new project/shell is
created from the template, the folder structure will be copied.

• Import a folder structure from a folder structure template.

Note

You must have permission to create or modify folders to perform the following
procedures.

View Folder Contents

To view folder contents:

In the folders view, select a folder. The contents of the folder appear in the project/shell or
Company Documents log. If a folder has a plus sign (+), select it to reveal subfolders.

About Locked Folder Structures
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The document administrator (the project/shell or company administrator or other designated
user with full administrative permissions) has the ability to lock the first-level folder structure.
First level refers to folders and documents directly under the root folder. It does not refer to the
sub-folders within the first-level folders.

Locking the first level folder structure prevents other users from adding, modifying, or deleting
folders and documents on the first level, or changing the document or folder properties. Users
can modify permissions on first-level folders and documents.

This ability allows the administrator to establish and maintain a consistent main folder structure
within and across project/shells.

Locked Folder Structure

To check if the first-level folder structure is locked:

1. Open the Document Manager.

2. In the left Navigator, select Documents or Company Documents.

3. Select the first level folder in the Document Manager log.

4. From the right pane, select the Options tab. If the Lock first level folder structure below
Project Documents or shell Documents checkbox is selected, the first-level folder
structure is locked.

Create a Folder

You can create a folder at the root level of the project/shell or Company Documents nodes, or
within any existing folder. You can also create several folders within the same parent folder.

When you create a folder, you become its owner by default and have full read, write, and edit
privileges. For other users to access the folder and its contents, you must grant permission. It
is recommended that you understand the permissions settings before creating folders.

You can create multiple folders within the same parent folder, and these folders can share
similar properties.

Folder names cannot include the following special characters: / \ : * ? " < > |

Note

First-level folders might be locked by a document administrator. This restriction
prevents changes or additions to folders directly under the project/shell or Company
Documents nodes, preserving the main folder structure. However, subfolders can still
be created within existing folders.

To create a folder:

1. Select the folder in which you want to create another folder, or select the project/shell or
Company Documents root node.

2. From the toolbar, select Create, and then select Folder.
The Create Folder window opens. This window is identical to the Folder Properties
window, which can be viewed for existing folders.

3. In the Properties tab, enter values in the editable fields.
The other fields are system-defined or optional.
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4. Select the Options tab, and select the applicable options.

5. Choose one of the following:

• To create a single folder, select Save. The folder is created, and the Create Folder
window closes.

• To create another folder in the same parent folder, select Save & Create New. Repeat
steps 3 through 5.

• To cancel the creation of a folder, select Cancel.

Folder Properties Window

To open the Folder Properties window:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

3. Select a folder.

When you select a folder, the right pane displays the following tabs:

• Properties

• Audit Log

• Permissions

• Options

If a data element in the right pane contains a tooltip (a description of the field), a question mark
(?) symbol appears next to that field. When you hover over the question mark, the tooltip
appears.

Folder Properties Window (Properties Tab)

The Properties tab has several fields that are categorized under the following blocks:

• General

• Other

General

In this field Do this

Name This always appears at the top and is required. For the
project/shell Documents or Company Documents root
folder, this is not editable.

Location The folder location within the project/shell Documents
node. "/" indicates the project/shell Documents root
folder.

Owner The name of the folder creator or current owner. Select
to view the user profile.

Creation Date The date that the folder was created.
% Complete This is a calculated field derived from the overall

percent complete of all documents within the folder. The
% Complete for documents is maintained manually in
the Document Properties window.

Description You can enter an optional description for the folder.
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Other

In this field Do this

Categories
(applicable to project-level Document Manager only)

Project administrators can group folders into
customized categories. You cannot use Find to search for
Category designations, but you can include them in a
report (user-defined reports). This field is not present at
the company level.

Phases
(applicable to project/shell level Document Manager
only)

In the project/shell level Document Manager, a folder
can be associated with one or more project/shell phases,
making it accessible only during those phases of the
project/shell. This helps ensure that important, phase-
specific documents are visible at the appropriate times
during the life cycle of the project/shell. Click Select and
select one or more phases.
The Phase setting controls the visibility of folders. For
example, if the project/shell administrator sets the
project/shell phase to conceptual design, only those
folders tagged with the phase conceptual design, as well
as those without a phase tag, will be visible during that
phase. If you do not specify a phase, the folder will
display during all project/shell phases.

Folder Properties Window (Permissions Tab)

The Permissions tab has several fields that are categorized under the following blocks:

• Inherit permissions from the parent folder
This option is not available for folders or files that do not have a parent folder (that is, are
located at the root).

This option has the following are the two blocks:

– User Name or Group Name
A selection section on the left. You can enter in the field (picker). Alternatively, you can
select an option to open a user or group picker, select one or more users or groups,
and add your selections. When you select users or groups, an expanded list of
selected users or groups appears.

If there are both users and groups, the first group is displayed as selected by default.
The permissions are in the right section.

If there are no groups, but users only, the first user is displayed as selected by default.
The permissions are in the right section.

You can delete any of the existing or saved permissions.

Usernames shows the user's profile picture next to the user name. Also, the user Title
(from user's Unifier profile) is displayed below the user name.

– Document Permissions
A definition section on the right. This section displays a list of all folder or file
permissions. If the option "Inherit permissions from the parent folder" is selected, this
section will become read-only. You can edit the contents of this section only when the
option "Inherit permissions from the parent folder" does not exist (for root level files or
folders), or if the option "Inherit permissions from the parent folder" is selected.

When you select multiple files (from the Documents log in the Document Manager),
the right pane displays the following tabs:
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Revisions tab: The Revisions tab is not available if more than one file has been
selected in the DM. This tab is displayed only if the document has revisions.

Permissions tab

Options tab: Revisions must have same file name

Audit Log tab: Print, Export To CSV, and Export to Excel.

• Selected Users/Groups

• Folder Permissions

• Document Permissions

• Apply these permissions to documents and sub-folders

Folder Properties Window (Audit Log Tab)

The Audit Log tab has a tabular log that displays the following information:

• Date

• Event

• Action

• Field Name

• Old Value

• New Value

• User Name

• Proxy User

Folder Properties Window (Options Tab)

The Options tab has several fields that are categorized under the following blocks:

• Folder Upload

– Upload files only: Default selection; when a folder is selected for upload, only the files
within it are uploaded, not the folder itself.

– Upload folders and files: Allows uploading of both files and folders.

– Apply these options to all sub-folders: If you select this option for the current folder,
all new and existing subfolders and documents within the folder will be modified when
the window is saved.

• Folder Download

– Download files only: Default selection; when a folder is selected for download, only
the files within it are downloaded, not the folder itself.

– Download folders and files: Allows downloading of both files and folders.

– Apply these options to all sub-folders: If you select this option for the current folder,
all new and existing subfolders and documents within the folder will be modified when
the window is saved.

• Send email notification to subscribed users: Select this box if you want the owner to
receive an email notification whenever the folder properties are modified. If you select or
deselect this box on a folder, the checkbox will update on all subfolders automatically. This
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option will not override users' email subscription selections in user preferences. Users also
have to have at least view permissions on the specific folder or document to get the
notification.

Lock folder structure for the first level below project or shell Documents: This option
appears only for the root project/shell Documents folder. It disallows the addition, modification,
or deletion of any first-level folder: folders that are directly under the project/shell Documents
node. Subfolders can still be added to the first-level folders. The administrator can unlock the
structure to change first-level folders if necessary.

View or Modify Folder Properties

You can view or modify (with proper permissions) the folder properties of existing folders.
When you create or upload a folder, you become its owner and have full access to the folder
and its contents.

To view folder properties:

1. From the project/shell or Company Document log, select any folder or subfolder, or the
project/shell or Company Documents root folder.

2. From the right pane, select the Properties tab.
The folder properties are displayed in the right pane.

To modify folder properties:

1. From the project/shell or Company Document log, select any folder or subfolder, or the
project/shell or Company Documents root folder.

2. From the right pane, select the Properties tab.

3. Make your changes and select OK.

View or Modify Folder Options

To view folder options:

1. From the project/shell or Company Document log, select any folder or subfolder, or the
project/shell or Company Documents root folder.

2. From the right pane, select the Options tab.
The folder options are displayed in the right pane.

To modify folder options:

1. From the project/shell or Company Document log, select any folder or subfolder, or the
project/shell or Company Documents root folder.

2. From the right pane, select the Options tab.

3. Make your changes and select Save.

View, Add, or Modify Folder Permissions

When you create or upload a folder, you become its owner and have full access to the folder
and its contents.

Setting permissions at the folder level lets you grant other users access not only to the
selected folder, but also (optionally) its contents as well, such as subfolders, shortcuts, and
documents. You also have the option of setting individual permission settings to specific
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shortcuts and documents within the folder, as discussed in the documents and shortcuts
sections.

Note

• You may want to add yourself to the permissions list. Though not necessary, if you
remain the owner and you decide later to transfer ownership of the folder, you will
no longer have owner permissions. However, you will retain the permissions, if
any, that you specify in the permission window.

• The project/shell Documents root folder is selectable for modifying permissions.

To view the folder permissions:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log (for Project Documents).

3. Select an item (folder) from the log.

4. On the right pane, select the Permissions tab to view the folder permissions.

To add or modify the folder permissions:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log (for Project Documents).

3. Select an item (folder) from the log. You can select more than one item.

4. From the toolbar, select Actions, and select Permissions to open the Permissions
overlay page. Alternatively, if you are working with one item (folder) only, you can select

the gear menu ( ) next to the item and select Permissions.

5. On the Permissions overlay page, you can add or modify the folder permissions by using
the following options:

• Inherit form parent folder <parent folder name>
If the Inherit permissions from the parent folder checkbox at the top of the window
is selected, the folder-level permissions will apply automatically and cannot be
modified.

• Assign new permissions

• Apply these permissions to documents and sub-folders
You can select this option to apply the selected permissions to all the documents and
folder contained within the selected items (folders). This selection erases the existing
permissions assigned to the selected items (folders).

6. Select Save when done, or select Cancel to close the Permissions overlay page without
any changes.
When you are working with more than one item (folder), there is an additional option: Save
and Close.

When you are working with permission of one item (folder) only, there are additional
options: Previous and Next. These additional options let you finish your work and navigate
to permissions of the previous or the next item.

7. Do any of the following:
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• To add a new user, select Add and add users or groups to grant permission. Select the
user from the list and grant or remove individual permissions (see below).

• To remove a user's permissions, select the user from the list, and select Remove.

• To modify a user's permissions, select the user from the list and grant or remove
individual permissions.

Add or Modify Multiple Folder Permissions

To add permissions to multiple folders:

Note

This option does not let you use the existing permissions for the selected folders. For
example, if a user 'A' already has permission to one of the selected folders, and if the
same user is selected again from the user group picker, then user A's existing
permissions will get overwritten with the new permissions.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

3. In the Documents log (for Project Documents), select multiple folders.

4. From the toolbar, select Actions, and then select Permissions.

5. In the Permissions window, assign permissions to users or groups.
By default, permissions are inherited from the common parent folder of all the chosen files.
The inherited permissions will all be read-only. You have the option to assign new
permissions instead of choosing to inherit from parent folder.

The permissions of folder owners can never be removed. If you select multiple folders, add
the folder owners from the users- or group-picker, and select Remove, the system
removes the folder owners from the current permission window. The system does not
remove permissions for the folder owner.

If you switch between the Inherit form parent folder <parent folder name> and Assign
new permissions options, all the inherited permissions are removed and the
Permissions page toolbar and grid is updated as if you are proceeding to create
permissions from scratch.

If you have already inserted one or more rows in the grid (manually or by copying from
parent) and you decide to switch between the Assign new permissions and Inherit form
parent folder <parent folder name> options, the system displays a message stating that
the manually added permissions will be erased and replaced with the inherited
permissions. You will have the option to proceed or cancel.

6. When you are done, select Save.

Copy a Folder

You can copy a folder from one location to another. When you copy a folder, you become the
owner with ownership permissions of the copied folder and its contents. The owner of the
original folder and other users with permissions to the original folder retain their permissions on
the original and the copied folder. You can copy more than one folder at a time.
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Note

If a folder contains attachments, you can copy the folder with the attachments.

To copy a folder:

1. Select a folder in the project/shell Documents log.

2. Select , select Edit, and then select Copy.

3. Select the target location from the folders shown.

4. Select the Include Comments checkbox if you want to copy any comments or markups
that may be on documents within the copied folder.

5. Select Copy. The folder and all contents (subfolders, documents, shortcuts) are copied to
the target location.

Note

To copy multiple folders, select the folders, go to the toolbar, select Actions,
select Edit, and then select Copy.

Move a Folder

If you are the owner of the folder (or otherwise have proper permissions), you can move a
folder to a new location. When you move a folder from one location to another, all subfolders,
documents, and any comments or markups on the documents are moved to the new location.
Original ownership and user permissions are maintained. To move a folder, you must have the
following permissions: Create Sub-Folder permission in the destination folder and Move
permission in the source folder. If a folder with the same name exists in the destination folder,
you can choose to either cancel the move or keep both the folders. When you select the option
to keep both, the folder you are moving will be appended with a number to distinguish it from
the folder that exists. If you are moving multiple folders at the same time, you can select the
Apply for all conflicts checkbox to apply the same action for subsequent conflicts.

To move a folder:

1. Select a folder in the project/shell Documents log.

2. Select , select Edit, and then select Move.

3. Select the target location from the folders shown.

4. Select Move. The folder and its contents are moved to the target location.

Note

To move multiple folders, select the folders, go to the toolbar, select Actions,
select Edit, and then select Move.

Rename a Folder
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To rename a folder:

1. Select the folder in the project/shell Documents log.

2. Select , select Edit, and then select Properties.

3. Enter the new folder name, and select OK.

Delete a Folder

When you delete a folder, it is moved to the Recycle Bin. Items in the Recycle Bin can be
restored back to their original location or permanently deleted. See The Recycle Bin. You can
delete more than one folder at a time.

Note

Documents attached to business processes cannot be deleted. Therefore, to delete a
folder that contains a document that cannot be deleted, you must first move that
document to a different location.

To delete a folder:

1. Select a folder in the project/shell Documents log.

2. Select , select Edit, and then select Delete.

3. Select Yes to confirm. The folder is moved to the Recycle Bin.

Note

To delete multiple folders, select the folders, go to the toolbar, select Actions,
select Edit, and then select Delete.

Creating and Managing Documents

A document refers to a file that is uploaded into the system and stored in the Document
Manager. A document in the Document Manager can be thought of as a container of the file
that was uploaded.

View and Open Documents

Documents can be stored in folders or directly in the root project/shell documents or company
documents node. The project/shell documents log displays the contents of the selected folder,
including subfolders, documents, and shortcuts.
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Note

If you are using an Oracle Cloud-based deployment, the system displays a message
when you choose to view or download files or attachments that have not been
scanned for viruses. To continue, you must select Yes or No. If you select Yes and the
system determines that the file is infected, the download is stopped; otherwise, the
download completes successfully.

Documents can be opened in several ways from within the system, depending on your default
viewer selection and integrations enabled by your Company Administrator:

• Native: Documents are opened in their native software applications; for example, Microsoft
Word documents are opened in Microsoft Word. This option requires that users have the
native software application installed on their machine or your Company Administrator
enabled Office 365 integration for use with Microsoft 365 applications.

• Unifier Viewer: Documents are displayed in the Unifier Viewer. Documents are opened in
a read-only view that supports adding graphical markups and text comments. Unifier
Viewer supports the document file types listed in the table below.

• Office for the web: If Office 365 integration is enabled, you can also use Microsoft 365 to
view and update documents, including working on attachments for BPs.

• AutoVue: If your Unifier server is configured to use it, you also have the option of opening
a document in AutoVue.

Supported File Types with Unifier Viewer

File Type File Type File Type File Type File Type File Type File Type

BMP DOTX JFIF ODT PPSX TXT XLT
CSV DWF JP2 PDF PPT VSD XLTM
DGN DWG JPC PNG PPTM VSDX XLTX
DOC DXF JPEG POT PPTX WMF  
DOCM EMF JPG POTM PUB XLS  
DOCX EML MSG POTX RTF XLSB  
DOT GIF ODP PPS SVG XLSM  
DOTM HTML ODS PPSM TIF XLSX  

Microsoft Cloud Storage Partner Program (CSPP) File Size Guidelines (Microsoft 365)
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Application Mode CSPP Limit CSPP+ Limit Notes

Word for the web View   No limit, but there is
a 60-second file
download time out
that applies to all
GetFile operations,
and this time out can
affect the perceived
file size limit. In
practice, this time out
is rarely reached,
because connectivity
and bandwidth is
typically very good
between Office for
the web and host
data centers.
However, hosts
should be aware of
this limit.

Word for the web Edit 100 MB 100 MB  
Excel for the web View 25 MB 100 MB  
Excel for the web Edit 25 MB 100 MB  
PowerPoint for the
web

View   No limit, but subject
to the 60-second time
out for file
downloads as
described above.

PowerPoint for the
web

Edit 300 MB 2 GB Subject to the 60-
second time out for
file downloads
described above so it
is possible that
smaller files will
reach that timeout. In
addition, for
embedded media, the
size limit is 100MB
for most embedded
media types. For WAV
files the limit is
100KB.

The Viewer Option is set in the Preferences section of the More tab.

To view a document:

1. In the Documents log, select a document.

2. Do one of the following:

• To open the document in the default viewer set in your preferences, select , and
then select Open.

• To open the document in AutoVue, select , and then select Open in AutoVue.

• To open the document in Microsoft 365, select , and then select Open in Office for
the web.
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You can also select the link in the Name column to view or download the document.

3. If you are using Microsoft 365 and you are logging into a new session, select I Agree to
continue.

4. If you are using Unifier Viewer and the document is protected with a password, enter the
password in the Password required dialog box after it appears, and then select Submit.
You can try entering the correct password up to three times.

By default, Unifier Viewer opens the document in a compressed state to reduce the impact
on environment bandwidth and improve the time required to display the document. To view
the document in its original state, select Switch to Original Document. To switch back to
the compressed state, select Switch to Compressed Document.

To search a document by using Unifier Viewer:

1. Open the document in Unifier Viewer.

2. Select anywhere in the Comments box.

3. From the toolbar, select Search .

4. Specify the content that you are looking for.

Create an Empty Document

Empty documents are used as placeholders for documents that have yet to be uploaded into
Document Manager. For example, a project/shell manager might create an empty document in
a folder and then send an action item to a team member to upload the file into it.

You can also import empty documents. See Import and Export Folders, Properties, and Empty
Documents.

Empty documents can be populated with files by revising them (replacing the empty document
with the completed document). See Revising Documents.

To create an empty document:

1. In the Documents log, select Create, and then select Empty Document. The Create
Document window opens.

2. In the Properties tab, enter the document name.

3. Complete the other fields as necessary.

4. Select the Options tab, and select Revisions must have same file name, if necessary.

5. Select Save. The empty document is created.

Note

To upload a file into the empty document, see Uploading Files and Folders.

Document Properties Window

To open the Documents Properties window:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.
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3. Select a document.

When you select a document, the right pane displays the following tabs:

• Properties

• Linked Records

• Audit Log

• Permissions

• Options

If a data element in the right pane contains a tooltip (a description of the field), a question mark
(?) symbol appears next to that field. When you hover over the question mark, the tooltip
appears.

Document Properties Window (Properties Tab)

The Properties tab has several fields that are categorized under the General and Other
blocks.

General

In this field Do this

Name This always appears at the top and is required. For the
project/shell Documents or Company Documents root
folder, this is not editable.

Location The folder location within the project/shell Documents
node. "/" indicates the project/shell Documents root
folder.

Document URL The URL for the selected document.
Owner The name of the folder creator or current owner. Select

to view the user profile.
Creation Date The date that the folder was created.
% Complete This is a calculated field derived from the overall

percent complete of all documents within the folder. The
% Complete for documents is maintained manually in
the Document Properties window.

Description You can enter an optional description for the folder.

Other

In this field Do this

Categories
(applicable to project-level Document Manager only)

Project administrators can group folders into
customized categories. You cannot use Find to search for
Category designations, but you can include them in a
report (user-defined reports). This field is not present at
the company level.
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In this field Do this

Phases
(applicable to project/shell level Document Manager
only)

In the project/shell level Document Manager, a folder
can be associated with one or more project/shell phases,
making it accessible only during those phases of the
project/shell. This helps ensure that important, phase-
specific documents are visible at the appropriate times
during the life cycle of the project/shell. Click Select and
select one or more phases.
The Phase setting controls the visibility of folders. For
example, if the project/shell administrator sets the
project/shell phase to conceptual design, only those
folders tagged with the phase conceptual design, as well
as those without a phase tag, will be visible during that
phase. If you do not specify a phase, the folder will
display during all project/shell phases.

Document Properties Window (Linked Records Tab)

Select Expand ( ) to expand the Linked Records tab.

The Linked Records tab has a tabular log that displays the following information:

• Record Number

• Name

• Title

• Status

• Upload Date

The right pane of the Linked Records tab displays the Record Details tab. The Record
Details tab has several fields that are categorized under the following blocks:

• General

• Details

• Calculation

Document Properties Window (Audit Log)

The Audit Log tab has a tabular log that displays the following information:

• Date

• Event

• Action

• Field Name

• Old Value

• New Value

• User Name

• Proxy User
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Document Properties Window (Permissions Log)

The Permissions tab has several fields that are categorized under the following blocks:

• Inherit permissions from the parent folder

• Selected Users/Groups

• Document Permissions

Document Properties Window (Options Log)

The Options tab lets you select the following option:

• Revisions must have same file name

Document Properties Window (E-Sign Log)

The E-Sign Log tab has a tabular log that displays the following information:

• Signee

• Status

• Initiated Date

• Completion Date

View or Modify Document Properties

You can view or modify (with proper permissions) the Document Properties of uploaded files
and empty documents. You can also import properties values. See Import and Export Folders,
Properties, and Empty Documents.

To view document properties:

1. Select the document in the project/shell Documents log.

2. From the right pane, select the Properties tab. The folder properties are displayed in the
right pane.

To view document options:

1. Select the document in the project/shell Documents log.

2. From the right pane, select the Options tab. The folder options are displayed in the right
pane.

To modify document properties:

1. Select the document in the project/shell Documents log.

2. From the right pane, select the Properties tab.

3. Make your changes and select OK.

To modify document options:

1. Select the document in the project/shell Documents log.

2. From the right pane, select the Options tab.
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3. Make your changes and select Save.

Note

The Administrator can specify values on the Document Attribute Form (for
Document Properties) that enable auto-sequencing (auto-numbering of
documents). You can use document auto-numbering on documents across the
Company level or the project/shell level. For example, the Administrator can
specify that a Document Name field uses auto-sequencing to give each document
a unique number as it is created. The auto-numbering occurs when you select
Apply or OK in the Document Properties window. Later, you can view the auto-
numbering of the document by selecting the Properties button to view the
Document Properties.

View, Add, or Modify Document Permissions

When you upload a document or when you publish a document from the Unpublished
Documents sub-node, you become its owner and have full access to it. You can grant other
users access to it.

If you have granted folder-level permission to other users and allowed the permission to apply
to the contents of the folder, those permissions will apply to the documents that you add to it
automatically. They will appear as selected in the document permissions window. However,
you can modify these permissions per document if needed.

To view the document permissions:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log (for Project Documents).

3. Select an item (document) from the log.

4. On the right pane, select the Permissions tab to view the document permissions.

To add or modify the document permissions:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log (for Project Documents).

3. Select an item (document) from the log. You can select more than one item.

4. From the toolbar, select Actions, and select Permissions to open the Permissions
overlay page. Alternatively, if you are working with one item (document) only, you can

select the gear menu ( ) next to the item, and select Permissions.

5. On the Permissions overlay page, you can add or modify the document permissions by
using the following options:

• Inherit form parent folder <parent folder name>

If the Inherit permissions from the parent folder checkbox at the top of the window is
selected, the folder-level permissions will apply automatically and cannot be modified.

• Assign new permissions
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6. Select Save when done, or select Cancel to close the Permissions overlay page without
any changes.
When you are working with more than one item (document), there is an additional option:
Save and Close.

When you are working with permission of one item (document) only, there are additional
options: Previous and Next. These additional options let you finish your work and navigate
to permissions of the previous or the next item.

To modify the folder permissions, deselect Inherit permissions from the parent folder.

Do any of the following:

• To add a new user, select Add, and add users or groups to grant permission. Select the
user from the list and grant or remove individual permission.

• To remove a user's permissions, select the user from the list, and select Remove.

• To modify a user's permissions, select the user from the list and grant or remove individual
permissions.

Add or Modify Multiple Documents Permissions

To add permissions to multiple documents:

Note

This option does not let you use the existing permissions for the selected documents.
For example, if a user 'A' already has permission to one of the selected documents,
and if the same user is selected again from the user group picker, then the user A's
existing permissions will get overwritten with the new permissions.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

3. In the Documents log (for Project Documents), select multiple documents.

4. From the toolbar, select Actions, and then select Permissions.

5. In the Permissions window, assign permissions to users or groups.
By default, permissions will be inherited from the common parent folder of all the chosen
files. The inherited permissions will all be read-only. You have option to assign new
permissions instead of choosing to inherit from parent folder.

The permissions of file owners can never be removed. If you select multiple files, add the
file owners from the users- or group-picker, and select Remove, the system removes the
file owners from the current permission window. The system does not remove permissions
for the file owner.

If you switch between the Inherit form parent folder <parent folder name> and Assign
new permissions options, all the inherited permissions are removed and the
Permissions page toolbar and grid is updated as if you are proceeding to create
permissions from scratch.

If you have already inserted one or more rows in the grid (manually or by copying from
parent) and you decide to switch between the Assign new permissions and Inherit form
parent folder <parent folder name> options, the system displays a message stating that
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the manually added permissions will be erased and replaced with the inherited
permissions. You will have the option to proceed or cancel.

6. When you are done, select Save.

Transferring Ownership

You can transfer ownership of a document, or multiple documents, in a folder. The new owner
will have all privileges of the original owner.

To transfer ownership:

1. Select a folder, document, or multiple documents.

2. From the toolbar, select Actions, and select Transfer Ownership.

3. Type the name of the user you would like to transfer the ownership to. As you type, the list
of users is refined to show you the closest match.

4. Select a user from the list.

5. Select Transfer.

6. Select Ok.

Copy a Document

A document can be copied from one location to another, with the option to include any
comments or markups associated with it. You can select and copy multiple documents or
folders at once. If you copy a document owned by another user, you become the owner of the
copy, and the original owner maintains original permissions on the original and copied
versions.

Note

You must select a destination folder that is different from the source folder. You cannot
copy a document into the same location you are copying it from.

To copy a document:

1. Select the document in the project/shell Documents log.

2. Select , select Edit, and then select Copy.

3. Select the destination folder into which you want to place the document copy.

4. To copy with comments or markups attached to the document, select the Include
Comments/Markups checkbox.

5. Select Copy.

Note

To copy multiple documents, select the documents, go to the toolbar, select
Actions, select Edit, and then select Copy.
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Move a Document

When a file is moved, comments or markups associated with the document are moved with it
automatically. To move a document, you must have the following permissions: Add Document
folder permission in the destination folder and Move document permission in the source folder.
If a file with the same name exists in the destination folder, you can choose to either cancel the
move, revise the file in the destination folder, or keep both the files. When you select the option
to revise, the file in the destination folder is revised and an entry is made in the Revisions tab.
When you select the option to keep both files, the file you are moving will be appended with a
number to distinguish it from the file that exists. If you are moving multiple files at the same
time, you can select the Apply for all conflicts checkbox to apply the same action for
subsequent conflicts.

To move a document:

1. Select the document in the project/shell Documents log.

2. Select , select Edit, and then select Move.

3. Select the target folder into which you want to move the document.

4. Select Move.

Note

To move multiple documents, select the documents, go to the toolbar, select
Actions, select Edit, and then select Move.

Rename a Document

You can rename a document, if your administrator has enabled the document name field as an
editable and required field. When you rename a document, the change is reflected everywhere
the document is referenced or linked. The name is also updated in formulas that use file name
in its calculations. Each time a file is renamed, it is tracked and can be viewed from the Audit
Log tab.

If you rename a file with a name that exists in the same folder, an alert message is displayed.
You can rename the file or choose to keep the same file name. If you choose to keep the same
file name, it is appended with an integer. For example: Architecture Diagram.png will be
renamed as Architecture Diagram(1).png.

Note

You cannot change the extension of a file; you can only rename the file.

To rename a document:

1. Select the document in the project/shell Documents log.

2. Select , select Edit, and then select Properties.

3. Enter a new file name, and select OK.
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Delete a Document

When you delete a document, it is moved to the Recycle Bin. Items in the Recycle Bin can be
restored to their original location or permanently deleted to save space. You can select and
delete more than one document simultaneously.

A document that is attached to a business process (BP) record is linked to it and cannot be
deleted from the Document Manager. If the document is linked to a record, it shows a linked
records icon in the BP (Linked Records) column of the Documents log. However, if the latest
version of the document is not linked to a BP, the icon is not displayed in the log. You can
select the document, select View, and then select Revisions to check if an older revision has
linked records. In addition, a document may also contain links to BPs that are still in draft,
which will not display as a link to the document until the BP record is sent.

Caution

Use caution when deleting drawing base or reference files. Deleting a linked reference
file will cause the file to be marked as missing on the corresponding base drawing file.

Note

If you must remove a document that cannot be deleted, move it from its original
location into another folder with limited user access.

To delete a document:

1. In the project/shell Documents log, select the document.

2. Select , select Edit, and then select Delete.

3. When the Confirmation message appears, select Yes to confirm to move the document to
the Recycle Bin.

Note

To delete multiple documents, select the documents, go to the toolbar, select
Actions, and then select Delete.

Revising Documents

To revise a document, you replace the current version with a new one that you upload from
your local machine or that you save if you are using Microsoft 365 (the Open in Office for the
web option). The new file does not need to have the same file name as the original. This is
also how you populate an empty document in the system with the completed document from
your local machine or from Microsoft 365.

The newest version of a document is available in the project/shell Documents log. Earlier
versions are accessible on the Revisions tab. When a document is revised, the file itself is
never changed. It remains untouched. Each version is maintained separately.

The procedures for uploading revisions are the same as for uploading files.
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Note

• You can help control revisions by locking documents or checking them out prior to
revising. If you have locked the file, you must unlock it before proceeding. If you
have checked it out, you can revise it by checking it in, or cancel the check out
before proceeding.

• If you are using the co-authoring feature of Microsoft 365 and you want to update
a document, make sure that the document supports co-authoring and that the co-
authors have permission to access and edit the applicable document. For more
information, see your Microsoft documentation.

To revise a document using the Revise function:

1. Do one of the following:

• If you are revising a file with a new version with the same file name, proceed to the
next step.

• If the revised file has a different name, select the document in the Documents log,
select Properties, and select the Options tab. Be sure the Revisions must have the
same file name checkbox is not selected.

2. Select the document in the Documents log.

3. From the toolbar, select Actions, select Edit, and then select Revise.

4. Do one of the following:

• If you are not using Microsoft 365:

a. As stated above, make sure that the current file is not locked or checked out.

b. In the Upload dialog box, drag and drop the revised file to the dialog box or use
the Browse option to locate and select the file.

c. Select Upload to bring the revised file into the Document Manager.

• If you are using Microsoft 365:

a. Select Edit.

b. If there is more than one user updating the same document, verify that all
instances are participating in the same co-authoring session.
Whenever you invoke the Edit action on a Microsoft 365-supported document, a
new revision is created. When another user joins the co-authoring session while
your session is active, changes from both users are saved in the same revision of
the document.

The publication number (Pub. No.) of the file increases by one for each revision uploaded.
For example, the first time you upload a document, the publication number is 1. If you
revise it, the publication number becomes 2, and so on.

To revise a document automatically upon uploading:

1. Follow the procedure for uploading documents.

2. In the Upload window, select the Revise automatically if file with same name exists
option.
If you are uploading a file that has the same file name as a document that exists in the
Document Manager target folder, that document will automatically be revised to the newly
uploaded version.
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To learn more about comparing two versions of a document and file attachments, see the
Unifier Business Processes User Guide.

Viewing Previous Revisions

You can view earlier versions of a revised document, including any comments or markups or
linked business processes (BPs) on previous versions.

To view earlier versions of a document:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

3. Select a document in the log.

4. From the right pane, select the Revisions tab.
Previous versions of the document are displayed on the right pane.

5. Select a file version, select the gear menu (  ), and then select one the following actions:

• To download the selected version, select Download.

• To make the selected file the current version of the file, select Restore this Revision.

• To view the list of BP records to which the selected version is linked, select View
Linked Records.

Restoring to a Previous Revision

You can revert to a previous version of the file, if you have the Revise Document permission.
When you restore a file, all comments and references associated with it are also restored. It
also gets tracked in the Audit log.

If the Revisions must have same file name option is selected, you cannot restore to a
revision with a different name.

Note

The following HTML special characters / \ : * ? " < > | cannot be used in the file name.

The selected version becomes the current version.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

3. Select a document in the log.

4. From the right pane, select the Revisions tab. The Revisions tab is displayed only if the
file has revisions. The Revisions tab displays all previous versions of the document.

5. Select the version you want to revert to, select , and then select Restore this Revision.
The selected file now becomes the current file. This change is tracked and can be viewed
from the Audit tab. The Restore this Revision option is displayed only if you have the
Revise Document permission.

Chapter 1
Document Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 378 of 671



Checking In and Checking Out Documents

The Document Manager's check-in and check-out capability helps you have greater control
over document revisions. If you must revise a file, you have the option of checking it out, which
locks it and prevents others from modifying it. It is available to other users as view only. You
can change the document as necessary, and then check in the new revision.

The procedure for checking out a document is similar to downloading a document. The
procedure for checking in a document is similar to the procedure for revising a document.

When a document is checked out, the check-out icon appears next to the document name in
the Document Manager log.

To check out a document:

1. Select the document in the project/shell Documents log.

2. Select , select Actions, and then select Check out.

3. Download a copy of the file to your local system.

Note

• If you cancel the download procedure, the document will still be checked out
to you.

• To check out multiple documents, select multiple documents, select Actions,
select Edit, and then select Check Out.

The Check Out icon appears next to the document in the log. You can upload a new revision
and check the document back in, or you can cancel the check out without revising the
document.

To check in a new revision of a checked out document:

1. Select the document in the project/shell Documents log.
Checked-out documents have an icon in the lock column.

2. Select , select Actions, and then select Check in.

3. In the Upload page, select the ellipsis icon , and select Browse.

4. Locate and select the file that you want to check in.

5. Select Upload to upload the revised file.

The publication number (Pub. No.) of the file increases by one for each revision uploaded.

Note

To check in multiple documents, select multiple documents, select Actions, select
Edit, and then select Check In.

To restore a checked out document without checking in a new revision:

1. Select the checked out document in the project/shell Documents log.
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2. Select , select Actions, and then select Cancel check out.

The document will no longer be checked out.

Note

To restore multiple checked out documents, select multiple documents, select
Actions, select Edit, and then select Cancel Check Out.

To ascertain which user has a document checked out:

1. Select the checked out document in the project/shell Documents log.

2. From the right pane, select the Audit Log tab.
The Audit Log report displays the complete history of the document, including who last
checked out or revised it.

Lock and Unlock Documents

If you are the owner of a document, you have the option of locking the document to prevent it
from being revised or modified. After a document is locked, only the document owner (or an
administrator with proper permissions) can unlock it.

When a document is locked, users can:

• View the document, revision log, and audit log.

• Download or copy the document.

• Create a shortcut to the document.

• Modify document permissions.

• Move a document, or move the folder containing the document.

When a document is locked, users cannot:

• Delete, revise, edit properties, transfer ownership, or add comments or markups.

To lock or unlock a document:

1. Select the document in the project/shell Documents log.

2. Select , select Actions, and then select Lock or Unlock.

Note

• Only the document owner or an administrator with full access can lock or
unlock a document.

• To lock or unlock multiple documents, select Actions, and then select Lock or
Unlock.

• Only the document owner or an administrator with full access can lock or
unlock a document.

Adding and Viewing Graphic Markups and Comments
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In project or shell documents, you can add text comments or create graphic markups on a
document. You can also attach a file directly to a comment (for example, supporting
documentation).

You can add comments and markups only to the latest version of a document. For earlier
versions, you can view existing comments and markups but cannot add or edit them.

Text comments act as notes that accompany the document without becoming part of it.

Graphic markups function like an invisible overlay. When multiple users add markups, each
user’s markup resides on its own “sheet.” You can view them all together, view them one at a
time, or hide them. Every markup is associated with a text comment.

Text comments and graphic markups can be copied between business process (BP) records
and the Document Manager, including:

• Comments on documents in the Document Manager

• General comments on business process records

• Comments on file attachments in non-Document-type BP records

• Comments on file attachments (line item content) in Document-type BP records

• Markups on file attachments that were added within comments

Opening a Document to View Comments

To open a document using the Unifier Viewer:

1. Select a document.

2. Select , and then select Open, or select the link in the Name column to open the
document.

3. If the document is protected with a password, enter the password in the Password
required dialog box after it appears, and then select Submit.
You can try entering the correct password up to three times.

The document and any associated comments are displayed in one window. By default, the
system displays one page at a time. You can use the Page Number field or the arrows to scroll
through the pages. You can also select Switch to Full Document if you want to view the
complete document in a single view instead of viewing individual pages.

The Comments section on the right displays a list of existing comments. You can highlight and
view all comments in a single view. If you are in pagination mode, this only applies to the
comments on one page. If you are in full document mode , this applies to all comments across
all pages.

Note

Older comments entered using OIT are shown in read-only mode and are excluded
from the option to view all comments in a single view.

To highlight the comments (annotations):

1. Choose one of the following:

• To highlight multiple comments in a multi-page document, make sure that you are
using full document mode (Switch to Full Document).
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• To highlight multiple comments on a specific page, make sure that you are in
pagination mode (Switch to Page level Document).

2. In the Comments pane on the right, select the applicable comments by pressing the Ctrl
key and then selecting the applicable comments.

To open a document using AutoVue:

1. Select a document.

2. Click , and then select Open in AutoVue to open the document.
This option displays only if your Unifier server is configured to use AutoVue.

Adding Markups, Comments, and File Attachments

Note

All comments are displayed in both viewers regardless of which viewer the comments
were added in. Markups are visible only in the viewer they were made in.

To mark up a document using Unifier Viewer:

1. Select a document.

2. Select , and then select Open to open a document.

3. To activate an additional set of tools, such as Pan, Select, View, Annotate, Shapes, and
so on, select anywhere in the Comments box.

4. Use the applicable tools to mark up your document.
For example, to annotate a document, from the toolbar, select Annotate, and then select
one of the tool buttons located below it, such as Highlight. After you select a tool, additional
options appear in the container section to the right of the toolbar. If you selected Highlight,
you might also want to select a specific color to use. If you select Shapes, you can add
different objects, such as arrows, or draw boxes around specific content.

5. If applicable, enter your comments in the Comments box.

6. To add attachments to your comments, select Attachment, and upload the applicable
attachment.

7. When you are done, select Post, which is located below the Comments box.

To mark up a document using AutoVue Viewer:

This option displays only if your Unifier server is configured to use AutoVue.

1. Select a document.

2. Select  , and then select Open in AutoVue to open a document.

3. Ensure you have selected the latest revisions of the document.

4. Select the Markup icon in the Comments and Revision window.

5. Use the markup toolbar displayed in the Document window to mark up your document.

6. Enter your comments in the Comments and Revisions window and select Post.

7. To add attachments to your comments, select the Attachment icon.

Viewing and Adding New Markups in AutoVue
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In addition to adding markups to a DM document, you can add and view old markups
simultaneously. With this functionality, multiple members can add various markups across
shared files throughout the life cycle of a design document.

When you select Open in AutoVue in the gear menu ( ) of the document, a View All
Markups option is available in the File Viewer of the Comments and Revisions window. If
you select View All Markups, the document is displayed in View-Only mode.

You can also choose the markups that are displayed by selecting the checkbox next to each
markup. After selecting OK, all the chosen markups are displayed.

Creating and Adding Stamps to Documents

The system includes standard stamps, such as Approved, Completed, Confidential, and so on.
You can use these stamps to mark a document. You can also create your own unique stamps
(duplicates are not allowed).

To create additional stamps for use within Unifier Viewer:

1. After opening a document in Unifier Viewer, select anywhere in the Comments box.

2. From the toolbar, select Insert to display an additional set of options.

3. Select Rubber Stamp  .

4. On the Custom tab, select Create New Stamp.

5. In the Create New Stamp window, use the features to design a stamp, and then select
Create.
The stamp is added to the list of stamps available for use on the Custom tab.

To add stamps to a document that was opened using Unifier Viewer:

1. After opening the document, go to the location in the document where you want to insert a
stamp.

2. Select anywhere in the Comments box

3. From the toolbar, select Insert, and then select Rubber Stamp  .

4. On the Standard or Custom tab, select the applicable stamp, and then select the
applicable location in the document to mark it with the selected stamp.

Adding Bookmarks to Document pages

The system lets you bookmark specific pages in a document within Unifier Viewer and use
those bookmarks later for quicker retrieval.

To bookmark a page:

1. After opening a document in Unifier Viewer, select anywhere in the Comments box.

2. Make sure that you are viewing the document in pagination mode (Switch to Page level
Document) and not full document mode (Switch to Full Document).

3. From the toolbar, select Panel to display an additional set of options.

4. Select the Bookmarks tab.

5. Go to the page that you want to mark, and either select the Bookmark icon  or select +
Add Bookmark at the bottom of the Bookmarks tab and enter a custom name for the
bookmark.
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When a page is bookmarked, the Bookmark icon is filled in on the applicable page instead
of appearing as an outlined icon.

To view a list of bookmarks:

1. After opening a document in Unifier Viewer, select anywhere in the Comments box.

2. From the toolbar, select Panel to display an additional set of options.

3. Select the Bookmarks tab.
The list of existing bookmarks is displayed on the Bookmarks tab.

Send for E-Signature

To send one or more documents to another Unifier user or to an external user for an electronic
signature (e-sig):

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents.

3. In the Documents log, locate and select the applicable documents.

4. From the toolbar, select Actions, and then select Send for E-Signature.

5. In the Request eSignature dialog box, enter the names of the recipients.
The Internal recipients field lets you either enter a user or group name or select Request
eSignature
 

 
to access the Add users and groups window.

The External recipients field lets you enter email addresses separated by commas or
semicolons.

6. 6. If you need signatures completed in a specific order, select Sequential Order, and then
select Change the order of signers (
 

 
) to set the order.

7. Enter a mandatory Subject.

8. Enter an optional Message (fewer than 1000 characters).
The attached documents appear below the Message field. To remove a document, select
the corresponding Remove (X) option.

9. Select Send.
If the number of files selected or the size of the files exceeds the limits defined by
DocuSign or Acrobat Sign, the system displays an error message. Make the applicable
adjustments and try again.

Alternatively, you can select a single document, select the gear menu ( ), and use Self-sign
or Send for E-Signature.

E-Sign Log tab

If your administrator has used the Integration node to configure and activate DocuSign or
Acrobat Sign and a document has been self-signed, or a document has been sent to an
internal or external user, when the recipient selects the document in the Documents log in the
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Document Manager, in addition to the existing tabs on the right side, the log displays the E-
Sign Log tab. The E-Sign Log tab contains:

• The message that was sent when the sender selected Send in the Request eSignature
window.

• A list of all users who received the document for signature.

• A list of all users who self-signed the document.

• A Print option.

• A Download option.

• The columns for Signee, Status, Initiated Date, Completion Date, and Signer Number.

E-Signature Status column

If your administrator has used the Integration node to configure and activate DocuSign or
Acrobat Sign, the system displays the E-Signature Status column in the Documents log in
the Document Manager (select View, and then select All). When creating a view, you can
include the E-Signature Status column in any order you select for the log. The following
values are displayed in the E-Signature Status column:

• In Progress: When at least one signer or assignee must bring the signing task to a
Terminal status (Completed, Declined, or Reassigned).

• Completed: When the status is marked Completed or Reassigned.

• Declined: When the status is marked Declined by at least one signer or assignee.
If there is more than one signer, the Declined status overrides the status for other signers.

Note

These values are represented by yellow, green, and red icons.

In the E-Signature Status column, the values are sorted by Completed, In-Progress, and
Declined statuses.

You can use the following file types if you select DocuSign:

Format Extension

Document .doc, .docm, .docx, .dot, .dotm, .dotx, .htm, .html, .msg, .p
df, .rtf, .txt, .wpd, .xps

Image .bmp, .gif, .jpg, .jpeg, .png, .tif, .tiff
.dwg: If DocuSign does not support this type of file, the
system converts it to a .pdf prior to sending it for e-sign.

Presentation .pot, .potx, .pps, .ppt, .pptm, .pptx
Spreadsheet .csv, .xls, .xlsm, .xlsx

You can use the following file types if you select Acrobat Sign:

Format Extension

Document .doc, .docx, .txt, .rtf, .odt
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Format Extension

Image .jpg, .png, .gif, .tif
.dwg: If Acrobat Sign does not support this type of file,
the system converts it to a .pdf prior to sending it for e-
sign.

Presentation .ppt, .pptx
Spreadsheet .xls, .xlsx

About Actions options

If a document is already sent for E-signature but the signing process is not yet complete (the
E-signature Status has not yet reached a terminal state), you cannot check out, lock, or revise
that document. If you try to check out, lock, or revise the document, the system displays: This
action cannot be performed on documents whose E-Signature process is not yet complete.

About email containing an E-signature task

When you (a Unifier user) receive an E-Signature email notification to sign a document, select
Login in the email, enter your sign-in credentials. The system opens the document in
DocuSign or Acrobat Sign and you can sign.

Note

To receive E-signature task notification emails, ensure that you have selected to
receive emails with E-Signature task in your Preferences.

Exceptions:

• If the E-signature node is not deployed from the User Mode Navigator for the project/shell
in which the task resides, then, when you sign in, the system takes you to the home tab of
the E-Signature Tasks node, and the E-signature task can be accessed from this log.

• If the E-signatures node is not deployed for the Home tab as well, then, when you sign in,
the system takes you to the project/shell landing page and displays the message: You do
not have permission to view E-Signature tasks. Contact your Company Administrator.

The above conditions apply only if the status of the E-Signature Task that is sent to you is "In
Progress." If the status is not "In Progress," the task window does not appear. Instead, you will
be navigated to the E-Signatures node in the respective project/shell or home tab (or to the
shell landing page if the node is not deployed). In the latter case, you will be presented with the
message: You do not have permission to view E-Signature tasks. Contact your Company
Administrator.

Document Manager (DM) and E-Signature

When the E-signature process for a document is incomplete (E-Signature Status = In
Progress), the E-signature request sender or the document owner can select the gear menu
( ), and select Recall E-Sign Request.
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Note

This option is not available when the E-signature process is complete or when a
document has not been sent for E-signature. Alternatively, you can select Actions from
the toolbar, and select Recall E-Sign Request.

The Recall E-Sign Request option is available only to the:

• E-Signature request sender

• Document Owner

Other users will not be able to view or act even if all other conditions are met.

If you select multiple documents in the Document Manager (DM) Log and select Recall E-Sign
Request, then:

• If all the selected documents are such that their E-Signature Status = In Progress, the
system displays the Recall E-Sign Request option. If you select this option, a confirmation
message appears that indicates all files associated with the selected envelopes will be
recalled. If you select Yes, the files are recalled and the E-signature Status is set to
Recalled on the Documents log in the Document Manager, E-Signatures node,
Attachments tab, and File Viewer. Additionally, for each document:

– The E-signature request sent out to each signee who has not yet completed the E-
signature request (E-signature Status = In Progress) is recalled, and the E-signature
Status = Recalled.

– The E-Signature status column in the DM log is set to Recalled.

Note

There might be signees who have completed the E-signature request.
Irrespective, the E-Signature Status for the file in DM is set = Recalled.

– The E-Signature Status in the E-Signatures node for each signee who has not yet
completed the E-Sign task is set = Recalled, in the E-Sign Log tab as well as in the E-
Signatures log.

– When you proceed to open a task that has been recalled, the system displays the
alert: This E-signature task has been recalled and cannot be acted upon.

– If an E-signature request is recalled for an External User, that user will not be able to
act upon the E-signature request by selecting at relevant links in the E-signature email
from Acrobat Sign or DocuSign.

• If any document in the user's selection has a completed E-signature request, or it has not
been sent for E-signature at all, no change will take place, and the system ignores the
recall request.

When you select a file in DM Tile View and select the gear menu ( ), the following options are
available depending on the E-Signature Status of the selected document:

• Self-sign

• Send for E-Signature

• Recall E-Sign Request
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Additionally, similar to the Flat View, the E-signature-related actions are available when you
select one or more files in Tile View and select Actions.

After all recipients have signed the request, they receive an e-mail notification. If they are using
DocuSign, individual attachments are included in the email. If they are using Acrobat Sign, a
single file that contains the combined documents is included with the email. For Unifier users,
the signed file can also be viewed on the E-Signatures node. The signatures of the recipients
appear on the actual page that they signed; they are not grouped on a specific page.

Document Manager (DM) Filters

You can filter files in the DM log based on the E-Signature status (for more information, see 
Working with DM Log Views). If all the E-signature features are enabled for the Company,
Shell, and Project home landing pages, the Filters tab within the Documents log in the
Document Manager displays the E-signature Status as a field on the basis of which user can
filter the records. You can filter on basis of multiple E-signature statuses, and you can see the
operators "equals" and "does not equal." The options are available at the end of all other fields,
if configured, in uDesigner.

Document Manager (DM) Log

If your administrator has used the Integration node to configure and activate DocuSign or
Acrobat Sign:

• The Search window within the DM log displays E-Signature Status as an option, which
lets you search for files with particular E-signature statuses within the DM. The search
parameters are available at the end of the list of all other parameters within the Search
window, and you can conduct a search based on E-Signature Status.

• Your search results log displays the E-Signature Status, which lets you filter the DM files
based on the status that you are searching for.

• The All option under View lets you view all files and run the find option on the E-Signature
Status.

If your company or project/shell is configured to display a value for the E-signature type
(Acrobat Sign or DocuSign):

• When you export, or import, the structure and properties of a file in the DM, the CSV or
Microsoft Excel file will contain an additional column, E-Signature Status, before the
Categories column. The value of the status cannot be modified because the value is
system-populated based on the file status through the E-signature process.

• An export file is populated with the E-signature status value, but an import file will always
ignore the values contained in the E-Signature Status column.

Note

If you enter values in this column during import, the system will ignore your input
and run the import for remaining columns that allow modification.

If there are pending E-signature tasks for an existing E-signature type and you change the
signature type at the project/shell level, the system will display an alert message that lets you
recall those pending E-signature tasks and change the signature type. If you do not recall the
pending tasks, the E-signature type at project/shell level will not change.
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If you change the E-signature type of a project/shell from "Default" to another value that
matches the "Default" set at the company level, and there are pending E-signature tasks for
the "Default" E-signature type, the system displays a message that the newly chosen E-
signature type value is the same as the company Default and lets you decide whether you still
want to change the E-signature type. The same behavior applies when you change the E-
signature type to "Default," and the "Default' value is the same as the current E-signature type
value.

Linked Documents

If a DM file is attached to a BP record, the system lets you sign or send it for E-signature from
within the DM.

If a linked file is sent out for E-signature, the BP record will remain linked to the original file.
The E-signature status, E-signature log, and so on, from DM does not reflect back into the BP
record. When the E-signature process from DM is complete, the BP continues to show as
linked to the original file; however, the DM displays the signed and revised file.

Note

If you link a DM file to a BP record and send the DM file for E-signature from the DM
as well as the BP record, the result will be similar to attaching a checked-out file from
DM to a BP record. In this case, the system revises the file on the BP record (the E-
signature request [DM or BP record] that completes first revises the file in the DM
first).

Creating and Managing Shortcuts

You may create convenient shortcuts to frequently used documents or folders.

Document and folder permissions always take precedence. That is, you must have the proper
permissions to view, open, or modify the document or folder to which the shortcut is pointing.

Use Shortcuts

Shortcuts are a convenient way to quickly navigate to important or frequently used documents
and folders. They can be used to quickly access and view a document or folder. Shortcuts
cannot be downloaded.

Note

If a folder or document is moved, any shortcuts that have been created for it will point
to the new location. However, if you rename or delete a document or folder, any
associated shortcuts will not be automatically modified. Users who try to use a
shortcut to a document or folder that has been renamed or deleted will see an error
message.

To use a shortcut:

Do one of the following:
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• Select the shortcut in the project/shell Documents log, and select Open.

• Double-click the shortcut.

If the shortcut is to a folder, the folder opens in the folders view, displaying the contents. If the
shortcut is to a document, the document opens.

Create a Shortcut

You may create a shortcut to a document or a folder. Selecting a shortcut to a folder displays
the folder contents. Selecting a shortcut to a document opens the document for viewing.

Note

For ease of use, create shortcuts to commonly used documents and folders and store
them in a central folder.

To create a shortcut:

1. Select the folder in which you want the shortcut to reside.

2. Select , and then select Create Shortcut. The New Shortcut window opens.
In the Name field, enter a name for this shortcut. You can rename the shortcut.

3. In the Source field, select Browse. The Select Files window opens.

4. Select to the document or folder for which you want to create the shortcut. You can select

Find on Page  to help you find a particular document or folder.

5. Click Select. The shortcut is created in the selected folder.

View or Modify Shortcut Properties

The Shortcut Properties window consists of the name of the shortcut as it appears in the
project/shell Documents log and the path of the document or folder to which it points. It is not
customizable in uDesigner.

In this field Do this

Name The name of the shortcut, as displayed in the log.
Source The path of the file or folder to which the shortcut

points. You can select Browse to change the source.

To view shortcut properties:

1. In the project/shell Documents log, select the shortcut.

2. From the right pane, select the Properties tab.
The folder properties are displayed in the right pane.

To modify shortcut properties:

1. In the project/shell Documents log, select the shortcut.

2. Select the gear menu , select Edit, and then select Properties.

3. Make your changes and select OK.
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Modify Shortcut Permissions

When you create a shortcut, you become its owner and have full access to it. You can grant
other users access to it. A shortcut will have limited permission settings related to the
document or folder to which it points.

If you have granted folder-level permission to other users and allowed the permission to apply
to the contents of the folder, those permissions will apply to the documents that you add to it
automatically; however, you can modify these permissions per document if needed.

To view the shortcut permissions:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log (for Project Documents).

3. Select an item (shortcut) from the log.

4. On the right pane, select the Permissions tab to view the folder permissions.

To add or modify the shortcut permissions:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Document Manager, and then select Documents to open the
Documents log (for Project Documents).

3. Select an item (shortcut) from the log.

4. From the toolbar, select Actions, and select Permissions to open the Permissions
overlay page. Alternatively, you can select the gear menu ( ) next to an item, and select
Permissions.

5. On the Permissions overlay page, you can add or modify the shortcut permissions by
using the following options:

• Inherit form parent folder <project name>
If the Inherit permissions from the parent folder checkbox at the top of the window
is selected, the folder-level permissions will apply automatically and cannot be
modified.

• Assign new permissions

• Inherit Permissions (View drop-down list)

• Apply these permissions to documents and sub-folders

6. Select Save when done, or select Cancel to close the Permissions overlay page without
any changes.

Copy a Shortcut

To copy a shortcut:

1. Select the shortcut in the project/shell Documents log.

2. Select , select Edit, and then select Copy.

3. Select the destination folder into which you want to copy the shortcut.
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4. To copy with comments or markups attached to the document, select the Include
Comments/Markups checkbox.

5. Select Copy.

Move a Shortcut

To move a shortcut:

1. Select the shortcut in the project/shell Documents log.

2. Select , select Edit, and then select Move.

3. Select the target folder into which you want to move the shortcut.

4. Select Move.

Rename a Shortcut

To rename a shortcut:

1. Select the shortcut in the project/shell Documents log.

2. Select , select Edit, and then select Properties.

3. Enter the new name, and select OK.

Delete a Shortcut

When you delete a shortcut, it is moved to the Recycle Bin. Items in the Recycle Bin can be
restored back to their original location or permanently deleted. Deleting a shortcut does not
delete the folder or document to which it points.

To delete a shortcut:

1. Select the shortcut in the project/shell Documents log.

2. Select , select Edit, and then select Delete.

3. Select Yes to confirm. The document is moved to the Recycle Bin.

Note

To delete multiple shortcuts, select the shortcuts, go to the toolbar, select Actions,
select Edit, and then select Delete.

Change the Shortcut Source

You can change the file or folder to which the shortcut points by choosing a different source in
the Shortcut Properties window.

To change a shortcut source:

1. In the project/shell Documents log, select the shortcut.

2. Select , and then select Edit Properties.
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3. If you want to rename the shortcut automatically with the name of the new source
document or folder, delete the name in the Name field.

4. In the Source field, select Browse, and browse to the new source document or folder.

5. Make your changes, and select OK.

Favorites

Creating your Favorites List

Select and tag your frequently used files and folders within DM log, as favorites. This list is
user specific and lets you view, access, and delete frequently visited items in Document
Manager.

To add files or folders to your favorites list:

1. From the DM log, select a file or folder.

2. Select , and then select Add to Favorites.

Managing Your Favorites List

To view your Favorites list, from the Document Manager log, select  Favorites. A pop-up
window displays all your files and folders that you have marked as favorite.

Task Action

Sort the order of your files and folders. From the Favorites pop-up window, drop and drag files
or folders to change the order.

Find files or folder From the Favorites pop-up window, select Find on Page,
and start typing the name of your file or folder.

Remove files or folders from your Favorites list. From the Favorites pop-up window, select a file or

folder, select , and select Delete.
View the path of your file or folder From the Favorites pop-up window, hover over a file or

folder to view its location.
View the folder and file in the DM log From the Favorites pop-up window, select a file or

folder, select , and select Go to Folder.

Opening your Favorite File or Folder

To open your favorite file or folder:

1. From the Document Manager log, select Favorites. A pop-up window displays all your files
and folders that you have marked as favorite.

2. To open a file:

From the Favorites pop-up window, select a file, click , and then select Open to open the

file using the default Unifier Viewer. To open the file in AutoVue, select a file, click , and
then select Open in AutoVue.

3. To open a folder:
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From the Favorites pop-up window, select a folder, click , and then select Open to open
the folder in the Document Manager log.

Uploading Files and Folders

You can upload files or folders from your local system into the Document Manager.

Note

• You can navigate to different parts of the application through any browser, while
the upload is in progress (in the background).

• If you are using an Oracle Cloud deployment, Unifier includes a virus scanner. To
prevent virus attacks from infiltrating your system through external files, the
system scans each file that is uploaded. Until the scan is completed, the file
remains in a Scan Pending state.

Asynchronous upload of files or folders lets you upload files while simultaneously using the
application. The login session is kept active if there are pending uploads; uploads are canceled
if you sign out of the application.

You can view the status of your upload by selecting the Upload Status  icon on the top
banner (next to the Announcements icon). The color of this icon changes from blue (in
progress) to green (successful) or red (failed) to indicate the status of the uploads. The Upload
Status window displays a list of all files or folders that were uploaded within the last 15 days.
From this window, you can see the name of the uploaded file or folder, size of the file, the
reason for the failed upload, and the number of files in the uploaded folder. You can select the
file name or folder name to open or save the file. From the Upload Status window, you can also
cancel pending and in progress uploads, and clear the upload history.

The file size for the uploads must be more than 0 bytes and less than the size limit that has
been specified in the Unifier Configurator (~2.5 GB).

If the file size for the uploads is not specified in the Unifier Configurator, the actual file size
for the uploads depends on the following:

• The network bandwidth, session time-out setting, and other pertinent parameters.

• Browser restrictions.

Additional information

• While you can upload an extensive range of document file types, Unifier Viewer only
supports the markup of the types listed in the table in View and Open Documents. If you try
to view a file type that is not supported, the system displays a message that it is not
supported but that you can download it. You can also use the Comments box to add notes
regarding the file.

• The following drawing file types are supported: DWG and DGN

• Drawing files are always uploaded synchronously, regardless of the browser you are using.
When selecting multiple files all the files will be uploaded synchronously, if the upload
contains one or more drawing files.

• You can drag and drop folders onto the Upload window only if you are using Google
Chrome or Microsoft Edge.
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• You can view the parent folder of the uploaded file in the Update Status window.

• You can navigate to the uploaded folder from the Update Status window.

Using the Upload Status Window

From the top banner, select the Upload Status  icon to view the Upload Status window.
From this window, you can do the following:

• View a count of pending uploads.

• View the status of uploads. Failed uploads are in red; you can select Info to view the
reason for the failed upload.

• Cancel a pending or in-progress upload. Hover around the file or folder name, and select
X. To cancel all pending and in-progress uploads, select Cancel All.

• Open or save the uploaded file or folder. Select the file or folder name.

• Open the parent folder of the uploaded file. Select the folder icon next the uploaded file.

• Clear the upload history. Select Clear. The history is saved for 15 days.

Uploading Files and Folders

1. Choose the applicable location:

• For a project/shell, from the left Navigator, select Document Manager, and then open
the applicable sub-node.

• For company-related documents, from the left Navigator (User mode), select
Document Manager, and then select Company Documents.

2. Select the destination (target) folder into which you want to upload the files.

3. From the toolbar, select Upload .
In the Upload dialog box, you can select the Revise automatically if file with same
name exists option, if necessary. The other two options (Upload files only and Upload
folders and files) are selected by default and based on the folder options (Options tab).

4. Proceed to drag and drop the files or folders to the Drag and Drop field.
Alternatively, you can select anywhere in the Drag and Drop field, and select the file or
folder to upload by way of the Windows File Explorer.

5. Select Upload.
After a few seconds, the system will display a confirmation message. The file upload time
depends on your server and network bandwidth.

If you want to delete an item in the Upload dialog box, select the item, select the icon 
to the right, and select Delete.

If Unifier Viewer is your default file viewer, the system converts new documents for use
with the viewer. If you try to view a new document before conversion is finished, the
system displays a file conversion message.

Downloading Documents and Folders

You can download copies of documents from the Document Manager to your local or network
drive.
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Note

If you are using an Oracle Cloud-based deployment, the system displays a message
when you choose to view or download files or attachments that have not been
scanned for viruses. To continue, you must select Yes or No. If you select Yes and the
system determines that the file is infected, the download is stopped; otherwise, the
download completes successfully.

When you download files, the name of the downloaded files must be unique. If you select
multiple documents or files in the Unpublished Documents folder of the Document Manager
and select to download them, and you notice that not all your selected documents have been
downloaded, it is because duplicated names existed in the Unpublished Documents folder.

The file size for the downloading must be more than 0 byte. The actual file size for the
downloading depends on the following:

• The network bandwidth, session time-out setting, and other pertinent parameters.

• Browser restrictions.

By default, the latest version of a document will be downloaded.

Shortcuts, empty folders, and empty documents cannot be downloaded.

If the download window (Java console plug-in) is still open on your machine, you may not be
able to delete, move, or modify the downloaded file as it will appear to be in use. If this is the
case, close the plug-in window.

To download a document:

1. Select the document to be downloaded. You can choose only one document at a time.

2. Select the Download button.

3. If the document is a drawing file with reference files, the Reference window opens, listing
all drawing and reference files. Select the Download button next to one of the files to
download. The File Download window opens.

4. Select the Save button. The Save As window opens.

5. Browse to the location where you want to download the file and select Save.

6. If you are downloading drawing and reference files, repeat for each file.

To download a file or folder:

1. Select one or more documents or folders in the documents log.

2. From the File menu, select Download. The Download Files and Folders window opens.

3. Browse to the location where you want to download the files.

Importing and Exporting in Document Manager

The following topics describe how to import and export using the Document Manager.

Import Folder Structure Template

If a folder structure template has been created in Admin mode (Standards & Libraries), you can
import it into your project/shell document manager to quickly create a predesigned structure of
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folders and subfolders. You can import the folder structure template into the root project/shell
Documents or Company Documents node or into any subfolder.

To import a folder structure template:

1. In the project/shell or Company Documents node, navigate to the target folder (or the
project/shell Documents root node) into which you want to import the new folder structure.

2. From the toolbar, select Actions, select Import, and then select Folder Structure
Template. The Select Folder Template window opens.

3. Select a template from the drop-down list.

4. You can preview the template structure by selecting the Preview button.

5. When you are ready to import, select Import. The folders and subfolders defined in the
template are created within the target folder you selected.

Import and Export Folders, Properties, and Empty Documents

You can import a folder structure and folder metadata (properties, such as the enabling of auto-
sequencing of formulas and other values) from a CSV or Microsoft Excel file. This procedure
also allows the import of empty documents into the structure.

Note

The term "file" in this topic applies to both comma-separated values (.csv) and
Microsoft Excel files.

You can export the current structure and properties after making the selection in the
Document Manager. The export file (the file name is suffixed with "Project Documents") has
the following worksheets or tabs:

• Instructions tab: This tab contains important instructions, tips, and additional information.
Ensure that you read the contents.

• Project Documents tab: Use the Project Documents tab to update document structure
and properties.

You can update the exported file and import it using the options available under Actions.

Before importing a file into Document Manager, you must follow these steps:

Step 1: Export structure and properties to a file

Your options are:

• Structure and Properties (CSV)

• Structure and Properties (Excel)

Exporting the existing structure and properties creates the file structure (rows and columns).

The file template will contain a list of documents and folders with their full paths and all
attributes displayed on the General tab of folder and document properties (either by default or
by design).

Documents and folder rows are identified by the first column (type).

The location of the folder or document is identified in the second column.
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The order in which the columns appear is the same as they appear in the folder and document
properties forms.

Step 2: Modify the file

While ensuring that you do not change the structure, proceed to add new folder, folders,
document properties, or empty documents to the file.

You can only modify the columns that are modifiable in project/shell documents.

The read-only fields cannot be modified by importing.

Folder and document names are case sensitive.

Note

As of the date of publication, there is a known issue with Microsoft Excel CSV files
with 15 or more rows. See the procedure below for details.

Step 3: Import the modified file

Your options are:

• Structure and Properties (CSV)

• Structure and Properties (Excel)

The imported file can include new folders and documents (empty documents), as well as
modified or additional properties that have been applied to existing folders and documents.

You can upload files into empty documents later by using the Revise option.

Export structure and properties to a file

To export structure and properties to a file:

1. Select specific folders or documents to export.

2. From the toolbar, select Actions, select Export, and then select Structure and
Properties.

3. Select Yes to confirm.

4. Save the file to your local system.

Modify the file

To modify the import file:

1. Open the file in a compatible software application.

2. If needed, add new folders or documents in rows (will be added as empty documents) as
needed.
You can also add property information to existing folders and documents. This includes
enabling the auto-sequencing of formulas and other values.

3. Save the file.
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Note

As of the date of publication, there is a known issue in the way that Microsoft
Excel handles CSV files with 15 or more rows. In CSV files, columns are
separated with commas. However, when the CSV template is opened with Excel, if
one or more columns toward the end are empty, Excel drops the additional
commas from the 15th row onward, resulting in an error when you try to import the
file. You can work around this in one of two ways:

• Add your data to the CSV file in Excel and save the file. Reopen the file in a
text editor such as Notepad, find the rows that have the missing commas, and
add the additional commas to these rows.

• Use the text editor instead of Excel to modify column values in the CSV file.

Import the modified file

To import the modified file into the Document Manager:

1. In project/shell Documents, select the folder into which to import the structure or
properties.

2. From the toolbar, Actions, select Import, and then select Structure and Properties.

3. In the File Upload window, browse for the file, select it, and select Open.

4. When the confirmation message appears, select Yes to download a status file or No to
skip.

View the Import Audit Log

1. Navigate to:

• (For Document Manager at the company level) Go to the Company Workspace tab,
and switch to User mode. In the left Navigator, select Document Manager, and then
select Company Documents.

• (For Document Manager at the project/shell level) Go to the shell tab, and switch to
User mode. In the left Navigator, select Document Manager, and then select
Documents.

2. In the applicable log, Company Documents or Documents, select the applicable folder or
file.

3. From the toolbar, select Actions, and select View Import Audit Log.
The Import Audit Log for the selected folder or file opens. You can view and print
information pertaining to the import process that created the folder or file, such as the
name of the CSV or Microsoft Excel file that was imported, the date that the folder or file
was created and completed, the name of the user who performed the import, and so on.

The Recycle Bin

When you delete documents, folders, or shortcuts from project/shell Documents, they are
stored temporarily in the Recycle Bin. These items can be restored back to their original
location. Items in the Recycle Bin remain there until you permanently delete them.
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Note

If you are using a custom user mode navigator, you must add the Recycle Bin to the
navigator.

Restore deleted items

Deleted documents, folders, and shortcuts that are still in the Recycle Bin can be restored back
to their original locations.

Note

If you restore a folder whose parent folder has been deleted, the folder structure will
be recreated. However, the other contents of the parent folder will not automatically be
restored.

To restore deleted items in the Recycle Bin:

1. Select the Recycle Bin node from left pane.

• To restore a single item, select it and select Restore.

• To restore all items in the Recycle Bin, select Restore All.

2. Select Yes to confirm.

Delete items from the Recycle Bin

After documents, folders, or shortcuts are deleted from the Recycle Bin, they cannot be
retrieved.

To permanently delete items from the Recycle Bin:

1. Select the Recycle Bin node in left pane and do one of the following:

• Select the item, and select Delete button.

• Select Empty Recycle Bin to permanently delete all items in the Recycle Bin.

2. Select Yes to confirm.

Index Reports

The index report utilizes the Oracle Primavera Unifier user-defined report engine. It lists
content (documents, subfolders, shortcuts) within a selected folder, properties, and phase
(contents may be associated with more than one phase). The index report can be generated in
HTML, PDF, or CSV format.

To view an index report:

1. Select a folder in folders view of the project/shell Documents or Company Documents
node.

2. From the toolbar, select Actions, select Index Report, and choose the format to display:
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• HTML Format: Displays the report in a browser window.

• PDF Format: Creates a PDF file of the report.

• CSV Format: Creates a CSV file of the report.

View Document Manager Audit log

Actions that you take, such as uploading a file, are automatically noted on the Document
Manager Audit Log in the system, whether those actions are initiated from the Unifier web
application or the Unifier mobile application.

To view the Audit log:

1. Select a folder or document in the project/shell Documents or Company Documents log (or
a folder in the folders view).

2. From the right pane, select the Audit Log tab.

3. To view additional information about an Event, select the Event, and view the information in
the Audit Details tab located to the right of the Audit Log tab.
To view the Audit Details tab, you might need to resize the Audit Log tab and use screen

split  to make adjustments.

The information displayed in Audit Details includes the mode of entry or change to a
record and line items in the record, whether the change was processed through REST,
SOAP, CSV, or reverse auto-population. This tab contains the following toolbar options:

• Print (Export To CSV and Export to Excel)

• Find on Page

Project or Shell Documents or Company Documents Attached to a Business
Process

A document that is attached to a business process record maintains a link with that record. You
can view the business process records to which any document is linked (permissions to view
BPs apply). Because of this link, documents that are attached to BP records cannot be
deleted.

Launch a Business Process from the Document Manager

A business process record can be launched directly from documents (Documents sub-node)
within the Document Manager node.

For information about creating a BP record in Document Manager, see the Unifier Business
Process User Guide.

View Linked Business Process Records

If a document in project/shell Documents or Company Documents has been attached to one or
more business process records, an icon will appear in the BP column next to the document in
the log. You can view the records to which the document is attached if you have view
permissions for that BP.
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To view business process records to which a document is linked:

1. In the project/shell Documents or Company Documents log, select a document.

Documents with the link icon (  ) in the BP column are linked to BP records.

2. From the right pane, select Linked Records.

3. To open the BP record form, select the hyperlink for the Record Number.
You must have permission to view the specific BP to open the record.

View and print the business process audit log

To view a business process Audit log:

From the right pane, select the Audit Log tab. The Audit Log tab lists each event associated
with the business process and workflow. The date and time stamp of each event reflects users'
current time zone as set in their User Preferences.

To view business process Audit Details:

To view additional information about an Event, select the Event, and view the information in the
Audit Details tab located to the right of the Audit Log tab. (To view the Audit Details tab, you

might need to resize the Audit Log tab and use screen split  to make adjustments.) The
details also include the user's current time zone for reference.

To print a business process Audit log:

1. On the Audit Log tab, select Print , and select Print.

2. In the Print dialog box, select Print.
A PDF file is created.

Unpublished Documents

When a user uploads a file from a local machine and attaches it to a business process, the
document is automatically stored in the Unpublished Documents log as soon as the business
process is sent. The link to the business process is also listed in the Unpublished Documents
log. The Unpublished Documents log is an automatic repository for files that have been
attached to business processes and which have not yet been published in the company or
project/shell (Company Documents and Documents functional nodes).

Note

If you are using an Oracle Cloud-based deployment, the system displays a message
when you choose to view or download files or attachments that have not been
scanned for viruses. To continue, you must select Yes or No. If you select Yes and the
system determines that the file is infected, the download is stopped; otherwise, the
download completes successfully.

You can access the unpublished documents for the company or project/shell in the respective
Unpublished Documents functional node.

• To access the Unpublished Documents log in your Company Workspace: Go to the
Company Workspace tab, and switch to User mode; in the left Navigator, select
Document Manager, and then select Unpublished Documents.
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• To access the Unpublished Documents log in your project or shell: Go to the shell tab,
and switch to User mode; in the left Navigator, select Document Manager, and then
select Unpublished Documents.

Within your company or project/shell, when you select the Unpublished Documents
functional node, the Unpublished Documents log opens which displays a list of unpublished
documents. The following topic provides the details of the Unpublished Documents log.

Unpublished Documents and Link to BPs

The link to the BP allows the BP record to be reviewed, allowing the administrator to review
where the document originated from. This provides a means to control the documents that are
accessible in the company or project/shell Document Manager.

Example

A subcontractor submits a Request for Information (RFI) BP with attached documents
requesting input from the architect. These attached documents can be traced back to the
original BP through the link, and the documents become available in the unpublished area of
the Document Manager. The administrator can then review the documents and make the
decision to publish them into the project/shell or Company Documents node and where to store
them, or not to publish them at all.

Note the following:

• This process applies only to business processes that support form attachments.

• Text-type BPs, such as action items or RFIs, are excluded. This is because text-type BPs,
by design, can have file attachments only in comments, not to the form itself.

• Files cannot be directly uploaded to or deleted from the Unpublished Documents folder.

• Permissions for unpublished documents are at the node-level only. You can either see all
the documents or you cannot see any. There are no document-level permissions. Folder-
level permissions are not applicable, as there are no folders in Unpublished Documents.

• Drawing files are handled with the base file listed and the associated reference files
bundled with it, similar to a zip file.

Unpublished Documents Log

The documents in the Unpublished Documents log have the following toolbars:

• Publish (  ): To publish a document.
When you select Publish, the Publish -Select Destination Folder window opens. The
function of Publish is similar to the Move option in Document Manager (DM). In the
Publish -Select Destination Folder window you can:

– Select the document phase (All Phases or Current Phase) from the drop-down list
field on top to load pertinent folders from Document Manager into the space below.

– Use the Find on Page link to open a row under the Name block and search for a
particular folder from the Document Manager.

– Use the scroll bar to parse through all folders from the selected phase so you can
browse and select a destination folder for the document publication.

– Include comments by selecting the Include Comments option.

– Ensure that if a file with the same name exists in the Document Manager, it gets
revised by the selected file in Unpublished Documents by selecting the Revise
automatically if file with same name exists option.
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– Discard your changes by selecting Cancel.

– Publish the selected file to the chosen folder in the Documents sub-node under
Document Manager node, by selecting Publish. This option is available only after you
have selected a destination folder from the available list. When you select Publish, the
Publish Status window opens. This window displays a grid with the following columns:

* No

* File Name

* Title

* Status

* Message

If you select more than one file and select Publish, the Publish -Select Destination
Folder window opens and the names of all the selected files will be listed at top of the
window.

• Download ( ): To download documents or folders onto your local or network drive. If you
select more than one file to download, the system creates a zip file for all the selected files
and opens the download window.

• Switch to Tile View ( ): To view documents and folders as tiles. When this option is

selected, the icon changes to Switch to List View (  ).

• Search (  ): To search for unpublished documents in the log. See Searching Content.

• Find on Page (  ): To find files on the displayed page. See Finding on Page.

The documents in the Unpublished Documents log includes multiple columns, such as File
Name, Record Number, and so on.

For each record, the Unpublished Documents log displays the following tabs in the right
pane:

• Properties: Under General, this tab displays the following read-only information about the
selected file:

– File Name: To change the file name, access Properties from the gear menu ( ).

– Title

– Size

– Issue Date

– Revision No.

– Publication No.

– Publication Date

• Linked Record: To see records linked from the same, or different, business process log.
The Linked Record tab displays the Record Number, Name, Title, Status, and Upload Date
of the linked records

• References: This tab appears only if the selected file has associated references.

You can use Expand ( ) to expand the right pane.

Each record has a gear menu ( ) that lets you perform the following actions:

• Open: To open the selected document in viewer.
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• Open in AutoVue: To open the selected document in AutoVue viewer.

• Properties: To review the document properties and change the file name.

• Publish

• Download

Publishing of Documents Automatically

By default, files attached to business processes are placed in the Unpublished Documents
folder in the Document Manager. A Publish Path data element can be designed in business
processes in uDesigner to specify the automatic publishing of documents to a specified path
and override the default. For Document-type business processes With Folder Structure, the
designer can specify that a configured folder path be appended to the folder structure. This
appended path is based on the path configured in the uuu_dm_publish_path data element on
the business process form, and the selection of the Append Line Items Folder Structure to
AutoPublish Path option, which is documented in the Unifier uDesigner User Guide.

The automatic document publication folder path is built based on the values of data elements
specified in the path defined in the data element uuu_dm_publish_path (Publish Path) in
uDesigner. To help you understand why automatic publishing does or does not occur and the
results of automatic publication, these are the rules for the automatic publication of documents:

• The data element uuu_dm_ publish _path is used in business process design to specify
the folder path into which the file should be published in the Document Manager. This
applies to Company, project, or shell business processes. A formula is configured to define
the value of the path to use when automatically publishing documents.
On the Creation Step of the Workflow-type business process, the system evaluates, or
replaces, the "record_no" in the data element "uuu_dm_publish_path" or in the data
element "uuu_dm_record_info_path," when the "record_no" is used directly as part of
formula, as shown in the example below. This condition (evaluation or replacement) does
not apply to the "Advanced Formula” type data element.

Example:

Suppose 'uuu_dm_publish_path' and 'title' are defined as formula.

=> uuu_dm_publish_path = firstName + record_no + title

=> title = subject + record_no

uuu_dm_publish_path would be evaluated as 'firstName + record_no + subject'
('record_no' in data element 'title' is ignored)

• To use the automatic publishing feature, you must know (from your Administrator) which
data elements comprise the publish path that will populate the Publish Path field. The
values in this field are used to create and populate the folders in the Document Manager
with the business process attachment.

• If you do not have permissions granted to upload documents to the Document Manager,
the file is placed in the Unpublished Documents folder.

• If there is no folder defined or the path is invalid, the file will be placed in the Unpublished
Documents folder.

• If the folder specified in the defined path does not exist in the Document Manager as
defined by the data element uuu_dm_publish_path (Publish Path), it should be created
automatically and inherit rights from the parent folder, (if you have permission to create
folders), otherwise the file will be placed in the Unpublished Documents folder.

• If the file exists in target file, the file shall be published as a revision.
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• The owner of the automatically published document is the owner of the business process
that published it.

• The folders created and used for automatic publication are based on the values of the data
elements specified in the uuu_dm_publish_path data element (Publish Path). For
example, if the publication path contains the data elements State and City, and the values
for those data elements are Iowa and Rapid City, the folder structure will be Documents/
Iowa/Rapid City.

• The publication path displays in the Publish Path data element on the business process
form. If the path is shown as /, the documents will publish to the Documents folder. Usually,
when the / to shows in the Publish Path field, this indicates that you have no values in the
fields for the data elements configured as the publication path. Be sure that you have
values in the fields that are part of the publication path.

• If a business process has a publication path configured on the upper form and another on
a line item, and the path on the line item is invalid, the attachment will be published to the
path designated on the upper form. If the paths on the line item and the upper form are
both invalid, the attachment is published to the Unpublished Documents folder. The
exception is that in a non-workflow business process, if the publication path configured on
the line item is invalid, the attached document is not published in any folder.

• When a document is published from a business process (BP) record, the system compares
the data elements (DEs) in the BP record with the DEs in the Document Attribute Form and
where the DEs match, the system copies the values from one DE to the other DE.

• If the attachment is on the Upper Form, the system matches the DEs on the Upper Form
with the DEs on the Document Attribute Form and updates the values.

• If the attachment is on the Detail form, the system compares the DEs on the Detail and the
Upper Form. If a DE exists on both the Upper Form and the Detail form, the system only
matches the value of the DE that is on the Detail form. This lets you override the "default"
value that exists on the Upper Form.

• The system lets you selectively restrict attachments from getting published, as explained
below:

– For Document-type BPs: Open the Document Review window and deselect the
Publish checkbox for the attachments that you do not want published.

– For non-Document-type BPs: Open the Document Review window, or the respective
attachment log (record or Line Item) and deselect the Publish checkbox for the
attachments that you do not want published.

• On a Document-type BP, when a value is added to uuu_revision_no or uuu_title or
uuu_issue_date, it will get respectively copied over to uuu_file_revision_no or
uuu_file_title or uuu_file_issue_date when the document is published to Document
Manager.

• After a document that has been attached to a business process is published, it will not get
published again even if you have the uuu_dm_publish_path defined in consecutive forms
in your workflow.

• If you are attaching a document to your business process by selecting the document from
Document Manager, the document will not get published again from your business process
because it is already published in Document Manager.

Opening Unpublished Documents

To open and view an unpublished document:
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1. In the Unpublished Documents log select a document.

2. Select the gear menu ( ), and select Open to open a window that shows the unpublished
document and any comments that are related to that unpublished document.

Opening Linked BP Record

To open the BP record to which an unpublished document is linked:

1. Select the document in the Unpublished Documents log.

2. From the properties pane on the right, select the Linked Record tab.

3. Select the record number of the BP record you want to view to open a new window which
contains the following details:

• BP details, on the left pane.

• Properties of the BP, on the right pane.
The properties are detailed in the following tabs:

– Attachments tab

– Comments tab

– Linked Records tab

– Workflow Progress tab

– Audit Log tab

– Reference Records tab

Viewing Unpublished Document Properties

To view the properties of an unpublished document, select a document in the Unpublished
Documents log and the Properties tab will display on the right.

Viewing Unpublished Document Comments

You can view any comments that are added to a document from the BP. To view comments or
markups on an unpublished document:

1. Select a document in the Unpublished Documents log, and select the Linked Record
tab.

2. Select the record number of the associated BP record to open a BP window.

3. On the right, under the Attachments tab, select the gear menu ( ), and select Review.
An Attachments window will open. Comments may be viewed in the log on the right.

Downloading Unpublished Documents

To download an unpublished document, select a document in the Unpublished Documents
log, and select Download, from the toolbar.

Deleting Unpublished Documents
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If a document is linked to a BP, the document cannot be deleted directly from Unpublished
Documents (or from the Company Documents and Documents logs).

A document is stored in the Unpublished Documents log automatically and as soon as a
document is directly uploaded from the local machine, or network, and attached to a business
process.

A document can be deleted from the Unpublished Documents log:

• If the uploaded document is deleted from the BP during the workflow, or

• If the document is deleted when the BP is in Draft mode, in case of a non-workflow BP.

You cannot delete a document:

• If the BP has already completed the workflow, or

• If the document has already been moved by an administrator to the Published Documents
folder.

Note

You can create a special folder in project/shell Documents for documents that you
want to publish and limit access to those documents, but the documents remain
traceable.

Renaming Unpublished Documents

You can rename an unpublished document, if your administrator has enabled the document
name field as an editable and required field. When you rename an unpublished document, the
change is reflected everywhere the unpublished document is referenced or linked to. The
name is also updated in formulas that use file name in its calculations.

Note

You cannot change the extension of a file, you can only rename the file.

To rename an unpublished document:

1. From the Unpublished Document log, select an unpublished document.

2. On the right pane, in the Properties tab, edit the File Name field with a new file name and
select Save.

Searching for and Sorting Unpublished Documents

To search for an unpublished document:

1. Select Search in the Unpublished Documents log toolbar to open the Search window
bar, and from the field on the right select a category that you want to search for. For
example, select File Name. These categories that are listed correspond to the column
headings in the Unpublished Document log (File Name, Content, File Type, Record
Number, Rev. No., Title, Publication Date, and Issue Date).
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2. In the left field, enter a value that corresponds to the category that you selected in the right
field. For example, if you selected File Name, enter the name of the file.

3. Select Search in the Search window. A new Search window will open which has two
panes.
The right pane lists the items that correspond to your search, in columns. The Search
window toolbar options are:

• Publish

• Download

• Switch to Tile View / Switch to List View

• Find on Page

The left pane of the Search window lets you sort or filter unpublished documents. In the
left pane, you can select options to sort or filter unpublished documents based on results
from your search.

The default options are as follows:

• Group By - Publication Date

• Format - Drawing Files, PDF, Word, Excel, PowerPoint, Images, Text, Others

• Publication Date - Last 7 days, Last 15 days, Last 30 days

• Bluebeam Session Status - Active, Finalized, Archived, Deleted in Bluebeam

4. Follow the prompts to complete your search. You can select Change to open the Search
window bar and change your search parameters.

Note

This search option can be customized through uDesigner. If a designer has
imported Document Manager attribute forms, the search criteria can also be
customized. This means that the fields on which you can search may differ from
the above list.

Publishing Unpublished Documents to Company or Project/Shell

Publishing a document (from the Unpublished Documents log) to the Company Documents
log or the project/shell Documents log makes the document available to the team members,
with the full functionality made available in that log or functional node.

Note

Only the administrator other users with full access to the Document Manager can
publish documents from the Unpublished Documents functional node (company or
project/shell) to the Company Documents log or the project/shell Documents log.

To publish an unpublished document to the Company Documents log or the project/shell
Documents log:

1. Select the document in the Unpublished Documents log, select the gear menu ( ), and
select Publish.
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Tip

To publish multiple documents, select one or more documents and from the
toolbar, select Publish. A new Publish window opens. If you select documents
with the same name to publish, the Duplicate Files window opens, which lets you
remove or delete the duplicate files.

2. Select a destination folder to publish the document or documents to.

• You may select Include Comments if you want to include any attached comments
with the document.

• Revise automatically if the file already exists is selected by default. Deselect it if
you do not want to revise existing documents automatically. If you deselect this, the
new version of the document is not copied into the Document Manager.

3. Select Publish to finalize.
The Publish Status window opens and displays the status of the documents as they are
published. The window displays the following:

• No.

• File Name

• Title

• Status

• Message

4. Select OK to close this window.

Note

The user who publishes the document becomes the owner. In the Company
Documents log or the project/shell Documents log, select the document, and
select the Permissions tab to grant the proper permissions to the team members
who need it. You may want to select the Properties tab to review properties and
update them if necessary.

Portfolio Manager
The Portfolio Manager is where the budget forecast planners in your company can gather cost
and schedule information on projects (both planned and in execution) and analyze "what if"
scenarios. These scenarios are used to propose an optimal mix of projects for a portfolio,
based on available budget targets and the strategic goals of the company.

As a planner, you can create a portfolio for a specific "planning horizon" (for example, from
2014 through 2020) and then create multiple scenarios in that portfolio. Each scenario can use
forecast numbers and actuals, as well as schedule dates, for both planned and active projects
in a specific shell type across a hierarchy in the company.

You create these scenarios on sheets, one for each scenario. The scenario sheets can pull in
the following data from any shell type in a hierarchy:

• Project information from the Shell Attribute Form or single-record business process

• Project start and end dates from the Shell Attribute Form or single-record business process
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• Cash flow data (both forecasted and actual) from each project's Cost Manager

With this data, you can forecast costs over a specific time period (called a "period structure").
You can then manipulate scenarios by:

• Including or excluding projects

• Pushing start dates for planned projects into the future, which automatically updates end
dates for Standard Planning Periods (not for Financial Periods)

• Modifying project end dates to change the project's duration

• Proposing different cash flow distribution numbers by manually editing the cash flow
columns

• Negotiating proposed budgets with project managers

After these scenario analyses have been completed, the best (or several best) scenario(s) can
be sent to the executive decision makers for approval.

After a scenario has been approved, the system:

• Marks the approved scenario "shared" so that project managers can see the approved
dates and numbers. The scenario is set to read-only mode and can no longer be modified
or deleted.

• Updates each project's original budget numbers with the proposed numbers on the
approved scenario.

• Updates each project's monthly or yearly cash flow numbers with the proposed numbers
on the approved scenario.

• Updates the project start date (if it was changed) for any planned projects that will begin
during the portfolio's planning period.

• Locks the budget and cash flow numbers to prevent any further changes.

View and Open Portfolios

Portfolios are grouped by their portfolio type. Scenarios are grouped under each portfolio.

To view portfolios:

1. Go to the shell tab where the Portfolio Manager resides and switch to User mode.

2. In the left Navigator, select Portfolio Manager. The system expands the navigator to show
the portfolio types currently loaded into the system.

3. In the left Navigator, select the portfolio type that contains the portfolio you want to view.
The system displays the portfolios for this type in the right pane.
The portfolio type log contains the following toolbar options:

• Create: To create a new portfolio manager sheet, or to create a new portfolio manager
sheet for the next planning period.
When you select an existing portfolio, select Create, and then select Portfolio or Plan
for next period, the Add Portfolio window opens which has two blocks: the general
block and the options block. For each block, enter the values in the fields and select
Save.

• Delete: To delete a selected portfolio in the portfolio type log.

• Refresh: To refresh the list of portfolios in the portfolio type log.

• Print: To print the list of portfolios in the portfolio type log or export to CSV or Excel.
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• Search: To open the Search block and search for a particular portfolio in the portfolio
type log. Use the following toolbars (the icons on the right corner) to dock the Search
block, clear values in the search fields, apply the search criteria, or close the Search
block:

– Dock Right

– Clear

– Apply

– Close

• Find on Page: To open a row in the list of portfolios in the portfolio type log and find
items according to the column headings. See the portfolio type log contains the
following columns, below. To close the row, select the Find on Page option again.

• View Help menu: To access the portfolio type help (not available) or the portfolio type
training (User Productivity Kit).

The portfolio type log contains the following columns:

• Attachments

• Portfolio Name

• Planning Period

• Creation Date

• Creator

The portfolio type log contains the Properties pane (the right pane) that appears when you
select a portfolio. The Properties pane, similar to the Properties window (accessed by the
Properties toolbar option available in an opened portfolio), enables you to access the
following information:

• Portfolio Name

• Planning Period

• Creation Date

• Creator

• Planner Comments

• Decimal Places

To open a portfolio:

1. Go to the shell tab where the Portfolio Manager resides, and switch to User mode.

2. In the left Navigator, select Portfolio Manager. The system expands the navigator to show
the portfolio types currently loaded.

3. In the left Navigator, select the portfolio type that contains the portfolio you want to open.
The system displays the portfolios for this type in the right pane.

4. In the portfolio type log, select a portfolio, select the gear menu ( ), and select Open to
open the portfolio details page or pop-up to either:

• The scenario that has been marked for sharing

• The most recently updated scenario

Within either of the scenarios, you are presented with two tabs (for example, a Budget
Planning tab and a Dashboard tab).
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In this window, you can select the plus option (the plus symbol + next to the scenario) to open
the Add Scenario window, add the title for your new scenario, add projects, and when
finished, select Save to add your new scenario. At the same level as the tabs, you have the
option to:

• Approve a scenario (or tab)

• Share or unshare a scenario (or tab)

• Duplicate the information of a scenario (or tab)

In the default tab of the scenario that has been marked for sharing, or the most recently
updated scenario, you can use the toolbar options to:

• Select projects

• Switch from the Grid View (default) to the Gantt Chart View

Note

If Begin calculations at end of curve is selected for a Forecast Curve and
Display financial period breakdown of Actuals is selected for the portfolio
configuration, the Actuals information displayed in a Grid View or Gantt Chart View
does not shift if the Start Date is modified.

• Change the view of the log by selecting with columns to be presented on the log

• Edit the view of the log

• Print the log items or export the items to a CSV or Excel file

• Refresh the list log items to get the latest, or the most up-to-date

• Access the Properties pane of the portfolio

• Collapse or expand all columns groups (you can group monthly reports into yearly groups)

• Find items on the log

In each row, you can:

• Select the gear menu ( ), and remove, or unlink, a project from the scenario.

• Select a project number cell to open the project.

• See the following amounts, for each project, after the split at the bottom of the log:

– Total

– Target

– Difference

– Current Project Data

• The number of projects appear at the very end of the screen.

Additional information

When a cell value in the Project Portfolio Manager (PPM) Sheet is updated for a current project
data, the system places a Warning symbol (a triangle with an exclamation mark in the middle)
in the cell to indicate that the cell value differs from the current project data.

When you conduct a Find on Page in the log view (grid), if the value of an item in your filter
has no match, the bottom part of the grid (after the split at the bottom of the log) will remain as
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it was, and it will not change from what it was prior to conducting the Find on Page. The
bottom part of the grid will change only when the value of an item in your filter has a match.

When exporting your grid to a file, the column groups are exported, too.

Read-only cells in a grid cannot be deleted. Note that the read-only cells are highlighted gray.

Create or Modify a Portfolio

You can create a portfolio "from scratch," or you can create one using a portfolio that has been
approved for the current planning period.

To create a portfolio, you must have Create or Full Access permission.

To create a portfolio:

1. Go to the shell tab, and switch to User mode.

Note

Portfolios can only be created at the project level, not at the company level.

2. In the left Navigator, select Portfolio Manager, and then select the portfolio type that
contains the portfolio you want to view. The system displays the portfolios for this type in
the right pane.

3. In the portfolio type log, select Create to create a portfolio manager sheet, or to create a
portfolio manager sheet for the next planning period.
When you select an existing portfolio, select Create, and then select Portfolio or Plan for
next period, the Add Portfolio window opens which has two blocks: the general block
and the Options block. For each block, enter the values in the fields, and select Save.

After you create a portfolio, the system displays the portfolio name in the right pane and
automatically creates an initial scenario sheet called Scenario 1. On this sheet, the system
displays the projects that:

• Are included in the scenario, if the projects are configured to be automatically added

• Can be included on the scenario, if the projects are configured to be manually added.

The project records for the scenario sheet are extracted from the database using a query that
your Administrator created when the portfolio was configured. Whenever you open a portfolio,
the system re-runs the query and adds or removes projects from the scenario depending on
whether the project matches the query criteria. For example, a project that was previously on
the sheet may be dropped from the sheet if it no longer meets the query criteria. Another
project may be added to the sheet because it now meets the query criteria.

In this field: Do this:

Portfolio Name Enter a name for the portfolio you are creating.
Planning Period Select the year for which you want to analyze the data

in this scenario.
Creation Date This field shows the current date.
Creator This field shows the name of the person creating the

portfolio.
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In the Options block: Do this:

Use Decimal Places To specify the number of decimal places that the column
data should display, select this option.

Use 1000 Separator (,) If you want the data to be formatted with a separator
(for example, 1,000, not 1000), select this checkbox.

Negative Number Format Specify how negative values will be displayed on the
sheet: with a negative sign, or in parentheses.

Use Currency Decimal Precision To use the number of decimals used within areas such
as Base Currency, Project Currency, and Transaction
Currency, select this option.

Create a portfolio from an approved or shared portfolio

Rather than create a completely new portfolio for your next planning period, you can save time
and effort by "copying" a portfolio that has already been shared or approved for the current
planning period.

To create a portfolio from an approved one:

1. Open the Portfolio Manager log and select the portfolio you want to copy for the new
planning period.

2. From the File menu, choose Plan for next period. The Portfolio Properties window opens.
The General tab of the Properties window will show the name of the portfolio you selected
as the new portfolio's name. In addition, the Planning Period field will display that portfolio's
next planning period by default.

3. In the Name field, change the portfolio name.

4. If necessary, you can change the planning period by selecting the drop-down list beside
the Planning Period field.

Note

The combination of the portfolio name and the planning period must be unique.

5. If necessary, you can change the numeric format on the Options tab.

6. Select OK.
The system displays the portfolio name in the right pane and automatically creates an
initial scenario sheet called Scenario 1. This scenario sheet will contain all the projects that
were present in the portfolio you copied. These projects will show the data that was current
for each project at the time the portfolio was copied, based on the matching monthly and
yearly cash flow columns. For the new scenarios, the system will calculate the new totals
and then calculate the variances to show the differences.

Note

If the original portfolio contained monthly numbers and the new portfolio contains
only a year column, the monthly numbers will be consolidated for the year.
Conversely, if a year column is being copied into a portfolio with monthly columns,
the number will be divided into monthly columns.
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Sort a Portfolio Log

You can sort the portfolio log by portfolio name into ascending or descending alphanumeric
order. To do so, select the triangle icon on the right side of the Portfolio Name column.

Find, Sort, and Delete a Portfolio

Find a Portfolio

For information on searching for a portfolio, see the Unifier General User Guide.

Sort a Portfolio

You can sort the portfolio log by portfolio name into ascending or descending alphanumeric
order. To do so, select the triangle icon on the right side of the Portfolio Name column.

Delete a Portfolio

1. Open the Portfolio Manager log.

2. Select the portfolio(s) you want to delete.

3. From the toolbar, select Delete.

About Scenario Sheets

As the budget forecast planner, you can create scenarios to plan an optimal portfolio of
projects for the company, based on available budget targets and strategic goals.

Portfolio management entails collaboration and negotiation between you, as the budget
forecaster, and the project managers in your company. At their respective project levels, project
managers maintain project information and create cash flow budgets and projections in the
Cost Manager.

In the Portfolio Manager, on the scenario sheets you create, the system collects the budget
and projection numbers from the projects' Cost Managers, as well as project start and end
dates from the project information.

During a scenario analysis, you can:

1. Apply regional budget targets

2. Group the projects in the scenario according to project characteristics

3. Sort and filter the rows of project data and analyze the summary totals

4. Accept the project managers' budget numbers or propose new numbers

5. Accept the schedule dates, or remove or postpone planned projects

6. Create additional scenarios to reflect other possible forecasts
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Note

• The numbers you propose in a scenario will not affect a project's live data.
Your proposed numbers are stored only in the Portfolio Manager and will not
affect live project data until a scenario has been approved by your company
management.

• For Standard Planning Periods only: If Begin calculations at end of curve is
selected for a Forecast Curve and Display financial period breakdown of
Actuals is selected for the portfolio configuration, the Actuals information
does not shift if the Start Date is modified. Otherwise, modifying the Start Date
in either view automatically adjusts the End Date and it adjusts the cost data
for monthly and yearly planning periods.

During this analysis, you will likely be in touch with project managers to negotiate these
numbers and dates until you reach agreement.

Project managers will not see the changes you make on the scenario sheet. Instead, the
project managers must create a "shared" type of portfolio budget curve. This curve shows your
proposed numbers for the project. The project manager can include this curve on the cost
worksheet, along with the forecast budget, or any other budget curve, to see the difference
between the project's numbers and your proposed budget numbers.

For them to see the curve, you must share the scenario (see Share a Scenario).

For more information about the portfolio budget curve, refer to the Unifier Modules Setup
Administration Guide and the Unifier Managers User Guide.

After you have completed a budget forecast analysis using these scenarios, you can send the
best (or several best) scenario(s) to the executive decision makers for approval by "sharing"
the scenario.

Gantt View

Gantt Chart View shows you how capital is used over time. It lets you quickly adjust schedules
to achieve a better combination of projects within schedule and target. You can access a Gantt
view of any scenario in which one or more projects is selected for budget planning. From the
toolbar, select Gantt to display a Gantt distribution of proposed total over time on the grid. You
can open the dialog of select projects and add projects to the Gantt view.

Make schedule adjustments by moving Gantt bars and adjusting the project schedule. You can
view the target and difference rows simultaneously. You can also change start and end dates,
and the Gantt view will update accordingly. Based on changes that you make, the system
updates Total fields, such as Year and Proposed Total, so that you can immediately see the
impact. Select Save or Cancel after making changes.

Note

In the case of a standard planning period and if you have chosen some years as
monthly, all Proposal Distribution columns will be displayed in months.

Portfolio Dashboard

The portfolio dashboard lets you gather insights by looking at visual representations of Risk vs.
Benefit, Investment vs. Return on Investment (ROI), and so forth. The dashboard displays all
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project data that has been selected in Budget Planning of the current scenario. Select
Dashboard at the top of the scenario sheet to view the portfolio dashboard. A bubble chart
displays alongside six fields with drop-down menus: Chart Type, X-Axis, Y-Axis, Bubble Size,
Shape, and Color. Use the drop-down menus to select values for each field. A bubble color
legend is displayed below the chart.

Select Reset to clear all selections.

Select Apply to configure the chart based on your selections.

Select Update to apply your configuration to the chart. The chart configuration saves upon
selecting Update.

Note

The system will not display the bubble chart legends when the number of projects
exceed 100 (one hundred) items. This is the limitation of the technology framework.

Open a Scenario Sheet

On the Portfolio Manager log, double-click the portfolio that contains the sheet you want to
open.

The system displays one of these scenario sheets:

• The scenario sheet marked "shared"

• The scenario sheet that was last updated, if there is no shared scenario

You can resize the column that is available in the left of the split. The fields, in the left side of
the split, will be editable along with the fields in the right side of the split.

In the Project Portfolio Manager (PPM) scenario sheet, regardless of their position (left or right
splits), the following are considered special columns and are read-only:

• Project Name

• Project Number

• Project State

These fields are read-only because the option “Enable Column Editing” (in the Column
Properties window) is not selected.

For the “Start Date” column, if the Project State is in execution, the column will not be editable
in the scenario sheet, whether placed in right or left side of the split.

For the “Start Date” column, if the Project state is not in execution, because the field is editable
in the right side of the split, if the column is moved to left it can be edited in that scenario sheet.

The read-only columns will have a background color.

For a selected cell, the corresponding row and column header, will be highlighted in color, with
border.

Monthly Breakdown of Actuals Values in Scenario Sheet
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For the projects that are in-progress, where Forecast Curve is used (not Baseline Curve), if the
Administrator has selected to display the monthly breakdown of Actuals (Display monthly
breakdown of Actuals option in the portfolio Configuration window), then:

• Within the Portfolio Manager for the current year, all months prior to the current month will
display the corresponding value from the Actuals curve, and the fields will be read-only.

• The current month will display the value from the Forecast, or the value from Actuals
curve. After the Actuals value is displayed, the cell becomes read-only.

Similarly, the Pre-Actuals (in the Project Portfolio Manager) will contain the total, from the
Actuals curve, for all previous years if the Actuals source is defined.

Example

For project City4, the user has defined Actuals source (in the Configuration window of the
portfolio) for period 2017.

For period between 1/1/16 to 12/1/17, the total Actuals amount is $7200.

The Actuals total for period 1/1/16 to 12/16 is $5806.45.

When the user opens the Project Portfolio Manager for period 2017, the "Pre-Actuals" column
will show the total amount from Actuals for previous year (1/1/16 to 12/1/16), and the Cash flow
Curve displays a steady incline.

Considering it is May 2017:

When the Actuals source is defined (in project City4) for the columns from Jan 2017 to April
2017, when the selected tab in the Portfolio Manager is not shared or is not approved, the
screen displays the corresponding value (read-only) that is coming from the Actuals curve in
the Cashflow.

For the month of May 2017, the corresponding values displayed for City4 will be editable, or
read-only, based on the Period Close Settings fields, defined in the Cash flow properties
("Enable auto snapshot on").

For the current year and current month, in the Portfolio Manager, the same logic applies as for
the Forecast Curve in the Cashflow.

Within the Portfolio Manager for the current year, for the current month, the logic will follow the
same logic as for the forecast curve in the Cash flow (Cash flow by Forecast - CBS).

If the Enable auto snapshot on option is checked, then:

• If the current date is before the date defined, the value shown in Portfolio Manager (for the
current month) will show the value from the Forecast Curve.

• If Replace current period forecast with Actual on cut off date" (in the Forecast options)
is checked, the value shown in the Portfolio Manager (for the current month) will be the
value from the Forecast curve.

• If the Allow edit of current period forecast until replacement by Actuals is checked,
the value shown in the Portfolio Manager (for the current month) will be editable;
otherwise, it will be read-only.

• If Replace current period forecast with Actual on cut off date (in the Forecast options)
is not checked, the value shown in the Portfolio Manager (for the current month) will be the
value from the Actuals curve.

• If the current date is on, or after, the date defined, the value shown in the Portfolio
Manager (for the current month) will show value from the Actuals curve and will be read-
only.
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If the "Enable auto snapshot on" option is not checked, the value shown in the Portfolio
Manager (for the current month) will be from the Actuals curve and will be read-only.

When the user shares the scenario in the Portfolio Manager, only the "ALL values of Forecast"
will be shared.

If the Project Portfolio Manager (PPM) is unlinked, then for those scenarios the Actuals will be
read-only for the previous months.

For approved scenarios, the monthly Actuals are displayed as read-only only when the PPM is
linked.

Unless the Cash flow is refreshed (even after the checkbox is selected), the Actuals will not be
displayed.

Additional information

Approved/shared date will reflect actuals spread data only if the project is unlinked.

For the existing PPM Sheet, for prior years (for example,2014), the actual data is not displayed
for yearly columns (for example, 2015 or 2016).

As the cash flow is refreshed, the current month forecast data will become non-editable in PPM
even if the project is not linked.

As the cash flow is refreshed, the current month and the previous month baseline data will
become non-editable in PPM even if the project is not linked.

Multiple Forecast Curve

If there are multiple forecast curves defined within a project, with different option setting, this
system displays a warning message (through a red triangle) in the current month cell when you
hover over. In this case:

• For the future months, the scenario sheet shows cumulative values on forecast. For the
prior months, the scenario sheet shows cumulative values for actuals.

• For current month, the scenario sheet shows the cumulative actuals values which are
linked to forecast as read-only, always.

For support for monthly actuals, in case of consistent settings in multiple forecast curves, the
behavior for the current, prior, and future months will be determined according to the existing
functionality.

Project Portfolio Manager (PPM)

Whether linked, or unlinked, in the scenario sheet, the approved and shared data actuals
spread are displayed in the Cashflow.

For the current month forecast data, whether the PPM is linked or unlinked, the system retains
the forecast settings in the Cashflow.

Yearly PPM

In an existing PPM scenario sheet, for prior years actuals, data is seen as read-only for yearly
columns if the checkbox to show monthly actuals is selected in the PPM configuration.

The current and future years will be determined according to the existing functionality.

View a Scenario Sheet's Properties
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To view a scenario sheet's properties, from the toolbar, select Menu Options (  ), and select
Properties. The Properties will show you the following information:

• Portfolio name

• Planning period for the portfolio analysis

• Date the portfolio was created

• Any other fields of information that were added to the Portfolio Manager form

Unlink or Link Projects

When you create a scenario, the system populates the sheet with all the projects that have met
the criteria for inclusion on the sheet. (These criteria were created in a query by your
administrator when the Portfolio Manager was configured.) This is a dynamic process that
occurs whenever you open a scenario sheet. The projects that appear on the sheet will
fluctuate, depending on whether they still meet the criteria for inclusion. For example, a project
that was previously on the sheet may be dropped from the sheet if it no longer meets the query
criteria. Another project may be added to the sheet because it now meets the query criteria.

According to the configuration your administrator created for the Portfolio Manager, all the
projects on the scenario sheet will be automatically either linked or unlinked when you first
open the scenario sheet.

• If they are linked, the data on the scenario sheet is linked to the project data and is
updated every time you open the sheet. Any new project that is added to the sheet will also
be linked.

• If they are unlinked, the data on the scenario sheet is not linked to the project data and will
not be updated by changes in the project data. Any new project that is added to the sheet
will also be unlinked.

You can link and unlink one or multiple projects.

To link a project on the scenario sheet to current project data:

1. Select the project row(s) you want to link.

2. Select the gear menu ( ) next to one of the selected rows, and select Link, or select the
cell in the Linked column of that row. The system will display a warning that any numbers
you changed on the sheet will be lost if the project is linked. When the project is linked, you
will see a link icon in the Linked column beside the project(s) name(s).

3. Select Save.

To unlink a project from the scenario sheet:

1. Select the project row(s) you want to unlink.

2. Select the gear menu ( ) next to one of the selected rows, and select Unlink, or select
the cell in the Linked column of that row. When the project is unlinked, the system will
delete the link icon in the Linked column beside the project(s) name(s).

3. Select Save.
You can also unlink a project by editing any cell in the row. After you start editing, the
system will automatically unlink the project from the project data.

Edit Numbers on a Sheet
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A primary function of scenario sheets is to make it easy for you to modify numbers and see the
resulting budget analysis quickly. You can edit the following numbers on the scenario sheet:

• Cash flow projections

• Targets for cash flows and numeric columns

• Start and end dates for planned projects

When you edit any of these numbers, the system dynamically updates totals and calculates the
differences between target numbers and those totals; however, it does NOT change a project's
live data. Your proposed numbers are stored only in the Portfolio Manager and will not affect
live project data until a scenario has been approved by your company management.

Note

When you edit numbers in any project row, the system automatically unlinks that
project row from the project data.

To edit numbers on the sheet:

1. Double-click the cell containing the number you want to change. The cell becomes
editable.

Note

If any yearly projections have been broken down into months, you must make your
edits in the month cells, not the yearly total.

2. Enter the change.

3. Press the Enter key on your keyboard, or press the Tab key to move to the next editable
cell in the row.
The system updates the values in the Total and Difference rows for this column and flags
the cell to indicate that there is a discrepancy between the number you entered and the
project data.

Note

To leave a cell without saving your changes, press the ESC key on your keyboard.
The system restores the original numbers to the cell.

4. Select Save All.

You cannot edit:

• Project name

• Number

• Status

• Location
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Drill Down to Project Data

During the planning cycle, you might need quick access to project data to view project
characteristics, schedule activities, cost data, cash flow data, and other information. In
addition, you might need to update some of this data as you are working on a scenario. For
this purpose, the project names on a scenario sheet are hyperlinked to the project. If you have
permissions, you can open the project's landing page from the scenario sheet and view or edit
data directly in the project.

To drill down to project data:

On the scenario sheet, select the hyperlinked project name. The system opens the project
landing page in a new window. From this page, you can navigate to project data and view or
edit it directly.

The scenario sheet remains open in a separate window so that you can easily work on both
the project data and the scenario sheet at the same time.

Additional Information

If a Drill Down dashboard (Table or Grid) is set to show data from the current shell, when you
create a report of your records, the report will contain all the pertinent records as hyperlinks,
which can take you to the details of that record.

If a Drill Down dashboard (Table or Grid) is set to show data from sub-shells, when you create
a report of your records, the report will contain all the pertinent records without any hyperlinks,
which is by design.

Change Start Dates

You can change the start dates of planned projects, but not those in execution. When you
change a start date, the system shifts the end date to preserve the project duration and also
shifts the cash flow numbers (excluding pre-actuals) left or right to preserve the cash flow
distribution.

To change a start date:

1. Double-click the date in the Start Date column. The system displays a calendar.

2. Choose the new date from the calendar.
The system shifts the end date and the cash flow numbers to reflect the change.

How the System Distributes Cash Flow

The system stores all cash flow amounts by month in the database. The logic that the system
uses to distribute cash flow dollars is rendered in monthly allocations and presented as follows:

• If you move the start date backwards by (for example) three months, the system will move
all the cash flow amounts (excluding the pre-actuals column) left by three months and
display a zero dollar amount in the last three month columns for that year. Amounts from
the following fiscal year will not move left.

• If you move a start date forward by three months, the system will move all the cash flow
amounts (excluding the pre-actuals column) right by three months and display a zero dollar
amount in the first three month columns. The cash flow amounts will continue to move
forward in time, replacing the values of the next three months with the values of the past
three months. If the cash flows through multiple years, the total for the next year will
increase by the three months' amount, and the monthly cash flow for the last three months
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of the previous year will replace the new year's first three months. The rest of the new
year's monthly values will move forward three columns.

Change Cash Flow Amounts

You can change the cash flow amounts of any project on the sheet, planned or in execution.
When you change a number in the cash flow amounts, the system unlinks the project from the
live project data.

To change a cash flow amount:

1. Double-click the cell that contains the amount you want to change.

2. Enter your change, and press Enter.
The project's Total amount and the year's total amount increases or decreases by the
amount you entered. The system calculates the difference, indicates the edited column
amounts in italics, and changes the color of the text in the cell.

Create and Manage Views on a Scenario Sheet

To make viewing information easier on either the scenario sheet or the project candidate list,
you can create views that show relevant cash flow columns.

To create a view:

1. Select View, and select Create New View. The New View window opens.

2. In the Save View As field, enter a name for the view.

3. Complete the Columns tab to determine which columns will be visible in this view.

a. In the Columns tab, choose columns from the Available Columns list, and select Move
to add columns to the Selected Columns list, or select the Move All double arrow to
move all available columns to the Selected Columns list.

b. You can remove columns from the Selected Columns list by selecting columns and
selecting Remove or Remove All.

4. Complete the Filters tab. See Filter the Scenario Sheet.

5. Complete the Group By tab. See Group the Data on a Scenario Sheet.

6. Complete the Sort By tab. See Sort the Data on a Scenario Sheet.

7. When finished, select Save.

Note

Avoid defining a view with no columns selected.

To manage a view:

1. Select View, and select Manage Views.
The Manage Views window opens.

• You can select the box in the Visible column to Show View or deselect it to Hide View.

• You can select  to Delete View.

• You can select and drag views to reorder the way they will appear in the View menu.
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2. When finished, select Save.

Filter the Scenario Sheet

When creating a view, you can make viewing project information easier by using filters on both
the scenario sheet and the project candidate list to narrow the focus of information to particular
specifics, such as a date range, or a budget amount. For example, you might want to see only
those projects in a specific date range, or only those projects with budgets greater than a
specific amount, or projects of a specific type.

How you filter information depends on the column you choose to use as a filter. For example,
you can use a text column, such as Project Name, or you can use a date column, such as Start
Date. You can also use the AND and OR operators to apply multiple filters.

To filter information:

1. In the View drop-down menu, select Create New View.

2. In the New View window, select the Filters tab.

3. Select Add Filter.

4. Choose a Data Element: This drop-down list displays all data elements that are on the
attribute form. Any data elements in a hidden block are not available.

5. Choose a Condition: This drop-down displays a list of conditions. This list is based on the
type of data element selected.

6. Choose a Value: Depending on the type of data element, choose a value that the query
condition must meet.

7. To add additional filters, select Add Filter again, and repeat the preceding steps.
You can use the same data element multiple times.

8. If you are using multiple filters, select the applicable operator that should apply:

• And: If you want to specify that the view must match all listed filters, select And.

• Or: If you want to specify that the view should match any of the listed filters, select Or.

9. When you are done, select Save.

Group the Data on a Scenario Sheet

When creating a view, you can group the data on the sheet by column. Grouping data can
make it easier to identify projects with similar characteristics, such as estimated cost or start
date. You can group by any column except the Pre-Actuals and year columns. When you
group data, the system displays a sub-total amount by group.

To group the data:

1. In the View drop-down menu, select Create New View. The New View window opens.

2. Navigate to the Group By tab.

3. Select the column by which you want to group the data from the drop-down menu.

4. Select Ascending or Descending from the Order drop-down menu to determine the order
in which the data will be displayed.

5. Add more groups by selecting the gear menu ( ), and then selecting Add Below.
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• When you create multiple groups, you can use the gear menu to Add Above or Add
Below.

• When you create multiple groups, you can use the gear menu to Move Up or Move
Down, to determine the order in which your groups will appear on the scenario sheet.

• You can use the gear menu to Delete groups that you have created.

6. When finished, select Save. Whenever you open this view, it will display the data in this
grouping.

Sort the Data on a Scenario Sheet

To make data easier to locate alphanumerically on either the scenario sheet or the project
candidate list, you can sort the information by column in ascending or descending order.

To sort the sheet by column:

Hover over the column heading. A set of arrows will appear. Select the arrows to sort the data.

• Select the arrow once to sort Ascending.

• Select the arrow a second time to sort Descending.

To sort the sheet by column when creating a view:

1. In the View drop-down menu, select Create New View. The New View window opens.

2. Navigate to the Sort By tab.

3. Select the column in which you want to sort the data from the drop-down menu.

4. Next, select Ascending or Descending from the Order drop-down menu to determine the
order in which the data will be displayed.

5. Sort more columns by selecting the gear menu ( ), and then selecting Add Below.

• When you sort multiple columns, you can use the gear menu to Add Above or Add
Below.

• You can use the gear menu to Delete sortings that you have created.

6. When finished, select Save. Whenever you open this view, it will display the data in the
way you have sorted it.

Create a Scenario

When you create a portfolio, the system automatically creates one initial scenario sheet. You
can create additional scenario sheets.

To create a scenario sheet:

1. Select the plus sign at the top of the scenario sheet window.
The system adds a "new scenario" tab to the top of the window.

2. Enter a name for the new scenario, and press Enter.
You can include up to 30 characters in the name. Letters, numbers, hyphens, spaces,
underscores, and special characters are allowed.

The project records that will be included on the scenario sheet are extracted from the database
using a query that your Administrator created when the portfolio was configured. Whenever
you create or open a scenario sheet, the system re-runs the query and adds or removes
projects from the scenario depending on whether the project matches the query criteria. For

Chapter 1
Portfolio Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 426 of 671



example, a project that was previously on the sheet might be dropped from the sheet if it no
longer meets the query criteria. Another project may be added to the sheet because it now
meets the query criteria.

Edit the Name of a Scenario Sheet

To edit the name of a scenario sheet:

1. At the top of the scenario sheet window, double-click the tab showing the name that you
want to edit. The tab name becomes editable.

2. Change the name as necessary. You can include up to 30 characters in the name. Letters,
numbers, hyphens, spaces, underscores, and special characters are allowed.

Duplicate a Scenario

To duplicate a scenario:

1. At the top of the scenario sheet window, select the tab containing the scenario you want to
duplicate.

2. In the upper-right corner of the window, select Duplicate.
The system duplicates the scenario into a new tab, which you can rename. All the projects
in the original scenario will be duplicated to the new scenario, including their linked or
unlinked state, and current column widths, targets, sorting, and so on. For the new
scenario, the system will calculate the new totals and then calculate the variance to show
the difference.

Share a Scenario

Sharing a scenario makes the budget numbers you propose available to project managers for
viewing. Project managers will not see the changes you make on the scenario sheet itself.
Instead, the project managers will use a read-only portfolio budget curve in their Cost Manager
Cash Flow node to view both their original budget curve and a parallel scenario curve that
shows the differences between their initial forecast projections and your proposed numbers.

For project managers to see the portfolio budge curve, you must share the scenario. For more
information about the portfolio budget curve, refer to the Unifier Modules Setup Administration
Guide and the Unifier Managers User Guide.

You must have "full access" permission to share a scenario. You can share only one scenario
at a time.

To share a scenario:

1. At the top of the scenario sheet window, select the tab containing the scenario you want to
share.

2. In the upper-right corner of the window, select Share.

3. Select Save.
The system visually marks the scenario tab with a "shared" icon and makes the scenario
numbers visible on the portfolio budget cash flow curve for the project manager to see.

To stop sharing a scenario:

1. At the top of the scenario sheet window, select the tab containing the scenario you want to
stop sharing.
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2. In the upper-right corner of the window, select UnShare.

3. Select Save.

Remove a Scenario

To remove a scenario:

1. At the top of the scenario sheet window, select the x on the tab containing the scenario you
want to delete, or

2. Right-click the tab containing the scenario you want to delete, and select Remove.

3. Select Save.

Approve a Scenario

After management has approved a scenario for the portfolio, you can mark the scenario as
"approved." You must have "full access" permission to approve a scenario.

After you approve a scenario, the system:

• Marks the approved scenario "shared" so that project managers can see the approved
dates and numbers. The scenario is set to read-only mode and can no longer be modified
or deleted.

• Updates each project's original budget numbers with the proposed numbers on the
approved scenario.

• Updates each project's monthly or yearly cash flow numbers with the proposed numbers
on the approved scenario.

• Updates the project start date (if it was changed) for any planned projects that will begin
during the portfolio's planning period.

• Updates the project/shell data with any project/shell information that was changed on the
scenario sheet, and sends you an email notification of the updates

• Locks the budget and cash flow numbers to prevent any further changes.

To approve a scenario:

1. At the top of the scenario sheet window, select the tab containing the scenario you want to
approve.

2. In the upper-right corner of the window, select Approve.

3. Select Save.
When you approve a scenario, the system automatically shares the scenario and visually
marks the scenario tab with an Approved and Shared icon to indicate to project
managers that this is the approved scenario.

To "un-approve" a scenario:

1. At the top of the scenario sheet window, select the tab containing the scenario you want to
un-approve.

2. In the upper-right corner of the window, select UnApprove.

3. Select Save.
The Portfolio Manager deletes the approval icon from the tab, but does not delete the
shared icon. If you want to stop sharing the scenario as well, you must select Unshare in
the upper-right corner of the window.
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Note

If you "un-approve" a scenario, the system does not reset dates to their original
values. Date fields will retain the approved values.

Export the Scenarios

To use scenario data for additional purposes, you can export your scenario sheets to CSV files
or Excel sheets.

To export scenarios:

1. Select Print at the top of the window.

2. Select Export To CSV or Export To Excel.
The Portfolio Manager will export all your scenario sheets.

Note

• For export to Microsoft Excel, the system currently supports only Euro (EUR)
and United States Dollar (USD) currency symbols.

• If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you might
need to configure your columns in Excel to match the correct data type
(Number). Otherwise, the columns will not be treated as numeric and will not
sum as expected. One supported format includes placing the negative sign
between the currency symbol and the amount (for example, $-1,000). One
supported format includes placing the negative sign between the currency
symbol and the amount (for example, $-1,000).

You will see a prompt at the bottom of the window, asking you to open or save the files.

When you open the file, it displays the data from each scenario sheet, arrayed in tabs and
columns identical to the Portfolio Manager scenarios. The sheet will include any formulas that
were created in the Portfolio Manager for calculating values. The sheet also retains the frozen
columns, as well as the scrolling ability so that you can scroll through the cash flow columns.

Financial Period in Portfolio Manager

If you select the financial period type of the period structure in the configuration of Portfolio
Manager, the system summons all the sub-periods, based on the selected planning period
(drop-down list), starting from the year.

When you select Financial period in the time scale of Cash Flow curve, the system populates
the financial period (present in the Shell options) in the financial period field of that Cash Flow
curve.

The financial period present in the Shell options of parent Shell will not be used to filter projects
in Portfolio Manager.
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Note

When a financial period from the Shell is being used in a portfolio, you will not be able
to change it in the future unless you delete all the scenarios associated with it.

The system displays all the periods (and their names) in Portfolio Manager as individual
columns.

The scenario sheets bring in the following data from any Shell type in a hierarchy:

• Project information from the Shell Attribute Form

• Project information from a single-record business process

• Project start and end dates from the Shell Attribute Form

• Project start and end dates from a single-record business process

• Cash Flow data (both forecasted and actual) from each project Cost Manager

• Column names in the Portfolio manager will be the period name from financial period.

• Forecast & Actuals data will be populated only when user chooses the Forecast option in
Cashflow Begin calculations at end of curve.

• Forecast data will be populated if Display financial period breakdown of Actuals
checkbox is not selected.

• Actuals data will be populated if Display financial period breakdown of Actuals
checkbox is selected.

• Baseline data will be populated if user has not used the option in Forecast Begin
calculations at end of curve.

After these scenario analyses have been completed, you can send the best (or several best)
scenarios to the executive decision makers for approval. After a scenario has been approved,
the system:

• Marks the approved scenario "shared" so that project managers can see the approved
dates and numbers. In this case, the scenario is set to read-only mode and can no longer
be modified or deleted.

• Updates each project's original budget numbers with the proposed numbers on the
approved scenario.

• Updates each project's monthly or yearly cash flow numbers with the proposed numbers
on the approved scenario.

• Updates the project start date (if it was changed) for any planned projects that will begin
during the portfolio's planning period.

• Locks the budget and cash flow numbers to prevent any further changes.

Note

The pre-actuals will be the consolidated amount for actuals before the start of
Financial Period.
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Planning Manager
The Planning Manager provides sponsoring companies the ability to create, organize, manage,
and update all company or project/shell planning initiatives from conception to completion. It
supports the ability to define unlimited number of planning categories, such as capital project
planning, IT planning, resource planning, and so on, providing a flexible method for managing
and organizing any type of planning initiative.

The Planning Manager provides the flexibility of defining unique planning item property forms
and planning sheets. Each planning sheet can be configured with any number of columns to
capture and manage data for all planned items.

In addition, the planning sheet can be configured to compare planned data with actual rolled up
data from projects/shells, related to each planned initiative.

The Planning Sheet is central to Planning Manager functions. Each planning item "type" (such
as a capital plan or a campus remodel) can have one or more planning sheets that contain
information about the plans of this type being considered by your company or project. It is from
these sheets that you can access, create, update, and import or export company plans.
Business processes designed for planning items can roll up information onto the planning
sheets. In addition, Project/Shell Creation types of business processes can be designed to
create projects/shells for planning items when they reach a certain status or condition. If the
Project/Shell Creation BP includes a Planning Item Picker, you can link new projects/shells
with a planning item. At runtime, this BP will automatically create a link to the planning item
when the project/shell is created, and data will begin to roll up to the Planning Sheet from the
business processes in this project/shell.

The Planning Items node is where you create plans and proposals, import plans from outside
applications, export a plan template, and link a plan to a running project/shell in Unifier.

The Planning Sheets node is where you create and manage planning sheets. A planning
sheet can contain data for one or multiple plans and proposals. From the planning sheet, users
can automatically update individual plans with data added to the planning sheet and refresh
the data on the sheet, such as changes to dates or cost numbers.

About the Planning Manager

The Planning Manager is where you can plan for new projects/shells and proposals and create
forecasts for those projects/shells that are already running in the system. You cannot
administer planned projects/shells the way you administer real projects/shells; however, you
can manage the planning phases for these projects/shells as business processes using the
same functions used by other business processes. Planned projects/shells can include cost
sheets, resource sheets, funding sheets, and other typical business processes; but certain
data, such as dates and monies, can be viewed as future forecasts.

You can have a Planning Manager at both the company and project/shell levels.

The Planning Sheet is central to Planning Manager functions. This sheet contains information
about all the plans (planning items) being considered by your company. It is from this sheet
that you access, create, update, and import or export the company's plans. From the planning
sheet, you can automatically update plans with changes made on the planning sheet.
Reciprocally, you can refresh the planning sheet with changes made to individual plans. In
addition, planning sheets can be configured to compare planned data with actual rolled-up data
from projects/shells related to each planning item.
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Using a Project/Shell Creation type of business process, you can create projects/shells for
planning items when they reach a certain status or condition. If the Project/Shell Creation
business process includes a Planning Item Picker, you can link new projects/shells with
planning items. Instead of linking a planning item to a project in the Planning Manager, this
business process will automatically create the link when the project/shell is created, and data
will begin to roll up to the Planning Sheet from the business processes in this project/shell.

Using the snapshot feature, you can take a "picture" of the planning sheet at any point in time.
This is a way of "drilling down" into the planning process to expose specific plans or planning
phases for particular attention.

The Planning Items node is where you create plans and proposals, import plans from outside
software applications, export a plan template, and link a plan to a running project/shell in the
system.

The Planning Sheets node is where you create and manage planning sheets. A planning
sheet can contain data for one or multiple plans and proposals. From the planning sheet, you
can automatically update individual plans with data added to the planning sheet and refresh
the data on the sheet, such as changes to dates or cost numbers.

Access Planning Items and Planning Sheets

The Planning Manager groups planning initiatives by planning type; for example, Capital
Planning or IT Planning. Each planning type will have a node available for planning items in
that type and also for planning sheets to manage the planning initiatives.

Planning items and sheets are grouped by their planning type.

To view planning items and planning sheets:

1. In User mode, navigate to:

• (For a Planning Manager at the company level) Go to the Company Workspace tab
and select Planning Manager in the left Navigator.

• (For a Planning Manager at the project/shell level) Open the shell or sub-shell where
the Planning Manager resides. In the left Navigator, select Planning Manager.

The system expands the left Navigator to show the planning types and their corresponding
items and sheets.

2. To view:

• Planning items, choose a <planning type> - Items

• Planning sheets, choose a <planning type> - Sheets

The system displays the items or sheets in the right pane.

Note

If an advanced log has been designed for the Planning Manager, the log will
display a tree structure with a middle column that narrows the navigation to help
you locate and select the correct item or sheet.

3. To open the item or sheet, double-click the name of it in the right pane.

Access Planning Items from Master Log - Business Processes node
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The Master Log - Business Processes node can list all planning items at the project/shell
level in separate nodes for each type.

Note

The name of the Master Log - Business Processes node can be customized.

If you are an active member of the project, shell, or sub-shell, and you have permissions, you
can access project/shell planning item records from the Master Log - Business Processes
node. The Master Log - Business Processes node is in the Home tab. The Master Log -
Business Processes node allows you to access all or a subset of records of the same type, in
a single log that spans multiple projects/shells. Also, you can create and use saved searches
under the Master Log - Business Processes node.

Note

If you do not have permissions to view any of the business process types listed under
the Master Log - Business Processes node, you will not see the Master Log -
Business Processes node in the Home tab.

Records are listed under the Master Log - Business Processes node by planning item type.
The Master Log - Business Processes node can be renamed by your Administrator, and
access to the node depends on permissions.

Depending on permissions, you can perform these actions on records listed in a Master Log:

• Create a new record

• Edit an existing record

• Perform bulk edits on records

You can also save searches of records in the Master Logs as needed.

To access Master Logs:

1. Go to the Home  tab.

2. In the left Navigator, select Master Log - Business Processes (or Master Logs -
Planning Items).

3. Select the name of the item you want to access.

Planning Manager Item Log (Attributes)

The Planning Item log displays the log and the preview pane.

To access the log for the company level:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Planning Manager.
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Note

The functions of the options presented below have been explained in the
preceding sections. This section explains new functions and procedural
differences.

The log contains the following toolbar options:

• Create
When you select Create to create a new record, the Create New Planning - Item window
opens. The three horizontal bars icon enables you to update a record and access the
following:

– Delete

– Print

* HTML

* PDF

* Custom

– Terminate Record

– Transfer Ownership

– Help

* [Planning Item] Help

* User Productivity Kit

– Close

During the creation step, the record has the following tabs:

– Comments
Enables you to add comments to the Planning attribute, only in the edit mode.

– Linked Records
Enables you to link records to the Planning attribute. The functional flow is the same
as a non-workflow business process.

Note

When you are updating a record, the following additional tabs are displayed:
Audit Log and Reference Records.

• Actions

• View

• Edit View

• Refresh

• Print

– Print

– Export To CSV

– Export To Excel
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Note

* For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

* If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

• Search

• Find on page

• Help

– [Planning Item] Help

– User Productivity Kit

The Actions option enables you to:

• Import

• Export CSV Template

• Edit Permissions

• Bulk Edit

• Print

• Transfer Ownership

• Terminate Record

• Bulk Delete

• View Import Audit Log

For each record, the gear menu ( ) are as follows and each option enables you to conduct
the action on one particular record.

• Open

• Edit Permissions

• Print - HTML

• Print - PDF

• Print - Custom

• Transfer Ownership

• Terminate Record

• Delete

The log preview pane has the following tabs:

• Record Details
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• Attachments

• Permission

Note

If an attribute form is present, you can hover over the question mark (?) symbol to
see more information in the form of a tooltip.

Planning Manager Sheet Log

Similar to the Cost Sheet log, the Planning Manager Sheet log (for Company-level, Shell-level,
and Project-level sheets) contains the following elements:

• Log header

• Toolbar

• Grid with columns and rows

• Right pane with tabs corresponding to each row of the sheet log

Toolbar

Option Description

Create As designed in uDesigner, the Create window enables
you to enter values in fields that are categorized in
different blocks.
To modify the Data Sort options, open the Planning
Sheet, select Edit View, and then select Sort By.

Actions Contains the following options:
• Permissions
• Delete
• Refresh

Refresh Select Refresh to update the items on the log or roll up
planning items from project level to company level.

Note

The last update date displays
only if the data element,
uuu_last_update_date is
included in the design of the
planning sheet.

Print To print the log.

Chapter 1
Planning Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 436 of 671



Option Description

Search Similar to the Search option in the Business Processes
log, this option enables you to search among log items.
The Search window contains all the elements from the
Planning sheet detail form log Find section, from
uDesigner.
If the Find option is not defined in uDesigner, there will
be two fields in this window: <label of DE uuu_name>
and <label of DE uuu_last_update_date>. You can run a
search on these two sheet attributes.
If the elements are defined in the log (the Find option is
defined in uDesigner), all the defined elements appear
in the window in the same order as defined in
uDesigner.

Find on Page To find an item on the log.
<Planning name> Help To access corresponding help.

Columns

All columns are displayed according to the log design in uDesigner. Select Refresh to
update any planning item record or roll up planning items from project level to company level.
The last update date displays only if the data element, uuu_last_update_date is included in the
design of the planning sheet.

Rows

If the newly created sheet is the one that updates the planning items, the first column (Updates
Planning Items) displays a check-mark icon.

At a given time, only one planning sheet in the log can updated Planning Items. So, if you
modify the properties of a sheet to change the value of "Update Planning Items," the check-
mark icon (in the first column) will appear or disappear based on your changes.

When you open the log (selecting the Planning Sheets node in the Navigator) and there are no
records in the log, the right pane does not have any contents.

When you open the log (selecting the Planning Sheets node in the Navigator) and there are
records, then:

• If no sheet is set to update the planning items: The topmost row in the log is selected by
default and the right pane displays the selected sheet properties.

• If one of the sheets in the log is set to update the planning items: The sheet is selected by
default and the right pane displays the sheet properties.

The tabs in the right pane are:

• Properties
This tab is selected by default and displays all attributes of the planning sheet as defined in
uDesigner. The tab also contains the option to choose whether a sheet updates the
planning items.

• Permissions
If you do not have Modify permission or Full Access permission (for planning sheets), you
will not be able to view the Permissions tab. Also, if you do not have the Modify Properties
permission (for Planning Sheet), you will not be able to modify the planning sheets
properties.
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• Audit Log
Similar to the other audit logs in the system, it displays the actions taken by the users. You
can also view additional information about each Event in the Audit Details section located
below the Audit Log tab.

The gear menu ( ) for each planning sheet:

• Open: To open the planning sheet.

• Permissions: To edit the permissions to the sheet.

• Copy: Use Create Planning Sheet overlay form. All properties of the source sheet are
shown as copied into this overlay form.

• Delete: To delete a sheet.

You can select multiple sheets and right-click to delete.

The gear menu is not available when you select multiple sheets.

Create a Planning Item

To create a planning item:

1. Navigate to:

• (For a Planning Manager at the company level) Go to the Company Workspace tab,
and switch to User mode. In the left Navigator, select Planning Manager.

• (For a Planning Manager at the project/shell level) Go to the shell tab where the
Planning Manager resides and switch to User mode. In the left Navigator, select
Planning Manager.

The system expands the navigator to show the planning types and their corresponding
items and sheets.

2. Select the [planning item] - Items node. The [planning item] log opens.

3. Select Create. The planning item form opens.

4. Complete the form fields. The form fields will vary depending on the design of the form for
this planning type.

Note

If the planning item form has a Project or Shell Picker, you can use it to link the
planning item directly to a project/shell. Business processes in the project/shell
with fields that match those on the planning item form will roll up values to the
Planning Sheet.

5. Save the form (select Save to save or Submit to prevent further editing).

Bulk Edit Planning Items from the Planning Manager Log

To edit planning items in bulk:

1. Navigate to the Planning Items log.

2. Select the desired planning item.
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3. From the log, Ctrl+select to select the items that you want to edit.

4. Select Actions, and select Bulk Edit to open the Bulk Edit window.
The window is divided into two panes. Use the left pane to edit the details of each record.

The system automatically selects the Update checkbox when you type into or modify a
field. You can deselect it if you do not want to modify the field at this time.

Use the right pane (Action Status) to preview the status of each record.

5. When finished, select Close.

For more information on editing these records in bulk, refer to the Unifier Business Processes
User Guide.

Delete Planning Items

You can delete planning items if they are in a non-terminal status. You can delete planning
items in two ways:

• From the planning item record itself

• From the Planning Manager Log using Bulk Delete mode

Note

When you delete a record, it is not actually deleted. It is only hidden from view on
the log; the record remains in the system. Consequently, you cannot create
another record with the same name. If there is a business process that auto-
creates a planning item record, the name of that planning item will need to be
changed; otherwise, you will never see it on the log.

To delete a planning item from a record:

1. Open the record.

2. From the toolbar, select Delete.

To delete planning items from the Planning Manager log:

1. Open the planning items log.

2. Highlight the item or items you want to delete.

3. From the gear menu ( ), select Delete.

Note

You cannot delete planning items from a master log.

Create a Planning Sheet

You can create planning sheets for each planning type. These are based on templates created
in Admin mode.

To create a planning sheet:
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1. Navigate to:

• (For a Planning Manager at the company level) Go to the Company Workspace tab
and select Planning Manager in the left Navigator.

• (For a Planning Manager at the project/shell level) Open the shell or sub-shell where
the Planning Manager resides and select Planning Manager in the left Navigator.

The Navigator expands to show the planning types and their corresponding items and
sheets.

2. Under the planning type for which you want to create a sheet, select the [planning item] -
Sheet node. The planning sheets log opens.

3. Select Create. The Properties window opens.

4. In the General block, name the planning sheet and enter an optional description.

5. In the Options block, you can select:

• Update Planning Items: Select this checkbox if you want planning sheet users to be
able to manually edit planned item data. This helps prevent conflicting data from
multiple planning items. This box can be selected on only one sheet per planning type.

6. Select OK. The planning sheet opens. The columns are those defined in the default
structure. You can add additional columns as needed. Rows correspond to planning items.
See Add and Manage Planning Sheet Rows.

Copy a Planning Sheet

The user will be allowed to create a new planning sheet under a planning type by copying
another planning sheet. When a planning sheet is created by copying another planning sheet,
all column definitions, manually entered data with each row should be replicated (copied over)
including column definitions.

To create a planning sheet by copying another planning sheet:

1. Select a planning sheet from the Planning Sheet log.

2. Select Copy in the gear menu ( ). The Properties window opens.

3. Enter a name for the new sheet. You can change other information as necessary.

4. Select Save.

Open the Planning Sheet

To open a planning sheet:

In the log, select a sheet, and select Open in the gear menu ( ).

Columns displayed initially are based on the planning sheet default structure defined in Admin
mode (Configuration node).

Add and Manage Planning Sheet Rows

You can add planning items of the same type to create rows on the planning sheet. By default,
there are two rows at the bottom of the sheet, one for total and one for average, which add a
summary row for the column data.
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To add a row (planning item) to a planning sheet:

1. Open the planning sheet.

2. Select Add Rows. The Add Rows window opens, displaying the planning items created for
the planning type.

3. Select one or more items, and click Select. The rows are added to the sheet.

To delete a row from the planning sheet:

1. Open the planning sheet.

2. On the planning sheet, select one or more rows to delete.

3. Select Remove Rows.

4. Select Yes to confirm. The rows will be removed from the sheet.

Add and Manage Planning Sheet Columns

To add a column to a planning sheet:

1. Open the planning sheet.

2. Select Add Columns. The Add Columns window opens.

3. Enter a Datasource, a Query Data Type, Formula, and Column Position After.

4. Edit the Data Format and Additional Options as necessary.

5. Select Save & Add New. The column is added to the sheet.

To manage a column in a planning sheet:

1. Open the planning sheet.

2. On the planning sheet, right-click the column header for the column you want to edit. The
following options are revealed:

• Hide: Hides the column from view. This can be undone by selecting Menu Options,
selecting Columns, selecting Unhide, and then selecting [column name].

• Copy: Copies the current column. The properties of this copied column can be edited
when the Column Properties window opens.

• Delete: Deletes the column. Select Yes in the confirmation window that appears.

• Lock after this Column: Creates a lock in the sheet that cannot be moved or resized.
This can be undone by selecting Edit View, selecting Lock after Column, and then
selecting None.

• Insert: Opens the New Column window to insert a new column.

• Properties: Opens the Column Properties window to view and edit the column
properties.

Filter Planning Sheet Content

Some managers can accumulate a substantial amount of data. To make viewing this data
easier, you can create views that filter (restrict) the content of the sheet.

You can use the View option to access existing views, create views, or update existing views.
The views that have been created, including Default, are listed in the upper segment of the
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drop-down list. The lower segment of the list includes the Create New View and Manage
Views options.

To create a view:

1. Select Create New View.

2. Use the Save option to name your new view.

3. Use the following tabs for adding columns and filtering, grouping, and sorting information:

• Columns tab

• Filters tab

• Group By tab

• Sort By tab

4. Use the Columns tab to select the columns that you want displayed in the view.
The Available Columns box displays all the columns that you might want to include. The
Selected Columns box displays all the columns that you select. You can move columns in
and out of the Selected Columns box.

Use the following fields to set the position of the new view:

• Left Lock after Column: Displays a list of all columns, except the last column from the
selected columns list. By default, None is selected, which means that you have
chosen no column to be locked, from the left side of the sheet.

• Right Lock after Column: The default value is None, which means that you can
select not to right-lock the column in the view. Other values in this field are based on
the value that you have selected in the Left Lock after Column.

5. Use the Filters tab to control what information is displayed in the selected view.
You can add multiple filters to a view, and you can use the same data element multiple
times. When adding multiple filters, you can use operators to specify that the view must
match all listed filters or that it can match one or more of the listed filters.

a. Select Add Filter.

b. Choose a Data Element: This drop-down list displays all data elements that are on the
attribute form. Any data elements in a hidden block are not available.

c. Choose a Condition: This drop-down displays a list of conditions. This list is based on
the type of data element selected.

d. Choose a Value: Depending on the type of data element, choose a value that the
query condition must meet.

6. To add additional filters, select Add Filter again, and repeat the preceding steps.
You can use the same data element multiple times.

7. If you are using multiple filters, select the applicable operator that should apply:

• And: If you want to specify that the view must match all listed filters, select And.

• Or: If you want to specify that the view should match any of the listed filters, select Or.

8. Use the Group By and Sort By tabs to identify which columns should be used for group
and sorting and in what order.

9. When you are done, select Save.

To manage a view:

To update a view, select the applicable view from the View list, select Edit View , and then
make and save the applicable changes.
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To modify or remove a filter:

1. From within the applicable view, select Edit View , and select the Filters tab.

2. Make the applicable changes, such as changing the selected Data Element or Condition,
updating the Value, or removing one or more of the filters from a set.

3. To save your changes, select Save or Save As.

Copy Column Data

To copy column data from a planning sheet:

1. Open the planning sheet.

2. Select Menu Options.

3. Hover over Columns, and select Copy Column Data. This will open the Copy Column
Data window.

4. Select the column to copy from, the percentage of each row value to copy, and which
column to paste the information to.

5. If you would like the value to be copied to all rows for this column, under Rows, select All.
If you would like the value to be copied to only select rows, select Partial and select which
Planning Items to copy the column data to.

Modify Planning Items from a Planning Sheet

You can update planning item information from a planning sheet. The Update Planning Items
option must be selected in the Planning Sheet properties (Options section).

While defining columns on a planning sheet, data elements from the planning item can be
selected. Some of these data elements can be edited from the planning sheet. Changes made
to these elements are reflected on planning items automatically.

Data elements that are editable and not required on the planning item form will be editable
from the planning sheet. The following are conditions under which a data element is not
editable from the sheet:

• BP picker data elements

• Project picker

• Shell picker

• Data elements that are required on the form

• Data elements that are of SYS Logical Datasource (formulas)

• Data elements that are SYS Datasource

You cannot change the planning name. This can only be changed from the planning item
window.

Grant Planning Sheet Permission

In addition to module-level permission, access to each planning item and planning sheet can
be controlled based on user side permissions. The creator of a planning sheet is the owner of
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the sheet. By default, the owner has full sheet permissions. The owner can grant permission to
other users or groups as needed.

To grant permissions to a planning sheet:

1. In the planning sheet log, select the planning sheet.

2. Select Actions, and select Permissions. The Permissions window opens.

3. Add the users or groups you want to grant permission, and set the permission level.
The permission settings are:

• Modify Permission: Can view, edit, and modify permissions of a planning sheet.

• Modify Properties: Can edit planning sheet properties.

• Edit: Can view, add, edit, or import data on a planning sheet. The user cannot change
the column structure.

• View: Can view the planning sheet in view-only mode.

4. When you are done, select Save.
When you change settings in the Permissions window, the Save button is enabled. After
you select Save, a spinning wheel appears while your changes are saved and then the
Save button is dimmed.

To grant permissions to a planning item:

1. Open the Planning Item log that contains the item you want to grant permissions to.

2. Select the planning item.

3. Select Actions, and select Permissions. The Permissions window opens.

4. Add the users or groups to whom you want to grant permissions and set the permissions
you want to grant.

• Modify Permission: Users can view, edit, and modify permissions of the planning
item. With this permission, you automatically give the user edit and view permissions.

• Edit Data: Users can edit the planning item information.

• View: Users can view the planning item but cannot make changes.

5. Select Save to apply the permissions.
When you change settings in the Permissions window, the Save button is enabled. After
you select Save, a spinning wheel appears while your changes are saved and then the
Save button is dimmed.

Understanding Reverse Auto-population

Certain data elements support reverse auto-population. These are specified in uDesigner.
Reverse auto-population means that some values can be updated when other values are
modified in a business process record that has reached a specified status.

Depending on the setup in uDesigner, auto-population can occur in these instances:

• Changes to data elements in a BP upper form can result in changes to the upper form of
another BP.

• Changes to the detail form in a BP can result in changes to the upper form and detail form
of another BP.

• Changes to the upper form or detail form of a BP can result in changes in the Asset,
Resource, or Planning Manager forms.
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View the Import Audit Log

1. Navigate to:

• (For a Planning Manager at the company level) Go to the Company Workspace tab,
and switch to User mode. In the left Navigator, select Planning Manager.

• (For a Planning Manager at the project/shell level) Go to the shell tab where the
Planning Manager resides, and switch to User mode. In the left Navigator, select
Planning Manager.

The system expands the navigator to show the planning types and their corresponding
items and sheets.

2. Select the [planning item] - Items node.

3. In the [planning item] log, select the applicable item.

4. From the toolbar, select Actions, and select View Import Audit Log.

5. In the Import Audit Log, view information pertaining to the import process that created the
planning item such as the name of the CSV or Microsoft Excel file that was imported, the
date that the item was created and completed, the name of the user who performed the
import, and so on.

Note

By design, planning items with attachments are not included in the CSV import.

Print a Planning Manager Form

You can print a copy of a Planning item. You can choose PDF, HTML or Custom print formats
and select one of the following options:

• Save a copy of the form as a PDF file and print the file

• Print an HTML view

• Print from a Word file if a custom print layout has been created for the form

The Custom Print formats include the Oracle Analytics Server custom print templates designed
in the Custom Templates node. If custom print layouts have been created for the Planning
Manager, the form will print according to the layout that you select. For more information, see 
Printing Options - Custom Format.

To preview and print a Planning Manager item:

1. Open the planning item that you want to print.

2. From the gear menu ( ), choose either Print - HTML, Print - PDF, or Print - Custom.

• HTML to view the form in the browser which can then be printed.

• PDF to open the form in Adobe Reader, which can be saved or emailed as a PDF file,
or printed process, you are asked to save the changes to the form.

• Custom to select the Oracle Analytics Server, Microsoft Word, and PDF custom print
templates from the same place as the current custom prints. See Printing Options -
Custom Format for details.
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The Print Options window opens. This window displays the record information that can be
printed.

3. Select the checkboxes for the information that you want to print.

4. To select all the checkboxes, select Show All. To clear all, deselect Show All. If you
deselect all checkboxes, only the header and footer will print.

5. Select Print. The preview form opens in an HTML or PDF (Adobe Acrobat or Reader)
window, from which you can print.

Depending on your browser, the file will be downloaded automatically, or you will be prompted
to download the file manually.

Print Options for Planning Manager Form

Following is a summary of the print options.

Print option What it prints

Detail Form This prints the information entered on the form.
General Comments The general comment text and create details are printed.
Record Attachments File attachments to the record are listed alphabetically

by file name and include the file title, issue date,
revision number, and file size.

Record Attachments followed by Comments Prints comments associated with file attachments to the
record. "Record Attachments" must also be selected to
select this option.

To print a Planning Manager item with a custom print layout:

1. Open the planning item that you want to print. Be sure it is in a view mode.

2. From the Menu Options (  ), hover over Print, and then select Custom to select the
Oracle Analytics Server, Microsoft Word, or PDF custom print templates from the same
place as the current custom prints (Custom Format Print selection window).

3. Select a Template and Format, and then select Print. The File Download window opens.

4. Choose to Open or Save the file, which is a Microsoft Word .doc file.

5. Open the file in Microsoft Word and print.

Printing Options - Custom Format

The Custom Format Print window has two sections:

• Select a custom print template

• Select a template and format to print

Both sections facilitate custom print template and format selections.

Select a custom print template

Lists all the custom print templates, including the custom print templates created in the
Custom Templates node and the custom print templates. For example, the list may include
Oracle Analytics Server custom print templates, Word, and PDF custom print templates.

If there are multiple custom print templates, all the published templates are listed in this
section.
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The "Select a template and format to print" section is populated by the selection made in the
"Select a custom print template" section.

Select a template and format to print

• If you select an Oracle Analytics Server custom print, you can select the desired template
and format from the drop-down lists.

• Template drop-down displays all the available templates for the selected format.

• Format drop-down displays the available formats for the selected template.

• If the custom print template was created using PDF or Word, "Select a template and format
to print" is disabled.

Default template and format

• If an Oracle Analytics Server print template is selected, the default values in the drop-down
lists are set based on the default in the custom print template.

• When an Oracle Analytics Server print template is selected in the "Select a custom print
template" section, the template and format are populated based on the default value
selected at the time of designing the print template.

Resource Manager
If you have access to the Resource Manager feature, which was deprecated starting with
version 23.10, it lets you:

• View a company's personnel resources or those of a partner company

• View skills, proficiency levels, resource capacities, and more

• View roles associated with personnel working on projects

• View job functions associated with roles

Using the Resource Manager

The Resource Manager is available at the company level and allows you to view resources
and roles.

At the company level, the Resource Manager has two nodes:

• Roles: Displays the company-level roles entered in Admin mode.

• Resources: Displays the company-level resources that are hard-booked across projects.

View Roles

Roles are defined and maintained in Administration (Admin) mode at the company level. At the
company level, you can view role details, which includes resources and rates.

To view role details:

1. Go to the Company Workspace tab, and switch to User mode.

2. In the left Navigator, select Resource Manager, and then select Roles. The Roles log
opens.

3. Select a role, and select Open.
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4. In the Role Properties window, select any of the following tabs:

• General: Displays the role name, description, and status, and may display other fields;
the fields on this tab correspond to the Role Attribute Form.

• Rates: Displays standard and overtime rates defined for the role.

• Resources: Displays resources that have been associated with the role.

View Resources

Resources are defined and maintained in Admin mode at the company level. You can view
resources that are hard-booked for a project or across multiple projects.

To view resource details:

1. In User mode, do one of the following:

• To view resources across projects, go to the Company Workspace tab, select
Resource Manager, and then select Resources.

• To view resources for a project, go to the shell tab, select project, select Resource
Manager, and then select Resources.

The Resources log displays the following information for each resource:

• Resource Code: Automatically generated, manually entered, based on the
configuration.

• Resource Name: This is the name of the resource.

• Resource Type: Description of the resource.

• Default Resource Capacity (Hrs): Default value is 8. This defines the number of
hours a person can work in a day.

• Sunday (Hrs.).....Saturday (Hrs.): Depending on the design of the Resource Attribute
Form, these fields may or may not appear on the General tab. If they do, they will
show the number of hours the resource can work on each of these days. The system
will use these values to calculate the resource's Capacity per week.

2. Select a resource, and select Open.

3. In the Resource Properties window, select any of the following tabs:

• General: This tab may vary greatly with the design of the Resource Attribute Form you
imported. Fields may include:

• Roles: Displays any roles that have been associated with the resource.

• Skills: Displays any skills associated with the resource.

• Calendar: The calendar displays bookings, vacation days, and so on for the resource.

• Projects: Displays the projects in which the resource is booked and booking specifics.

View Your Own Resource Properties

At the company level, you can view your own resource properties and calendar. From your
user sign in, the system identifies you and automatically gives you permissions to view your
properties and calendar. However, you must have View permission to the Resource Log.

To view your resource properties:
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1. In the left Navigator, select Resource Manager, and then select Resources.

2. Select the Company Workspace tab.

3. On the Resources Log, double-click your name.

4. In the Resource Properties window, view your information under each tab as necessary.

General Tab

This tab may vary according to the design of the Resource Attribute Form. Fields may include:

• Resource Code: Automatically generated, manually entered, based on the configuration.

• Resource Name: View your name.

• Description: View your description.

• Resource Status: View your status. The default is Active.

• Capacity per week (Hrs): View the number of hours you can work in a day. Default value
is 8.

• Sunday (Hrs.).....Saturday (Hrs.): These fields may or may not appear. If they do, you can
edit the number of hours you can work on each of these days. The system will use these
values to calculate your Capacity per week.

Roles Tab

Select the Roles tab to view a role in your profile.

Skills Tab

Select the Skills tab in the Resource Properties window to view skills in your profile.

The following information is displayed for each skill:

• Skill: The name of the skill

• Proficiency: Displays your proficiency in each skill.

• Interest: Displays your level of interest in each skill.

Calendar Tab

Select the Calendar tab in the Resource Properties window to view booking dates as well as
unavailable dates (non-project time, such as vacation days). The calendar shows both your
soft and hard bookings.

To change your calendar view, select the Month or Week tab. In the Month view, a maximum
of five projects/shells can be shown for any day. If you are booked for more than five project/
shells in a day, you can view them all in the Week view.

Projects/Shells Tab

The Projects/Shells tab is read-only. You cannot edit the information on this tab.
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Schedule Manager
If you have access to the Schedule Manager feature, it helps you manage project/shell
schedules. You can use an existing Project Schedule Sheet that is customized to the project's
needs. You can use existing sheets to create project activities and tasks, assign resources to
tasks, create relationships between activities, track schedule progress and variables, and
calculate the schedule's critical path.

Note

The Schedule Manager feature was deprecated starting with version 23.5. However, if
you have access to it, you can continue to use it with existing configurations, but you
cannot create Schedule Sheets.

In Unifier, you can also import project schedule records from Primavera Project Planner or
Microsoft Project. These external project schedules can provide additional detail or supporting
schedule information—for example, resource information, or subcontractor or vendor
schedules. Imported schedules are editable, and the data can be used in reports.

The Schedule Manager presents schedule activities as interactive Gantt charts, where you
can:

• Zoom in to see tasks at the day, week, or month level

• Move activities and add dependency relationships, and automatically update the dates on
the schedule

• Create critical path calculations that will flag activities that, if delayed, can cause the
schedule to go beyond the planned project end date

Using the snapshot feature, you can take a "picture" of the schedule sheet at any point in time.
Using the Schedule Manager's baseline function, you can measure progress and determine
payments against original estimates. With the tracking Gantt feature, you can compare
schedule dates, such as baseline estimates against the actual schedule.

If you copy activities from one schedule to another, Unifier will immediately notify you if the
change will create a schedule conflict so that you can make corrections as you work. Each
change in the Schedule Manager creates a record, which is useful for auditing purposes. An
audit report of these records shows detailed information on dates, events, actions, and old
values versus new values, along with the user or proxy user who performed the action.

Each project/shell can have multiple schedule sheets and one master schedule sheet. This
master sheet drives project start and end dates, tracks the project's progress, and serves as
the interface between the Schedule Manager and other modules. In particular, the master
schedule updates resource assignment information in the Resource Manager, which affects
timesheets and resource utilization figures, and it integrates cost items on the schedule with
the Cost Manager. Users can refresh resource rates on the schedule sheet and post the new
rates to the Cost Manager, update the cost sheet with assignment costs, and refresh costs on
the sheet to recalculate labor costs and post them to the cost sheet.

Features include the following:

• Fully configurable activity attributes form

• Activities and Gantt chart on the same schedule sheet
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• Interactive Gantt chart with ability to drag activity end dates and link activities

• Tracking Gantt chart

• Filters for activities

• Baselines for schedule sheets and activity sheets

• Activity update

• Integration of Schedule Manager with the Resource Manager, enabling resource loading of
schedule activities

• Multiple CBS codes for each activity to capture activity costs, such as labor, non-labor, and
fixed costs. If designed in uDesigner, you can add a column to the schedule sheet to
display the CBS codes associated with each activity.

• View the cost distribution information by CBS codes from a schedule sheet

• Cut and paste and copy and paste of rows in a sheet

• Update of schedule sheets from linked templates

• Critical path calculation and display

• Streamlined and enhanced integration and interaction between the Schedule Manager,
Primavera, and Microsoft Project

• Activity progress tracking and percentage of work completed per assigned resource

• Works with shells that have the CBS cost type

• Scope Management, with the ability to launch business processes from activities and
automate schedule management.

• Budget and progress settings, and the ability to work with progress and earned progress
data

For information about language (internationalization) and CSV files, see Internationalization
and CSV Files.

Schedule Sheet permissions

User mode sheet-level permissions can be assigned by the creator or a user with Full Access
permission.

Sheet-level permissions are set up on each project/shell Schedule Sheet on the user side, and
can also be set up on schedule sheets within project/shell templates.

To assign permissions to a schedule sheet:

1. Go to the shell tab or the shell template.

2. Select the schedule sheet in the Schedule Sheets log.

3. Select Permission.

4. Add users or groups and assign permissions:

• Modify Permissions: Allows the user to modify the permissions of a schedule sheet.
Checking this permission will check all permissions below.

• Edit Data: Allows the user to edit the sheet, including data, columns, and rows, cut
and paste activities. Users that have the Edit Data permission can import data. They
can also edit Activity Progress and refresh the schedule sheet.
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• Edit Data and Structure: Allows the user to set and clear baselines on schedule
sheets and Activity Sheets; also to copy and paste activities. Enables users to add or
remove linked schedule sheet templates. Also enables users to edit data element level
restrictions on activities on a schedule sheet.
Users with the Edit Data and Structure permission can edit these activity progress
related components:

– Options tab of the Schedule Sheet Properties

– Budget and Progress Setup (schedule sheet level or activity level)

– Activity Progress

– Activity Progress Log

– Schedule sheet refresh

• View: Allows the user view-only access to the sheet. Automatically granted if any of
the permissions above are granted. Can also view the Linked Template window.

5. Select OK.

Maintaining a Schedule Sheet and Updating Its Properties

Each schedule sheet has its own set of properties, which you can use to control schedule
sheet behavior.

The system separates Schedule Sheet Properties into five tabs. Each tab has a distinct
purpose.

• The General tab is where you can define basic schedule information, for example,
Schedule Sheet Name, and Start Date.

• The Gantt Chart tab is where you can define what you want to see in the visual
representation of the sheet, for example, common choices are Activity Name, Start Date,
and Finish Date.

• The Tracking Gantt tab is where you can set up comparisons of activities, for example, you
can compare Actual Start Date with the originally planned Start Date.

• The Options tab is where you can set up how you want the system to update activity status
and progress requirements.

• The Schedule tab is where you set the schedule sheet refresh schedule.

You can have any number of schedule sheets in a project/shell. You can designate one sheet
as a master schedule sheet, which appears in bold in the log. The master schedule sheet
drives the activity start and finish dates, and allows you to assign resources to activities. You
can use it to track progress and resource assignment information to other modules in the
system.

Note

You may want to set up the schedule sheet before selecting it as the master sheet.
After you select the sheet as the master sheet, it cannot be deselected.

To update a project/shell schedule sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.
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3. In the Schedule Sheets log, select the applicable sheet, and select Properties.

4. Use the information provided in the following subtopics to make the applicable changes.

• Updating the General Tab for Schedule Sheet Properties

• Updating the Gantt Chart Tab for Schedule Sheet Properties

• Updating the Tracking Gantt Chart Tab for Schedule Sheet Properties

• Updating the Options Tab for Schedule Sheet Properties

• Updating the Schedule Tab for Schedule Sheet Properties

• Using Import to Update a Schedule Sheet

• Setting a Schedule Sheet as the Master Schedule Sheet

Updating the General Tab for Schedule Sheet Properties

To complete the General tab of the schedule sheet properties:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select the applicable sheet, and select Properties.

4. Complete the General tab as described in the table below.

5. Select OK.

In this field: Do this:

Schedule Title Enter a title for the template. This is used as the
template identifier and must be unique. (up to 120
characters)

Description Enter an optional description. (up to 400 characters)
Master Schedule Selecting this checkbox identifies the schedule sheet as

the "master schedule. (Only one is allowed per project/
shell or project/shell template. After it is selected, it
cannot be deselected.)

Status When you are ready to make the template active and
available for use, select Active.
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In this field: Do this:

Auto-control Controls the automatic update of tasks for Scope
Management. The default is Off. Setting Auto-control to
On enables the automatic launch of BP records. Setting
Auto-control to Off means that BPs will not be launched
automatically on activities. Also, completion conditions
will not be checked on activities. Users can still launch
BPs manually.

Note

The system disregards
predecessor/successor
dependency relationships
when you manually start an
activity, even if auto-control is
set to On in the schedule sheet
properties.

Calendar Select a calendar to use with the schedule sheet. You can
choose from Standard Calendars (company-level
calendars), Project/Shell Calendars, or Custom Calendars
(defined for the Schedule Manager). This calendar is
used by all activities on the schedule sheet. The Calendar
data element is also available for use as a column in the
schedule sheet. The calendar selected affects project
durations and due dates.
For templates, the only choice is Standard calendars.
The Schedule Start Date always uses the Project/Shell
Calendar. Activity start dates are not affected when you
change the calendar.
The selected Start Date or Finish Date for an activity can
be a non-working calendar day, however the duration of
the activity will only account for working calendar days.
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In this field: Do this:

Schedule Start Date Drives the dates of floating activities on the schedule
sheet for Scope Management. No activities can begin
before this date. However, activities do not have to
begin on this date if their preceding activities complete
previous to this date.
The Manual and Shell Attribute radio buttons are active
for a master schedule sheet if the Project Start Date data
element has been added to the Shell Attribute Form (for
CBS shells) in uDesigner, and if no activity has started on
the sheet. These buttons allow you to specify whether
the Schedule Start Date should be set manually, or
automatically populate. For non-master schedule sheets,
the choice is always Manual, and Shell Attribute is not
selectable.
If you select the Manual radio button, you can select a
Schedule Start Date.
If you select Shell Attribute radio button, the Schedule
Start Date automatically populates from the Project Start
Date specified on the General tab of the shell properties.
Also, the shell Project Start Date can update the master
schedule sheet start date and reschedule the sheet
accordingly. Sheets that were created with the Project
Start Date specified on the shell will generate an entry in
the Audit Log if the Project Start Date is changed.
If the Schedule Sheet and the Activity Sheet are both in
the same shell, and the Schedule Start Date (in the
Schedule Sheet) is selected as the Project Start Date, and
you update the Project Start Date in P6, then when you
perform Get Data (in the Activity Sheet), the Schedule/
Project Start Date (in the Activity Sheet) will not change
if one or more activities show as Complete or In
Progress in the Schedule sheet.

Notify users and/or groups on errors Select Users and groups to be notified if there are errors
during any point during the Scope Management task
routing.

Permission: Enforce Activity Level Permissions by
Group

Select to specify that you are implementing group
activity editing. If you select this checkbox, you must
also select a default group.

Default Group Required if you select Permission Enforce Activity Level
Permissions by Group. Select the group to use as the
default group for activity-level editing.

Updating the Gantt Chart Tab for Schedule Sheet Properties

You can define the display of data elements on the activity bars on the Gantt chart. You can
add up to three labels: to the left, on top, and to the right of each activity bar. The labels
correspond with the data element fields that are available on the Properties window (Activity
Attribute Form) for each activity.
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Note

If you are selecting specific calendars for your project/shell and schedule sheet, the
Gantt chart uses the project/shell-level calendar, not the calendar selected for the
schedule sheet.

To configure Gantt chart activity bar text:

1. Select the Gantt Chart tab.

2. Select data elements.
You can add one label or all three. The selected data element(s) will display at the Top,
Left or Right of the activity bar. The available data element options are derived from the
activity form (Schedule Attribute Form or default form).

3. Select OK.

Updating the Tracking Gantt Chart Tab for Schedule Sheet Properties

A tracking Gantt chart allows you to compare two sets of dates for a specific activity. It allows
you to track activity progress against the original plan. For example, the tracking Gantt chart
allows the comparison between two sets of dates such as baseline and actuals. Users with
view permissions can view a tracking Gantt chart. The tracking Gantt chart is view only. It is not
interactive like the regular Gantt chart.

You can define the display of data elements on the activity bars on the Tracking Gantt chart.
You can add up to three labels: to the left, on top, and to the right of each activity bar. The
labels correspond with the data element fields that are available on the Properties window
(Activity Attribute Form) for each activity.

To configure Tracking Gantt chart activity bar text:

1. Select the Tracking Gantt Chart tab.

2. Select data elements.
You can add one label or all three. The selected data elements will display at the Top, Left
or Right of the activity bar. The available data element options are derived from the activity
form (Schedule Attribute Form or default form).

3. Select OK.

Updating the Options Tab for Schedule Sheet Properties

These options allow you to control the automatic update of activity status based on Actual Start
and Actual Finish dates, to specify that activity progress requires an Actual Start Date, and to
enforce a dependency between Activity % Complete and the Actual Finish Date (with the
option of auto-update of the Activity % Complete).

See Project Progress Data Accumulation and Calculation for details on progress data
accumulation and earned progress.

To specify that activity status auto updates based on actual start and finish dates:

By default, the Activity Status controls Actual Start and Finish of an activity. If you select the
Auto update activity based on Actual Start/Finish Dates, the Actual Start date and Actual Finish
date control the Activity Status. Selecting this box, makes the Activity Status field read-only on
the Activity Properties. When this checkbox is deselected, you can change the Activity Status.
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The following table describes the interactivity of the Actual Start, Actual Finish, and Activity
Status fields when the Auto update activity status based on Actual Start/Finish Dates checkbox
is selected:

Actual Start Actual Finish Activity Status

Editable (no date selected) Editable (no date selected) Read-only. Not Started option is
selected.

Editable (date selected) Editable (no date selected) Read-only. In Progress option is
selected.

Editable (date selected) Editable (date selected) Read-only. Complete option is
selected.

1. Select the Options tab.

2. Select the Auto update activity status based on Actual Start/Finish Dates checkbox.

3. Select OK.

To specify that activity progress requires an actual start date:

You can specify that activity progress information cannot be entered if there is no actual start
date for the activity. For example, an actual start date must be specified for users to be able to
enter any activity progress, including Activity % Complete and Earned Progress on the Activity
Properties.

When the Checking the Activity Progress requires an Actual Start date checkbox is selected,
the system validates that there is an Actual Start date specified for the activity. If there is no
Actual Start date, and this checkbox is selected, users will not be able to enter activity progress
data until the Actual Start date is added for the activity.

Note

You cannot select the Activity Progress requires an Actual Start date checkbox if the
activity has recorded progress. If there are any progress entries, the system will not
allow you to select this checkbox until a start date is provided or the existing progress
data is deleted.

1. Select the Options tab.

2. Select the Activity Progress requires an Actual Start date checkbox.

3. Select OK.

To enforce dependency between Activity % Complete and Actual Finish Date for an activity:

You can enforce a dependency between the Activity % Complete and the Actual Finish Date of
an activity. When you select Enforce Activity 100% Complete again Actual Finish, the system
will require the user to enter the percentage for Activity % Complete as 100%. Conversely,
when the user specifies that Activity % Complete is 100%, the system will require the user to
enter a value for the Actual Finish Date. Also, you can enforce that Activity % Complete is
changed to 100% if an Actual Finish Date is entered.
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Note

If data has been entered (Activity Finish Data is entered or the Activity % Complete is
less than 100%, or conversely), and then you attempt to select the Enforce Activity
100% Complete against Actual Finish checkbox, the system will prevent you from
selecting the checkbox for this option. In this case, you must clear the existing data to
be able to select the Enforce Activity 100% Complete against Actual Finish checkbox.

1. Select the Options tab.

2. Select the Enforce Activity 100% Complete against Actual Finish checkbox.

3. Select OK.

Note

Impact on Scope Management: If you have specified a dependency between the
Actual Finish Date of an activity and the Activity % Complete, the Activity %
Complete value for an activity will automatically update to 100% when an Actual
Finish Date is entered for that activity. This can occur when the Activity Status is
updated to Complete, whether through a business process or manually.

To auto-update Activity % Complete based on Actual Finish Date for an activity:

If you have selected Enforce Activity 100% Complete again Actual Finish, you can further
specify that the Activity % Complete value is automatically updated to 100% when the user
enters an Actual Finish Date.

1. Select the Options tab.

2. Select the Enforce Activity 100% Complete against Actual Finish and Auto-Update %
Complete to 100% after entering Actual checkboxes.

3. Select OK.

Updating the Schedule Tab for Schedule Sheet Properties

The schedule sheet refresh updates cost data associated with the schedule sheet. The refresh
updates activity costs and resource/role costs.

A schedule sheet refresh can fail if:

• An activity has more than one CBS code

• A cost sheet column to which a schedule sheet column is associated is deleted from the
cost sheet

You can set the refresh frequency. The refresh frequency you set is shown in the schedule
sheet log under the column heading Scheduled. Schedule sheets that require refresh are
listed in the Schedule Sheet log displaying the Refresh icon.

To set the refresh frequency of schedule sheet template data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select one or more schedule sheet templates.
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4. From the toolbar, select Refresh  , and then select Set Frequency.

5. In the Set Frequency window, select the Enable scheduled refresh checkbox.

6. Select the Frequency and the Range of Recurrence.

7. Select OK.

Using Import to Update a Schedule Sheet

You can also use CSV, XML, and MPP files to update an existing sheet. Before you begin:

• You must have permission to import files. See Schedule Sheet permissions.

• For CSV or XML files, your administrator must first define the data mapping.

• To use the Activity Calendar from Microsoft Project, first create a calendar in Unifier with
the same name as the external calendar.

• To import Resource Assignments from Microsoft Project, first add the same MPP resource
types to the SYS Resource Type data set in Unifier. Oracle recommends using MPP
standard resource types: Work, Material, and Cost.

To import CSV files:

1. Open the schedule sheet.

2. From the File menu, select Import, and then select From CSV. If a default mapping is not
selected, the Select Data Mapping window opens.

3. Select the data mapping you want to use for this import, and select OK.

4. In the File Upload window, browse to select the file to upload.

5. Select OK.

To import XML and MPP files:

1. Open the schedule sheet.

2. From the File menu, select Import, and then select From External Source. If a default
mapping is not selected, the Select Data Mapping window opens.

3. Use the table below to complete the fields in this window.

4. Select OK.

5. In the File Upload window, browse to select the file to upload.

6. Select OK.

In this field: Do this:

MPP Data mapping is not required. Leave the Data Mapping
field empty.

MPP XML Data mapping is required. Select the mapping you want
to use.

MPP activity calendar Select Consider Activity Calendar.
This requires an existing calendar with the same name.
If an activity calendar is not imported and considered,
the activity will use the existing calendar defined in the
schedule sheet properties.
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In this field: Do this:

MPP Resource assignments Data mapping is not required. Leave the Data Mapping
field empty. This requires a data set for the SYS Resource
Type data element.
Use MPP standard resource types: Work, Material, and
Cost. Upon import, the system will soft-book these
resource types.

Setting a Schedule Sheet as the Master Schedule Sheet

The system allows one master schedule sheet per project/shell. You can mark a schedule
sheet in a project/shell and a project/shell template as the Master Schedule sheet.

NOT_SUPPORTED

Caution: Upon saving, Master Schedule designation is permanent and cannot be
undone.

You can use the master schedule sheet to:

• Drive project dates, for example start date, finish date, planned completion, revised
completion

• Drive activity start and end dates

• Track progress of activities over the lifetime of the project

• Drive scope management

• Post costs to the Cost Manager

• Support Cash Flow and Earned Value analysis

• Interface with the Resource Manager for resource assignments and availability

To mark a sheet as the master schedule sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select the sheet that you want to make a master schedule
sheet, and select Properties.

4. On the General tab of the Properties window, select the Create as master schedule
sheet checkbox.

5. When the confirmation message appears, select Yes.

Changes that occur to copied and pasted activities

• Status will be set to Not Started for the pasted activity.

• Actual Start Date and Actual Finish Date will be cleared.

• Links to BP Record, Record Status are not copied.

• Critical Path elements are recalculated.
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• Copying an activity will not copy dependencies.

• Moving Summary Activities will automatically move all activities below the summary
whether the summary is expanded or collapsed. If the activity is not a summary row, any
corresponding summary tasks will be updated automatically to reflect any changes in start,
finish, and duration. The Gantt Chart View will reflect the new ordering of activities without
affecting dependencies.

Activities remain in the buffer until the next copy/cut or save. Allowed actions that do not empty
the buffer are:

• Find

• Zoom In or Zoom Out

• Focus

• Opening the Activity Attribute Form without changing data.

If you perform any other actions before selecting Paste, the contents of the buffer are lost. A
subsequent paste will not result in any action. Actions that empty the buffer are:

• All actions on the toolbar (Save, Add, Delete, Indent/Outdent, Gantt, Progress, Close
Window)

• All actions under the File menu

• All actions under the Edit menu except Paste

• All actions under the View menu except Find

• Selecting into any editable cell or modifying dates via Gantt or the Activity Attribute
Form.

Adding an Activity to an Existing Schedule Sheet

Before you begin: Schedule sheet permission is granted on a sheet-by-sheet basis. Adding or
editing an activity requires Edit Data or greater permission. If you only have View permission,
you cannot add or edit activities. See Schedule Sheet permissions.

This page contains information on adding activities manually, copying activities from another
sheet, and using copy/cut and paste.

For information about importing schedule sheet data directly into Unifier, see Maintaining a
Schedule Sheet and Updating Its Properties.

Add Activities

You can add activities to a schedule sheet in the Activity Properties window.

Select the topic links for information and directions on completing:

• The General tab of the Activity properties

• The CBS tab of the Activity properties

• The Resources tab of the Activity properties and Role-related Calculations

• The Dependencies tab of the Activity properties

To manually add an activity to a schedule sheet:

1. Go to the shell tab where the schedule sheet resides, and switch to User mode.
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2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets. The
Schedule Sheets log opens.

3. From the Edit menu, or from the toolbar, select Add, and select Manual. The Activity
Properties window opens.

4. Complete the activity property tabs as described in General tab of the Activity properties.

To copy an activity from another sheet:

1. Go to the shell tab where the schedule sheet resides, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets. The
Schedule Sheets log opens.

3. Open the sheet you want to change.
The default order for a new row is at the end of the activities list. You can insert a row
where you want it by selecting a row on the sheet. The system adds the new row above
the selected row.

4. From the Edit menu, or from the toolbar, select Add, and select Copy Activity From. The
Schedule Manager Picker window opens.

5. Select a schedule sheet from the Schedule Sheet drop-down list, which lists all the active
schedule sheets in the current project.

6. Select an activity from that sheet, and select Copy.
Non-hardbooked roles are copied into the destination schedule sheet.

The role amount is recalculated for the added activity and for any activity that has its start
or finish dates changed as a result of the addition.

7. If you want to change the activity properties, click the activity to open it.

To copy and paste activities in a sheet:

1. Open the schedule sheet in the log.

2. Highlight the row or rows you want to copy.

3. From the Edit menu, select Copy.

4. Select the destination for the copied rows. The rows you copy will be inserted above the
selected destination row.

5. From the Edit menu, select Paste. You can repeat this step multiple times to repeat
pasting the copied rows.

6. Copy and paste copies all data on the copied activity including Scope Management
Setup, dependency relationships, Baselines, CBS, and resource assignments.

To cut and paste activities in a sheet:

1. Open the schedule sheet in the log.

2. Highlight the row or rows you want to cut.

3. From the Edit menu, select Cut. The row you want to cut is highlighted and remains in
place until you paste it.

4. Select the destination for the cut rows. The rows you paste will be inserted above the
selected destination row.

5. From the Edit menu, select Paste. You can repeat this step multiple times to repeat the
pasting of the cut rows.

6. You can undo the cut action by selecting Undo Cut from the Edit menu.
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General tab of the Activity properties

The General tab shows fields from the schedule sheet. The fields may vary depending upon
how the designer created the Schedule Sheet Attribute Form. The table below shows required
fields.

In this field: Do this:

Activity ID The Activity ID reflects the list order of activities on the
schedule sheet. This field is automatically populated and
can change if activities are added or removed.

Activity name The activity name reflects the activity on the schedule
sheet. This is an editable field; any changes in the
attribute form will show up on the schedule sheet.

Start Date Enter or edit the date an activity will start.
role-related calculation

Finish Date Enter or edit the date an activity will end.
Any changes to the finish date, either in Activity
Properties or directly in a schedule sheet column, will
trigger the system to recalculate the role amount of the
role assigned to the activity. This helps you understand
the cost impact of a schedule change.

Task Duration The task duration is automatically calculated from the
start and finish dates. If you enter a value that is larger
than the difference between the start and finish dates,
the duration is re-calculated from the start date.

CBS tab of the Activity properties

On the CBS Codes tab, you can link a CBS code to an activity, which makes the activity
available for cash flow analysis.

To add a CBS code:

1. Select Add, which is located on the bottom left of the window. The Add CBS Code window
opens.

2. Select a CBS code from the CBS code picker. The CBS Item automatically populates
based on the CBS code selection.

3. Add a value for Split Percent. Oracle recommends using 100%.

To remove a CBS code:

1. Select the CBS code you want to remove.

2. Select Remove, which is located on the bottom left of the window.

Resources tab of the Activity properties

On the Resources tab, you can assign resources and roles to an activity using the Schedule
Sheet Resource Assignment form, which can be different than the one shown here. Fields can
be in a different order on the form, the form can include additional fields than this form, and the
form can dynamically change, depending on field selections.
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Note

When you assign resources or roles that have multiple rates to an activity sheet, to
update the total cost (Total Cost value), you must reschedule, or recost, the activity
sheet; otherwise, the system will assign earliest assigned resources or roles rates
(price/unit) to the activity sheet, and you will not be able to view the correct
accumulated cost.

Before you begin, be sure your administrator defined resources and roles in the company-level
Resource Manager.

To add or edit a resource:

1. Select Add, which is located on the bottom left of the window. The Resource Assignment
window opens.

2. Use the information in the table below to complete the fields on this form.

3. Select OK to save the form.

In this field: Do this:

Resource Type Select a resource type for the activity.
Hard Booked resource costs roll up to the total activity
cost as a labor cost. They are company defined and can
be virtually anything from a person to something like
pipe or concrete.
Non-hard booked resource costs roll up to the non-labor
costs of an activity. They are company defined as well
and can be virtually anything from a person to
something like pipe or concrete.

Note

Data set values for this drop-
down field must start on row
1 and cannot be 0 (zero).

Resource Picker Select a resource for the activity.
If you selected a hard booked resource for the activity,
you can use the Resource Picker to assign a resource to
this activity.
If you selected a non-hard booked resource, the
Resource Picker is unavailable and you must enter the
Resource Name.

Resource Name View or enter the resource name.
If you selected a hard booked resource, this field is
automatically populated.
If you selected a non-hard booked resources, you must
enter the name of the activity resource.
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In this field: Do this:

Resource Code View or enter the resource code of the assigned
resource.
If you selected a hard booked resource, this field is
populated with the code of the selected resource.
If you selected a non-hard booked resource, this field is
editable and you can enter a value.

Role Data Picker If this field is not on your form, disregard these
instructions.
If this field is on your form, you can select a role for the
activity. See Role-related Calculations for instructions on
working with this field.

Role Name This is a read-only field where you can the role of the
resource assigned to the activity.
If a hard booked resource is selected, this field is auto-
populated.
If a non-hard booked resource is selected, this field is
not populated.
If a role data picker is on your form, and you selected a
role using the picker, the Role Name is automatically
populated.

Quantity (Qty) Enter the resource quantity, for example tonnage or
number of days, as suitable for the resource.

UOM Select the unit of measure associated with the effort. For
example, if the Resource Type is Man-hours, the unit of
measure is hours.

Rate View or enter the unit rate of the effort.
If a hard booked resource is selected, this value is read-
only and populated based on the rate at which the
resource is booked.
If a non-hard booked resource is selected, you must
enter a rate.
If you used a role data picker to select the role, the rate
is pre-populated.

Amount View or enter the amount or cost of the effort. If the
resource selected is hard booked, this field is read-only
and the value is calculated automatically by multiplying
Quantity (Qty) with Rate.
Otherwise, this data element is editable. You can enter a
value in Unifier or a formula can be defined in
uDesigner to calculate the amount.

Role Amount If this field is not on your form, disregard these
instructions.
If this field is on your form, this field is automatically
calculated.
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In this field: Do this:

% Units View or enter the percentage of the resource available
for the activity.
If a hard booked resource is selected, enter the
percentage.
If a non-hard booked resource is selected, this field is
unavailable.
If a role is selected using the role picker, this field is
automatically calculated.

% Complete This is a read-only field that shows the percentage
completion of the activity. The value of this data element
is calculated using Progress Quantity / Quantity (Qty).

Role-related Calculations

When you use a role data picker to assign a role to an activity, the system can use the role
information to calculate role costs.

Role-related calculations

Activity role rate: For the activity role rate calculation, the system takes into account the
effective date of the current role rate and the active currency exchange rate. The system
recalculates the role amount under these circumstances:

• The activity role rate changes, or any other activity dates change, for example, finish date
or duration.

• The role changes.

• An activity is copied in the sheet.

• An activity is copied from another sheet.

Activity role amount: The system calculates the activity role amount on a daily basis. It
considers:

• Value of the role rate, as of the effective date (this can differ by effective date)

• Activity duration (this is the length of time the role rate was applicable before another rate
became effective)

• Active currency exchange rate (this can change due to currency fluctuations)

• Percentage of a role's assignment to the activity (% Unit) (this can differ during the activity)

The system uses active currency exchange rates for transaction-to-project currency
conversions. Exchange rate changes will flag the schedule sheet for refresh.

Role amount recalculation: Any changes to start and finish dates, duration, predecessor
activities, constraints, available days (via the calendar), activity levels (indent or out-dent) can
trigger the system to recalculate the activity role amount. You can see the effect of activity role
rate changes in cash flow distribution. The system calculates all values on a daily basis and
adds up all amounts.
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Activity amount: An activity can have more than one role, each with its own costs. If the activity
is associated with at least one CBS code, the system tallies the role amounts for an activity,
rolls up costs to non-labor costs, and displays the sum of CBS code in cash flow.

To use the role picker:

1. Go to the shell tab where the schedule sheet resides, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets. The
Schedule Sheets log opens.

3. Select the schedule sheet that contains the activity you want to modify and open it.

4. Select the activity you want to modify. The Activities Properties window opens.

5. Select the Resources tab, and select Add, which is located on the bottom left of the
window. The Resource Assignment window opens.

6. If you are using a role data picker, complete these fields:

In this field: Do this:

Resource Type Select a non-hard booked resource type for the activity.
Non-hard booked resource costs roll up to the non-labor
costs of an activity.
They are company defined, and can be virtually
anything from a person to something like pipe or
concrete.

Resource Picker This field is not available.
Resource Name Enter the name of the activity resource.
Resource Code Enter the resource code of the assigned resource.
Role Data Picker Select a role for the activity. You can click Select or the

drop-down arrow and select Roles.
This is a dynamic button whose label changes according
to the previous selection.
For example, after you select a role, the button name
changes to Rate so you can access the Role Rate
Override.

Role Name The Role Name is automatically populated.
Quantity (Qty) Enter the resource quantity, for example tonnage or

number of days, as suitable for the resource.
UOM Select the unit of measure associated with the effort. For

example, if the Resource Type is Man-hours, the unit of
measure is hours.
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In this field: Do this:

Rate This field is not available for direct edit. Rates can be
changed either at the company level or via Role Rate
Override.

Amount This data element is editable. You can enter a value in
Unifier or a formula can be defined in uDesigner to
calculate the amount.

Role Amount This field is automatically calculated.
% Units This field is automatically calculated.
% Complete This field is read-only; it shows the percentage

completion of the activity. The value of this data element
is calculated using Progress Quantity / Quantity (Qty).

If you want to override the role rate, go to the next procedure below to override the role rate. If
not, select OK to save and close the form.

To override the role rate:

1. In the Role picker field, select Rates.
The Current Effective Rate window opens, which shows the Effective Date, Standard Rate,
and Custom Rate for the role selected.

2. In the Current Effective Rates window select the Custom Rate field and enter the new rate
for the role. You cannot change the Standard Rate from this window.

3. If you want to add another rate that will take effect later, select Add. The system adds a
line to the form.

4. In the Effective Date field, specify when this rate should take effect. Dates must be unique
and fall within Start / Finish dates.

5. In the Custom Rate field, specify the rate you want for the role.

6. Select OK. Role rates recalculate upon schedule sheet refresh.

Dependencies tab of the Activity properties

On the Dependencies tab, you can add dependencies between the current activity and other
activities from the schedule sheet. You can select another activity on the schedule sheet,
determine the relationship, (for example, Finish to Start, Start to Finish, Start to Start, or Finish
to Finish), and add a Lag.

Note

The system disregards predecessor/successor dependency relationships when you
manually start an activity, even if auto-control is set to On in the schedule sheet
properties.

To add or edit a dependency:

1. Select Add, which is located on the bottom left of the window. The Add Dependency
window opens.

2. In the Activity Name field, select the activity to make dependent upon the current activity.
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3. In the Relationship field, select from one of the following options:

• Finish to Start: the dependency must finish before the Activity can start.

• Start to Finish: the dependency must start before the Activity can finish.

• Start to Start: the dependency must start before the Activity can start.

• Finish to Finish: the dependency must finish before the Activity can finish.

4. In the Lag field, enter the number of days for a gap or overlap between the selected
activity and the current activity. A positive lag indicates a gap. A negative number indicates
an overlap. Non-Working days are not counted.

To remove a dependency:

1. Select the dependency to remove.

2. Select Remove, which is located on the bottom left of the window.

Add a schedule Sheet column

There are three default columns: Start Date, Finish Date, and Duration. Duration always
displays the result of Finish Date minus Start Date. You can add other columns as needed.
You can add baseline columns that map to Start Date, Finish Date, and Duration. See Set
Schedule Sheet Baselines.

Note

Any changes to an activity start date, either in Activity Properties or directly in a
schedule sheet column, will trigger the system to recalculate the role amount of the
role assigned to the activity. See Role-related Calculations.

To add a schedule column:

1. Go to the shell tab where the schedule sheet resides, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheet.
The Schedule Sheets log opens.

3. Open the schedule sheet, and select Columns. The Columns Log opens

4. Select New. The Column Properties window opens.

5. Complete the Column Properties window as described in the following table.

6. Select OK.

In this field: Do this:

Name This field is populated with the chosen Data Source
Data Source Select a Data Source from the drop-down list. The

options include the data elements in the activity
Properties window. When a Schedule Attribute Form is
designed in uDesigner, the data sources include all
elements on the form, including hidden elements. This
list also shows data elements based on Sys Project Cost
Data Source data definitions.
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In this field: Do this:

Entry Method Choose one (the options that are available are
dependent on the data source chosen):
• Manual Entry: Users enter values directly on the

schedule sheet
• Formula: Value is calculated using the entered

formula. Formulas can include calculating
differences between date columns, or adding /
subtracting numeric columns / values from dates.
This is useful to calculate durations or to calculate
one date from another date by adding/subtracting
days.

• Cost Sheet Column: Select a Cost Sheet column to
associate with the data element based on the data
definition Sys Project Cost Data Source. This pull-
down menu lists all the columns defined on the Cost
Sheet. The cost data is refreshed when you or a user
choose Refresh from the File menu in a Schedule
Sheet and refresh immediately or set up a refresh
frequency. The Cost Sheet Column selector is
available on schedule sheets in projects/shells and
in project/shell templates.

• The Cost Sheet Column definition must be reselected
in a new schedule sheet that you create by copying a
sheet or template, or by copying a project/shell.
Definition must also be reselected if you link the
schedule sheet.

Data Format This controls how data is displayed on the schedule
sheet. Options are:
• Show as percentage. Data is displayed as %
• Decimal places. Choose 1 to 8
• Use 1000 Separator. Select the checkbox to include

a comma (,) separator
• Negative Number Format. Choose parentheses or

minus sign
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In this field: Do this:

Summary This controls the display of numeric and date column
data on summary rows.
• Display: Select the checkbox to display summary

data for the column
• Date Rollup: Available only for Date data types.

Select Earliest Date or Latest Date.
• Earliest Date: To summarize columns that

represent activity start dates (for example, start,
planned start, actual start, and so on). The cell on
the summary activity will show the earliest date
from all child activities.

• Latest Date: To summarize columns that represent
activity finish dates (for example, finish, planned
finish, actual finish, and so on). The cell on the
summary activity will show the latest date from all
child activities.

• Number Rollup: Available for numeric columns.
Choose Total (displays sum total of the rows),
Average (displays average value of the rows), or
Weighted Average based on and select a field from
the Activity Attributes form. For example, you might
choose Total for currency or other numeric types;
for percentage columns, you might want to choose
Average.

• Weighted Average Based On: The drop-down list
for this option lists the data elements available on
the Activity Attribute Form. Only data elements of
the type Numeric are available for selection.
Selecting this option and a data element allows the
system to calculate the weighted average of
summary rows. For example:

Display Mode Choose to Show or Hide the column from user view.
Users with Create permissions can see hidden column in
the Columns Log.

Column Position After The new column will be inserted after the column
selected.

Create a formula column in a schedule sheet

You can create formula columns on a schedule sheet or template. Formulas can calculate
differences between date columns, or add / subtract numeric columns / values from dates. This
is useful to calculate durations or to calculate one date from another date by adding/subtracting
days.

You can define formulas of the following types:
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• Numeric: Build a numeric formula. This choice is available if the data source is SYS
Numeric Logical.

• Date Difference: Formula is by default Later Date - Earlier Date. This choice is available if
the data source is SYS Numeric Logical.

• Date Add: Add a numeric value to a date. This is available if the data source is SYS Date
Logical.

SYS Numeric Logical and SYS Date Logical are data definitions form which data elements can
be created in uDesigner and used on Schedule Attribute Forms.

How to tell which data source to use in building a formula

The ability to build formulas is dependent on the data definitions used to create the data
elements on the Schedule Attribute Form.

To see which data elements are based on the above data definitions:

1. Go to the Company Workspace tab, and switch to Admin mode.

2. In the left Navigator, select Data Structure Setup, and then select Data Elements.

3. In the Data Elements log, select the column heading to sort by data definition.

Alternatively, you can choose a Data Source in the drop-down list, then, with the Data Source
field still active, press your keyboard's up and down arrow keys to scroll through the data
source options. When one of the above data definitions is reached, the Formula radio button
becomes active.

To create a Numeric formula:

Choose Numeric, and select Create. Activity data type displays data elements that are defined
on the detail form along with "SYS Numeric Datasource" and "SYS Numeric Logical
Datasource".

To create a Date Difference formula:

1. Choose Date Difference, and select Create.

2. Enter Earlier Date and Later Date:

a. Click Select. The Data Element picker opens.

b. Choose a data element. Options are data elements from schedule sheet detail form or
columns defined on schedule sheet. Only date type (Timestamp) data elements are
displayed.

c. Choose Calculation based on Calendar days (non-working days will be counted) or
Work days (non-working days will be ignored). Work days are defined in the company
calendar.

3. Select OK.

To create a Data Add formula:

1. Choose Data Add, and select Create.

2. Choose a data element for Date and Add (click Select to open the data element picker).
Data elements on the schedule sheet detail form and schedule sheet columns are
available.

• For Date, only date type (Timestamp) of data elements is displayed.

• For Add, only numeric (integer, float) type of data elements or columns are displayed
in the picker list. This includes Total and Average columns.
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3. Choose Calculation based on Calendar days (non-working days will be counted) or Work
days (non-working days will be ignored). Work days are defined in the company calendar.

4. Select OK.

Working with Schedule Sheets

Working with schedule sheets entails, for example:

• Adding or managing rows and columns.

• Tracking activity progress and costs.

• Managing dependencies and constraints.

In the open schedule sheet, you can view activities and columns in the left pane and view the
Gantt chart in the right pane. You can move the split screen bar to the left or right as needed.
Scroll bars are available on the bottom of the sheet.

For more information about Activity Sheets and Schedule Sheets, see Activity Manager and—if
you have access to the Earned Value Manager feature—refer to the Unifier Earned Value
Management User Guide.

To open a project/shell schedule sheet:

1. Go to the shell tab where the schedule sheet resides, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.
The Schedule Sheets log opens.

• The log lists all active schedule sheets. To view all active and inactive sheets, select
View, and choose All.

• The Refresh icon  indicates whether you must refresh a schedule sheet to display
the latest data. The Refresh icon is not displayed for schedule sheets that are Inactive
or are in a view-only project/shell.

3. Double-click a schedule sheet in the log to open the sheet.
If the sheet requires a refresh of the data, you will be asked if you want to refresh the
sheet. Select OK to refresh the sheet or No to close the sheet without refreshing the data.

4. Select the sheet in the log, and select Open. The schedule sheet opens.

Schedule sheet toolbar

You can perform the following functions from the toolbar. Select the down arrow next to a
button to view further options.

Button Action

Save Saves changes made to the schedule sheet.
Add Select the arrow next to the button, and choose one of

the options:
• Manual: Add a row (activity) manually.
• Copy Activity From: Add a row by copying a row in

a selected sheet.

Delete Select a row, and select Delete to delete the activity.
Indent Select a row, and select to indent the row. The row above

become a summary row.
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Button Action

Outdent Select an indented row, and select to out-dent.
Gantt Return to the Gantt chart view.
Progress Access the Activity Progress view. See Entering Progress

in the Activity Progress Window for details on activity
progress.

Columns Add and manage columns on the sheet.
Find Select to search for an activity. You can search on any

column on the sheet.
Zoom In Select to zoom in the Gantt chart. The default view is

week (by day), which is the maximum zoom-in view.
Zoom Out Select to zoom out the Gantt chart. You can zoom out to

month (by week) view and year (by month) view.
Focus Select an activity, and select to move the activity into

focus. The Gantt chart view moves to the beginning date
of the selected activity.

Close Window Close the schedule sheet.

Using a Gantt Chart

The Gantt Chart is displayed in the right pane of the schedule sheet. The activities are shown
as bars and align with activities in the left pane. The activity bar is drawn with the start date,
finish date, and duration elements of the activity. The Gantt chart is shown in week/day zoom
mode by default.

The Gantt chart displays:

• Activity bars, which illustrate start and finish dates and duration

• Dependency links between dependent activities

• Summary rows

• Milestones

• Critical paths

The Gantt chart is interactive. You can:

• Zoom in or out of the Gantt chart view to display detail or overview of scheduled activities.

• Configure activity bar labels; for example, you can display percent complete to monitor the
progress of activities, or names of resources assigned to activities, or virtually any activity
property. See Updating the Gantt Chart Tab for Schedule Sheet Properties.

• Increase and decrease activity schedule durations by dragging on bar ends.

• Move activities from one time frame to another (modifying start and end dates).

• Add or remove a predecessor (dependency). See Dependencies tab of the Activity
properties.

• Resize Gantt window by dragging the vertical split bar.

• Display critical paths.

The Gantt chart is refreshed automatically when any changes are made on the activities.
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Understanding the Gantt chart view

Zoom in or out of the Gantt chart

You can view the Gantt chart by week (per day), month (per week), or year (per month) by
zooming in and out. This allows you to view the Gantt chart in detail or over an extended
period of time.

To zoom in or out of the Gantt chart:

1. Open the schedule sheet.

2. Do one of the following:

• From the toolbar, select Zoom In. The default view is weekly, with each day of the
week displayed. This is the maximum detail level that you can zoom in to the schedule
sheet.

• From the toolbar, select Zoom Out. You can zoom out to view the Gantt chart by
month with each week in the month displayed, or by year with each month displayed.

View the critical path

The critical path calculation can be used to flag activities on the schedule that, if delayed, can
cause the schedule to go beyond the pre-planned project/shell end date. Therefore, it is
important to have fixed project/shell start and end dates defined for the project/shell. project/
shell start and end dates should not automatically adjust as activities are added or
rescheduled.

To view the critical path:

1. Open the schedule sheet.

2. From the View menu, select Critical Path.
The activities that are on the critical path will change to red on the Gantt chart. The critical
path action will also update the system-defined data element uuu_float to zero if it has
been included on the activity attributes form (Activity Properties window).

3. To restore the Gantt chart view, from the View menu, select Gantt Chart.

View a tracking Gantt chart

A tracking Gantt chart allows you to compare two sets of dates for a specific activity. It allows
you to track activity progress against the original plan. For example, the tracking Gantt chart
allows the comparison between two sets of dates such as baseline and actuals. Users with

Chapter 1
Schedule Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 475 of 671



view permissions can view a tracking Gantt chart. See Set Schedule Sheet Baselines for
details on setting baselines.

The tracking Gantt chart is view only. It is not interactive like the regular Gantt chart.

To view a tracking Gantt chart:

1. Select the schedule sheet in the log, select View, and then select Tracking Gantt.

2. To switch back to the regular Gantt chart, select View, and then select Tracking Gantt.

The tracking Gantt chart displays the data elements as a set of two bars (upper and lower) that
allow you to make the comparison.

Using a Tracking Gantt Chart

You can use a Tracking Gantt chart to the compare data sets defined in the schedule sheet
properties. The read-only Tracking Gantt chart displays comparison as a set of two bars (upper
and lower).

To view a tracking Gantt chart:

1. Select the schedule sheet in the log, select View, and then select Tracking Gantt.

2. To switch back to the regular Gantt chart, select View, and then select Tracking Gantt.

Find an activity

You can search for a specific activity by the values of any column on the schedule sheet.

To search for an activity:

1. Open the schedule sheet.

2. From the toolbar, select Find. The Find window opens.

3. Complete the window:

• Column: Select the drop-down list, and choose a column to search on. The default is
activity name.

• Value: Enter all or part of a value to search for. For example, to search for the word
Construction, you can enter the entire word or any part of the word.

• Search: Select the drop-down list, and choose to search down or up from a selected
row. If you do not select a row, the search will begin at the top row.

4. Select Find Next. If an activity is found that matches the search criteria, the row will be
highlighted. To keep searching, select Find Next again.

5. When you are done searching, select Cancel to close the window.

About activity-level editing restrictions

Your Administrator can set up cell editing restrictions in schedule sheets. These restrictions
can allow certain work groups to edit specific dates in the sheet and prevent other groups from
editing these dates. If you are a member of a specific work group that has these restrictions
set, you will find that you can edit only certain cells on the schedule sheet.

The following image shows an example of the impact on dates in a schedule sheet with
activity-level editing configured, and with activities and group-specific date columns. In this
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example, the groups Const, IT, and ATM all have group-specific start and finish dates for
activities:

As shown in the example, the date cells in the schedule sheet that are specific to a certain
group can be edited only by that group.

Restrict Access to Activity fields and columns

You can restrict user access to selected fields and columns (those based system defined data
elements on the General tab, which are on the Activity Attribute Form and on the Resource
tab, which are on the Resource Assignment Attribute Form).

Note

These restrictions also apply to schedule sheet columns when a restricted data
element is used as a column.

After a field or column is marked with restricted access for selected users or groups, those
users or group members cannot modify those data elements (fields). For Start Data, Finish
Date and Duration data elements, users that are restricted cannot modify this group data
elements, even if they have restriction on any one of the data elements in the group. Also, the
Gantt Chart will be disabled for a user if the Start, Finish, and Duration data elements are
restricted for that user.

If a data element cannot be modified by a user or group, data imported through CSV / XML for
that data element is ignored. If there is any failure in validation (both user and system defined),
the system will stop data import.

To restrict access to specified system defined data elements:

1. Navigate to the schedule sheet log.

2. Open a schedule sheet.

3. From the File menu, select Restrictions. The Restrictions Setup window opens.

4. Add the user or group name whose access you want to restrict.

5. Choose the data elements to restrict. The data elements listed for the Activity Attribute
Form and the Resource Assignment Attribute Form are those that are system defined (the
data element name starts with uuu_) and were added to the forms. You can select all the
listed data elements, or individual data elements.

6. Select OK.
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Use filters in a schedule sheet

You can use filters to locate certain activities in a schedule sheet. The filter is based on criteria
that you specify. When you use a filter, it applies only to the schedule sheet you are working
with, but the filters you create are visible to all other users.

To add a filter for activities in a schedule sheet:

1. Select the records in the schedule sheet that you want to filter.

2. Open the schedule sheet in the log.

3. From the View menu, select Filters. The Filters window opens.

4. Select Add.

5. In the Add Filter window, specify the filter criteria. Each filter can have multiple criteria
based on the data elements in the Activity Attribute Form. You can also use this window to
edit or remove filters. The Add and Remove buttons are enabled only for users who have
edit permissions on the schedule sheet.

6. Selecting the Display Summary Activities checkbox controls whether the filtered
schedule sheet displays summary activities corresponding to any leaf activities displayed
in the sheet. The filter is not applied to the summary activities.

7. Select Apply to save and immediately apply the filter to the schedule sheet.

8. Select OK to save the filter for later use.

To apply a filter to schedule sheet activities:

1. Open the schedule sheet in the log.

2. From the View menu, select Filters. The Filters window opens.

3. Select the activities you want to filter.

4. Select a filter name, and select Apply Filter. The schedule sheet refreshes with the filter
applied.

To clear a filter from a schedule sheet:

1. To return the schedule sheet to the original view, select the schedule sheet in the log.

2. From the View menu, select Clear Filters.

Update rates and cost data

When a resource is assigned, the average booking rate is used to calculate assignment costs.

Average Booking Rate = Total Booking Cost / Total Hours for the entire booking row selected
while assigning the resource.

Labor Cost (for a resource assignment) = Total Assigned Hours x Average Booking Rate.

After assignment, the booking rate may change as changes occur to the booking sheet. These
rate changes will not automatically affect the assignment (labor) costs stored in the schedule
sheet.

You can update resource rates on the master schedule sheet and also update the project/shell
cost sheet with corresponding assignment costs. The active currency exchange rate at the
time of assignment will be used.
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The update has two options:

• Resource Utilization: This updates resource rates only.

• Resource Utilization and Cost Manager: This updates resource rates on the schedule
sheet and posts costs to the cost manager. This option is only enabled on the master
schedule sheet.

To update rates on the schedule sheet:

1. Open the master schedule sheet.

2. From the Edit menu, select Update, and then select Resource Utilization. Labor costs on
the entire schedule sheet are recalculated based on the latest average booking costs and
exchange rate.

To update costs on the cost sheet:

1. Open the schedule sheet.

2. From the Edit menu, select Update, and then select Resource Utilization and Cost
Manager. Labor costs are updated and posted to the cost sheet (column with labor cost
data source) based on the CBS codes and split percentage specified on each activity. The
existing cost in the cost sheet columns will be replaced by new values. Similarly, any
values in the Fixed Cost, Non-Labor Cost, and Total Cost columns in the schedule sheet
will be posted to corresponding data sources on the cost sheet.

Constrain Schedule Sheet Activities

You can constrain activities on a schedule sheet. A constraint ties a successor activity start
date to a predecessor activity completion date, after observing dependencies and lags.
Available constraints in the system are As soon as possible (ASAP) and None.

To constrain a schedule sheet activity:

Before you can constrain an activity, the activity's dependencies must be set.

1. Navigate to the schedule sheet where you want to constrain activities and open the sheet.

2. Double-click the activity you want to constrain. The Activity form window opens.

Note

If the schedule sheet displays the Activity Constraint column, you can assign the
constraint without opening the Activity form window.

3. For each activity you want to constrain, select the activity constraint you want, either As
soon as possible or None.
As soon as possible: If the start date of a predecessor activity changes, either pulls in or
pushes out, the start date of an ASAP-constrained successor activity changes accordingly.
If an ASAP-constrained activity does not have a predecessor, the schedule sheet start date
determines the activity start date; unstarted ASAP-constrained successor activities align
accordingly.

None: The start date of a None-constrained activity does not change if the start date of a
predecessor activity changes. The schedule sheet start date does not determine the start
date of None-constrained activities that do not have predecessor activities. The only in-
built rule is that the start date of the None-constrained activity should not be earlier than
the schedule sheet start date.
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Integration: When activities are created through CSV, MPP, MPP XML, or P6, the default
value will be None. Upon modification of the activity constraint type, Unifier scheduler will
readjust the schedule sheet accordingly.

4. Select OK to close the Activity form window and save the schedule sheet.

Add general comments (with or without file attachments)

You can add general comments to a schedule sheet, and you can include file attachments with
the comments. This is similar to adding general comments to a business process.

To add a general comment to a schedule sheet:

1. Select the schedule sheet in the log, and select Comments. The General Comments
window opens.

2. Add your text comments in the Text Comments box in the upper portion of the window.
You can view any previous comments in the Existing Comments section of the window.

3. To attach a file to the general comment, select Attach.

Note

After you add a general comment to a schedule sheet, you cannot edit or delete it.

4. Select OK to save the general comment.

Refreshing Schedule Sheet data

A schedule sheet refresh is required if there are changes to project costs, activity costs, for
example role rates and amounts, currency rates, and schedule sheet or activity calendars.
When the schedule sheet requires a refresh, you will see a Refresh icon in the log. When you
open a schedule sheet that requires a refresh, you will be asked if you want to refresh the data
in the sheet. If you decline the refresh the schedule sheet will not open.

Schedule sheet refresh options are set on the Refresh tab of the schedule sheet properties.
Options include:

• Cost: Refresh the cost data only from the associated CBS code

• Schedule: Refresh the schedule data only, based on dates

• Cost and Schedule: Refresh both the cost and schedule data

• Set Frequency: Define the schedule sheet refresh frequency. This scheduled refresh
updates both cost and schedule data.

• History: View the schedule sheet refresh history

Schedule sheet refresh can fail if:

• An activity has more than one CBS code

• A cost sheet column to which a schedule sheet column is associated is deleted from the
cost sheet

To set the frequency of schedule sheet refresh:

The schedule sheet refresh frequency you set is shown in the schedule sheet log under the
column heading Scheduled.
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1. Navigate to the schedule sheet log.

2. Select one or more schedule sheets.

3. From the toolbar, select Refresh  , and then select Set Frequency.

4. Select the Enable scheduled refresh checkbox.

5. Select the Frequency and the Range of Recurrence.

6. Select OK.

To view schedule sheet refresh history:

1. Navigate to the schedule sheet log.

2. From the toolbar, select Refresh, and then select History.

3. Select a record, and select Open to view history details.

4. Select Cancel Request to cancel any history query that has not started (has no Start
Date).

5. Select Close Window.

Print a Schedule Sheet

You can print schedule sheet columns and Gantt charts from the PDF of the schedule sheet.

To print a schedule sheet:

1. Navigate to your project/shell, and open the schedule sheet you want to print.

2. From the File menu, select Print.

3. Select the print options you want.

• All Columns: Select to print all columns of the schedule sheet (default.)

• Gantt Chart: Prints the current view of the Gantt chart (Gantt, Critical and Tracking.)
This is checked by default.

4. Select Print to PDF.
Your browser may require you to confirm opening the PDF or saving the PDF. If saving the
PDF, select Save. Browse to where you saved the file and open the PDF. If you select
Open, an Adobe PDF opens with the schedule sheet.

5. From within Adobe PDF file, select File, and then select Print. The Adobe Print window
displays.

6. For multiple pages of a schedule sheet, select Tile All Pages from the Page Scaling drop-
down.

Note

This option is not available on older Adobe Reader versions. It is recommended
that you upgrade to the latest Adobe Reader (free). If you have Adobe Acrobat or
Adobe Professional, the Tile All Pages option will print multiple pages of the
schedule sheet.

7. Select OK. To cancel the print, select Cancel.
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Schedule Manager audit log

Each change in the Schedule Manager creates a record in the system, which is useful for
auditing purposes. An audit report of these records shows detailed information on dates,
events, actions, and old values versus new values, along with the user or proxy user who
performed the action.

To view schedule sheet details in the audit log:

1. Navigate to the Schedule Sheets log in the Schedule Manager node.

2. In the View menu, select Audit Log.
You can review audit log entries for Date, Event, Action, Field, Old Value, New Value, User
Name, Proxy User, and Attachments.

To view cell details in the audit log:

1. Navigate to the Schedule Sheets log in the Schedule Manager node and open a schedule
sheet.

2. Under the View menu, select Audit Log.
You can review audit log entries for Date, Event, Action, Field, Old Value, New Value, User
Name, Proxy User, and Attachments.

Note

If the Schedule Start Date is updated through a change in the linked project start
date, the audit log will show an entry for the updated Schedule Start Date.

Set Schedule Sheet Baselines

A baseline is a set of original project/shell estimates. It consists of the following for a task:

• Start

• Finish

• Duration

Comparing multiple baselines provides insight into project health. With the original estimates,
you can track the progress of a project/shell and compare its state at any given time. The
system leverages the CBS code association between schedule sheets and earned value (EV)
sheets to construct baseline comparison. The best way to do this is to:

• Create a corresponding detail-level EV sheet for an existing schedule sheet

• Create a summary EV sheet to compare selected baseline information

If you have access to the Earned Value Manager feature, refer to the Unifier Earned Value
Management User Guide for more information.

You can save up to 11 sets of baselines in a single project/shell schedule sheet. You can use
these various baselines as snapshots of your project/shell progress over time, with each
baseline corresponding to key project/shell events.

The first baseline that you save is named Baseline. Subsequent baselines are named Baseline
1 through Baseline 10. The baseline sets are system-defined data elements that your
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administrator has included on the Activity Attribute Form. When you set up the baselines, the
values from the start, finish, and duration elements are mapped to the baseline set.

Note

The baseline columns are not required, but you must use all three of them, if you use
them at all. You must use the complete baseline set of columns (start, finish, and
duration) in your sheet. You cannot use one baseline column alone.

All baseline attributes are read-only in the schedule sheet. They can be modified only via the
set/clear schedule sheet baseline actions. Users with the Edit Data and Structure permission
on the schedule sheet can set or clear baselines.

Note

The Edit data permission allows you to import data.

All baseline attributes are read-only on the schedule sheet. They can be modified only via the
set/clear schedule sheet baseline actions. Users with the Edit Data and Structure permission
on the schedule sheet can set or clear baselines.

To set a baseline on a schedule sheet:

1. Open the schedule sheet in the log. If you modify the schedule sheet, you must save the
sheet before you can set baselines.

2. From the Edit menu, select Baseline. The Set Baseline window opens.

3. Select the baseline to set. The Set baseline radio button is selected by default. Only
baselines that have been designed in uDesigner are available.

4. Select OK. The values from the start, finish, and duration elements are copied into the
corresponding baseline elements. If the baseline elements contain data, you will receive a
warning that the baseline will be overwritten You can choose whether to override the data.

To clear a baseline on a schedule sheet:

1. Open the schedule sheet in the log.

2. From the Edit menu, select Baseline. The Set Baseline window opens.

3. Select the baseline you want to clear.

4. Select the Clear baseline radio button.

5. Select OK.

Lock or unlock the schedule sheet structure

You can lock a schedule sheet. This locks the columns and activity rows, preventing editing of
the sheet structure.

To lock or unlock a schedule sheet:

1. Open the schedule sheet.

2. From the File menu, select Lock Structure or Unlock Structure.
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Linked schedule sheets

Linked schedule sheets are project/shell schedule sheets that are dynamically linked to a
schedule sheet template. You must work with your Administrator to enable and setup the
schedule sheet linking.

Linking is optional; it is useful if you have numerous project/shell schedule sheets to update
simultaneously with the exact same information and structure.

Linked schedule sheets can be updated manually, but you can only make limited changes to
dates and data.

You can change:

• Start and Finish dates

• Durations

• Schedule sheet properties; however, a linked template push cannot change sheet
properties

You cannot:

• Add Activities

• Delete Activities

• Indent/Outdent Activities

• Import CSV, MPP

• Import with Overwrite or Merge (XML, WS)

• Modify Activity Name, Activity Codes

• Modify Scope Management Setup

• Cannot add /modify/delete columns

• Re-arrange (cut/paste) activities

The overall structure of the sheet (adding or deleting activities, for example) is updated only
through the associated linked template. The Administrator must unlink the linked schedule
sheets for you to be able to modify the structure of the sheet.

Note

Updating schedule sheets through linked schedule sheet templates can overlay the
structure of schedule sheets and the data elements listed below. Be sure that you
want the linked sheets to be updated to this extent by the template.

A linked schedule sheet template update to a linked schedule sheet can push:

• Changes to Activity Name

• Changes to Activity Codes

• Changes Activity Id (caused by re-ordering of activities)

• Addition of new activities or deletion of activities

• New or changed predecessor relationships
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• Addition, deletion, or modification of column definitions

• Ordering of activities in sheet

• Changes to the indentation of activities

Note

Changes to dependent activity Start Date or Finish Date caused by changes such
as modifications to predecessors or the addition or deletion of activities are
handled dynamically by the schedule sheet

To view the linked template for a linked schedule sheet:

1. Navigate to the schedule sheet log.

2. Select a schedule sheet that is linked to a schedule sheet template.

3. From the View menu, select Linked Template. The Linked Template window opens.

4. Select Close Window when you are done viewing the linked templates.

To link existing schedule sheets to a link-enabled template:

You can link an existing schedule sheet to a link-enabled template. Linking an existing
schedule sheet causes loss of existing data on the project/shell schedule sheet, including all
activities, columns, and cell data. Project/shell schedule sheet properties, including the
Schedule Start Date are retained.

1. Navigate to the schedule sheet log.

2. Select a schedule sheet that you want to link to a schedule sheet template.

3. From the View menu, select Linked Template. The Linked Template window opens.

4. Select Add. The Schedule Sheet Templates window opens.

5. Select a template, and click Select.

6. Click OK on the confirmation message that data in the newly-linked sheet will be modified
when the update is completed using the link between the template and the sheet.

7. Click OK.

To unlink schedule sheets from a link-enabled template:

Unlinking removes the link between the schedule sheet and the template so no further updates
can occur from the template.

1. Navigate to the schedule sheet log.

2. Select a schedule sheet that is linked to a schedule sheet template.

3. From the View menu, select Linked Template. The Linked Template window opens.

4. Click Remove.

5. Select the template.

6. Select OK.

Linked tags and Business Process fields
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Tags work with linked elements to connect schedule sheet activities with business processes,
shells, and configurable manager objects. With this feature, you can view key activity dates,
such as milestones, on forms like project details, without having to open the schedule sheet.

To select a link tag to populate a business process field:

1. Add a "Tag" column to the schedule sheet.

2. On the schedule sheet, select the row containing the activity you want to link.

3. Select the Tag column. The cell becomes editable.

4. Select the arrow, and select the tag you want to assign to this activity.
When you assign this tag to the activity, any form associated with this schedule that
contains a linked element with a matching tag will now show the current value of that
activity.

Search for schedule sheets

To search for a schedule sheet in the log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select Find.
The Find box opens at the top of the log.

4. From the Search By list, select the field to search by.

5. Enter search criteria in the Search for field.

6. Select Search.

Activity Sheet (Integrated with an External Application) in Schedule
Manager
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Note

Integration with P6 application only applies to the CBS type Shell.

For more information about the Activity Sheet, refer to the Unifier Earned Value Management
User Guide.

Additional information about an Activity Sheet integrated with an external application

• It is required that an Activity Sheet to have the following fields as fixed columns:

– Activity ID

– Activity Name

Note

You cannot remove the two required fields from an Activity Sheet.

• When an Activity Sheet Attribute Form is deployed to Unifier for the first time, all fields
present in the Activity Sheet Attribute Form are saved and displayed as columns in the
Activity Sheet following the same order.

• If you remove a field from an Activity Sheet Attribute Form and the Activity Sheet Attribute
Form is deployed to Unifier, the deployment does not go through if the field that you had
removed from the Activity Sheet Attribute Form is present as a column in the Activity
Sheet; otherwise, the deployment goes through if the field that you had removed from the
Activity Sheet Attribute Form is not present as a column in the Activity Sheet.

• If you add a new field to an existing Activity Sheet Attribute Form and the Activity Sheet
Attribute Form is deployed to Unifier, the columns in the Activity Sheet do not reflect this
change; you must manually add the field to the columns in the Activity Sheet.

• You can add columns to or remove columns from an Activity Sheet view.

• You can arrange the columns order in an Activity Sheet.

• You can find, sort, group, and filter Activity Sheets.

• The data within and Activity Sheet is synchronized with P6 by way of Gateway (Import/
Export Synchronization) daily.

Note

Exchange of data with inactive CBS type Shells is not permitted whether initiated
manually or by Gateway.

You can map the P6 CBS Code to the Unifier CBS Code ( bitemID) in Gateway (in the field
mappings).

When the Activity Sheet data is synchronized between P6 and Unifier, Unifier Provider
converts the P6 CBS Code to the corresponding CBS Code ( bitemID), and the Activity Sheet
is populated automatically.

When the data is synchronized between Unifier and P6, Unifier Provider converts the Unifier
CBS Code to the corresponding P6 CBS Code, and the Activity Sheet, in P6, is populated
automatically.
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The CBS auto-population works differently in Base commit, Change commit, and Payments
with respect to other classifications that are under Cost type business processes.

The auto-population for the CBS Code occurs in Base Commit business processes and
Change Commit business processes.

In Payments business processes, the CBS Code matches with the Commit line item of SOV,
the CBS Code is auto-populated; otherwise, the CBS Code does not auto-populate.

• If there is only one Commit line item matching the CBS Code/Cost Code, the CBS Code
will be auto-populated along with the Commit line item from the SOV, if the CBS Code/Cost
Code matches with what is present in the SOV.

• If there is more than one Committed line item (where the CBS Code matches with the
Activity picker), the value for the CBS code remains as it was.

• If the Activity picker is associated with a CBS Code that is not used by any of the
Committed line items in the SOV, the value for the CBS code remains as it was.

You can change the CBS Code by selecting the CBS Picker, which will over-write the auto-
populated value.

Gateway and Unifier Provider

The Activity Sheet object in Unifier must be available for integration through Gateway.

Note

The Activity Sheet object, in its entirety, must be available as a field in both Gateway
and Unifier.

To synchronize data between a P6 Activity object and a Unifier Activity Sheet object, data
mapping must take place. The following sections explain data mapping in detail.

Data Mapping Templates

About Data Mapping templates

When a project in Unifier is linked to a project in P6, each project retains their respective name,
with no changes applied to the names.

Establishing a link between a project in Unifier and a project in P6 is based on a specific Data
Element (uuu_int_p6_Project_id) corresponding to a specific P6 element (Project ID).

The following lists the out-of-the-box (OOTB) Data Mapping templates available for use and
provides a description for each template.

Create Activity Sheet from P6

Use this template to map all the fields in the Activity Sheet to the P6 Activity object that is
needed from P6. You can use this template to create a new Activity Sheet in projects.

There are 26 pre-defined elements that are included in the Activity Sheet Attribute Form. By
default, this template contains the first 24 pre-defined elements that are included in the Activity
Sheet Attribute Form, and the fields are mapped to the corresponding P6 Activity object.

The following elements are excluded from this template:
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• Primary Constraint

• Secondary Constraint

You can deploy custom activity attributes to Gateway and then add those attributes to this
template.

Update Activity Sheet from P6

Use this template to update an existing Activity Sheet in a project based on P6 data.

There are 26 pre-defined elements that are included in the Activity Sheet Attribute Form. By
default, this template contains 22 pre-defined elements that are included in the Activity Sheet
Attribute Form, which cannot be populated by Reverse Auto-Population. As a result, the
template does not contain the following elements:

• Actual Start

• Actual Finish

• Primary Constraint

• Secondary Constraint

You can deploy custom activity attributes to Gateway and then add those attributes to this
template.

Send Activity data to P6

Use this template to map those fields in the Activity Sheet Attribute Form to a P6 Activity object
that might get updated in Unifier by way of a Business Process record. These fields need to be
updated from Unifier to P6 through Gateway.

There are 26 pre-defined elements that are included in the Activity Sheet Attribute Form. By
default, this template contains the 2 fields that can be populated by Reverse Auto-Population.
As a result, the template contains only the following two elements:

• Actual Start

• Actual Finish

You can deploy custom activity attributes to Gateway and then add those attributes to this
template.

Note

The fields in this template must be maintained exclusive of the fields in the "Update
Activity Sheet from P6" template. There are no common fields between the "Send
Activity Data to P6" template and the "Update Activity Sheet from P6" template. If you
add the common fields to the two templates, inaccurate information can be generated
in either application (Unifier or P6).

Editing Data Mapping templates

You can edit (take out a field or add a new field) any of the Data Mapping templates mentioned
in this section by going to Gateway, selecting Configuration, and then selecting Customization.

1. From the Customization window, select the "Activity" business object from the "Select
Business Object'' drop-down list to see all Data Mappings, based on the "Activity" object.

2. Select any Data Mapping template.

3. Select Edit, and go to the Mappings tab.
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4. Add a new field, to exchange data for example.

You can add any custom field to an Activity Sheet Attribute Form in uDesigner and Deploy the
Activity Sheet Attribute Form to Gateway. All the fields from the Activity Sheet Attribute Form
appear in Unifier (P6 Activity Sheet drop-down list). As a result, you can select any Activity
Sheet Attribute Form that you have defined in Unifier and map the Activity Sheet Attribute
Form to a corresponding activity field (fixed field or user-defined field) in P6; however, ensure
that you map the Unifier element to the Activity Sheet Attribute Form in a way that the "Data
Types" of the P6 Activity elements match the Data Definitions (DEs) of the Activity Sheet
Attribute Form. The following shows the mapping of data between the P6 Data Types and the
corresponding DEs.

P6 Data Type Corresponding Unifier Data Definition

Text (40 chars) SYS Short Description Text 50
Text (120 chars) SYS Short Description Text 120
Text (UDF* Fields) SYS Short Description Text 255
Date Date Picker
Cost Currency Amount
Number Decimal Amount
Integer Integer Amount
Indicator SYS P6 Indicator

Note

In the Edit window of the Data
Mapping template, Gateway
does not display "Indicator" as
an available field type. As a
result, you need to map an
"Indicator" type field from
Unifier to P6 UDF and set the
"Data Type" as "String."

Activity Status Pulldown SYS Short Description Text 50
Activity Type Pulldown SYS Short Description Text 50

*UDF: User-defined Field

Additional information about editing Data Mapping templates

In P6 some activity attributes fields, cannot be updated manually, or by way of any other
methods. These fields must be calculated using the P6 internal logic. If you modify the "Send
Activity Data to P6" Data Mapping template to map to a P6 activity attributes field that cannot
be updated, then:

• The P6 internal logic prevents the mapping during integration and synchronization will fail.

• The data in P6 is updated incorrectly.

Ensure that you are aware of the limitations when you add a new field to the "Send Activity
Data to P6" Data Mapping template.

Since the "Actual Finish" field is added to the "Send Activity Data to P6" Data Mapping
template and based on the value of the "Activity Type" field in P6, the "Actual Finish" field gets
calculated, in P6, you must not keep the "Actual Finish" field in the "Send Activity Data to P6"
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Data Mapping template. Instead, you must keep the "Actual Finish" field in the "Update Activity
Sheet from P6' Data Mapping template.

In short, you need to keep, or designate, only one application as the source for each field. This
is to prevent a field to get updated in both applications.

Business Flows

The Unifier Provider allows you to filter Shells using "Project IDs." You can do this filtering in
two ways:

• By entering a fixed list of comma-separated Project IDs values (corresponding to each
Shell), and when you synchronize, all the Projects that match those Project IDs are pulled.

• By using any Shell attribute (custom or system defined). When Object = Project, you can
go to the "Source App Parameters" window and add filter conditions to a synchronization,
using any data element of "Data Type = String" or "Data Type = Integer'" from a Shell
Attribute Form. The "Field" drop-down lists in the Edit Business Flow window have an
option called "Shell Attribute." You can:

1. Select Shell Attribute.

2. Use the information presented (in the Value box) to enter any Shell attribute DE name
of Data Type = "String" or "Integer."

3. Select Add Row, and set the item as a condition to filter the Unifier Shell.

Note

– You can set only one value for a Shell attribute within a given condition;
however, you can add more than one condition for a Shell attribute.

– If you set conditions for a DE which is neither "Text" nor "Integer," the
synchronization will fail and you will receive an error message.

There are two templates available for OOTB Business Flows:

• Get Activity data from P6

– To create Activity Sheet in the Unifier Projects.

– To update an existing Activity sheet.

• Send Activity data to P6
To transfer, or push, data from a Unifier Activity Sheet object to a P6 Activity object.

Note

For more information, see Data Mapping Templates.

The "Import Project data" flow ("Send Activity Data to P6" flow) has the Data Mapping template
the "Send Activity Data to P6" set as "Update" only to prevent the accidental creation of
activities in P6 from Unifier. P6 is the source for all activities.

Synchronization
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The synchronization of the following two commands (on the OOTB Data Mapping templates) is
scheduled to run daily:

• Get Activity Data from P6

• Send Activity Data to P6

Note

For more information, see Data Mapping Templates.

Synchronization can be performed:

• From Unifier by executing the "Get Data" or "Get Activity Sheet Data" commands from the
"Activity Sheet" log or the Shell log.

• From Gateway, manually.

The Unifier Provider performs a check to see if the Unifier Project is linked to the
corresponding P6 Project.

• If the Project is not linked to the corresponding P6 Project, you must establish the link.

• If P6 does not have a corresponding project, a message will notify you that the project has
not been created in P6.

To ensure a successful synchronization, do the following:

1. Set the Shell attribute DE = uuu_integrated_with to P6.

Note

If the attribute was missing, after this setup the integration will take place.

2. Receive the Activity Sheet data from Gateway and:

• If an "Activity Sheet" does not exist in Unifier, create the "Activity Sheet," populate the
fields with the data received, and name the sheet as: <P6 project name>.

• If an "Activity Sheet" exists, update the "Activity Sheet" with data from Gateway.

You only need to perform the steps above to create the "Activity Sheet" within Unifier Shells the
first time. After you create an "Activity Sheet," the hourly synchronization updates the "Activity
Sheet" with the latest data received from Gateway.

When projects between Unifier and P6 are linked for the first time, Gateway ensures that a P6
Project attribute that is integrated is checked.

If a "Get Activity Data from " synchronization is performed, but the P6 Project that must
correspond to the Unifier Project is not found by Gateway, the system will generate an error
message.

Sending Activity Sheet data to P6

When you synchronize, the Unifier Provider performs the following:

• Checks to ensure that the Unifier Project contains an "Activity Sheet."

– If an "Activity Sheet" does not exist, the system generates an error message.

– If an "Activity Sheet" exist, you can continue on with pulling (receiving) data.
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• Pull all updated "Activity Sheet" data by way of Reverse Auto-Population since the last
"Send Activity Data to P6" synchronization. You can send the updated "Activity Sheet" to
Gateway in Portable Database Image (PDI) format.

– If the "Activity Sheet" has not been updated by way of Reverse Auto-Population, you
do not need to send data to P6.

– If you add a DE to a Data Mapping template that is read-only in P6, the system
generates an error message.

Additional information about synchronization

• If an Activity Type, in a Schedule, is set as “Start Milestone,” P6 does not allow you to
update the "Actual Finish Date." If you proceed with updating the "Actual Finish Date," you
generate inconsistent data.

• If an Activity Type, in a Schedule, is set as “Finish Milestone,” P6 does not allow you to
update the "Actual Start Date." If you proceed with updating the "Actual Finish Date," you
generate inconsistent data.

• You must define the filter condition before you filter the Unifier Project using the "Send
Activity Data to P6" synchronization command.

Note

If a filter condition is defined in Business Flow, but a filter condition is not defined
in the synchronization, Gateway will not know which Project to send data from. As
a result, filter condition must be defined within the synchronization itself.

Connectivity issues with Gateway or incorrect Gateway parameters will cause synchronization
to fail. Use History, Admin mode, to see the list of failed synchronizations, if any.

Criteria for successful data exchange

Ensure that the fields ("Update Activity Sheet from P6" and "Send Activity data to P6") in the
Data Mapping templates are not overlapping and a field that is set to map from P6 to Unifier is
not added to the "Send" template.

Note

The OOTB Data Mapping templates are designed in a way that the fields are
exclusive; therefore, when you edit a Data Mapping template, ensure that you keep
the fields that are exclusive intact.

If you use DE = uuu_int_p6_project_id for linking P6 and Unifier projects, when the "Project ID"
field in P6 is updated, the "P6 Project ID" (uuu_p6_project_id), field in corresponding Unifier
Shell, must be updated manually.

UDR, Data Views, and ER View

You can access and open an "Activity Sheet" in Unifier by way of User-Defined Reports
(UDRs), Data Views, and ER views.

The new Data Type that you need to use for creating UDRs is the "Shell Activity Sheet."
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Using Schedule Sheets

Before you begin: Schedule Sheet permissions are granted on a sheet-by-sheet basis.
Adding or editing an activity requires Edit Data or greater permission. If you only have View
permission, you cannot add or edit activities. The Schedule Manager helps you manage
project/shell schedules by:

• Creating project activities

• Assigning cost codes to activities

• Assigning roles to activities

• Creating relationships between activities

• Tracking schedule progress and variables

• Calculating the schedule's critical path

Note

The Schedule Manager feature was deprecated starting with version 23.5.
However, if you have access to it, you can continue to use it with existing
configurations, but you cannot create Schedule Sheets.

In Unifier, you can also import project schedule records from Primavera P6. Imported
schedules are editable and the data can be used in reports. If you copy activities from one
schedule to another, the system will immediately notify you if the change will create a schedule
conflict so that you can make corrections as you work.

Each change in the Schedule Manager creates a record in Unifier, which is useful for auditing
purposes. An audit report of these records shows detailed information on dates, events,
actions, and old values versus new values, along with the user or proxy user who performed
the action.

Each project can have multiple schedule sheets, and one Master Schedule Sheet. The master
schedule sheet drives project start and end dates, tracks the project's progress, and serves as
the interface between the Schedule Manager and other modules. The master schedule
integrates cost items on the schedule with the Cost Manager. Users can refresh resource rates
on the schedule sheet and post the new rates to the Cost Manager, update the cost sheet with
assignment costs, and refresh costs on the sheet to recalculate labor costs and post them to
the cost sheet.

Features include the following:

• Fully configurable activity attributes form

• Activities and Gantt chart on the same schedule sheet

• Interactive Gantt chart with ability to drag activity end dates and link activities

• Tracking Gantt chart

• Filters for activities

• Baselines for schedule sheets and activity sheets

• Activity update

• Support for existing integration of Schedule Manager with the Resource Manager, enabling
resource loading of schedule activities
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• Multiple CBS codes for each activity to capture activity costs, such as labor, non-labor, and
fixed costs. If the existing design supports it, you can add a column to the schedule sheet
to display the CBS codes associated with each activity.

• View the cost distribution information by CBS codes from a schedule sheet

• Cut and paste and copy and paste of rows in a sheet

• Update of schedule sheets from linked templates

• Critical path calculation and display

• Streamlined and enhanced integration and interaction between Unifier's Schedule
Manager and Primavera and Microsoft Project

• Activity progress tracking and percentage of work completed per assigned resource

• Works with shells that have the CBS cost type

• Scope Management, with the ability to launch business processes from activities and
automate schedule management.

• Budget and progress settings, and the ability to work with progress and earned progress
data

You will need to add activity rows to the schedule sheet before you can enter your company
data to the schedule sheet.

Scope Management

Scope Management defines deliverables, responsible roles, actual assignees and their
schedules, and drives coordinated production of these deliverables. Scope Management
initiates actions for producing deliverables based on the completion of dependencies. It routes
them to the responsible person or group, monitors their completion, and updates deliverable
statuses automatically. It manages different activities across schedules for different team
members simultaneously.

Team members work on BPs that are linked to activities in a schedule sheet. Scope
Management allows you to use existing Schedule Manager functionality with added data
elements to automate the management of a project's scope and schedule with all associated
activities, tasks, and deliverables. This feature provides project managers with the ability to
manage each scope item's task assignments, ownerships, and durations.

Note

The Schedule Manager feature was deprecated starting with version 23.5. However, if
you have access to it, you can continue to use it with existing configurations, but you
cannot create Schedule Sheets.

Project managers can use scope management to manage high-volume, quick turnaround
projects that have standardized scope and scheduled activities. Examples of projects that
would benefit from the use of scope management functionality are retail construction projects
such as bank branches or chain fast food restaurants. Scope management capabilities are
also useful for large capital projects with complex scope and schedules, and that have
numerous dependent activities and milestones with associated tasks and deadlines.

Scope management:
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• Coordinates the creation of the defined deliverables using the schedules of the various
assignees

• Automatically moves tasks to the next assignee.

• Routes tasks related to the deliverables to the next responsible assignee (person or
group), monitors the state of the tasks, and updates deliverable status automatically.
Actions for the creation of deliverables are based on fixed-time durations and the
completion of dependencies.

• Launches business processes that are linked to activities

This functionality can be enabled on any schedule sheet, including a master schedule sheet.
Scope management enables you to link BPs with schedule sheet task activities and route
those BPs with an automatic update of status as they are routed and worked on. The BPs
represent the work that needs to be done to complete the task. You can override automatic
routing at any time and launch the BPs manually. The BP-related task is completed when
specified conditions are met.

Working with Schedule Sheets with Scope Management

You can have any number of schedule sheets. There is one master sheet, which appears in
bold in the log. The master schedule sheet drives the activity start and finish dates. You can
use it to track progress and resource assignment information to other modules. You can use
scope management on any existing schedule sheet. You must have the correct permissions to
be able to view and modify scope management data. If you find that you cannot access the
functionality that you need, see your company administrator.

To access project schedule sheets:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.
The Schedule Sheets log opens. By default, the log lists all active schedule sheets.

3. To view all active and inactive sheets, from the View menu, select All.

Scope management and multiple calendars

In Scope Management a business process record can be created from an activity based on the
setup. As part of setup, you can define how the system should calculate the workflow duration
of the business process record that gets created.

These are the following options:

Enforce Activity Duration:

System will take the planned duration of the activity and will pass it to business process record
to calculate workflow due date and the workflow duration. With multiple calendars, it is possible
that the activity has a different calendar than the calendar used on business process (which
was the project/shell calendar). In this scenario, the system will take the duration from the
activity and calculate the record/workflow due date based on business process calendar.

Enforce Activity Finish Date:

System will set planned finish date as the workflow due date. With multiple calendars, it is
possible that the activity has a different calendar than the calendar used on business process
(project/shell calendar). In this scenario system will take planned finish date of activity and
force it to due date of business process record.
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In both cases when progress comes back from business process record to the activity, the
system will take the actual end date and updates activity actual finish date. In this scenario, the
system will not consider activity calendar.

Manage scope management properties

Scope Management functionality can be enabled on any existing schedule sheet (including
master schedule sheets). You can modify the properties associated with scope management.
These include:

• Auto-control

• Schedule start date

• Error notification to users and groups

To manage scope management properties:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Properties.

4. On the General tab, complete or modify the fields described in the following table, and
then select OK.

In this field: Do this:

Auto-control Controls the automatic update of tasks. The default is
Off. Setting auto-control to On enables the automatic
launch of BP records. Setting auto-control to Off means
that BPs will not be launched automatically on activities
and completion conditions will not be checked on
activities. Users can still launch BPs manually.

Note

The system disregards
predecessor/successor
dependency relationships
when you manually start an
activity, even if auto-control is
set to On in the schedule sheet
properties.

Schedule Start Date Drives the dates of floating activities on the schedule
sheet. Activities cannot begin before this date, unless
their preceding activities complete previous to this date.

Notify users and/or groups on errors Select users and groups to be notified if there are errors
during the scope management task routing.

About scope management data elements

There are data elements that are specific to scope management, which were added to the
Schedule Attribute Form in uDesigner. These data elements can be added to the scope
management schedule sheet as columns as you work with the sheet. If data elements are on
both the Schedule Attribute Form and on the business process that you will be using to run the
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activity task for scope management, the values are copied from the form to the business
process and conversely.

When you are planning to use scope management, consult with the uDesigner user and your
company administrator to achieve the setup of data elements and business processes that will
meet your business needs for managing scope.

The scope management-specific data elements that are added to the Schedule Attribute Form
are:

Data Element Name Description

Actual Start Date Actual start date of the activity.
Actual Finish Date Actual finish date of the activity.
Actual Duration Actual duration of the activity. This is calculated from

the Actual Start Date and Actual Finish Date.
Status Activity status. The default is Not Started.
Predecessors A list of the predecessor activities.

Note

Activities that have no
predecessors are known as
floating activities.

Record Number Hyperlink to the linked business process record.
Record Status Hyperlink to the linked business process record.
Estimated Start Date Calculated date.
Estimated Finish Date Calculated date.
Estimated Duration Calculated duration.
Auto-update Activity Data Enables the automatic update of activity data. The

default is unchecked. If this checkbox is not selected, the
activity must be completed manually, and automatic
completion will be turned off. This means you must
change the activity status to compete and enter an
actual finish date.

Linked BP Name Name of the linked business process.

Set up scope management for activities

You can set up the schedule sheet activities to link to BPs, specify responsible users or groups,
enter a due date, and create completion conditions.

You can change all setup options for activities that have the status of not started or not
applicable. For activities that have an in-progress status and have a linked BP record, you can
change only the completion conditions. You cannot change setup options for activities with the
status complete.

To set up scope management for an activity:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

Chapter 1
Schedule Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 498 of 671



4. Select an activity in the sheet.

5. From the File menu, select Setup Scope Management.
The Activity Task Setup window displays on the right side of the pane, replacing the view of
the Gantt portion of the window.

Note

You can return to the Gantt chart view by selecting the Gantt button.

6. Complete the Activity Task Setup portion of the window as described in the table below.

7. Repeat these steps for each activity.

8. Select Save when your changes are complete.

In this field: Do this:

Linked Business Process Select a project/shell level workflow BP that will launch
from the activity.

Bypass initiation step during auto-creation Auto-created records normally appear in users' Tasks
and BP logs as an initiation step (I Step). Select this
checkbox if you want to bypass the I step that this auto-
creation normally creates. If you select this option, the
auto-created record will skip the initiation step and will
appear in the user's BP log at the step that the
Administrator designated on the BP's Auto-Creation tab
during setup.
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In this field: Do this:

Record Due Date Select Enforce Activity Duration (default) or Enforce
Activity Finish Date. When a BP is launched
automatically or manually from an activity, you can
specify whether the record due date on the newly
launched BP record is set to use the activity duration or
the activity finish date.
Enforce Activity Duration: The finish date of the
activity is not considered. If the Record Due Date option
is set to enforce the activity duration, the value is
calculated as:
Record Due Date = Current Date (date/time) + Activity
Duration (days)
Enforce Activity Finish Date: If the Record Due Date
option is set to enforce the activity finish date, it is
calculated as:
Record Due Date = Activity Finish Date

Note

This functionality applies to
workflow BPs launched from
Scope Management only. Non-
workflow BPs cannot be
launched using Scope
Management.

If you select Enforce Activity Finish Date, the workflow
due date for the business process might be affected. Be
sure to select Yes for Override Workflow Due Date in the
workflow setup for the affected business process.

Responsible User(s) /Group(s) Select one or more users or groups to which to route the
business process. Be sure to add users and groups to this
field so the business process associated with the activity
will launch properly.

Completion Conditions Add one or more conditions to indicate the completion
condition on the activity. Select Add and select from the
data elements for the selected BP, enter a label for the
condition data element, select a condition, and select a
value. Select OK. Conditions can be a BP status, a
monetary value, or the completion of certain
predecessor activities. You set up several completion
conditions for each activity. See Completion Conditions for
details.

Show results matching ANY condition Select to complete the activity if any of the completion
conditions are met for the activity.

Completion Conditions

You can set up completion conditions for a string or a date.

For example, for the string City:
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For example, for a date:
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Launching Business Processes from Activities

While the scope management functionality is automatic after it is set up, you can also manually
launch or remove BPs from activities and manage the activity properties.

Note

If a project/shell changes status from Active to View-Only or Inactive, business
processes associated with activities are not launched while the project/shell has the
View-Only or Inactive status. When the project/shell reverts to Active status, you must
adjust the dates on these business processes and launch them manually.

Manually launch a business process

When you manually launch a BP associated with an activity, you override the Auto-control
property setting. See Manage scope management properties for details on properties.

See About Launching or Removing Business Processes from Activities for details on the
conditions under which you can manually launch BPs.

To manually launch a BP associated with an activity:

1. Go to the shell tab, and switch to User mode.
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2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select an activity in the sheet.

5. From the Edit menu, select Linked Business Process, and then select Start.
You can select one or more BPs and launch them. They will be routed to the assignees
that have been specified.

Remove the link between a business process and an activity

You can remove (unlink) a BP from an activity. See About Launching or Removing Business
Processes from Activities for details on the conditions under which you can remove BPs from
activities.

To remove the link between an activity and a BP:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select an activity in the sheet.

5. From the Edit menu, select Linked Business Process, and then select Remove Record.
You can select one or more BPs. The BP itself is not deleted.

Note

The link between a BP and an activity is automatically removed if the BP is
terminated. When a linked BP is terminated, the BP hyperlink is removed from the
associated activity, and the activity is set to not started.

Update activity properties

To update activity properties for scope management:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select the link for the applicable activity in the sheet.
The Activity Properties window displays.

5. Modify the activity properties as needed.
The properties shown in the Activity Properties window depend on the design configured in
uDesigner. Activity properties associated with scope management can include what is
shown in the table below.

6. Select OK.
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Property Name Definition

Activity Statuses Read-only for automatically controlled activities.
Editable for manually controlled activities. The statuses
are:
• Not Started: All activities have this as the initial

status by default. Indicates that the BP linked to the
activity has not yet been launched.

• In Progress: Indicates that predecessor activities
are complete and that the current activity is not
started. A new BP record is created and linked to the
activity.

Note

You cannot modify certain activity
attributes while an activity is In Progress.

• Complete: Indicates that an activity is complete
based on the completion conditions set up for the
activity.

Linked BP Name Read-only; displays the BP linked to the activity.
Record Number Read-only; displays the current record number that is

linked with the activity.
Record Status Read-only; displays the current status of the BP record

linked to the activity.
Actual Start Date Read-only or editable, depending on the setting for the

Auto-update activity data box. This value is set when the
linked BP is launched for the activity.

Actual Finish Date Read-only or editable, depending on the setting for the
Auto-update activity data box. This value is set when the
linked BP is completed based on the completion
conditions.

Estimated Start Date Read-only; indicates the estimated start date for the
activity.

Estimated Finish Date Read-only, indicates the estimated finish date for the
activity.

Auto-update activity status The default is not selected. Indicates if the current
activity is automatically controlled or manually
controlled.

Dependencies Read-only; lists the predecessor activities for the current
activity using a coding format indicating lag and lead
time: Finish to Start (FS), Start to Start (SS), Finish to
Finish (FF), and Start to Finish (SF). For example:
3FS + 3d (Activity 3 is a predecessor with FS relationship
with 3 days lag)
2SS - 1d (Activity 2 is a predecessor with SS relationship
with a 1 day lead)
An activity can have multiple dependencies separated
by a comma. The value is updated every time there is an
addition or change to the predecessors.

Status Transitions and Activities
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Scope management activities have statuses that control the transition of the activity from one
state to another as it progresses toward completion. You can perform certain changes to the
activity during its progress, but it can be limited as to what you can change while an activity
has the status In Progress. The activity status transitions vary depending on whether an
activity is automatically or manually launched.

Automatic activity status transitions

When activities are auto-controlled (the Auto-update Activity Status box is checked), activity
status is read only. The statuses automatically transition as follows:

• Not started (default)

• In progress (this is when the linked BP is launched)

• Complete (when the BP completion conditions are met)

Manual activity status transitions

You can change the activity status manually when the Auto-update Activity Status box is not
checked. You can change the status during any of the states (not started, in progress, or
complete).

• If you change the status of an activity to In Progress, you can enter the actual start date.
This clears the existing actual finish date.

• If you change the status of an activity to Not Started, both the actual start date and the
actual finish date are read only.

• If you change the status of an activity to Complete, you can enter an actual finish date. In
this case, the actual start date, if it is not populated, is set to the actual finish date at
activity completion.

About Launching or Removing Business Processes from Activities

Scope management functionality enables manual creation of business processes (BPs) from
activities on a schedule sheet. A new BP record can be created for every eligible activity. The
BP record will be permanently linked to the activity, unless you terminate or remove the BP. An
activity can be linked to only one BP record at a time. Any two activities cannot link to the same
BP record.

Automatic launching of business processes

For BPs to launch automatically from activities, these conditions must be met:

• Auto-control must be set to On on the Schedule Sheet properties

• Activity is not manually controlled, which means that Auto-update Activity is selected

• Activity has a BP setup

• Activity has the status Not Started

• Activity has no predecessors or the predecessors are all in Complete status

• The Start Date for the activity is not in the future
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Manually launching business processes

You can launch BPs manually by selecting an activity and choosing Edit, selecting Linked
Business Process, and then selecting Start. To manually launch BPs, these conditions must
be met:

• Activity has the status Not Started

• BP setup is present on the activity

Note

A BP can be launched manually to override the setting of the Auto-control flag on
the Schedule Sheet Properties and Auto-update Activity Data on the Activity
Properties.

Manual launch under various conditions:

Auto-control on Schedule Sheet
Properties

Auto-update Activity Status on
Activity

System Behavior

On/Off Checked Manually launched BP is tracked by
the system, and actuals will be auto-
populated on launch and completion.

On/Off Unchecked Scope Management will not keep
track of BP completion and auto-
population of actual start and finish
dates of manually launched BP.

Manually remove business process link

You can remove a linked BP record manually if these conditions are met:

• Activity is in manual mode; that is, Auto-update Activity Status on Activity is unchecked

• Activity is in any status.

Automatic removal of business process link

If a BP is terminated by the user, the termination removes the BP link from the activity and sets
the activity back to Not Started.

About Activity Completion

This section covers the criteria for automatic and manual completion of scope management
activities.

Conditions for the automatic completion of activities

The system checks the linked BP record workflow for in-progress status activities that are not
manually controlled (Auto-update Activity Data box is checked for the activity).
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When the system detects BP completion based on the conditions, it performs the following
actions:

1. Actual finish is updated with current date

2. Activity status is updated to complete

3. Success of activities is evaluated for the automatic launching of further BPs

If there is no BP setup or if the activity is manually controlled, the system does not evaluate the
BP completion conditions but waits for you to manually complete the activity.

Conditions for the manual completion of activities

Activities that are manually controlled (Auto-update Activity Data box is unchecked) can only
be completed manually. In this case, you must change the activity status to Complete and
enter the actual finish date, which is required for the activity to complete successfully.

About Manual or Automatic Control of Individual Activities

This section describes the behavior of manual and automatic control of scope management
activities.

Auto-update activity data on activity attributes

Activities can be controlled in two modes: automatic or manual. This choice depends on the
value of the Auto-update Activity Data checkbox.

If Auto-update Activity Data is checked, automatic launching of BPs and completion checks
with the possibility of launching the BP sooner.

If Auto-update Activity Data is unchecked (default value), the user has manual control, but
basic scope completion rules are enforced. BP link is maintained. New BPs can be launched
manually. The BP is not checked for completion.

The following table summarizes the behavior in each mode:

Behavior Automatic Manual

Auto-update Activity Data checkbox Checked Unchecked (default)
BP setup allowed Yes Yes
Create BP record link Yes Retain existing link if any exists
BPs launched by scheduler Yes No
Manual BP launch Yes Yes, but completion and actuals are

not tracked
BP condition check Yes No
Scope status updated Updated by system Manual update via drop-down list

choice
Scope status update rules enforced Yes Yes
Actual dates Automatic Manual

Rules for modifying the Auto-update Activity Data checkbox

These are the rules for using the Auto-update Activity Data checkbox.
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• The Auto-Update Activity Data checkbox is deselected by default for all schedule sheets.

• As soon as a new BP is set up for the activity (by going to the File menu and selecting
Setup Scope Management), the Auto-update Activity Data checkbox will be selected only
for activities in the Not Started status.

• Updating the BP setup on an activity later will only select the Auto-update Activity Data
checkbox automatically if the activity is in the Not Started status. If you have not set up any
BP linking, by default, the box is unchecked. In that case, you can update the Actual Start,
Actual Finish, and Status fields.

• You can manually modify the Auto-update Activity Data checkbox for any activity status,
including complete.

System behavior when the Auto-update Activity Data checkbox is modified

The following is the sequence of the system behavior when the Auto-update Activity Data
checkbox is modified:

1. The Auto-update Activity Data checkbox is deselected by default, assuming that no BP
setup exists for the activity. As soon as a new BP is set up or modified for the activity, the
Auto-update Activity Data checkbox is checked.

2. Deselecting the Auto-update Activity Data checkbox will:

a. Retain the BP record link (if any).

b. Retain the original status of the activity.

c. Change the activity status of an editable field.

d. Retain existing actuals but allow them to be modified.

3. Subsequent selecting of the Auto-update Activity Data checkbox will:

a. Retain the BP record link if it exists.

b. If a BP record link exists, update BP record status on the activity, and check the BP
record for complete condition and set the appropriate status of the activity (either
Complete or In Progress).

c. If a link does not exist and conditions allow the start of the BP, the system launches the
BP and sets the activity status to In Progress.

d. If a link does not exist and conditions do not allow the start of the BP, the system sets
the activity status to Not Started.

Note

Setting the status to Not Started or Not Applicable in manual control mode
does not clear the BP record link. The actual start cannot be a future date
when entered manually, and the actual finish cannot be a future date when
entered manually.

Impact of Schedule Start Date

The schedule start date on schedule sheet properties defines the earliest possible date on the
schedule sheet. The start dates of all activities on the schedule sheet must be greater than or
equal to the schedule start date.
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The schedule start date affects the first activity in a group of linked activities and controls the
start of any floating activities. Floating activities are activities that have no predecessor
activities.

When you change the schedule start date, the entire schedule moves, and all the dates adjust
in relation to the new schedule start date.

The schedule start date is a required field on schedule sheet properties. Updates to the
schedule start date start activities are based on following rules:

• Floating activities start and retain the offset from the schedule start date specified on the
sheet properties.

• The start date on floating activities can be updated; however, the activities start date
cannot be earlier than the schedule start date.

• The start date of any floating activity will drive the start of the system update process. Each
floating item may be the root of a tree and hence will have its own system update process
that drives launching and completion of BPs for the current activity and successor
activities.

• Forecast dates (start date, finish date) can only be changed for not started or in-progress
activities.

• The schedule start date cannot be changed when at least one activity is in progress or
complete.

• Manual launch cannot be done on any activity before the schedule start date on the sheet
properties.

Calculation of Estimated Start and Finish Dates

Estimated dates are used to predict the effect of delayed or early completion of predecessor
activities on successor activities. They are useful to identify potential problems or the potential
for schedule compression.

The estimated start, finish, and duration are read-only elements calculated by the system.
They are updated by the system each time activities complete. Succeeding estimated dates
are adjusted based on the logic below.

For completed or predecessor complete activities:

• Estimated Start Date = Actual Start Date

• Estimated Finish Date = Actual Finish Date

For in-progress or not started activities:

• Estimated Start Date = Predecessor (latest) Estimated Finish Date

• Estimated Finish Date = Estimated Start Date + Forecast Duration

Impact of Successor and Predecessor Activities on Launching and Completion of BPs

This section discusses the interaction of activities and the launching of BPs. The start of an
activity is affected by whether there is a lag or a lead, as shown in the examples below.

Finish-to-start (FS)

Chapter 1
Schedule Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 509 of 671



The successor activity is launched when the activity completes or the Calculated Date =
Predecessor Actual Finish + Lag (if not already past).

In case of a lead, the successor activity is launched on the forecast start date (similar to a
floating activity.

Finish-to-start

Start-to-start (SS)

When an activity's predecessor is started (for example, status = in-progress), it is also placed
into an in-progress status (assuming zero lag).

• Lag: Success, or activity will be started on forecast date

• Lead: Success, or activity will be started on forecast date

Start-to-start

Finish-to-finish (FF) and start-to-finish (SF)

The activities will be treated as floating activities. They are launched on their forecast date.

• Lag: Success, or activity will be started on forecast date

• Lead: Success, or activity will be started on forecast date

Finish-to-finish, start-to-finish

Entering and Viewing Cost Data

In uDesigner, data elements can be added that allow you to enter and view cost data on
schedule sheets. These data elements are Activity Cost 1 (and Activity Total Cost 1 Per CBS)
and Activity Cost 2 (and Activity Total Cost 2 Per CBS). The Cost and Per CBS data elements

Chapter 1
Schedule Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 510 of 671



have a predefined association between them. Also, the Activity Latest Progress As Of data
element can be added to allow you to track the date of the last change to an activity.

Note

Unifier refreshes the cost data when you go to the File menu, select Refresh, and
select Cost in a Schedule Sheet and refresh immediately or set up a refresh
frequency. See Refreshing Schedule Sheet data for details.

In the activity setup performed by the Administrator, one of more CBS Codes can be
associated with an activity. The value carried by the Total Cost data element on add to a
Schedule Activity Attribute Form gets passed onto these CBS codes as the result of
calculations such as data roll up to a Cost Sheet, or earned value calculations. The logic used
by the Activity Cost 1 and Activity Cost 2 and the associated Activity Total Cost 1 Per CBS and
Activity Total Cost 2 Per CBS data elements is based on the association of an activity to a CBS
code.

The values for Activity Total Cost 1 Per CBS and Activity Total Cost 2 Per CBS data elements
are calculated by the system based on the corresponding Activity Cost 1 or Activity Cost 2 data
element values.

These are the steps the system follows to calculate values for Activity Total Cost 1 Per CBS
and Activity Total Cost 2 Per CBS data elements:

1. If the combination of Cost and Per CBS data elements are used on a Schedule Activity
Attribute Form, the system will scan through all the activities and associated CBS codes.

2. The system will accumulate all the values in the Activity Cost 1 or Activity Cost 2 data
elements for all activities per CBS code associated with each activity.

3. Use the total value calculated in step 2 per CBS code as the value for each Activity Total
Cost 1 Per CBS and Activity Total Cost 2 Per CBS data element specified for each activity.

4. Each activity gets a total value calculated in step 2 based on the CBS code associated with
it.

The following example explains these calculations. For this example, the data elements Activity
Cost 1 and Activity Total Cost 1 Per CBS have been added to the attribute form:

Activity Name Activity Cost 1 Activity Total Cost 1 Per CBS
Control Account 1 $28,000.00  
Control Activity 1.1 $19,000.00
Control Point 1.1.1 $10,000.00 $28,000.00
CBS - 1 $10,000.00  
Control Point 1.1.2 $9,000.00 $28,000.00
CBS - 1 $9,000.00  
Control Activity 1.2 $9,000.00
Control Point 1.2.1 $5,000.00 $28,000.00
CBS - 1 $5,000.00  
Control Point 1.2.2 $4,000.00 $28,000.00
CBS - 1 $4,000.00  
Control Account 2 $20,000.00
Control Activity 2.1 $20,000.00
Control Point 2.1.1 $8,000.00 $20,000.00
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CBS - 2 $8,000.00  
Control Point 2.1.2 $12,000.00 $20,000.00
CBS - 2 $12,000.00  

In the above example, Control Point 1.1.1 has a value $28000.00, which was arrived at by
adding the value of CBS - 1 across all activities.

Effects of multiple calendars

Activities can be affected by calendar selection, if there are multiple calendars implemented.
There can be a Calendar column in the activity sheet, for example. This column will allow to
select a calendar per activity as needed. If this column exists, you can select from the
Company level calendars and Project/Shell calendars as permissions allow. Any defined
Custom calendars (which are defined for the Schedule Manager at the project/shell level) are
not available for selection on the Activity Sheet.

If you are using an Activity Attribute Form designed in uDesigner to manage activities, the data
element uuu_activity_calendar can be added to the form so users can select calendars. If you
are not using a designed Activity Attribute Form (are letting Unifier use the default form
provided), the data element uuu_activity_calendar is automatically included in the Activity
Attribute Form.

When activities are updated through the Activity Sheet, they consider the calendar in use for
the activity. The Start Dates, Finish Dates and Durations can be affected by the calendar used
for an activity. Double-click the Calendar cell to see a list of Company level calendars and
project/shell calendars (not the custom calendar). You can select another calendar for the
activity.

The selected Start Date or Finish Date for an activity can be a non-working calendar day,
however the duration of the activity will only account for working calendar days.

Note

When you select the alternate calendar and click Save, the schedule sheet associated

with the activity is marked for refresh with the Refresh icon  .

Project Progress Data Accumulation and Calculation

The Schedule Manager allows you to enter activity progress, which is accumulated and used
to calculate the earned progress for each activity. Earned progress represents how much has
been earned on an activity. Depending on type of activity, earned progress can be tied to
activity progress directly. However, it is also possible nothing is earned even if the progress is
99%, if the activity has been defined to have earned progress counted upon 100% of activity
completion.

Note

The Schedule Manager feature was deprecated starting with version 23.5. However, if
you have access to it, you can continue to use it with existing configurations.
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Earned progress is a quantitative measurement to indicate how much has been earned on an
activity over the duration of the activity. Earned Progress can be represented by amount,
quantity, and a percentage value. Earned Progress is based on the progress entered by the
user on an activity.

Each activity can earn progress in different ways. One way to earn is when progress is
entered. Another way to earn is by % of activity when the activity is started and earn remaining
% when that activity is finished. The system captures earned progress for an activity as well as
resources that assigned to an activity. Earned progress data from the Schedule Manager is
related to CBS codes and is used by the Earned Value module (in the Cost Manager) to
calculate different key components that are required to perform Earned Value analysis.

The Schedule Manager also allows you to enter activity progress in the activity properties.

The calculations described in this section pertain to the progress and earned progress data
accumulation and calculation discussed in Progress and Earned Progress Calculations. If you
do not need to work with progress or earned progress data to ultimately calculate Earned
Value, you do not need to read this section.

Note

The calculations described in this section pertain to the progress and earned progress
data accumulation and calculation. If you do not need to work with progress or earned
progress data to ultimately calculate Earned Value, you do not need to read this
section.

Terminology

Progress: A percentage that indicates how much of an activity has been accomplished.

Earned Progress: This quantity represents the progress earned for a given activity over a time
period. Depending on type of activity, earned progress can be tied directly to activity progress.
Also, earned progress can be set up to be given at activity finish. For example, earned
progress might not be awarded for incremental percentages of progress, and not be counted
until 100% of an activity is complete.

Earned Progress and Earned Value

If you have access to the Earned Value Manager (EVM) module, it provides an analytical tool
that allows Project Managers and stake holders of a project to determine whether a project is
on schedule and on budget. Based on the outcome of the earned value analysis, the project
manager can determine if corrective action is needed to ensure that the project can be
completed within its constraints. Examples of corrective action can be the change of project
scope, extension of the schedule, or the addition of resources.

There are multiple parameters that are used to calculate Earned Value to determine if a project
is on schedule and on budget. Some of these parameters are Budget, Progress, or Actual
Cost. All parameters must be considered together to determine the current state of a project.
One of the key components of this technique is to capture the progress of a project. This
progress is usually provided by a General Contractor or the person who is in charge of the
project. These progress entries are analyzed to determine the state of the project. Progress
information entered by user can be analyzed to determine the progress of the project with
respect to budget and schedule.
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Add a progress filter for earned value to a column

If the Schedule Attribute Form includes an Activity Earned Value Filter field
(uuu_activity_ev_filter), you can set up progress filtering for earned value sheets in the Cost
Manager.

To set up the schedule sheet for progress filtering:

1. Open a schedule sheet in a template or project/shell.

2. Add the Activity Earned Value Filter data element as a column to the schedule sheet.

3. Enter an alphanumeric value, such as "progressable" or "non-progressable," into the
column cell. (Use whatever term you like.)

4. Save the schedule sheet.

Enter progress and earned progress information

In the system, there are several areas that enable you to enter data (based on settings), view
progress and earned progress information, or control the accumulation of progress information:

1. Budget and Progress Setup window: First, set up how you want your progress data
calculated. See Setting Up the Budget and Progress Method.

2. Enter data on the attribute forms. The fields that allow you to enter data are determined
by the settings on the Budget and Progress Setup window:

• Resource Assignment Attribute Form (Resource tab of Activity Properties)

• Schedule Attribute Form (General tab of Activity Properties)

See Entering Progress Data on the General and Resource Tabs of Activity Properties.

3. Activity Progress window: View activity and resource progress; depending on settings on
the Budget and Progress Setup window, you can enter progress data in this window. This
window is available only if you have imported the Resource Assignment Attribute Form.
See Entering Progress in the Activity Progress Window.

4. Check activity and resource progress in the logs: View and enter progress data as
needed:

• Activity Progress log

• Resource Progress log

See Using the Activity Progress and Resource Progress Logs.

5. Options tab of the Schedule Sheet Properties: The options on this tab allow you to
control the automatic update of activity status based on Actual Start and Actual Finish
dates, and to specify that activity progress requires an Actual Start Date.

Setting Up the Budget and Progress Method

The Schedule Manager allows you to set up a budgeted cost of work schedule profile for each
activity on a schedule sheet to distribute budget associated with the activity. You can enter this
profile information in the Budget and Progress setup window, either at the schedule sheet level
(for all the activities on the sheet) or at the individual activity level.
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These settings include selecting a profile, an entry method, and calculation methods for %
Complete and % Earned. The settings you select in this window control how the progress and
earned progress data that is entered on the Resource Assignment Attribute Form (Resource
tab for Activity Properties) and the Activity form (General tab for Activity Properties) is
calculated. Also, you can choose the workpackage-related CBS codes to link to, and lock the
progress so it cannot be updated outside of a defined period.

You can configure the setup for progress (both resource and activity) and earned progress
settings independently. At the same time, you can also have activity or resource progress
calculate earned progress automatically or the earned progress calculate the progress.

Most of the Budget and Progress settings that you can use at the schedule sheet level are also
available at the activity level, however there are some differences. This section will first
document the settings for the schedule sheet level, and mention when there are variations at
the activity level and refer to the appropriate section.

Note

The Budget and Progress Method setup options for an activity cannot be modified
after a user begins to enter progress for that activity. This includes activity progress or
progress of the resource assigned to that activity.

The calculations used to derive progress and earned progress are explained in Progress and
Earned Progress Calculations.

To set up the budget and progress method:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet or Activity.
At the activity level, the Budget and Progress Method Setup window opens in the right side
of the schedule sheet window, and replaces the Gantt chart. When you are done working
with the activity-level Budget and Progress Method Setup window, you can select Gantt
Chart from the View menu.

5. Select the Budget and Progress settings.
The Budget and Progress Method Setup window has several sections where you can
choose settings.

• Activity Budget Distribution Profile: See Select the activity budget distribution
profile.

• % Complete and Earned Progress: See Select the entry method for the % complete
and earned progress.

• % Complete Calculation Method: See Select the calculation method for % complete.

• % Earned Calculation Method: See Select the calculation method for % earned.

• Additional Options (schedule sheet level only): See Select CBS codes filtered by
workpackage (schedule sheet level only) and Lock the reporting and progress entry
period (schedule sheet level only).

6. Select OK.
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Select the activity budget distribution profile

You can choose the option that determine how the budget of an activity is distributed.

To set up budget distribution for activities at the schedule sheet level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet.
The Default Budget and Progress Method Setup window opens.

5. Under the Activity Budget Distribution Profile section, choose an option.
This option will apply to all activities in the schedule sheet, unless it is overridden by the
selection of a different option for an individual activity.

Data Element Name Description

Linear This option distributes the activity budget linearly.
S-curve
Sigma
Mu %

This option distributes the activity budget based on
Sigma and Mu values.
S-curve calculations are based on Sigma and Mu values
that are provided as setup parameters. The system will
generate data using following probability density
function:

Parameters in this equation are:
X is determined based on the number of periods.
Mu is the mean that is calculated based on user input.
Sigma is the standard deviation that is used based on
user input.

On Start and Finish
% budgeted on Start
and Finish

This option distributes the activity budget based on the
Start and Finish Dates of the activity.
% budgeted on Start: This option allows you to enter the
percentage that should be budgeted on start of the
activity.
% budgeted on Finish: This is a read-only field, and is
calculated based on the % budgeted on Start value. The
value for this filed is (100 - % budgeted on Start).

Import distribution data from external sources This option allows Unifier to import progress data from
Primavera. Data mapping is required in the schedule
sheet to ensure the spread will be populated correctly in
the EV sheet. All required fields must be mapped.
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Data Element Name Description

Distribution profile based on resource This option distributes the cost of a role per activity by
rolling up the rate of all the resources assigned to the
activity. If hard booked resources are allocated, the total
cost = (role rate) x (currency rate) x (quantity.) If the
resources are not allocated, the total cost is manual
entry (from a formula).
In a schedule sheet's activity, you will need to match the
activity's total cost to the role cost total. The total
amount is rolled up to the cash flow module to create a
cash flow profile based on the resource(s) cost on the
activity.

The tables below show incremental and cumulative examples of how these three options work
and the differences between them. This data is assumed for these examples:

• Start Date: 01/1/2009

• Finish Date: 12/1/2009

• Total Cost: $12000.00

• For S-Curve: Sigma = 2 and Mu = 50%

• For Start and Finish: % budget distribution on start = 5%, % budget distribution on finish
= 95%

Incremental

Optio
n

01-09 02-09 03-09 04-09 05-09 06-09 07-09 08-09 09-09 10-09 11-09 12-09

Linear 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000
S-
Curve

26.52 104.88 323.06 789.30 1462.1
7

2120.9
3

2401.4
3

2120.9
3

1447.8
5

774.98 323.06 104.88

On
Start
and
Finish

600 0 0 0 0 0 0 0 0 0 0 11400

Cumulative

Optio
n

01-09 02-09 03-09 04-09 05-09 06-09 07-09 08-09 09-09 10-09 11-09 12-09

Linear 1000 2000 3000 4000 5000 6000 7000 8000 9000 10000 11000 12000
S-
Curve

26.52 131.40 454.46 1243.7
6

2705.9
3

4826.8
6

7228.2
9

9349.2
2

10797.
07

11572.
10

11895.
10

11999.99

On
Start
and
Finish

600 600 600 600 600 600 600 600 600 600 600 12000

To set up budget distribution for activities at the activity level:
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1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select an activity in the sheet.

5. From the File menu, select Budget and Progress Setup, and then select Activity.

6. Under the Activity Budget Distribution Profile section, choose an option.
This option will apply specifically to the selected activity, and will override any default
option set up at the schedule sheet level. The behavior of these Activity Budget Distribution
Profile options at the activity level is the same as the default options at the schedule sheet
level.

Select the entry method for the % complete and earned progress

You can select an entry method for the progress and earned progress data, and can enter
progress (both resource and activity) and earned progress independently. Also, you can select
an entry method that allows you to enter the progress of activity or resource then calculate
earned progress, or enter earned progress and calculate progress for an activity or resource.

To select the entry method for the % complete and earned progress for activities at the
schedule sheet level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet.

5. In the Default % Complete and Earned Progress section, choose a default entry method.
This entry method will apply to all activities in the schedule sheet, unless it is overridden by
the selection of a different entry method for an individual activity.

Use this Entry Method To do this:

Independently Control % complete and earned quantity Enter the progress of activity or resource independent
of earned progress.

Activity and resource % complete updates % earned Enter the progress of activity or resource, and earned
progress will be automatically calculated.

Activity and resource % earned updated % complete Enter the earned progress of activity or resource, and
progress will be automatically calculated.

Do not allow update of % complete and % earned Not enter either progress or earned progress. You
cannot enter any type of activity progress information
with this option selected.

To select the entry method for the % complete and earned progress for activities at the activity
level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select an activity in the sheet.

5. From the File menu, select Budget and Progress Setup, and then select Activity.
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6. Under the % Complete and Earned Progress section, choose an entry method.
This option will apply specifically to the selected activity, and will override any default entry
method set up at the schedule sheet level. The behavior of these % Complete and Earned
Progress Entry Method options at the activity level is the same as the default options at the
schedule sheet level.

Select the calculation method for % complete

You can select an option that allows you to enter progress information for a key quantity
(referred to as the Leader) of an activity which will determine the overall progress of other
resources and the activity itself. For example:

• Example 1: Assume that there are two resources on an activity, called Resource 1 and
Resource 2. If the key quantity is Resource 1 and you enter progress (say 30%) on
Resource 1, then Resource 2 should also progress with same 30%. Also, overall activity
progress should progress by 30%.

• Example 2: Assume that the key quantity (Leader) in this example is Activity % Complete.
If you enter progress of 50% on the activity, Resource 1 and Resource 2 are updated with
the same progress of 50%.

The key quantity is referred to as the Leader in Unifier.

To select the % complete calculation method for activities at the schedule sheet level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet.

5. Under the Default % Complete Calculation Method section, choose an option.
This option will apply to all activities in the schedule sheet, unless it is overridden by the
selection of a different option for an individual activity.

Note

Company holidays based on company calendar should be considered while
distributing budget. Budget should not be distributed on days that are marked as
holidays on company calendar.

Use this Calculation Method To do this:

Manual activity % complete and resource % complete Enter the progress of activity and resource independent
of each other. Entering Activity % Complete will not
update resource progress and entering resource %
complete will not update Activity % Complete.

Manual activity % complete - updates resource %
complete

Enter the progress of an activity, and resource %
complete will be updated automatically. If this option is
selected, Activity % Complete will become the key
quantity or Leader, which will control the progress of
the entire activity, including resources.
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Use this Calculation Method To do this:

Resource updates Activity - weighted average of
resource costs
 

Enter progress for each resource independently. Activity
% Complete is read-only and will be automatically
calculated based on weighted resource cost.
The following formula is used to calculate this value:
{Sum of [Resource Progress Quantity / Resource
Quantity) * (Resource Amount)] / Sum of (Resource
Amount) } * 100
All resources are considered in this calculation,
including hard booked resources.

Resource updates Activity - weighted avg. of resource
hours
 

Enter progress for each resource independently. Activity
% Complete will be read-only and will be automatically
calculated based on weighted resource man hours.
The following formula is used to calculate this value:
{Sum of [Resource Progress Quantity / Resource
Quantity) * (Resource Amount)] / Sum of (Resource
Quantity) } * 100
The only resources considered in this calculation are
hard booked resources.

Note

Progress entry for Resource and Activity before importing Resource Assignment
Attribute Form is based on Activity % Complete and Resource % Complete. After the
Resource Assignment Attribute Form is imported, progress on activity will be Activity
% Complete, but for Resource it is Progress Quantity the data element. Resource %
Complete is then read-only and always calculated.

To select the % complete calculation method for activities at the activity level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Activity.

5. Under the % Complete Calculation Method section, choose an option.
This option will apply specifically to the selected activity, and will override any default entry
method set up at the schedule sheet level. The behavior of these % Complete Calculation
Method options at the activity level is the same as the default options at the schedule sheet
level. The exception is Lead resource updates Activity and other resources, described
in the next step.

Under the activity level, you can select Lead resource updates Activity and other
resources, and choose resources (including hard booked) that are assigned to the activity
on the Resource tab. This option allows you to select a resource as a key quantity or a
Leader. If you select this option and a resource from the drop down menu, you can enter
progress on only that resource. Activity % Complete and Resource % Complete on all
other resources are read-only and will be automatically calculated based on the progress
entered on key quantity or leader resource.

For example:
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Assume that there is an activity with Resource 1 and Resource 2, with the Activity % Complete
at 0%:

Resource Work Hours % Complete

Resource 1 200 0
Resource 2 500 0 (read-only)

For a further example, assume that Resource 1 is the key quantity or Leader, with the Activity
% Complete at 30%:

Resource Work Hours % Complete

Resource 1 200 30
Resource 2 500 30 (read-only)

You can change the Lead resource updates Activity and other resources drop down menu
selection until there is progress or earned progress entries for the activity or resource. After
progress or earned progress data is entered, the Budget and Progress Method Setup for the
activity is disabled and you cannot delete the resource selected as Leader. If you find that you
must change the settings for the activity, you must delete the activity and start over with new
data and settings.

Select the calculation method for % earned

Earned progress is a quantitative measurement to indicate how much has been earned on an
activity over its duration. Earned progress can be represented by amount, quantity, and a
percentage value.

Earned progress is based on the progress entered on an activity. Activities can earn progress
in when progress is entered, or by % of activity budget, when the activity is started and earn
remaining the remaining percentage when that activity completes.

The system allows you to accumulate and calculate earned progress for an activity as well as
resources assigned to an activity:

• Earned Progress is calculated at activity level and each resource assigned to that activity.

• Earned Progress calculated under a schedule sheet for activity and assigned resources is
used later in the Earned Value module (in the Cost Manager) to calculate Budgeted Cost of
Work Performed (BCWP).

• Earned Progress calculated at the activity level is used when BCWP needs to be
represented by the cost.

• Earned Progress calculated at resource assignment level is used when BCWP is
represented by a unit of measure (for example, Hours).

To select the % earned calculation method for activities at the schedule sheet level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet.

5. Under the Default % Earned Calculation Method section, choose an option.
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This option will apply to all activities in the schedule sheet, unless it is overridden by the
selection of a different option for an individual activity.

Use this Calculation Method To do this:

Manual activity % earned and resource % earned Enter earned progress of activity and resource
independent of each other. Entering Activity earned
progress will not update resource earned progress and
entering resource earned progress will not update
activity earned progress.

Manual activity % earned - updates resource % earned You can select this option only if Manual activity %
earned and resource % earned is selected. Allows you to
enter earned progress of an activity and resource
earned progress will be updated automatically.

Resource updates Activity - weighted average of
resource costs
 

Enter earned progress for each resource independently.
Activity earned progress will be read-only and will be
automatically calculated based on weighted resource
cost.
Following formula will be used.
(Sum of Resource Cost * Resource Earned Progress /
Total Activity Work Hours) * 100
All resources will be considered in this calculation
including hard booked resources.

Update Activity and all resources on activity start and
finish
% earned on Actual Start and Actual Finish
 

Allow the system to calculate earned progress based on
actual start and finish of the activity
% earned on Actual Start: This option will allow user to
enter % that should be earned on start of the activity.
User can enter a value.
% earned on Actual Finish: This is a read-only field.
Should always be calculated based on % earned on
Actual Start. Value for this filed should be (100 - %
earned on Actual Start).
If you select this option, earned progress is calculated
based on Update Activity and all resources on activity
start and finish of the activity. The system will
automatically calculate earned progress for activity and
assigned resources when actual start and finish dates
are entered.

To select the % earned calculation method for activities at the activity level:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Activity.

5. Under the % Earned Calculation Method section, choose an option.
This option will apply specifically to the selected activity, and will override any default entry
method set up at the schedule sheet level. The behavior of these % Earned Calculation
Method options at the activity level is the same as the default options at the schedule sheet
level. The exception is Lead resource updates Activity and other resources, described
in the next step.

Under the activity level, you can select Lead resource updates Activity and other
resources, and choose resources (including hard booked) that are assigned to the activity
on the Resource tab. This option allows you to select a resource as a key quantity or a
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Leader. If you select this option and a resource from the drop down menu, you can enter
progress on only that resource.

For example:

Assume that there is an activity with Resource 1 and Resource 2, with the Earned Progress at
0%:

Resource Work Hours % Complete

Resource 1 200 0
Resource 2 500 0 (read-only)

For a further example, assume that Resource 1 is the key quantity or Leader, with the Earned
Progress at 30%:

Resource Work Hours % Complete

Resource 1 200 30
Resource 2 500 30 (read-only)

You can change the Lead resource updates Activity and other resources drop down menu
selection until there is progress or earned progress entries for the activity or resource. After
progress or earned progress data is entered, the Budget and Progress Method Setup for the
activity is disabled and you cannot delete the resource selected as Leader. If you find that you
must change the settings for the activity, you must delete the activity and start over with new
data and settings.

Select CBS codes filtered by workpackage (schedule sheet level only)

An activity in a schedule sheet can be associated with one or more CBS Codes. This
assignment is used to create a mapping between costs associated with an activity to a Cost
Code (CBS Code). The system allows you to choose a workpackage to use to filter the CBS
codes you can select in the Activity Properties, CBS Codes tab. You can choose one
workpackage to use as a filter.

Note

The Workpackage must be active and contain CBS codes, and also transactions must
have occurred using the pertinent CBS codes, or the CBS codes tab will not contain
codes for you to select.

To filter CBS codes by workpackage:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet.

5. Under the Additional Options section, in the Workpackage field, click Select.
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Lock the reporting and progress entry period (schedule sheet level only)

You can prevent users from entering or modifying progress data entries made prior to the
current week or the current month. These selections allow you to control the activity and
resource data entered on the Activity Progress window. See Entering Progress in the Activity
Progress Window for details.

To specify a restriction on data entry or reporting for progress data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager , and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Budget and Progress Setup, and then select Schedule
Sheet.

5. Under the Additional Options section, in the Reporting Period field, select Week or
Month.
If there is an activity calendar specified, that calendar affects the reporting period for these
options.

6. Select the Do not allow progress entry older than current period checkbox.
This checkbox works in conjunction with Reporting Period that you select. If you select
Week as the reporting period, users cannot enter or modify progress entered prior to
current week; if you select Month as the reporting period, users cannot enter or modify
progress entered prior to current month.

In addition, you can select Allow editing of last period progress and specify a number of
working days into the current period. Selecting this option allows users to modify progress
of the last period (based on the reporting period) until a specified number of days into the
current period.

7. Select OK.

Entering Progress Data on the General and Resource Tabs of Activity Properties

The Resource Assignment Attribute Form (when imported, replaces the Resources tab of the
Activity Properties and provides data elements to other areas) contains fields related to
resources assigned to an activity to that allow you to enter effort and expense information
related to that effort. The Resource Assignment Attribute Form allows you to assign a resource
to a Resource Type, rather than to a hard booked resource. Also, it allows the capture of
progress with respect to effort, and the base lining of resource assignment.

The Schedule Attribute Form is used as the General tab of the Activity Properties can also
include fields that allow you to enter progress and earned progress data.

The ability to enter progress and earned progress on the Schedule Attribute and the Resource
Assignment Attribute Forms is based on the options selected on the Budget and Progress
Setup for a given activity. See Setting Up the Budget and Progress Method. Fields on the
forms are editable or read-only and calculated based on the option settings.

This progress or earned progress is time stamped when entered:

• For an activity:

– Date on which the progress or earned progress is entered or calculated.

– Activity % Complete value
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– Earned Progress value

• For a resource:

– Date on which the progress quantity and or earned progress is entered or calculated

– Progress Quantity value

– Earned Progress value

You can access time stamped information through the Activity Progress Log or the Resource
Progress Log. See Using the Activity Progress and Resource Progress Logs for details on the
logs.

The calculations used to derive progress and earned progress are explained in Progress and
Earned Progress Calculations.

To enter data into the attribute forms:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select the link for the applicable activity in the sheet.
On the General tab, you can enter progress or earned progress data in these fields,
depending on settings on the Budget and Progress Setup window, and if the data elements
for these fields have been added to the Schedule Attribute Form and that form has been
imported:

• Earned Progress

• Earned Amount

• Forecast 1 Start

• Forecast 1 Finish

• Activity Percent 1

On the Resource tab, you can enter progress or earned progress data in these fields,
depending on settings on the Budget and Progress Setup window, and if the data elements
for these fields have been added to the Resource Assignment Attribute Form and that form
has been imported The fields you see may vary:

• Resource Name

• Role Name (Picker)

• Resource Type

• Quantity (Qty)

• UOM

• Amount

• % Units

• Earned Progress

• Earned Amount

• ETC

• ETC Amount

• Resource % 1
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Note

You can double-click the resource name to view the Resource Assignment
Attribute Form in view-only mode.

5. Select Add.

6. Enter resource data as needed.

7. Select OK.

Entering Progress in the Activity Progress Window

The Activity Progress window allows users to quickly modify the daily activity and resource
progress data for a selected activity. Users can move down the rows of activities with the
Activity Progress window open and quickly modify the progress for each activity without having
to open the activity.

Note

The Activity Progress window is available only if the Resource Assignment Attribute
Form is designed and imported into Unifier.

You can access the Activity Progress Log and the Resource Progress Log from the Activity
Progress window. The logs display the progress data that is entered over time, and allow the
user to view and modify the progress data for activities and resources. See Using the Activity
Progress and Resource Progress Logs for details.

Note

If you enter partial activity progress data, for example enter Activity Progress for a day,
but do not enter the Resource Progress (or enter Resource Progress and do not enter
Activity Progress at that time), and then save the data, you cannot enter the Resource
Progress later that day. However, you can enter the progress the next day.

To view or enter activity progress on the Activity Progress window:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select an activity in the sheet.

5. Select Progress.
The Activity Progress window opens on the right side. The Activity Progress and Resource
Progress fields are editable or read-only depending on settings on the Budget and
Progress Method setup window.

6. Select Save.
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In this field: Do this:

Activity progress as of Select a date for which you want to enter progress data.
Today's date shows by default. This date is used as the
time stamp for progress data entered on this window. If
you choose a date that conflicts with the date restriction
you have set up on the Budget and Progress Method
Setup under Additional Options (see Lock the reporting
and progress entry period (schedule sheet level only) for
details) you will receive a warning message.
If you have selected the Reporting Period:
• Week: You cannot select a date prior to current

week. Weeks are counted as Sunday to Saturday. For
example, if today is Monday, June 22, you cannot
select a date prior to Sunday, June 21.

• Month: You cannot select a date prior to current
month. For example, if the current month is June
2009, you cannot select a month prior to June 2009.

You can select a date in the future if it is in the current
period. You cannot select a date which is designated as a
company holiday on company calendar.

Activity Progress - latest activity progress information
 

Activity Progress Log button Select to access the Activity Progress Log. See Using the
Activity Progress and Resource Progress Logs for details.
This log displays all activity progress entries made by
user.

Activity Percent Complete Enter or view activity progress data. This field is read-
only or editable based on settings in Budget and
Progress Method setup window for the activity. Unless
you enter a value, the latest previously-entered value is
retained in this field.

Earned Progress Enter or view activity progress data. This field is read-
only or editable based on settings in Budget and
Progress Method setup window for the activity. Unless
you enter a value, the latest previously-entered value is
retained in this field.

Latest Progress as of View the date on which the system last calculated
activity progress.
This field corresponds with Primavera Current Data
Date. The system retains Current Data Date on schedule
sheets imported from Primavera.

Latest % Complete View the latest activity % complete.
Latest Earned Progress View the latest earned progress of the activity.
Resource Progress - latest resource progress information
 

Activity Progress Log button Select to access the Resource Progress Log. See Using the
Activity Progress and Resource Progress Logs for details.
This log displays all resource progress entries made by
user.

Leader Column View an icon to indicate the leader selected on the
Budget and Progress Method Setup window.
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In this field: Do this:

Resource Name View the name of the resource. This column will show
Resource Name for each resource from resource
assignment form.

Quantity View the quantity for each resource from the Resource
Assignment Attribute Form.

Progress Quantity Enter progress quantity. Unless you enter a value, the
latest previously-entered value is retained in this field.

Earned Progress View the earned quantity of each resource, which is
associated with the Earned Progress on Resource
Assignment Attribute Form. Unless you enter a value,
the latest previously-entered value is retained in this
field.

UOM View the unit of measure for each resource from the
Resource Assignment Attribute Form.

Resource Latest Progress - latest progress information for each resource. Select a resource listed under Resource
Progress to see the latest progress for each resource.
 

Resource Name View the name of the selected resource.
Progress as of View the latest progress entry date of the resource.
Progress Quantity View the latest progress quantity entered.
Earned Progress View the latest earned quantity of the resource.
UOM View the unit of measure for the resource.

To view or enter activity progress on the Activity Progress window for a summary activity:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select the link for the applicable activity in the sheet.

5. Select a summary activity in the sheet.

6. Select Progress.
The Activity Progress window opens on the right side. For an explanation of the fields on
this window, see the table below.

7. Select Save.

Activity Progress window fields:

In this field: Do this:

Activity % Complete View the activity percent complete for the activities.
Latest Progress as of View the latest progress entry date across all leaf

activities under the selected summary activity.
Earned Progress View the latest earned quantity of the activities.

Export and Import Activity Progress data

You can export and import to import Activity Progress using CSV files. This CSV export and
import functionality is available only if the Resource Assignment Attribute Form has been
imported.
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To export Activity Progress data:

You can export Activity Progress data to a CSV file with latest activity and resource
information. The CSV will only contain leaf level activities. This is an example of an exported
Activity Progress CSV file:

Example of Activity Progress CSV file

In the example, notice that the first column is named Progress as of!. This date is used as a
timestamp on the progress information. There are two headers in this example file:

Notice that there is a Leader! Column. This column identifies which row is a leader for an
activity. This is based on Budget and Progress setup profile option of an activity. If the activity
is updating all resources, the activity shows Yes in the Leader column. If a resource is updated
all other resources, the resource shows Yes in the Leader column. For all other options, the
Leader column will be empty.

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Export, and then select Activity Progress Template.

5. Modify the CSV file as needed to add activity progress data.

6. Save the CSV file and import it.

To import Activity Progress data:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. From the File menu, select Import, and then select Activity Progress.

5. Browse to select the CSV file to import.

6. Select OK.

Using the Activity Progress and Resource Progress Logs

After entering activity or resource progress data, the user can view or modify the data by going
to an Activity Progress Log or Resource Progress Log. These logs are accessible only from the
Activity Progress window. From these logs, the user can view progress effective date, progress
quantity and earned quantity. The user can also modify the progress and earned quantity data,
for the most recent entry and for entries in the past, depending on the settings for the editing of
period progress on the Budget Progress and Method Setup window. See Lock the reporting
and progress entry period (schedule sheet level only) for details.
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For example, you might want to use this log to modify data if you need to change past progress
data based on actual start of data calculation, which saves you from having to delete the
activity and lose all the data associated with that activity.

Note

Modifying log information will not change the current information on Schedule Attribute
Form and Resource Assignment Attribute Form unless data related to today is
modified.

To view or modify progress data from the Activity Progress or Resource Progress logs:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

3. In the Schedule Sheets log, select a schedule sheet, and select Open.

4. Select a summary activity in the sheet.

5. Select Progress.
The Activity Progress window opens on the right side.

6. Select Activity Progress Log or Resource Progress Log.

7. Modify progress data as needed. Select the row you want to modify and double-click the
cell that you need to modify. The Progress Quantity or Earned Progress columns can be
editable depending on settings on Budget and Progress Method Setup window for the
activity.

8. Select Save.

Progress and Earned Progress Calculations

Note

The calculations described in this section pertain to the progress and earned progress
data accumulation and calculation discussed in Project Progress Data Accumulation
and Calculation. If you do not need to work with progress or earned progress data to
ultimately calculate Earned Value, you do not need to read this section.

This section explains calculations involved in calculating progress and earned progress at
activity and resource level based on different options selected on Budget and Progress Method
setup window. The data elements on the Schedule Attribute and Resource Assignment
Attribute Forms are considered and affected by the progress and earned progress calculations
are:

• Activity

– Total Cost

– Activity % Complete

– Earned Progress

– Earned Amount (Value of this data element is always based on uDesigner design)
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• Resource

– Role

– Quantity

– Rate

– Amount

– Resource % Complete (Value of this data element is calculated as (Progress Quantity /
Quantity) %

– Progress Quantity

– Earned Quantity

– Earned Amount (Value of this data element is always based on uDesigner design)

The calculations are described in terms of the calculation options in relation to the % Complete
and Earned Progress entry method selected:

• Independently Control % complete and Earned quantity

• Activity and resource % complete updates % earned

• Activity and resource % earned updates % complete

• Do not allow update of % complete and % earned

See Select the entry method for the % complete and earned progress for details on these
methods.

Independently Control % complete and Earned quantity

This section contains scenarios for calculations based on the entry method Independently
Control % complete and earned quantity and the % Complete Calculation Method option
selected.

Method is Manual activity % complete and resource % complete

This section contains scenarios based on the option selected for % Complete Calculation
Method being Manual activity % complete and resource % complete.

% Earned Calculation Method option is Manual activity % earned and resource % earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete and resource %
complete

• % Earned Calculation Method option = Manual activity % earned and resource % earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry
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Activity or Resource Data Element Data Entry Method

Earned Progress Manual entry
Resource
 Progress Quantity Manual entry

Earned Progress Manual entry

% Earned Calculation Method option is Manual activity % earned - updates resource %
earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete and resource %
complete

• % Earned Calculation Method option = Manual activity % earned - updates resource %
earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Manual entry
Resource
 Progress Quantity Manual entry

Earned Progress Calculated (read-only)
(Activity-level Earned
Progress * Quantity)

% Earned Calculation Method option is Resource updates Activity - weighted average of
resource costs

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete and resource %
complete

• % Earned Calculation Method option = Resource updates Activity - weighted average of
resource costs

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry
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Activity or Resource Data Element Data Entry Method

Earned Progress Calculated (Weighted
Cost) and read-only.
{Sum of [ (Resource
Earned Progress /
Resource Quantity) *
(Resource Amount)] /
Sum of (Resource
Amount) } * 100

Resource
 Progress Quantity Manual entry

Earned Progress Manual entry

% Earned Calculation Method option is Lead resource updates Activity and other resources

This combination of settings is not available.

% Earned Calculation Method option is Update Activity and all resources on activity start and
finish

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete and resource %
complete

• % Earned Calculation Method option = Update Activity and all resources on activity start
and finish

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Calculated (Weighted Cost)
and read-only.
{Sum of [ (Resource Earned
Progress / Resource
Quantity) * (Resource
Amount)] / Sum of
(Resource Amount) } * 100

Resource
 Progress Quantity Manual entry
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Activity or Resource Data Element Data Entry Method

Earned Progress Calculated (read-only)
based Update Activity and
all resources on activity
start and finish.
For example: If % earned
on Actual Start = 5% and %
earned on Actual Finish =
95 % then,
when Actual Start is
entered, Earned Progress =
5% * Quantity
When Actual Finish is
entered, Earned Progress =
100% * Quantity.

Method is Manual activity % complete - updates resource % complete

This section contains scenarios based on the option selected for % Complete Calculation
Method being Manual activity % complete - updates resource % complete.

% Earned Calculation Method option is Manual activity % earned and resource % earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete - updates resource
% complete

• % Earned Calculation Method option = Manual activity % earned and resource % earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Manual entry
Resource
 Progress Quantity Calculated (read-only).

(Activity-level Activity % Complete *
Quantity)

Earned Progress Manual entry

% Earned Calculation Method option is Manual activity % earned - updates resource %
earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity
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• % Complete Calculation Method option = Manual activity % complete - updates resource
% complete

• % Earned Calculation Method option = Manual activity % earned - updates resource %
earned

This data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Manual entry
Resource
 Progress Quantity Calculated (read-only).

(Activity-level Activity %
Complete * Quantity)

Earned Progress Calculated (read-only).
(Activity-level Earned
Progress * Quantity)

% Earned Calculation Method option is Resource updates Activity - weighted average of
resource costs

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete - updates resource
% complete

• % Earned Calculation Method option = Resource updates Activity - weighted average of
resource costs

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Calculated (Weighted Cost)
{Sum of [ (Resource Earned Progress /
Resource Quantity) * (Resource
Amount)] / Sum of (Resource
Amount) } * 100

Resource
 Progress Quantity Calculated (read-only).

(Activity-level Activity % Complete *
Quantity)

Earned Progress Manual Entry

% Earned Calculation Method option is Lead resource updates Activity and other resources
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This combination of settings is not available.

% Earned Calculation Method option is Update Activity and all resources on activity start and
finish

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Manual activity % complete - updates resource
% complete

• % Earned Calculation Method option = Update Activity and all resources on activity start
and finish

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Calculated (Weighted
Cost)
{Sum of [ (Resource
Earned Progress /
Resource Quantity) *
(Resource Amount)] /
Sum of (Resource
Amount) } * 100

Resource
 Progress Quantity Calculated (read-

only).
(Activity-level
Activity % Complete *
Quantity)

Earned Progress Calculated based
Update Activity and
all resources on
activity start and
finish.
For example: If %
earned on Actual
Start = 5% and %
earned on Actual
Finish = 95 % then,
when Actual Start is
entered, Earned
Progress = 5% *
Quantity
When Actual Finish is
entered, Earned
Progress = 100% *
Quantity.

Method is Resource updates Activity - weighted avg. of resource hours
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This section contains scenarios based on the option selected for % Complete Calculation
Method being Resource updates Activity - weighted avg. of resource hours.

% Earned Calculation Method option is Manual activity % earned and resource % earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource hours

• % Earned Calculation Method option = Manual activity % earned and resource % earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted

Hours) and (read-only).
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Quantity)] / Sum
of (Resource Quantity) } *
100
Only hard booked
resources will be
considered.

Earned Progress Manual entry
Resource
 Progress Quantity Manual entry

Earned Progress Manual entry

% Earned Calculation Method option is Manual Activity % earned - updates resource %
earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource hours

• % Earned Calculation Method option = Manual activity % earned - updates resource %
earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
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Activity or Resource Data Element Data Entry Method

 Activity % Complete Calculated (Weighted
Hours) and (read-
only).
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Quantity)] /
Sum of (Resource
Quantity) } * 100
Only hard booked
resources will be
considered.

Earned Progress Manual entry
Resource
 Progress Quantity Manual entry

Earned Progress Calculated
(Activity-level Earned
Progress * Quantity)

% Earned Calculation Method option is Resource updates Activity - weighted avg. of resource
costs

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource hours

• % Earned Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted

Hours) and (read-only).
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Quantity)] / Sum
of (Resource Quantity) } *
100
Only hard booked
resources will be
considered.
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Activity or Resource Data Element Data Entry Method

Earned Progress Calculated (Weighted Cost)
{Sum of [ (Resource Earned
Progress / Resource
Quantity) * (Resource
Amount)] / Sum of
(Resource Amount) } * 100

Resource
 Progress Quantity Manual entry

Earned Progress Manual entry

% Earned Calculation Method option is Lead resource updates Activity and other resources

This combination of settings is not available.

% Earned Calculation Method option is Update Activity and all resources on activity start and
finish

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource hours

• % Earned Calculation Method option = Update Activity and all resources on activity start
and finish

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted Hours) and

(read-only).
{Sum of [ (Resource Progress
Quantity / Resource Quantity) *
(Resource Quantity)] / Sum of
(Resource Quantity) } * 100
Only hard booked resources will be
considered.

Earned Progress Calculated (Weighted Cost)
{Sum of [ (Resource Earned Progress /
Resource Quantity) * (Resource
Amount)] / Sum of (Resource
Amount) } * 100

Resource
 Progress Quantity Manual entry
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Activity or Resource Data Element Data Entry Method

Earned Progress Calculated based Update Activity and
all resources on activity start and
finish.
For example: If % earned on Actual
Start = 5% and % earned on Actual
Finish = 95 % then,
When Actual Start is entered, Earned
Progress = 5% * Quantity
When Actual Finish is entered,
Earned Progress = 100% * Quantity.

Method is Resource updates Activity - weighted avg. of resource costs

This section contains scenarios based on the option selected for % Complete Calculation
Method being Resource updates Activity - weighted avg. of resource costs.

% Earned Calculation Method option is Manual activity % earned and resource % earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

• % Earned Calculation Method option = Manual activity % earned and resource % earned

then this data entry method scenario results:

Activity or
Resource

Data Element Data Entry
Method

Activity
 Activity % Complete Calculated

(Weighted
Hours) and read-
only.
{Sum of
[ (Resource
Progress
Quantity /
Resource
Quantity) *
(Resource
Amount)] / Sum
of (Resource
Amount) } * 100
All resources
will be
considered.

Earned Progress Manual entry
Resource
 Progress Quantity Manual entry
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Activity or
Resource

Data Element Data Entry
Method

Earned Progress Manual entry

% Earned Calculation Method option is Manual activity % earned - updates resource %
earned

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

• % Earned Calculation Method option = Manual activity % earned - updates resource %
earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted

Hours) and read-only.
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Amount)] /
Sum of (Resource
Amount) } * 100
All booked resources
will be considered.

Earned Progress Manual entry
Resource
 Progress Quantity Manual entry

Earned Progress Calculated
(Activity-level Earned
Progress * Quantity)

% Earned Calculation Method option is Resource updates Activity - weighted avg. of resource
costs

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

• % Earned Calculation Method option = Resource updates Activity - weighted avg. of
resource costs
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then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted

Hours) and read-only.
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Amount)] / Sum
of (Resource Amount) } *
100
All resources will be
considered.

Earned Progress Calculated (Weighted Cost).
{Sum of [ (Resource Earned
Progress / Resource
Quantity) * (Resource
Amount)] / Sum of
(Resource Amount) } * 100

Resource
 Progress Quantity Manual entry

Earned Progress Manual entry

% Earned Calculation Method option is Lead resource updates Activity and other resources

This combination of settings is not available.

% Earned Calculation Method option is Update Activity and all resources on activity start and
finish

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

• % Earned Calculation Method option = Update Activity and all resource on activity start
and finish

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
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Activity or Resource Data Element Data Entry Method

 Activity % Complete Calculated (Weighted
Hours) and read-only.
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Amount)] /
Sum of (Resource
Amount) } * 100
All resources will be
considered.

Earned Progress Calculated (read-
only) based Update
Activity and all
resources on activity
start and finish.
For example: If %
earned on Actual
Start = 5% and %
earned on Actual
Finish = 95 % then,
When Actual Start is
entered, Earned
Progress = 5%
When Actual Finish is
entered, Earned
Progress = 100%

Resource
 Progress Quantity Manual entry

Earned Progress Calculated (read-
only) based Update
Activity and all
resources on activity
start and finish.
For example: If %
earned on Actual
Start = 5% and %
earned on Actual
Finish = 95 % then,
When Actual Start is
entered, Earned
Progress = 5% *
Quantity
When Actual Finish is
entered, Earned
Progress = 100% *
Quantity.

Method is Lead resource updates Activity and other resources

This section contains scenarios based on the option selected for % Complete Calculation
Method being Lead resource updates Activity and other resources. There is only one data
entry scenario for this setting.
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% Earned Calculation Method option is Lead resource updates Activity and other resources

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Independently Control % complete and
earned quantity

• % Complete Calculation Method option = Lead resources updates Activity and other
resources.

• % Earned Calculation Method option = Lead resource updates Activity and other resources

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted Hours) and

read-only.
{Sum of [ (Resource Progress
Quantity / Resource Quantity) *
(Resource Amount)] / Sum of
(Resource Amount) } * 100
All resources will be considered.

Earned Progress Calculated (Weighted Cost) and read-
only.
{Sum of [ (Resource Earned Progress /
Resource Quantity) * (Resource
Amount)] / Sum of (Resource
Amount) } * 100

Resource
 Progress Quantity Manual Entry (Only resource that is

selected under drop-down). For all
other resources, Progress Quantity
will be calculated based on
(Leader Progress Quantity / Leader
Quantity) * Resource Quantity

Earned Progress Manual Entry (only resource that is
selected under drop-down). For all
other resources, Progress Quantity
will be calculated based on
(Leader Earned Quantity / Leader
Quantity) * Resource Quantity

Activity and resource % complete updates % earned

This section contains scenarios for calculations based on the entry method Activity and
Resource % Complete Updates % Earned and the % Complete Calculation Method option
selected.

Method is Manual activity % complete and resource % complete
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This section contains scenarios based on the option selected for % Complete Calculation
Method being Manual activity % complete and resource % complete. There is only one
data entry scenario for this setting.

% Earned Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % complete
updates % earned

• % Complete Calculation Method option = Manual activity % complete and resource %
complete

• % Earned Calculation Method option = Not available

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry

Earned Progress Calculated (read-
only)
Same as Activity %
Complete

Resource
 Progress Quantity Manual entry

Earned Progress Calculated (read-
only)
Same as Progress
Quantity

Method is Manual activity % complete - updates resource % complete

This section contains scenarios based on the option selected for % Complete Calculation
Method being Manual activity % complete - updates resource % complete. There is only
one data entry scenario for this setting.

% Earned Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % complete
updates % earned

• % Complete Calculation Method option = Manual activity % complete - updates resource
% complete

• % Earned Calculation Method option = Not available

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Manual entry
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Activity or Resource Data Element Data Entry Method

Earned Progress Calculated (read-only)
Same as Activity %
Complete

Resource
 Progress Quantity Calculated (read-only)

(Activity-level Activity %
Complete * Quantity)

Earned Progress Calculated (read-only)
Same as Progress Quantity

Method is Resource updates Activity - weighted avg. of resource hours

This section contains scenarios based on the option selected for % Complete Calculation
Method being Resource updates Activity - weighted avg. of resource hours. There is only
one data entry scenario for this setting.

% Earned Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % complete
updates % earned

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource hours

• % Earned Calculation Method option = Not available

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted

Hours) and read-only.
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Amount)] / Sum
of (Resource Amount) } *
100
Only hard booked
resources will be
considered

Earned Progress Calculated (read-only)
Same as Activity %
Complete

Resource
 Progress Quantity Manual entry

Earned Progress Calculated (read-only)
Same as Progress Quantity
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Method is Resource updates Activity - weighted avg. of resource costs

This section contains scenarios based on the option selected for % Complete Calculation
Method being Resource updates Activity - weighted avg. of resource costs. There is only
one data entry scenario for this setting.

% Earned Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % complete
updates % earned

• % Complete Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

• % Earned Calculation Method option = Not available

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted

Hours) and read-only.
{Sum of [ (Resource
Progress Quantity /
Resource Quantity) *
(Resource Amount)] / Sum
of (Resource Amount) } *
100
Only hard booked
resources will be
considered

Earned Progress Calculated (read-only)
Same as Activity %
Complete

Resource
 Progress Quantity Manual entry

Earned Progress Calculated (read-only)
Same as Progress Quantity

Method is Lead resource updates Activity and other resources

This section contains scenarios based on the option selected for % Complete Calculation
Method being Lead resource updates Activity and other resources. There is only one data
entry scenario for this setting.

% Earned Calculation Method option is Lead resource updates Activity and other resources

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % complete
updates % earned
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• % Complete Calculation Method option = Lead resource updates Activity and other
resources

• % Earned Calculation Method option = Lead resource updates Activity and other resources

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (Weighted Hours) and

read-only.
{Sum of [ (Resource Progress
Quantity / Resource Quantity) *
(Resource Amount)] / Sum of
(Resource Amount) } * 100
All resources will be considered

Earned Progress Calculated (read-only)
Same as Activity % Complete

Resource
 Progress Quantity Manual entry. (Only resource that is

selected under drop-down). For all
other resources, Progress Quantity
will be calculated based on
(Leader Progress Quantity / Leader
Quantity) * Resource Quantity

Earned Progress Calculated (read-only)
Same as Progress Quantity

Activity and resource % earned updates % complete

This section contains scenarios for calculations based on the entry method Activity % Earned
and Resource % Earned Updates % Complete and the % Earned Calculation Method
option selected.

Method is Manual activity % earned and resource % earned

This section contains scenarios based on the option selected for % Earned Calculation Method
being Manual activity % earned and resource % earned. There is only one data entry
scenario for this setting.

% Complete Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % earned updates
% complete

• % Complete Calculation Method option = Not available

• % Earned Calculation Method option = Manual activity % earned and resource % earned

then this data entry method scenario results:
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Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (read-only)

Same as Earned Progress

Earned Progress Manual entry
Resource
 Progress Quantity Calculated (read-only)

Same as Earned Progress

Earned Progress Manual entry

Method is Manual activity % earned - updates resource % earned

This section contains scenarios based on the option selected for % Earned Calculation Method
being Manual activity % earned - updates resource % earned. There is only one data entry
scenario for this setting.

% Complete Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % earned updates
% complete

• % Complete Calculation Method option = Not available

• % Earned Calculation Method option = Manual activity % earned - updates resource %
earned

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (read-only)

Same as Earned Progress

Earned Progress Manual entry
Resource
 Progress Quantity Calculated (read-only)

Same as Earned Progress

Earned Progress Calculated (read-only)
(Activity-level Earned
Progress * Quantity)

Method is Resource updates Activity - weighted avg. of resource costs

This section contains scenarios based on the option selected for % Earned Calculation Method
being Resource updates Activity - weighted avg. of resource costs. There is only one data
entry scenario for this setting.

% Complete Calculation Method options are not available

Chapter 1
Schedule Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 549 of 671



If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % earned updates
% complete

• % Complete Calculation Method option = Not available

• % Earned Calculation Method option = Resource updates Activity - weighted avg. of
resource costs

then this data entry method scenario results:

Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (read-

only)
Same as Earned
Progress

Earned Progress Calculated (Weighted
Hours) and read-only.
{Sum of [ (Resource
Earned Progress /
Resource Quantity) *
(Resource Amount)] /
Sum of (Resource
Amount) } * 100
All resources will be
considered

Resource
 Progress Quantity Calculated (read-

only)
Same as Earned
Progress

Earned Progress Manual entry

Method is Lead resource updates Activity and other resources

This section contains scenarios based on the option selected for % Earned Calculation Method
being Lead resource updates Activity and other resources. There is only one data entry
scenario for this setting.

% Complete Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % earned updates
% complete

• % Complete Calculation Method option = Not available

• % Earned Calculation Method option = Lead resource updates Activity and other resources

then this data entry method scenario results:
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Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (read-

only)
Same as Earned
Progress

Earned Progress Calculated (Weighted
Hours) and read-only.
{Sum of [ (Resource
Earned Progress /
Resource Quantity) *
(Resource Amount)] /
Sum of (Resource
Amount) } * 100

Resource
 Progress Quantity Calculated (read-

only)
Same as Earned
Progress

Earned Progress Manual Entry (Only
resource that is
selected under drop-
down).
 
For all other
resources, Earned
Progress will be
calculated based on
(Leader Earned
Progress / Leader
Quantity) * Resource
Quantity

Method is Update Activity and all resources on start and finish

This section contains scenarios based on the option selected for % Earned Calculation Method
being Update Activity and all resources on activity start and finish. There is only one data
entry scenario for this setting.

% Complete Calculation Method options are not available

If the entry method and option settings on the Budget and Progress Method Setup window are:

• % Complete and Earned Progress entry method = Activity and resource % earned updates
% complete

• % Complete Calculation Method option = Not available

• % Earned Calculation Method option = Update Activity and all resources on activity start
and finish

then this data entry method scenario results:
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Activity or Resource Data Element Data Entry Method

Activity
 Activity % Complete Calculated (read-only)

Same as Earned Progress

Earned Progress Calculated (read-Only) based Update
Activity and all resources on activity
start and finish.
For example: If % earned on Actual
Start = 5% and % earned on Actual
Finish = 95 % then,
When Actual Start is entered, Earned
Progress = 5%
When Actual Finish is entered,
Earned Progress = 100%

Resource
 Progress Quantity Calculated (read-only)

Same as Earned Progress

Earned Progress Calculated (read Only) based Update
Activity and all resources on activity
start and finish.
For example: If % earned on Actual
Start = 5% and % earned on Actual
Finish = 95 % then,
When Actual Start is entered, Earned
Progress = 5% * Quantity
When Actual Finish is entered,
Earned Progress = 100% * Quantity.

Creating Schedule Manager Custom Calendars

The system allows you to create Custom Calendars to be used by the Schedule Manager. The
Custom Calendar that you specify can override the company-level Standard Calendar. If there
is no Custom Calendar, the Standard Calendar marked as the default calendar is the calendar
that is used by the Schedule Manager.

The system allows you to create multiple Custom Calendars, enabling you to create a library of
calendars that can be selected for use on your schedule sheets. The multiple calendars enable
you to have calendars to support varying work schedules (depending on locality) and to
account for holidays and other non-working days. For example, some countries in the Middle
East have weekends that are other than Saturday and Sunday.

You must have permissions granted to create, modify, delete, or view Custom Calendars.

About Calendars and Activities

When you select or change an activity calendar, the calendar affects the following dates and
date pickers:

• Start Date date picker

• Finish Date date picker
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• Duration calculation

• Actual Start Date date picker

• Actual Finish Date date picker

• Actual Duration

• Forecast Start calculation

• Forecast Finish calculation

• Forecast Duration calculation

• Critical Path

• Estimate dates

• Estimate duration

• Float calculation

• Progress window Progress As Of Date date picker

• Budget and Progress options Do not allow progress entry older than the current
period and Allow editing of last progress

• Any date or date only picker data element

This is how the dates are changed when the activity calendar changes. Changes occur when
the schedule sheet is refreshed.

• Activity (not started): If the Start Date is affected by a new activity calendar, the Start Date
and Finish Date will change to keep the Duration as specified. The system will use the next
day on the calendar.

• Activity (not started): If the Finish Date is affected by a new activity calendar, the system
will select either a previous or next working day on the calendar.

• Activity (in progress): If the Finish Date is affected by a new activity calendar, the system
will select either a previous or next working day on the calendar. The Start Date is not
affected in this case.

• Activity (completed): No impact on Start Date or Finish Date for the activity.

Create a Custom Calendar in the Schedule Manager

To create a custom calendar in the Schedule Manager, you must have Create permission. You
can create a new calendar manually, or by copying and modifying an existing calendar.

To create Custom Calendars:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Custom Calendars.
The Custom Calendars log opens.

3. Select New.
The Calendar Properties window opens.

4. Enter the calendar name and an optional description.

5. Specify the working and non-working days for the calendar you are creating. Browse to the
month and year using the pull-down menus at the top of the calendar. Saturdays and
Sundays are set as non-working days by default. Do one of the following:
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• To set a particular date as a non-working day (for example, a holiday), select the date
on the calendar, and select Non Working. The date will appear greyed out, and will
not be used in date calculations.

• To set a non-working day as a working day, select a greyed cell, and select Working.

• To set a particular day of the week (for example, every Saturday) as a non-working
day, select the day at the top of the calendar (for example "Sat"), and then select Non
Working. All Saturdays in the calendar will be changed to non-working days (grey).

• To set a particular day of the week as a working day, select the day at the top of the
calendar, and then select Working.

• If you only want to set the day of the week in a particular month as working or non-
working days, select each day individually, and select Working or Non Working.

Note

If you have marked the day of the week as a non-working day throughout the
calendar by selecting the day at the top of the calendar (for example "Sat"),
you will not be able to mark individual days (that is, individual Saturdays in this
example) as working days. To be able to include both working and non-
working instances of a day of the week on the calendar, you must select them
individually.

6. Specify the Default Work Time with the Start Time and Hours/Day fields.

7. Select OK.

To copy an existing calendar:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Schedule Manager, and then select Custom Calendars.
The Custom Calendars log opens.

3. Select a calendar in the log.

4. Select Copy.
The Calendar Properties window opens with the calendar description and calendars days
specified. You can copy from Standard (Company level) or Custom (project/shell level)
calendars.

5. Enter the calendar name and change the optional description as needed.

6. Modify the working and non-working days that are specific to the new calendar you are
creating. Browse to the calendar months you want to modify. Select the calendar day, and
select the working days and default work time as needed.

7. Select OK.

Do not allow update of % complete and % earned

When the Do not allow update of % complete and % earned entry method is selected, these
fields are disabled.

• Activity

– Activity % Complete

– Earned Progress
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• Resource

– Resource % Complete

– Progress Quantity

– Earned Quantity

P6 Summary Sheets

Unifier allows you to store summarized data from P6 in the P6 Summary Sheets node.

If you have access to the Earned Value Manager feature, refer to the Unifier Earned Value
Management User Guide for more information about Activity Sheets and P6 Summary Sheets.

To view the P6 Summary Sheets node in a project/shell, User mode, the Shell Attribute Form
must have the Data Element (DE) uuu_int_schedule_type, and you (User) must have the
appropriate permissions for accessing the node.

The placement of P6 Summary Sheet node under the Schedule Manager is by default. A user
can move P6 Summary Sheet node under other Summary nodes (Example: Cost Manager) if
needed.

The P6 Summary Sheets node contains one sheet, or more, that contains “summarized” P6
data:

• Master Summary Sheet
Contains summarized data from the P6 Project and the sheet is linked to the current
project/shell.

The Master Summary Sheet is not displayed as "Master" in the Master Summary Sheet
properties.

• Baseline Summary Sheet
A P6 Project can contain any number of baselines, or no baselines at all. A baseline is a
copy of the P6 Project that contains frozen data per Data Date. You can select to bring
summarized baseline data from a P6 Project to Unifier, via Gateway. The Baseline
Summary Sheets that you bring to Unifier, from a P6 Project, reside in the Master sheet
below the P6 Summary Sheets node.

Note

– The Baseline Summary Sheet appears as an additional Schedule Sheets
node under the Schedule Manager.

– When a P6 User enters the actual and progress data in P6 Schedule, the date
is displayed as "Progress as of" date in P6 Schedule.

– You cannot create a new P6 Summary Sheet manually. Unifier allows a total
of 12 summary sheets to be integrated: 1 current Schedule Summary sheet
and 11 Baseline Summary Sheets, or 12 Baseline Summary Sheets.

Schedule Sheet Integration

Unifier continues to support out-of-the-box (OOTB) mapping for integration between P6 and
Unifier, using existing Schedule Sheets.
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This OOTB mapping is available as part of Project Controls installation as a shell template
(T-002).

To view the data mapping fields in Unifier:

1. Go to the Company Workspace tab, and switch to Admin mode.

2. In the left Navigator, select Templates, select Shells, and then select Projects.

3. Open the T-002 (Project #) Owner Project Template (Project Name).

4. In the left Navigator, select Schedule Manager, and then select Schedule Sheets.

5. In the Schedule Sheets log, open Project Schedule Sheet.

6. From the File menu, select Data Mapping.

7. In the Data Mappings dialog box, select P6, select Modify, and then select the Activity
tab.

The column name and XML elements are listed as shown below. You can use the XML
elements for integration with P6.

Column XML Element

Activity Name Name
Activity Percent PercentComplete
Actual Finish Date ActualFinishDate
Actual Start Date ActualStartDate
Duration PlannedDuration
Early Start date EarlyStartDate
Early finish date EarlyFinishDate
Finish date PlannedFinishDate
Late Start date LateStartDate
Late finish date LateFinishDate
P6 Activity Number Id
P6 CBS CBSCode
Start date PlannedStartDate

Auto-Scheduling of Activities

You can disable automatic re-scheduling within Unifier Schedule Sheet to:

• Schedule Activities manually.

• Integrate Activities with their dependencies with the same schedule as exists in P6 and
MPP.

Disabling Automatic Scheduling of Activities

When Activities with dependencies are integrated by Direct Integration with P6, or imported
through MPP XMLS, the activities are re-scheduled automatically within the Schedule Sheet to
retain the dependencies, leading to Data change. You can disable this automatic reschedule in
Schedule sheet to integrate or import the data as is and to schedule the Activities manually, if
desired.

To enable or disable auto-scheduling:

1. Go to the Schedule Sheet Properties window, General tab.
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2. Select your option in Auto-Schedule field. The default selection is Enable.

In the Schedule Sheets log, the column Auto-Schedule displays the condition of the sheet.

When the auto-scheduling is disabled:

• You will be able to edit the Activity Properties of a particular Activity, for example Start
Date, Finish Date, Duration, Predecessor, Dependencies, and so on. The properties of
the dependent activities are not impacted because if automatic scheduling is disabled.

• You can manually reschedule the schedule sheet to implement your changes by refreshing
it through a manual Schedule refresh, Cost and Schedule refresh, or enabling scheduled
refresh (Set Frequency). These options are available under Refresh in the log toolbar.

• After changing the Activity Properties of individual activities, when the schedule sheet is
refreshed manually or through Schedule refresh, the entire schedule sheet will be re-
scheduled. The impact on dependent activities can be reviewed after refresh.

• The refresh status of schedule sheet is displayed on Schedule Sheet Refresh window
(History Details window).

• No updates will take place for resource rates on the master schedule sheet and also
update to shell cost sheet with corresponding assignment costs until you allow manual
scheduling through manual or Schedule refresh. After the schedule sheet is manually
scheduled, the updates will take place.

• When you go to the Edit menu, select Update, and then select Resource Utilization (on
the master schedule sheet) or Resource Utilization and Cost Manager, the following
alert message is displayed: Cannot update cost till Sheet is scheduled.

Calendar

When the calendar that is defined for a particular Activity is changed in the Activity
Properties, Unifier changes the Finish Date. In this case, if the auto-scheduling is disabled,
no impact of this change is reflected in the dependent activities.

When the calendar that is defined for a particular Schedule Sheet is changed in the Schedule
Sheet Properties, the next time you open the schedule sheet, the following message is
displayed: Schedule sheet requires a refresh due to modifications to a Calendar or Rates
associated to a Role on a Resource. Do you want to refresh schedule sheet?

If you select Yes, the schedule sheet will be rescheduled on refresh, as an impact of Calendar
change, irrespective of whether Auto-scheduling is enabled or disabled.

If you select No, no impact of Calendar change is reflected in the schedule sheet.

Activity Manager
The system enables you to create, consolidate, and monitor activities that must be completed
on a schedule by way of the Activity Manager.

The Activity Manager grouping node contains the following sub-nodes, when available:

• Activity Sheet

• OBS Sheet

• Rate Sheet

• WBS Sheet
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Note

– To view the Activity Sheet, or other sheets, you must have the appropriate
permissions.

– To view additional information that might be minimized, select the split screen
icon ( ) at the bottom of the window for the selected sheet.

To access the Activity Manager node:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Activity Manager to expand it.

The following provides summary details about each functional node (sub-nodes).

Activity Sheet functional node

The Activity Sheet sub-node contains a list of activity sheets listed in the Activity Sheets log.
You can have multiple activity sheets.

An activity sheet captures scheduling data from mapped P6 or Oracle Primavera Cloud
projects and role and resource rates from the company-level Master Rate Sheet (default) or
shell-level rate sheets, and calculates the Earned Values metrics and derivatives. When
Unifier, Oracle Primavera Cloud, and Oracle Integration are integrated, you can use Oracle
Integration recipes to update the System Activity Sheet or the Master Rate Sheet (or both) in
Unifier with information from Oracle Primavera Cloud. A System Activity Sheet is the primary
source of data for the Earned Value Analysis.

OBS Sheet functional node

An OBS Sheet (Organization Breakdown Structure sheet) contains the following information:

• Full Name

• Short Name

• Unifier User

• Title

• Department

• Status

• WBS Name

• Contract No

• Weekly Capacity

The OBS Sheet node log displays the only available OBS sheet.

Refer to the Unifier Earned Value Management User Guide for details.

Rate Sheet functional node

The Rate Sheet node captures the list of resources and roles (based on the latest data
available in activity sheet) and corresponding rates from the Master Rate Sheet.

In P6/Oracle Primavera Cloud, users can assign a role, or resource, to an activity under the
Assignments tab of an activity for any project. In P6/Oracle Primavera Cloud, rates are
assigned to a role or resource at global level. To maintain the consistency, the system will
import the P6/Oracle Primavera Cloud global data to Unifier Company Workspace. This data
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will be captured under a new entity called Master Rate Sheet. The rate sheet being created
through P6/Oracle Primavera Cloud to Unifier integration will be saved as 'Master Rate Sheet'
under a new node in Company Workspace called Master Rate Sheet.

The rates (Price/Unit) for assigned roles and resources are managed at global level in P6/
Oracle Primavera Cloud, which can then be used in a project while doing the costing
(calculating Present Value, Earned Value, and so on) of the project depending on the rate
source (resource, role, or override) corresponding to that assignment in an activity.

For a resource loaded schedule, the system needs rates corresponding to roles and resources
for costing of any project in Unifier. There are two types of rate sheets:

• Master Rate Sheet (at Company Workspace)

• Rate Sheet (at Shell) explained in the subsequent sections.

A company will only have one Rate Sheet called the "Master Rate Sheet." So, users are not
allowed to create a copy sheet of the Master Rate Sheet under Company Workspace. This
sheet will contain rates for both roles and resources, users will be able to toggle between
resource and role rates from the display. By default, the rates present in master rate sheet will
be used across all the resources and roles present in all activity sheets across all shells unless
user has assigned another rate sheet present at the shell level to the activity sheet/project.

To override the price or unit. The Planning and Actuals will be fetched from corresponding Rate
Sheet or Overridden Price/Unit from override action. Whenever a different Rate is assigned to
a Resource, system will display the following alert message: Perform Recost to see updated
costs.

Refer to the Unifier Earned Value Management User Guide for details.

WBS Sheet functional node

A WBS Sheet (Work Breakdown Structure sheet) contains the following information:

• Planned Units

• Planned Total Cost

• Actual Units

• Actual Total Cost

• Remaining Units

• Remaining Total Cost

• At Completion Units

• At Completion Total Cost

The WBS Sheet node log displays the only available WBS sheet.

Refer to the Unifier Earned Value Management User Guide for:

• Details about the functional nodes, mentioned above.

• Information related to the System Activity Sheet, Master Rate Sheet, and Rate Sheet.

Activity Sheet Sub-Node

The Activity Sheet sub-node contains a list of activity sheets (including the System Activity
Sheet), and they are all listed in the Activity Sheets log.

You can have multiple activity sheets.

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 559 of 671



You can create User-Defined Reports (UDRs) from the Activity Sheet Data Elements (DEs).

The system uses the following schedule types to determine the activity schedule when sending
activity data to the Cash Flow:

Note

The Cash Flow properties will be displayed based on the activity sheet schedule type.

Type Description

Resource The Activity Sheet receives the entire duration based
information from P6.
The Activity Sheet receives the entire resource
assignment related information.
(Not always) The Activity Sheet receives the entire cost
related information.
The Activity Sheet is available as a source for Cash Flow
and Cost Sheet.
The Activity Sheet has all cost related feature. (Assign
rate sheet and Recost.)
The Activity Sheet is available for Earned Value
Analysis.

Cost The Activity Sheet receives the entire duration based
information from P6.
The Activity Sheet receives the entire resource
assignment related information.
The Activity Sheet receives the entire cost related
information.
The Activity Sheet is available as a source for Cash Flow
and Cost Sheet.
The Activity Sheet does not have any cost related
feature. (Assign rate sheet and Recost.)
The Activity Sheet is available for Earned Value
Analysis.

Note

The system uses the data
directly from P6 and does not
perform any calculations for a
cost loaded schedule.
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Type Description

Duration (without 'Based') The Activity Sheet receives duration based information
from P6.
(Not always) The Activity Sheet receives resource
assignment related information.
(Not always) The Activity Sheet receives cost related
information.
The Activity Sheet is not available as a source for Cash
Flow and Cost Sheet.
The Activity Sheet does not have any cost related
feature. (Assign rate sheet and Recost.)
The Activity Sheet is not available for Earned Value
Analysis.

The following explain the Activity Sheets log elements, followed by information regarding
manual activity sheets.

Activity Sheets Log and Manual Activity Sheets

The Activity Sheets log contains a list of manually created activity sheets, which have a
Source Type of Custom, and the System Activity Sheet, which is produced when you
integrate Unifier with another product, such as Primavera P6.

All the activity sheets that are defined in Unifier will be displayed with source type as 'Custom'
in the Activity Sheets log.

Manual Activity Sheet

To create and maintain project schedules within the system, you can manually define activity
sheets.

A manual activity sheet captures the:

• Schedule of activities, within a project

• Resource assignments

• Rate

Note

When you assign resources or roles that have multiple rates to an activity sheet, to
update the total cost (Total Cost value), you must reschedule, or recost, the
activity sheet. Otherwise, the system assigns earliest assigned resources or roles
rates (price/unit) to the activity sheet, and you cannot view the correct
accumulated cost.

A manual activity sheet also tracks the progress of activities, over the lifetime of the project.

Note

For information about the System Activity Sheet, refer to the Activity Manager
section in the Unifier Earned Value Management User Guide.
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You can use an activity sheet to:

• Define simple project schedules.

• Define tasks, milestones, and relationships between tasks, to enhance user experience.

• Assign resources and track project progress by capturing actuals and calculating
remaining work that needs to be done.

• Assign CBS codes to Baseline activities.

In an activity sheet, you can:

• Set the view to WBS and add activities or update and remove the activities in the WBS
view, similar to the Default view.

• Include attachments and comments for the activities.

• View the History Log (within Activity Sheet and Schedule) by using the Data Date.

• Add, edit, and remove the activities and dependencies and assignments in the user-
defined views. You can also view the dates, costs, units, and other summary data within
the WBS hierarchy view.

• Within the WBS hierarchy, add, copy, or remove the activities in WBS view and user-
defined views.

• Add, edit, or remove both the column and row data in user-defined views.

• Add additional notes to the tasks or activities.

• Schedule the activities based on data date and view the schedule history.

In the activity sheet, the Default view is shown by default when you open the sheet. In the
Default view, all the activities are displayed in flat mode.

Note

Any existing views that you created prior to version 20.10 are not listed in the View
drop-down field.

If you create a new view to display only the WBS items, all the activities within the sheet are
grouped by WBS hierarchy. At WBS (Summary level), all the costs show the sum of the costs
of all the activities, as well as the costs that are received at the summary level.

The Start and Finish dates, in the WBS row, show the earliest start date and latest finish dates
for all the activities under that WBS.

All the attributes defined in the Activity Attribute Form are displayed as columns in the WBS
View, similar to the Default View. The order of columns is the same as selected in the design.

Within an activity sheet, you can create views with filters, groupings, and so forth to view the
filtered and small list of activities and associated columns, instead of scrolling down and right
to navigate to specific activities.

If your administrator defined additional views in a template and pushed them to your project/
shell, these views are listed in the Manage Views dialog box of your activity sheet. You can
make these views visible in your activity sheet, and you can change the order in which they are
listed. After they are visible, you can use them to create additional custom views. You cannot
edit or delete the predefined views. If the administrator pushes additional updates to the
template, custom views that you created are deleted. For more information about views, see 
Creating and Managing Views in Activity Sheets and the System Activity Sheet.

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 562 of 671



For the default and user-defined views, you can perform the following functions, in addition to
adding, deleting, and updating the activities and the schedules:

• Drag and drop columns and reorder the columns, except the first two columns (Activity ID
and Activity Name) which are fixed.

• Select a column header to change the Sort By option.

• Right-click a column or column header, and select Lock after this column to lock a
column.

Note

You cannot lock before this column beyond the Activity Name column.

Similar to a Cost Sheet or a WBS Sheet, you can group selected columns in the sheet.

Activity Sheet

The values for the following cost-related units are calculated according to the assignments, as
follows:

Planned Cost & Remaining Cost

Planned Cost and Remaining Cost for the assigned resource will be calculated based on the
number of the units * the rate per unit.

Planned Cost is calculated as Planned units * price/unit.

If the rate source is an override, the system uses the rate present in the activity sheet that
corresponds to that assignment.

The resource rate is derived from the rate based on the effective date between the start and
the finish dates.

The exchange rates for that day are applied if the resource/role does not have the same
currency as the project.

Remaining Cost

Remaining Cost for the assigned resource will be calculated based on the number of remaining
units * price per unit.

If the rate source is an override, the system uses the price/unit for the calculating remaining
cost.

Actual Cost

The system calculates the Actual Cost based on the number of actual units * rate per unit.

The rate is based on the Actual Start Date onwards.

The unit rate is based on the effective date which falls on the actual start date.

At Completion Cost

At Completion Cost value is equal to: Actual Cost + Remaining Cost.

All the calculated costs (Planned Cost, Actual Cost, Remaining Cost, and At Completion Cost)
will be rolled up to the activity sheet and to the:
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• Planned Total Cost

• Actual Total Cost

• Remaining Total Cost

• At Completion Total Cost

The following units will be rolled up from Assignments tab:

• Planned Total Units

• Actual Total Units

• Remaining Total Units

• At Completion Total Units

Activity % Complete

The system calculates this field as a simple and intuitive formula for Units % Complete of
Activities, with labor or non-labor assignments:

Activity % Complete = [Actual Units] / ([Actual Units] + [Remaining Units] )

Earned Value Calculations at the Activity level:

• Planned Value (uuu_P6PVCost)
This is the planned total cost of the activity that is complete as of the data date.

• Earned Value (uuu_P6EVCost)
The cost of all activities in the project that are actually completed as of the data date.

The Budget At Completion is calculated from the project baseline and is calculated as:
Budget At Completion multiplied by Performance % Complete.

• Estimate to Complete (uuu_P6ETC)
The estimated cost to complete the activity, WBS, or project.

It is calculated as Remaining Total Cost for the activity or the Performance Factor
multiplied by (Budget At Completion minus Earned Value), depending on the Earned
Value technique selected for the activity's WBS.

The Budget at Completion is calculated from the project baseline. The ETC technique will
be fetched from the WBS sheet for the respective activity.

• Schedule Performance Index (uuu_P6SPIndex)
A measure of the work accomplished as a percentage of the work scheduled.

The Schedule Performance Index indicates whether you are meeting earned and
planned values within your schedule. A value less than 1 indicates that less work was
performed than was scheduled.

It is calculated as Earned Value divided by Planned Value.

• Cost Performance Index (uuu_P6CPIndex)
A measure of the value of work accomplished as a percentage of the actual costs.

The Cost Performance Index (CPI) indicates whether you have spent money over the
budget to date.

It is calculated as Earned Value Cost divided by Actual Cost. A value less than 1
indicates that the actual cost has exceeded the planned value.

• Cost Schedule Index (uuu_P6CSIndex)
It is a product of Schedule Performance Index & Cost Schedule Index.

• Schedule Variance (uuu_P6ScheduleVariance)
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The measure of Schedule Performance Index on a project. A negative value indicates
that less work was actually performed than was scheduled.

It is calculated as Earned Value minus Planned Value.

• Cost Variance (uuu_P6CostVariance)
A measure of Cost Schedule Index on an activity, WBS, or project. A negative value
indicates that the actual cost has exceeded the planned value.

It is calculated as Earned Value minus Actual Cost.

• To Complete Performance Index (uuu_P6TCPIndex)
The ratio of the remaining work to the remaining funds.

It is calculated as (Budget at Completion minus Earned Value) divided by (Estimate at
Completion minus Actual Units or Cost).

• Estimate at Completions (uuu_P6EACCost)
The expected total cost of a schedule activity, a work breakdown structure (WBS)
component, or the project when the defined scope of work will be completed.

It is calculated as Actual Cost plus Estimate to Complete Cost. The method for
calculating estimate to complete depends on the earned value technique selected for the
activity's WBS.

• Budget at Completion (uuu_P6BAC)
The planned total cost through activity or project completion.

It is calculated as Planned Labor Cost plus Planned Non-labor Cost plus Planned
Expense Cost plus Planned Material Cost.

• Variance at Completion (uuu_P6VAC)
The difference between the baseline total cost and the current estimate of total cost. A
negative value indicates an estimated cost overrun.

The Budget At Completion is calculated from the current baseline.

It is calculated as Budget At Completion minus Estimate At Completion.

All the earned value calculations are performed at activity level.

• Assign a CBS Code at Assignment level:
You can assign the CBS Code at the resource level similar to the CBS Code assignment at
the activity level. CBS code is a picker column which shows active CBS Codes defined in
the project cost sheet.

All the costs and units will be rolled up to the cost sheet and cash flow based on the CBS
assignment.

Note

All the calculations are performed during recosting.

Cost Sheet

You can roll up all the units (Planned, Actual, Remaining, and At Completion) and costs
(Planned, Actual, Remaining, and At Completion) from manual activity sheets, both at the
resource and activity level, into the cost sheet by using logical sources.
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In the column properties, when you select From Activity Sheet as type, the Sheet Name
drop-down field displays all the active manual activity sheets, and you can select columns
(Planned Units, Actual Units, Planned Cost, and so on) at the activity and resource level.

The following columns are displayed when you select the manual activity sheet:

Activity

• Planned Total Cost - cost (uuu_P6PlannedTotalCost)

• Actual Total Cost - cost (uuu_P6ActualTotalCost)

• At Completion Total Cost - cost (uuu_P6AtCompletionTotalCost)

• Remaining Total Cost - cost (uuu_P6RemainingTotalCost)

• Planned Units - units (uuu_P6PlannedTotalUnits)

• Actual Units - units (uuu_P6ActualTotalUnits)

• At Completion Units - units (uuu_P6AtCompletionTotalUnits)

• Remaining Units - units (uuu_P6RemainingTotalUnits)

• Planned Duration

• Actual Duration

• Remaining Duration

• At Completion Duration

• Performance % Complete

• User Defined Data Elements which are of currency and decimal type data elements

Resource

• Planned Cost - cost (uuu_P6PlannedCost)

• Actual Cost - cost (uuu_P6ActualCost)

• At Completion Cost - cost (uuu_P6AtCompletionCost)

• Remaining Cost - cost (uuu_P6RemainingCost)

• Planned Units- Units (uuu_P6PlannedUnits)

• Actual Units- Units (uuu_P6ActualUnits)

• At Completion Units- Units (uuu_P6AtCompletionUnit)

• Remaining Units- Units (uuu_P6RemainingUnits)

If the selected activity sheet becomes inactive, the new data will not be rolled up to the Cost
Sheet.

The system changes the value of the current Sheet Name from Activity Sheet 1 to System
Activity Sheet at both Activity and Resource level.

All the existing columns that are available from the System Activity Sheet are displayed for
other manual activity sheets that you have selected.

You can pull data from all costs and units and all other custom defined decimal and currency
fields from the manual activity sheets.

The cost sheet template (company and shell levels) remains as it is, except that the label will
change.
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WBS Sheet

You can see the rolled-up value against WBS codes in the WBS sheet.

Activity Sheets Log (Toolbar Options)

The Activity Sheets log contains the following toolbar options:

• Create
To open the Create Activity Sheet window and manually proceed to create a standard,
project/shell, or custom activity sheet. See Creating a Manual Activity Sheet.

• View
Lets you determine the type of activity sheets that you want to view. Your options are:

– Active

– All

• Actions

– Permissions
This option is not applicable to the System Activity Sheet. This option is available
when you select a single or multiple activity sheets (manual or custom). The
functionality is the same as when the Permissions option is selected using the gear
menu ( ) option. You can assign permissions to multiple activity sheets that are
created manually from the log. This includes the sheets created using import from
MPP or P6 XML files.

– Assign Rate Sheet
Use this option to select Rate Sheets for a project. The system uses the resource or
role rates from the selected Rate Sheets for both Planning and Actuals to calculate the
Planned, Actual, At Completion, and Remaining Costs.

– Import

* Microsoft MPP

* P6 XML

• Get Data into Activity Sheet
See Creating a Manual Activity Sheet.

• Send Data from Activity Sheet
See Creating a Manual Activity Sheet.

• Refresh
To update the information displayed on the screen.

When a different rate sheet is assigned to roles and resources or when recost is
performed, values in the sheet are not automatically updated. Select Refresh to display
updated data in the fields.

• Print
To print the information displayed on the screen. Your other options are:

– Export To CSV

– Export To Excel
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Note

* For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

* If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

• Find on Page
To find items on the displayed page. When you select this option, the system inserts a row
that lets you enter filter parameters.

If you have the Create Manual Activity Sheets permission, or the Full Access permission
(see Activity Sheet in Shell (User Mode) Permissions), the toolbar options in the Activity
Sheets log are as follows:

Toolbar Option Description

Create Lets you create activity sheets. This option is enabled
when the user has at least the Create permission for the
manual activity sheets. The Create option has two
additional sub-options to support the manual creation of
an activity sheet and creating an activity sheet from
Activity Sheet templates (when the Activity Sheet
templates is made available in Admin mode).
When you select Create, the system checks for Manual
Activity Attribute Form, if a system activity sheet has
been created by using the System Activity Sheet
Attribute Form.
If there is no System Activity Sheet Attribute Form
defined, or there is no Manual Activity Attribute Form,
in the design, the system uses the canned form for the
activities in the activity sheet.
An Activity Attribute Form must be defined for you to be
able to create custom activity sheets. If a System Activity
Attribute Form is defined, but there is no Manual
Activity Attribute Form, the system displays this
message: Activity attribute form must be defined
in order to create custom activity sheets.

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 568 of 671



Toolbar Option Description

View Lets you select how to view the list of the activity sheets
that are available.
To be able to see any activity sheets in the Activity
Sheets log, you must have the View permission, or
above.
The View drop-down field displays the following out-of-
the box, or default, options:
• All: To display all the activity sheets.
• Active: To display all the activity sheets with active

status. Available if there are activity sheets in the log
that have active status.

Note

The System Activity Sheet will
be active (Status) at all times,
and the status cannot be
changed.

Actions To set permissions and import options:
Permissions: To assign activity sheet-level permissions
similar to the record-level permissions set for the non-
Workflow BPs.
Import (Microsoft MPP or P6XML)
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Toolbar Option Description

Get Data 
Get Data into System Activity Sheet

The Get Data option will be enabled when you have the
Get Data permission at the node level in the
Permissions tab. This option lets you receive the
schedules from P6 or Oracle Primavera Cloud based on
synchronization selected in Gateway, Primavera Cloud,
or Oracle Integration settings.
Use the Get Data option to:
• Create an activity sheet for the first time.
• Update an existing activity sheet with the most

recent activity spread data from the Oracle
Primavera Cloud project.

Updating an existing activity sheet triggers a new OOTB
import synchronizations if you have selected the Select
Synchronization to Exchange Activity Data option in
Gateway integration settings drop-down list.
All the synchronized Oracle Primavera Cloud project
activities, planned dates, actual, at completion dates,
and associated WBS Code will be displayed in the
activity sheet.

Note

A WBS code assignment is
applicable only to a manual
activity sheet, whereas a CBS
code assignment is applicable
to both manual and system
activity sheets.

If the shell is not active (inactive shell), Gateway
integration will fail.
When you select Get Data, the system checks for the
Oracle Primavera Cloud project that as defined in the
Integration tab and then brings the Oracle Primavera
Cloud project activity data and their schedules into the
activity sheet based on the import synchronization
defined in Gateway settings, and if Oracle Primavera
Cloud and Unifier projects are linked.
If you select Get Data and there is no Project ID added
in the Integration tab, the system will display this
message: Valid Project ID is not specified in the Shell
Integration Tab.
Unifier does not bring the baseline (project data) from
Oracle Primavera Cloud.
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Toolbar Option Description

Send Data 
Send Data from System Activity Sheet

The Send Data option will be enabled when you have
the Send Data permission at the node level in the
Permissions tab. This option lets you receive the
schedules from P6 or Oracle Primavera Cloud based on
synchronization selected in Gateway settings.
Use the Send Data option to run the export
synchronization to send the updated activities and
schedules from the Unifier Activity Sheet to the Oracle
Primavera Cloud.
The data elements in the business processes, or the shell
attribute form, which have been set to reverse auto-
populate (RAP) back to the Oracle Primavera Cloud
Activity Sheet (using P6 Activity Picker), will get the
latest updates into the Oracle Primavera Cloud Activity
Sheet.
You can send the updated Activity Sheet data (such as:
updated Actual Start Date or Finish Dates) to the Oracle
Primavera Cloud project which is linked by way of the
OOTB export synchronization option: Update Unifier
Activity data in to Oracle Primavera Cloud.
The Schedule tab, in the Activity Sheet log, shows this
option, and you can set the scheduled send data based
on frequency.
Before the initial synchronization, the Get Data is the
only toolbar function available in the log. Select Get
Data to initiate synchronization and create the Activity
Sheet.

Refresh To retrieve the latest number of activity sheets created
in the log.

Print To print the log contents into HTML, CSV, or Excel
formats.

Find on Page To search in the log.

If you do not have the Create Manual Activity Sheets permission, or the Full Access
permission, the toolbar in the Activity Sheets log does not display the Create option.

Activity Sheets Log (Columns)

The Activity Sheets log contains the following columns:

• Refresh Data: A Refresh icon  is displayed in this column if the activity calendar is
edited in the following areas:

– Working and Non-working days

– Working hours

– Start time of working day

Use the Refresh toolbar option to update the sheet based on the new calendar values.
The refresh is captured in the History tab of the sheet.

• Name: The name of the manual activity sheet.

• Description: The description for the manual activity sheet.

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 571 of 671



• Source Type: To show whether the source for the manual activity sheet is standard,
project/shell, or custom.

Note

The Source Type for a System Activity Sheet is P6 or Oracle Primavera Cloud.

• Status: To show whether the manual activity sheet is active.

• Last Updated On

• Creation Date

• Created By

Activity Sheets Log (Manual Activity Sheet Gear Menu)

To open the Activity Sheets log:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Activity Manager, and then select Activity Sheet.

The Activity Sheets log lists the activity sheets. Each activity sheet is listed in a row, and each

activity sheet has a gear menu ( ). The following table explains the functions of each option
within the gear menu:

Option Description

Open To open the Activity Sheet from the log. Alternatively,
you can highlight a row, right-click, and use the Open
option.

Import Microsoft MPP To import the activity sheet by way of MPP. This option
lets you bring the file from P6 and import them into an
activity sheet to create a schedule. The import will
remove the existing data from the activity sheet.

Import P6 XML To import the activity sheet by way of P6 XML. This
option lets you bring the file from P6 and import them
into an activity sheet to create a schedule. The import
will remove the existing data from the activity sheet.

Permissions To assign Edit, View, and Modify permissions to other
users for the selected activity sheets. The functionality
supported is same as assigning permissions to Non-
Workflow BPs.

Recost To perform the cost calculations.

Activity Sheets Log (Manual Activity Sheet Properties Tabs)

In the Activity Sheets log, when you select an activity sheet (manually created), the following
properties tabs appear in the right pane:

• Properties tab

• Permissions tab

• Audit Log tab
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• History tab

The following table describes the tabs listed above:

See Creating a Manual Activity Sheet for details.
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Tab Name Description

Properties The Properties tab displays the following properties of
the selected activity sheet, based on the values entered
when the activity sheet was created:
• Name
• Description
• Status (Active or Inactive)
• Calendar
• Select Project Schedule Start Date Source

(Manual or From Shell Attribute)
• Schedule Start Date

Note

The Start Date of an Activity
Sheet can be before a Project
Start Date because a schedule
may include activities that
were carried out before the
project officially starts.

• Time Zone (cannot be changed after creation)
• Data Date
• Schedule Type
• Assign Rate Sheet (block) which contains the Rate

Sheet (Planning) and Rate Sheet (Actual) fields.
• Activity Sequence Numbering (block) which

contains the Activity Id Prefix, Activity Id Suffix,
and Increment fields, all required.

You can change the values for the following fields:
• Name
• Description
• Status
• Calendar
• Assign Rate Sheet (block)

Note

Assigning a Rate Sheet is
optional. If a Master Rate
Sheet is defined at the
Company level, it is assigned
to the Rate Sheet (Planning)
and Rate Sheet (Actual)
fields by default; however,
you can select a different Rate
Sheet for a project.

• Activity Sequence Numbering (block)
The Project Schedule Start Date can be modified if
there are no activities that are in progress in the log.
You can modify the activity sequence number in the
Properties tab. The modified sequence will be displayed
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Tab Name Description

for any new activity sheets that are created after the
sequence got modified. The activity sheets will not be
impacted with this change in the activity sequencing.
When changes are made in the Properties tab, the
Cancel and Save options will be enabled. There will be
an entry in the activity sheet Audit Log tab for the
changes made.
The Schedule Type field (by default the value is
Duration) determines the type as resource-based or
cost-based.

Permissions The Permissions tab lets you view or conduct a user or
group search and view the corresponding permissions.
Use the Permissions tab to define, edit, or view other
members' permissions in the project. The activity sheet
owner, or the user with full access permission, will be
able to assign, modify, and view other members'
permissions.
The permissions that are allowed to be assigned to other
users are:
• Modify Permissions
• Edit Data
• View
The permissions will be similar to record-level
permissions set for earned value reports or non-
workflow business process. You can select an activity
sheet or multiple activity sheets, right-click, and select
Permissions. This action lets you assign permissions to
multiple groups and users.

Audit Log The Audit Log tab in the Activity Sheets log captures the
following events:
• Creation of the sheet.
• Update of the activity sheet properties, including the

data date and activity sequence numbering field.
• Cost Sheet roll up of costs (in the future).
The Audit Log tab will be available for the activity
sheets that are created manually.
The Audit Log tab provides the following details
regarding the events that have taken place in the
Activity Sheets log:
• Date
• Event
• Action
• Field Name
• Old Value
• New Value
• User Name
• Proxy User
You can use the toolbar options in the Audit Log tab to
refresh the list on the page, print (including exporting
the list to CSV or Excel), and search and find an item in
the page.
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Tab Name Description

History This tab contains the history information about an
activity sheet, based on:
• Action
• Requestor
• Initiated On
• Start Date
• End Date
• Status

Creating a Manual Activity Sheet

The manual activity sheet is mainly used for projects (such as building owners projects) that do
not use a P6/Oracle Primavera Cloud and Unifier integration, and the project schedule is
simple.

You can create an activity sheet, manually, in the Activity Sheets log (User mode), and if you
have the following permissions, the Activity Sheets log displays the following options, in
addition to the other options:

• Receive and send the scheduling and resource data into an activity sheet from P6 or
Oracle Primavera Cloud

• Create activity sheets both manually and through synchronization with P6 or Oracle
Primavera Cloud

Create

If you have the Create Manual Activity Sheets permission, or the Full Access permission,
you will see the Create option.

If only the standard activity attribute form is defined but not manual activity attribute form, the
Create option is not displayed.

Get Data 

Get Data into System Activity Sheet

If you have permission to use Get Data only, you will see the Get Data option.

The Get Data synchronization that created the activity sheet also populates the activity sheet
with the:

• Scheduling data (activities along with assignments and spread data) from the P6 projects
mapped to the current shell in the Integration tabs (Gateway Integration for P6 and
Primavera Cloud Integration for Oracle Primavera Cloud).

• Role and resource rates data from the Master Rate Sheet for the mapped projects.

Subsequent updates of CBS Code, Role Rate, and Resource Rate in P6 will not trigger the
update of the CBS Code (in the Activity Sheet) and Role Rate and Resource Rate (in the
Master Rate Sheet) in Unifier. This is to prevent data in Unifier from being overwritten by
updates in P6.

Send Data 

Send Data from System Activity Sheet
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To create an activity sheet, you must use the Create option.

Note

The Get Data and Send Data options are used to create a System Activity Sheet.

To create a manual activity sheet:

1. In the Activity Sheets log, select Create to open the Create Activity Sheet window.

2. Proceed to name the manually created activity sheet, determine the status, select a
calendar, select the source for the project schedule start date, select the schedule start
date, data date, and the activity sequence number.
The Time Zone and Schedule Type selected in the properties will be saved and cannot
be reverted. The Time Zone defaults to the time zone indicated in the User Preference,
and the Data Date defaults to the Project Schedule Start Date.

3. When you are done, select Create, and select Yes when the confirmation message
appears.

The following explains the Create Activity Sheet window fields and block:

Name

Use this required field to specify the name of the activity sheet. The name specified should be
unique. Also, do not use "System Activity Sheet" as the name. The field supports names of 150
characters or less.

Description

Use this long-description field to describe the activity sheet. This field supports alphanumeric
characters, as well as all special characters, and can be up to 400 characters in length.

Status

Use this field to make an activity sheet active or inactive. The default status is Active. The
activity sheet can later be set as active or inactive through the properties screen. Only the
active sheet data will be rolled up to other cost modules like Cost Sheet, EVM Sheet, Cash
Flow, and so on.

Calendar

This field lets you select any calendar for the project schedule. You cannot deselect the
calendar from the drop-down, but you can change the selected calendar.

This field has the following options to select from:

• Standard (24x7 Calendar or Company Calendar)

• Project / Shell (Project/Shell Calendar)

• Custom (Custom Calendar)

The 'Project/Shell Calendar' is the default value.

The drop-down field lists all the calendars that have been defined at the Custom Calendars
node, in the project/shell and company calendars (as defined in Standards & Libraries).

Select Project Schedule Start Date Source

This field lets you select a manual start date, or the start date in the shell properties, for your
project (project schedule start date).
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• Manual

• From Shell Attribute

This field is identified as the start date for the project schedule as defined in the activity sheet.

The project schedule start date can be entered manually by selecting the Manual option or by
using the shell attribute: uuu_project_start_date. This is a required field in the activity sheet
properties.

If it is selected as manual, you must provide a start date to be able to save the activity sheet
properties.

The second option, From Shell Attribute, will populate the start date on the activity sheet by
using the targeted project start date (uuu_project_start_date) on the project/shell properties
which in turn can be received from the project creation business process.

Any change in the project start date in shell properties will automatically update the activity
sheet start date. Synchronous update to the activity sheet takes place if there is no activity
which is either in-progress or has been completed.

Schedule Start Date

If you select Manual in the previous field, this field lets you enter a specific start date for the
project schedule.

Time Zone

The field defaults to the User Preference time zone. This time zone is used when saving the
activities date and time within the sheet. The users or groups who have view access to this
sheet will see the activity dates and times based on the specified time zone.

Data Date

This field displays the date that the project can be scheduled. This date can be the same as
the project start date, for initial schedules. The value in this field will populate the data date for
the scheduled activity sheet. Initially, the value is the project start date, if no schedule has been
run.

Schedule Type

The value in this field is used to determine the activity schedules (as resource-based or cost-
based) when the activity data is sent to the Cash Flow. The values can be: Duration or
Resource. The default setting is Duration, which renders the field read-only because cash
flow only supports a duration-based schedule.

Assign Rate Sheet

Use these optional fields to select Rate Sheets for a project. The system will use the resource
or role rates from the selected Rate Sheets for both Planning and Actuals to calculate the
Planned, Actual, At Completion, and Remaining Costs.

• Rate Sheet (Planning)

• Rate Sheet (Actual)

If a Master Rate Sheet is defined at the Company level, by default, the resource or role rates in
the activity sheet are retrieved from the Master Rate Sheet and applied across all the projects.
If the Master Rate Sheet is selected, the following guidelines apply:

• The system pre-populates the Rate Sheet (Planning) and Rate Sheet (Actual) lists with
Master Rate Sheet, which lets a Project Manager assign resources or roles and perform
resource management.
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• To get the project rates for assignments, users can assign any Rate Sheet that they
defined at the project/shell level.

• If the assigned Rate Sheet selection is removed from the Activity Sheet properties, the
system defaults to using Master Rate Sheet so that recosting is be done based on rates
defined in the Master Rate Sheet.

Note

When an Activity Sheet is created from a shell template, the Master Rate Sheet (if
it exists) is also assigned by default.

If a Master Rate Sheet is not defined at the Company level, the following guidelines apply:

• The system allows creation of Activity Sheets, and the Project Scheduler can be used to
define the activities and their schedules.

• The Assignments tab will be visible, but users cannot add resources and roles.

• If a user accesses the Recost option from the gear menu ( ), the following message is
displayed: "No Rate Sheet is assigned to the selected Activity Sheet to calculate costs."

Activity Sequencing Numbering (block)

To define the sequence number for the Activity ID while defining activities or tasks in the
activity sheet.

The following required sub-fields are available:

Activity Id Prefix (a letter value)

To define the sequence prefix which can be a sequence of characters. The limit on the number
of characters will be between 1 to 20. This is a required field, and the default value is 'A.' The
field allows alphanumeric characters.

Activity Id Suffix (a number value)

This field defines the suffix for the Activity ID. It allows integer digits from 1 to 6 characters
long. The range will be between 1 to 999,999. No negative and decimal values are allowed.
The default value will be 1000.

Increment (a number value)

To define the increment that each activity sheet can be incremented. It allows only integer
digits from 1 to 1000. The default value is '1.' No negative and decimal values are allowed. The
system shows the unique ID for each activity sheet that is defined.

Example

Prefix of A combined with the suffix of 1000 with default increment as '1' would show the
activity IDs as A1000, A1001, and so on.

The above activity sequencing format will be retained for all new activities that get created
within the Sheet. Any activities that get imported from an external source (MPP or P6 XML) or
CSV import then the activity ID column will show the imported IDs if provided otherwise would
use the activity sequence defined in the sheet properties to generate a unique Activity ID for all
the activities that are imported.

You can change the activity sequencing anytime from the properties window. All the new
activities will retain the new sequence format, if the activity sequencing is changed. Any
changes to the activity sequence numbering fields will be audited (Audit Log).
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Technique for computing Estimate to Complete (ETC)

The technique for computing Estimate to Complete (ETC) is available when you are:

• Creating an activity sheet, or
An ETC user value will be added for the user to select the ETC technique, as explained
below.

• In the activity sheet properties (see Manual Activity Sheet Tabs for details on activity
properties).
An ETC user value will be added for the user to select the ETC technique, as explained
below.

By default, the ETC technique for the activity sheet is applicable for all the WBS codes and
Activities, unless there is a different ETC technique for the WBS or Activity.

The ETC drop-down will have the following values:

1. ETC = remaining cost for the activity, the default setting

2. ETC = [PF*(Budget at Completion- Earned Value Cost)]
PF = 1

PF = 1/CPI

PF = 1/(CPI * SPI)

PF = user defined value

After creating the activity sheet manually by defining the properties, the system creates a
default activity sheet. You can then update the activities. (If an activity sheet was created by
integration, it contains activities that you can subsequently update.)

The Activity Sheets page contains the following sections:

• Toolbar

• Log

• Properties tabs. The Properties tabs include Preview, Permissions, Audit Log, and History.

Note

In the process explained above, the Project Start date (Start) and Project Finish
Date (Finish) fields (columns) will not be seen in Unifier version 20.12 or later.

Manual Activity Sheet Default

When you create an activity sheet, after defining the activity sheet properties, the system
creates a default activity sheet.

You can populate the newly created activity sheet by way of opening an existing activity in the
log.

Note

In the process explained above, the Project Start date (Start) and Project Finish
Date (Finish) fields (columns) will not be seen in Unifier version 20.12 or later.

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 580 of 671



In the newly created activity sheet:

• Project Start Date
Displays the earliest date of all the activities. In the case of a blank activity sheet, the
scheduled start date will be the project start date.

• Project End Date
Displays the latest date of all the activities on the activity sheet. In the case of a blank
activity sheet, the scheduled start date will be the project end or finish date.

The following explains the first five columns displayed in a created activity sheet, in the grid
section of the activity sheet:

• Row Number
Displays the row number and errors, if any. This is a read-only column, with a sequential
number starting from 1 (one).

• Activity ID
Displays the activity ID for each added activity sheet. The system uses the default
sequence number specified in activity sheet properties to populate the activity ID. You can
edit the column and enter custom activity ID for a selected activity sheet. This is a required
field and only alphanumeric characters are allowed. Verify that no special characters are
entered when defining the activity ID.

• Activity Name
Displays the name of the activity sheet. This is a required field and alphanumeric
characters are allowed.

Note

The attachments and notes features will not be seen in the activity sheet in Unifier
version 20.12, but are available in version 21.12 and later.

A default lock will be seen after the first three columns.

• Attachments
Displays the attachment icon. You can add attachments to the activity sheet in the
Attachments tab (in the right pane or dock bottom pane).

• Notes
Displays the notes icon. You can add notes for the selected activity sheet in the Notes tab.
The functionality will be the same as in the CBS rows. This functionality will allow you to
enter the notes. For example, you can use notes to specify the reasons for the change of
the activity sheet dates or duration from the initial baseline.

All the other columns are displayed in their defined order, followed by the Notes column. If
there is no attribute form defined (for manual activity sheets), all the P6 data elements (uuu_P6
data elements) are displayed as columns.

Manual Activity Sheet

When you open an activity sheet, the Activity Sheet window opens. The Activity Sheet
window contains:

• Toolbar options, including the view options (Baseline Project View or Current Project View),
if applicable

• Columns grid
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• Activity properties (presented in the General, Dependencies, Notes, and Audit Log tabs,
below the columns grid).

Each row in the Activity Sheet window contains an activity. Each activity has a gear menu
( ) that lets you:

• Add Activity

• Duplicate

• Add Milestone

• Delete

• Apply CBS Code to All Assignments

• Copy

You can use the toolbar options in the Activity Sheet window to:

• Add a rate sheet to the project.

• Schedule the project.

• View, create, edit, and manage log views.

• Filter information by project.

• Switch between schedule types (current or baseline) of the project.

Manual Activity Sheet Toolbar Options

The following table explains the manual activity sheet toolbar options:

Option Description

 Add To add a new row. The row will have the Activity ID field
value pre-populated with the sequence number
specified in the activity sheet properties. The Activity
Name field is displayed as required and other required
columns will be highlighted with a red triangle on the
right corner. Upon selecting Save All, the required fields
will show as errors in the first column (similar to
manage rows in the cost sheet).
• If you select an activity and select Add, the new

activity row will be created after the selected
activity.

• If you do not select an activity and select Add, the
new activity row will be created after the selected
activity.

• If you do not select any activity, the new activity row
will be created at the very end.

Note

The activity sheet shows the
flat list of activities. Any user
with edit permissions would
be able to add and update the
activities to the activity sheet.
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Option Description

Schedule When you open an activity sheet, the activity sheet
details page will be displayed. On this page, when you
select Schedule, select a Data Date, and select Schedule
Now, the log (upper-right corner) displays a check-mark

icon ( ) which indicates the status of the schedule as
completed. You can select the icon to open the History
Log and review the details of scheduling that have been
done to the activity sheet. The Schedule option, in an
activity sheet, is similar to the scheduling option in P6.
You can use the Schedule option to:
• Apply selected data necessary for scheduling the

project.
• Schedule activities based on Data Date value. When

you select Schedule, the Schedule window opens
which lets you select a date (from the Data Date
field) and select Schedule Now to initiate the
scheduling process.

• Schedule activity sheet after you added activities
and updated activity schedule (such as planned,
actual dates, duration, and so forth).

• Remove activities. Upon removal of activities, all the
dependent activities will be rescheduled based on
the Data Date value specified in the schedule.

Additional information about the Schedule option:
• If you select Schedule in a blank sheet, the system

displays this message: There are no activities in the
sheet to be scheduled.

• Scheduling more than 2000 activities will take time
to complete.

• Any unsaved changes to the sheet will be lost after
the scheduled refresh.

• The activity sheet data will be refreshed after the
schedule completion.

• When you open an activity sheet, from the Activity
Sheets log, the activity sheet details page will be
displayed, and when you select Schedule, select a
Data Date, and select Schedule Now, on the activity
sheet page (upper-left corner) the Schedule Status

icon appears (a green dotted circle with a check
mark) which indicates the status of the schedule as

completed. You can select Schedule Status  to
open the History Log and review the details of
scheduling that have been done to the activity sheet.

• As a part of scheduling, you can use the History Log
(also available under Menu Options) to view a lot of
the actions that have been performed on the activity
sheet.

The following actions will be performed as a part of
rescheduling:
• If the activity start, finish, duration, calendar, or

predecessor changes, the system reschedules the
successor activities (based on the data date).

• If the activity is in progress, the system calculates
the remaining duration of the activity (based on the
data date) and recalculates the successor activities
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Option Description

start and finish dates (if not started). The system
also calculates the remaining duration for all
incomplete activities (based on the data date).

• The system moves the activities or tasks that are not
finished (based on the data date). This happens even
if the expected finish date is earlier than the data
date. The system retains the relationship logic for
the dependent activities, for example, the system
recalculates the start and finish dates for the
successor activities.

• The system retains the schedule logic. The system
moves the activities that are in progress and
activities that are incomplete (with finish date
earlier than the data date) to the data date which
makes the activities the first tasks that must be
completed. This also moves the start date of the
successor activities to a future date, based on the
Lead/Lag time and relationship.

• The system recalculates the Float value for all the
activities, according to the schedule.

• The system recalculates the Critical Path based on
the changes in the duration or dates of the activities.
The Critical Path is determined by the activities that
contain a Total Float of zero.

After Resources or Roles have been assigned to
activities, you must:
• Enter the progress and then recalculate the

assignment costs.
• Use Schedule to calculate both the Remaining units

or costs as well as the At Completion units or costs.
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Option Description

View To create a view or manage the existing views. You can
create and manage views in the activity sheet by using
the following options:
• Default
• Create New View
• Manage Views

Note

If a view is linked from the
template, you cannot delete or
modify it. If you created the
view, you can modify or
delete it.

You can also add activities and change column structure
in the Default view.
Same as in the System Activity Sheet, the View drop-
down list displays the system-defined view Default and
WBS View, by default.
Similar to the other activity sheets, the data creation
(both rows and columns) will be available in the default
view.
The View field lets you create the WBS View which
displays all the activities based on WBS codes in one
screen as well as the roll-up data for each WBS. In this
view, similar to the default view, you can add an activity

(select the gear menu [ ], and then select Add Activity)
under a WBS code and add information such as the
activity name (select in the Activity Name cell) and so
forth, such as units and duration. The newly created
WBS code can be dragged and dropped under a
different WBS. The roll-up, in this scenario, will be
calculated automatically.
You can use the default view, or the custom view, to add,
update, delete, link, unlink activities, milestones, and
scheduling.

 Edit View To open the Edit View window and:
• Select a name for your view (View Name).
• Access tabs
The list of tabs:
• Columns tab: To set the contents of columns and

lock columns.
• Filters tab: To set filters on activity attributes. For

example, WBS Code can be set to contain, or not
contain, a certain value.

• Group By tab: To group activities.
• Sort By tab: To sort activities.
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Option Description

Actions To conduct the following:
• Create Baseline, if not available
• Update Baseline
• Apply CBS Code to All Assignments
• Link Selected Activities
• Unlink Selected Activities
You must have Edit Data permission for the manual
activity sheet to be able to use these options.
Use the Create Baseline option to create the baseline
data for the project schedule defined in the activity
sheet. After you create the baseline, the Update
Baseline option appears in the Actions list, which lets
you update the baseline view with the latest data and
date. In the Baseline Project View, the window title
shows the name that is given while creating the
baseline, and the baseline creation date is shown on the
right corner. This date retains the date preference set
for the logged in user. Within the Baseline Project
View, you can update and assign Cost Codes. The
remaining fields are read-only and contain the current
project data including CBS and WBS assignments. If you
switch to the Current Project View, you can manually
update additional fields.
You can view the activity sheet details in the General
tab.
The creation date is populated with the current date.
The baseline name defaults to the project schedule
name.
Use the Update Baseline option to update the baseline
data for the project schedule defined in the activity
sheet. This option becomes available after you create a
baseline.
If there are no baselines, the Update Baseline option
will be replaced by Create Baseline. You can navigate to
the Project Baseline view by selecting Switch to
Baseline Project View (this function is similar to the
System Activity Sheet, after the baseline is created).
You can export all the activities by selecting Menu
Options, selecting Export, and then selecting All
Activities.
Use the Link Selected Activities to link multiple activity
sheets. The selected activity sheets are linked with the
default relationship (Finish-to-Start) if no relationship
exists. For more information, see Dependencies Tab.

Use the Unlink Selected Activities to unlink multiple
activity sheets.

 Refresh To update the information displayed on the screen.
If there are unsaved changes in the activity sheet and
you select Refresh, your unsaved changes will be lost.
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Option Description

 Print To print the information displayed on the screen. Your
other options are:
• Print
• Export To CSV
• Export To Excel

Note

– For export to Microsoft Excel, the
system currently supports only Euro
(EUR) and United States Dollar (USD)
currency symbols.

– If you export data from a business
process (BP) record, sheet (such as an
Activity Sheet), or log (such as
Company Funding Sheet Log) to Excel,
be aware that depending on how your
negative values are formatted, you
might need to configure your columns
in Excel to match the correct data type
(Number). Otherwise, the columns will
not be treated as numeric and will not
sum as expected. One supported
format includes placing the negative
sign between the currency symbol and
the amount (for example, $-1,000).

 Find on Page To find items on the displayed page. When you select
this option, the system inserts a row that lets you enter
filter parameters.
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Option Description

 Menu Options All the existing export and import options available for
CBS Code activities and assignments will be seen in the
Menu Options. Additionally, the same import options
are also available in the Baseline Project View.
Depending on your permissions, the Menu Options
option lets you:
Export
- Activity Details
- All Activities
Use Activity Details to export the CSV template with
activity attributes defined in uDesigner.
All the columns seen in the activity sheet will be
exported.
The order of columns seen in the CSV template is the
same as in the activity sheet.
The Required columns will show additional required
symbol in the CSV template.
All the existing activities details will be exported.
Use All Activities to include all the activities.
Import
- Activity Details
Use Activity Details to import the activities and add
new activities if activities do not exist. When you select
this option, the existing activities in the sheet will be
exported to CSV template.
View History Log
To open the History Log to see the following:
• Action
• Requestor
• Initiated On
• Start Date
• End Date
• Status
Dates and Numeric values displayed in tooltip are based
on the user preference set at company-level.
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Option Description

 Gantt Select Gantt to associate a Gantt chart with an activity
and see the baseline comparison (Baseline Comparison
icon). You can select the Grid icon to return to the
previous view.
To split the screen and view the Gantt chart.
If applicable, the following toolbar options will be
displayed:

Grid

Focus Activity 

Baseline Comparison 
Lets you see the baseline bars along with current
activities. The relationship between the current
activities will also be seen.
Use the Baseline Comparison option to compare the
current project dates and costs with the baseline dates
and costs and highlight the cells where:
• The activity progress is not as expected, or
• The activities are delayed (comparing to the

baseline).
The link to view the baseline data will be seen only
when the baseline is created successfully.
You can view the schedule comparison of current
project data with baseline data by way of selecting the
Menu option and then selecting Baseline Comparison.
When you select Baseline Comparison, the Baseline
and Current Project Comparison window opens. This
window displays all the activities comparing the
schedules based planned, actual, remaining dates, and
other dates. Variance will show the number of days the
activity has been delayed, and the number of days the
activity has started ahead or on time.
By default, all the columns within the current activity
sheet will be compared with the baseline. This is shown
as Default view. The View option lets you filter the
columns that can be seen. You can filter the columns
that can be seen in the Baseline and Current Project
Comparison window by navigating to Views, creating a
view, and filtering the columns displayed.

Critical Path 
The critical path calculation follows a standard
mathematical algorithm known as the Critical Path
Method (CPM). The CPM lets you calculate the starting
and ending times for each activity. CPM determines
which activities are critical (uuu_float = 0) to the
completion of the project (called Critical Path) and
reevaluates activities with uuu_float values. The tooltip
for the current activities will show the current and
baseline dates, and the variance in number of days
between the baseline start and start dates.
The options above let you access a visual representation
of the activity-related processes.
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Option Description

The Show drop-down field will be editable after you
select Gantt from the toolbar. This drop-down has the
following options:
• Default Gantt
• Critical Path
• Baseline Comparison

Project View options (Baseline or Current), if applicable Depending on whether a baseline has been set, the
following additional links will also be present in the
activity sheet page, or in the sheet:
• Switch to Baseline Project View (from project

view): To see the baseline for the project.
• Switch to Current Project View (from baseline

view): To add activity and change the activity
schedule.

Manual Activity Sheet Gantt View

The Activity Sheet node supports the manual Activity Sheets to define project schedules. To
be able to view the activities and the relationship between the activities and their associated
resources that define the project schedule, the system provides the option to view the Gantt
chart (bar chart) in the manual Activity Sheets.

The Gantt chart provides a representation all the activities of the project in a timeline view, the
amount of time each activity is expected to take, the time frame in which an individual task has
to be completed, and the relationship between various activities.

The Gantt chart can be launched from both the System Activity Sheet and the Manual Activity
Sheet (the Gantt option from the toolbar).

After you select Gantt, the right pane will show the Gantt representation of the project
schedules, and you will be able to view and perform the following functions:

• Show project schedules activities in a Gantt mode.

• Zoom in or zoom out to view the details of the activities and links.

• Show dependencies between activities (predecessors and so forth).

• Show assigned resources by category.

• Show percent (%) complete for each activity to monitor the progress of the activities.

• Allow changing the activity durations by dragging the bars.

• Allow moving activities from one time frame to another (modifying start and end dates at
the same time).

• Allow critical path calculation and viewing activities in the critical path.

• Show tooltips for the activity, link, and milestones.

Increasing duration of activities and moving activities

In Gantt view, you can move the activities (tasks) that do not start ahead of the schedule. The
selected activity start and finish dates are updated along with duration. When you select the
schedule option from the toolbar, the successor activities start and finish date will be updated
along with the current updated activity according to the new data date, and the Gantt view will
reflect the changes in activity start and finish dates. The tooltip will show the updated start and
finish dates, duration, and so forth upon selecting the activities.
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You can increase or decrease the duration of the activity using drag-and-drop of the selected
activity. In this scenario, the duration and the Finish Date values will be updated accordingly,
for the selected activity.

The following shows the basic keyboard shortcuts for moving activities:

• Tab: Tab to the Gantt view and use the arrow keys to navigate to the task you want to
move. You can select multiple tasks and move them together.

• Ctrl + m: Select "Ctrl + m" to enter into the move mode. Use the left arrow and the right
arrow keys to move the activities (tasks) horizontally, and use the up arrow and so keys to
move the task(s) to different rows.

• Enter: Enter to finalize the move and exit move mode, or Esc to cancel and exit move
mode

To perform task resize, use:

• Alt + s

• Alt + e

Manual Activity Sheet Columns

The activity details are presented in columns. The columns are displayed in the order defined
in uDesigner, followed by the Notes column. If there is no attribute form defined (for manual
activity sheets), all the P6 data elements (uuu_P6 data elements) are displayed as columns.

You can change the default view by creating and managing custom views in the View drop-
down list.

Note

The attachments and notes features will not be seen in the activity sheet in Unifier
version 20.12, but are available in version 21.12 and later.

Columns Description

Sequence No. This is a read-only column, with a sequential number
starting from 1 (one).
The numbering sequence of activities. The column cells
are pre-populated with the sequence number provided
in the activity sheet properties. The sequence number is
a unique value.
This column displays the row number and errors, if any.
To select an activity, select inside the corresponding
Sequence No. cell.

Group By Grouping activities according to shells.
Select the plus (+) or minus (-) symbols to expand or
collapse grouped activities.
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Columns Description

Activity ID
<label of the uuu_P6ActivityID>

The activity identification number for each added
activity sheet, starting with letter "A".
The Activity ID column shows color icon-based on the
activity status and the activity type. For example, the
green rectangular icon indicates that an activity has not
started, the yellow rectangular icon indicates that an
activity is in progress, the light green rectangular icon
indicates that an activity is completed, and the diamond
icon indicates that an activity is milestone activity.
The system uses the default sequence number specified
in activity sheet properties to populate the Activity ID.
You can edit the column and enter custom activity ID for
a selected activity sheet.
This is a required field and only alphanumeric
characters are allowed.
Verify that no special characters are entered when
defining the Activity ID.
You can edit the Activity ID column data.

Activity Name
<label of the uuu_P6ActivityName>

The name of the activity sheet.
This is a required field and alphanumeric characters are
allowed.
You can edit the Activity Name column data.
You must specify the activity name. All the
alphanumeric characters are allowed for the activity
name.

Attachments The column with the attachment icon.
You can add attachments to the activity sheet in the
Attachments tab (in the right pane or dock bottom
pane).

Notes If available, notes related to the activity.
You can add notes for the selected activity sheet in the
Notes tab.
The activity sheet window, or page, also contains a
Notes (paper and paper-clip icon) column that indicates
whether and activity sheet has a note (entered from the
Notes tab in the properties pane), or not.
You must have permission to be able to post notes.
The functionality will be the same as in the CBS rows.
This functionality will allow you to enter the notes. For
example, you can use notes to specify the reasons for the
change of the activity sheet dates or duration from the
initial baseline.

The following shows a list of typical column headings in the Activity Sheet window (the default
layout):
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Columns Description

Start
<label of uuu_P6StartDate>

The start date for the activity.
This column is populated with the project start date by
default. You can edit the date by selecting date picker in
the column. You can edit the date before or later but
cannot move the date before project start date.
For Activities that are 'In Progress' and 'Completed,' the
start date will be the Actual Start Date
(uuu_P6ActualStart).
For new activities, once the project is scheduled on
certain data date, the new activities start date will be by
default the data date.
Upon scheduling, if the activity is still not started as per
the 'Data Date,' then the activity will be rescheduled
according to the data date.

Finish
<label of uuu_P6FinishDate>

The finish date for the activity.
This column is populated with the project start date by
default for activities with status 'Not Started'. You can
edit the date. When the activity sheet is not scheduled,
the 'Data Date' will be the project start date.
For activities that have been created after the activity
sheet is scheduled (on certain data date), the finish date
will be defaulted to the start date which is the 'Data
Date'.
For Activities that are 'In Progress' and 'Completed,' the
finish date will be the date from Data Date plus
duration. When an activity sheet has not been
scheduled, the 'Data Date' will be the project start date.

Duration
<label of uuu_P6Duration>

The duration of the activity.
This column is populated with duration as one (1) day by
default for regular Tasks/Activities and duration as 0 for
the milestone activity. Duration will be updated by
means of finish date changes or user can manually
update the duration column. Finish date will be
calculated accordingly.

At Completion Duration The total working time from the activity start date to the
activity finish date.

Planned Start The scheduled start date.
Planned Finish The scheduled finish date.
Planned Duration The scheduled duration of the activity.
CBS Code The Cost Breakdown Structure code.
Calendar The calendar type that has been used.
WBS Code The Work Breakdown Structure code.
WBS Name The Work Breakdown Structure name.
Activity Status
<label of uuu_P6ActivityStatus>

The default 'Not Started' will be displayed, and the
activity icon (seen before the activity ID) will be in blue
color, for not started activities. When the Activity
Status changes to 'In Progress' or 'Completed' (based on
the activity actual start date and finish dates), the color
of the Activity ID will be changed accordingly.
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Columns Description

Activity Type This column is populated with the default value of 'Task
Dependent.' You can select other values such as 'Start
Milestone' which will automatically the task to
milestone with 0 (zero) duration days and 'Resource
Dependent' which will preserve the calendars of the
associated resources/roles. Resource Dependent
activities adjust to resource calendars when resources
are assigned.

Planned Start Date
<label of uuu_P6PlannedStart>

This column is populated with the default value of Start
Date (uuu_P6Start) for the activities with status 'Not
Started'. When the project is scheduled by using project
scheduler, the values for the Start and Planned Start
Date will move to the Current Data Date, if they are
past dates.

Planned Finish Date
<label of uuu_P6PlannedFinish>

This column is populated with the default value of
Finish Date (uuu_P6Finish) for the activities with status
'Not Started'. When the project is scheduled by using
project scheduler, the values for the Start and Planned
Finish Date will be the Planned Start Date plus
Duration.
The task dependent activities base their duration on the
working and non-working days of the activity calendar,
but the resource dependent activities base their
duration on the working and non-working days of the
assigned resource's calendar.
When multiple resources are assigned, the Finish Date
of the activity will be based on the time required by the
last resource it will take to finish the same task, based
on the resource calendar.
You can edit the Duration column value in the activity
sheet. This field will allow only integer-type data with no
negative values.

Note

The calendar that you select
for each activity will be used
to calculate the finish date.

Milestone When the activity type is selected as 'Milestone,' the
system designates the activity as a milestone activity.
The duration of a milestone activity is always 0 (zero).
You cannot update the duration for milestone activity.
The Activity Status for a milestone-type activity can have
only two values: 1) 'Not Started' and 2) 'Completed.' The
default value is: 'Not Started.'

Manual Activity Sheet Tabs

When you open an activity from the list of activities, when available, a series of tabs can be
accessed from the bottom of the window, or page, as shown below:
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The following explains the activity sheet properties tabs:

General

The General tab provides information about Activity Name, Start date, Finish date, and so
forth.

Assignments

The Assignments tab lets you view the resources and roles assigned to the activity selected
in the main grid. See Assignments Tab.

Activity Spread

In the Activity Spread tab, you can see the spread data of the selected activity. The Activity
Spread tab lets you select the values for:

• Frequency
The Frequency drop-down field enables you to select the frequency of the spread in:

– Day

– Week

– Month

– Year

• Cost & Rate Type
Enables you to select:

– All Cost Types |Direct

– All Cost Types |Indirect

– Standard |All Rate Types

Dependencies

The Dependencies tab provides information about activity predecessors and successors.
Depending on your permissions, you can use the Add option to add activities in either
category. See Dependencies Tab.

Notes

Use the Notes tab to enter comments regarding the activity; when you are finished, select
Post. You must have permission to add notes.
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Audit Log

Displays the audit details at the activity level in the following columns:

• Date

• Event

• Action

• Field Name

• Old Value

• New Value

• User Name

• Proxy User

Assignments Tab

Use the Assignments tab to view the resources and roles assigned to the activity selected in
the main grid. The costs associated with the resources allocated for an activity will be
calculated and rolled up to the Activity and WBS level summaries. The cost associated with
each resource will be calculated based on the number of total planned units * price per unit.

Note

The Assignments tab is not available for the milestones or WBS Summaries.

The following toolbar options will be available in the Assignments tab:

• Assign

– Resources

– Roles

• Refresh

• Print

– Print

– Export to CSV

– Export to Excel
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Note

* For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

* If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

• Find on page

The Assignments tab log displays the following fixed columns, as seen in the Assignments
tab for the System Activity Sheet:

• Resource Name
The Resource Name is read-only and is populated according to the assigned resource, as
defined in Master Rate Sheet regardless of the status.

• Role Name
The Role Name is read-only and is populated according to the assigned role, as defined in
Master Rate Sheet regardless of the status.

• Rate Source

• Cost Code

• Planned Units

• Actual Units

• Remaining Units

• At Completion Units

• Price/Unit (Planning)

• Price/Unit (Actuals)

• Planned Units/Time

• Remaining Units/Time

• Start

• Finish

• Duration (hrs)

• Planned Start

• Planned Finish

• Planned Duration (hrs)

• Actual Start

• Actual Finish

• Remaining Early Start

• Remaining Early Finish
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• Planned Cost

• Actual Cost

• Remaining Cost

• At Completion Cost

• Profile

All the duration columns are also displayed:

• Planned Duration

• Duration

• Actual Duration along with dates

• Remaining Duration along with dates

The system calculates the duration based on Finish - Start for all date types.

The following columns in the Assignments tab log are required:

• Start

• Finish

• Planned Start

• Planned Finish

• Planned Units/Time

• Remaining Units/Time

You can edit all the columns in the Assignments tab log except the Planned and Actuals
Price/Unit for which the value will be populated from the assigned rate sheet for the resources.
The rate displayed will be based on the current date (the rate as of the current date as an
effective date). You can edit this column only if the rate source is selected as Override.

Note

Finish dates, such as Finish, Planned Finish, and so on, must be December 31, 9999,
or earlier. If you enter a date later than that, an error occurs.

Planned Units/Time column will populate with the default number of units that the assigned
resource is available for, per hour. By default, this value will be populated from the Master Rate
Sheet. You can edit the Planned Units/Time column, which means that you can increase or
decrease the resource capacity, per hour. Only numeric values are allowed for the Planned
Units/Time. The AtCompletion units will be set to the same value as the Planned Units/Time.

Remaining Units/Time column will populate with the default number of units that the assigned
resource is available for, per hour. By default, this cell value will be populated with Planned
Units/Time but can be editable. Only numeric values are allowed for the Remaining Units/Time.

Planned Units column is editable. By default, the Planned Units will show the calculated value
which means the number of working days between the planned start and planned finish date
times, based on the Activity calendar, multiplied by the number of the Planned Units/Time.

Remaining Units is by default calculated as Number of working days between Remaining start
and Remaining end date times the number of Remaining Units/Time.
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Actual Units can be entered manually. If the Actual Units for the resource assignments is
entered manually, the Activity Status will be 'In Progress'. The actual cost will be calculated
based on the number of units per day and rate per effective date. You can enter the units
manually or through P6 XML or Microsoft Project import.

When a resource/role is assigned to an activity in the Assignments tab, the Planned Start and
Planned Finish dates will be defaulted to show the Start (uuu_P6Start) and Finish
(uuu_P6Finish) dates of the activity. The system should allow modification of these dates.

Remaining Units will default to the AtCompletion Units - Actual Units for Not Started activities.
When you enter the Actual Units, the Remaining Units will not change unless you updated the
Remaining Units manually.

When you update the AtCompletion Units, the Remaining Units will be AtCompletionUnits -
Actual Units

AtCompletion Units will be calculated as Actuals Units + Remaining Units.

The gear menu ( ) options for the resource, in the Assignments tab, vary depending on the
project type. The gear menu options are:

• Add Resource
This option enables you to open the Resource Picker and select a resource to add.

• Add Role
This option enables you to open the Role Picker and select a role to add.

• View Assignment Spread
This option (for any selected resource) displays the spread data for that resource, in a split
screen Assignment Spread of <resource> at the bottom of the window. In the
Assignment Spread of <resource> screen you can set the frequency and the cost and
rate type to see the following details for your selections. The Cost & Rate Type field
enables you to select either a Cost Type Grouping or a Rate Type Grouping.

– Period Start

– Cost & Rate Type

– Planned Units

– Actual Units

– Remaining Units

– At Completion Units

– Planned Cost

– Actual Cost

– Remaining Cost

– At Completion Cost

• Remove
This option enables you to remove the assignment and its associated costs. When an
existing assignment is removed, the resource assignment and the associated costs will be
removed and subsequently all the costs at the activity level will be recalculated based on
the updated or changed assignments list.

The additional options seen will allow the user to add new resources or roles using resource or
role picker and remove the existing assignments.

You can add the resources or roles from the activity sheet grid (right-click, select Assign, and
then select Resource or Roles). When selected, the Add Resources (a resource picker)
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window will be displayed which displays all the active resources available in the company
Master Rate Sheet.

The resource picker user interface, and the function, is same as when accessed by way of the
Assignments tab.

The resource picker will show all the resources whether they were created manually or created
through receiving from a source, such as P6. You can select one or multiple resources from the
list and contains the following columns:

• ID
Displays the ID of the resource.

• Name
Displays the name of the resource.

• Type
Displays the type of the resource. It can be Labor, Non-labor, and Material type.

• Status
Displays the status of the resource.

• Source
Will display either as Unifier or P6 currently based on the resources created in the Master
Rate Sheet.

When you assign the resource, a row will be inserted in the Assignments tab, and the following
data will be populated for that row:

• The Planned start and Planned finish date will default to the uuu_P6plannedstart and
uuu_P6plannedfinish of the activity and can be edited. Similarly, the:

– Assignments Start and Finish will be defaulted to uuu_P6Start and uuu_P6Finish.

– Remaining Start and Remaining Finish will be defaulted to uuu_P6Remainingearlystart
and uuu_P6Remainingearlyfinish of the activity.

– For an activity that is In progress, if any new assignment is added, the new assignment
will default the actual start date to uuu_P6ActualStart of the activity.

– For an activity that is Completed, if any new assignment is added, the new assignment
will default the actual start date and actual finish date to uuu_P6ActualStart and
uuu_P6ActualFinish of the activity.

• The Price/Unit (Planned and Actuals) will be populated with the standard rate, defined for
the resource in the Master Rate Sheet, and the columns are editable if the rate source is
selected as Override, similar to the System Activity Sheet.

You can assign the Rate Sheet per activity sheet in the log, and the rates defined in that
selected Rate Sheet will be retained for calculating costs for units spread. If there is no rate
defined in the assigned rate sheet on an effective date, the rate will be considered as zero (0).
The default Price/Unit will show the rate that is the earliest one, at which resource has started
(effective rate close to the start date of the assignment).

If multiple effective rates are defined for the assignment, the costs will be calculated based on
multiple rates. In this case, the Planned Cost, Actual Cost, Remaining Cost, and AtCompletion
Cost will be total of the cost spread.

The Rate Source in the Assignments tab is a drop-down field, and it is editable. You can either
pick the rate from the resource or override it for the assigned resources. You can override the
rate within the sheet. The Price/Unit will become editable if you select to override both the
Planned and the Actuals. If the role is assigned, the rate source will show Role or Override,
and the default rate (from the Master Rate Sheet) will be selected, if a rate sheet is not
assigned.
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When you select multiple activities, excluding milestones, and right-click, you can select the
Assign option, and then select Resource or Roles, which enables you to assign a source to
multiple activities. The Resource and Roles options are not available if you select multiple
activities, including milestones.

When you copy an activity (select the activity, and select Copy), you have the option to also
copy the assignments and dependency information, if you need. You can select any activity to
copy, regardless of the Activity Status.

Note

When you select Duplicate from the gear menu ( ), the activity details will be copied,
along with assignments and dependencies.

Fixed Duration

The duration type field will default to Fixed Duration in the Activity Sheet Properties.

If the duration type data element is included in the activity attributes, or the activity sheet is
created using the standard method or without Activity Attribute Form, the value for the following
columns in the Assignment tab will be as if duration type selected as Fixed Duration, by
default.

• Units

• Duration

• Units/Time

The following table details the behavior of duration and unit data elements in the activity sheet
and the Assignments tab.

Field Activity Level when Activity %
Complete entered/updated

Resource Level when Activity %
Complete entered/updated

Start Start Date of the Activity. When
checks it becomes the Actual Start
and will set the Actual Start for all
Resource Assignments.

Start Date of the Activity. When
checks it becomes the Actual Start
and will set the Actual Start for all
Resource Assignments.

Finish Defaults to 8 units after the start
date. If changed then the Planned
Duration will be recalculated as
Finished - Started.

Defaults to 8 units after the start date.
If changed then the Planned Duration
will be recalculated as Finished -
Started.

Activity % Complete You must manually update or enter
a value.

You must manually update or enter a
value.

Planned Duration Defaults to the Finished - Started.
When changed it will change the
Finished date to Started + Planned
Duration.

Defaults to the Finished - Started.
When changed it will change the
Finished date to Started + Planned
Duration.

Actual Duration Actual Duration will be calculated
whenever the project is scheduled
based on the Data Date - Actual Start
Date.

Actual Duration will be calculated
whenever the project is scheduled
based on the Data Date - Actual Start
Date.
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Field Activity Level when Activity %
Complete entered/updated

Resource Level when Activity %
Complete entered/updated

Remaining Duration Remaining Duration calculated as
Planned Duration - ((1-Activity %
Complete) * Planned Duration). This
can be edited and will recalculate
the Activity % Complete. (Planned
Duration - Remaining Duration) /
Planned Duration.

Remaining Duration calculated as
Planned Duration - ((1-Activity %
Complete) * Planned Duration).

At Completion Duration At Completion Duration is Actual
Duration + Remaining Duration.

At Completion Duration is Actual
Duration + Remaining Duration.

Planned Units Planned Units is calculated as
Planned Duration * Planned Units/
Time.

Planned Units is calculated as
Planned Duration * Planned Units/
Time.

Actual Units Actual Units can be rolled up from
the resource assignments or can be
entered manually. If entered
manually then the values are pro-
rated across the assignments if the
assignment has an actual start date.

Actual units will not be updated and
can be entered manually. These will
then be rolled up to the Actual Units
at the Activity level.

Remaining Units Remaining Units calculated as
Planned Units - ((1-Activity %
Complete) * Planned Units). This can
be overridden and entered
manually. If entered manually then
the values are pro-rated across the
assignments remaining units.

Remaining Units calculated as
Planned Units - ((1-Activity %
Complete) * Planned Units). This can
be overridden and entered manually.

At Completion Units At Completion Units is Actual Units +
Remaining Units.

At Completion Units is Actual Units +
Remaining Units.

Dependencies Tab

Use the Dependencies tab to:

1. Link one or more activities.

2. Define relationship between activities.

You can also enter predecessor dependencies between a selected activity and another activity.
The dependency relation is used to automatically shift activity dates forward or backwards
based on changes to the predecessor. This is also reflected in the Gantt chart.

In the predecessor section, you can add predecessor activities, in bulk, by using the Add
option in the predecessor section. In the successors section, you can add the successors, in
bulk, to a selected activity by using the Add option in successors section.

Predecessors block

ID

The ID column displays the activity ID of the predecessor for the current activity. The ID column
is added by way of the Add option, in the toolbar. This field is editable, and you can change the
activity ID. If you enter a value in the ID column in the grid and that activity ID does not exist,
the system displays an error message. You can only enter alphanumeric characters in the ID
column.

Activity Name
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The value in the Activity Name column is populated with the activity ID that was entered. This
is a read-only column in the grid, and you cannot enter or edit the Activity Name column
value.

Relationship

The following relationship types are supported:

• Finish-to-Start

• Finish-to-Finish

• Start-to-Finish

• Start-to-Start

Lead/Lag (days)

The Lead/Lag (days) column enables you to specify the number of days the activity can start
ahead (lead), or delayed (lag), by mentioning the number of lead or lag days. This is an integer
type field which allows both the negative and the positive integers.

The lead days will be provided by specifying the negative number, and the lag days can be
provided by specifying a positive number (specifying the days that the successor activity can
be delayed to start).

When you select Add, a picker with a list of all activities that were defined in the activity sheet
will be displayed. This list does not include activities which are successors and current activity.
Can select one or multiple activities as predecessors. The default relationship shown in the
grid is Finish to Start after the user adds the activities.

User should be able to select the relationship between the predecessor and current activity by
choosing the relationship drop-down and lead/lag days.

The same functionality as seen while adding predecessors is applicable in the case of adding
successors in the Dependencies tab.

Successors block

ID

The activity ID column displays the activity ID of the predecessor for the current activity. This is
added via the Add action on the toolbar.

Activity Name

The value in the Activity Name column is populated with the activity ID that was entered. This
is a read-only column in the grid, and you cannot enter or edit the Activity Name column
value.

Relationship

The following relationship types are supported:

• Finish-to-Start

• Finish-to-Finish

• Start-to-Finish

• Start-to-Start

Lead/Lag (days)
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The Lead/Lag (days) column enables you to specify the number of days the activity can start
ahead (lead), or delayed (lag), by mentioning the number of lead or lag days. This is an integer
type field which allows both the negative and the positive integers.

The lead days will be provided by specifying the negative number, and the lag days can be
provided by specifying a positive number (specifying the days that the successor activity can
be delayed to start).

When you select Add, a picker with a list of all activities that were defined in the activity sheet
will be displayed. This list does not include activities which are successors and current activity.
Can select one or multiple activities as predecessors. The default relationship shown in the
grid is Finish to Start after the user adds the activities.

User should be able to select the relationship between the predecessor and current activity by
choosing the relationship drop-down and lead/lag days.

The same functionality as seen while adding predecessors is applicable in the case of adding
successors in the Dependencies tab.

Bulk Assigning WBS Code to Different Activities

You can highlight the WBS Code column for multiple activities and assign the same code to all
the selected activity sheet, by using the WBS picker.

Link Activities (Adding Dependencies)

You can link multiple activity sheets by selecting one or more activity sheets, right-click, and
selecting the Link Selected Activities option. The selected activity sheets will be linked with
the default relationship (Finish-to-Start) if no relationship exists.

The Predecessor and Successor columns in the Activity Sheet log show the activity sheets
that are linked based on the Finish-to-Start relationship of the selected activity sheets. This
setup will also reflect in the Gantt Chart.

Similarly, you can unlink the selected activity sheets by highlighting one or more activity sheets,
right-click, and selecting the Unlink Selected Activities option. The Unlink Selected
Activities option will be available only if the selected activity sheets are linked.

When you link multiple activity sheets (using the Link Selected Activities option):

• If the same relationship exists for all the selected activity sheets, the system will not update
any values.

• If the predecessor activity has been already added as successor for the highlighted row,
the system will display an error message.

• If the successor activity has been already added as predecessor for the highlighted row,
the system will display an error message.

• If you select a single activity sheet and try to link (using the Link Selected Activities
option from Actions menu), the system will display an error message.

Manual Activity Sheet Gear Menu

The following explains the gear menu ( ) options when you select a single activity. To access
an activity:
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1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Activity Manager, and then select Activity Sheet.

3. Select and open an activity sheet.

4. To the left of an activity, select the gear menu.

Note

You can add, duplicate, copy-paste, and delete the activities by using the gear
menu. Whenever a new activity is created by default, the Activity ID is
automatically populated and you must enter all the other mandatory data (such as
Name and any other required fields) to be able to save the activity details.

Option Description

Add Activity This option should not be available if you select more
than one activity row at a time.
When you select this gear menu, while highlighting an
activity, a new row will be inserted below the selected
activity.
The Activity ID will have a generated sequence number,
and you have to enter the required fields to save the
newly created activity row.
The Cancel and Save options, in the sheet, will be
enabled.

Duplicate You can select an activity and select duplicate to create
an activity with the same information.
The new activity will be created underneath the selected
activity.
All the information related to selected activity (such as
dependencies, WBS, and assignments) will be copied
into the new activity.
The Activity ID will have a generated sequence number,
as specified in properties, and you can update the
activity information.

Add Milestone Use this option to create an activity of activity type 'Start
Milestone'.
The duration of this activity will be always 0.
If you change the Change Start Date, the Finish Date
will also be updated to the same date as the Start Date
and conversely. The Duration field cannot be updated,
and it is always read-only.

Delete You can select one or more activities and select Delete to
remove the selected activities. A confirmation message
will be displayed and if you select Yes, then the selected
activities along with dependencies, assignments, and
WBS will be removed.

Apply CBS Code to All Assignments After you create a Baseline, if the Cost Breakdown
Structure (CBS) codes are missing or set incorrectly, use
this option to apply the codes to all assignments. If you
do not want to apply the same code, you can manually
update them on an individual basis.
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Option Description

Copy When you highlight the activities and select Copy from
the gear menu option, the Paste gear menu option will
become available.
Selecting Copy copies all the activities along with
dependencies, assignments, WBS, and actuals, for the
selected activities.
The other gear menu options will be seen after you select
Copy.

Paste This gear menu option will be seen only if the activities
are copied or cut.
When you select Paste, a confirmation message will be
displayed and if you select Yes, all the activities along
with dependencies, assignments, WBS, and actuals will
be copied into the destination row selected.

Manual Activity Sheet Start Date, Finish Date, and Duration

The values for the Start Date, Finish Date, and Duration columns are controlled by an
automatic formula.

• If you change the Duration, the Finish Date will change.

• If you change the Finish Date, the Duration will change.

• If you change the Start Date, the Finish Date will change.

Note

Finish dates must be December 31, 9999, or earlier. If you enter a date later than
that, an error occurs.

These fields also control the display on the Gantt chart, and their values can change when you
manipulate the activity bar, in the Gantt chart.

The Activity Status will be changed into 'In Progress' if the Actual Start Date is entered.

To edit the activity % complete (progress), you have to enter the Actual Start Date. Also, you
can change the Activity Status to 'In Progress' to change the Actual Start Date to the current
date and make the activity % complete (progress) editable.

Similarly, when an Activity Status is changed to 'Completed,' the Actual Start Date and the
Finish Date will populate with current date, and the % complete value will be: 100%.

You cannot change the Activity Status to 'Not Started' if there are values for the Actual Start
Date and % complete. To change the Activity Status, the values for the Actual Start Date
and % complete must be removed. Also, when the actual finish date is entered, the Activity
Status will be changed to 'Completed.' When the Activity Status is changed to 'Completed,'
the actual finish date will be updated.

If you clear the Start Date or Finish Date, the system displays an alert notifying you that the
fields are required. All the date columns (uuu_P6Start, uuu_P6Finish, and uuu_P6Duration)
are required columns in the activity sheet. You cannot reset the Start Date or Finish Date, and
the system displays an error message if you attempt to do so.

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 606 of 671



• If you enter a Start Date that is earlier than the Project Schedule Start Date (specified in
the activity sheet properties), the system displays the following message: "<uuu_P6Start>
cannot be earlier than Project Schedule Start Date."

• If you update the Finish Date <uuu_P6Finish> with a date earlier than <uuu_P6Start>, the
system displays the following message: "<uuu_P6Finish> cannot be earlier than
<uuu_P6Start>."

The Duration <uuu_P6Duration> and the Finish Date <uuu_P6Finish> values will change
based on the activity sheet calendar selected. The Activity Calendar drop-down field will
show all the calendars that are defined at the project level (which are located, by default, under
Custom Calendars in the Schedule Manager).

The Activity Status (uuu_P6ActivityStatus) value will be "Not Started," by default

The Start Date and the Finish Date values will show the Project Schedule Start Date,
specified in properties, by default.

The Activity Type (uuu_P6ActivityType) value will be "Task Dependent," by default. You can
update the task to "Resource Dependent' or "Milestone."

Manual Activity Sheet and CSV Template

This section covers a variety of topics related to using the CSV template to import and update
activities.

CSV Template for Activity Details

When you export the CSV template file (select Menu Options, select Export, and then select
Activity Details), the order of the columns in the CSV template matches the order of the data
elements that are added in the integration phase. You can:

• Add new activities by specifying the details for each row.

• Enter data for all editable data. The values entered in the CSV file will be ignored if that
data element is a formula column in the sheet.

• For Unifier version 20.12 and later, the CSV import does not allow activities with
dependencies and assignments.

CSV import of activities

The Activity ID is generated using the activity sequence numbering set up at properties level, if
no value is provided in the Activity ID column. You can enter only alphanumeric characters in
the Activity ID column.

You cannot leave any of the required field in an activity attributes form blank. If the CSV file
imported does not have data for all the required fields in the activity attributes form, import will
fail.

Only columns that are editable can be updated, for the existing activities. Changes to read-only
columns in the CSV file will be ignored.

The WBS Code and CBS Code for the activities can be added for new activities. For the
existing activities, the WBS Code and CBS Code for the activities can be updated.
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CSV restrictions

The data elements that are added in the Integration tab must match the names, or labels, in
the exported CSV template.

All the data elements that are defined in the Integration tab will be seen as column headers in
the CSV template. The order of the column headers are as they appear in the Integration tab.

If no integration interface is defined, all the uuu_P6 pre-defined columns will be seen in the
CSV template. In this case, the Activity ID and Activity Name will be shown as the first two
columns, followed by other uuu_P6 data elements.

The existing rows (activities) must be in the same order as currently seen in the sheet.

The Activity ID and Activity Name columns are shown as required in the exported CSV
template, along with other required fields.

During the CSV import (for creating activities), the system performs the following validations:

• Required field validations will be shown, except for the Activity ID which uses the activity
sequence specified in sheet properties. New rows will automatically generate the next
sequence and show it as a new Activity ID.

• Activity Name is shown as required in the exported CSV template. If you do not enter the
Activity Name, the "required field" error message will be displayed.

• Other than the Activity Name (uuu_P6ActivityName), the uuu_P6 data elements which are
marked as required in the design will not show as required in the exported CSV template, if
there are no default values.

• If you enter the Activity ID value in the CSV template, this input will have high priority. A
new row will be created using the Activity ID specified in the CSV template. The Activity ID
value column allows alphanumeric values only in the input CSV file.

• If no value is entered, the Activity ID will take the next auto-sequence number that is
generated. If you provide the Activity ID, a new activity is created with the value that you
enter (provided that there is no activity with the same ID in the Activity Sheet).

• If not available in the input CSV file, the default values will be used for the following
columns:

– Start Date

– Finish Dates

– Duration

– Activity Status

– Activity Type

– Calendar

• If the user did not provide any value for these columns in the CSV file, by default the value
for the:

– Activity Status (uuu_P6ActivityStatus) will be: Not Started.

– Start Date will be the project schedule start date specified in the properties.

– Finish Date will be the project schedule start date specified in the properties.

• Activity Calendar (uuu_P6ActivityCalendar) will be the default calendar, as the calendar
selected in the activity sheet properties window. If the calendar is specified in the CSV file,
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the system validates the calendar name to ensure that it is a custom calendar or a
company calendar.

• You must specify the entire path for the WBS Picker (uuu_cmwbs_picker) and CBS Picker
(bitemID) columns in the input CSV file. Check for valid WBS Code and CBS Code when
updating existing activities or importing new activities.

• All the required fields must be entered for the CSV import to be successful.

You will encounter error messages when creating activities by way of CSV import if:

• You enter a Start Date (uuu_P6Start) that is earlier than the Schedule Start Date
(act_sch_start_date).

• You enter a Start Date (uuu_P6Start) that is later than the Finish Date (uuu_P6Finish), and
conversely.

• You enter an Actual Finish Date (uuu_P6ActualFinish) that is earlier than the Actual Start
date (uuu_P6ActualStart).

• The above date-related errors will be displayed when you enter input values for the
following date combinations:

– uuu_P6PlannedStart, uuu_P6PlannedFinish, and uuu_P6PlannedDuration

– uuu_P6Start, uuu_P6Finish, and uuu_P6Duration

– uuu_P6RemainingDuration, uuu_P6RemainingEarlyFinish, and
uuu_P6RemainingEarlyStart

• You enter the Actual Start Date (uuu_P6ActualStart) that is after the current date.

• If the Start Date (uuu_P6Start) is provided in the input CSV file, but the Finish Date
(uuu_P6Finish) is not provided in the input CSV file.

• If the Finish Date (uuu_P6Finish) is provided in the input CSV file, but the Start Date
(uuu_P6Start) is not provided in the input CSV file.

• You enter a CBS Code that is currently inactive or does not exist in the Cost Sheet.

• You enter a WBS Code that is currently inactive or does not exist in the Project WBS
Sheet.

• The uuu_P6Start and uuu_p6Finish dates are different for the milestone-type activity.

You will encounter the following validations when creating activities by way of CSV import:

• The Start(uuu_P6Start) alone is provided with the Activity Name. In this case, the activity is
created with default duration 1 and finish (uuu_P6Finish) same as uuu_P6Start.

• The Duration (uuu_P6Duration) and Start (uuu_P6Start) are provided. In this case, the
duration will be calculated based on Finish Date and uuu_activity_calendar.

• The Start (uuu_P6Start) and Finish (uuu_P6Finish) are provided. In this case, the
uuu_P6Duration will be calculated accordingly.

• When the Start, Finish, and Duration values are provided. In this case, the Duration will be
calculated based on Start and Finish values.

• When you enter Actual Finish Date (uuu_P6ActualFinish) without Actual Start Date
(uuu_P6ActualStart). In this case, after the CSV import, the uu_P6ActualStart and
uuu_P6ActualFinish will have the same date, and the uuu_P6ActivityStatus will be shown
as: Completed
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Note

The error validation applies to all dates in the input CSV file.

• When you enter Activity Percent Complete (uuu_P6PercentComplete), you can enter a
value for Performance Percent Complete (uuu_P6PerfPercComplete). In this case, the
value must be between 0 and 100 (zero and one hundred).

• The value of the Duration (uuu_P6Duration) must be entered in the number of days, in the
CSV file. You cannot enter a negative or decimal number.

• You can enter the CBS Code, or WBS Code, for the new activities. When entering the CBS
Code, or WBS Code, you must specify the entire path.

• When you enter the Activity Type as "Start Milestone" (for the new activities in the input
CSV file), the sheet shows the activity as milestone-type with uuu_P6Start and
uuu_P6Finish shows the same date and duration as 0, after a successful import.

• You only enter the uuu_P6Start in the input CSV file for the milestone-type activity.

Using CSV Import to Update Activities

The editable data elements in the activities that exist in the sheet can be updated by using the
CSV import, including:

• Activity Name (uuu_P6ActivityName)

• Start Date (uuu_P6Start)

• Finish Date (uuu_P6Finish)

• Duration (uuu_P6Duration)

• Activity Status (uuu_P6ActivityStatus)

• Percent Complete (uuu_Percent Complete)

When updating through CSV import, the system validates the existing activities including:

• Activity Name (uuu_P6ActivityName)

• Start Date (uuu_P6Start)

• Finish Date (uuu_P6Finish)

If the Start Date (uuu_P6Start) exists for an activity and the Duration (uuu_P6Duration) is also
provided in the input CSV file, the system calculates the Finish Date (uuu_P6Finish). In this
case, if Finish Date (uuu_P6Finish) is provided, the system calculates the Duration
(uuu_P6Duration) based on the Finish Date (uuu_P6Finish) and uuu_P6ActivityCalendar.

In the CSV file, for existing activities:

• You cannot change the status of an activity that is "In Progress" to "Not Started."

• The Actual Finish Date cannot be earlier than the Actual Start Date.

• You can update the Percent Complete column. The range of values are 0 to 100 (zero to
one hundred).

• When you enter the Actual Start Date (uuu_P6ActualStart) in the CSV file after the import,
the system changes the status for that activity from "Not Started" to "In Progress."

• You can update an activity with Actual Finish Date (uuu_P6ActualFinish) status as "In
Progress."
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• If you update the Actual Finish Date for an activity that has not started (Status + Not
Started), the Actual Start Date shows the same value as the Actual Finish Date, and the
status shows as "Completed" with the Percent Complete as 100% (one hundred percent).

• If you enter the Percent Complete value without providing an Actual Start Date or an Actual
Finish Date, the system dismisses the Percent Complete value.

• For an activity that is in progress (Status = In Progress), if you update the Percent
Complete value to 100% (one hundred percent), the system updates the Actual Finish
Date to the current date.

• When you update the Actual Start Date and the Actual Finish Date values, the dates
cannot be earlier than the Scheduled Start Date.

• When you update the Actual Start Date and the Actual Finish Date values, the dates
cannot be later than the Current Date.

• You can add or update the CBS Code (bitemID) and the WBS Code (uuu_cmwbs_picker).

• The system changes the Start Date of the successor activities accordingly and based on
the Scheduling.

• You can use reschedule the remaining activities by way of the Schedule option from the
toolbar.

New and Existing Activities Through CSV Import

For the new activities with uuu_P6ActivityStatus as "Not Started" the following cases apply for
Start, Finish, and Duration:

Note

Invalid values for any of the date and duration columns will result in error.

• If duration is provided without a start date, the duration will be ignored.

• If duration is provided with a start date, the finish date is calculated.

• If the start date and the finish date are provided, duration is calculated.

• If duration is provided without a start date or a finish date, an error message will be
displayed.

• If only the duration is provided, an error message will be displayed.

• If only the start date is provided, an error message will be displayed.

• If only the end date is provided, an error message will be displayed.

• If the start date and the duration are provided, the finish date will be calculated.

• If the start date and the finish are provided, the duration will be calculated.

Note

Any new activities created without any dates entered in the input CSV file will
retain the Project Start Date.
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The validations mentioned above will be applied to the following dates and durations:

• uuu_P6PlannedStart

• uuu_P6PlannedFinish

• uuu_P6PlannedDuration

• uuu_P6RemainingDuration

• uuu_P6RemainingEarlyFinish

• uuu_P6RemainingEarlyStart

New "In Progress" and "Completed" Activities

In the input CSV file for a new activity creation, the following applies to:

• Actual Start

• Actual Finish

• Actual Duration

The invalid values for any of the date and duration columns will result in error.
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

t
e
s
w
i
l
l
b
e
r
e
t
a
i
n
e
d
.
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

No date entered
for uuu_P6Start,
uuu_P6Finish
and entered
uuu_P6ActualSta
rt

No Value
provided

No Value
provided

No Value
provided

Valid value
entered

Activity will be
created with Activity
Status as "In
Progress"
Activity Percentage
as entered in input
CSV file
Actual Duration will
be 0 (zero), if not
entered

N
o
t
e

I
f
n
o
t
p
r
o
v
i
d
e
d
i
n
t
h
e
C
S
V
i
n
p
u
t
fi
l
e
,
t
h
e
P
6
S
t
a
r
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

t
,
P
6
F
i
n
i
s
h
,
P
6
P
l
a
n
n
e
d
S
t
a
r
t
,
a
n
d
P
6
P
l
a
n
n
e
d
F
i
n
i
s
h
w
i
l
l
b
e
t
h
e
p
r
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

o
j
e
c
t
s
t
a
r
t
d
a
t
e
;
o
t
h
e
r
w
i
s
e
,
t
h
e
u
s
e
r
-
p
r
o
v
i
d
e
d
d
a
t
e
s
w
i
l
l
b
e
r
e
t
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

a
i
n
e
d
.

The
uuu_P6RemainingSta
rt will be the Actual
Start Date and the
uuu_RemainingFinis
h will be the
uuu_P6RemainingSta
rt +
uuu_P6RemainingDu
ration
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

Valid date
entered for
uuu_P6Start,
uuu_P6Finish
but no
uuu_P6ActualSta
rt is provided.

Valid date
entered and on
or after Project
Schedule Start
Date

No Value
provided

No Value
provided

No Value
provided

Activity will be
created with Activity
Status as "Completed"
Actual Start and
Actual Finish Dates
are shown with same
date as provided in
Actual Finish Date
and Activity %
Complete should be
100% (one hundred
percent)
Actual Duration will
be duration between
Actual Start and
Actual Finish

N
o
t
e

I
f
n
o
t
p
r
o
v
i
d
e
d
i
n
t
h
e
C
S
V
i
n
p
u
t
fi
l
e
,
t
h
e

Chapter 1
Activity Manager

Managers User Guide
G30280-01
Copyright © 1998, 2026, Oracle and/or its affiliates.

April 3, 2026
Page 622 of 671



uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

P
6
S
t
a
r
t
,
P
6
F
i
n
i
s
h
,
P
6
P
l
a
n
n
e
d
S
t
a
r
t
,
a
n
d
P
6
P
l
a
n
n
e
d
F
i
n
i
s
h
w
i
l
l
b
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

e
t
h
e
p
r
o
j
e
c
t
s
t
a
r
t
d
a
t
e
;
o
t
h
e
r
w
i
s
e
,
t
h
e
u
s
e
r
-
p
r
o
v
i
d
e
d
d
a
t
e
s
w
i
l
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

l
b
e
r
e
t
a
i
n
e
d
.

The
uuu_P6RemainingSta
rt and
uuu_P6Reamining
Finish will not show
any dates because the
activity is complete
(if provided in the
input CSV file for
completed activity,
the dates will be
ignored and
remaining duration
will be 0)
Actual Duration will
be total duration
between Actual Start
and Actual Finish
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uuu_P6ActualSt
art

uuu_P6ActualFi
nish

uuu_P6ActualDu
ration

uuu_P6ActivityS
tatus

uuu_P6PercentC
omplete

Behavior

No Value
provided

No Value
provided

Valid value
entered for
uuu_P6Actual
Duration

No Value
provided

No Value
provided

Activity will be
created with Activity
Status as "Not
Started"
Activity Complete
will be 0% (zero
percent)
Actual Duration
value will be ignored
if entered without
uuu_P6ActualStart
If the uuu_P6Start
and uuu_P6Actual
Start are both
entered, those dates
are retained;
otherwise, the
uuu_P6Start and
uuu_P6Finish will be
the project start date,
if it exists
The
uuu_P6PlannedStart
will be same as
uuu_P6Start, and the
uuu_P6PlannedFinish
will be same as
uuu_P6Finish
The
uuu_P6RemainingSta
rt and
uuu_P6Remaining
Finish will be the
same as uuu_P6Start
and uuu_P6Finish

Valid date
entered in
uuu_P6Start and
uuu_P6Finish
Valid date
entered and on
or after Project
Schedule Start
Date

Valid date
entered and <=
uuu_P6ActualSta
rt

Not applicable Not applicable Not applicable Error message
indicating that the
uuu_P6ActualFinish
cannot be earlier
than
uuu_P6ActualStart

Update Activities
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Pla
nned Start

uuu_P6Pla
nnedFinis
h

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Re
mainingEa
rlyStart

uuu_P6Re
mainingEa
rlyFinish

Behavior
after import

For Not
Started
Activity:
Valid date
provided

No Change No Change No Change No Value No Value No Change No Change Activity will
be updated
with
uuu_P6Start
update
provided
uuu_P6Finis
h will be
calculated
based on
Start and
duration
All other
dates -
Planned
Start,
Planned
Finish,
Remaining
Early Start
and
Remaining
Early Finish
will be
updated
same as
Start and
Finish
Activity
status will
be "Not
Started"
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Pla
nned Start

uuu_P6Pla
nnedFinis
h

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Re
mainingEa
rlyStart

uuu_P6Re
mainingEa
rlyFinish

Behavior
after import

No Change Valid date
provided

No Change No Change No Value No Value No Change No Change Activity will
be updated
with
uuu_P6Finis
h and
duration
will be
recalculated
All other
dates -
Planned
Start,
Planned
Finish,
Remaining
Early Start
and
Remaining
Early Finish
will be
updated
same as
Start and
Finish
Activity
status will
be "Not
Started"
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Pla
nned Start

uuu_P6Pla
nnedFinis
h

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Re
mainingEa
rlyStart

uuu_P6Re
mainingEa
rlyFinish

Behavior
after import

No Change No Change No Change No Change Valid Value
entered

No Value No Change No Change Activity will
be updated
with
uuu_P6Start
same as
uuu_P6Actu
alStart
Planned
Start and
Planned
Finish will
not be
changed
Remaining
Early start
will be same
as
uuu_P6Actu
alStart and
Remaining
Early Finish
will be same
as
uuu_P6Finis
h
Activity
status will
be "In
progress"
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Pla
nned Start

uuu_P6Pla
nnedFinis
h

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Re
mainingEa
rlyStart

uuu_P6Re
mainingEa
rlyFinish

Behavior
after import

No Change No Change No Change No Change No Change Valid date
entered

No Change No Change Activity will
be updated
with
uuu_P6Finis
h same as
uuu_P6Actu
alFinish
Planned
Start and
Planned
Finish will
not be
changed
Remaining
Early start
and Finish
will not
show any
dates
(empty) as
the activity
is being
completed
Activity
status will
be
"Complete"
Activity
percent will
be 100%
(one
hundred
percent)

Note

When you change any of the above dates, the system updates the dates accordingly.
For activities that are marked as "Not Started," the values for the Start, Finish,
Planned Start, Planned Finish, Remaining Early Start, and Remaining Early Finish will
be the same.

Add Start Milestone Activity
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

Valid date
provided

No value No value No value Activity
type is
provided
as  'Start
Milestone'

No value No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be "Not
Started"
uuu_P6Start
and
uuu_P6Finis
h will be the
same date
as given in
input CSV
for
uuu_P6Start
.
uuu_P6Dura
tion will be
0 (zero)

No value Valid date
provided.

Valid value
provided 
or not
provided.

No value Activity
type is
provided
as  'Start
Milestone'

No value No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be "Not
Started"
uuu_P6Start
and
uuu_P6Finis
h will be the
same as
uuu_P6Finis
h
uuu_P6Dura
tion will be
0 (zero)
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

No value No value No value Activity
Status is
provided
as 'Not
Started' 

Activity
type is
provided
as  'Start
Milestone'

No value No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be "Not
Started"
uuu_P6Start
and
uuu_P6Finis
h will be the
project
schedule
start date
uuu_P6Dura
tion will be
0 (zero)
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

No value No value No value Activity
Status is
provided
as
'Completed
' 

Activity
type is
provided
as  'Start
Milestone'

No value No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be
"Completed"
uuu_P6Start
and
uuu_P6Finis
h will be the
project
schedule
start date
uuu_P6Actu
alStart and
uuu_P6Actu
alFinish will
be the
project
schedule
start date
uuu_P6Dura
tion will be
0 (zero)
uuu_P6Perc
entComplet
e will be 100
(one
hundred)
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

Valid date
provided

Valid date
provided
and not
same as
uuu_P6star
t

Valid value
provided 
or not
provided.

No value Activity
type is
provided
as  'Start
Milestone'

No value No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be "Not
Started"
uuu_P6Start
and
uuu_P6Finis
h will be the
same date
as given in
input CSV
for
uuu_P6Start
uuu_P6Dura
tion will be
0 (zero)

No Value No Value Valid value
provided 
or not
provided.

No value Activity
type is
provided
as  'Start
Milestone'

No value No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be "Not
Started"
uuu_P6Start
and
uuu_P6Finis
h will be the
same date
as given
project
schedule
start date
uuu_P6Dura
tion will be
0 (zero)
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

Valid date
provided

Valid date
provided a
nd not
same as
uuu_P6star
t or Value
not
provided

Valid value
provided 
or not
provided.

No value Activity
type is
provided
as  'Start
Milestone'

No value No value No value Error
message

N
o
t
e

T
h
i
s
i
s
t
h
e
s
a
m
e
c
a
s
e
w
h
e
n
u
u
u
_
P
6
A
c
t
u
a
l
S
t
a
r
t
a
n
d
u
u
u
_
P
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

6
A
c
t
u
a
l
F
i
n
i
s
h
a
r
e
p
r
o
v
i
d
e
d
,
a
n
d
t
h
e
y
a
r
e
d
i
f
f
e
r
e
n
t
d
a
t
e
s
.
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

Valid date
provided

Valid date
provided a
nd  same
as
uuu_P6star
t or Value
not
provided

No value No value Activity
type is
provided
as  'Start
Milestone'

Valid date
provided 

No value No value Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be
'Completed'.
uuu_P6Actu
alStart and
uuu_P6Actu
alFinish will
be same
date as
provided
uuu_P6Start
and
uuu_P6Finis
h will be the
same date
as
uuu_P6Actu
alStart
uuu_P6Dura
tion will be
0 (zero)
uuu_P6Perc
entComplet
e will be 100
(one
hundred)
Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be
'Completed'.
uuu_P6Actu
alStart and
uuu_P6Actu
alFinish will
be same
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

date as
provided
uuu_P6Start
and
uuu_P6Finis
h will be the
same date
as
uuu_P6Actu
alStart
uuu_P6Dura
tion will be
0 (zero)
uuu_P6Perc
entComplet
e will be 100
(one
hundred)

The following dates will show the same date as uuu_P6Start, uuu_P6Finish and
uuu_P6Duration for the milestone activities:

• uuu_P6PlannedStart

• uuu_P6PlannedFinish

• uuu_P6PlannedDuration

• uuu_P6RemainingDuration

• uuu_P6RemainingEarlyFinish

• uuu_P6RemainingEarlyStart

Update Existing Activity (Not Started) to Start Milestone
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

Valid value
provided 
or not
provided.

Valid value
provided 
or not
provided.

Valid value
provided 
or not
provided.

Valid value
provided 
or not
provided.

Activity
type is
provided
as  'Start
Milestone'

Not
applicable

Not
applicable

Not
applicable

Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be "Not
Started"
uuu_P6Start
and
uuu_P6Finis
h will be the
same as
project
schedule
start date
uuu_P6Dura
tion will be
0 (zero)

Update Existing Activity (In Progress or Completed) to Start Milestone
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

Valid value
provided
or not
provided.

Valid value
provided
or not
provided.

Valid value
provided
or not
provided.

Valid value
provided
or not
provided.

Activity
type is
provided
as 'Start
Milestone'

Valid value
provided
or not
provided.

Valid value
provided
or not
provided.

Valid value
provided
or not
provided.

Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be
"Completed"
uuu_P6Start
and
uuu_P6Finis
h will be the
same date
as
uuu_P6Actu
alStart
uuu_P6Dura
tion will be
0 (zero)
uuu_P6Actu
alStart and
uuu_P6Actu
alFinish will
be same
date and
uuu_P6Actu
alDuration
will be 0
(zero)
uuu_P6Perc
entComplet
e will be 100
(one
hundred)
Activity will
be created
as milestone
with
Activity
Type
selected as
"Start
Milestone"
Activity
Status will
be
"Completed"
uuu_P6Start
and
uuu_P6Finis
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uuu_P6Sta
rt

uuu_P6Fin
ish

uuu_P6Du
ration

Activity
Status

Activity
Type

uuu_P6Act
ualStart

uuu_P6Act
ualFinish

uuu_P6Per
centCompl
ete

Behavior

h will be the
same date
as
uuu_P6Actu
alStart
uuu_P6Dura
tion will be
0 (zero)
uuu_P6Actu
alStart and
uuu_P6Actu
alFinish will
be same
date and
uuu_P6Actu
alDuration
will be 0
(zero)
uuu_P6Perc
entComplet
e will be 100
(one
hundred)

Manual Activity Sheet (Supported Schedule Types)

Manual Activity Sheets support the following schedule methods (types), which provides
flexibility when you are integrating project schedule data with Cash Flow and Cost
Management processes.

The following explains each of the manual activity sheet Schedule types:

Duration-Based Schedules

• You can import duration data from Primavera P6 by using the XML Import option.

• Project Schedulers and Project Managers can manually define Duration-Based Schedules
within the Activity Sheet.

• You can use the sheets as a source for Cash Flow. The Schedule Type property in the
sheet is used by Cash Flow to determine whether the Activity Sheet is Duration-Based or
Resource-Loaded.

• Duration-Based Manual Activity Sheets do not support cost-related functionality, such as
assigning rate sheets or performing recosting.

• Duration-Based Manual Activity Sheets are not available for Earned Value Analysis (EVA).

Resource-Loaded Schedules

• You can import resource-assignment data from Primavera P6 by using the XML Import
option.

• To support cost calculations for P6 resource-loaded projects, the Resource-Loaded Manual
Activity Sheets use rates from the Master Rate Sheet.
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• Using the Assignments tab, you can assign Resources and Roles to activities. Costs are
then calculated based on the defined resource or role rates in the assigned rate sheet.

• When the Schedule Type property is set to Resource, Cash Flow can consume both:

– Schedule data and

– Cost Distribution from the Manual Activity Sheet

Manual Activity Sheet Dates

Activities with Status: Not Started

Note

For Not Started activities, the dates are always the same for Start, Finish, Planned
Start, Planned Finish, Remaining Early Start, and Remaining Early Finish dates.

Start Finish Planned
Start

Planned
Finish

Actual
Start

Actual
Duration

Actual
Finish

Remaining
Early Start

Remaining
Early Finish

Default to
Project
Schedule
Start Date
or to Data
Date if the
Project
Schedule
Start Date
moved
forward.
Can
modify the
date.

Default to
Project
Schedule
Start Date
or to Data
Date if the
Project
Schedule
Start Date
moved
forward.
Can
modify the
date.
Calculated
based on
start date +
duration.

Default to
Start Date.
Can be
modified.

Default to
Finish
Date.
Calculated
based on
Planned
Start date +
duration
Can be
modified.

Not
applicable.

Not
applicable.

Not
applicable.

Default to
Start Date.
Can be
modified.

Default to
Finish Date.
Calculated
based on
Remaining
Start date +
duration.
Can be
modified.

Activities with Status: In Progress

Note

For In Progress activities, the Start and Actual Start would always be the same, and
the Remaining Early Start will be >= Actual Start Date.
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Start Finish Planned
Start

Planned
Finish

Actual
Start

Actual
Duration

Actual
Finish

Remaining
Early Start

Remaining
Early Finish

Default to
Actual
Start Date
Can
modify the
date.
If Start
date is
modified,
then
update
Actual
Start date
and vice
versa.
Can be
updated by
means of
the update
of Actual
Start Date.

Start Date
+ Duration.
Can
modify the
date >=
Start Date.

Planned
Start Date
will not be
updated to
latest
schedule
data dates.
Can be
modified
manually.

Calculated
based on
Planned
Start date +
duration.
Can be
modified.

Can enter
date in the
column >=
project
schedule
start date.
Start will
be updated
accordingl
y to align
with
Actual
Start Date.
Can be
updated by
means of
Activity
Status.

In the
attribute
form and
activity
sheet, this
field is
read-only.
The value
for this
field will
be updated
as the
Duration
calculated
between
Actual
Start Date
and
Duration.

Not
applicable.

Default to
Start or
Actual
Start if not
scheduled.
Can be
updated to
later date
by means
of the
actual start
date or
start date.
If
scheduled,
then
Remaining
Start Date
will be
Data Date.
Can be
modified >
= Data
Date.

Calculated
based on
Remaining
Start Date +
Duration
If
Scheduled,
then
Remaining
Finish will
be Data
Date +
Remaining
Duration.
Can be
modified >=
Remaining
Start.

Activities with Status: Complete

Start Finish Planned
Start

Planned
Finish

Actual
Start

Actual
Duration

Actual
Finish

Remaining
Early Start

Remaining
Early Finish

Default to
Actual
Start Date
Can
modify the
date.
If Start
Date is
modified,
then
update
Actual
Start Date
and vice
versa.
Can be
updated by
means of
the update
of Actual
Start Date.

Default to
Actual
Finish
Date.
Can
modify the
date >=
Start Date.

Planned
Start Date
will not be
updated.
Can be
modified
manually.

Calculated
based on
Planned
Start Date
+ Duration.
Can be
modified.

Can enter
date in the
column >=
project
schedule
start date.
Can be
updated by
means of
Activity
Status.

In the
attribute
form and
activity
sheet, this
field is
read-only.
The value
for this
field will
be updated
as the
Duration
calculated
between
Actual
Start Date
and Actual
Finish.

Not
applicable.

Will be
empty as
the activity
is being
completed.

Will be
empty as
the activity
is being
completed.

Activity Sheet User Defined Report (UDR)
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You can create User-Defined Reports (UDRs) from the data present in your activity sheet.

The Create User-defined Report window lets you define the following fields for your UDR
(template or individual reports):

• Data Type

• Element

• Report Type

– Tabular

– Cross Tab

– Summary

– Alert

• Access Type

Note

The same fields will be available for system and permission-based data sources.

The elements (Currency/Decimal) in the OOTB Activity Sheet, along with any user-defined
column, will be available as DEs for your report.

Note

Only the data elements available in the Activity Sheet will be available in the
respective UDR.

Data for reports can be imported to Unifier from the CSV file. You can import data for Date
Field, only (if it is in the same format as in the Unifier client). In cases where the client is using
mm/dd/yyyy, you have to create custom settings in the CSV file.

In Excel, add the new custom formats as follows:

1. Right-click the applicable cell, and select Format Cells.

2. On the Number tab, select the Custom category, and specify a mm/dd/yyyy format.

Roll Up Activity Sheet to Cost Sheet

The Column Properties window enables you to select your cost sheets.

The Type field enables you to select the following:

• Worksheet

• Activity Sheet

The Name/ID field displays the name of the worksheet that you have selected; otherwise, this
field displays the Activity Sheet, using the following naming conventions:

• Activity Sheet 01 (Activity) - for Activity Sheet with ID 01

• Activity Sheet 01 (Resource)
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If there is no data or sheet for that ID, Unifier displays an error message when you select OK,
after making the selection, and the value will be zero in the Cost Sheet for that column.

The Column field enables you to select the currency and decimal fields from the Activity Sheet
that are available to be rolled up into the Cost Sheet as a column.

Assignments

• uuu_P6PlannedCost (Planned Cost - cost)

• uuu_P6ActualCost (Actual Cost - cost)

• uuu_P6AtCompletionCost (At Completion Cost - cost)

• uuu_P6RemainingCost (Remaining Cost - cost)

• uuu_P6PlannedUnits (Planned Units- Units)

• uuu_P6ActualUnits (Actual Units- Units)

• uuu_P6AtCompletionUnit (At Completion Units- Units)

• uuu_P6RemainingUnits (Remaining Units- Units)

Activity

• uuu_P6PlannedTotalCost (Planned Total Cost - cost)

• uuu_P6ActualTotalCost (Actual Total Cost - cost)

• uuu_P6AtCompletionTotalCost (At Completion Total Cost - cost)

• uuu_P6RemainingTotalCost (Remaining Total Cost - cost)

• uuu_P6PlannedTotalUnits (Planned Units - units)

• uuu_P6ActualTotalUnits (Actual Units - units)

• uuu_P6AtCompletionTotalUnits (At Completion Units - units)

• uuu_P6RemainingTotalUnits (Remaining Units - units)

Note

The decimal type Data Element (DE) is available in the cost formula.

The Column Name field, in the Cell Details window, displays the DE field label in the
respective Activity Sheet.

Note

You can have from 1 to 100 predefined cost DEs created in the Cost Sheet.

Importing Manual Activity Sheet

You can use (import) data from P6 or Microsoft Project into a Unifier project, including creating
or managing activity, activity schedules, dependencies, and resource assignments.
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Note

If you select multiple activity sheet or System Activity Sheet, import options will not be
seen.

You also have the ability to import project schedules that are maintained in P6 (.xml) or
Microsoft Project (.mpp) in the manual activity sheets. You can create a project schedule in
Unifier (manual activity sheet) and bring data by way of importing a Microsoft Project file
(.mpp). After a successful import, you can see that all the activities, their dependencies, and
assignments are created in a new activity sheet.

You can create a project schedule in Unifier (a manual activity sheet) and bring data by way of
importing a P6 (.xml). After a successful import, you can see that all the activities, their
dependencies, and assignments are created in a new activity sheet.

The imported data can be further used in the earned value calculations, cash flow
management, and so forth.

For the manual activity sheets, the system supports:

• Integrating with P6 or Microsoft Project to be able to import activities and related data to a
specified activity sheet.

• Adding new activities in an activity sheet, through P6 or Microsoft Project import, with no
additional setups.

• Synchronizing matching activities, through P6 or Microsoft Project import.

• Integrating with P6 or Microsoft Project out-of-the-box (OOTB), without any data mapping.

• Importing activity schedules, dependencies, and resource assignments, through P6 or
Microsoft Project import.

• Updating the activities that are created, through P6 or Microsoft Project import.

To import from data from P6 or Microsoft Project:

1. Select a manual activity sheet.

2. Select the gear menu ( ), and select either Import Microsoft MPP or Import P6 XML, to
open the source and import either a Microsoft Project or P6 XML file.

The options above are available for the users who have the Create permission, at the activity
sheet node level.

Note

The gear menu displays the same options for any selected activity sheet.

You can export the XML version of an existing project schedule (of an activity sheet) into other
sources, such as Microsoft Project or P6 schedules.

The History tab contains the details for any import that you have initiated. (Go to the Activity
Sheets log, select a manual activity sheet, and select the History tab in the right pane.)

After a successful import, a new activity sheet will be created.
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The import will remove any existing data in the activity sheet. Only activities for the selected
activity sheet will be removed. The WBS associated to the activity sheet will not be removed.

The following file formats are supported, for the file upload:

• The .mpp format (Microsoft Project Standard)

• The .xml format (P6 schedule)

The following objects are supported:

• Activity Sheet properties
The project schedule start date and calendar. If there is no calendar, the default project/
shell calendar is used, and the earliest start date (across all the activities in the sheet) will
be the project schedule start date.

• Activity Sheet
The activity attributes (uuu_P6 elements only), Dependencies (Predecessors and
Successors), and Resource Assignments (units and costs).

• WBS Sheet
All the WBS attributes (WBS Code, WBS Name, and other default mapped attributes).

After the activities are created in the sheet, you can assign a WBS Code (Select WBS
Code window) to a selected activity by using the WBS picker. By default, all the activities
created in the manual activity sheet will show the project-level WBS row as assigned WBS.
You can select a single WBS Code from the hierarchy. You can bulk assign the same WBS
Code to multiple activities, through drag-and-drop at the cell level within the activity sheet.

• Master Rate Sheet:
Resources/Roles (along with calendars). The Resource ID and Name/Role ID and Name,
Currency, Calendar, Default Units/time, type of resource, and standard rates.

You can modify an existing activity sheet data only if you have the Edit permission.

The following data from the source file will be copied into an activity sheet:

• Activity Sheet properties

• Activity details
For Not Started, In Progress, and Completed activities: All uuu_P6 activity data elements
and other system defined data elements like uuu_successor, uuu_predecessor, and so
forth.

For In Progress and Completed activities: The uuu_P6percentcomplete will be updated.

• WBS Summaries
Project WBS Sheet will be updated with the Summary tasks as WBS items, if no data
exists.

• Dependencies
All the relationships between the activities will be retained during the import. Those
dependencies will be imported as successors and predecessors.

• Assigned Resources/Roles
Master Rate Sheet will be updated with adding new resources and roles.

• Resource Assignments
All the Resources/Roles assigned in the project schedule will be imported, along with units
and costs. All activities will show the rolled-up costs and units when there are assignments.

In case of errors, the system aborts the importing process. The History tab will contain details
about failed or successful imports.
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Import Activities (Microsoft Project)

Activities are uniquely identified within one Microsoft Project file by the Unique ID (<UID>). The
following applies when importing activities from Microsoft Project:

• New activities inserted

– A new activity row will be created for each <UID>

– The <ID> will be copied into Activity ID (uuu_P6ActivityID)

– The <Name> will be the Activity Name (uuu_P6ActivityName).

– The Unique ID (<UID>) will be copied from the corresponding Microsoft Project
activities.

– All other default (mapped) elements will be copied into the new activity.

• Dependencies of new activities

– Dependencies will be added for the new activities (if dependencies exist) using
elements within the PredecessorLink tags.

• WBS summaries for new activities

– The WBS will be identified using the hierarchy provided within the <WBS> tag in
the .xml file.

– This is WBS Code field in the source (the .mpp file for each activity in the Advanced
tab).

– All the summary tasks (in .mpp file) will be created as WBS in project WBS Sheet, if
they do not exist.

• Resource assignments for new activities

– When a new activity is created, all assignments for that activity will be created. If the
resource does not exist (resource ID does not exist), a new resource will be created in
Master Rate Sheet, with resource name from Microsoft Project as resource ID and
Name. If the resource exists and matches the source, the resource will not be updated,
and the existing resource will be assigned to the activity. If the resource exists but does
not match the resource (resource ID is different from the ID in the source Microsoft
Project file), you must create a resource with resource ID and Name identical to the
source file.

Also, when importing the project schedule by using Microsoft Project (.mpp), for:

• Activities with start date earlier than the project schedule start date:
The project schedule start date will show the earliest start date across all the activities and
the activities will be imported according to the schedule specified in the import file. In case
the project schedule start date is selected (from shell attribute), the system displays: Import
has failed as activities have <label of uuu_P6start> earlier than project schedule start date
for the selected Activity Sheet. This takes place when importing the project schedule with
activities earlier than project start date. Similarly, when the required field values are
missing in the source Microsoft Project file, the system displays: Could not add Activity
<Activity ID> as <Field1> is required.

• WBS Code import:
The summary tasks in Microsoft Project will be imported as a WBS summaries into the
project WBS Sheet. All the summaries with hierarchy will be imported as a WBS
hierarchies into the Project WBS Sheet. Only the WBS Code and the Name will be
populated for the WBS Summaries.
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Note

Ensure that you add a new WBS Code and associate the activity, or task, with the
existing WBS Code if there is an existing WBS Code (with the same WBS name
but different WBS code), when importing the summary tasks as WBS codes.

If the WBS Code exists in the project WBS Sheet, create an activity with the WBS Picker
populating the WBS Code. The Used By field, in the project WBS Sheet, will be populated
with Activity Sheet that the WBS Code is associated with. Similarly, when the required
fields are missing in the source Microsoft Project file, the system displays the message:
Could not add WBS <WBS Code> as <Field1> is required.

• Resources that do not exist in the Master Rate Sheet in Unifier:
The system matches the resources by resource name, in the Master Rate Sheet.

If the resource is not found in the Master Rate Sheet, the resources will be added with the
resource ID and Name because the resource name (from the Microsoft Project), and the
source are selected as user-defined (User Defined).

If the resource exists in the Master Rate Sheet with the same name, but the ID does not
match, you must create a resource.

The default values will be used for the resources that you create.

If the resource has a required field that is not available in the source Microsoft Project file,
the system displays the message: Could not add resource <Resource ID> as <Field1> is
required.

• Roles:
The Microsoft project resource assignment does not specify a role.

• Project calendar in the Microsoft Project does not match with the Activity Sheet
Use the project schedule calendar that is selected for the Activity Sheet. All the imported
activities will be adjusted based on the calendar in the project schedule start date.

• Resource calendar in the Microsoft Project does not match with any calendars available in
Standards & Libraries:
Use the company calendar for the resources that have calendar that do not match. All the
imported resource assignments will be adjusted to the company calendar.

• Currencies and formats:
All costs will be converted to the shell currency, from the source file, for the activities and
assignments.

• Constraints and dependencies:
The import process will match the dependencies based on the connected activities. If a
dependency is matched, all properties of the dependency will be updated from the
Microsoft Project file, based the mapping described earlier. Activities will be moved to
retain the new dependency values. By default, all the activities will have the "As Soon As
Possible" constraint even if there are different constraints set for the activities.

• Impact on milestone activities:
You can import the milestone activities into the activity sheet. All the activities that are
created as milestone will have activity type selected as: Start Milestone.

• Required fields not part of Import file:
If there are any required elements in the activity attributes, and the imported file does not
have any values for the required elements, the system will display the following message
in the History tab, and the import will fail: <field name> is a required field in activity details.
Or <field name> is a required field in WBS details.
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The above condition applies to all the required elements (in the WBS Sheet and Master
Rate Sheet) when importing the WBS Summaries and Resources.

• Rollback on error:
The various conditions (such as resources are not matched or no data for required fields)
described above can cause the import process to abort. In such cases, all the changes
made in the project schedule, by the import, will be reverted.

The errors and warnings will be reported in the History tab (log) for various miscellaneous
conditions such as: Activities with start date that is beyond the project start date, and the
activity sheet has "From Shell" attribute that is selected for project start date.

You can import the schedule irrespective of the status of the activity sheet.

Creating and Managing Views in Activity Sheets and the System Activity
Sheet

You can use the View option to access created views, create views, update the existing views,
and change the order and visibility. The views that have been created, including Default, are
listed in the upper segment of the drop-down list. The lower segment of the list includes the
Create New View and Manage Views options.

If your administrator defined additional views in a template and pushed them to your project/
shell, these views are listed in the Manage Views dialog box. You can make these views
visible in your sheet, and you can change the order in which they are listed. After they are
visible, you can use them to create additional custom views. You cannot edit or delete the
predefined views. If the administrator pushes additional updates to the template, custom views
that you created are deleted.

To create a view:

1. Open the applicable activity sheet or the system activity sheet.

2. From the toolbar, select Create New View from the View list.

3. In the Save View As field of the New View window, enter a name for the new view.

4. Use the various tabs for adding columns and filtering, grouping, and sorting information.

5. Use the Columns tab to select the columns that you want displayed in the view.
The Available Columns box displays all the columns that you might want to include. The
Selected Columns box displays all the columns that you select. You can move columns in
and out of the Selected Columns box.

Use the following fields to set the position of the new view:

• Left Lock after Column: Displays a list of all columns, except the last column from the
selected columns list. By default, None is selected, which means that you have
chosen no column to be locked, from the left side of the sheet.

• Right Lock after Column: The default value is None, which means that you can
select not to right-lock the column in the view. Other values in this field are based on
the value that you have selected in the Left Lock after Column.

In addition to the previous sections, there are three options located after the Selected
Columns section: Group Management, Group Selected Columns, and Delete Group.

6. Use the Filters tab to control what information is displayed in the selected view.

7. Use the Group By and Sort By tabs to identify which columns should be used for group
and sorting and in what order.
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8. When you are done, select Save.

To update a user-defined view:

1. From within the applicable view, select Edit View  in the toolbar.

2. Make the applicable changes.

3. To save your changes, select Save or Save As.

To manage views:

1. Open the applicable activity or system activity sheet.

2. From within the applicable view, select Manage Views from the View list.

3. In the Manage Views dialog box, make the applicable changes.

• You can select the checkbox in the Visible column to display or hide a view.

• You can select  to delete a user-defined view.

• You can select and drag views to reorder the way they will appear in the View list.

4. When you are done, select Save.

Space Manager
The Space Manager is where you can perform the tasks of facilities management.

Note

You cannot view .DWF files in Google Chrome or Mozilla Firefox browsers.

Using the Space Manager, you can gather data about the levels in your facility (such as floors
and parking lots) and the spaces that exist on each level (cubicles, offices, conference rooms,
and so on). Categories (called types) of spaces can be designed in uDesigner, and you can
then add records of individual spaces to these types and manage them on an electronic sheet.

The Space Manager is a means of organizing all the square footage in your facility to make
monitoring, maintaining, and revising your facility more efficient. The Space Manager can be
integrated with other managers or business processes (BPs) to give you a broader view of
your company's physical capital and resources.

In uDesigner, one attribute form is designed for a “level” type in your facility and multiple
attribute forms for “spaces” types. With these attribute forms, you can create a hierarchy of
levels and spaces within levels to store the facilities data you choose to collect.

Note

• In the Space Manager, think of a level as the “platform” on which spaces reside.

• Configuration of the Data Picker and Data Elements (and when applicable: Unique
and Auto Sequence settings) must be done in uDesigner.

The Levels Sheet node in the Space Manager stores the manager sheet (Levels Sheet) on
which all the levels in a specific shell are shown. The system automatically creates a Levels
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Sheet for every level type that is created. The sheet helps you manage levels and spaces and
lets you create formulas to calculate total leasable and rentable space for a facility or building.
From the Levels Sheet, you can also automatically update individual level records with data
added to the sheet, either manually or via a formula created for a column.

The Stack Plans node is where you can create stack plans to show the actual usage of the
levels in the company's buildings. You can choose the information (data elements or specific
spaces) you want to see on the stack plan and update the plan periodically to keep abreast of
changes in the levels' space usage. For example, you might want to know the square footage
used by each department on each floor (level) or how many square feet of a floor are vacant
versus leased.

The Levels node lists all the levels that exist in a specific shell. This is where you can create
levels or update existing ones, import data from CSV or Microsoft Excel files, or export
templates to CSV or Excel.

The Spaces node shows a list of all the space types, and under the space type sub-node, all
the spaces that exist in a specific shell. This is where you can create spaces or update existing
ones, import or export data from CSV or Excel files, and select spaces to view on the level
drawing.

The Space Manager allows you to identify floors and each space by type and associate
attributes to the particular spaces. For example, a multi-floor building could have many types of
spaces, such as offices, cubicles, restrooms, conferences room, laboratories, and eating
areas.

You manage spaces according to space type. Examples of space types are:

• Gross measured area, which is the entire square footage of a floor, from wall to wall

• Common area, such as hallways, lobbies, and entrances

• Usable space, such as cubicles, offices, and conference rooms

• Vertical penetration, which includes elevators, stairwells, and columns

The Space Manager is available within a shell. Each shell can have only one Space Manager
and one corresponding Levels Sheet. A building is at the shell level. An example hierarchical
arrangement of objects in the Space Manager is as follows:

• Buildings (shell level)

– Levels (Floors) of the building or other similar structures (in this case, Floor is an
example of a level record)

* Spaces in the building. These are the various spaces in the structure, such as
storage rooms, offices, and other interior spaces (space records). Spaces is a
fixed node designed in uDesigner.

Space Manager Prerequisites

The following is a list of prerequisites:

• Generic or CBS shells configured

• Level and Space Attribute Forms defined in uDesigner

Accessing the Space Manager

The Space Manager is available within a shell. Each shell can have one space manager.
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To access the Space Manager:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select the applicable Levels Sheet,
level, or space.

Quick Calendar

The Quick Calendar is available for Space Manager. For details, see Working with Quick
Calendar Entry.

Working with Levels

The Levels log enables you to view a summary of Level records, take actions from the log,
and make log adjustments as explained in the following sections.

When you select a record in the log, the system opens the Record Details tab (on the right
side of the page). You can use this tab to view the details of the selected record.

In addition, you can use the log to:

• Print the log based on the current view. This outputs a report similar to a UDR.

• Select the order of the columns in the log and define which columns must be visible.

• Sort on one or many columns within the log.

• Group items based on one column or up to three columns, and define how the groups are
sorted and how rows are sorted within the groups.

• Apply filters to individual columns.

• Lock columns so that they are fixed on the left side and the remaining columns scroll on
the right side.

Levels Log Options

Levels log toolbar options:

• Create

• Actions

– Import

– Export CSV Template

– Export Microsoft Excel Template

– Bulk Edit

– View Import Audit Log
Enables you to open the Import Audit Log - Levels, which displays the pertinent
information regarding the import of CSV or Microsoft Excel files.

• View
The system-defined views are:

– All Records

– Records Created by Me
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In addition, there are options for you to:

– Create New View

– Manage Views

• Edit View
Enables you to change the settings of the selected View.

• Refresh

• Print

– Print

– Export To CSV

– Export To Excel

• Search

• Find on Page

• Help

The gear menu ( ) options:

• Open

• Copy

• Print - HTML

• Print - PDF

• Print - Custom

Note

If an attribute form is present, you can hover over the question mark (?) symbol to
see more information in the form of a tooltip.

Creating a Level Record

You can manually create a record or you can copy an existing record to create a new one.

To create a level record manually:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels.

3. From the toolbar in the Levels log, select  Create.

4. In the Create New Levels window, enter the values in the required fields.
At this point, you are creating the floor details. If the properties pane does not display,

select the three vertical dots icon ( ) to open it. The properties pane contains the following
tabs:

• Comments: Contains additional details about the record. You can only add comments
to the space attribute in the edit mode.

• Linked Records: Enables you to link records to the space attribute. The functional
flow is similar to that of a non-Workflow BP.
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• Linked Mail: Enables you to link email to the space attribute. The functional flow is
similar to that of a non-Workflow BP.

5. If you want to include drawing files in the record, select More Actions, select Import
drawing file, and select the applicable file.

6. When finished, select Submit.

7. When the confirmation message appears, select OK.

8. When the log appears, select Refresh .

9. Review your recently created level.

To create a level record by copying an existing level record:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels.

3. In the Level log, select a level record, select the gear menu ( ), and select Copy.
The Create New Levels window opens with the information from the original level record.

4. Modify the form as needed.

5. To save the new record, select Submit.

Viewing or Updating a Level Record

You can view any of the level or space records in the logs. If there are many records listed in a
level or space log, you can use search criteria to narrow the options.

To view the details of a level record and its associated drawing:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels.

3. In the Levels log, double-click the applicable record to see the Levels window.
The window is divided into two panes. The left pane contains the following blocks:

• General

• Floor Plan Image

The right pane (properties pane) contains the following tabs:

• Comments

• Linked Records

• Linked Mail

• Audit Log
Lists all the actions taken by a user (Bulk Edit, Create, and so on).

4. Choose any of the following actions:

• To update the record, select Edit, make the applicable changes, and then select Save
or Submit.

• To print the record in HTML, PDF, or a Custom format, select More Actions, select
Print, and then select the applicable option.

• To view associated spaces, select More Actions, and select View Spaces. If
applicable, this action opens the space picker field. The title is "Spaces on <Level
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Name>," and the floor name is considered the level name value for the level that you
select.

Locating and Opening Space Records from Within a Level Record

To open a space record from a level record:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels.

3. In the Levels log, double-click the applicable level to open it.

4. Select More Actions, and select View Spaces.
The detail form for the selected space record opens. You can highlight the entire floor and
view all available spaces.

Working with Spaces

The Space log enables you to view a summary of Space records, take actions from the log,
and make log adjustments as explained in the following sections.

When you select a record in the log, the system opens the Record Details tab (on the right
side of the page). You can use this tab to view the details of the selected record.

In addition, you can use the log to:

• Print the log based on the current view. This outputs a report similar to a UDR.

• Select the order of the columns in the log and define which columns must be visible.

• Sort on one or many columns within the log.

• Group items based on one column or up to three columns, and define how the groups are
sorted and how rows are sorted within the groups.

• Apply filters to individual columns.

• Lock columns so that they are fixed on the left side and the remaining columns scroll on
the right side.

Space Log Options

Space log toolbar options:

• Create

• Actions

– Import

– Export CSV Template

– Export Microsoft Excel Template

– Bulk Edit

– Print

* HTML

* PDF
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* Custom

– Delete
The Delete option in the Delete Records window is dimmed (grayed out) until you
enter a reason for deletion. If you enter the reason and then remove it completely, the
Delete option is dimmed again. You cannot leave a blank space in the available box
and select Delete.

– Deleted Record History
Displays the history of deleted items.

– View Import Audit Log
Enables you to open the Import Audit Log - Space, which displays the pertinent
information regarding the import of CSV or Microsoft Excel files.

• View
The system-defined views are:

– All Records

– Records Created by Me

In addition, there are options for the user to:

– Create New View

– Manage Views

• Edit View
Enables you to change the settings of the selected View.

• Refresh

• Calendar
Accesses the Quick Calendar.

• Print

– Print

– Export To CSV

– Export To Excel

Note

* For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

* If you export data from a business process (BP) record, sheet (such as an
Activity Sheet), or log (such as Company Funding Sheet Log) to Excel, be
aware that depending on how your negative values are formatted, you
might need to configure your columns in Excel to match the correct data
type (Number). Otherwise, the columns will not be treated as numeric and
will not sum as expected. One supported format includes placing the
negative sign between the currency symbol and the amount (for
example, $-1,000).

• Search

• Find on Page

• Help

• Expand All Groups
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• Collapse All Groups

The gear menu ( ) options:

• Open

• Copy

• Delete

Note

If an attribute form is present, you can hover over the question mark (?) symbol to
see more information in the form of a tooltip.

Creating a Space Record

You can manually create a record or you can copy an existing record to create a new one.

To create a space record manually:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select [space type].

3. From the toolbar, select  Create.

4. In the General section of the Create New [space] window, enter the values in the required
fields.
At this point, you are creating a space. If the properties window is not open, select the

three vertical dots icon ( ) to open it. The properties pane contains the following tabs:

• Comments: Contains additional details about the record. You can only add comments
to the space attribute in the edit mode.

• Linked Records: Enables you to link records to the space attribute. The functional
flow is similar to that of a non-Workflow BP.

• Linked Mail: Enables you to link email to the space attribute. The functional flow is
similar to that of a non-Workflow BP.

5. When finished, select Submit.

6. When the confirmation message appears, select OK.

7. When the log appears, select Refresh .

8. Review your recently created space.

To create a space record by copying an existing space record:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select [space type].

3. In the [Space Type] log, select a space record, select the gear menu ( ), and select
Copy.
The Create New [space type] window opens with the information from the original space
record.

4. Modify the form as needed.
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5. To save the new record, select Submit.

Viewing or Updating a Space Record

You can view any of the level or space records in the logs. If there are many records listed in a
level or space log, you can use search criteria to narrow the options.

To view the details of a space record:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select [space type].

3. In the [Space Type] log, double-click the applicable space record to see the space
window.

Tip

You can also open a space record from an advanced log. An advanced log creates a
tree hierarchy structure for records. This tree structure makes it easier to view and
select records from a log of spaces in the Space Manager. To open a space record
from an advanced log, use the middle navigation column to narrow the focus of the
log, and then pick the space from the log in the right pane.

The window is divided into two panes. The left pane contains the following tabs:

• Details

• Asset
Contains the assets associated with the space. If any QBDEs are associated with the
record, the Asset tab lists the QBDEs. You can select Create to open the Create New
Assets window and enter asset information. The Create New Assets window has the
following elements:

Left pane: Asset Details tab (General and Preventive Maintenance Information blocks),
Gauges & Meters tab, and Components tab.

Right pane: Attachments tab, Comments tab, Linked Records tab, and Linked Mail tab.

The right pane (properties pane) contains the following tabs:

• Comments

• Linked Records

• Linked Mail

• Audit Log
Lists all the actions taken by a user (Bulk Edit, Create, and so on).

• Space Content
This tab contains the list of records that are associated with the space. A graphical
representation is also present for the same. The Space Content tab will be similar to the
Reference Records seen in the business processes (BPs), with the following differences:

'Reference Records' = 'Space Content'

'Business Process' = 'Record Type'

Objects seen in the link are based on the referring or referred object type.
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Similar to Reference records, the Space Content tab displays the linked records and the
reference records.

1. Choose any of the following actions:

• To update the record, select Edit, make the applicable changes, and then select Save
or Submit.

• To access the Quick Calendar, select More Actions, and then select Calendar.

• To print the record in HTML, PDF, or a Custom format, select More Actions, select
Print, and then select the applicable option.

2. If you change or add any information, select Submit to make your changes a part of
reference record to the space details or content.

Business Process (BP) Query-based Tab (QBT) in the Space Records

After a BP QBT is configured and the Space is deployed after changes are made, the QBT
appears in the Space for which the QBT has been configured.

Working with a Levels Sheet

The Space Manager includes a sheet to help you manage levels and spaces. The Levels
Sheet lets you create formulas to calculate "leasable" space and other related information in a
building. You can create one Levels Sheet per shell.

Note

You must have permissions to access a sheet.

To access the Levels Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.
If a Levels Sheet exists, it is listed in the Levels Sheet log.

The log contains two panes. The left pane lists the sheet for the current project/shell, and
identifies its Name, Description, and the Last Modified Date. The right pane displays the
Properties tab, which displays information such as the Title and Description, as well as a
list of the levels that are included and their individual status.

You can modify and save the properties, provided that you have permission.

3. To view the levels that have been added to the sheet, double-click the name of the Levels
Sheet.

4. To ensure that you are viewing the latest information from all levels and spaces in the
selected shell, from the toolbar, select Refresh Sheet Data.

Note

This toolbar option does not refresh the log items that are displayed in the Levels
Sheet log. Instead, it updates the data that is displayed within the sheet after you
open it.
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After you select Refresh Sheet Data, the Last Modified Date field at the log level shows
"In Progress" until the data update is complete, after which the date of the refresh is
displayed.

Creating a Levels Sheet

When there is no Levels Sheet available, the system displays the Create toolbar option. As
explained previously, you can only create one Levels Sheet per shell.

Note

You must have the Create permission to create a Levels Sheet.

To create a Levels Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. Select Create, and select one of the following options:

• Manual

• From <shell or project>

4. Complete the steps for the option that you selected:

• If you select Manual:

a. In the Create Levels Sheet dialog box, enter a Title and optional Description.

b. Select All Levels or Levels with statuses.

c. If you selected Levels with statuses, select the applicable statuses, such as
Occupied or Vacant.

d. Select Save.

• If you select From <shell or project>:

a. In the Levels Sheet window, select Find on Page to find the applicable project/
shell.

b. Click Select, and follow the prompts.

5. After the sheet is created, from the toolbar, select Refresh Sheet Data to refresh the data
on a sheet (update the data).
This toolbar option does not refresh the log items that are displayed in the Levels Sheet
log. Instead, it updates the data that is displayed within the sheet after you open it.

After you select Refresh Sheet Data, the Last Modified Date field shows "In Progress"
until the data update is complete, after which the date of the refresh is displayed.

Adding Columns to a Levels Sheet

To add columns to a Levels Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.
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4. From the toolbar, select Add Column .

5. In the Datasource list on the New Column window, select the data element to use.
The list includes the data elements found on the level form.

The selected datasource determines what additional fields are displayed and whether
those fields are predefined.

6. For Entry Method, choose how information is entered in the column.
Again, the choices depend on the selected datasource.

7. If you selected a datasource that is based on a formula, complete the following steps:

a. For Query Data Type, select the applicable type.

b. For Formula, define the formula that you want to use.

c. For Query Conditions, select the applicable data elements and conditions.

8. For Data Format, select the format for numeric columns.
The options are:

• Show as percentage: Displays data in percentage. Enter the value using a percent
format.

• Decimal Places: Select the number of decimal places to display.

• Use 1000 Separator (,): Data is formatted using separators. For example, one
thousand is displayed as 1,000 with a comma, not 1000.

• Negative Number Format: Select how negative values are displayed: with a negative
sign or in parentheses.

9. In the Additional Options section, complete the following:

a. For Display Mode, select Hide to make the column invisible to users or Show to
display it.

b. For Total, select what is shown in the bottom summary row for each column. The
options are:

• Blank: Summary row is blank.

• Sum of All Rows: Displays the sum total of all row values for this column.

• User Formula Definition: Displays the result of the formula entered in the
Formula field.

c. For Average, select Blank or the average of all rows.

d. For Column Position After, select a column from the list to specify its position on the
sheet.

10. Select Save or Save & Add New.

11. To update the information that is displayed on the Levels Sheet, select Refresh .

Copying Column Data Within a Levels Sheet

If you want to use column data to view different aspects of information, for example, use an
annual charge to view the quarterly charge, you can copy information from an existing column
to a new column in which you changes the properties of what is displayed.

To copy column data:

1. Go to the shell tab, and switch to User mode.
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2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.

4. From the toolbar, select Menu Options , select Columns, and then select Copy
Column Data.

5. In the Copy Column Data dialog box, complete the applicable fields, and then select
Save.

6. When the confirmation message appears, select Yes.

7. To update the information that is displayed on the Levels Sheet, select Refresh .

Exporting CSV or Microsoft Excel Files from the Levels Sheet

Because the Levels Sheet functions as a view of the information tracked in the individual levels
and spaces, the system only supports exporting data from the Levels Sheet.

To export a sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. Select a sheet.

4. From the toolbar, select Menu Options , and then select Level Summary Sheet or
Column Data.
For more information, see Exporting and Importing CSV Level Templates and Records.

Taking Snapshots of a Levels Sheet

If you have Create permission, you can use the snapshot feature to create a historical picture
of the Levels Sheet that you can preserve before the it is modified.

To take a snapshot:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.

4. From the toolbar, select Menu Options , select Snapshots, and then select Create.

5. In the Create Snapshot window, enter a Snapshot Title, and then select Create.
In the window that displays the current snapshot, you can use the Print option to print the
results or export the results to a CSV or Excel file. You can also use Find on Page to
locate specific information.

Viewing Snapshots of a Levels Sheet

To view the snapshots for a Levels Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.
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4. From the toolbar, select Menu Options , select Snapshots, and then select Open.

5. To open a snapshot, select its title to download the .pdf file of the snapshot.

Printing or Exporting a Levels Sheet

To print or generate a PDF version of a Levels Sheet or to export it to CSV or Microsoft Excel:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.

4. From the toolbar, select Print , and select one of the following options:

• To print the sheet or generate a PDF version, select Print.

• To export the sheet, select Export To CSV or Export To Excel.

Viewing the Audit Log of a Levels Sheet

To view the Audit Log for a Levels Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.

4. From the toolbar, select Menu Options , and then select Audit Log.

Changing the Row Coloring of a Levels Sheet

You can use color to change the shading of rows in a Levels Sheet.

To change the colors:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Levels Sheet log, double-click the sheet to open it.

4. From the toolbar, select Menu Options , select Row Coloring, and then select Multi-
Color or Single-Color.

Updating the Properties of a Levels Sheet

To view the Audit Log for a Levels Sheet:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels Sheet.

3. In the Properties tab on the right pane, make the applicable changes, and then select
Save.
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Working with Stack Plans

A stack plan is a two-dimensional graphical display of facility or building data. Usually, these
graphs display area calculations by different attributes (for example, rented, leased, vacant,
occupied by a tenant). The y-axis lists levels, and the x-axis lists areas. Stack plans allow you
to view area information across all building levels or floors based on defined attributes. Stack
plans display only space records. If you have permission, you can create and modify stack
plans.

Creating a Stack Plan

To create a stack plan:

1. Go to the shell tab, and switch to User mode

2. In the left Navigator, select Space Manager, and then select Stack Plans.

3. From the toolbar, select New.

4. In the Properties window, complete the following fields on the General tab:

• Name: Enter the stack plan name.

• Description: (Optional) Enter a description.

• Include: Indicate whether you want all levels included in the stack plan (All levels), or
indicate whether you only want to include levels that have a specific status (Levels
with statuses).

5. Select the Options tab, and complete the following fields:

• Space Types: Select a space type.

• Stack By: Indicate whether to stack by a selected Space Type or by a selected Data
Element.

• Stacking View: Select to specify standard stacking or 100% stacking.

• Sort Floors By: Select to sort floors by a selected data element from the Level
Attribute Form.

• Show Legend: Select this option to display a legend for the stack chart.

• Conditions: Add a condition to filter the number of space records included in the stack
plan calculation. The stack plan calculation logic sums up the values from the
uuu_area data element used on the space-type detail form.

6. Select Apply to save changes, or OK to save and exit.

Viewing a Stack Plan

To view a stack plan:

1. Go to the shell tab, and switch to User mode

2. In the left Navigator, select Space Manager, and then select Stack Plans.

3. In the Stack Plans log, double-click the applicable plan to open it.
If your stack plan contains no data, you will see a gray box. Your stack plan must contain
data to display. You can scroll up and down the stack plan if there are numerous records
listed.
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Modifying the Display Mode for a Stack Plan

You can change the display mode of the Stack Plans to display a standard view (Stack Plans -
Current View) or display the bars in the graph as proportional percentages of varying length.

To change the display mode for a stack plan:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Stack Plans.

3. In the Stack Plans log, double-click the applicable plan to open it.

4. To change the view, select Explicit Value or Percent.

Printing a Stack Plan

To print a stack plan:

1. Go to the shell tab, and switch to User mode

2. In the left Navigator, select Space Manager, and then select Stack Plans.

3. In the Stack Plans log, double-click the applicable plan to open it.

4. From the toolbar, select Print .
The displayed area is printed.

5. To print more of the records, scroll down the stack plan, and select Print again.

Printing a Level or Space Record

When printing the level or space records, you can choose PDF, HTML, or Custom print
formats, and select one of the following options:

• Save a copy of the form as a PDF file and print the file

• Print an HTML view

• Print from a Microsoft Word file if a custom print layout has been created for the form

The Custom Print formats include the Oracle Analytics Server custom print templates designed
in the Custom Templates node. If custom print layouts have been created for the Space
Manager, the form prints according to the layout that you select. For more information, see 
Printing Options - Custom Format.

To preview and print a log or record:

1. Open the record that you want to print.

2. Select More Actions, select Print, and choose one of the following:

• HTML to view the form in the browser, which can then be printed.

• PDF to open the form in Adobe Reader, which can be saved or emailed as a PDF file,
or printed process, you are asked to save the changes to the form.

• Custom to select the Oracle Analytics Server, Microsoft Word, and PDF custom print
templates from the same place as the current custom prints. For more information, see 
Printing Options - Custom Format.
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The Print Options window opens. This window displays the record information that can be
printed.

3. Select the check boxes for the information that you want to print.

• To select all the checkboxes, select Show All.

• To clear all, select Show All again. If you deselect all checkboxes, only the header and
footer will print.

4. Select Print.
The preview form opens in an HTML or PDF (Adobe Acrobat or Reader) window, from
which you can print.

5. If you chose PDF, select Print, or select Save a Copy if you want to save a copy.

6. To print from HTML format, select Print in the upper-right corner.

Print Options for Level and Space Records

Following is a summary of the print options for a level or space record.

Print option What it prints

Detail Form This prints the information entered on the record.
Depreciation details in the line items are not printed.

Line Item List Selected by default. This prints the information present
on the tabs displayed on the Space.

General Comments The general comment text and create details are printed.
Record Attachments File attachments to the record are listed alphabetically

by file name, and include the file title, issue date,
revision number, and file size.

Record Attachments followed by Comments Prints comments associated with file attachments to the
record. "Record Attachments" must also be selected to
select this option.

Printing Options - Custom Format

The Custom Format Print window has two sections:

• Select a custom print template

• Select a template and format to print

Both sections facilitate custom print template and format selections.

Select a custom print template

Lists all the custom print templates, including the custom print templates created in the
Custom Templates node and the custom print templates. For example, the list may include
Oracle Analytics Server custom print templates, Word, and PDF custom print templates.

If there are multiple custom print templates, all the published templates are listed in this
section.

The "Select a template and format to print" section is populated by the selection made in the
"Select a custom print template" section.

Select a template and format to print
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• If you select an Oracle Analytics Server custom print, you can select the desired template
and format from the drop-down lists.

• Template drop-down displays all the available templates for the selected format.

• Format drop-down displays the available formats for the selected template.

• If the custom print template was created using PDF or Word, "Select a template and format
to print" is disabled.

Default template and format

• If an Oracle Analytics Server print template is selected, the default values in the drop-down
lists are set based on the default in the custom print template.

• When an Oracle Analytics Server print template is selected in the "Select a custom print
template" section, the template and format are populated based on the default value
selected at the time of designing the print template.

Exporting and Importing CSV and Excel Level or Space Templates and
Records

You can use CSV and Microsoft Excel files to create level or space records and to import
drawing files. After you have edited and saved the exported file, you can import it back into
Unifier. During the import process, the system validates the data. If the data passes validation,
the new records are created. If the data fails the validation, you can view or download a text file
summarizing the errors.

To export a template file:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels or [space type].

3. From the toolbar, select Actions, and then select Export CSV Template or Export
Microsoft Excel Template.
The exported template is based on the Integration interface design of Level or Space that
was created in uDesigner.

4. Save the exported file to your desktop.

To modify an exported template file:

1. Open the file in Microsoft Excel or a compatible software application.

2. Add data to the file, one record per row.

3. Save the file.
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Note

Excel 2003 cannot handle CSV files with 15 or more rows. In CSV files, columns
are separated with commas. With Excel, when you open a CSV file that has empty
columns at the end of the file, Excel drops the additional commas from the 15th
row onward, resulting in an error when you try to import the file. To work around
this problem, do one of the following:

• Add your data to the CSV file in Excel, and save the file. Then reopen the file
in a text editor such as Notepad, find the rows that have the missing commas,
and add the additional commas to these rows.

• Use a text editor instead of Excel to modify column values in the CSV file.

To import an updated template file:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select Levels or [space type].

3. From the toolbar, select Actions, and then select Import.

4. Locate and select the file.
The system checks the file for the following items to make sure that valid records are
created:

• The file format of the imported file matches the interface design created in uDesigner.

• You are importing into the same log from which you exported the CSV template file.

• The required fields contain data in the correct format.

If an error occurs, a confirmation message gives you the option to save a file that lists the
errors.

To view the import validation error file:

1. When the Confirmation message appears, select Yes.

2. Select Open to open the file, or select Save to save the file to your local machine.
The error file is a CSV file.

3. To view the full contents of the listed error, select a cell.

4. After fixing the errors, use this file to re-import the records.

Creating and Managing Log Views in the Space Manager

In addition to opening and viewing the various sheets and records used in the Space Manager,
you can use the View list to customize a log to display information based your filter criteria.

The Levels Sheet includes one predefined view: Default

The logs for the level and space records include two predefined views: All Records and
Records Created by Me

To create a view:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select the applicable Levels Sheet,
level, or space.
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3. From the toolbar, select View, and select Create New View.

4. On the New View page, enter a name for your new view under the field Save View As.

5. In the Columns tab, select columns that you want to display.

6. Select the columns that you want to remain static on the page from: Lock after selected
Column drop-down list.
In addition to arranging the columns, you can go to the Filters, Group By, and Sort By
tabs to customize the new view by applying more refined selections.

7. Select Save.
Your new view appears in View list.

To manage views:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select the applicable Levels Sheet,
level, or space.

3. From the toolbar, select View, and select Manage Views.

4. Use the Manage Views window to delete or hide views within any log.
In addition, you can reorder views by dragging and dropping them in the Manage Views
window.

5. When finished, select Apply.
Your arrangement appears in the View list.

To edit or delete an existing view:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select the applicable Levels Sheet,
level, or space.

3. From the toolbar, select Edit View .

Note

If you modify the view and do not save the changes, the system keeps the existing
name and adds the word "Modify" to the existing name.

You can edit the view of the following elements on your log:

• Columns

• Filters

• Group By

• Sort By

4. When finished, select Apply.

Using Bulk Edit to Update Level or Space Records

If you have many records that need the same changes, you can use Bulk Edit to update all the
records at once. You can update up to 200 records at a time. Bulk editing must be defined in
uDesigner, and you must have the Allow Bulk Edit permission set for the manager.
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To edit multiple records in bulk:

1. Go to the shell tab, and switch to User mode.

2. In the left Navigator, select Space Manager, and then select the applicable level or space.

3. In the corresponding log, use Ctrl+click to select the records that you want to edit.

4. From the toolbar, select Actions, and select Bulk Edit.

5. Use the left pane of the Bulk Edit window to edit the details of each record.
The system automatically selects the corresponding checkbox when you type into or
modify a field. You can deselect it if you do not want to modify the field at this time.

6. To preview the status of each record, use the Action Status pane on the right.

7. When you are ready, select Update.

8. When finished, select Close.

For more information on editing records in bulk, refer to the Unifier Business Processes User
Guide.
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